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Dlaczego napisałem tę książkę? 

Ponieważ zawsze chciałem stworzyć model samolotu w komputerze. A gdy już to zrobiłem – stwierdziłem, że to 

dobra zabawa, i że warto tym doświadczeniem podzielić się z innymi. 

Dawno temu byłem zwykłym modelarzem i robiłem redukcyjne modele samolotów. To hobby dość specyficzne. 

Ślęczymy miesiącami nad naszym dziełem, starając się nanieść na kawałek materiału maleńkie nity, złącza 

blach, czy drobne detale tablic przyrządów. Sądzę, że w porównaniu z modelarzami, wędkarze mają mniej mę-

czące, choć podobnie monotonne hobby. W dodatku, zamiast tworzyć ładne, błyszczące miniaturki, nanosimy 

na ich powierzchnię zabrudzenia i przetarcia, aby wyglądały jak rzeczywiste, zużyte i gdzieniegdzie pordzewiałe 

maszyny. Nagrodą za ten wysiłek jest okazja do pokazania naszych dzieł komuś, kto potrafi docenić ich finezję. 

Mówiąc szczerze, dziwnym trafem są to zazwyczaj inni modelarze. A może tak naprawdę chodzi tu o możliwość 

nawiązania dyskusji na tak ezoteryczne tematy, jak wyższość Spitfire’a IX nad FW 190 A4? Albo paląca kwestia, 

jak był pomalowany P-40K, na którym Witold Urbanowicz latał nad Chinami w 1943r? 

Otóż chciałbym teraz zaoferować wszystkim modelarzom zupełnie nowy materiał i narzędzia. Zamiast własne-

go, czasami nieco pobrudzonego aerografem biurka – okno na inny świat, w głębi ekranu.  

Jest tu niezwykle plastyczny materiał, który można "wytłaczać" w dowolne powłoki, bez obawy, że go zabraknie. 

Są tu farby, dla których można dokładnie ustalić odcień i zasady nakładania. Można tu wreszcie odtworzyć gru-

bość blachy poszycia, jak w prawdziwym samolocie! Tu, gdy stwierdzisz, że okapotowanie silnika, który wyko-

nałeś rok temu, powinno mieć inny kształt, zawsze możesz ten błąd poprawić. I to nie raz! Tutaj nigdy Twój mo-

del nie obrośnie kurzem. Nie będziesz wysłuchiwał narzekań domowników na to, że nie ma już gdzie zmieścić 

Twojej kolekcji. Możesz kopiować i przesłać swój model innym hobbystom, takim jak Ty, bez obawy, że coś się z 

nim stanie podczas transportu. Z obiektów, które w ten sposób stworzysz, można szybko budować całe sceny 

(wirtualne dioramy).  

Jedyne, do czego trzeba się przyzwyczaić, to to, że niczego w tym świecie nie można dotknąć. Możesz tylko 

patrzeć i łapać wszystko myszką. Rozwój bardziej zaawansowanych urządzeń dotykowych od dziesięciu lat 

„drepcze w miejscu”. Za to niedrogie i odpowiednio dokładne drukarki 3D stają się już ogólnie dostępne. Obec-

nie, po kilku próbach, możesz zacząć „drukować” swoje własne zestawy do sklejania. 

Ten świat wirtualnego modelarstwa stał niepostrzeżenie dostępny. W istocie każdy komputer wyprodukowany 

obecnie to silna stacja graficzna, o której w latach 90-tych można było tylko pomarzyć. Co więcej – odpowiednie 

programy, które potrafią ten potencjał wykorzystać, stały się dostępne za darmo! Stworzyły je dziesiątki progra-

mistów Open Source. Ludzie ci pokazali, że stać ich co najmniej na to samo, co twórców najlepszych progra-

mów komercyjnych. I te aplikacje są coraz lepsze! Podczas pracy nad takim oprogramowaniem nie ma typowe-

go dla komercyjnych projektów pośpiechu, związanego z napiętymi terminami (a pośpiech rodzi błędy). W efek-

cie, dzięki pracy odpowiednio dużej grupy entuzjastów, powstaje dobry i stabilny program. 

Podsumowując – kupując parę lat temu komputer do gier, nabyłeś wszystko, co potrzeba do wejścia w świat 

wirtualnego modelarstwa. Oczywiście, budowa modeli komputerowych także wymaga nieodłącznych cech każ-

dego modelarza: precyzji i cierpliwości. Mam jednak nadzieję, że ta książka ułatwi Ci, drogi Czytelniku, jak naj-

szybsze osiągnięcie pożądanych rezultatów. Potem możesz pójść dalej i zrobić to samo jeszcze lepiej, niż tu 

proponuję. Przeczytanie dalszych stron oszczędzi Ci sporo czasu, a niekiedy – frustracji. Ta ostatnia bywa nie-

odłącznym składnikiem pracy z „tą głupią maszyną” – komputerem. Postaram się nie zanudzać i pokazywać 

dużo ilustracji, więc mam nadzieję, że "Wirtualne modelarstwo" Cię zainteresuje. 

Witold Jaworski 
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Co zawiera ta publikacja? 

„Wirtualne Modelarstwo” uczy „od zera”, jak tworzyć takie komputerowe modele samolotów1 i ich wizualizacje, 

takie jak pokazana na okładce książki. Aby szybciej udostępniać Czytelnikom uaktualnione fragmenty tego po-

radnika, zdecydowałem się stworzyć i opublikować wyciągi z jego tekstu, związane z określoną dziedziną. Są 

to: „Tom I: Przygotowania”, „Tom II: Modelowanie”, „Tom III: Materiały i tekstury”, oraz „Tom IV: Detale i rende-

rowanie”. Przebieg pracy prezentuję na przykładzie modelu myśliwca Curtiss P-40B. Ta maszyna zawiera kla-

syczne rozwiązania, stosowane w większości samolotów tego okresu. Z całym rozmysłem nie wybrałem Spitfi-

re, Mustanga, Thunerbolta, Focke-Wulfa czy Messerschmita. Nie chciałem zabierać Ci przyjemności samo-

dzielnego odwzorowania tych słynnych samolotów! 

 

Możesz tworzyć model każdego  myśliwca z okresu II wojny światowej, czytając jednocześnie kolejne 

rozdziały z tej książki. To wcale nie musi być P-40. Wszystkie te samoloty wykonuje się bardzo podob-

nie. W trakcie tej pracy na pewno zetkniesz się ze wszystkimi zagadnieniami, które są tu opisane. 

 
 Ta książka ma służyć zarówno tym, którzy dopiero zaczynają swoją przygodę „w 3D”, jak i tym, którzy mają już 

w tej dziedzinie pewne doświadczenie. W związku z tym, w części podstawowej opisuję co trzeba zrobić. 

Szczegółowe instrukcje, jak posłużyć się odpowiednim programem, umieściłem w częściach poświęconym de-

talom („Szczegóły obsługi Blendera 3D”). Ich zawartość przypomina tekst systemów pomocy (Help) aplikacji. To 

krótkie sekcje, opisujące pojedyncze polecenia (zazwyczaj nie są dłuższe niż dwie-trzy strony, i zawieraj kilka 

ilustracji). 

Dzieląc materiał na część „podstawową” i „szczegółową”, starałem się uniknąć niepotrzebnych, wydłużających 

tekst wskazówek, w rodzaju "kliknij tu, a potem naciśnij tamto". Zamiast tego, w odpowiednich miejscach opisu 

umieściłem odsyłacze (wewnętrzne linki) do sekcji z detalami tych poleceń. Jeżeli nie znasz programu, o którym 

akurat piszę, korzystaj z tych odsyłaczy i czytaj umieszczone w nich informacje szczegółowe2. Przygotowałem 

je tak, abyś nauczył się posługiwać wszystkimi narzędziami "od zera", w trakcie czytania części podstawowej. 

Gdy już będziesz wiedział, jak zrobić to, co opisuję – po prostu przestaniesz do nich zaglądać. 

Książka zawiera jeszcze jedną część: "Dodatki". To materiały, które mogą być ciekawe dla co dociekliwszych 

Czytelników. Tematyka "Dodatków" przypomina trochę "groch z kapustą": od wybranych zagadnień optyki (de-

formacja obrazu na fotografii, refrakcja światła), do odwzorowania profili lotniczych. A oprócz tego: metody zaa-

wansowanej weryfikacji rysunków samolotu (na poziomie tworzenia planów modelarskich) oraz szczegółowy 

opis właściwości powierzchni podziałowych. Nie musisz do „Dodatków” zaglądać, choć sądzę, że niektórzy mo-

gą w tych materiałach znaleźć dla siebie coś interesującego. 

 
1 Nie omawiam tu przygotowania modeli do wydruku 3D, ani do gier/symulatorów lotu. Jeżeli chciałbyś „drukować” własne zestawy do 

sklejania, zapoznaj się z pierwszymi częściami tego poradnika, o rysunkach referencyjnych i modelowaniu i pomiń resztę, dotyczącą wizua-

lizacji: materiałów, tekstur, kompozycji. W przypadku modeli dla gier/symulatorów – ta książka będzie użyteczna, ale w swoim projekcie 

musisz jeszcze uwzględniać specyficzne wymogi docelowego „silnika gry” (ang. „game engine”).  

2 Zakładam, że korzystanie z części drugiej będzie zawsze wyrywkowe. Stąd większość z zagadnień, które tam się znajdują, jest omówiona 

bez dalszych odnośników. Takie podejście powoduje, że np. opis skalowania w edytorze siatki Blendera jest niemal dosłowną kopią opisu z 

edytora obiektów. Różnią się tylko ilustracjami i paroma zdaniami. Po prostu nie wiem, który z tych tematów otworzysz jako pierwszy, a w 

każdym chciałbym zapewnić pełną informację.  
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Konwencje zapisu 

Wskazówki dotyczące klawiatury i myszki oparłem na założeniu, że masz standardowe: 

• klawiaturę – w normalnym układzie amerykańskim, 102 klawisze (dodam także parę uwag o klawia-

turze notebooka, bo sam na takiej pracuję); 

• myszkę – wyposażoną w dwa przyciski i kółko przewijania (które daje się także naciskać: wtedy 

działa jak trzeci, środkowy przycisk). 

 

Wywołanie polecenia programu będę zaznaczał następująco: 

Menu→Polecenie - taki zapis oznacza wywołanie z menu „Menu” polecenia „Polecenie”. W przypadku 

bardziej zagnieżdżonych menu może wystąpić więcej strzałek! 

Panel:Przycisk - taki zapis oznacza naciśnięcie w oknie dialogowym lub panelu "Panel" przycisku 

„Przycisk”. Czasami mogę także w ten sposób napisać o przełączniku lub liście 

rozwijalnej. W podobny sposób będę także oznaczał inne hierarchiczne zależności 

np. warstw. Wtedy jednak będą występować w kolorze zielonym, a nie niebieskim.   

 

Naciśnięcie klawisza na klawiaturze: 

Alt - K  - myślnik pomiędzy znakami klawiszy oznacza jednoczesne naciśnięcie obydwu kla-

wiszy na klawiaturze. W tym przykładzie trzymając wciśnięty Alt , naciskasz K ; 

G , X  - przecinek pomiędzy znakami klawiszy oznacza, że je naciskasz (i zwalniasz!) po 

kolei. W tym przykładzie najpierw G , a potem X  (tak, jak gdybyś chciał napisać 

wyraz „gx”). 

 

Naciśnięcie klawisza myszki: 

 LPM   - lewy przycisk myszy; 

 PPM   - prawy przycisk myszy; 

 SPM    - środkowy przycisk myszy (naciśnięte kółko przewijania); 

 KM  - kółko przewijania (pełni tę rolę, gdy jest obracane). 

Na koniec – „w kwestii formalnej”: jak mam się do Ciebie zwracać? Zazwyczaj w poradnikach używa się formy 

bezosobowej („teraz należy zrobić”). To jednak, mówiąc szczerze, czyni czytany tekst mniej zrozumiałym. Aby ta 

książka była jak najbardziej czytelna, zwracam się do Czytelnika w krótkiej, drugiej osobie („teraz zrób”). Cza-

sami używam także osoby pierwszej („teraz zrobiłem”, „teraz zrobimy”). Tak jest mi łatwiej1.  

 

 
1 Podczas pracy nad modelem traktowałem nas – czyli Ciebie, drogi Czytelniku, i siebie, piszącego te słowa – jako jeden zespół. Może 

trochę wyimaginowany, ale w jakiś sposób prawdziwy. Przecież tworząc tę książkę ja także wiele się uczyłem, bo wiedziałem, że każde 

zagadnienie mam Ci porządnie przedstawić! 
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Jak czytać tę książkę? 

Ta książka jest publikacją elektroniczną, dostarczaną w formacie PDF. Poniżej pokazuję jej angielską wersję, 

otwartą w systemie Windows, w popularnej, bezpłatnej przeglądarce Adobe Acrobat Reader (Rysunek 1): 

 

 Rysunek 1 Czytanie książki w przeglądarce PDF (Adobe Reader) 

Aby ten poradnik był bardziej czytelny niż drukowane książki, przeniosłem większość szczegółowych opisów z 

głównego tekstu do podrozdziałów, pozostawiając w ich miejscu odsyłacze (wewnętrzne „linki”). Używaj ich, aby 

zapoznać się ze szczegółami, a potem wracaj do głównego tekstu. Aby nie „zaśmiecać” zawartości poradnika, 

nie wyróżniałem specjalnie tych skrótów kolorem lub podkreśleniem. Możesz je jednak rozpoznać na podstawie 

kontekstu („por. str. …”) a także po zmianie kształtu kursor myszki na „wskazującą dłoń” (tak jak to pokazuje 

Rysunek 1). Gdy klikniesz w taki skrót, przejdziesz na stronę, na którą odsyła Cię tekst. Aby powrócić w po-

przednie miejsce książki, wykorzystaj przycisk Wstecz umieszczony u góry ekranu (Rysunek 1). Działają tak 

samo, jak w przeglądarce internetowej. Jednak w domyślnej konfiguracji Adobe Reader przyciski Wstecz/Dalej 

nie są wyświetlane. Rysunek 2 pokazuje, jak je dodać do paska narzędzi: 

 

Rysunek 2 Dodawanie przycisków Wstecz/Dalej do paska narzędzi (Adobe Reader) 

Przyciski Wstecz/Dalej 
– jak w przeglądarce 

Oglądaj w trybie 
“ciągłym” 

Ważny element: wewnętrzne linki w 
tekście. Kursor myszki zmienia się 
ponad nimi we „wskazującą dłoń” 

 

Struktura książki: 
rozdziały, sekcje 

 

Używaj Wstecz aby 
wrócić z objaśnienia 

1. Kliknij PPM  na przyborniku 

by otworzyć to menu 

2. Wybierz stąd 
przycisk Next View  
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Aby dodać przyciski Wstecz/Dalej do przybornika1, kliknij LPM  na pasku narzędzi i z menu kontekstowego wy-

wołaj submenu Show Page Navigation Tools…. Wybierz z niego polecenia Previous View i Next View (por. 

Rysunek 2). Za każdym razem możesz wybrać tylko jedno z tych poleceń. 

Aby ten dokument PDF można było poprawnie odczytać na różnych urządzeniach, jest zapisany w standardzie 

PDF/A. Po otworzeniu pliku książki, Adobe Reader wyświetla o tym odpowiedni komunikat u góry ekranu 

(Rysunek 3): 

 

 

 

Rysunek 3 Zamykanie wiadomości o formacie PDF/A (Adobe Reader) 

Jeżeli chcesz zachować tę książkę w oryginalnej postaci, kliknij ikonę (i) z lewej strony (por. Rysunek 3). Jeżeli 

jednak chciałbyś na własne potrzeby zaznaczać jakieś fragmenty i/lub dodawać własne notatki – kliknij przycisk 

Enable Editing po prawej.  

* * * 

 

Możesz wydrukować egzemplarz „Wirtualnego modelarstwa” na użytek własny. Możesz go także nie 

drukować i czytać wprost z ekranu podczas pracy nad modelem. Oszczędzisz w tym przypadku trochę 

tonerów i papieru – zawsze to o skrawek lasu więcej. Co więcej, możesz wtedy korzystać z hipertek-

stowych odsyłaczy i widzieć ilustracje w pełnym kolorze. 

 
 Oczywiście, jeżeli wolisz częste kartkowanie prawdziwego papieru – drukuj całość2. Nawet jeżeli Twoja drukar-

ka obsługuje wydruk dwustronny, przygotuj dwie ryzy formatu A4 i nowy toner, aby wydrukować pełne wydanie 

(cztery tomy) tej książki! Zapewniam, że nie było to moim celem. 

* * * 

 

 

1 Zawsze można użyć skrótów klawiszowych (Wstecz: Alt  -  , Dalej: Alt  - → ) , ale jakoś raźniej jest mieć te przyciski „pod ręką”. 

2 Nie chciałem w tej elektronicznej książce rezygnować z kolorowych ilustracji. W związku z tym wiele z nich na wydruku wydaje się być 

mało kontrastowa. Aby temu w jakimś stopniu zaradzić, na niektórych ilustracjach zmieniałem kolory odnośników (na ciemniejsze lub ja-

śniejsze). Dzięki temu na wydruku są w miarę czytelne. 

Kliknij tu, by ukryć tę wiado-
mość i pozostawić książkę w 
trybie „tylko do odczytu” 

Kliknij tutaj, jeżeli chcesz 
dodawać swoje własne 
komentarze i zaznaczenia 
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Oczywiście, możesz czytać tę książkę na tablecie, szczególnie jakimś większym. Dla urządzeń z systemem 

Android polecam także Adobe Reader (Rysunek 4): 

                   

Rysunek 4 Zawartość książki w systemie Android (Adobe Reader wersja mobilna) 

W stosunku do wersji z komputerów PC (pokazanej na poprzednich stronach), ten Adobe Reader ma uprosz-

czony interfejs użytkownika (Rysunek 5):  

 
 

 

Rysunek 5 Interfejs użytkownika programu Adobe Reader (Android) 

Na szczęście nadal można tu ustawić ciągłe wyświetlanie stron (opcja Continuous, por. Rysunek 5). To przyda-

je się szczególnie dla mniejszych ekranów! 

Naciskanie środka 
ekranu przełącza 
widoczność pa-
sków narzędzi 

Suwak stron 

Układ 

stron 

Struktura 
książki 
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W mobilnym wariancie Adobe Acrobat Reader także możesz korzystać z linków. Niestety, na ekranach doty-

kowych nie ma kursora, który by się zmieniał ponad takim odsyłaczem. Wystarczy jednak pamiętać, że każdy 

numer strony, ilustracji lub rozdziału zawiera odpowiedni link. Po prostu naciśnij odpowiedni tekst (Rysunek 6): 

 

 

 

Rysunek 6 Korzystanie z hipertekstowych odsyłaczy 

Aby powrócić z takiego „skoku” w poprzednie położenie w tekście książki, skorzystaj z przycisku „<”, który poja-

wi się z prawej (przy numerze strony – Rysunek 7): 

     

 

 

Rysunek 7 Powrót do poprzedniego miejsca (Android) 

Naciśnij na 

numer strony… 

… i to ją 
otworzy! 

… a znajdziesz się z powro-
tem na stronie, z której 
wywołałeś ten link, 

Naciśnij 
suwak… 

Page selection dialog: 

…potem naciśnij 
tę pozycję… 
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Rysunek 7 pokazuje okno wyboru strony, otwierane po naciśnięciu suwaka. Naciśnij w nim pozycję Go to last 

viewed, a wrócisz do tekstu głównego. (Mówiąc szczerze, wersja Adobe Acrobat Reader dla systemu Android 

sprzed kilku lat była wygodniejsza: miała przycisk Wstecz obok numeru aktualnej strony). 

Adobe Acrobat Reader ma także swój wariant dla systemu iOS. Niestety, w jego oknie wyboru strony brakuje 

kluczowej pozycji „Go to last viewed” (Rysunek 8): 

 

Rysunek 8 Okno wyboru strony w Adobe Reader dla iOS 

Dlatego jestem zmuszony zarekomendować dla iOS inny program: GoodReader. Ta płatna aplikacja (aktualnie 

dostępna w AppStore za 27zł) to doskonałe narzędzie do czytania na IPadzie (Rysunek 9): 

    

Rysunek 9 GoodReader dla iOS 

Poza samym czytaniem, GoodReader jest wygodnym narzędziem do zarządzania plikami książek na tablecie i 

w chmurze. Zawiera nawet własną przeglądarkę do obsługi umieszczonych w tekście odsyłaczy do Internetu. 

Naciśnij suwak by otwo-
rzyć okno wyboru strony… 

… lecz nie ma w nim pozycji 
Go to last viewed, którą używa-
liśmy w systemie Android! 
 

Naciśnij, by przełączyć przyborniki 

Zarządzaj 
książkami 

Komentuj i zaznaczaj 
fragmenty tekstu 

Nawigacja po 
stronach i inne 
kontrolki 

https://www.goodreader.com/
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U dołu ekranu znajdziesz w nim w tak przydatny przycisk Wstecz, ale także wiele innych „gadżetów”, jak np. 

pasek wyboru stron (Rysunek 10): 

 

Rysunek 10 GoodReader dla iOS 

Oprócz przycisku Wstecz, który pozwala na powrót z połączonej strony, GoodReader potrafi także zaznaczyć w 

tekście wszystkie wewnętrzne odsyłacze. Wystarczy tylko włączyć w ustawieniach książki opcję Show link 

bounds (Rysunek 11): 

 

Rysunek 11 GoodReader: kilka przydatnych opcji w ustawieniach książki 

Osobiście jednak, tak jak napisałem na początku tej sekcji, wolę czytać tekst bez takich oznaczeń. 

 

Struktura 
książki 

Przycisk 
Wstecz 

Wyszuki-
wanie 

Ustawienia 
książki 

Pasek 
przewijania 

Ta opcja rysuje 
niebieskie ramki 

wokół odsyłaczy 

Tutaj można także wyłączyć własną 
przeglądarkę Internetu GoodReader 
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Przygotowanie „warsztatu pracy” dla tego projektu 

Po pierwsze, potrzebujesz komputer. Nie musi być to nowa maszyna, ale sugeruję nie używać sprzętu sprzed 

więcej niż siedmiu lat.  

(Na komputerach starszych niż siedem lat aktualna wersja Blendera może mieć problemy ze sprzętem). 

 

 

Do obsługi aktualnej wersji Blendera potrzebujesz komputera z 64-bitowym procesorem. (Większość 

współczesnych komputerów ma właśnie taki procesor, więc nie jest to specjalny problem) 

 
 Przypuszczam, że większość czytelników tej książki używa komputera z Windows. Podczas opisu instalacji 

koncentruję się wyłącznie na tym środowisku. Sam go używam na moich komputerach. Nie mam żadnych do-

świadczeń z Linuksem ani z Mac OS, więc nie będę pisał o instalacjach, których nie wykonałem. Jeżeli używasz 

systemów innych niż Windows – poszukaj wskazówek na temat ich instalacji na stronach poszczególnych pro-

gramów. (Adresy tych portali zawiera Rozdział 2. Znajdziesz je na początku każdej z jego sekcji). 
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Rozdział 1. Pobranie materiałów pomocniczych 

 

Pliki towarzyszące tej książce możesz pobrać ze strony: http://samoloty3d.pl/wm4_p.xml. Utrzymuję 

tam ich aktualne wersje1. Uaktualniam je co jakiś czas, aby odpowiadały aktualnej wersji Blendera. 

 
 Następujące pliki są ważną częścią tej książki: 

- source.zip:  zawiera skrypty Pythona, plany P-40B, udostępnione przez producenta fragmenty rysun-

ków technicznych (P-40E) i inne pomocnicze materiały; 

- optional.zip: dodatkowe (opcjonalne) materiały; 

- la5.zip:  zawiera model, który wykorzystuje Rozdział 3;  

- p40.zip:  zawiera historię zmian (pliki *.blend) modelu P-40, oraz kilka obrazów tła, wykorzysta-

nych w tej książce. Każdej sekcji tej książki odpowiada plik ze spakowanego folderu 

history\;  

Rozpakuj wszystkie pobrane pliki *.zip do tego samego folderu. Rysunek 1.1 pokazuje strukturę podkatalogów, 

jaka powstanie po ich rozpakowaniu (pliki nie wymienione powyżej należą do innych części tej publikacji): 

 

 

 

 

 

 

 

 

 

    

 

 

 

 

Rysunek 1.1 Strona, z której możesz pobrać pliki Blendera 

Oczywiście, nazwa mój_folder zależy od Ciebie. 

 

 
1 Na tej stronie znajdziesz także odpowiedzi na najczęstsze pytania zadawane przez Czytelników oraz informacje o zmianach w opisywa-

nym oprogramowaniu, jakie się pojawiły po publikacji tej książki. 

mój folder 

model 

la5 

p40 

history 

optional 

source 

textures 

background 

Zawartość pliku la5.zip 

Zawartość pliku source.zip 

Zawartość pliku optional.zip 

Zawartość pliku textures.zip 

Zawartość plików p40.zip  

Rozpakuj wszystkie pobrane 
pliki w tym folderze. Stworzy to 
odpowiednie podkatalogi: 

http://samoloty3d.pl/wm4_p.xml
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Rozdział 2. Instalacja oprogramowania 

W tym rozdziale omówimy pokrótce instalację oprogramowania, z którego będziemy korzystać. W tym tomie to: 

- Blender: program podstawowy; 

 
To oprogramowanie jest udostępniane w zasadach licencji GPL. Oznacza to m.in., że nie można pobierać za 

nie żadnych opłat. (Oczywiście, jeżeli masz gest, a program Ci się bardzo spodoba, możesz wspomóc twórców 

dotacją – ale na zasadzie zupełnej dobrowolności. Szczegółowy opis, jak to zrobić, znajdziesz na stronie inter-

netowej każdego z tych projektów). 
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2.1 Instalacja Blendera 

Ta książka opisuje Blendera w wersji 3.3. (To bieżąca wersja LTS1 w chwili, gdy piszę te słowa). Program insta-

lacyjny możesz pobrać ze strony Fundacji Blendera: https://www.blender.org/download/ (Rysunek 2.1.1)2:  

 

Rysunek 2.1.1 Pobieranie pliku instalacyjnego Blendera (http://www.blender.org/download/) 

Pod wskazanym adresem znajdziesz skróty do wersji programu skompilowanych dla różnych systemów opera-

cyjnych (Windows, Linux, Max OSX, …).  

Instalacja jest prosta – uruchom pobrany program i przez cały czas wystarczy naciskaj przycisk Next. Pierwsze 

uruchomienie programu może trwać długo, bo Blender wykrywa wtedy dostępny sprzęt. Następnie otwiera się 

okno główne, z „ekranem powitalnym” (Rysunek 2.1.2):  

 

Rysunek 2.1.2 Okno Blendera, przy pierwszym uruchomieniu 

 
1 LTS = Long Term Support. Blender Foundation rocznie publikuje trzy “mniejsze” wersje Blendera (3.4, 3.5, …). Ta jest „preferowana”. 

2 Oczywiście, w przyszłości ten adres może się zmienić. Jeżeli okaże się, że wirtualny katalog /downloads już nie istnieje, zacznij od strony 

głównej tego portalu: https://blender.org.   

Kliknij tutaj, by pobrać plik 
instalacyjny (*.msi) naj-
nowszej wersji Blendera Przypuszczam, że ta strona odczytuje 

z przeglądarki standardowe informa-
cje o systemie użytkownika, aby za-
proponować właściwą wersje pliku 
instalacyjnego 

Na wszelki wypadek: tu 
możesz znaleźć wszyst-
kie wcześniejsze wersje 
Blendera 

W każdej wersji jest 
wyświetlana inna praca, 
wykonana w całości w 
Blenderze.  

Jeżeli wolisz Blender 3.3, 
znajdziesz go tutaj 

Na ilustracjach w tej sekcji 
używam Blender 2.83. (Proces 
jest taki sam jak w później-
szych wersjach) 

https://www.blender.org/download/
http://www.blender.org/download/
https://blender.org/
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Na ekranie powitalnym wybierz polecenie Tools1 jako polecenie przypisane do klawisza spacji, tak jak to poka-

zuje Rysunek 2.1.3. (To ustawienie, którego będę używać w tej książce): 

 

Rysunek 2.1.3 Okno powitalne (splash screen) wyświetlane przy pierwszym uruchomieniu nowej wersji Blendera 

Pozostawiam ten program w motywie Blender Dark (tak, jak jest ustawiony domyślnie w polu Theme)2. Gdy już 

jesteś gotowy, kliknij przycisk Next aby przejść na następny ekran (Rysunek 2.1.4): 

  

Rysunek 2.1.4 Drugie okno powitalne  

To okno ma podobny układ jak „codzienny” ekran powitalny, wyświetlany podczas kolejnych wywołań programu. 

 
1 Jeżeli przeoczysz ten ekran – nie szkodzi, możesz to zmienić później w Edit→Preferences→Keymap 

2 Zawsze możesz go zmienić później, w Edit→Preferences→Themes 

Przypisz do spacji 
polecenie Tools  

Kliknij Next by 
kontynuować 

Tutaj możesz wybrać jeden 
z predefiniowanych moty-
wów barw okien Blendera 

Przy każdym następnym 
uruchomieniu w tym 
miejscu znajdzie się lista 
ostatnio otwieranych 
plików 
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Po zainstalowaniu nowej wersji, Blender na pierwszym ekranie powitalnym zaproponuje import ustawień z wer-

sji poprzedniej (Rysunek 2.1.5). Nie przeocz tego momentu i kliknij przycisk Load X.xx Settings: 

 

Rysunek 2.1.5 Pierwsze okno powitalne, po aktualizacji Blendera do nowej wersji 

 

Na swoim komputerze możesz równocześnie używać wielu różnych wersji Blendera. (Jest to możliwe, 

gdyż program instalacyjny domyślnie proponuje każdej wersji w innym katalogu).   

 
  

 
Jak mogłeś zauważyć na ilustracjach powyżej, okna Blendera są bardzo ciemne, z niewielkimi, niemal mono-

chromatycznymi ikonami. Oczywiście, w Edit→Preferences:Themes możesz znaleźć kilka jaśniejszych moty-

wów. Przypuszczam jednak, że większość Czytelników tej książki będzie używać Blendera w tym motywie do-

myślnym. Dlatego, choć nie jestem specjalnym zwolennikiem ciemnych barw w interfejsie użytkownika, ja także 

będę go używać w tej książce1. 

 

Szczegółowy opis tej instalacji znajdziesz na str. 417. 

 
1 Jaśniejsze motywy lepiej wychodzą na wydrukach – w ustawieniach Blender jest nawet kontrastowy, biało-czarny motyw stworzony spe-

cjalnie w tym celu. Teoretycznie, jaśniejsze ilustracje w publikacji elektronicznej są także bardziej czytelne. Jednak po kilku eksperymentach 

stwierdziłem, że znacząca różnica w barwach interfejsu użytkownika może być poważną przeszkodą w porównywaniu Twojego ekranu z 

obrazkiem w tej książce. 

 

Do poprawnego działania Blender nie potrzebuje żadnej instalacji Pythona. (Możesz o niej napotkać w 

wzmianki w Internecie). Interpreter Pythona był opcjonalnym dodatkiem do jego wcześniejszych wersji 

– np. 2.4. Blender od wersji 2.5 korzysta z własnej, wbudowanej instancji Pythona. Jest ona używana 

np. w obsłudze interfejsu użytkownika (wszystkich okienek, przycisków, i menu programu). 

Kliknij ten przycisk, aby 
przenieść ustawienia z 
poprzedniej wersji programu 
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Formowanie modelu 

W tej części opiszę, jak zbudować trójwymiarowy model P-40B. Zacznę od wprowadzenia do naszego podsta-

wowego narzędzia: Blendera. To wprowadzenie jest przeznaczone dla tych, którzy jeszcze nie znają tego pro-

gramu. Następnie opiszę formowanie wszystkich głównych zespołów samolotu: skrzydeł, kadłuba, usterzenia, 

owiewek podwozia. Pozostałe szczegóły, jak samo podwozie czy wnętrze kokpitu, zostaną opisane później (w 

ostatniej części, o szczegółach). 

Do budowy modelu, ta książka wykorzystuje rysunki P-40B opracowane przez Jumpei Temmę. Dodatkowo bę-

dę wspomagał się moimi własnymi szkicami (alternatywnego widoku z boku, przekrojów kadłuba, profili NACA, 

łopaty śmigła) oraz pewnymi materiałami z p40warhawk.com (oryginalne rysunki szkieletu skrzydła, szczegółów 

lotki). Znajdziesz je w danych, które towarzyszą tej książce. Używałem tu także oryginalnej dokumentacji opu-

blikowanej przez AirCorps Library, ale te materiały nie są niezbędne, ponieważ przeniosłem ich wszystkie klu-

czowe wymiary do tekstu tego poradnika. 

Nazwa każdego pliku *.blend z archiwum p40.zip zawiera przedrostek P40B- i etykietę kolejnej sekcji (numero-

wane tak, jak występują w pełnej, czterotomowej edycji tej książki). Na przykład, plik zawierający rezultat pierw-

szej sekcji następnego rozdziału (4.1) nosi nazwę P40B-8.01.blend. Rezultat kolejnej sekcji (4.2) jest zapisany 

w pliku P40B-8.02.blend, i tak dalej.   

 

Spośród danych, które towarzyszą tej książce, do formowania modelu będziesz potrzebował pliku 

source.zip z rysunkami. W drugim pliku, o nazwie p40.zip, znajdziesz pliki *.blend z rezultatami po-

szczególnych sekcji (Rozdział 4 - Rozdział 9). Gdy rozpakujesz zawartość tego archiwum, te pliki zo-

staną umieszczone w model\p40\history. Link do strony z tymi plikami znajduje się na str. 19. 

  

http://soyuyo.main.jp/p40b/p40be-1.html
http://www.p40warhawk.com/Models/Technical/Technical.htm
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Rozdział 3. Blender – pierwsze kroki 

W tym rozdziale zapoznasz się z Blenderem1. Opisuję tu interfejs użytkownika, nawigację w przestrzeni sceny i 

manipulowanie obiektami. Sugeruję tu także kilku najbardziej potrzebnych skrótów klawiatury. 

 

Aby gdzieś dojść, trzeba wykonać pierwszy krok. Niektórzy mówią, że ten pierwszy jest najtrudniejszy. Na fo-

rach internetowych często czytuję głosy „chciałbym się pobawić Blenderem, ale przy pierwszej próbie dałem 

sobie spokój”. Ja też chciałem się nim pobawić. I szybko się wciągnąłem.  

Myślę, że mit o tym, że jest to program trudny, wyolbrzymiają ci, którzy chcieliby się nauczyć wszystkiego od 

razu. Moi drodzy, tak się nie da. Czasami trzeba ciężko westchnąć i siąść, i przeczytać.2 Na razie nie wymyślo-

no takich pigułek, jak w Matrix-ie – aby połknąć całą książkę i od razu wiedzieć wszystko. Dokonywałem kiedyś 

studiów porównawczych interfejsu użytkownika różnych systemów 3D. Mogę uczciwie powiedzieć, że Blender 

ma naprawdę fajny, spójny interfejs. Tyle, że trochę niekonwencjonalny. Zresztą w wersji 2.5 został przepisany 

od nowa, przez co stał się łatwiejszy. W dalszych sekcjach powolutku wyjaśnię, jakie są te konwencje ekranów 

Blendera. Gdy je poznasz, przekonasz się, że jest to nie tak trudna do opanowania całość. Wyrabia dobre na-

wyki – pracy z komputerem „na dwie ręce” (lewa na klawiaturze, prawa na myszce).   

 

Większość tej nauki przeprowadzimy na modelu myśliwca Ła-5. Otworzysz ten plik, obejrzysz jego zawartość, 

nauczysz się podstawowych metod edycji (transformacji) obiektów. Zrobimy to, przestawiając i obracając kame-

rę tej sceny. (Tak! Podobnie jak w prawdziwym studio fotograficznym, mamy tu kamery!). W sumie – po prze-

czytaniu tego rozdziału będziesz już umiał „pozować” model. Na koniec rozdziału wygenerujesz finalną scenę z 

tym samolotem. (O takim obrazie będę często mówił, że jest wyrenderowany3). 

 
1 Ten rozdział zawiera szczegółowe instrukcje, jak używać Blendera. Złamałem tu zasadę, przyjętą w tej książce (w pierwszej części książki 

opisuję, co należy zrobić, a w drugiej – „Szczegóły obsługi …” – jak ). Zrobiłem to, ponieważ prezentowany tu materiał jest podstawą do 

dalszej pracy.  

2 Kiedyś prowadziłem test ze znajomości oprogramowania biurowego. Każdy z uczestników najpierw deklarował, na ile zna np. obsługę 

edytora tekstu. Nikt w tej ocenie nie schodził poniżej 80%. Potem otrzymywał zadanie adekwatne do deklarowanej wiedzy. Nieliczni wyka-

zali się znajomością funkcji programu lepszą niż 50%. Dlaczego więc takie programy uchodzą za łatwe do nauki? Bo setki, o ile nie tysiące 

programistów przez dekadę szlifowało ich interfejs użytkownika. To „szlifowanie” miało na celu osiągnięcie dość specyficznego profilu nauki. 

Absolutnie podstawowe czynności musiały być tak łatwe do wykonania, aby mogły je opanować zupełnie początkujący pracownik biura. (W 

większości przypadków niespecjalnie lotny w sprawach komputerowych). Pozostałe funkcje – to już domena nielicznych wtajemniczonych. 

Tych, którym chciało się zagłębić w tak ezoteryczne i trudne do zrozumienia dzieła, jak samouczki z serii „dla opornych”. Profil nauki Blen-

dera jest inny – równo pod górkę, bez nadmiernych ułatwień na wstępie. Nie ma tu jednak wielkiej przepaści pomiędzy pierwszym krokiem, 

a następnymi. 

3 Operację generowania ostatecznego obrazu polega w Blenderze na naciśnięciu „bardzo ważnego przycisku” o angielskiej nazwie Render. 

Potem się czeka na wytworzenie ostatecznego rezultatu. Program dokonuje w tym czasie mnóstwa obliczeń – m.in. odblasków i cieni, więc 

to może trwać dłuższą chwilę. Ten proces będę nazywał renderowaniem, i odmieniał zgodnie z regułami polskiej gramatyki. Wiem, że było 

wiele prób znalezienia dla tej operacji polskiego określenia, ale jakoś żadna się nie przyjęła. Skoro już w naszej historii znieśliśmy przejścia 

interface→interfejs, czy manager→menedżer, to czas przywitać „renderowanie” w słowniku potocznej polszczyzny! 

 

W tym rozdziale będziemy wykorzystywać materiały z plików source.zip i la5.zip, towarzyszących tej 

książce (adres, z którego można je pobrać, znajdziesz na. str. 19). 
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3.1 Układ ekranu 

Rysunek 3.1.1 pokazuje, jak wygląda Twój ekran, gdy po raz pierwszy uruchomisz Blender: 

 

Rysunek 3.1.1 Blender – domyślny wygląd programu   

Nie wygląda jak typowa aplikacja Windows, prawda? Przyznam się: gdy miałem zacząć pracować z tą przepi-

saną od nowa wersją 2.5, to po pierwszym uruchomieniu przez 15 minut siedziałem i po prostu gapiłem się w 

ekran. Tak wszystko na nim „przemeblowano”, że był dla mnie zupełnie nowy! Nie ruszałem nawet myszką – nie 

byłem pewien, jak zacząć. Stało się tak, choć przez cztery lata pracowałem w kolejnych wersjach Blendera 2.4, 

i wcześniej nawet trochę zaglądałem do wersji testowych 2.5. Jednak po tych pierwszych 15 minutach kontem-

placji zacząłem od powtórki najprostszych czynności, zajrzenia do kilku samouczków – i jakoś poszło. Mam 

nadzieję, że pamięć o tym „drugim początku” pomoże mi lepiej napisać to wprowadzenie. 

 
Rozmieszczenie elementów na ekranie Blendera 2.5 lepiej pasuje do nowszych monitorów o proporcji 8x5. (Po-

przednie wersje dobrze pasowały do monitorów o starych proporcjach – 4x3). Blender jest napisany dla kilku 

systemów operacyjnych: Linux, Mac OS, Windows. W każdym z nich wygląda i działa w identyczny sposób1. 

Siłą rzeczy ten program ma specyficzny styl, który go wyróżnia. Jest to przemyślany interfejs użytkownika. Za-

cznijmy od omówienia jego podstawowych założeń. 

 
1 Jak osiągnięto taką zgodność? Otóż w każdym z tych systemów jest dostępny pewien zestaw procedur, które mogą być użyte przez pro-

gramy do tworzenia realistycznych, trójwymiarowych obrazów. Taki zestaw programiści nazywają „biblioteką”. Biblioteki te są implementacją 

standardu, noszącego nazwę OpenGL. OpenGL został opracowany na początku lat dziewięćdziesiątych, początkowo dla stacji graficznych 

Silicon Graphics. Wtedy to były prawdziwe „rakiety” ze sprzętowymi akceleratorami grafiki – obiekt westchnień wszelkich fanów grafiki 

komputerowej, o odpowiednio wysokiej cenie. (Przodek Blendera – program Traces – był napisany dla takich stacji). Niedługo potem za-

mieniony w standard OpenGL zaczął być wykorzystywany w wielu aplikacjach CAD, CAM, GIS, ...  

W połowie lat dziewięćdziesiątych umieszczono go nawet w systemie Windows. (Mimo że ich producent – Microsoft – już w tym czasie 

promował konkurencyjny produkt w postaci biblioteki DirectX). Blender „od zawsze” wykorzystywał do rysowania zawartości swoich scen 

właśnie OpenGL. Co ciekawe, jego twórcy wpadli w pewnym momencie na pomysł, aby tych samych poleceń, za pomocą których tworzyli 

trójwymiarowe modele, użyć także do rysowania w dwóch wymiarach. W efekcie cały interfejs użytkownika Blender jest rysowany za pomo-

cą OpenGL. Dzięki temu większa część kodu nie zależy od zastosowanego systemu operacyjnego. Przy okazji uzyskano stosunkowo 

niewielki rozmiar programu (nie musi korzystać z rozbudowanych, standardowych bibliotek „okienek”, takich jak wxWidgets, Qt, albo GTK+). 

Innym ciekawym rezultatem takiego rysowania „wektorowego” jest możliwość płynnej zmiany rozmiaru elementów interfejsu użytkownika. 
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Ekran Blender dzieli się na pasek górny (topbar), pasek dolny (status bar) i umieszczoną pomiędzy nimi prze-

strzeń roboczą. Przestrzeń ta jest wypełniona prostokątnymi obszarami (area), określanymi także jako „okna”. 

Rysunek 3.1.2 zaznacza paski górny i dolny na brązowo, a przestrzeń roboczą – na niebiesko:  

 

Rysunek 3.1.2 Blender – obszary okien   

Okna Blendera nie nakładają się na siebie. Myślę, że to zaleta. Klasyczne nakładające się okna (a la Windows) 

wyglądają dobrze wyłącznie na reklamach. Gdy podczas pracy używasz naraz dwóch lub więcej okien, zawsze 

starasz się ustawić je obok siebie.   

Na ekranie, który pokazuje Rysunek 3.1.2, widać cztery obszary (okna). Są to:  

- Okno widoku (3D Viewport): pokazuje trójwymiarową „scenę”, a w niej – model (tutaj: sześcian); 

- Okno struktury (Outliner): struktura sceny, przedstawiona w postaci symbolicznej; 

- Okno właściwości (Properties) wybranego elementu sceny: wszelkie przełączniki, pola numeryczne; 

- Okno osi czasu (Timeline): potrzebne do animacji; 

Granicę każdego z okien Blendera można „złapać” myszką i przesunąć (Rysunek 3.1.3): 

        
 

Rysunek 3.1.3 Przesuwanie granic okien Blendera 

 

Zauważyłem, że samouczkach Blendera poszczególne okna są określane także jako „edytory”. W 

praktyce to jedno i to samo, bo każdy obszar/okno jest wypełniony przez jakiś „edytor”. Ściśle rzecz 

biorąc, lista powyżej wylicza nie tyle typy okien, co rodzaje „edytorów”. Wyjaśnię to za chwilę.  

  

3D Viewport  

Properties 

Outliner  

 

Topbar 

 

Status bar 

 

Timeline 

Status bar 

Topbar 

…i przeciągnij rankę okna. 
Następnie zwolnij LPM . 

Naciśnij teraz 

LPM  … 

a) b) 

Kursor myszki zmienia 
kształt ponad granicą 
okna… 
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Usuńmy z ekranu niepotrzebne nam obecnie okno Timeline. Można je wyeliminować, łącząc z jednym z sąsied-

nich obszarów. Umieść kursor na krawędzi okna, która ma zniknąć, i naciśnij PPM . Spowoduje to otwarcie menu 

Area Options, z którego wybieramy polecenie Join Areas  (Rysunek 3.1.4a): 

 

 

 

 

Rysunek 3.1.4 Scalanie okien na ekranie Blendera 

Po wybraniu tego polecenia Blender rysuje ramkę wokół scalanych obszarów oraz zmienia kursor myszki w 

strzałkę wskazującą obszar, który podczas łączenia zniknie (Rysunek 3.1.4b).  

Kliknięcie LPM  kończy operację – powinieneś uzyskać taki ekran, jaki pokazuje Rysunek 3.1.5: 

 

Rysunek 3.1.5 Ekran po scaleniu okna Timeline z oknem 3D View 

 

Okno Blendera, znajdujące się pod kursorem myszy, nazywamy oknem aktywnym. Jest ono wyróż-

nione spośród innych okien odrobinę jaśniejszym nagłówkiem i tłem.  

  

 

Możesz przerwać łączenie okien naciskając Esc . (W Blenderze naciśnięcie tego klawisza zawsze 

oznacza rezygnację z aktualnie wykonywanego polecenia).  

a) 

b) 

Kliknij PPM  na ramce 

okna, aby otworzyć menu 
Area Options … 

… wybierz 
polecenie 

Join Areas … 

… i kliknij LPM  na 

usuwanym obszarze. 

Blender zaznacza ramką 
łączone obszary 

Kursor myszki zmienia się w kształt 
wskazujący obszar, który zniknie  

Tu było okno Timeline 
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Analogicznie, do podziału okna możesz użyć polecenia Area Options→Horizontal Split lub Vertical Split. 

Można to także zrobić w inny sposób – przeciągając lewy górny lub prawy dolny narożnik okna (Rysunek 3.1.6): 

 

      

Rysunek 3.1.6 Podział okna Blendera za pomocą uchwytu 

Na przykład: „złap” myszką (LPM) za prawy dolny narożnik okna i przesuń ją w pionowo w kierunku środka ob-

szaru. W odpowiedzi na taki gestu Blender dzieli okno poziomo (Rysunek 3.1.6). Zobaczysz nagle, że ciągniesz 

górną krawędź nowego okna. Gdy przesuniesz kursor z rogu w kierunku zbliżonym do poziomego – podzielisz 

okno w pionie. 

 
Uchwyt może także służyć do łączenia sąsiadujących okien. Wystarczy przeciągnąć kursor myszki z lewego 

górnego lub prawego dolnego narożnika na obszar, który ma zniknąć (Rysunek 3.1.7): 

 

Rysunek 3.1.7 Łączenie okien za pomocą uchwytu 

Blender zaznacza takie okno odpowiednią strzałką (Rysunek 3.1.7). Wystarczy zwolnić LPM , by wskazane okno 

uległo scaleniu. 

 

Nowe okno, uzyskane w wyniku podziału, jest zawsze dokładną kopią okna dzielonego.  

Naciśnij LPM  na 

tym narożniku… Nowe okno 

Ponad „aktywnym” narożni-
kiem kursor myszki zmienia 
się w krzyżyk  

 

…I przeciągnij kursor 

trzymając wciśnięty LPM . 

Naciśnij LPM  w narożniku i 

trzymając wciśnięty prze-
ciągnij kursor ponad okno, 
które ma zniknąć 

Gdy przeciągasz 
kursor, Blender 

obramowuje ramką 
łączone okna 
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W ramach ćwiczenia spróbuj za pomocą podziałów uzyskać taki układ ekranu, jaki pokazuje Rysunek 3.1.8: 

 

Rysunek 3.1.8 Zmieniony układ okien Blendera 

Zajmijmy się teraz podstawowymi elementami wnętrza pojedynczego okna (Rysunek 3.1.9): 

 

 

 

Rysunek 3.1.9 Elementy okna Blendera 

Każde okno Blendera ma nagłówek (header). Na ilustracji umieszczony jest u góry, ale możesz przełączyć na 

dół okna. Jeden z wierszy nagłówka zawiera menu rozwijalne i inne pomocnicze kontrolki, podczas gdy drugi – 

rozwijalną listę z wyboru typu edytora i opcje aktualnego narzędzia. 

Otwiera przybornik 
(por. str. 31) 

 

Obszar 

roboczy 
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a
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Nagłówek 

Wybór aktualnego edytora 

Menu 

rozwijalne 
Tryb 
edytora 

Opcje aktual-

nego widoku   

Opcje aktualnego narzędzia 
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Z lewej strony nagłówka okna znajduje się lista rozwijalna, z której można wybrać rodzaj edytora. Wybierasz z 

niej to, co ma być wyświetlone w oknie. Na przykład – struktura sceny w edytorze Outliner (Rysunek 3.1.10):  

 

 

Rysunek 3.1.10 Zmiana typu (zawartości) okna 

Kilka typów edytorów Blendera (3D Viewport, UV/Image Editor, Text Editor) ma także pasek narzędzi (Toolbar), 

umieszczony z lewej strony okna. Można go przywołać poleceniem menu (View→Toolbar), ale o wiele łatwiej 

jest po prostu nacisnąć na klawiaturze przycisk T  (Rysunek 3.1.11): 

 

                         

Rysunek 3.1.11 Ukrywanie i wysuwanie przybornika z narzędziami (Tool Shelf) za pomocą klawiatury 

Podobnie możesz wyświetlać/chować umieszczony z prawej strony przybornik (Sidebar), zawierający wybrane 

właściwości obiektu lub narzędzia. Zastosuj tu klawisz N , lub polecenie z menu View (Rysunek 3.1.12): 

 

       

Rysunek 3.1.12 Przybornik – różne metody wyświetlenia i ukrycia. 

Outliner 

(struktura sceny) 

Z listy edytorów 
wybierz Outliner 

Naciśnij T  

Aby wyświetlić pasek narzędzi 
także kliknąć w ten uchwyt 

Można go włączać 
i wyłączyć w menu 
View. 

Można także użyć 

klawisza N . Przybornik 
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Gdy kursor myszki znajduje się ponad nagłówkiem okna, kliknięcie w PPM  otwiera menu kontekstowe. W zależ-

ności od tego w co kliknąłeś, Blender otworzy mniejsze lub większe menu (Rysunek 3.1.13): 

 

 

 

                                                                                                                                 
 

Rysunek 3.1.13 Różne menu kontekstowe kontrolek Blendera  

Najwięcej poleceń znajduje się na menu kontekstowym kontrolki (Rysunek 3.1.13c). Polecenie Reset to Default 

Value może być czasami przydatne, gdy nie wiesz jaka jest ta wartość domyślna. Polecenie Online Manual 

otwiera odpowiedni fragment instrukcji Blendera (artykuł z wiki.blender.org), o ile oczywiście masz w tym mo-

mencie dostęp do Internetu. Polecenia Edit Source i Edit Translation są przydatne tylko dla programistów lub 

tłumaczy programu. Krótsza wersja tego menu (Rysunek 3.1.13a) pojawi się, gdy klikniesz PPM  w jedno z menu 

rozwijalnych. Jest jeszcze menu Header, sterujące widocznością i położeniem nagłówka okna (Rysunek 

3.1.13b). Menu Header można także otworzyć z menu a) i c). 

Polecenia z menu Header są przydatne przy modyfikowaniu układu ekranu. Jeżeli wywołasz polecenie 

Header→Flip to Bottom, nagłówek okna zostanie wyświetlony u dołu okna (Rysunek 3.1.14): 

     

Rysunek 3.1.14 Przesunięcie nagłówka na dół okna 

Po przeniesieniu nagłówka do dołu okna Blender zmienia jego menu Header. Zastępuje w nim polecenie Flip to 

Bottom poleceniem Flip to Top. Gdy je wywołasz, nagłówek znajdzie się z powrotem na górze. 

b) a) c) 

Kliknięcie PPM  

otwiera kontekst 
menu rozwijalnego 

Kliknięcie PPM  pomię-

dzy kontrolkami otwiera 
menu nagłówka 

Kliknięcie PPM  

w kontrolkę 
otwiera jej menu 

Do menu nagłówka można przejść 
także z innych menu kontekstowych 

Z menu Header 
wybierz polecenie 

Flip to Bottom 
 

To przeniesie nagłówek 
z górnej na dolną kra-
wędź okna. 

http://wiki.blender.org/
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W menu Header znajduje się także przełącznik Show Menus. Gdy go wyłączysz, menu rozwijalne zostanie 

„ściśnięte” (Rysunek 3.1.15). Może to być przydatne dla węższych okien:  

 

       

 

Rysunek 3.1.15 „Zwijanie” menu okna 

Kolejne polecenie z menu Header – Maximize Area – służy do rozciągnięcia aktywnego okna na cały ekran 

Blendera. Wygodniej jest jednak to zrobić za pomocą skrótu klawiatury: Ctrl - Spacja  (Rysunek 3.1.16): 

  

Rysunek 3.1.16 Przełączanie rozmiaru okna: na cały ekran i z powrotem  

Operację odwrotną – zmniejszenie okna do oryginalnego miejsca na ekranie – uzyskasz używając tego samego 

skrótu albo wywołując polecenie Header→Tile Area (ale po co tyle klikać?). 

 
Zwróć uwagę, że do tej pory poznaliśmy trzy skróty klawiaturowe Blendera: T , N , i Ctrl - Spacja . Każdemu z 

nich podałem także odpowiednie polecenie z menu. Która droga wywołania jest lepsza: wybór z menu czy skrót 

z klawiatury? Skróty są oczywiście szybsze. Jednak nie warto uczyć się każdego z nich, bo każda ludzka głowa 

ma skończoną pojemność. (Wiele poradników Blendera koncentruje się właśnie na skrótach. Sądzę, że przez to 

właśnie program ma opinię trudnego do opanowania). Rzadziej używane polecenia łatwiej jest wybierać z me-

nu. (Bo wystarczy wtedy pamiętać "mniej więcej", gdzie to polecenie się znajduje). Gdy zauważysz, że niektó-

rych komend używasz bardzo często – zwróć uwagę na prawą stronę ich menu. Jeżeli polecenie ma swój skrót 

klawiaturowy – jest tam wyświetlany. Opisując ten program, zawsze będę się starał określić, gdzie i w jakim 

menu jest dostępne omawiane polecenie. W przypadku częściej używanych operacji podam także ich skróty1. 

 
1 Gorąco polecam wprawianie się w stosowaniu skrótów. Pamiętam, że w jakimś podręczniku o projektowaniu interfejsów użytkownika autor 

narzekał, że dzisiejsze rozwiązania są projektowane dla „Napoleonów”. Dlaczego tak to nazwał? Pamiętacie może ulubioną postawę tego 

człowieka? Jedną ręką coś robi – pokazuje, grozi, pisze. (Tak był utrwalany na dziesiątkach obrazów). A druga? Tkwi bezczynnie zatknięta 

za płaszcz. Zbyt często interfejs programów komputerowych jest projektowany, jak gdyby użytkownik miał tylko jedną rękę – tę, w której 

trzyma myszkę. Druga leży bezczynnie gdzieś z boku. Programiści bardzo często zapominają, że człowiek ma dwie ręce. Jakby tę drugą 

jakoś „zatrudnić”, to robota poszłaby o wiele sprawniej. Na przykład – czy wiecie, jaką wydajność w edycji tekstów ma człowiek, który jedno-

cześnie pisze jedną ręką na klawiaturze, a drugą – zaznacza tekst myszką? Skróty klawiatury Blendera pozwalają osiągnąć podobny efekt 

w modelowaniu. Warto je stosować, aby „grać na obie ręce” z komputerem. Co najmniej warto mieć opanowane skróty stosowane do zmia-

ny bieżącego widoku oraz przy edycji siatek (ta operacja pochłania najwięcej czasu). 

Ale mogą być 
złączone w 
jedno rozwi-
jalne menu  

Domyślnie każde z tych menu jest 
wyświetlanie oddzielnie. 

Można także wybrać 
to polecenie z  menu 
Header 

Możesz przywrócić poprzedni 
rozmiar tego okna przyciskiem 
Back to Previous  Ctrl - Space  

Okna powiększonego nie można 
dzielić – więc w tych narożnikach 
kursor nie zmienia się w krzyżyk 

(por. Rysunek 3.1.6)  
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W Blenderze kilka powiązanych opcji może być pod pojedynczym skrótem klawiatury. Na przykład, gdy kursor 

myszy jest w gdzieś w oknie 3D Viewport naciśnij ,  (przecinek). To otworzy tzw. menu myszki (pie menu): 

 

Rysunek 3.1.17 Przykład menu myszki  

Wybieranie z tego menu myszki może być mniej rozpraszające niż z listy Orientation, umieszczonej w nagłówku 

okna. Menu myszki są bardzo użyteczne dla dostępu do opcji „schowanych” głęboko w menu rozwijalnych.  

W Blenderze masz dostępnych wiele różnych układów ekranu, abyś nie musiał za każdym razem mozolnie 

przestawiać granic okien. Służą do tego zakładki przestrzeni roboczych (workspaces) (Rysunek 3.1.18): 

 

Rysunek 3.1.18 Wybór jednego z zapamiętanych układów ekranu  

To, co zmienialiśmy do tej pory, to układ zapamiętywany pod nazwą Layout. Będziesz go używał przez więk-

szość czasu pracy, choć jest tu także podobny układ o nazwie Modeling. Układy UV Editing i Animation przy-

dadzą się później. Na razie przyjrzyj się oknom każdego z tych zestawów (Rysunek 3.1.19): 

                       

 

 

Rysunek 3.1.19 Inne, predefiniowane układy ekranów: UV Editing i Animation 

Oczywiście, to tylko propozycja autorów programu. Możesz je kompletnie pozmieniać. Ich menu kontekstowe 

(PPM ) pozwala na zmianę kolejności, usunięcie, lub powielenie zakładek Workspaces. Więcej na temat tej kon-

trolki i zarządzania układami ekranów znajdziesz na str. 441. 

Domyślny układ 
nosi nazwę Layout 

Kliknij tutaj, aby dodać kolejny 
układ. W chwili początkowej 
jest to kopia układu obecnego 

Inne predefiniowane 
układy ekranu 

Kliknij dwukrotnie 
(LPM ) na nazwie, 

aby ją zmienić 

Animation 

UV Editing 

Aktualny wybór 
jest zaznaczony 

na niebiesko 

Kliknij (LPM ) w jeden z 

tych elementów mysz-
ka lub naciśnij klawisz 
podany z lewej 

Nazwa kontrolki 
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Edytor konfiguracji programu – Preferences – możesz otworzyć w każdym z jego okien, bo jest dostępny na 

liście, tuż powyżej edytora Outliner (por. str. 31, Rysunek 3.1.10). Ja jednak wolę je wywoływać z poleceniem z 

głównego menu Blendera (Edit→Preferences… – Rysunek 3.1.20): 

          

Rysunek 3.1.20 Wywołanie okna konfiguracji programu  

Po lewej stronie okna Preferences widoczne są sekcje (Interface, Themes, Viewport…). Wybierz z nich jedną, 

tak jak to pokazuje Rysunek 3.1.21: 

 

Rysunek 3.1.21 Okno konfiguracji (Preferences) 

Rysunek 3.1.21 pokazuje zmianę opcji, która będzie potrzebna już w następnej sekcji tego poradnika. Jeżeli 

używasz laptopa, który nie ma klawiatury numerycznej – dodatkowo w sekcji Input zaznacz opcję Emulate 

Numpad. Szczegółowe omówienie, co jeszcze warto przestawić w tej konfiguracji znajdziesz na str. 428. 

Otwiera menu 
tego okna 

Wybierz 
sekcję 

Navigation  

Niektóre obszary są domyślnie 
zwinięte (kliknij LPM  by rozwinąć) 

Zaznacz 
te opcje 
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W oknie Preferences nie musisz klikać w żaden przycisk „OK” czy „Accept”. Każda zmiana jest natychmiast 

zastosowana i zapisana. Blender przechowuje konfigurację w specjalnym pliku o nazwie userpref.blend. Ten 

plik znajduje się w specjalnym folderze z konfiguracją Blendera, w katalogu użytkownika.  

 
Gdy zatrzymasz kursor myszki nieco dłużej ponad kontrolką, Blender wyświetla „dymek” z jej opisem (Rysunek 

3.1.22a). Aby się tak się działo, w sekcji Interface musi być włączona opcja Tooltips (Rysunek 3.1.22b): 

      

 

 

Rysunek 3.1.22 Podpowiedzi do każdej kontrolki, widocznej na ekranie  

Najniższa linia podpowiedzi jest zapisana czymś, co nie jest zrozumiałe dla zwykłego użytkownika: to nazwy 

tzw. właściwości klas – rzecz tylko dla programistów! Jeżeli ta informacja nie jest Ci potrzebna, możesz wyłą-

czyć opcję Python Tooltips (Rysunek 3.1.22b), a wtedy dolne linie znikną. 

A swoją drogą – zwróciłeś uwagę, że teraz na monitorze masz dwa ekrany Blendera (Rysunek 3.1.23)?: 

 

 

 

Rysunek 3.1.23 Dwa ekrany Blendera  

Ten drugi ekran (okno w nomenklaturze Windows) ma takie same właściwości jak pierwszy – możesz zmienić w 

nim typ edytora (np. na 3D Viewport). Możesz go także podzielić na kilka mniejszych obszarów.  

 

Więcej informacji na temat tego, jakie ustawienia Blender przechowuje w każdym rysunku, a co tylko 

w pliku konfiguracji, oraz gdzie dokładnie ten plik jest przechowywany, znajdziesz na str. 435.  

a) b) 

Upewnij się, że ta 
opcja jest włączona 

Gdy na chwilę zatrzymasz kursor myszki 
ponad kontrolką, Blender wyświetli jej opis 

Python Tooltips wyświetla dolny wiersz, przeznaczony dla 
programistów. (To wyrażenie API, które odpowiada tej opcji) 

Click here to “pull out” the 
hidden header of this area 

Here you can select 
any other editor type 
for this window!  
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Jeżeli Twój komputer ma dwa monitory, pracujące w trybie tzw. „rozszerzonego pulpitu”1 – możesz na nich roz-

mieścić ekrany Blendera. Każdy z tych ekranów będzie na bieżąco pokazywał ten sam model (Rysunek 3.1.24): 

 

 

 

 

 

 

 

 

 

 

 

 

Rysunek 3.1.24 Jeden z możliwych układów ekranów przy pracy na dwóch monitorach  

W praktyce zwiększa to co najmniej dwukrotnie dostępną przestrzeń ekranu. 

Na koniec tego wprowadzenia wspomnijmy o po-

prawnym zamykaniu programu. Jak każdą aplikację 

Windows, Blender można zakończyć klikając przy-

cisk  w prawym górnym narożniku jego okna. 

Można to także zrobić inaczej: wybierając z menu 

polecenie File→Quit (Rysunek 3.1.25), lub naciska-

jąc na klawiaturze skrót Ctrl - Q . 

W menu File znajduje się także submenu Startup. 

Polecenie Save Startup File z tej sekcji (Rysunek 

3.1.25) zapisuje aktualną scenę jako szablon dla 

nowych plików (tzn. plików tworzonych poleceniem 

File→New).  

A gdybyś już sam nie wiedział, co pozmieniałeś w 

konfiguracji, zawsze możesz skorzystać z polecenia 

„ostatniej szansy”: Load Factory Settings. Przy-

wraca ono domyślne ustawienia programu. 

Zwróć uwagę, że File jest jednym z pięciu głównych 

menu rozwijalnych (Rysunek 3.1.25). Pozostałe to: 

Edit, Render, Window i Help. Są one dostępne 

przez cały czas, niezależnie od tego, jaki edytor jest 

otwarty w obszarze roboczym. Jest to główne menu 

Blendera. Żadna z tych pięciu etykiet nie pojawia się w menu edytorów. Dlatego będę się odwoływał do ich po-

leceń pisząc po prostu o „poleceniu File→Save” lub „poleceniu Edit→Preferences”. Pierwszy segment ich nazw 

jest wskazówką, że znajdziesz je w menu głównym. 

 
1 Większość laptopów ma ten tryb – można do nich podłączyć dodatkowo monitor zewnętrzny 

 

Możesz także otworzyć drugi ekran Blendera w inny sposób: w oknie 3D Viewport otwórz menu 

View→Area i wywołaj polecenie Duplicate Area into New Window.  

 

Rysunek 3.1.25 Polecenia z menu File  

 

Monitor 1 Monitor 2 

To polecenie zapisu-
je aktualny plik jako 
plik startowy  

To polecenie 
zamyka Blender 

Menu główne 
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Podsumowanie 

• Interfejs użytkownika Blendera różni się od typowej aplikacji Windows. Jednak „różny” nie znaczy „gor-

szy”. W wielu przypadkach pozwala na bardziej efektywną pracę, z użyciem obydwu rąk. 

• Ekran Blendera jest podzielony na kilka obszarów (area), nazywanych także oknami. Te obszary nigdy 

się na siebie nie nakładają. Możesz przesuwać ich wspólne granice (por. str. 27). Każdy z nich jest 

zawsze wypełniony przez jakiś edytor. 

• Obszar ekranu Blendera znajdujący się w aktualnej chwili pod kursorem myszki jest nazywany 

aktywnym oknem (por. str. 28). 

• Możesz “rozciągnąć” aktywne okno na cały ekran skrótem Ctrl - Spacja . Użyj tego samego skrótu po-

nownie, aby przywrócić oryginalny układ ekranu (str. 33). 

• Możesz dzielić lub łączyć okna Blendera (w rezultacie łączenia jedno z nich ulega usunięciu). Możesz 

wywołać te polecenia z menu kontekstowego Area Options (str. 28). Ten sam efekt można uzyskać po-

przez przeciąganie narożników tych okien (str. 29). 

• Blender oferuje kilka gotowych układów ekranu, przeznaczonych dla kolejnych faz prac projektowych: 

modelowania, teksturowania i animacji (str. 34). Każdy z nich można zmienić. Możesz także stworzyć 

swoje własne układy ekranów (workspaces). 

• Każdy edytor Blendera ma nagłówek i obszar roboczy. Niektóre z nich mają dodatkowo pasek narzędzi 

i/lub przybornik (str. 30, 31). 

• Pasek narzędzi można “wyciągnąć” i “schować” klawiszem T . W przypadku przybornika służy do tego 

klawisz N . Gdy nie pamiętasz tych skrótów, użyj przełączników z menu View (str. 31). 

• Możesz dowolnie zmieniać typ edytora (zawartość okna). Użyj do tego celu listy rozwijalnej umieszczo-

nej w nagłówku okna (pierwsza od lewej – por str. 31). 

• Możesz otworzyć wiele ekranów Blendera (system operacyjny Twojego komputera traktuje je jako 

osobne okna). Gdy używasz dwóch monitorów w trybie rozszerzonego pulpit, możesz na każdym z nich 

umieścić jedno takie okno (str. 37). To się czasami bardzo przydaje. 

• Użyj polecenia Edit→Preferences aby otworzyć okno zmiany konfiguracji Blendera (str. 35). 

• Blender automatycznie stosuje I zachowuje zmiany, których dokonasz w oknie Preferences (str. 36). Są 

zapisywane w pliku userpref.blend, w Twoim profilu użytkownika. (Więcej na ten temat – por. str. 428). 

• W Blenderze są zawsze dwa rodzaje menu rozwijalnych: menu główne, umieszczone ponad obszarem 

roboczym i menu edytorów, umieszczone w nagłówkach ich okien. Menu główne zawiera ogólne pole-

cenia, niezależne od edytora (str. 37). Nazwy jego pięciu rozwijalnych menu (File, Edit, Render, Window 

i Help) są unikalne, więc łatwo zorientujesz się, że to o nie chodzi, gdy będę o nich pisał w dalszym tek-

ście (jak File→Quit czy Edit→Undo). 

 

 

Kompletny opis interfejsu użytkownika (w języku angielskim) znajduje się w sekcji „Window System” 

podręcznika online Blendera.  

 
  

https://docs.blender.org/manual/en/latest/interface/window_system/introduction.html
https://docs.blender.org/manual/en/latest/interface/window_system/introduction.html
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3.2 Zmiana projekcji w oknie 3D 

Nie sądzisz, że domyślne „pudełko” Blendera jest trochę nudne? Wczytajmy jakiś bardziej interesujący model! 

Rozpakuj z towarzyszącego tej książce archiwum la5.zip (por. str. 19) plik model\la5\la5.blend. Otwórz go pole-

ceniem File→Open (por. str. 423). Rysunek 3.2.1 pokazuje, jak powinien wyglądać rezultat: 

 

Rysunek 3.2.1 Załadowany plik z modelem myśliwca Ła-5F 

Stworzyłem ten model Ła-5F w 2007 r. Pozwoli nam posłużyć się we wprowadzeniu prawdziwą, złożoną sceną. 

Tekstury, widoczne w widoku Camera Perspective, mogą się ładować z kilkominutowym opóźnieniem. 

Zwróć uwagę, że ten model składa się z wielu części (obiektów), pogrupowanych w kolekcje (Rysunek 3.2.2): 

 

Rysunek 3.2.2 Ta sama scena w oknie Outliner i w oknie 3D Viewport 

Kolekcje Blendera to coś w rodzaju warstw z programów rysunkowych 2D. Możesz przełączać ich widoczność 

w oknach 3D klikając w ikonkę „oka”, umieszczoną po prawej stronie nazwy. (Pozostałe ikony omówię później).  

 

Zanim rozpoczniesz tę sekcję, upewnij się, że ustawienia z sekcji Navigation (w oknie 

Edit→Preferences) są takie, jakie pokazuje  Rysunek 3.1.21 na str. 35. 

  

Widok kamery, w 
trybie z teksturami 

Pasek stanu pokazuje 
podpowiedzi o aktualnie 
dostępnych skrótach 

Wersja 
Blendera 

Aktualna 
kolekcja 

Nazwa aktywnego obiektu 

Obiekt aktywny: Sun 

Kolekcje 
obiektów 

Kliknij w “oko”, aby przestawić wi-
doczność we wszystkich oknach 3D 

Viewports 
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Mamy wczytany model, czas pomówić o tym, jak obejrzeć go dokładniej. Zaczniemy od szybkiego powiększenia 

jednego z okien (Rysunek 3.2.3): 

 

Rysunek 3.2.3 Wywołanie powiększenia aktywnego okna 

Pamiętasz z poprzedniej sekcji? Ustaw kursor myszy wewnątrz jednego z okien 3D (Rysunek 3.2.3). Potem 

naciśnij kombinację klawiszy Ctrl - Spacja . Spowoduje to rozciągnięcie aktywnego okna na cały ekran Blendera. 

Teraz zobaczysz model o wiele dokładniej (Rysunek 3.2.4): 

 

Rysunek 3.2.4 Powiększone okno aktywne i jego ornamenty (gizmos) nawigacyjne 

Opis w lewym górnym narożniku okna pokazuje nazwę aktualnej projekcji. W tym przypadku nazywa się ona 

Right Orthographic1. Przy prawej krawędzi okna widać ornamenty (gizmos) do nawigacji w przestrzeni 3D. 

 
1 W tym modelu globalna oś Y jest skierowana do ogona, przez co widok „z prawej” Blendera pokazuje lewą stronę samolotu. 

 

Powtórne naciśnięcie Ctrl - Spacja  (lub kliknięcie przycisku Back to Previous z nagłówka) przywraca 

oryginalny rozmiar i pozycję okna, tzn. przywraca układ ekranu jaki pokazuje  Rysunek 3.2.1. 

  

Naciśnij Ctrl - Spacja  

w tym oknie 

Kliknij ten przycisk by 
pomniejszyć okno   

Ornamenty 
nawigacyjne 

Nazwa 
aktualnej 
projekcji 
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Na początku, przesuńmy ten ekran. Aby to zrobić, „złap” (LPM) ornament "dłoni" i przeciągnij mysz trzymając 

wciśnięty jej przycisk. To przesuwa ekran po płaszczyźnie prostopadłej do aktualnej projekcji (Rysunek 3.2.5):   

 

Rysunek 3.2.5 Przesuwanie ekranu 

Aby zakończyć tę operację, zwolnij przycisk myszy. Możesz to samo zrobić także w inny sposób: trzymając 

wciśnięty Shift , przeciągnij myszkę z wciśniętym SPM  (KM). Ponieważ ornamenty nawigacyjne pojawiły się za-

ledwie kilka lat temu, wielu „starych wyjadaczy” nadal używa Shift -SPM  do przesuwania okna 3D1. 

Podobnie, aby zmniejszyć/powiększyć widok, „złap” LPM  ornament „szkła powiększającego”  (Rysunek 3.2.6): 

 

Rysunek 3.2.6 Powiększanie/pomniejszanie  

Widok w ekranie ulega pomniejszeniu, gdy przesuwasz myszkę w dół, a powiększeniu, gdy przesuwasz ją w 

górę. Gdybyś zagubił się w zbyt dużym powiększeniu, naciśnij klawisz Home  (lub polecenie View→Frame All z 

menu). To przestawia aktualne powiększenie tak, aby okno obejmowało wszystkie obiekty sceny. 

 
1 Można jeszcze przenieść ekran do określonego punktu sceny. Służy to tego tzw. kursor 3D (por. str. 154) i polecenie View→Align 

View→Center View to Cursor.  

Złap ten ornament myszką 
(LPM ) i przeciągnij 

Złap ten ornament mysz-
ką (LMB ) I przeciągnij w 

dół, aby zmniejszyć 

Aby powiększyć 
widok, przeciągnij 
myszkę w górę 
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Możesz także zmieniać powiększenie w inny sposób. Zgrubnie – poprzez obrót KM , dokładnie – trzymając wci-

śnięty Ctrl , przesuwaj myszkę z wciśniętym PPM .    

Na koniec – obróćmy ten widok. Możesz to zrobić posługując się miniaturowym układem współrzędnych, wy-

świetlonym w prawym górnym narożniku okna 3D. To jest duża kontrolka do „orbitowania” wokół sceny. Gdy 

„złapiesz” (LPM) jedną z jej osi i przeciągniesz, obraz w oknie się obróci (Rysunek 3.2.7): 

 

Rysunek 3.2.7 Obracanie za pomocą ornamentu układu współrzędnych 

Alternatywna metoda oferuje dodatkową oś obrotu. Aby „orbitować” wokół sceny bez użycia ornamentu, naciśnij 

SPM  i przeciągnij myszkę. W ten sposób możesz także obrócić widok wokół środka okna (Rysunek 3.2.8): 

 

Rysunek 3.2.8 Obracanie wokół wybranego obiektu (użycie SPM )  

Ta metoda obraca obserwatora wokół aktualnie zaznaczonego obiektu (zaznaczasz obiekty kliknięciem LPM). 

Aktualna oś obrotu zależy od położenia kursora myszki. Gdy przeciągasz go w pobliżu krawędzi okna – obra-

casz widok wokół osi prostopadłej do ekranu. Gdy przesuwasz kursor myszki w pobliżu środka okna – obracasz 

widok w ten sam sposób jak robi to ornament „układ współrzędnych”.  

Obrót w poziomie 

O
b

ró
t 

w
 p
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n

ie
 

Złap (LMB ) okrągłą końcówkę 

jednej z osi i przeciągnij w 
nowe miejsce 

Trzymając wciśnięty SPM  przesu-

waj myszkę w środku okna aby 
obracać widok w pionie (przesu-
nięcie w górę/dół) lub poziomie 
(przesunięcie w prawo/lewo) 

Trzymając wciśnięty SPM  prze-

suwaj myszkę wokół krawędzi 
okna, aby obracać widok w 
płaszczyźnie ekranu 

Ta metoda obraca widok 
wokół aktualnie zaznaczone-

go (kliknięciem LPM ) obiektu 
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Z drugiej strony, ornament w narożniku okna jest wygodny przy wybieraniu widoków ortogonalnych. Gdy klik-

niesz LPM w okrągłą końcówkę jednej z jego osi, przełącza się w odpowiednią projekcję (Rysunek 3.2.9): 

                    

Rysunek 3.2.9 Przełączanie na jeden z widoków ortogonalnych 

Aby odwrócić widok ortogonalny, kliknij kółko w środku ornamentu układu współrzędnych (Rysunek 3.2.10): 

                     

Rysunek 3.2.10 Przełączanie widoku ortogonalnego na przeciwny 

Oczywiście, dla pokazanych powyżej operacji istnieją także polecenia w menu i skróty: 

• Widoki z przodu/tyłu: View→Viewpoint→Front lub 1 , View→Viewpoint→Rear lub Ctrl - 1 ; 

• Widoki z boku: View→Viewpoint→Left lub 3 , View→Viewpoint→Right lub Ctrl - 3 ; 

• Projekcje pionowe: Widok View→Viewpoint→Top lub 7 , View→Viewpoint→Bottom lub Ctrl - 7 ; 

Jako jeden ze “weteranów” Blendera, używam tych skrótów klawiatury. W zasadzie są na polu numerycznym, 

ale ja włączam sobie opcję Input:Emulate Numpad (w oknie Edit→Preferences). W ten sposób mam te klawi-

sze 1 , 3  i 7  bezpośrednio pod lewą ręką. (Używam klasycznej, pełnowymiarowej klawiatury).  

 

Zdolność do orbitowania wokół zaznaczonych obiektów czyni metodę opartą o SPM  bardziej użytecz-

ną od obracania za pomocą ornamentu układu współrzędnych. Szczególnie w złożonych scenach. 

  

 

Czasami przydaje się rozpoznawać kierunek zamierzonej projekcji po kolorze odpowiedniej osi. W 

domyślnych barwach Blendera Z jest niebieskie, Y jest zielone, a X jest czerwone (Rysunek 3.2.9). 

  

Widok 
z góry 

Y: zielony  

X: czerwony  

Kliknij (LPM ) 

w okrągły 
koniec osi Z 

Kliknij w 
kółko na 
środku 

Widok 
z góry 

Widok 
z dołu 
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Osobiście, zawsze okrążam model poprzez przesunięcie myszki z wciśniętym SPM , a ewentualne korekty 

wprowadzam naciskając dodatkowo klawisze Ctrl  lub Shift .   

Kolejny ornament służy do przełączania się pomiędzy widokiem ortograficznym i perspektywą (Rysunek 3.2.11): 

       

Rysunek 3.2.11 Przełączanie pomiędzy projekcją ortograficzną i perspektywiczną 

Możesz zrobić to samo za pomocą poleceń menu: View→Perspective / View→Orthographic (pojawiają się w 

tym samym miejscu, zależnie od aktualnej projekcji) lub klawisza 5 .  

Przyglądając się powierzchniom modelu w widoku perspektywicznym, możesz zauważyć dziwne „rysy” 

(Rysunek 3.2.12). Te „rysy” znikają, gdy przełączysz się na widok ortograficzny. 

 

Rysunek 3.2.12 Dziwne „rysy”, pojawiające się tylko w projekcji perspektywicznej 

Co to jest? 

 

Spróbuj przez chwilę pokrążyć w ten sposób dookoła sceny, aby poznać, jak to wygląda w praktyce. 

Czasami część sceny może się znaleźć poza obszarem widocznym w oknie. W takim przypadku sko-

ryguj to poprzez przesunięcie ekranu (por. Rysunek 3.2.5) i/lub zmianę powiększenia. 

  

Projekcja 
ortograficzna 

Projekcja      
perspektywiczna 

Kliknij w ten ornament, aby 
przełączyć się pomiędzy 
projekcją ortograficzną i 

perspektywiczną 

Dziwne 
“rysy” 

 

Dziwne 
“rysy” 

 

Dziwne 
“rysy” 
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Są to wewnętrzne ściany obiektów modelu. Nie wiem dlaczego, ale możesz się natknąć na ten efekt także w 

kamerach przeznaczonych do tworzenia finalnych obrazów modelu. Na szczęście istnieje proste remedium. 

Naciśnij klawisz N  (lub wybierz View→Sidebar) aby otworzyć w tym oknie przybornik (Rysunek 3.2.13). 

Przejdź do jego zakładki View. Tam, w panelu View, znajdują się ustawienia projekcji dla tego okna: 

  

Rysunek 3.2.13 Zmiana parametrów projekcji okna w przyborniku 

Zwiększaj tam wartość Clip Start dopóki „rysy” na modelu nie znikną. Dla tego okna modelu Ła-5F nastąpi to 

dla Clip Start = 0.1 lub nawet 0.2. W tym samym panelu możesz także przestawić inne parametry perspektywy. 

Na przykład, gdy zmniejszysz Focal Length z 70 do 35(mm), uzyskasz efekt zbliżony do „rybiego oka”. (Focal 

Length jest polem numerycznym. W przypadku wątpliwości jak je używać, patrz str. 78). 

Gdy dokonujesz powiększenia w widoku perspektywicznym, możesz się natknąć na efekt, który nazywam „nie-

widzialną ścianą”. Rysunek 3.2.14a) pokazuje, co mam na myśli, gdy dokonuję zbliżenia za pomocą ornamentu: 

   

Rysunek 3.2.14 Efekt „niewidzialnej ściany” podczas zbliżeń w widoku perspektywicznym (za pomocą ornamentu „lupy”) 

Początkowo masz wrażenie szybkiego zbliżania się do modelu. Jednak później ten ruch staje się coraz wolniej-

szy. W końcu masz wrażenie, że stoisz w miejscu (Rysunek 3.2.14b). 

Przesuwaj 
myszkę w górę 

 Lecz w pewnym 
momencie zupełnie 

przestajesz się 
zbliżać! 

a) b) 

Przybornik ( N ) 

Parametry projekcji 
perspektywicznej 

Zwiększ war-
tość Clip Start 

“Rysy” znikają 
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Co więcej, w sytuacji pokazywanej przez Rysunek 3.2.14b) nie można przesuwać tego ekranu na boki (orna-

ment „dłoni” także nie działa)! Można tylko zacząć się oddalać. Z początku powoli, ale wtedy wszystko powraca. 

Jaka jest przyczyna tego dziwnego efektu? W projekcji perspektywicznej potrzebny jest „punkt zbiegu”, umiesz-

czony w pewnej odległości od płaszczyzny ekranu. Zbliżenia w tej projekcji polegają na zmniejszaniu tego dy-

stansu. Wszystko się zatrzymuje, gdy jesteś bardzo blisko: „utykasz” w tym widoku!   

Na szczęście, gdy dokonujesz zbliżenia obracając KM  (alternatywna metoda), możesz zasugerować Blenderowi 

odsunięcie punktu zbiegu od płaszczyzny ekranu. W tym celu podczas obrotu KM  trzymaj kursor myszki ponad 

powierzchnią modelu w pobliżu środka widoku. Rysunek 3.2.15 pokazuje, jak to działa: 

                         

Rysunek 3.2.15 Zbliżanie w widoku perspektywicznym za pomocą obrotu KM   

Gdy zrobisz to w ten sposób, zbliżanie nie ulegnie blokadzie, gdyż Blender będzie dynamicznie odsuwać punkt 

zbiegu. Upewnij się tylko, że w konfiguracji masz włączoną opcję Navigation:Auto Depth (por. str. 430) .  

Wreszcie ornament „kamery” przełącza widok z aktualnego okna w projekcję z kamery sceny (Rysunek 3.2.16).  

 

Rysunek 3.2.16 Widok z aktualnej kamery sceny  

 

Możesz nadal używać ornament “lupy” w widoku perspektywicznym dla drobnych zmian zbliżenia.  

  

Obracaj 

KM 

Obracaj 

KM 

Trzymaj kursor 
myszki ponad 

modelem 

Kliknij w ten ornament, aby przełączyć 
się pomiędzy widokiem z kamery 
sceny i projekcją ustalaną „ręcznie” 

Projekcja z 
kamery sceny 
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Taki sam efekt uzyskasz poleceniami View→Cameras→Active Camera lub View→Viewpoint→Camera, klawisz 

skrótu: 0 . Więcej na temat kamer Blendera dowiesz się w sekcji 3.4. 

Podsumowanie 

• Części złożonych modeli 3D są grupowane w hierarchiczne kolekcje. Możesz je traktować jako odpowied-

nik warstw z programów rysunkowych 2D. W szczególności, możesz przełączać ich widoczność (str. 39). 

• Możesz tymczasowo zmaksymalizować aktywne okno na cały ekran Blendera poleceniem 

View→Area→Toggle Maximize Area, lub jego skrótem: Ctrl - Space  (str. 40). 

• Aby przesunąć widok: przeciągnij (LPM) ornament “dłoni” lub przeciągnij myszkę z wciśniętym SPM  i wci-

śniętym Shift  na klawiaturze (str. 41). 

• Aby zmienić powiększenie widoku: przeciągnij (LPM) ornament “lupy” lub przesuń do góry/dołu myszkę z 

wciśniętym SPM , i wciśniętym Ctrl  na klawiaturze, lub obracaj KM  (str. 41). 

• Aby obrócić widok: przeciągnij (LPM) wybraną oś z ornament układu współrzędnych, lub przeciągnij mysz-

kę z wciśniętym SPM  (str. 42). 

• Do przełączania pomiędzy projekcją ortograficzną i perspektywiczną: kliknij (LPM) w ornament „siatki” lub 

naciśnij klawisz 5  (str. 44). 

• Aby szybko ustawić jeden z widoków ortogonalnych, kliknij (LPM) okrągłą końcówkę jednej z osi ornamentu 

układu współrzędnych. Alternatywnie możesz użyć następujących skrótów: 1  (przód), 3  (strona lewa), 7  

(góra). Aby ujrzeć te widok z przeciwnej strony – wciśnij dodatkowo klawisz Ctrl : Ctrl - 1  (tył), Ctrl - 3  (stro-

na prawa), Ctrl - 7  (dół) (str. 43). 

• Możesz zmienić parametry projekcji (na przykład – długość ogniskowej) w przyborniku ( N ), zakładce 

View (str. 45). 

• Podczas zbliżeń w projekcji perspektywicznej możesz napotkać efekt “niewidzialnej ściany” (str. 45). Aby 

uniknąć takiej blokady, zmieniaj zbliżenie poprzez obrót KM  (str. 46). Pozostałe metody możesz wykorzy-

stać do końcowych, drobnych korekt. 

 

 

Kompletny opis nawigacji w przestrzeni okna 3D znajdziesz w sekcji “Editors: 3D Viewport: Navigating” 

z instrukcji online Blendera. 

 
  

https://docs.blender.org/manual/en/latest/editors/3dview/navigate/index.html
https://docs.blender.org/manual/en/latest/editors/3dview/navigate/index.html
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3.3 Cieniowania sceny w oknie 3D i inne opcje 

W tej sekcji omówię inne możliwości okna 3D, które mogą się przydać w dalszej pracy. Jedną z nich są przyci-

ski cieniowania, umieszczone po prawej stronie nagłówka okna (Rysunek 3.3.1):   

 

Rysunek 3.3.1 Przyciski z opcjami cieniowania  

Domyślnie, Blender pokazuje model w trybie cieniowania Solid. Można w nim włączyć dodatkową opcję „rent-

genowską” (X-Ray). Pozwala ona „widzieć na wskroś”, poprzez powierzchnie obiektów (Rysunek 3.3.2): 

 

Rysunek 3.3.2 Włączenie trybu X-Ray  

 

Tryb X-Ray bywa bardzo przydatny w przypadku złożonych modeli. Gdy edytujesz siatki obiektów, 

pozwala na zaznaczanie wierzchołków zasłoniętych przez ściany (por. str. 501). 

Opcje cieniowania 

Aktualny 
tryb: Solid 

Kliknij tutaj, aby włą-
czyć opcję X-Ray  
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Gdy przełączysz cieniowanie modelu w tryb Wireframe, Blender automatycznie włącza także opcję X-Ray 

(Rysunek 3.3.3): 

 

Rysunek 3.3.3 Tryb Wireframe (+ X-Ray) 

W trybie Wireframe widać każdą krawędź, która łączy nieplanarne ściany siatki. To tworzy na ekranie złożony 

obraz, ale przydaje się przy pracy z detalami. Często używam go do precyzyjnego dopasowania dwóch kontu-

rów. W domyślnych barwach Blendera te krawędzie są czarne, więc nie wyróżniają się specjalnie z ciemnego 

tła sceny. Taki słabszy kontrast jest dostateczny do pracy, ale nie wygląda dobrze na ilustracjach. Rysunek 3.3.3 

pokazuje wszystkie elementy modelu jako „zaznaczone”, co zmieniło kolor krawędzi na pomarańczowy. 

Opcja Wireframe z wyłączonym X-Ray tworzy coś w rodzaju rysunku konturowego (Rysunek 3.3.4): 

 

Rysunek 3.3.4 Tryb Wireframe (bez opcji X-Ray) 

Ten rodzaj cieniowania jest mniej użyteczny do modelowania. Na „tryb siatki” zazwyczaj przełączasz się po to, 

aby widzieć ukryte kontury, na przykład – kształty wręg kadłuba lub żeber skrzydeł.  

Wireframe 
+ X-Ray  

Zaznaczyłem te wszystkie obiekty 
aby podświetlić ich krawędzie 

Wireframe 
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Kiedy klikniesz w niepozorną strzałkę z prawej strony opcji cieniowania, Blender rozwija arkusz z ustawieniami 

aktualnego trybu cieniowania (Rysunek 3.3.5): 

 

Rysunek 3.3.5 Rozwijalny arkusz opcji cieniowania (wariant dla trybu Solid) 

Zawartość tego arkusza jest różna dla każdego z trybów cieniowania. Rysunek 3.3.5 pokazuje przypadek dla 

trybu Solid. Można tu uzyskać interesujące efekty. Na przykład – możesz zmienić własności materiału, przypi-

sanego do modelu. Wystarczy w sekcji Color wybrać opcję Single (Rysunek 3.3.5). 

W sekcji Lighting możesz wybrać jeden z kilku wariantów oświetlenia sceny (Rysunek 3.3.6): 

 

Rysunek 3.3.6 Wybieranie różnych opcji oświetlenia dla trybu Solid 

Blender pokazuje te opcje jako rozwijalną listę pocieniowanych kul (nazywanych także „próbkami”). Wypróbuj 

każdą z nich, aby przekonać się, która najlepiej pasuje do Twoich upodobań. 

Kliknij tu, aby 
rozwinąć ten 

arkusz 

Wybierz Color:Single  

Tu możesz zmienić ten 
domyślny biały kolor 

Kliknij tu, by 
otworzyć listę  

Jeżeli chcesz, możesz 
także włączyć cienie  

Wybierz tu jedną z 
opcji oświetlenia  
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Co więcej, oprócz różnych rodzajów oświetlenia możesz także sprawdzić, jak wyglądałby Twój model wykonany 

z różnych materiałów. Wystarczy przełączyć Lighting na MatCap i wybrać jeden z nich (Rysunek 3.3.7): 

 

Rysunek 3.3.7 Wybieranie materiału testowego 

Na przykład, zawsze warto sprawdzić, jak wyglądałyby powierzchnie modelu wypolerowanego na „wysoki po-

łysk” – na przykład pokryte czerwonym lakierem samochodowym (Rysunek 3.3.8): 

 

Rysunek 3.3.8 Poszukiwanie ewentualnych nierówności na połyskliwej powierzchni 

 

Dlaczego jest tu tyle różnych opcji oświetlenia? Ponieważ nie możesz dotknąć tego modelu swoimi 

palcami. Klasyczni modelarze sprawdzają kształt każdego nowego elementu swojego plastikowego 

lub drewnianego modelu poprzez dotyk i oglądanie pod różnymi kątami. W modelowaniu komputero-

wym dostępna jest tylko ta druga metoda. Dlatego Blender oferuje wiele wariantów oświetlenia. Cienie 

i odblaski każdego z nich mogą ujawnić inne klasy ewentualnych nierówności powierzchni. 

Przełącz na 
MatCap  

Wybierz jeden 
z materiałów 
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mochodowy”  
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Pozostałe dwa tryby cieniowania będziemy używać w dalszych częściach tej książki, gdyż wymagają przygoto-

wanych materiałów i tekstur. Pierwszym z nich jest Material Preview (Rysunek 3.3.9): 

 

Rysunek 3.3.9 Tryb cieniowania Material Preview 

Można go używać do sprawdzania materiałów i tekstur w różnych środowiskach. Każde z nich tworzy inne cie-

nie i odbicia, co jest szczególnie istotne dla bardzo połyskliwych powierzchni, jak oszklenie kabiny. Rozwijalny 

arkusz opcji dla tego trybu oferuje kilka parametrów, jak intensywność oświetlenia (Strength), lub ostrość 

szczegółów (Blur). Możesz także obracać sferę otoczenia wokół modelu.  

Ostatnim trybem cieniowania jest Rendered (Rysunek 3.3.10): 

 

Rysunek 3.3.10 Tryb cieniowania Rendered 

To jest podgląd końcowej sceny. W odróżnieniu od okna z ostatecznym obrazem, nadal możesz tu edytować 

obiekty. Ten tryb pomija niektóre zaawansowane efekty, jak rozmycie ruchu (dlatego widzisz łopaty śmigła).  
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W nagłówku okna 3D znajdują się także inne arkusze rozwijalne, sterujące widocznością jego pomocniczych 

elementów. Jeden z nich to parametry tzw. „nakładek” (overlays)  okna (Rysunek 3.3.11): 

 

Rysunek 3.3.11 Opcje Viewport Overlays 

Możesz tu np. ukryć domyślne informacje (Text Info) wyświetlane w lewym górnym narożniku okna, i np. włą-

czyć w tym miejscu informacje o scenie (Statistics). Poeksperymentuj trochę z tymi ustawieniami. 

Innym arkusz rozwijalny steruje widocznością różnych ornamentów okna (gizmos) . Na przykład, możesz ukryć 

ornamenty nawigacyjne, omówione w poprzedniej sekcji (Rysunek 3.3.12): 

 

Rysunek 3.3.12 Opcje Viewport Gizmos 

Niektóre z ornamentów figurujących na tym arkuszu pojawiają się tylko w pewnych trybach. Na przykład, Object 

Gizmos pojawiają się tylko podczas wykonywania poleceń Move, Rotate lub Scale. (Więcej – w sekcji 3.5). 
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Kliknij w przycisk Back to Previous (u góry ekranu) aby powrócić do poprzedniego układu wielu okien, Teraz 

możesz zmienić omawiane w tej sekcji ustawienia indywidualnie, dla każdego okna 3D (Rysunek 3.3.13): 

 

Rysunek 3.3.13 Zróżnicowane ustawienia cieniowania okien 3D  

Kiedy pracujesz z wieloma oknami, ich nagłówki mogą być dłuższe od szerokości tych obszarów na ekranie. W 

rezultacie, kontrolki z prawej są „obcinane” przez ich brzegi, tak jak pokazuje to Rysunek 3.3.13. Na szczęście, 

w Blenderze możesz przesuwać nagłówek edytora w prawo i w lewo (Rysunek 3.3.14):  

                

Rysunek 3.3.14 Przesuwanie nagłówka okna  

 

Gdy dzielisz obszary ekranu Blendera, jak te okna 3D (por. str. 29), nowoutworzone okno kopiuje 

wszystkie ustawienia oryginału. Dlatego najlepszą metodą zarządzania wieloma oknami Blendera jest 

ustawić wszystko w jednym oknie 3D, a potem je podzielić na dwa, trzy, lub cztery mniejsze. 

  

Wireframe 

Material Preview 

Solid 

Rendered 

“Złap” ten nagłówek 

(SPM ) tutaj… 
…potem przesuń go w 

lewo i zwolnij SPM  

 

Teraz widać 
przyciski opcji 
cieniowania 



Rozdział 3 Blender – pierwsze kroki 55 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Podsumowanie 

• Istnieją dwa podstawowe tryby wyświetlania modelu: Solid (str. 48) and Wireframe (str. 49). 

• Można je połączyć z opcją X-Ray aby “widzieć poprzez” powierzchnie obiektu (str. 48).  

• W trybie Solid możesz przełączyć się w tryb pojedynczego koloru (Single – por. str. 50). Ten tryb jest przy-

datny do poszukiwania ewentualnych zaburzeń powierzchni w kilku różnych trybach oświetlenia (z 

Lighting:Studio).  

• Można także sprawdzać wygląd powierzchnie modelu przypisując mu różne predefiniowane materiały. 

Znajdziesz je na liście Lighting:MatCap. Różnią się m.in. barwą i połyskliwością (str. 51). 

• Dwa inne tryby wyświetlania: Material Preview (str. 52) i Rendered (str. 52) są stworzone z myślą o póź-

niejszych fazach projektu, w którym definiujesz materiały i tekstury modelu, oraz otoczenie sceny. 

• Używaj arkuszy rozwijalnych Viewport Overlays i Viewport Gizmos (str. 53) do sterowania widocznością 

różnych elementów dodatkowych okna 3D. 

• Każde okno 3D może mieć różne ustawienia wyświetlania (str. 54). 

• W wąskich obszarach na podzielonym ekranie Blendera możesz „złapać” (SPM) nagłówek okna i przesu-

nąć je w poziomie, aby „sięgnąć” do kontrolek znajdujących się za ramką widocznego obszaru  (str. 54). 

 

 

 

Opcje cieniowania są także dostępne w menu myszki Shading (wyświetlane skrótem: Z ).  
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3.4 Kamery i zaznaczenie obiektów 

W Blenderze zaznaczasz (wybierasz) obiekt kliknięciem LPM . Wspomniałem już o tym w sekcji 3.2. To normalna 

metoda zaznaczania w aplikacjach Windows. W przypadku gdy obiekt jest zasłonięty, jak figura pilota w kabinie, 

można także „kliknąć” go w oknie Outliner, jak pokazuje to Rysunek 3.4.1. (Oczywiście, jeżeli wiesz w której 

kolekcji się znajduje):  

 

Rysunek 3.4.1 Zaznaczanie obiektu 

Okno 3D powyżej (Rysunek 3.4.1) to widok z kamery (polecenie View→Viewpoint→Camera, skrót: 0 ). Jest to 

projekcja, jaką Blender użyje dla tej sceny do stworzenia ostatecznego obrazka lub animacji.  

A co to są same kamery? To pewien rodzaj obiektu, który możesz wstawić w scenę. Wokół tego Ła-5F umieści-

łem dwie kamery. Zazwyczaj są daleko od modelu, więc możesz je zobaczyć w oknie 3D tylko w dużym zmniej-

szeniu. Oczywiście, są także dostępne w oknie Outliner (Rysunek 3.4.2): 

 

Rysunek 3.4.2 Dwie kamery w scenie z Ła-5 

Granice finalnego obrazu  Camera View 

Możesz zaznaczać 
obiekty kliknięciem LPM  

Użyj Outliner, aby 
zaznaczyć trudno 
dostępne obiekty. 

Blender obrysowuje 
zaznaczony obiekt 

Aktywna kamera: 
Camera.Tracked 
 

Obiekt kamery 

Alternatywna kamera: 
Camera.Static 
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Początkowo Camera.Tracked jest aktywną kamerą dla tej sceny. Jeżeli chcesz się przełączyć na alternatywną 

projekcję z Camera.Static, zaznacz ją i wywołaj polecenie View→Cameras→Set Active Object As Camera. 

Możesz także przesuwać kamery – tak jak w prawdziwym studio. Nim jednak tym się zajmiemy (na str. 62), 

powiem nieco więcej o zaznaczaniu obiektów. To jest zawsze pierwszy krok każdej operacji w Blenderze. 

Aby dodać do zaznaczenia kolejny obiekt, kliknij go ( LPM) w oknie 3D z wciśniętym Shift  (Rysunek 3.4.3): 

 

Rysunek 3.4.3 Zaznaczanie wielu obiektów 

Zaznaczony obiekt zmienił kolor na jasnopomarańczowy. Tak właśnie zaznacza się ostatni wybrany element. 

Jednocześnie w lewym dolnym narożniku okna została wyświetlona jego nazwa. To aktualny obiekt aktywny. 

Pozostałe zaznaczone elementy mają ciemniejsze obwódki. 

Aby usunąć wszystkie zaznaczenia, kliknij LPM  w pustą przestrzeń sceny albo użyj polecenia z menu: 

Select→None. Zwróć uwagę, że nazwa obiektu aktywnego pozostanie na ekranie (Rysunek 3.4.4): 

 

Rysunek 3.4.4 Obiekt aktywny 

Obiekt aktywny odgrywa ważną rolę w wielu operacjach Blendera – na przykład w poleceniu Parent, które budu-

je hierarchię modelu (por. str. 479) . 
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Aby lepiej „wyczuć”, jak to działa, proponuję, abyś wykonał kilka szybkich doświadczeń. Zacznij od sytuacji, gdy 

nic nie jest zaznaczone. Trzymaj wciśnięty klawisz Shift  i wykonuj po kolei operacje, które wylicza Tabela 3.4.1: 

 

Trzymając wciśnięty Shift : Rezultat 

Obiekty wybrane i ich kolory Obiekt aktywny 

Kliknij LPM  w obiekt Camera.Static Camera.Static (jasny pomarańczowy) Camera.Static 

Kliknij LPM  w obiekt Camera.Tracked Camera.Static (ciemny pomarańczowy) 

Camera.Tracked (jasny pomarańcz.) 

Camera.Tracked 

Kliknij LPM  w obiekt Camera.Static Camera.Static (jasny pomarańcz.) 

Camera.Tracked (ciemny pomarańcz.) 

Camera.Static 

Kliknij LPM  w obiekt Camera.Static Camera.Tracked (ciemny pomarańcz.) Camera.Static 

Tabela 3.4.1 Obiekty wybrane a obiekt aktywny – kilka doświadczeń z operacjami grupowymi 

Aby skojarzyć, gdzie jest Camera.Static a gdzie Camera.Tracked – patrz na Rysunek 3.4.2. Nie pokazuję re-

zultatów operacji z powyższej tabeli na ilustracjach, bo zajęłoby to kilka dodatkowych stron. Wnioski z wykona-

nego doświadczenia: 

• Modyfikator w postaci klawisza Shift  służy nie tylko do włączania, ale i wyłączania obiektu spośród wy-

boru. (Gdy klikniesz w obiekt powtórnie, stanie się obiektem aktywnym, a gdy klikniesz jeszcze raz – 

przestanie być wybranym); 

• Obiekt aktywny nie musi być w ogóle obiektem wybranym (patrz Tabela 3.4.1, ostatni wiersz); 

Możliwe jest także zaznaczanie grupy obiektów obszarem prostokątnym. To polecenie Box Select, ustawione 

jako domyślne w pasku narzędzi. Naciśnij LPM  i przesuń myszkę z tym wciśniętym klawiszem. Na ekranie po-

jawi się prostokątny obszar (por. Rysunek 3.4.5). Rozciągnij ten prostokąt i zwolnij LPM . Zaznaczeniu ulegają 

wszystkie obiekty, które znalazły się wewnątrz obszaru, lub przecięły jego krawędź: 

      

Rysunek 3.4.5 Zaznaczenie obszarem prostokątnym (Box Select) 

Zwróć uwagę, że zaznaczanie metodą Box Select nie zmienia aktualnego obiektu aktywnego.  

 

 

Można tej metody używać także do wykluczania z zaznaczenia obiektów objętych prostokątnym 

obszarem. W tym celu musisz użyć polecenia: Select→Box Select (skrót: B ). W tym trybie na kurso-

rze myszki przecinają się dwie kreskowane linie. Przesuń kursor w miejsce, gdzie ma być pierwszy 

narożnik obszaru. Potem zaznacz go jak to pokazuje Rysunek 3.4.5, ale używając SPM  zamiast LPM . 

...i zwolnij LPM .    

Naciśnij LPM  ... 

...przesuń 
myszkę...  Zaznaczone 

obiekty 

Aktywny obiekt 
jest ten sam 

Narzędzie Box Select  
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W dolnych prawych narożnikach narzędzi w pasku można dostrzec małe trójkąty. Jeden z nich widać w kwadra-

cie narzędzia wyboru. Gdy naciśniesz LPM na tym trójkącie, Blender wyświetla listę alternatywnych narzędzi tej 

samej klasy. Znajdziesz w niej cztery tryby wyboru (Rysunek 3.4.6a): 

      

Rysunek 3.4.6 Inne tryby wyboru 

Trzymając wciśnięty LPM  przesuń kursor ponad jednym z tych narzędzi, a następnie zwolnij przycisk. W przy-

kładzie powyżej wybrałem w ten sposób tryb Lasso Select. Rysunek 3.4.6b) pokazuje, jak ten tryb działa.  

Ja jednak wolę inne polecenie: Select→Circle Select. Wywołuję je zawsze korzystając ze skrótu klawiatury 

( C ), gdyż jego wariant z paska narzędzi działa inaczej (jest mniej użyteczny). Gdy nacisnę C , Blender rysuje 

okrąg wokół kursora myszki (Rysunek 3.4.7): 

          

Rysunek 3.4.7 Zaznaczanie okręgiem (Circle Select) 

Ten okrąg jest „przyczepiony” do kursora. Można zmienić jego promień obracając KM . Gdy klikniesz LPM , 

wszystkie obiekty w kole stają się zaznaczone. Gdy klikniesz SPM , wszystkie obiekty w tym obszarze przestają 

być zaznaczone. Aby wyjść z tego trybu naciśnij Esc . 

 

 

Zawsze zaznaczam/wykluczam obiekty klikając Shift -LPM , lub używając trybu Circle Select w warian-

cie pokazanym powyżej (wywoływanym klawiszem C ). Ale to tylko moje osobiste preferencje. 

a b Naciśnij tu LPM  aby zobaczyć więcej opcji 
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Obracaj KM  by 
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Kliknięcie LPM  zaznacza 

wszystko w środku, a SPM  

wyklucza z zaznaczenia 

Aby wyjść z tego 

trybu, naciśnij Esc    



60 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Menu Select okna 3D zawiera jeszcze wiele innych możliwości wyboru. Czasami wykorzystuję te z submenu 

Select Grouped (Rysunek 3.4.8): 

 

Rysunek 3.4.8 Przykład innych możliwości wyboru, dostępnych z menu Select. 

 

 

 

W dalszych rozdziałach użyję kilku metod z menu Select Grouped (por. str. 228). Kompletny opis 

wszystkich poleceń z menu Select znajdziesz w dokumentacji online Blendera: User Interfa-

ce:Selecting oraz w Scenes & Objects:Objects:Selecting. 

  

https://docs.blender.org/manual/en/latest/interface/selecting.html
https://docs.blender.org/manual/en/latest/interface/selecting.html
https://docs.blender.org/manual/en/latest/scene_layout/object/selecting.html
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Podsumowanie 

• Kamery są specjalnymi obiektami Blendera które przechowują ustawione projekcje dla późniejszego ren-

derowania sceny (str. 56). 

• Aby zaznaczyć obiekt, kliknij go LPM  (str. 56). Możesz to zrobić z dodatkowo wciśniętym Shift , jeżeli 

chcesz dołączyć kliknięty element do wcześniej zaznaczonych obiektów (str. 57); 

• Obiekty możesz zaznaczać w oknach: 3D i Outliner (str. 57). 

• W oknie Outliner użyj modyfikatora Ctrl  aby dołączyć kolejny obiekt do wcześniej zaznaczonych (str. 57). 

W tym oknie obowiązują te same klawisze modyfikatorów co w Windows Explorer: Shift  zaznacza cały za-

kres elementów z bieżącej listy, podczas gdy Ctrl  pozwala je „dobierać” jeden po drugim. 

• Aby zrezygnować z dokonanej selekcji, kliknij LPM  gdzieś w pustej przestrzeni lub wywołaj polecenie 

Select→None (str. 57). Istnieje także polecenie Select→All (skrót: A ), które czasami się przydaje. 

• Obiekt aktywny sceny jest ostatnim obiektem, który kliknąłeś LPM . W pewnych sytuacjach może nie być 

zaznaczony. Nazwa tego obiektu jest wyświetlana w lewym górnym narożniku okna 3D (str. 57). 

• Aby zaznaczać za pomocą prostokątnego obszaru, użyj polecenia Box Select z paska narzędzi. Następnie 

naciśnij LPM  i przeciągnij myszkę (str. 58). Możesz także uruchomić ten tryb skrótem B  (lub wywołując po-

lecenie z menu: Select→Box Select). W wariancie wywołanym z menu lub klawiszem skrótu, możesz także 

wykluczać z selekcji. W tym celu użyj SPM  zamiast LPM . 

• Aby zaznaczać obiekty okręgiem, użyj skrótu C  (lub wywołaj polecenie Select→Circle Select). W tym try-

bie użyj LPM  do zaznaczania i SPM  do „odznaczania” obiektów (str.59).  
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3.5 Podstawowe transformacje 

W tej sekcji pokażę, jak zmienić położenie, orientację i rozmiar aktywnej kamery (to też obiekt). Wcześniej jed-

nak: 

1. Ustaw obok siebie dwa okna 3D jak pokazuje to Rysunek 3.5.1. W lewym ustaw widok z kamery (0), w 

prawym – widok z przodu (1). Pomniejsz widok z przodu aby widzieć i model, i kamery. 

2. Zaznacz obiekt Camera.Tracked. To aktywna kamera tej sceny z Ła-5. Upewnij się, że widzisz tę na-

zwę w lewym górnym narożniku okna 3D. 

Będziemy pracować w prawym oknie, jedocześnie obserwując zmiany w lewym: 

 

Rysunek 3.5.1 Proponowany układ ekranu 

Naciśnij klawisz G  (Object→Transform→Grab/Move). Od tej chwili każdy ruch myszką powoduje przemiesz-

czenie kamery. Zwróć uwagę, że zmienia się także projekcja w oknie kamery (Rysunek 3.5.2): 

 

Rysunek 3.5.2 Przemieszczanie obiektu 

Podczas przesuwania Blender pokazuje w nagłówku aktywnego okna zmianę współrzędnych X,Y,Z, oraz zmia-

nę odległości (w nawiasie) od oryginalnego położenia obiektu. Kliknięciem LPM  kończysz tę operację, zatwier-

dzając nowe położenie. (W razie czego: naciśnięcie Esc  także ją kończy, anulując przesunięcie). 

Zaznacz 
Camera.Tracked 

Camera view Pomniejszony 
widok z przodu 

Zaznaczona 
kamera 

Gdy przesuwasz 
obiekt kamery… 

... ten widok ulega 
dynamicznej zmianie! 

Aktualny wektor 
przesunięcia (i 
odległość)  

Naciśnij G  

by zacząć   

Kliknij LPM  by zatwierdzić 

nowe położenie   
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Jak to się stało, że podczas przesuwania kamera nie straciła samolotu z centrum widzenia? Otóż ten obiekt ma 

włączony tryb „śledzenia” (ang. track).  W dalszej części tej książki opiszę, jak tworzyć takie powiązanie. Teraz 

chciałbym zademonstrować, co właściwe śledzi kamera. 

Jet to pomocniczy obiekt o nazwie Camera.Target. Znajdziesz go w oknie Outliner, w kolekcji Cameras & 

Lights. Obiekt został ukryty zapisaniem tego pliku la5.blend, więc musisz teraz go odsłonić poprzez kliknięcie w 

małą ikonkę „oka” po prawej stronie (Rysunek 3.5.3): 

 

Rysunek 3.5.3 Odsłonięcie pomocniczego obiektu Camera.Target 

W okolicy kabiny pilota pojawi wówczas się stosunkowo duży, czerwony walec1. Teraz zaznacz ten obiekt 

(Rysunek 3.5.4): 

 

Rysunek 3.5.4 Obiekt Camera.Target – „fokus” naszej kamery 

Gdy kliknąłeś obiekt Camera.Target, zniknęła pomarańczowa ramka wokół widoku z kamery. To dlatego, że ta 

kamera przestała być zaznaczona. Zwróć także uwagę, że zaznaczony obecnie „cel” kamery leży w środku jej 

ramki. W istocie, ten pomocniczy cylinder pełni rolę „fokusu” kamery. 

Przełącz także na swoim ekranie prawe okno na widok z lewej ( 3 ), jak to pokazuje Rysunek 3.5.4. 

 
1 Mógłby to być jakikolwiek obiekt, o dowolnym kształcie. Ten cylinder to mój arbitralny wybór. Jest dostatecznie duży, aby można go było 

łatwo zaznaczyć nawet z większej odległości. Kolor czerwony wyróżnia go spośród innych obiektów sceny. 

Kliknij w tę ikonę by 
zmienić widoczność  

Przełącz się na 
widok z lewej 

Zaznacz ten obiekt  

Kamera nie jest już zaznaczona, więc 
jej ramka nie ma już podświetlenia 
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Powiedzmy, że chcielibyśmy, aby punkt, na który „patrzy” kamera znajdował się w okolicy si lnika, a nie kabiny 

pilota. W tym celu należy przesunąć obiekt Camera.Target wzdłuż osi Y. Jest to możliwe w każdym widoku, 

nawet perspektywicznym (jak widok z kamery).  

Naciśnij znów klawisz G , aby rozpocząć przesuwanie. Zaraz potem naciśnij Y  – oznacza to, że ograniczamy 

przesunięcie tylko do tej osi. Oś Y stała się biała, i zmienił się tekst u dołu okna – pokazuje wyłącznie zmianę 

odległości wzdłuż tej osi. Teraz, wraz z każdym przesunięciem myszki, obiekt „jeździ” po osi Y jak po drucie 

(Rysunek 3.5.5).  

 

Rysunek 3.5.5 Przesuwanie obiektu wzdłuż osi Y 

Jak widać, kamera przez cały czas „trzyma” Camera.Target w centrum obrazu. Nie kończ jeszcze przesunięcia. 

Pokażę teraz inny efekt: w czasie ruchu myszki naciśnij i trzymaj wciśnięty, klawisz Ctrl . Wykonaj stosunkowo 

daleki ruch. Zobaczysz, że przesunięcie następuje teraz skokowo, co 1 jednostkę (Rysunek 3.5.6): 

 

Rysunek 3.5.6 Przesunięcie skokowe (wciśnięty klawisz Ctrl ) 

 

 

Klawisz Ctrl  podczas każdej transformacji (przesunięcia, obrotu, zmiany skali) wymusza skokowe 

zmiany, o jakieś „zaokrąglone” wartości. (Klawisz Ctrl  włącza “skok” (Snap), a domyślnym trybem 

skoku w Blenderze jest Increment – por. Rysunek 3.5.6.)  

Kierunek przesunięcia – 
wzdłuż globalnej osi Y. 

Przesuwany 
obiekt 

Trajektoria ruchu – 
równoległa do osi Y 
 

Trzymaj wciśnięty klawisz Ctrl  

aby przesuwać obiekt stałymi 
krokami co 10 jednostek 

Bieżący tryb 
Snap: 

Increment 
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A teraz inny efekt: podczas przesuwania obiektu trzymaj wciśnięty klawisz Shift . Co się dzieje? Ten sam ruch 

myszki wywołuje mniejsze przesunięcia! 

A gdy wciśniesz jednocześnie Ctrl  i Shift ? Uzyskujemy nadal skokowe przesunięcia, ale mniejsze o rząd wiel-

kości. W widoku perspektywicznym kamery przesunięcie z samym Ctrl  zmieniało położenie obiektu co 1 jedno-

stek, a z wciśniętym Shift - Ctrl  – co 0.1 jednostki. 

Istnieje więcej użytecznych skrótów: można ograniczyć transformację do pojedynczej płaszczyzny poprzez za-

blokowanie ruchu wzdłuż określonej osi. Na przykład skrót Shift - X  blokuje oś X, ograniczając aktualną trans-

formację do płaszczyzny ZY. Używając tych ograniczeń, możesz dokładnie ustawić obiekt w każdej projekcji (na 

przykład – w widoku perspektywicznym, pod kątem, z górnej półsfery). 

Począwszy od Blendera 2.8 możesz także przesuwać obiekty poleceniem Move z paska narzędzi. W tym trybie 

Blender rysuje w środku aktualnej selekcji „ornament transformacji”: układ współrzędnych (Rysunek 3.5.7): 

 

Rysunek 3.5.7 Alternatywne narzędzie do przesuwania obiektów 

To jest trójwymiarowy odpowiednik „ramek z uchwytami”, występujących w programach rysunkowych 2D. Mo-

żesz „złapać” i „przeciągnąć” ten ornament (trzymając wciśnięty LPM) do nowego położenia obiektu. Gdy zła-

piesz biały okrąg w środku – będziesz przesuwał zaznaczone obiekty po płaszczyźnie ekranu. Uchwyty w 

kształcie strzałek pozwalają na przesunięcie wzdłuż pojedynczej osi. Kolorowe kwadraty pozwalają na przesu-

wanie po wybranej płaszczyźnie. Gdy skończyłeś operację, wybierz z paska narzędzie (tryb) Select. 

 

Warto zapamiętać: klawisz Shift  podczas każdej transformacji (przesunięcia, obrotu, zmiany skali) 

zwiększa „przełożenie” ruchu myszki. (Większe ruchy myszką odpowiadają mniejszym przesunięciom 

na ekranie). Ułatwia to dokładniejsze ustalanie końcowej pozycji. 

  

 

W pasku stanu, u dołu ekranu, Blender wyświetla wszystkie skróty dostępne dla aktualnej komendy. 

  

 

Myślę, że polecenia z paska narzędzi są dużą pomocą dla początkujących. Jednak, gdy używasz tego 

ornamentu, kliknięcie LPM  nadal może zaznaczyć obiekt, więc celny wybór jego uchwytów wymaga 

precyzji i zajmuje więcej czasu. Dlatego, gdy tylko nabierzesz troche doświadczenia, Sugeruję używać 

skrótu G , ewentualnie połączonego z dodatkowymi klawiszami modyfikującymi: Shift , X , Y , Z . 

Wybierz narzędzie Move 
z paska, aby wyświetlić 
ten ornament 

“Złap” ten okrąg, aby przesuwać zaznaczone 

obiekty równolegle do płaszczyzny ekranu 

“Złap” ten prostokąt, aby prze-
suwać obiekt po odpowiedniej 
płaszczyźnie (tutaj to: XY) 

“Złap” tę strzałkę, aby prze-
suwać obiekt wzdłuż odpo-

wiedniej osi (tutaj to: Y) 

Tryb Select 
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Jak się obraca obiekt? Najpierw pokażę to na przykładzie ornamentu Rotate z paska narzędzi, ponieważ do-

brze obrazuje tę transformację (Rysunek 3.5.8): 

 

Rysunek 3.5.8 Ornament do obrotu 

Oczywiście, możesz wywołać polecenie obrotu za pomocą skrótu klawiatury R  (Object→Transform→Rotate). 

Podobnie jak G , ten klawisz od razu rozpoczyna obrót (Rysunek 3.5.9): 

 

Rysunek 3.5.9 Obrót obiektu za pomocą polecenia Rotate ( R ) 

Domyślną płaszczyzną obrotu jest aktualna płaszczyzna ekranu. Podobnie jak w przypadku przesunięcia, na-

główek okna pokazuje aktualny kąt obrotu. Można ograniczyć obrót do pojedynczych wybranych osi: X, Y, Z, 

naciskając jedną z tych klawiszy na klawiaturze ( X , Y , Z ).  

Wraz z obrotem Camera.Target, obraca się kamera (patrz okno po prawej). Wynika to z faktu, że kamera ma 

włączone "śledzenie" tego obiektu, więc orientacja osi Z kamery także podąża za orientacją Camera.Target.  

Podczas obrotu można także stosować klawisze modyfikujące Shift  (dokładny obrót, o ułamki stopnia), Ctrl  

(obrót co 5°), Shift - Ctrl  (obrót co 1°). 

 

Wybierz 
Rotate   

Biały okrąg obraca w 
płaszczyźnie ekranu 

Kolorowe okręg obracają 
wokół pojedynczych osi  

“Złap i przeciągnij” (LPM ) 

jeden z tych okręgów 

Środek obrotu jest 
w środku obiektu 

Aktualny obrót (w stopniach) 

Kamera także 
się obraca 

Skrót R  

rozpoczyna 
obrót 

Kliknij LPM  by skończyć 

(potwierdzić) obrót 
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Dotąd obracaliśmy zaznaczony obiekt wokół jego punktu odniesienia (ang. origin, będę go także czasami nazy-

wał „środkiem”). Zazwyczaj znajduje się w geometrycznym środku obiektu, ale może się także znajdować gdzie 

indziej. Jeżeli chcesz użyć innego środka transformacji niż punkt odniesienia, musisz się posłużyć tzw. „kurso-

rem 3D” (3D cursor).  

Co to jest? Znasz zapewne rolę mrugającego znaku „karetki” (caret) w edytorze tekstu. Pokazuje, w którym 

miejscu będzie wstawiony tekst, gdy zaczniesz pisać. Tę koncepcję przeniesiono w trzy wymiary. W Blenderze 

istnieje taki specjalny punkt, który możesz umieścić w dowolnym miejscu w przestrzeni. Nazywa się także kur-

sorem (ale, dla odróżnienia, „3D”). Pokazuje, gdzie zostanie umieszczony nowy obiekt, gdybyś go chciał w tym 

momencie stworzyć. Może także służyć jako punkt odniesienia w takich operacjach jak obrót czy skalowanie. 

Kursor 3D jest rysowany jako niewielki krzyż, otoczony czerwono-białym okręgiem. Możesz go umieścić w 

dowolnym miejscu wybierając odpowiednie narzędzie z paska (Rysunek 3.5.10a) i klikając w tym punkcie LPM . 

Aby precyzyjnie ustawić go w przestrzeni będziesz często potrzebował dwóch okien 3D. Czasami możesz się 

wspomóc niektórymi z funkcji Snap, na przykład– aby przenieść kursor do najbliższego węzła siatki. W tym celu 

wybierz z menu myszki Snap (skrót Shift - S ) opcję Cursor to Grid (Rysunek 3.5.10b):   

   

Rysunek 3.5.10 Kursor 3D i menu kontekstowe Snap 

Zauważyłem także, że często używam menu Snap do wywołania polecenia Cursor to World Origin. W innych 

przypadkach, przed rozpoczęciem obrotu ustawiam kursor 3D w środku innego obiektu (Cursor to Selected) . 

Aby wykonać obrót Camera.Target wokół kursora 3D, musisz zmienić bieżący tryb Piviot Point. Do tej pory był 

to Bounding Box Center, który umieszcza środek transformacji w środku zaznaczonych obiektów. Rozwiń z 

nagłówka okna 3D listę Pivot (Rysunek 3.5.11) i wybierz stamtąd opcję 3D Cursor: 

 

Rysunek 3.5.11 Zmiana Transformation Pivot Point na 3D Cursor 

Wybierz to narzędzie i 
kliknij LPM  w nowe 

miejsce dla kursora 3D 

Shift - S  otwiera menu 

Snap (w każdym trybie) 
 

a b 

Wybierz 3D Cursor 

Gdy zaznaczony jest pojedynczy 
obiekt, tryb Bounding Box umieszcza 
punkt obrotu w jego środku (origin) 

Transformation Pivot Point  
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Zwróć uwagę, że gdy przełączysz Pivot Point na 3D Cursor, Blender przesuwa ornament polecenia Rotate na 

kursor 3D (Rysunek 3.5.12). Reszta przebiega tak samo, jak poprzednio – złap za kontrolki ornamentu lub naci-

śnij R  i zacznij obracać obiekt: 

 

Rysunek 3.5.12 Obrót obiektu dookoła kursora 3D 

Po zakończeniu operacji przestaw menu Pivot Point z powrotem na opcję Bounding Box Center (aby podążać 

za dalszymi krokami tej sekcji). Alternatywnie możesz się przełączyć na tryb Individual Centers. 

W zakładce View przybornika ( N ) możesz także znaleźć aktualne współrzędne kursora 3D (Rysunek 3.5.13a). 

Możesz także zmieniać wartości w tych polach (czasami to najszybsza metoda ustalenia nowego położenia): 

                     

Rysunek 3.5.13 Przybornik: informacja o kursorze 3D i wybranych obiektach 

W zakładce Item przybornika znajduje się panel Transform z położeniem, obrotem i skalami aktywnego obiektu 

(Rysunek 3.5.13b). W tych polach możesz zmieniać ich wartości, jeżeli chcesz je ustalić bardzo dokładnie.    

 

Ustawienia okna 3D, omawiane do tej pory w tym rozdziale, dotyczyły pojedynczego okna. Tryb 

Transformation Pivot Point dotyczy całej sceny (wszystkich okien). 

  

Środkiem tego obrotu 
jest kursor 3D  

Camera.Target – 
obiekt obracany 
 

a b 

Współrzędne 
kursora 3D 

Współrzędne 
aktywnego 

obiektu 

Możesz wyłączyć współrzędne z 
ewentualnych transformacji klika-
jąc w „kłódki” z prawej strony pola 
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W trakcie transformacji (obrotu, przesunięcia, zmiany skali…) można także wprowadzić dokładne wartości prze-

sunięć za pomocą klawiatury. Wystarczy po wywołaniu transformacji nacisnąć klawisz =  (Rysunek 3.5.14): 

                          

Rysunek 3.5.14 Przełączenie w tryb ręcznego wpisywanie wartości transformacji 

Przełącza to Blendera w tryb, w którym w miejscu pierwszej współrzędnej pojawia się linia karetki – i możesz 

wpisać nową wartość z klawiatury). Aby przejść do następnego pola, naciśnij Tab  (Rysunek 3.5.15b):  

 

 

 
 

 

 

 

 

 

Rysunek 3.5.15 Wpisywanie dokładnych wartości przesunięć 

Aby zaakceptować wprowadzone zmiany naciśnij Enter , a aby z nich zrezygnować – Esc . 

Teraz powiedzmy co zrobić, gdy się pomyliliśmy i chcemy wycofać dokonane zmiany. Jak większość edytorów, 

Blender umożliwia wielokrotne wycofanie (Undo) i powtórzenia (Redo) ostatnio wykonanych poleceń. Są to 

operacje na tyle ważne, że ich skróty od razu umieszczę w ramkach: 

Menu Edit jest jednym z głównych menu rozwijalnych Blendera, umieszczonych w pasku u góry ekranu 

(topbar). Mam nadzieję, że szybko odnajdziesz tam te polecenia (człowiek zawsze szuka ich w stresie). 

 

Jeżeli zaznaczyłeś wiele obiektów i wpisujesz nową współrzędną X w pole Item:Location przybornika 

(por. Rysunek 3.5.13b), przesunięciu ulegnie tylko aktywny obiekt.  

  

 

Undo – wycofanie ostatniego polecenia: naciśnij Ctrl - Z  (albo wybierz z menu Edit→Undo). 

  

 

Redo – odwrócenie ostatniego Undo: naciśnij Ctrl - Shift - Z  (albo wybierz z menu Edit→Redo). 

  

Możesz także przejść w ten 
tryb poprzez naciśnięcie na 
klawiaturze jakiejkolwiek cyfry 

Blender wyświetla tutaj 
współrzędne aktualnej 
transformacji  
 

Press =  

W pierwszej współrzędnej pojawił 
się kursor tekstowy: teraz możesz 
wpisać dokładną wartość Dx. 
 

Tab  

Naciśnij Tab  by 

przejść do następnej 
współrzędnej 

W tych nawiasach 
Blender pokazuje 

dystans aktualnego 
przesunięcia 

Tutaj widać wprowadzaną wartość.  
Możesz wpisać także wyrażenia 
Pythona, np. “1-cos(3*pi/180)” 
 

Gdy zaczynasz wpisywać nową wartość 
Dy, Blender pokazuje ją wraz z karetką. 
 



70 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Na koniec krótko omówimy skalowanie (Scale). Podobnie jak w przypadku Move, możesz uruchomić ten tryb 

wybierając polecenie z paska narzędzi (Rysunek 3.5.16a) lub klawiszem S  (Rysunek 3.5.16b):  

    

Rysunek 3.5.16 Skalowanie: wywołane z paska narzędzi lub skrótem klawiatury 

Kliknięte narzędzie z paska wyświetla ornament opisany przez Rysunek 3.5.16a). Gdy wywołasz to polecenie 

skrótem S  (polecenie Object→Transform→Scale), każdy ruch myszki zmienia rozmiar zaznaczonych obiek-

tów. Podobnie jak w poprzednich przypadkach, możesz tu używać klawiszy Shift , X , Y , Z , aby ograniczyć tę 

transformację do pojedynczej płaszczyzny lub osi. Wciśnięcie kombinacji Ctrl - Shift  zaokrągla aktualny współ-

czynnik skali do drugiego miejsca po przecinku. 

Oczywiście, w menu Object→Transform możesz znaleźć więcej poleceń. Nie przejmuj się tym, że ich nazwy 

wyglądają nieznajomo. Niektóre z nich są tak specyficzne (jak To Sphere), że nigdy nie użyłem ich w praktyce. 

Te, które są nam potrzebne, omówię powoli w dalszych rozdziałach tej książki. 

 

 

 

W dalszym tekście będę sygnalizować ograniczenie obrotu do jednej osi pisząc np. „obróć teraz 

obiekt wokół globalnej osi Z”. Oznacza to tyle, że po wywołaniu obrotu (np. naciśnięciem R ) masz 

jeszcze nacisnąć klawisz Z . W ten sposób wskazuję tylko kierunek osi obrotu. Środek tej transforma-

cji może być w różnych miejscach (kursorze 3D, środku aktywnego obiektu, itp.) który będę wskazy-

wać oddzielnie.  

  

 

Kompletny opis wszystkich dostępnych transformacji znajdziesz w dokumentacji online Blendera: 

Scenes & Objects:Objects:Editing:Transform. Inna jej sekcja krótko opisuje ornamenty wyświetlane 

przez pasek narzędzi: Editors:3D Viewport:Display:Viewport Gizmos. 

  

Kliknij w 
Scale   

Jednorodna 
zmiana skali (we 
wszystkie strony) 

Rozciągnięcie 
wzdłuż jednej 
osi (tutaj: X) 

 

Alternatywnie: 

skrót S   

Aktualne współczynniki skali  

“Ciągnij”, aby 
zmienić rozmiar 

obiektu 

Kliknij LPM  aby 

potwierdzić 
nową skalę   

 

a b 

Skalowanie w jednej 
płaszczyźnie  (tutaj: XY) 

 

https://docs.blender.org/manual/en/latest/scene_layout/object/editing/transform/index.html
https://docs.blender.org/manual/en/latest/editors/3dview/display/gizmo.html
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Podsumowanie 

• Przesunięcie – klawisz skrótu G  (jak ang. grab lub Move – str. 62). 

• Obrót – klawisz skrótu R  (Rotate – str. 66, 68). 

• Skalowanie – klawisz skrótu S  (Scale – str. 70). 

• Klawisz Ctrl  wciśnięty podczas transformacji zmienia współrzędne w sposób krokowy (str. 64). 

• Klawisz Shift  wciśnięty podczas transformacji zwiększa precyzję myszki (str. 65). 

• Możesz ograniczyć transformację do pojedynczej osi za pomocą skrótów X , Y , lub Z  (str. 64). To pozwala 

przesuwać, obracać I skalować nawet w widoku perspektywicznym! Uwaga: gdy naciśniesz klawisz skrótu 

dwa razy, transformacja będzie ograniczona do tzw. lokalnej osi obiektu. (Gdy obiekt się obraca, jego układ 

lokalny obraca się wraz z nim). Naciśnięcie tego samego klawisza po raz trzeci przełącza Blender z powro-

tem do swobodnej transformacji w płaszczyźnie ekranu. 

• Skrót Shift  – <oś>  wyłącza (blokuje) odpowiednią oś z transformacji: Shift - X , Shift - Y , Shift - Z . 

• Możesz ustawić środek obrotu lub skalowania w tryb 3D Cursor lub Bounding Box Center (str. 67). Możesz 

także zmieniać ten tryb w menu myszki, wywoływanym klawiszem . . 

• Aby zrezygnować z aktualnej operacji – naciśnij Esc  (str. 62, 69). 

• Aby cofnąć (Undo) ostatnią operację – Ctrl - Z  (str. 69). 

• Aby powtórzyć (Redo) operację wycofaną ostatnim Undo – Shift - Ctrl - Z  (str. 69). 
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3.6 Okno właściwości (Properties) 

Na koniec tego rozdziału chciałbym pokazać, jak otrzymać efekt końcowy projektu – wyrenderowany obraz mo-

delu. W tym celu trzeba będzie coś kliknąć i coś przestawić w oknie właściwości (Properties). To okno jest do-

myślnie umieszczone z prawej strony ekranu Blendera (Rysunek 3.6.1):  

 

Rysunek 3.6.1 Elementy okna właściwości (Properties) 

W tym oknie są wyeksponowane wewnętrzne właściwości sceny, modelu, pojedynczej części, materiału, tekstu-

ry... Na pierwszy rzut oka roi się w niej od kontrolek. Zacznę więc od wyjaśnienia jego wewnętrznej struktury. 

Wzdłuż lewej krawędzi jest lista zakładek, grupujących różne kategorie właściwości aktywnego obiektu. Właści-

wości w zakładce są grupowe w panele (sekcje) związane z jakimś szczegółowym zagadnieniem (Sampling, 

Ambient Occlusion, … – Rysunek 3.6.1). Poniżej nagłówka okna jest podana nazwa bloku danych, którego 

dotyczą wyświetlane właściwości (to pojęcie dokładniej wyjaśniam na str. 626). Zakładka otwarta na ilustracji 

powyżej nazywa się Render i pokazuje właściwości bloku danych aktualnej sceny, o nazwie Airborne. 

 
Każda panel ma nagłówek. Jest w nim wyświetlana nazwa panelu. Z lewej strony nazwy umieszczono przycisk 

umożliwiający zwijanie i rozwijanie (Rysunek 3.6.2):  

                

Rysunek 3.6.2 Obsługa panelu – zwijanie i rozwijanie 

Zakładki są podzielone 
na panele (sekcje)  

Blok danych poniższych 
właściwości to w tej za-
kładce aktualna scena   o 
nazwie Airborne 

Zakładki, grupujące róż-
ne kategorie właściwości 
aktywnego obiektu    

Nagłówek paneli 
Kliknij tu LPM  aby rozwinąć 

nagłówek w panel 

Kliknij tu LPM  aby zwinąć 

panel w nagłówek 

 

Wyświetla właściwości aktywne-
go obiektu (lub obiektów, w któ-

rych się znajduje – np. sceny) 
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Po prawej stronie nagłówka panelu znajduje się „uchwyt” . Możesz go „złapać” LPM  i przesunąć panel w nowe 

miejsce (Rysunek 3.6.5): 

                                

Rysunek 3.6.3 Obsługa panelu – przesuwanie 

Pozycje wszystkich paneli (i w ogóle – cały stan interfejsu użytkownika) jest zachowywany w pliku Blendera. 

(Gdy otworzysz plik, wszystko na ekranie Blendera będzie wyglądać dokładnie tak, jak w momencie wywołania 

polecenia File→Save. To bardzo wygodne) 

Często panele wybranej sekcji nie mieszczą się na ekranie. Wtedy musisz przesuwać zawartość okna 

Properties. Możesz to zrobić używając suwaka (Rysunek 3.6.4a), umieszczonego przy krawędzi okna, lub po 

prostu przesuwając myszkę z wciśniętym SPM  (Rysunek 3.6.4b): 

                                 

Rysunek 3.6.4 Okno Properties – dwie metody przesuwanie zawartości 

“Złap” (LPM ) 

ten uchwyt … 

… przeciągnij 
go w dół … 

… i zwolnij 
LPM  w nowym 

miejscu: 

a) b) 

Przewijaj panele 
obracając KM  

Przewijaj panele używając 
tego pionowego paska. 
(Pojawi się, gdy zbliżysz 
kursor myszki do prawej 
krawędzi okna Properties) 
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Zakładki okna Properties odpowiadają typowym czynnością wykonywanym podczas pracy nad sceną. Jedne są 

modelowania, inne dla materiałów i tekstur, a jeszcze inne – do parametrów renderowania (Rysunek 3.6.5):  

 

Rysunek 3.6.5 Typowe zestawy paneli okna Properties 

Ilustracja powyżej przedstawia zakładki typowego obiektu „geometrycznego”. Zakładka Object Data wyświetla 

właściwości jego siatki (ang. mesh). Jest to powierzchnia 3D zbudowana ze ścian, ich krawędzi i wierzchołków. 

Zakładka Material pojawia się tylko dla takich elementów „z siatką”.  

W Blenderze istnieją także obiekty bez siatek, np. źródła światła (Lamp), albo kamery. Rysunek 3.6.6a) przed-

stawia sekcje, które są wyświetlane dla obiektów typu Lamp, a Rysunek 3.6.6b) – dla obiektów typu Camera: 

                       

Rysunek 3.6.6 Warianty zestawów dla różnych typów Object Data 

W sekcji Object Data, która dla siatek miała ikonę „trójkąta” (por. Rysunek 3.6.5b), dla obiektu Lamp jest „ża-

rówka” (Rysunek 3.6.6a). Ikona kamery mówi sama za siebie Rysunek 3.6.6b). Zauważ, że Blender nie wyświe-

tla dla świateł i kamer zakładek Particles i Material. 

 

Jeżeli w tym momencie takie określenia jak “materiał”, “tekstura”, czy „siatka” brzmią abstrakcyjnie – 

nie przejmuj się, wyjaśnię je w dalszych częściach książki. 

  

Render: generowanie finalnego obrazu lub animacji  

Scene: szczegóły aktualnej sceny 

Render Layers: dla graficznych efektów specjalnych 

Output: (renderowania): rozmiar finalnego obrazu, itp.   

World: definicja “otoczenia” wokół aktualnej sceny 

Object: aktywny obiekt (nazwa, położenie, itp.) 

Modifiers: odwracalne efekty: fazowanie, zaokrąglenia, itp. 

Particles: efekty specjalne jak trawa, włosy 

Physics: dynamika na potrzeby animacji  

Object Constraints: np. śledzenie kamery i wiele innych 

Object Data: w tym przypadku: właściwości siatki obiektu 

Material: przypisane do obiektu 

Texture: aktywnego “pędzla” (dla trybu malowania w 3D) 

Właściwości 
aktywnego 

obiektu 

Pewne właściwości z tej za-
kładki są także widoczne w 
nagłówku okna (Tool Options) 

Active Tool i inne ustawienia przestrzeni roboczej  

Object Data: 
parametry 

źródła światła 

Object Data: 
parametry 

kamery 

a) b) 
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Tabela 3.6.1 podaje zestawienie zestawów jakich przyjdzie nam używać w dalszych rozdziałach tej książki:  

Zestaw Opis 

 Active Tool 
Wyświetla opcje aktualnie wybranego narzędzia. Górna część tej zakładki jest także 

dostępna w nagłówku okna (Tool Options), a dolna – w przyborniku ( N ) 

 Render 

Obsługa tworzenia ostatecznego obrazu (renderowania), w szczególności: wybór 

tzw. silnika renderowania. Na koniec tej sekcji pokażę, o co chodzi. 

 Output 
Szczegóły wynikowego obrazu (lub animacji): rozdzielczość, format pliku, itp. Będę 

je ustawiać pod koniec tej sekcji. 

 Scene 

Właściwości sceny, np. wybór aktywnej kamery, ustawienie jakiejś drugiej sceny w 

charakterze tła. Jeden z dodatków do „pozowania” samolotu (wysuwanie u chowanie 

podwozia, ruchy sterów, itp.), który będziemy używać (Handle Panel) umieszcza 

swoje panele w tej sekcji. 

 World 

Sterowanie parametrami otoczenia sceny (np. kolor i/lub obraz tła, światło rozpro-

szone, itp.) 

 Object 
Właściwości obiektu: aktualne położenie, orientacja, nazwa, i inne (np. kolekcje, do 

których należy).  

  

Object Constraints 

Zarządzanie ewentualnymi ograniczeniami obiektu. Na przykład – kamera 

Camera.Tracked jest zawsze jest skierowana na model Ła-5, bo ma przypisane 

ograniczenie Track To. To ograniczenie zawsze kieruje wybraną oś kamery na obiekt 

Camera.Target). 

 Modifiers 
Sekcja wyświetlana tylko dla obiektów „geometrycznych” – czyli zawierających siatki 

(mesh). Pozwala w sposób „odwracalny” wzbogacić siatkę o dodatkowe efekty, np. 

wygładzania powierzchni (powierzchniami podziałowymi Catmull-Clarka). 

, , , … 

Object Data 

Właściwości „zawartości” obiektu: siatki (obiekt typu Mesh), albo źródła światła 

(Lamp), albo kamery (Camera), albo jeszcze innych typów obiektów (np. linii krzywej 

– Curve). 

 Material 

 

Ustalanie ogólnych właściwości materiału obiektu (kolor i połyskliwość powierzchni, 

przejrzystość, rzucanie cieni, i wiele innych aspektów). Jednak w przypadku bardziej 

złożonych materiałów będziemy to robić w specjalnym oknie Shader Editor. 

 Texture 

 

Zarządzanie teksturami. Są to obrazy rastrowe, używane przez niektóre modyfikato-

ry siatki (np. Displacement) jako „mapy wysokości”, albo jako wzory na pędzlu trybu 

Texture Paint. (W Blendrze można „malować” modele bezpośrednio w oknie 3D) 

 Particles 
Z tej sekcji skorzystamy pod koniec książki do zamodelowania trawy lotniska, na 

którym postawimy nasz model. 

Tabela 3.6.1 Zestawienie wybranych zestawów i podzestawów paneli 

Korzystając z tej tabeli, będziesz rozumiał co mam na myśli, gdy napiszę: „w oknie Properties, zakładce 

Material”, lub „wybierz zakładkę Material”, lub „w zakładce Properties:Material”. (Wszystkie oznaczają to samo). 

Wybacz, jeżeli dotychczasowe wprowadzenie było trochę przydługie. Chciałem przybliżyć szczegóły posługiwa-

nia się systemem zakładek okna Properties i ich paneli. Zresztą – panele napotkasz także w innych oknach. 



76 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

W istocie wygenerowanie ostatecznego obrazu lub animacji w Blender możne się sprowadzić do naciśnięcia 

pojedynczego przycisku. (Za chwilę podam, który to jest). Nim to jednak zrobię, omówię kilka opcji, określają-

cych postać obrazu, jaki uzyskamy. Przy tej okazji wyjaśnię pokrótce nietypowe szczegóły kontrolek Blendera. 

Przejdź do zakładki Output. Rysunek 3.6.7 przedstawia podstawowe rodzaje kontrolek, wykorzystywanych 

przez GUI Blendera na przykładzie paneli o nazwach Dimension i Stereoscopy: 

                

Rysunek 3.6.7 Podstawowe rodzaje kontrolek Blendera 

Na szczęście w ostatnich latach projektanci Blendera wykonali znaczący krok naprzód w adaptacji jego interfej-

su użytkownika do powszechnych standardów1. Rysunek 3.6.7a) przedstawia wiele różnych kontrolek. Niektóre 

z nich to zwykłe pola numeryczne (bez granic). Dla wartości ze znanymi granicami (jak %) stosuje się suwaki. 

Na ilustracji widać także pola wyboru. Takie pole w nagłówku panelu włącza/wyłącza jego całą zawartość. 

Po prawej stronie nagłówka panelu Dimensions znajduje się ikona listy. Gdy w nią klikniesz (oczywiście LPM) 

rozwija listę predefiniowanych formatów renderowania (Rysunek 3.6.7b). Gdy wybierzesz jeden z nich, Blender 

wypełni odpowiednimi parametrami wszystkie pola panelu Dimensions. Możesz także użyć pola tekstowego i 

znaku [+] u dołu tej listy, aby zachować swoje własne ustawienia. To zapisuje aktualną zawartość paneli pod 

wpisaną w pole tekstowe nazwą. Znak [-] po prawej stronie każdego elementu usuwa go z tej listy. 

W panelu Dimensions widać także klasyczną, „stałą” listę rozwijalną o nazwie Frame Rate. Gdy lista alternatyw 

jest dostatecznie krótka, projektanci UI używają tzw. paska wyboru (radial buttons) . Przykład takiego paska 

znajdziesz w panelu Stereoscopy (Rysunek 3.6.7a). W tym panelu znajduje się także przykład złożonej kontro-

lki: klasyczna lista. Użyj przycisków [+]/[-] po jej prawej stronie do dodawania/usuwania pozycji. W większości 

takich list możesz zmieniać nazwy ich elementów poprzez podwójne kliknięcie ( LPM) w ich nazwę. To otwiera 

tymczasowe pole tekstowe, w którym możesz ją zmienić. Więcej na temat obsługi list znajdziesz na str. 458. 

 
1 To była długa droga – w pierwszej dekadzie tego wieku Blender był znany ze swojego niestandardowego interfejsu użytkownika. W tam-

tych czasach każdy rodzaj kontrolki wyglądał jak przycisk! Ta konwencja oraz odwrócone domyślnie klawisze myszki (z których zrezygno-

wano dopiero w Blenderze 2.8) często zniechęcały początkujących. 

Pole numeryczne 
(ogólne) 

Lista 
rozwijalna 

Pole numeryczne 
(suwak)  

Pole wyboru 
(checkbox) 

To pole 
włącza cały 

panel 

a) b) 

Wybrana 
opcja  

Pole 
tekstowe 

Gotowe definicje 
rozmiarów obrazu 

Pasek wyboru 
(radial buttons) 

Kliknij tutaj 

Tu możesz zapisać 
własną definicję 

Lista 
(por. str.  

458) 
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Czasami lista rozwijalna ma wiele kolumn. Pokaże to na innym przykładzie. W zakładce Output znajduje się 

panel Output (jest jedną z ostatnich). Zawiera listę rozwijalną z której możesz wybrać domyślny format zapisu 

wyrenderowanego obrazu (Rysunek 3.6.8):  

                  

Rysunek 3.6.8 Wybór domyślnego formatu pliku obrazu/animacji – inna postać listy rozwijanej 

Gdy wybierzemy jako format zapisu Jpeg, warto sprawdzić wartość w polu numerycznym Quality (Rysunek 

3.6.8). Format Jpeg jest jednym z tzw. formatów degradujących (jakość obrazu) za cenę mniejszego rozmiaru. 

Za pomocą wartości Quality (wyrażonej w procentach) można sterować kompromisem pomiędzy rozmiarem a 

jakością. Jeżeli Quality = 100%, to żadna degradacja nie zachodzi (każdy piksel obrazu jest pamiętany oddziel-

nie). Takie pliki będą miały oczywiście największy rozmiar. Osobiście radzę ustalić wartość Quality dla Jpeg na 

85% – daje to jeszcze nie za duży plik, i jednocześnie w miarę dobrą jakość rezultatu. 

 
A jak to wpisać? Zapewne dla większości Czytelników jest to oczywiste, ale opiszę tu to w paru słowach. Być 

może przy okazji dowiesz się jakiegoś przydatnego szczegółu. 

Pole Output:Quality jest „suwakiem”, więc ma ograniczony zakres dopuszczalnych wartości (od 0% do 100%). 

Blender wypełnia suwak dwoma barwami, przy czym granica tych kolorów odpowiada aktualnej wartości kontro-

lki. Wartość suwaka możesz zmienić, przesuwając ponad nim myszką z wciśniętym LPM  (Rysunek 3.6.9): 

 

 

 

                              

Rysunek 3.6.9 Zmiana wartości pola numerycznego za pomocą myszki 

Jeżeli tylko raz klikniesz w pole numeryczne LPM  (lub naciśniesz na nim Enter ), przełączysz je w stan edycji, w 

którym możesz po prostu wpisać dokładną wartość (Rysunek 3.6.10): 

 
 

 

                              

Rysunek 3.6.10 Zmiana wartości pola numerycznego poprzez wpisanie 

Co ciekawe – można tu także wpisać wyrażenie arytmetyczne: np. „100/3”, a nawet coś z nawiasami! To działa 

jak kalkulator, podstawiając wynik operacji jako nową wartość pola numerycznego. 

 

W tym panelu ustalasz wartość domyślną, którą można potem zmienić przy zapisie finalnego obrazu.  

  

Domyślny 
format obrazu/ 

animacji 

Lista rozwijalna 
może mieć więcej 
niż jedną kolumnę 

Kontynuacja 
kolumny Image 

Naciśnij LPM  ponad 

suwakiem… … i przeciągnij 
go w poziomie! 

Kliknij tutaj LPM  i wpisz 

nową wartość… 

… i pole jest 
uaktualnione! 

… Enter , gdy 

skończyłeś … 
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Częściej spotykaną postacią pola numerycznego jest wersja „ze strzałkami” . Takie pole może nie mieć ograni-

czeń na wpisywane wartości. W sekcji Dimensions:Resolution możesz znaleźć zespół trzech pól numerycz-

nych, sterujących rozmiarem renderowanego obrazu. Dwa górne – X i Y – są polami „ze strzałkami”, określają-

cymi szerokość i wysokość rezultatu (w pikselach)1 (Rysunek 3.6.11): 

 

 

 

                          

Rysunek 3.6.11 Dwie metody zmiany wartości zwykłego pola numerycznego 

Klikając LPM  w „strzałki”, umieszczone po lewej i prawej stronie pola, możesz zmniejszać i zwiększać wyświe-

tlaną wartość (Rysunek 3.6.11a). Każde kliknięcie oznacza zmianę o ustaloną „krok” (w tym przypadku – o 1 

piksel). To dobre dla jakiś małych poprawek, ale jeżeli to pole ma zawierać zupełnie inną wartość – najlepiej ją 

bezpośrednio wpisać (jak to pokazuje Rysunek 3.6.11b i Rysunek 3.6.10).  

Każdym polem numerycznym możesz się posługiwać jak suwakiem – przeciągając ponad jego obszarem 

myszką z wciśniętym LPM  (por. Rysunek 3.6.9). Trzymając wciśnięty klawisz Ctrl , zmienisz je o zaokrąglone 

wartości. To podobna konwencja jak podczas przesuwania obiektów (por. str. 64, Rysunek 3.5.6).  

Oczywiście, możesz także kopiować ( Ctrl - C ) lub wklejać ( Ctrl - V ) zawartość pól Blendera do/ze schowka. 

Za pomocą myszki możesz także zaznaczyć pola jak obiekty w przestrzeni 3D. To przydaje się przy zmianie 

wartości powiązanych pól, jak współrzędne. Rysunek 3.6.12 pokazuje to na przykładzie współczynników skali: 

 

 

 

 

                                   

Rysunek 3.6.12 Jednoczesna zmiana dwóch powiązanych pól numerycznych 

Gdy wpisujesz nową wartość w jedno z tych pól (Rysunek 3.6.12c) Blender wprowadza te same wartości w 

pozostałych zaznaczonych polach.   

Czy zwróciłeś uwagę, że gdy w panelu Dimensions zmieniliśmy wysokość renderowanego obrazu (Rysunek 

3.6.11),  od razu zmieniło to proporcje okna kamery, wyświetlanej w jednym z widoków 3D? 

 
1 Umieszczony poniżej suwak pozwala uzyskiwać mniejsze wersje obrazów. To ułatwia testowanie. Im większy rozmiar obrazu wynikowego, 

tym dłużej się generuje. Szybkie testowe rendery wykonuje się do obrazów o rozmiarach 50% lub 75% rozmiarów finalnego obrazu. 

 

Aby zrezygnować z wpisywanej zmiany (Rysunek 3.6.11b), użyj klawisza Esc .  

  

 

W Blenderze nie ma przycisków „OK.”, czy „Akceptuj”. Wszystko, co ustawisz za pomocą jakiejkol-

wiek kontrolki w oknie przycisków lub przybornikach, natychmiast jest odwzorowane na scenie. 

Kliknij (LPM ) w te 

strzałki, aby zwięk-
szyć lub zmniej-
szyć wartość pola 

b) a) 

 

Można ją 
także wpisać 

Jeżeli zwolnisz LPM  po kroku  

a) – wpisując w jedno z pól 
wartość, wpisujesz je w obydwa  
 

Aby zmienić obydwie 

wartości, wciśnij LPM  i 

przesuń myszkę poziomo 

Trzymając LPM  wciśnięte, 

przeciągnij myszką zazna-
czony (ciemniejszy) obszar 

a) b) c) 
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Taka „natychmiastowość” efektu jest w zasadzie bardzo wygodna. Gdy zmieniasz jakiś parametr (na przykład 

obrót lub skalę obiektu) w sposób ciągły, przeciągając myszkę, w oknie 3D możesz na bieżąco obserwować 

wpływ tych zmian na obiekty sceny. To działa dobrze, gdy czas odświeżenia ekranu wszystkich okien Blendera 

jest odpowiednio krótki. Gorzej, gdy Twój komputer nie ma żadnego specjalnego akceleratora grafiki. Gdy w 

trzech różnych oknach 3D masz wyświetlone kilkaset tysięcy ścian takiego modelu jak ten Ła-5, i zaczynasz 

przesuwać myszką jakiś suwak, możesz zauważyć jego „opór” – wyświetlane w kontrolce wartości nie będą się 

zmieniać natychmiast. Dzieje się tak dlatego, że każda zmiana tej kontrolki wymaga ponownego narysowania 

modelu w każdym z okien programu! To nie jest jakaś wielka niedogodność, ale można zmniejszyć takie opóź-

nienia pracując tylko na warstwach, które są w danym momencie potrzebne. 

Wróćmy jeszcze na chwilę do panelu Render:Output, gdyż zawiera jeszcze jeden rodzaj kontrolki: pole teksto-

we na nazwę pliku (Rysunek 3.6.13). W pole tekstowe wpisujesz nową wartość tak samo jak to robisz w polu 

numerycznym – klikasz LPM , wpisujesz, a na koniec naciskasz Enter . Podczas wpisywania są dostępne typowe 

operacje na tekście: możesz zaznaczyć i usunąć fragment:   

 

 

 

 

 

Rysunek 3.6.13 Wyspecjalizowane pole tekstowe: wybór ścieżki i jego okno dialogowe 

Zauważ, że pole w tym przykładzie jest przykładem kontrolki „złożonej”. Z prawej strony ma niewielką ikonę 

otwartego folderu. Gdy klikniesz w nią, na ekranie pojawi się okno wyboru plików (File View, por. str. 423). Przy-

pomina standardowe okno Windows . Można w nim wskazać odpowiednią ścieżkę.  

Oczywiście, możesz także wprost wpisać całą ścieżkę w to pole. Zwróć uwagę, że domyślnie zaczyna się ono 

od podwójnego ukośnika: „//”. To tak zwany „znacznik ścieżki względnej”. Jest on także włączony (przełącznik 

Relative path w przybornik) w oknie File View (Rysunek 3.6.13) Czytając ten wpis, Blender zastępuje „//” odpo-

wiednią ścieżką początkową – zazwyczaj miejscem, gdzie znajduje się aktualny plik z rysunkiem. Dzięki temu 

można przesuwać folder z rysunkiem i wszystkimi plikami towarzyszącymi z jednego miejsca na dysku na dru-

gie. Przy konsekwentnym stosowaniu znacznika „//” na początku ścieżek nie ma niebezpieczeństwa, że Blender 

nie będzie mógł czegoś znaleźć po takim przeniesieniu. 

 
Myślę, że na tym zakończymy nasze wprowadzenie do okna Properties i kontrolek Blendera.  

 
 

Pole tekstowe. Można 
tu wpisać nazwę pliku 

 
okno File View  

Wyświetl 
przybornik 
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Wreszcie – wygenerujmy finalny obraz dla tej sceny! Z menu Render (u góry ekranu) wybierz polecenie Render 

Image (Rysunek 3.6.14).  Możesz także nacisnąć skrót tego polecenia: klawisz F12 . Blender otworzy wówczas 

nowe okno, zawierające Image Editor: 

 

 

 

Rysunek 3.6.14 Renderowanie pojedynczego obrazu 

Początkowo okno jest puste, ale po kilku sekundach pojawi się w nim finalny obraz, jak powyżej. Zwróć uwagę, 

że nagłówek Image Editor jest wyświetlany u dołu obszaru. Aby zachować stworzony przez program obraz, użyj 

polecenia Image→Save As (Rysunek 3.6.15): 

 

Rysunek 3.6.15 Zapisywanie finalnego obrazu na dysk  

Otwiera okno Render i zaczyna gene-
rowanie (renderowanie) obrazu 

Ten obraz pojawi się 

po kilku sekundach 
To specjalny edytor dla obrazów rastrowych  

Otwiera okno File View 

(Rysunek 3.6.13) 
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Obraz na poprzedniej stronie został wygenerowany przez renderera o nazwie Eevve. Jest szybki, ale jego re-

zultat przypomina ekrany współczesnych gier komputerowych. Cienie są głębokie, a rozmycie ruchu łopat śmi-

gła jest minimalne. Eevve nadaje się do renderów testowych. 

Dla bardziej realistycznego rezultatu, w panelu Render wybierz renderer o nazwie Cycles (Rysunek 3.6.16): 

                           

Rysunek 3.6.16 Przełączanie renderowanie sceny na Cycles  

Kluczowym parametrem Cycles jest liczba próbek (Samples). Przyczyna stanie się jasna, gdy uruchomisz po-

nownie renderowanie (Rysunek 3.6.17): 

 

 

 

 

 

 

 

 

 

 

 

 

Rysunek 3.6.17 Stopniowa poprawa renderowanego obrazu  (Cycles)  

Początkowo będziesz widział zgrubne przybliżenie ostatecznego obrazu. Jego cienie i szklane powierzchnie 

zawierają mnóstwo „czarnego szumu”. Następnie, z każdą kolejną próbką, ten obraz zacznie się poprawiać: 

szkło uzyska połysk, cienie staną się „gładkie”. Cycles zatrzymuje się po wykonaniu zadanej liczby próbek. 

Wybierz Cycles 

Ważny parametr  

Może być także CPU  

Ciemny “szum” w cieniu i na 
szklanych powierzchniach 

Próbka: 4/300 

Próbka: 300/300 
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Wybór optymalnej liczby próbek zależy od Ciebie. Większa ich liczba oznacza dłuższy czas renderowania ale 

lepszą jakość wyniku. Z drugiej strony, pierwsze 20-30 próbek wprowadza największe zmiany w renderowanym 

obrazie, potem wpływ kolejnych jest już coraz mniejszy. Zazwyczaj będziesz próbował znaleźć najmniejszą 

liczbę próbek przy której Cycles tworzy rezultat o akceptowalnej jakości. Najbardziej czasochłonnymi elemen-

tami sceny są duże przejrzyste powierzchnie, jak szkło czy woda. Te elementy w scenie z Ła-5 (Rysunek 

3.6.17) są relatywnie małe. Wydaje mi się, że w tym przypadku wystarczyłoby i 100 próbek. 

Podsumowanie 

• Okno Properties udostępnia właściwości aktywnego obiektu lub jego sceny. Blender wyświetla je u góry 

okna (str. 72) jako “kontekst” (data context).  

• Właściwości obiektu są pogrupowane w kilkunastu zakładkach (str. 72, 74). Niektóre z tych zakładek są za-

leżne od kontekstu (str. 74). 

• W obrębie zakładek, kontrolki są grupowane w panele (str. 72). 

• Panele można zwijać i rozwijać (str. 72) lub zmieniać ich kolejność w obrębie zakładki (str. 73). Rozwinięte 

panele mogą zajmować obszar dłuższy od okna Properties, więc można je także przewijać w górę i w dół 

(str. 73).  

• Blender zapamiętuje stan okien projektu w jego pliku (*.blend). Dzięki temu zawsze otwiera projekt dokład-

nie w takim stanie, w jakim go zapisałeś. Dzięki temu, gdy rozpoczynasz pracę w kolejnym dniu, nie tracisz 

czasu na dostosowanie środowiska.    

• Podstawowymi kontrolkami w Blenderze są pola numeryczne (str. 77, 78), pole wyboru i pasek opcji (str. 

76), lista rozwijalna (str. 76, 77), i pole tekstowe (str. 79). 

• Każda zmiana w oknie Properties jest natychmiast wprowadzana do sceny. Pola numeryczne możesz 

zmieniać w sposób ciągły poprzez przeciągnięcie myszki (jak na str. 77, 78) I obserwować w oknie 3D ich 

wpływ na model. Takie “animowane” aktualizacje pozwalają szybciej zrozumieć, jak zmieniany parametr 

działa na scenę.  

• Aby zrenderować scenę, użyj polecenia Render→Render Image (str. 80). 

• Możesz zachować wyrenderowany obraz poleceniem Image→Save (str. 80). 

• Blender oferuje dwa alternatywne renderery: Eevee (szybszy, ale mniej “fizyczny” – str. 80) i wolniejszy, ale 

bardziej realistyczny Cycles (str. 81). 

 

 

 

 

W każdej chwili możesz przerwać proces renderowania poprzez zamknięcie jego okna. To dzięki te-

mu, że GUI Blendera nadal reaguje na wszystkie polecenia (renderowania jest wydzielonym proce-

sem). W tym czasie możesz nawet zmieniać tę scenę w innym oknie 3D.  

  

 

Dokładny opis wszystkich kontrolek Blendera znajdziesz w jego dokumentacji online: User 

Interface:Interface Controls. Jest tam także opis okna Properties, w Editors:Properties. 

  

 

https://docs.blender.org/manual/en/latest/interface/index.html#interface-controls
https://docs.blender.org/manual/en/latest/interface/index.html#interface-controls
https://docs.blender.org/manual/en/latest/editors/properties_editor.html
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Rozdział 4. Wprowadzenie do modelowania 

W tym rozdziale zaczniemy budować nasz wirtualny model. Na początek zaczniemy od prostej bryły obrotowej: 

kołpaka śmigła. Potem stworzymy coś bardziej złożonego: łopaty śmigła. W ten sposób wprowadzę Cię, Czytel-

niku, w podstawowy proces budowy modelu w Blenderze.  

Z własnego doświadczenia radziłbym zapisywać stan pracy, osiągnięty na koniec każdego dnia, do oddzielnego 

pliku (por. str. 426). Aby było jasne: na tym etapie nie spodziewam się żadnych kłopotów z Blenderem – to na-

prawdę stabilny program. Jednak, na wszelki wypadek zapoznaj się także ze sposobem odzyskiwania danych 

na str. 439. 
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4.1 Przygotowanie pliku Blendera 

Skonfiguruj środowisko Blendera tak, jak jest to podane w sekcji 10.5. Możesz to zrobić poprzez skopiowanie 

plików konfiguracyjnych towarzyszących tej książce. Znajdziesz je w katalogu source/Blender cfg (por. str. 435). 

W tej sekcji ustawimy w scenie Blendera rysunki referencyjne, przygotowane we wcześniejszych rozdziałach 

tego poradnika. Poszukaj w towarzyszących danych katalogu source/reference/drawings (por. str. 19). Otwórz 

go w Eksploratorze Plików Windows. Ustaw w oknie 3D Blendera aktualną projekcję na rzut z lewej ( 3  lub 

View→Viewpoint→Right)  i upewnij się, że jesteś w Object Mode (Rysunek 4.1.1): 

 

 

Rysunek 4.1.1 Wstawianie obrazu referencyjnego w okno 3D 

Przeciągnij plik o nazwie P-40B_side.png z okna Eksploratora Plików (wyświetlającego zawartość folderu 

source\reference\drawings) do okna 3D Blendera, jak pokazuje to Rysunek 4.1.1. „Upuść” tam ten plik. 

Gdy to zrobisz, w scenie Blendera pojawi się mały obrazek (Rysunek 4.1.2): 

 

Rysunek 4.1.2 Obraz referencyjny w Blenderze 

Jednocześnie w oknie Outliner pojawi się nowy obiekt, o nazwie Empty. To ten nowo dodany obraz. 

Object Mode 

Ustaw projekcję na 
widok z lewej 

Dane, które towarzyszą 
tej książce (por. str. 19) 

Przeciągnij i upuść obraz 
P-40B_side.png 

Ten nowy obiekt 
o nazwie Empty 
zawiera link do 

obrazu na dysku 
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Możesz ten odsyłacz zobaczyć we właściwościach (okno Properties), zakładce Object Data (Rysunek 4.1.3): 

 

Rysunek 4.1.3 Właściwości obiektu Empty (Image) 

W panelu Image znajduje się odnośnik (link) do pliku zawierającego wyświetlany obraz. Blender przechowuje 

taki odnośnik jako ścieżkę od położenia pliku projektu (oznaczonego jako „//”). Jest to więc rodzaj ścieżki 

względnej. Więcej szczegółów o właściwościach obrazów referencyjnych znajdziesz w sekcji 11.1, str. 461. 

Aby widzieć inne elementy (jak siatka sceny) poprzez ten obraz, włącz jego sterowanie nieprzejrzystością 

(Opacity) i zmniejsz je do 0.5 (Rysunek 4.1.3). Następnie umieść środek tego obiektu w punkcie (0, 0, 0). Dla 

takich obiektów sugeruję wpisywać te współrzędne w przybornik ( N ), zakładkę Item (Rysunek 4.1.4): 

 

Rysunek 4.1.4 Umieszczenie obrazu referencyjnego w środku sceny  

 

Obiekt typu Empty (Image) zawiera odnośnik (link) do pliku z obrazem rastrowym na dysku. Domyśl-

nie Blender zawsze używa odnośników. To pozwala zachować mały rozmiar pliku projektu (*.blend).  

  

W oknie Properties 
widać szczegóły 

aktywnego obiektu 

Zakładka Object Data 
(w tym przypadku – to 
właściwości obrazu) 

Ścieżka względna 
(link) do pliku obrazu  

Włącz sterowanie 
nieprzejrzystością i 
zmniejsz jej wartość 

Przesunięcie obrazu (%) 
względem jego środka 

Wpisz: X: 0, Y: 0, Z: 0 
by umieścić ten obraz 
w środku sceny   
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Teraz użyj pól Offset X/Y z panelu Empty zakładki Properties:Object Data (Rysunek 4.1.5, por. także Rysunek 

4.1.3) aby przesunąć ten obraz względem jego środka. Dopasuj linię przegrody silnika, widoczną na tym rysun-

ku, do osi Z (niebieska), i poziomą linię referencyjną kadłuba do osi Y (zielona): 

 

Rysunek 4.1.5 Dopasowanie osi obrazu do globalnych osi sceny  

W tym momencie musisz zdecydować się na konkretną „skalę” naszego modelu. Sugeruję użyć podobnej regu-

ły jak ta, której użyliśmy przygotowując rysunki referencyjne (por. Tom I, sek. 3.3). Załóżmy, że dla tego P-40: 

1 jednostka Blendera = 1 cal na prawdziwym samolocie 

Wszystkie obrazy referencyjne będziemy skalować zgodnie z tą formułą. (Cale będę oznaczał symbolem ") 

Jednak przed wywołaniem skalowania potrzebujemy punktu odniesienia. Ustal go za pomocą kursora 3D. Na 

tym planie jest podany wymiar: odległość od przegrody silnika do krawędzi spływu (262.34”). Stąd w panelu 

View:3D Cursor przybornika wpisałem następujące współrzędne: X: 0, Y: 262.34, Z: 30 (Rysunek 4.1.6): 

 

 

Rysunek 4.1.6 Umieszczanie kursora 3D w zwymiarowanym punkcie 

Wartość Z (+30) jest tylko szacunkiem odległości od osi Y miejsca o najszerszej cięciwie steru kierunku. Chcę 

tam umieścić kursor 3D, ponieważ w tym punkcie będę widział także linie skalowanego obrazu. Kiedy to zro-

bisz, pomniejsz aktualny widok, dopóki nie ujrzysz kursora 3D. Zwróć uwagę, jaki mały jest w tej chwili obraz! 

 

Zmieniaj Offset X / Y poprzez przeciąganie myszki ponad tymi suwakami (por. str. 77). Aby zwiększyć 

dokładność finalnych dopasowań, wykonaj je z wciśniętym klawiszem Shift .  

  

(okno Properties) Z 

Y 
Offset X: -32% Offset Y: -36% 

Y
(o

b
ra

z
):

 1
0
0
%

 

X(obraz): 100% 

Zmień przesunięcie obrazu, 
aby dopasować go do osi 

Przegroda 
silnika 

(firewall) 

Pozioma 
oś kadłuba  

Kursor 3D 
jest w poda-
nym punkcie 

Nasz obraz 
(taki mały) 

Dla większej czytelności 
“zwinąłem” panel View 

 

262.34 
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Do skalowania obrazu możesz użyć suwak Size z panelu Empty (por. Rysunek 4.1.5). Jednak ja stosuję ogólne 

polecenie Object→Transform→Scale ( S , por. str. 70)1. Ustaw tryb Pivot Point (por. str. 67) na Bounding Box 

Center2. Następnie skaluj ten obraz we wszystkich kierunkach jednocześnie (jednorodnym współczynnikiem 

skali). Użyj powiększeń do sprawdzania, kiedy kontur rysunku pasuje do kursora 3D (Rysunek 4.1.7): 

 

 

Rysunek 4.1.7 Skalowanie obrazu referencyjnego 

Zrobiłem to w dwóch krokach (wywołując Scale dwa razy). Najpierw zgrubnie powiększyłem ten obraz (Rysunek 

4.1.7a), używając dużego współczynnika skali. Potem wykonałem zbliżenie na krawędź spływu steru (Rysunek 

4.1.7b) i ponownie wywołałem Scale. Tym razem zmieniałem jego rozmiar o małe wartości, z wciśniętym Shift . 

Teraz sprawdźmy rezultat tej transformacji, umieszczając kursor 3D zgodnie z innymi wymiarami podanymi w 

tym rysunku. Rysunek 4.1.8 pokazuje weryfikację położenia zawiasu steru (232.5” od przegrody silnika): 

 

Rysunek 4.1.8 Użycie innych wymiarów do weryfikacji: zawias steru 

 
1 Te ogólne transformacje obiektu są szczególnie użyteczne w przypadku „surowych” obrazów, które nie były wcześniej przygotowane 

(skalowane i obracane) w Inkscape. W takich przypadkach dla zgrubnego kompensowania ewentualnych deformacji używam obrotu do 

wyrównania osi obrazu z globalnymi osiami sceny i dwóch różnych współczynników skali wzdłuż lokalnych (tj. obrazu) osi X i Y.   

2 Gdy masz zaznaczony tylko jednej obiekt (jak w tym przypadku), wszystkie opcje Pivot Point oprócz 3D Cursor dają taki sam rezultat. 

Pierwsze, zgrubne dopasowanie 
do podanej długości kadłuba  

Drugie skalowanie: 
dokładne dopasowanie 
konturu do kursora 3D. 

Zbliżenie 

a) 

b) 

Sprawdzenie 
położenia osi 
zawiasu steru 
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Rysunek 4.1.9 pokazuje ważniejszy test, dla którego umieściłem kursor 3D na czubku kołpaka śmigła. To prze-

ciwna strona przegrody silnika, więc jej współrzędna Y jest ujemna: 

 

Rysunek 4.1.9 Użycie innych wymiarów do weryfikacji: kołpak śmigła 

Suma tej odległości od przegrody (118.19”) i odległości od przegrody krawędzi spływu stru (262.34” – por. Ry-

sunek 4.1.6) daje ogólną długość P-40-cu/B/C: 380.53”1.  

Możesz użyć Measure do sprawdzania krótszych, pionowych wymiarów (Rysunek 4.1.10): 

 

Rysunek 4.1.10 Weryfikacja krótszych wymiarów 

Szczegóły „miarki” Blendera znajdziesz na str. 446. Gdybyś znalazł różnicę – skaluj ten obraz wzdłuż osi Z. 

 
1 Wszystkie częściowe wymiary w P-40 są podawane bez uwzględnienia grubości poszycia, które mogło wynosić od 0.02 do 0.05”. Zazwy-

czaj było to 0.03”. Stąd, jeżeli dodasz grubość poszycia kołpaka śmigła (0.03”) do tej długości (380.53”) otrzymasz 380.56”, co jest zgodne z 

wymiarem z rysunku poglądowego (por. Tom I). Krawędź spływu steru była uformowana z wygiętej rury o przekroju trójkątnym. Jej ze-

wnętrzna krawędź była pokryta płótnem, którego grubość nie jest uwzględniona w gabarytach samolotu. 

 

W pasku narzędzi Blendera znajdziesz funkcję Measure. Ta „miarka” przydaje się do różnych weryfi-

kacji ad hoc, ale uważam, że kursor 3D sprawdza się lepiej przy weryfikacji dłuższych dystansów. 

  

To miejsce jest po drugiej 
stronie przegrody silnika, 

stąd ujemna współrzędna Y 

Sprawdź to położenie 
czubka kołpaka śmigła 

„Miarka” – użyteczna 
do sprawdzania 

krótszych wymiarów 

Zawsze wystąpią małe odchy-
lenia, jak w tym przypadku  
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Teraz dodajmy do tej sceny rysunki Jumpei Temmy, które przygotowaliśmy w poprzednich rozdziałach. Umieści-

łem je w oddzielnym folderze: source\reference\drawings\temma\. Znajdź w nim plik o nazwie Left.png i „wrzuć” 

go do okna 3D, poniżej lub powyżej pierwszego obrazu (Rysunek 4.1.11): 

 

 

 

 

 

 

 

 

 

 

Rysunek 4.1.11 Dodanie nowego widoku z boku 

Rysunek 4.1.11 pokazuje, że nowo wstawiony do sceny obrazu jest bardzo mały (szerokość: 5 cali). Aby uczy-

nić go porównywalnym z poprzednim obrazem, powiększ go (Scale) zgrubnie (jak to pokazuje Rysunek 4.1.7a): 

 

Rysunek 4.1.12 Początkowe, zgrubne skalowanie nowego obrazu referencyjnego 

 

Jeżeli „upuścisz” ten plik na obiekt Empty (Image), Blender użyje go zamiast oryginalnego obrazu. To 

wygodna metoda na szybką podmianę rysunków referencyjnych o jednakowych wymiarach i środ-

kach. Jeżeli jednak zrobiłeś to przez pomyłkę – użyj polecenia Edit→Undo. 

  

„Przeciągnij i 
upuść” Left.png 

„Upuść” ten nowy obraz poni-
żej lub powyżej istniejących.   

Gdybyś „upuścił” ten plik 
tutaj, podmieniłbyś ten obraz 

Powiększ ten obraz (Scale) aby uczynić 
go porównywalnym do innych rysunków 

Środek skalowania: 
Bounding Box Center 

lub Median Point 



90 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Blender nadał temu nowemu obiektowi nazwę Empty.001 (Rysunek 4.1.13a). Następny byłby Empty.002, i tak 

dalej. Te nazwy bez znaczenia szybko uczyniłyby Twój projekt niemożliwym do zarządzania. Dlatego zaraz po 

dodaniu nowego obiektu do sceny, nadaj mu nową nazwę (Rysunek 4.1.13b). Czasami możesz także dodać 

nową kolekcję (por. str. 448), tak jak zrobiłem to w tym przypadku (Rysunek 4.1.13c): 

 

             

Rysunek 4.1.13 Organizacja struktury projektu (okno Outliner) 

W Blenderze te nazwy są także identyfikatorami, więc muszą być unikalne. Z tego powodu, sugeruję dodawać 

unikalne przedrostki do wszystkich obiektów i kolekcji projektu. Dla nazw rysunków referencyjnych dodaję tylko 

przedrostek „R” („R” jak „referencyjny”). To z powodu ograniczonej liczby tych obrazów na scenie: jestem pe-

wien, że „ludzka” część ich nazw będzie unikalna. Wszędzie w projekcie używam języka angielskiego.  

Zwróć uwagę, że pozostawiam „luki” w numeracji przedrostków kolekcji: 1.Blueprints, 9.Camera & Lights. To są 

miejsca dla innych zespołów („Wing”, „Empennage”, „Fuselage”), które dodamy w kolejnych rozdziałach. 

Technicznie rzecz biorąc, zmieniłem nazwę domyślnej kolekcji (Collection) na 9.Camera & Lights. Zrobiłem to 

w ten sam sposób, w jaki zmieniam nazwy obiektów (podwójne kliknięcie w etykietę i wpisanie nowej nazwy). 

Następnie użyłem przycisku z nagłówka okna Outliner (por. Rysunek 4.1.13c) aby dodać nową kolekcję. Na-

zwałem ją 1.Bluerpints. Potem odwróciłem ich kolejność przeciągając kolekcję 1 powyżej kolekcji 9. Na końcu 

przesunąłem (także metodą „przeciągnij i upuść”) obydwa obiekty z obrazami do kolekcji 1.  

W podobny sposób możesz ukrywać/odkrywać pojedyncze obiekty. Teraz schowaj pierwszy obraz (R.Side.Left 

(compiled)), jak to pokazuje Rysunek 4.1.14, gdyż zasłaniałby nam rysunek dodany przed chwilą. 

Przygotuj ten nowy obraz w ten sam sposób, w jaki przygotowaliśmy poprzedni: zmniejsz jego nieprzejrzystość, 

umieść środek (origin) na przegrodzie silnika, itd. (patrz str. 85-88). 

 

Rysunek 4.1.14 Rysunek J. Temmy, wyrównany i wyskalowany 

 

Jak pokazuje to Rysunek 4.1.13c), Ukryłem także obiekty kamery i światła klikając ikonę „oka” przy 

kolekcji 9. Zrobiłem to, gdyż nie będziemy ich potrzebować podczas modelowania. 

  

Pierwszy obraz 

Ten obraz 

a) b) c) Dodaj nową kolekcję 

Przenieś obiekty Camera i 
Light do oddzielnej kolekcji  

Zmień nazwy obrazów 

Aby zmienić nazwę, kliknij 
podwójnie (LPM ) na etykiecie 

Ukryj poprzedni obraz 

Podczas skalowania użyj zazna-
czonej na rysunku STA #1 (prze-
groda silnika) i osi zawiasu steru 
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W szczególności, całkowita długość P-40B Jumpei Temmy jest o około 1.2” większa od wymiaru podanego w 

rysunkach poglądowych Curtiss (por. Tom I, sekcja 3.3). Główną przyczyną tej różnicy jest rozmiar kołpaka śmi-

gła: na rysunkach J. Temmy wydaje się być za długi. Dodałem kilka korygujących konturów do jego rzutu z góry 

(Top.png), który znajduje się w folderze source\reference\drawings\temma\. W przypadku rzutu z boku zdecy-

dowałem się użyć do kształtowania osłony silnika mojej „kompilacji” dokumentacji źródłowej (P-40B_side.png –

to pierwszy obraz, który załadowaliśmy w tej sekcji). Te dwa widoki się uzupełniają: rysunek Temmy pokazuje 

szczegóły połączeń i nitów, podczas gdy na mojej kompilacji znajdziesz szkielet kadłuba. 

Wyciąłem te obrazy referencyjne z planów Jumpei Temmy nadając im jednolite rozmiary i położenie osi (por. 

Tom I, sekcja 3.7, Rysunek 3.7.9). Teraz ta metoda zaprocentuje. W związku z tym, że rzut z lewej (Left.png) i 

rzut z prawej (Right.png) mają te same „ramki” i środki, mogę stworzyć w Blenderze obraz rzutu z prawej po-

przez skopiowanie obiektu z rzutem z prawej i podmianę połączonego z nim obrazu.  

Zróbmy to: skopiuj obiekt R.Side.Left (Temma). Zrób to wykorzystując polecenie Object→Duplicate Objects, 

lub jego skrótu: Shift - D  (szczegóły – str. 464): 

 

Rysunek 4.1.15 Kopiowanie obrazu (widoku z boku) 

Blender nazwie ten nowy obiekt R.Side.Left (Temma).001. Zmień tę nazwę na R.Side.Right (Temma).  

Ukryj oryginalny obraz R.Side.Left (Temma) i upewnij się, że środek (origin) R.Side.Right (Temma) znajduje 

się w (0,0,0) (por. Rysunek 4.1.4). Możesz także przełączyć projekcję okna 3D na drugą stronę ( Ctrl - 3 ). Na-

stępnie przeciągnij i upuść obraz source\reference\drawings\temma\Right.png na obiekt R.Side.Right. Powi-

nieneś natychmiast zobaczyć widok z prawej, poprawnie ustawiony i wyskalowany (Rysunek 4.1.16): 

 

Rysunek 4.1.16 Podmiana obrazu referencyjnego  

 

Dlaczego używamy dwa widoki z lewej? Ponieważ występują pomiędzy nimi drobne różnice, szcze-

gólnie w okolicach osłony silnika (Tom I, sekcja 6.1, Rysunek 6.1.3 i 6.1.7).  

  

Stwórz kopię tego obra-

zu ( Shift - D ) 

Nowo 
stworzony 

obiekt 

Przeciągnij i upuść tutaj 
plik temma\Right.png  
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„Upuszczony” na obraz plik zastąpił w tym obiekcie poprzedni rysunek, zachowując dotychczasową skalę i 

przesunięcie. Włączyć widoczność obydwu rzutów z boku Temmy i sprawdź, czy do siebie pasują.  

Teraz przełącz projekcję na widok z góry ( 7 ) i „upuść” w oknie Blendera plik Top.png z tego samego katalogu 

(source\reference\drawings\temma\). Nazwij go R.Top (Temma). Powiększ ten obiekt, aby lepiej go widzieć, 

obróć o 90º i umieść w środku układu współrzędnych (0,0,0): 

 

Rysunek 4.1.17 Przygotowanie rzutu z góry  

Podczas gdy oś symetrii kadłuba już leży na globalnej osi Y, wciąć musimy dostosować Offset X tego obrazu, 

aby przegroda silnika leżała w środku (origin) obiektu. Aby w tym pomóc, linia STA #1 (t.j. Y = 0) jest zaznaczo-

na czarną linią (Rysunek 4.1.18a): 

                       

Rysunek 4.1.18 Kluczowe punkty dla skalowania widoku z góry  

Do precyzyjnego skalowania użyj jednego z wymiarów widocznych na usterzeniu. Może to być oś steru wyso-

kości, położona 230.875” od przegrody silnika (Rysunek 4.1.18b). 

 

Aby zachować w tym samym miejscu punkt środkowy obydwu widoków, Right.png jest lustrzanym 

odbiciem oryginalnej sylwetki z planów Jumpei Temmy. W Blenderze taka transformacja nie czyni 

żadnej różnicy, ponieważ każdy obraz widać z obydwu stron.  

  

Y 

X 

Przeciągnij i upuść 
plik temma\Top.png 

Przełącz 
na widok 

z góry 

a) b) 

Sta #1 (“0”) 
(przegroda 

silnika) 

Kursor 3D: 
X = -17.0, 
Y= 230.875 

Powiększ ten obraz 
aby dopasować oś 
steru wysokości do 

położenia kursora 3D 

Środek (punkt 
odniesienia) 

obiektu obrazu 
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Po tym skalowaniu, sprawdź czy końcówka każdego płata „dotyka” X=+/- 223.75” (to połowa rozpiętości P-40: 

447.5”). Możesz także wyłączyć na chwilę przejrzystość tych obrazów (por. Rysunek 4.1.3) i sprawdzić, czy na 

rzutach z góry i z boku pasują do siebie linie odpowiednich wręg (Rysunek 4.1.19): 

 

Rysunek 4.1.19 Dopasowanie widoków z góry i z boku  

Gdy wszystko wydaje się być na swoim miejscu, skopiuj obraz R.Top (Temma) w nowy obiekt, o nazwie 

R.Bottom (Temma). Następnie zastąp plik powiązany z tą kopią plikiem Bottom.png, z tego samego katalogu 

(Rysunek 4.1.20): 

 

Rysunek 4.1.20 Widok z dołu  

 

Dodatkowo możesz wykonać „lustrzane odbicie” tego obrazu, skalując go (:-1) wzdłuż osi X (por. str. 

70). W ten sposób reflektor lądowania w widoku z dołu znajdzie się na poprawnym, lewym skrzydle.  

Wyłącz kontrolkę 
Opacity dla widoków 

z góry i z boku 

Sprawdź, czy linie wręg 
pasują do siebie 

Przeciągnij tutaj i upuść 
plik temma\Bottom.png  



94 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Porównanie tego rzut z dołu z rzutami z boku potwierdziło, że w rysunkach Temmy coś jest nie tak z kołpakiem 

śmigła. W widoku z dołu, podstawa kołpaka znajduje się 92.31” od przegrody silnika. To zgadza się z wymiarem 

z dokumentacji XP-40, której użyłem w mojej „kompilacji” widoku z boku P-40B (Rysunek 4.1.21a): 

            

Rysunek 4.1.21 Problem z kształtem kołpaka śmigła na rysunku J. Temmy  

Jak wspomniałem wcześniej, długość kołpaka w rysunkach J. Temmy jest za duża (o około 1”). Co więcej, Ry-

sunek 4.1.21b) pokazuje, że linie kołpaka z rzutów z boku i dołu tych samych planów nie pasują do siebie. W 

rzutach z boku są minimalnie przesunięte do przodu. No cóż, takie niewielkie różnice mogą się zdarzyć nawet 

na najlepszych rysunkach. 

Ostatnią parą ogólnych rysunków referencyjnych są sylwetki samolotu z przodu i z tyłu. Przełącz się na projek-

cję z przodu ( 1 ), a potem przeciągnij z folderu source\reference\drawings\temma\ plik o nazwie Front.png. 

Upuść go w okno Blendera, a potem wyrównaj jego pozycję i dopasuj skalę (Rysunek 4.1.22): 

 

Rysunek 4.1.22 Widok z przodu 

Do skalowania tych obrazów, użyj rozpiętości skrzydła (223.75”). Nazwij ten obiekt: R.Front (Temma). 

a) b) 

“Skompilowany” 

rzut z boku 

Rzut z boku 

wg Temmy 

Widok z dołu wg Temmy 

(częściowo przejrzysty) 

Kołpak jest 
za długi 

118.19” od 
przegrody 
silnika 

Podstawa kołpaka 
pasuje do wymiaru 
z XP-40  

Inne położenie 
podstawy kołpaka 
w rzucie z boku  

Kołpak w rzucie 
z boku jest 

jeszcze dłuższy 

Przeciągnij i upuść tutaj 
plik temma\Front.png  

223.75” 

Skaluj ten rysunek wykorzystu-
jąc znaną rozpiętość skrzydła 

Nie używaj do skalowania tego kręgu śmigła. Zgodnie 
z rysunkami poglądowymi jego średnica to 11’ (132”), 
podczas gdy na tym rysunku to tylko 130” 

Widok z dołu wg Temmy 

(częściowo przejrzysty) 
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Możesz przesunąć ten obraz wzdłuż globalnej osi Y i sprawdzić, czy jego pozostałe szczegóły pasują do odpo-

wiedników w rzutach z góry i z dołu (Rysunek 4.1.23): 

       

Rysunek 4.1.23 Sprawdzanie widoku z przodu  

Kontur osłony kabiny pasuje do widoku z boku (Rysunek 4.1.23a). Jednak średnica podstawy kołpaka wydaje 

się być większa od konturu z widoków z góry i z dołu (Rysunek 4.1.23b). 

Skopiuj ten obiekt R.Front (Temma) i zastąp jego zawartość z obrazem Rear.png z tego samego katalogu. 

Nazwij ten nowy obiekt R.Back (Temma). Sugeruję umieścić te dwa obrazy przed kołpakiem śmigła i za krawę-

dzią spływu steru kierunku. Możesz także przesunąć obraz R.Bottom poniżej kół głównych (Rysunek 4.1.24): 

 

Rysunek 4.1.24 Ustawienie głównych rysunków referencyjnych na scenie Blendera 

Dwa pozostałe rzuty z boku (R.Side.Right i R.Side.Left (compiled)) są ukryte, ponieważ będziemy ich używać 

jako rysunków alternatywnych: gdy jeden z nich jest widoczny, pozostałe są ukryte. W istocie, w zależności od 

bieżących potrzeb będziemy także ukrywać/odkrywać pozostałe rysunki referencyjne. 

a) 
b) 

Przesuń widok z przodu wzdłuż osi Y  

Kontur osłony 
kabiny pasuje do 

widoku z boku 

Kołpak śmigła 
jest za duży 

R.Back 

R.Front 

R.Side.Left 

R.Top 

R.Bottom 
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W następnych rozdziałach dodamy do kolekcji Bluerpints dalsze szczegółowe rysunki, jak kontur skrzydła w 

rzucie z góry i jego przekroje, mechanizm głównego podwozia, i przekroje poprzeczne kadłuba. 

Dlatego aby zobaczyć lewą stronę samolotu w Blenderze (obrazy referencyjne: R.Side.Left*) musisz przełączyć 

się na projekcję o nazwie Right. Na str. 40 pokazałem podobny przypadek dla modelu Ła-5F. Mam nadzieję, że 

przyzwyczaisz się do tej konwencji. 

 

Podsumowanie 

• Pierwszym krokiem w modelowaniu 3D jest rozmieszczenie na scenie projektu rysunków referencyjnych. 

• Rysunki można łatwo wstawiać w scenę Blendera metoda „przeciągnij i upuść” (str. 84). Domyślnie, Blen-

der wstawia je jako “linki” (przechowuje relatywne ścieżki do plików obrazów we właściwościach obiektów 

Empty – por. str. 85).  

• Ustawienie obrazu referencyjnego wymaga czterech kroków: 

 1. Włącz kontrolę przejrzystości (Opacity) i zmniejsz nieprzejrzystość obrazu (str. 85). 

 2. Umieść punkt odniesienia (środek) obrazu w odpowiednim miejscu sceny (str. 85). 

 3. Popraw relatywne położenie środka obrazu (zmieniając jego wartości X/Y offset – str. 86). 

 4. Dopasuj skalę obrazu. Staraj się to robić to w oparciu o jakiś jawny wymiar (str. 86,87).  

• Zadecyduj przed ustaleniem skali pierwszego obrazu, jaką „skalę” ma mieć Twój model 3D (str. 86). 

• Sprawdź na wyskalowanym obrazie referencyjnym inne znane wymiary (str. 87, 88).  

• Organizuj obiekty referencyjne w Twoim projekcie poprzez ujednolicone nazewnictwo i grupowanie w wy-

dzielonej kolekcji (str. 90). 

• Możesz szybko zastąpić obraz wyświetlany przez obiekt Empty poprzez „upuszczenie” na nim pliku z in-

nym obrazem  (str. 91, 93). 

 

Ten plik *.blend zawiera linki do plików z obrazami referencyjnymi z folderu source\reference\drawings. To linki 

względne, więc jeżeli zachowasz oryginalną strukturę katalogów danych, które towarzyszą tej książce (por. str. 

19) i otworzysz ten plik Blendera w oryginalnym folderze, zobaczysz w jego scenie wszystkie rysunki referen-

cyjne. Jeżeli zamierzasz zapisać ten plik w innej lokalizacji, użyj w tym celu polecenia Blendera File→Save As. 

W ten sposób unikniesz zerwania tych powiązań.  

 

 

 

Rysunki referencyjne w tej scenie oznaczyłem używając konwencji “lotniczej”. Nazywa się w niej wi-

doki ortograficzne “z fotela pilota”. Z drugiej strony, projekcje ortograficzne w Blenderze są nazywane 

z innego punktu widzenia, umieszczonego z przodu obiektu (taka jest ogólna konwencja, stosowana 

w rysunkach technicznych).  

  

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-8.01.blend. 
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4.2 Kołpak śmigła 

W tej sekcji uformujemy kołpak śmigła. Na początek wybrałem tę część ze względu na jej prosty, obrotowy 

kształt. Każdy krok procesu modelowania będzie tu przedstawiany bardziej szczegółowo niż w dalszych sek-

cjach. Jeżeli jest to Twoja pierwsza praca w Blenderze, daje to możliwość poznania podstawowych technik mo-

delowania powierzchni. W trakcie czytania korzystaj z linków (numerów stron) do szczegółowych opisów. 

Zacznijmy: 

1. Ukryj wszystkie rysunki referencyjne oprócz R.Side.Left (compiled) i R.Front (Temma). 

2. Umieść kursor 3D w środku okręgu podstawy kołpaka. Zgodnie z wymiarami z dokumentacji, znajdował 

się 92.31” od przegrody silnika. Stąd umieść kursor w X=0.0, Y= -92.31, Z=1.0, jak pokazuje to Ry-

sunek 4.2.1a) (por. także str. 68). W tym punkcie Blender wstawi nowy obiekt. 

3. Przełącz projekcję na widok z przodu ( 1 ) i wstaw okrąg poleceniem Add→Mesh→Circle (por. str. 466). 

W panelu parametrów polecenia ( F9 : Adjust Last Operation) ustaw jego promień tak, aby pasował do 

rysunku referencyjnego (około 15”) i wybierz umiarkowaną liczbę wierzchołków: 12 (Rysunek 4.2.1b). 

4. Dodaj do obiektu modyfikator Subdivision Surface (w zakładce Properties:Modifiers – por. str. F22.4.4). 

Ustaw jego obydwa podziały Levels na 2. To przekształci ten wielobok w gładki okrąg (Rysunek 4.2.1c). 

Rysunek 4.2.1 pokazuje ten proces: 

 

 

 

Rysunek 4.2.1 Tworzenie okrągłej podstawy kołpaka 

Widok z przodu 

Dodaj do tego okręgu 
modyfikator Subdivision  

Adjust Last Operation ( F9 ) 

a) 

b) 

c) 

Wstaw okrąg (12 
wierzchołków) 

Add→Mesh→Circle  

Umieść kursor 3D w 
środku podstawy kołpaka 

Ustaw poziom podziału 
na co najmniej 2 
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Teraz wyciągnij (extrude) ten okrąg w „rurę”: 

1. Przełącz się w Edit Mode ( Tab  – por. str. 496, 497). 

2. Zaznacz wszystkie wierzchołki tego okręgu ( A  – patrz także opis zaznaczania na str. 498). 

3. Wyciągnij je wzdłuż osi Y na około 25” ( E , Y  lub Mesh→Extrude – por. str. 503). W ten sposób pozo-

stawisz przestrzeń na zaokrąglenie czubka kołpaka. 

Rysunek 4.2.2 ilustruje tę operację: 

 

Rysunek 4.2.2 Wyciągnięcie okręgu w powierzchnię 

Po wyciągnięciu, zmień metodę cieniowania tej nowo utworzonej powierzchni z „płaskiej” na „gładką” 

(Face→Shade Smooth, por. str. F23.10.3). 

Przekształć ten walec w stożek: 

1. Upewnij się, że środek transformacji (Pivot) jest ustawiony na Bounding Box Center (Rysunek 4.2.3) . 

2. Zaznacz przednią krawędź tej powierzchni (por. str. 498). 

3. Zmniejsz zaznaczoną sekcję ( S , lub Mesh→Transform→Scale – str. 506)   

Rysunek 4.2.3 ilustruje tę operację: 

       

Rysunek 4.2.3 Formowanie stożka kołpaka śmigła 

Dopasuj rozmiar czubka tego stożka do promienia czubka kołpaka, który widać na rysunku referencyjnym.  

Naciśnij E , Y  by wycią-

gnąć ten profil w „rurę” 

Wyciągnij ten profil 
do czubka kołpaka  

 Oś Y 

Zaokrąglenie 
czubka 

Pozostaw 
ten odstęp 

Ustaw tryb środka (Pivot) 
na Bounding Box Center. 

Dopasuj średnicę czub-
ka stożka do rysunku 
referencyjnego 

S : Zmniejsz skalę tych 

wierzchołków względem 
środka ich okręgu 
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Z czubka tego stożka: 

1. Wyciągnij ( E ) nową krawędź z poprzednio zmniejszonego okręgu wierzchołków i przesuń tę nową sek-

cję naprzód (Rysunek 4.2.4), do czubka kołpaka (o 0.89”). 

2. Zmniejsz średnicę tego nowego okręgu poprzez skalowanie ( S ).  

3. Wyciągnij kolejną krawędź z poprzedniej ( E ). Tym razem, zamiast przesunięcia, naciśnij S  by przełą-

czyć się na skalowanie. Umieść wierzchołki na osi kołpaka, zmieniając ich skale do 0.  

Rysunek 4.2.4 ilustruje tę operację: 

                      

Rysunek 4.2.4 Formowanie zaokrąglenia na czubku kołpaka 

Ewentualnie możesz już złączyć taką „zdegenerowaną” krawędź w pojedynczy wierzchołek poleceniem 

Mesh→Merge→At Center (str. 518). Jednak sugeruję wykonać ten krok później, na str. 100. 

Aby dopasować ten czubek do błękitnego konturu na rysunku referencyjnym, zmniejszyłem (Scale) jego pierw-

szą sekcję i powiększyłem (x 1.3) sekcję następną (Rysunek 4.2.5): 

 

Rysunek 4.2.5 Dopasowanie zaokrąglonego wierzchołka do rysunku referencyjnego 

 

Pierwsza sekcja tego stożka i jej środkowy wierzchołek tworzą z trójkątnych ścian płaską „rozetę”. 

Możesz zmieniać jej rozmiar skalując, przesuwać wzdłuż osi Y, ale zachowaj ją płaską.  

Wyciągnij (Extrude) 
kolejny segment po-

wierzchni wzdłuż osi Y 

Zmniejsz tą sekcję, tworząc 
kolejny segment stożka 

Wyciągnij nową 
krawędź i 

zmniejsz ją do 0  

12 wierzchołków: później 
scalimy je w jeden 

Tryb Pivot:   
Bounding Box Center 

Zmniejsz 
pierwszą 

sekcję 

Powiększ 
tę sekcję 

Niebieski kontur 
kołpaka na rysunku 

referencyjnym 

 Płaska “rozeta” 
na czubku 

Powierzchnia 
podziałowa 
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Gdy czubek stożka kołpaka pasuje do rysunku, zajmijmy się jego powierzchnią boczną: 

1. Wstaw poleceniem Loop Cut (str. 511)  nową sekcję, mniej więcej w połowie długości kołpaka. 

2. Zwiększ nieco (skalując) promień tej nowej sekcji, dopasowując powierzchnię podziałową do odpowied-

niej części konturu kołpaka śmigła (Rysunek 4.2.6): 

 

Rysunek 4.2.6 Formowanie wypukłych powierzchni bocznych kołpaka 

Teraz scalmy nakładające się wierzchołki na czubku kołpaka (por. Rysunek 4.2.4) w jeden wierzchołek: 

1. Wstaw dodatkową sekcję wokół tego punktu (Loop Cut - Rysunek 4.2.7a). To zapobiega „falbankom” na 

powierzchni podziałowej, które pojawiłyby się po scaleniu wierzchołków w środku (por. str. 518). 

2. Włącz tryb cieniowania X-Ray i zaznacz wierzchołki na czubku kołpaka. Aby się upewnić, że zaznaczo-

ne są wszystkie, użyj narzędzia Circle Select (Rysunek 4.2.7b, patrz str. 501). 

3. Scal zaznaczone wierzchołki ( M , At Center – jak pokazuje to Rysunek 4.2.7c) . 

            

Rysunek 4.2.7 Łączenie nakładających się wierzchołków na czubku kołpaka 

Wstaw (Loop Cut) 
nową sekcję w tę 
siatkę 

Średnica tej sekcji steruje 
krzywizną powierzchni 

bocznych stożka 

Powiększ tę sekcję, 
aby dopasować kontur 

boczny do rysunku 

Mesh→Merge 

( M ) 

Włącz 
X-Ray 

Zaznacz te wierzchołki 

narzędziem Circle Select 

Zbliżenie Oddalenie 

Scal te wierzchołki w 
jeden, położony w ich 

środku geometrycznym 

a

) 

b

) 

c

) 

Wstaw i przesuń (Loop Cut and 
Slide) tę sekcję blisko środka 
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Po zamknięciu topologii tej siatki, sprawdźmy jak jej wygładzona powierzchnia podziałowa pasuje do rysunku 

referencyjnego. W tym celu włącz opcję On Cage w panelu modyfikatora Subdivision (Rysunek 4.2.8): 

 

Rysunek 4.2.8 Ustawienia dla końcowego sprawdzania kształtu kołpaka 

Teraz sprawdźmy ten model w dużym zbliżeniu, szukając ewentualnych różnic pomiędzy konturem wynikowej 

powierzchni i rysunkiem referencyjnym. Aby poprawić kształt kołpaka, przesuwaj sekcje jego węzłów (siatki) 

poleceniem Edge Slide (str. 513) i zmieniaj ich promień poleceniem Scale. Jest to także okazja dla innych 

drobnych korekt. Na przykład: gdy nie jest to zbyt trudne, zawsze staram się umieścić niektóre z sekcji siatki 

wzdłuż krawędzi oryginalnych paneli (tak jak ta, pokazywana przez Rysunek 4.2.8). Dlatego zdecydowałem się 

przysunąć środkową sekcję tej siatki do czerwonej linii na planach (Rysunek 4.2.9), bo były bardzo blisko. 

 

Rysunek 4.2.9 Drobne poprawki kształtu 

Zazwyczaj dopasowanie do zaokrąglonego konturu czubka kołpaka wymaga kilku modyfikacji sekcji siatki z 

tego obszaru. Zachowałem centralną „rozetę” płaską, ale przesunąłem nieco do tyłu następną sekcję. Wydaje 

się ze szeroki kąt pomiędzy tymi ścianami nie tworzy widocznych „falbanek”, jak te ze str. 518. 

 

Opcja On Cage pozwala na bezpośrednią manipulację węzłami powierzchni podziałowej. Każdy z 

tych węzłów odpowiada wierzchołkowi siatki bazowej (przesuwając węzeł, modyfikujesz tę siatkę).  

  

Włącz opcję On Cage 
tego modyfikatora 

Subdivision 

Szukaj odchyleń pomiędzy 
powierzchnią podziałową i 
konturem z rysunku 

Linia podziału 
paneli 

X-Ray 
włączony 

Każdy z tych węzłów 
odpowiada wierzchoł-
kowi na siatce bazowej  

Środkowa 
sekcja siatki 

Przesunąłem tę sekcję 
poleceniem Edge Slide 

Środkowa część powierzchni 
podziałowej pasuje do rysunku 

Ta “rozeta” pozo-
stała płaska 

Odtworzenie tego 
zaokrąglenia wymaga-
ło przesuwania i zmia-
ny promieni tych sekcji 
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Oryginalny kołpak był wykonany z blachy (duraluminium). Możemy szybko stworzyć efekt grubości blachy doda-

jąc kolejny modyfikator: Solidify (Rysunek 4.2.10, por także str. 521): 

 

Rysunek 4.2.10 Odtwarzanie grubości blachy poszycia  

Grubość poszycia samolotu waha się od 0.02 do 0.05”. Założyłem, że w tym kołpaku użyto nieco grubszej bla-

chy: 0.04”. 

Nasz kołpak jest gotowy (Rysunek 4.2.11). Nie będziemy odtwarzać jego wewnętrznych wręg, ponieważ po 

zamontowaniu na śmigle tego samolotu stają się niewidoczne. Zamierzam później odtworzyć otwory na łopaty 

śmigieł, wykorzystując tekstury. Dlatego teraz można się już z powrotem przełączyć w Object Mode ( Tab ): 

 

Rysunek 4.2.11 Gotowy kołpak 

Zajmijmy się teraz strukturą (hierarchią) tej sceny. Przyjrzyj się jej w oknie Outliner (Rysunek 4.2.11). Zauważ, 

że ten kołpak nazywa się Circle i znajduje się w kolekcji 1. Blueprints. Przypuszczam, że w Twoim projekcie 

wygląda to podobnie. Poprawmy to: 

1. Stwórz nową kolekcję (str. 448), o nazwie 2. Fuselage.  

2. Przesuń (por. str. 449) obiekt kołpaka do tej nowej kolekcji Fuselage. 

3. Zmień nazwę obiektu kołpaka i jego siatki (por. Rysunek 4.2.12) na B.005.Spinner. To nazwa zgodna z 

nomenklaturą, którą proponuję w sekcji 11.10 (str. 477). 

 

Kolejność modyfikatorów jest istotna. Dodaj ten nowy modyfikator poniżej Subdivision Surface 

(Rysunek 4.2.10) tak, aby „pogrubił” gładkie ściany wygenerowane przez poprzednika. 

  

Ustaw grubość powłoki na 0.04” 

Zawsze umieszczaj 
modyfikator Subdivision 

ponad Solidify 

Domyślne położenie środka 
(origin) obiektu odpowiada poło-
żeniu kursora 3D w momencie 

tworzenia początkowego okręgu 

Obiekt: kołpak 
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Rysunek 4.2.12 pokazuje te ostatnie kroki: 

 

Rysunek 4.2.12 Nadanie nazwy obiektowi i jego siatce 

Podsumowanie 

• Ta sekcja prezentuje metodę nadawania obiektowi docelowego kształtu poprzez kolejne przekształcenia 

prostej siatki początkowej. W naszym przypadku by to okrąg Circle (a dokładniej – 12-kąt: str. 97).  

• Możesz stworzyć nową sekcję siatki poprzez wyciągnięcie (Extrude – str. 98) jednej z istniejących sekcji, 

lub poprzez podział powierzchni (Loop Cut – str. 100).  

• Aby dopasować kształt kołpaka, zmniejszaliśmy (Scale – str. 99) i przesuwaliśmy (Edge Slide – str. 101) 

jego sekcje. Scaliliśmy także wierzchołki na jego czubku (Merge – str. 100). 

• Użyliśmy modyfikatora Subdivision Surfaces do odtworzenia gładkich powierzchni samolotu. Generuje on z 

siatki bazowej tzw. powierzchnię Catmull-Clarka. W tym przypadku wierzchołki powierzchni bazowej są 

„punktami sterującymi” (control points) tej powierzchni (str. 99).  

• Modyfikator Solidify przydaje się do tworzenia efektu „grubości blachy” (str. 102). Będzie także przydatny 

do wycinania otworów w powierzchniach modelu. Pokażę to w następnym rozdziale. 

• Modyfikatory pozwalają uzyskać różne złożone kształty z prostej siatki bazowej. Prostota siatki jest ważna 

na dalszych etapach projektu, np. podczas teksturowania. Będziemy ich używać, gdy tylko jest to możliwe. 

• Metoda formowania siatki prezentowana w tej sekcji jest bardziej wygodna i elastyczna od tworzenia 

„wszystkiego naraz” w oparciu o przygotowane poprzednio „wręgi” NURBS. (Taka “metoda NURBS” jest 

preferowana przez wielu użytkowników, którzy wcześniej pracowali w systemach CAD.) Sądzę, że siatka 

uzyskana w rezultacie stopniowych transformacji jest prostsza i ma mniej błędów, ponieważ znasz dobrze 

wszystkie jej „zakamarki”. 

• Każdy obiekt w Blenderze musi mieć unikalny identyfikator: nazwę (na przykład: B.005.Spinner). W więk-

szości przypadków, nazwy w parze obiekt→siatka mogą być identyczne, ponieważ każda z nich dotyczy 

innego rodzaju danych (por. str. 626). Dobrą praktyką jest nadawać te nazwy zaraz po stworzeniu obiektu 

(jak to pokazuje Rysunek 4.2.12). 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-8.02.blend. 

  

Kliknij tutaj, by 
rozwinąć szcze-

góły obiektu 
Skopiuj nazwę 
obiektu i wklej 
do nazwy siatki 
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4.3 Łopata śmigła 

Klasyczna łopata śmigła przypomina cienkie, zwichrzone (skręcone) skrzydło. Niestety, rzadko można znaleźć 

jakiekolwiek dokładne rysunki ich geometrii. Jumpei Temma nie umieścił ich w swoim widoku z przodu (por. str. 

94). Nawet w oryginalnej dokumentacji P-40 nie znajdziesz żadnej podpowiedzi na temat tych łopat. Śmigła były 

produkowane w innych zakładach, zazwyczaj przez wyspecjalizowane firmy1. Dla projektantów samolotów śmi-

gło było „kompletną częścią” pozyskiwana z zewnątrz. 

Wydaje się, że dane geometryczne śmigieł Curtiss zaginęły. Wszystko, czym dysponujemy to zdjęcia, lecz trud-

no na ich podstawie określić dokładne grubości łopaty na podstawie tych obrazów2. Najlepszym materiałem 

źródłowym, jaki znalazłem, jest ilustracja z folderu reklamowego Curtiss z lat 40. XX w. Prezentuje stalową, 

pustą w środku łopatę śmigła, wyglądająca jak te na zdjęciach wczesnych P-40 (Rysunek 4.3.1):  

 

 

Rysunek 4.3.1 Zdjęcia stalowej łopaty śmigła Curtiss 

Dolne zdjęcie jest najważniejsze, ponieważ pokazuje łopatę pociętą na kawałki, tj. bez zwichrzenia. Widać tu 

także jej przekroje poprzeczne! Niestety, stosunkowa niska rozdzielczość tego obrazu nie pozwala na dokład-

niejsze pomiary. Tym niemniej, używając go byłem w stanie stworzyć rysunek referencyjny „płaskiej” łopaty (tj. 

bez zwichrzenia) z dokładnością do około 0.1” (Rysunek 4.3.2): 

 

Rysunek 4.3.2 Mój rysunek referencyjny „spłaszczonej” łopaty śmigła (widok z przodu) 

 
1 Jedną z nich jest Hamilton Standard, nadal obecna na rynku. Gdy modelarze zwrócili się do niej z prośbą o rysunki geometrii łopat produ-

kowanych przez w latach 30. XX w, udzielono im odpowiedzi odmownej. Hamilton Standard. wyjaśnił, że utrzymanie tej informacji w tajem-

nicy zapewnia im nadal „przewagę konkurencyjną”. Dziwnym trafem, jedyne plany samolotu z rysunkiem z geometrii łopaty śmigła, jakie 

znalazłem, były opublikowane w latach 80. XX w. w radzieckim magazynie modelarskim „Modelist Konstruktor”. Były to oczywiście śmigła 

samolotów produkowanych w ZSSR podczas II wojny światowej.   

2 Możesz także wykonać skan 3D jakiegoś zachowanego śmigła. Miałem okazję pracować z obrazami zeskanowanej łopaty Hamilton Stan-

dard z samolotu C-47 (szczegóły opisałem moim blogu, w 2016r.). Jak dotąd, nikt nie wykonał podobnego skanu śmigła P-40. Z drugiej 

strony, dokładność tej metody (przynajmniej w wersji opartej na popularnych smartfonach) pozostawia dużo do życzenia.   

Oryginalna 
(zwichrzona) 
łopata śmigła 

Podstawa 
łopaty ma 

okrągły 
przekrój 

Oszacowałem tę od-
ległość w oparciu o 

rysunki mechanizmu 
śmigła Curtiss Electric 

Wymiar z 
rysunku 

poglądowego Kołpak 

https://airplanes3d.wordpress.com/2016/10/29/modeling-a-c-47-propeller-blade/
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Aby ułatwić formowanie tej łopaty w przestrzeni 3D, przygotowałem także jej rzuty z góry i z boku. Niektóre z 

kluczowych wymiarów z tych rysunków są przybliżone. Oszacowałem je w oparciu o zdjęcia i inne ilustracje z 

publikacji producenta (Curtiss Electric). W szczególności: 

• Odległość płaszczyzny łopaty śmigła (wzdłuż osi Y) od płaszczyzny przegrody silnika (100”). Oszaco-

wana w oparciu o niezwymiarowany przekrój mechanizmu zmiany skoku śmigła. 

• Odległość od podstawy łopaty do osi obrotu śmigła. Ten wymiar determinuje skalę konturu śmigła prze-

rysowanego ze zdjęcia (por. Rysunek 4.3.2). Oczywiście, musiał być większy od promienia wału silnika 

Allison. Oparłem to przybliżenie na kliku rysunkach z instrukcji obsługi śmigła Curtiss Electric. 

Te trzy rysunki znajdują się w archiwum source.zip, towarzyszącym tej książce (por. str. 19). Można je znaleźć w 

katalogu source\reference\drawings. Są to: Propeller (front).png, Propeller (side).png i Propeller (top).png. 

Umieść je w naszej scenie jako dodatkowe rysunki referencyjne: 

1. Stwórz nową kolekcję na te trzy rysunki wewnątrz 1.Blueprints. Nazwij ją 1a.Propeller. 

2. Wstaw obraz Propeller (side).png w widoku z boku (tak, jak to robiliśmy w sekcji 4.1, str. 84). Ustaw 

środek (origin) obrazu na czubku kołpaka śmigła (X:0, Y:-118.19, Z:1) i zmień jego skalę dopasowując 

do promienia śmigła: 66” (Rysunek 4.3.3a). Nadaj temu nowemu obiektowi nazwę R.Propeller (side). 

3. Wstaw obraz Propeller (front).png w widok z przodu. Ustal jego środek na osi obrotu śmigła, umieść w 

go w punkcie (X:0, Y:-100, Z:1), i skaluj by dopasować do promienia śmigła 66” (Rysunek 4.3.3b). Na-

zwij ten nowy obiekt R.Propeller (front). 

4. Wstaw obraz Propeller (top).png w widok z góry. Ustaw jego środek na czubku kołpaka śmigła (w tym 

samym miejscu co widok z boku w p. 2). Skaluj ten obraz, dopasowując go do odległości od osi łopaty 

śmigła (Y= -100, jak p. 3) i czubka kołpaka (Rysunek 4.3.3c). Nazwij ten nowy obiekt R.Propeller (top). 

Rysunek 4.3.3 przedstawia kroki 2 - 4: 

                    

Rysunek 4.3.3 Ustawianie pomocniczego rysunku referencyjnego z kolekcji 1a.Propeller 

Jak widać powyżej, tymczasowo ukryłem (w oknie Outliner) obiekt kołpaka śmigła, ponieważ zasłaniałby nowo 

dodane rysunki referencyjne. 

 

a) c) 

R.Propeller (side)  

Umieść w 
-118.19”  

R.Propeller (front)  

Umieść w -100.0” 

Skaluj do 
promienia 66” 

Skaluj do 
promienia 66” 

R.Propeller 
(top) 

R.Propeller 
(side) 

Skaluj, by 
dopasować 
do osi łopaty 

Umieść w 
-118.19”  
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Pierwsza z naszych łopat będzie skierowana w dół, wzdłuż osi Z. Zacznijmy: 

1. Umieść kursor 3D na przecięciu osi kołpaka śmigła i płaszczyzny łopat (X:0, Y:-100, Z:1)1. 

2. Przełącz się na widok z góry ( 7 ). 

3. Wstaw 12-wierzchołkowy okrąg (Add→Mesh→Circle) wygładzony modyfikatorem Subdivision Surface. 

Rysunek 4.3.4 ten okrąg w rzucie z góry: 

 

Rysunek 4.3.4 Kontur początkowy: okrąg 

Następnie: 

1. Przełącz projekcję na widok z przodu ( 1 ). 

2. Przełącz się w Edit Mode ( Tab ). 

3. Zaznacz wszystkie wierzchołki okręgu ( A ). 

4. Wyciągnij (Extrude) ten okrąg w dół (wzdłuż osi Z) na 8” (Rysunek 4.3.5a): 

5. Wyciągnij (Extrude) tę nową dolną krawędź powtórnie, tym razem na 23” (Rysunek 4.3.5b): 

                

Rysunek 4.3.5 Wyciągnięcie okręgu wzdłuż osi łopaty 

 

1 W tym punkcie umieściliśmy środek rysunku referencyjnego R.Propeller (front) (por. Rysunek 4.3.3b). Stąd, zamiast wpisywać te współ-

rzędne, możesz zaznaczyć ten obiekt, otworzyć menu myszki Snap ( Shift - S ) i wybrać opcję Cursor to Selected ( 2 ) – por. str. 679. 
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Przekształć ostatnią krawędź tej „rury” (tą w Z=-31) w kontur przekroju łopaty z rysunku referencyjnego: 

1. Zaznacz ostatnią sekcję (brzeg) tej siatki (Rysunek 4.3.5b). 

2. Umieść kursor 3D pośrodku tego konturu: z menu myszki Snap ( Shift - S ) wybierz Cursor to Selected 

( 2 ) – por. str. 454.  

3. Przełącz projekcję na widok z dołu ( Ctrl - 7 ). Włącz tryb okna 3D na cieniowanie Wireframe (str. 49). 

4. Przełącz aktualny środek transformacji (Pivot) na 3D Cursor (str. 67). 

5. Powiększ tę sekcję (Scale, wspc: 2.5). Uzyskany okrąg powinien mieć średnicę zbliżoną do szerokości 

największego przekroju łopaty (Rysunek 4.3.6a). 

6. „Spłaszcz” ten kontur wzdłuż globalnej osi Y ( S , Y , wspc: 0.23), aby jego wysokość była zbliżona do 

grubości największego z czerwonych przekrojów (Rysunek 4.3.6b). 

            

Rysunek 4.3.6 Spłaszczenie okrągłego przekroju w profil lotniczy  

Kontynuuj dopasowywanie do kształtu z rysunku referencyjnego: 

1. Zaznacz wierzchołki: jeden lub dwa w jednym kroku, klikając w nie LPM . Zawsze kliknij pierwszy wierz-

chołek bez klawisza Shift , aby wykluczyć wierzchołek użyty w poprzednim kroku. 

2. Przesuń (Move) zaznaczone wierzchołki ( G , str. 508) w nowe miejsce. 

Powtarzając kroki 1-2 uformowałem zaokrągloną krawędź spływu profilu. Zacząłem od przesunięcia wierzchoł-

ków A, B, D i E do wierzchołka C (Rysunek 4.3.7a). Ustawiłem je tak, by tworzyły łuk (Rysunek 4.3.7b): 

                  

Rysunek 4.3.7 Formowanie konturu krawędzi spływu 

Sugeruję zachować wierzchołek C na osi Y (Rysunek 4.3.7b). To punkt końcowy cięciwy naszego profilu. 
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Przesuwając w ten sposób kolejne wierzchołki tego konturu, stwórz pierwsze przybliżenie profilu łopaty. Rysu-

nek 4.3.8 pokazuje kształt, który przygotowałem: 

 

Rysunek 4.3.8 Wstępne przybliżenie kształtu profilu łopaty śmigła 

Jak wspomniałem na poprzedniej stronie, zachowałem położenie wierzchołków C i I na cięciwie tego profilu 

(Y=-100). Byłem także w stanie dopasować wynikowy, gładki kontur zachowując środkowe wierzchołki: F i L na 

płaszczyźnie osi łopaty (X=0). Na wszelki wypadek zdecydowałem utrzymać je w tym miejscu. 

Na zdjęciu Curtissa (Rysunek 4.3.1), dolne kontury przekrojów łopaty wydają się być płaskie (poza przednimi 

25% cięciwy)1. Odtworzyłem to, ustawiając wierzchołki D-H wzdłuż linii prostej (Rysunek 4.3.9, por. str. 523) . 

Podczas końcowych dopasowań, włącz w modyfikatorze Subdivison Surface opcję On Cage (por. str. 101). 

Sprawdź wynikowy kontur pod kątem ewentualnych odchyleń od rysunku referencyjnego (Rysunek 4.3.9): 

 

Rysunek 4.3.9 Ostateczny kontur przekroju środka łopaty śmigła 

Zwróć uwagę, że kilka węzłów tego gładkiego kształtu (A, L, E, F) leżą daleko od odpowiednich punktów steru-

jących (por. Rysunek 4.3.8 i Rysunek 4.3.9). To naturalne dla powierzchni podziałowych. Innym typowym efekt 

jest widoczny w dolnej części tego konturu. W oryginalnej siatce są tu cztery współliniowe odcinki (pomiędzy 

wierzchołkami D i H). Na konturze wynikowym pierwszy (D-E) i ostatni (G-H) z nich są segmentami krzywej, 

choć zachowują ciągłość stycznych. Tylko dwa środkowe odcinki nadal leżą na jednej prostej. Ten efekt napo-

tkasz we wszystkich krzywych podziałowych.  

 
1 Profile płasko-wypukłe z lat 20. XX w., jak Clark Y lub rodzina RAF, są często używane w łopatach śmigieł. Ich płaski dolny kontur tworzy 

jakąś technologiczną powierzchnię odniesienia i przydaje się także w pomiarach warsztatowych podczas ewentualnych napraw. 
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Uformujmy górną część tej łopaty: 

1. Wyłącz Subdivision:OnCage i przełącz tryb cieniowania na Solid + X-Ray (Rysunek 4.3.10b). 

2. Wstaw dwie nowe okrągłe sekcje (Rysunek 4.3.10b), wykorzystując polecenie Loop Cut (str. 512). 

3. Przesuń te trzy sekcje w dół, umieszczając je w Z: -9.0, -10.5, -12.5 (Rysunek 4.3.10b): 

      

Rysunek 4.3.10 Modyfikacja podstawy łopaty 

Rysunek 4.3.10b) pokazuje przydatną technikę. Gdy zaznaczysz wiele wierzchołków, panel Item przybornika 

pokazuje współrzędne ich „środka ciężkości” (median point). Możesz także wpisać tam nową współrzędną Z dla 

zaznaczonych sekcji. Czasami szybciej jest wpisać dokładne położenie niż przesuwać lub skalować. 

4. Ustaw widok z przodu ( 1 ), włącz Subdivision:On Cage. Upewnij się, że kursor 3D jest na osi łopaty. 

5. Wstaw (Loop Cut) dodatkową sekcję (4 - Rysunek 4.3.11a). 

6. Dopasuj kształt łopaty konturu z widoku z przodu. W tym celu skaluj sekcje 3 i 4 wzdłuż osi X (oddziel-

nie wierzchołki lewe i wierzchołki prawe – por.  Rysunek 4.3.11b). 

7. Przełącz się na widok z boku ( 3 ). 

8. Dopasuj kontur łopaty do jej rzutu z boku. Skaluj sekcje 3 i 4 wzdłuż osi Y (Rysunek 4.3.11c): 

                                         

Rysunek 4.3.11 Kształtowanie obrysu łopaty w widokach z przodu i z boku 
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W tym momencie nasza łopata przypomina końcówkę odkurzacza (Rysunek 4.3.12): 

 

Rysunek 4.3.12 Górna część łopaty śmigła 

Ze zdjęcia Curtiss (Rysunek 4.3.1) wynika, że promień krawędzi spływu sekcji 4 powinien być mały, taki sam jak 

w sekcji 5. W naszym modelu jest o wiele większy. Aby to skorygować, musimy przesunąć wierzchołki krawędzi 

spływu nie tylko w sekcji 4, ale także w sekcjach 3 i 2:  

1. Włącz tryb Subdivision:On Cage. 

2. Podziel okno 3D pionowo na dwa okna (por. str. 29). 

3. W prawym oknie ustaw widok z dołu ( Ctrl - 7 ), w lewym oknie widok ortograficzny pokazany przez Ry-

sunek 4.3.12, i wyłącz opcję X-Ray. 

4. Przesuń wierzchołki sekcji 4, 3, 2w kierunku krawędzi spływu. Rób to w widoku z dołu (prawym oknie). 

Wykorzystaj lewe okno do zaznaczania wierzchołków i oceny uzyskanego kształtu. 

Rysunek 4.3.13 przedstawia zmodyfikowaną siatkę: 

 

Rysunek 4.3.13 Zmodyfikowane punkty sterujące (siatki) krawędzi spływu 

Rysunek 4.3.14 pokazuje wynikową powierzchnię podziałową: 

 

Rysunek 4.3.14 Skorygowany kształt  
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Abyś mógł powtórzyć modyfikacje opisane na poprzedniej stronie, poniżej pokazuję szczegóły trzech zmodyfi-

kowanych sekcji: 4, 3, i 2. Te ilustracje są skopiowane z okna 3D mojego Blendera, w którym ustawiłem projek-

cję Bottom. Wykorzystaj pomocniczą siatkę, widoczną na tych obrazach do określenia położenia wierzchołków1. 

Rysunek 4.3.15 przedstawia jako pomarańczowy wielokąt podstawową siatkę sekcji 4, a czarna cienka linia to 

jej kontur na wynikowej powierzchni. W tle widać rysunek referencyjny (R.Propeller (top)): 

 

Rysunek 4.3.15 Punkty sterujące (podstawowa siatka) i wynikowa krzywa sekcji 4  

Współrzędna Z tej sekcji, podana w ilustracji powyżej (-24.3) dotyczy siatki (pomarańczowe linie). Ten podsta-

wowy („sterujący”) wielobok tworzy na powierzchni wynikowej gładki kontur w Z=-23.8 (por. Rysunek 4.3.11). 

Rysunek 4.3.15 pokazuje, że ta wynikowa czarna krzywa pasuje do zewnętrznej krawędzi niebieskiego obrysu 

profilu z tego miejsca2. Zwróć uwagę, że dolna część wynikowej krzywej leży poniżej wieloboku kontrolnego. 

Podczas gdy pojedyncza krzywa podziałowa zawsze znajduje się wewnątrz konturu swoich punktów kontrol-

nych, to ta linia jest częścią trójwymiarowej powierzchni. Jej spód „ciągną w dół” sąsiednie sekcje (3 i 2). 

Zaokrąglenie krawędzi spływu sekcji 4, o średnicy 0.11”,  formuje pięć wierzchołków. W istocie, ten kontur jest 

bardziej zbliżony do paraboli, ale zdecydowałem pozostawić go w tej postaci. 

Rysunek 4.3.16 pokazuje podobne obrazy dla sekcji 3 i 2. Te sekcje nie były narysowane na żadnym rysunku 

referencyjnym, więc ich kształt opiera się głównie o zdjęcia:  

                

Rysunek 4.3.16 Punkty sterujące (podstawowa siatka) i wynikowe krzywe sekcji 3 i 2  

 
1 Twoje kontury powinny przypominać te kształty, lecz nie muszą być identyczne. Użyte w tej sekcji obrazy referencyjne są „niższej jakości”. 

Możesz założyć, że zakres ich ewentualnych odchyłek jest zbliżony do szerokości cieńszych linii użytych w tych rysunkach. To pozostawia 

podobnie szeroki margines błędu dla Twojej „indywidualnej interpretacji” tych konturów. 

2 Ten rysunek referencyjny kreśliłem jak plany modelarskie: prawdziwy kontur leży na zewnętrznej stronie obrysu. 

 

Tworząc te obrazy ekranu, tymczasowo ukrywałem element siatki poleceniami Mesh→Show/Hide 

(por. str. 525). Ta funkcja przydaje się przy edycji skomplikowanych siatek!    
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Górna część łopaty jest gotowa, więc zacznijmy teraz część dolną: 

1. Wyłącz Subdivision:On Cage, włącz cieniowanie z X-Ray. 

2. Przełącz się na widok z przodu ( 1 ). 

3. Wyciągnij (Extrude) z sekcji 5 nowy segment. Umieść tę nową sekcję nad ostatnim przekrojem łopaty 

zaznaczonym na rysunku referencyjnym (Rysunek 4.3.17a): 

4. Zmniejsz (Scale) sekcję bez osi Z ( S , Shift - Z ), aby jej cięciwa pasowała do planów (Rysunek 4.3.17b). 

5. Przełącz się na widok z dołu ( Ctrl - 7 ) i włącz Subdivision:On Cage. 

6. Zaznacz prawą stronę nowo utworzonej sekcji (czyli jej krawędź natarcia) wraz z wierzchołkami ze 

środka jej konturu. „Ściśnij” je (Scale) wzdłuż osi Y ( S , Y ) (Rysunek 4.3.17c) : 

               

Rysunek 4.3.17 Wyciąganie dolnej części łopaty śmigła 

W ostatnim kroku (Rysunek 4.3.17c) wyłączyliśmy ze skalowania pięć wierzchołków tworzących krawędź spły-

wu. Zrobiliśmy to, aby zachować dotychczasowy promień zaokrąglenia tej krawędzi (około 0.08”), uzyskany w 

kroku 4. Ten promień już pasował do rysunku referencyjnego i nie było potrzeby jego dalszego zmniejszania. 

Z drugiej strony, trudno jest dokładnie określić promień krawędzi spływu ze zdjęcia Curtiss (Rysunek 4.3.1). 

Uwzględniając ograniczenia technologiczne, założyłem następujący rozkład wzdłuż łopaty (Rysunek 4.3.18): 

 

Rysunek 4.3.18 Zmiany promienia krawędzi spływu wzdłuż rozpiętości łopaty 
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Aby dopasować kontur łopaty do widoku z przodu, wstaw dodatkową sekcję w środek ostatniego segmentu: 

1. Przełącz się na widok z przodu ( 1 ) i upewnij się, że tryb Subdivision:On Cage jest włączony. 

2. Wstaw nową sekcję (Loop Cut) w ostatni segment siatki, i przesuń ją do najbliższego przekroju nanie-

sionego na rysunek referencyjny (Rysunek 4.3.19a). 

3. Dopasuj tę nową sekcję do konturu z rysunku. Zrób to skalując (Rysunek 4.3.19b) i przesuwając wierz-

chołki (Rysunek 4.3.19c) wzdłuż osi X: 

            

Rysunek 4.3.19 Wstawienie środkowej sekcji (6) 

W dalszym tekście ta nowa sekcja jest oznaczona numerem 6, a ostatnia – 7. Zauważ, że obróciłem aktualną 

projekcję wokół osi X. Pod ostrym kątem lepiej widać ewentualne różnice pomiędzy powierzchnią wynikową a 

konturem z rysunku. Skalowanie czy przesuwanie jest niezależne od projekcji, więc jest to prosta metoda na 

efektywne dopasowanie kształtu1. To jest pierwsze przybliżenie, więc Rysunek 4.3.19c) pokazuje niewielkie 

różnice w kształcie krawędzi spływu pomiędzy sekcjami 5 i 6.  

Nie musiałem skalować sekcji 6 wzdłuż osi Y, ponieważ od razu dobrze pasowała do przekroju łopaty w tym 

miejscu (Rysunek 4.3.20). Przypuszczam, że wszystkie przekroje pomiędzy 5 i 7 zmieniają się liniowo. 

 

Rysunek 4.3.20 Przekrój sekcji 6 

 

1 Użyliśmy już jej przy okazji formowania linii prostej (por. Rysunek 4.3.8 oraz str. 1062). 
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W trybie On Cage możesz zauważyć, że po dodaniu sekcji 6 i 7 wynikowa sekcja 5 przesunęła się wzdłuż osi 

łopaty (porównaj Rysunek 4.3.20 i Rysunek 4.3.19a). Oczywiście, wierzchołki jej siatki (punkty sterujące) pozo-

stały w tym samym miejscu. To normalny efekt. Jeżeli sprawdziłbyś kształt obecnego przekroju łopaty w miejscu 

zaznaczonym na rysunku referencyjnym jako sekcja 5, okazałoby się, że jej wynikowy kontur nie uległ żadnym 

specjalnym zmianom. 

Kontynuujmy naszą pracę: 

1. Przełącz się na widok z przodu ( 1 ), wyłącz tryb Subdivison:On Cage. 

2. Wyciągnij (Extrude) nowy segment z sekcji 7. Umieść tę nową sekcję 8 w Z = -63.3 (Rysunek 4.3.21a). 

3. Zaznacz prawą część sekcji 8 (por. Rysunek 4.3.17c). 

4. Zmniejsz (Scale) zaznaczone wierzchołki z zablokowaną osią Z ( S , Shift - Z ), dopasowując kształt kra-

wędzi natarcia łopaty do konturu na rysunku (Rysunek 4.3.21b). 

5. Zaznacz pięć wierzchołków na krawędzi spływu i przesuń je ( G ) wzdłuż osi X, dopasowując kształt tej 

krawędzi do konturu łopaty (Rysunek 4.3.21c): 

                     

Rysunek 4.3.21 Wyciagnięcie segmentu z sekcją 8 

Rozpocznijmy budować zewnętrzny kontur końcówki tej łopaty: 

1. Zaznacz środkowe wierzchołki 

sekcji 8 (Rysunek 4.3.22a). 

2. Przejdź do widoku z boku ( 3 ). 

3. Wyciągnij zaznaczone wierzchołki. 

To stworzy dwie nowe krawędzie 

(Rysunek 4.3.22b). Umieść końce 

tych krawędzi (nowe wierzchołki) w 

Z = -65.14. 

4. Zbliż te nowe wierzchołki wzdłuż Y 

do osi siatki (Rysunek 4.3.22c). 

 

 

 

 

       

Rysunek 4.3.22 Wyciagnięcie bocznego konturu końcówki łopaty 
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5. Zaznacz obydwa nowe wierzchołki i połącz je krawędzią ( F  – por. str. 546, jak w Rysunek 4.3.23a). 

6. Podziel tę krawędź wierzchołkiem (Edge→Subdivide, por. str. 535), jak w Rysunek 4.3.23b). 

7. Przesuń ( G ) ten nowo stworzony wierzchołek w dół, do Z = -65.20. 

8. Zaznacz i podziel (Subdivide) krawędzie A i B (Rysunek 4.3.23c). 

9. Przesuń te nowe wierzchołki w dół wzdłuż krawędzi poleceniem Vertex Slide ( Shift - V , por. str. 537), 

do około 75% krawędzi A i B (Rysunek 4.3.23d). 

             

Rysunek 4.3.23 Zamykanie bocznego konturu końcówki łopaty śmigła 

Teraz zacznijmy wyciągać zaokrąglone obramowanie tej końcówki: 

1. Przełącz się do widoku z przodu ( 1 ). 

2. Zaznacz środkowy wierzchołek sekcji 8 i umieść tam kursor 3D ( Shift - S , 2  – por. str. 454). 

3. Zaznacz pięć wierzchołków krawędzi spływu sekcji 8. 

4. Wyciągnij je poprzez obrót ( E , R  – por. str. 510) o 45º (Rysunek 4.3.24a). 

5. Zaznacz pięć wierzchołków krawędzi natarcia sekcji 8. 

6. Wyciągnij je poprzez obrót ( E , R ) o 45º (Rysunek 4.3.24b): 

       

Rysunek 4.3.24 Wyciąganie konturu końcówki 
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Zamknij zewnętrzną krawędź tej końcówki tworząc nowe ściany siatki: 

1. W oknie Outliner wyłącz widoczność rysunków referencyjnych (kolekcji 1a.Propeller), ponieważ zasła-

niałyby niektóre z wierzchołków końcówki. 

2. Wyłącz trym X-Ray, przełącz się na cieniowanie Solid (jak w Rysunek 4.3.25a). 

3. Okrąż (zmień punkt obserwacji) końcówkę, aby lepiej widzieć jej wierzchołki. 

4. Zaznacz cztery wierzchołki i połącz je ścianą ( F  – por. str. 545) jak w Rysunek 4.3.25a). 

5. Powtarzaj kroki  3 i 4 dopóki nie zamkniesz tej końcówki (Rysunek 4.3.25b). 

       

Rysunek 4.3.25 Zamykanie siatki końcówki  

Dopasuj kształt tego konturu do rysunku referencyjnego w widoku z przodu: 

1. W oknie Outliner włącz widoczność rysunków referencyjnych (kolekcji 1a.Propeller). 

2. Przełącz się na widok z przodu ( 1 ). 

3. Przełącz się na cieniowanie Wireframe i upewnij się, że opcja X-Ray jest włączona (Rysunek 4.3.26a). 

4. Zaznacz (narzędziem Circle) wszystkie pięć wierzchołków którejś z sekcji krawędzi natarcia/spływu. 

5. Przesuwaj ( G ) zaznaczone wierzchołki, obserwując jak to zmienia krzywą wynikową. Umieść je w miej-

scu, w którym ta krzywa lepiej pasuje do konturu z widoku z przodu. 

6. Możesz także poprawić wierzchołki krawędzi natarcia i spływu sekcji 7 i 8. Przesuwaj je jednak tylko 

wzdłuż osi X. Ewentualnie, możesz także przesuwać całe sekcje poleceniem Edge→Edge Slide. 

7. Powtarzaj kroki 4-6 dopóki wynikowy kontur tej końcówki nie będzie wyglądać jak w Rysunek 4.3.26b). 

Aby lepiej widzieć ten gładki obrys, możesz włączyć tryb Subdivision:On Cage. 

       

Rysunek 4.3.26 Dopasowywanie konturu końcówki do rysunku referencyjnego 
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Dopasowanie konturu tej końcówki wymagało tylko niewielkich modyfikacji. Najważniejszą było przesunięcie 

(Slide) sekcji 8 do sekcji 7 o około 20% (Rysunek 4.3.26b). W rezultacie sekcja 8 znalazła się w Z=-62.5. prze-

sunąłem także na zewnątrz (wzdłuż osi X, o około 0.1”-0.2”) krawędzie natarcia i spływu pomiędzy sekcjami 7 i 

8. Czasami musiałem to robić dwukrotnie, bo zmiany w jednej sekcji powierzchni podziałowej (powiedzmy: n) 

wpływają także na dwie najbliższe sekcje (n-1, n+1)1. Przesunąłem także odrobinę pod kątem krawędź 9T 

(Rysunek 4.3.26) o X:-0.02, Z:-0.04, i krawędź 9C w dół wzdłuż osi Z o -0.04. W Twoim przypadku te odległości 

mogą być inne, ale podaję je tutaj jako podpowiedź, jak takie dopasowywanie wygląda w praktyce. 

Po zamknięciu siatki tej łopaty i dopasowaniu jej konturu w widoku z przodu, warto sprawdzić, czy ta końcówka 

nie wymaga jakichś poprawek w kierunku prostopadłym. Pamiętaj, że regularna siatka gwarantuje regularną 

powierzchnię podziałową, więc: 

1. wyłącz tryb Subdivision:OnCage, 

2. wyłącz tryb X-Ray, 

3. przełącz cieniowanie w tryb Solid, 

4. wyłącz widoczność rysunków referencyjnych, 

i poszukaj jakichkolwiek nieregularności wśród jej oryginalnych krawędzi (Rysunek 4.3.27a): 

       

Rysunek 4.3.27 Dopasowywanie siatki końcówki  

Kształt tej siatki wydawała się być poprawny, ale po przyjrzeniu się jej liniom w widoku z dołu (i podobnych) 

zdecydowałem, że powinienem przesunąć wierzchołki z sekcji 9L i 9T bliżej do płaszczyzny łopaty. Rysunek 

4.3.27b i c) pokazują taką operację dla krawędzi 9L. W tym ciągu zmieniłem trzy wierzchołki, które Rysunek 

4.3.27 oznacza jako A, B, i C. Zostały przesunięte wzdłuż osi Y na odległość od 0.02 (A) do 0.007 (C). Koń-

cówka łopaty śmigła była tak cienka, że nawet tak niewielkie zmiany czynią widoczną różnicę – przynajmniej w 

estetce bazowej siatki (porównaj Rysunek 4.3.27b i c). 

 
1 To ogólna reguła dla schematu podziałowego Catmull-Clarka: por. str. 1407. Na przykład: przesunąłem krawędź natarcia sekcji 7 o +0.2”, 

dopasowując ją do rysunku referencyjnego. W następnym kroku przesunąłem krawędź natarcia sekcji 8 o +0.13”, także dopasowując ją do 

rysunku. W rezultacie wynikowa łopata śmigła stała się zbyt szeroka w sekcji 7. Musiałem przesunąć jej krawędź natarcia o -0.08”.  

 

Możesz także przełączyć cieniowanie tych powierzchni z “płaskiego” na “gładkie” (Face→Shade 

Smooth, por. str. 515).     

  

 

Gdy wynikowa powierzchnia jest cieniowana “płasko” (Flat), jak ta końcówka, łatwiej jest na niej zi-

dentyfikować ewentualne nieregularności na siatce bazowej.     
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Wprowadźmy ostatnie korekty tej łopaty. Włącz cieniowanie Wireframe i tryb Subdivision:On Cage. Włącz wi-

doczność kolekcji z rysunkami śmigła. Obejrzyj ze wszystkich stron siatkę w oknie 3D, szukając ewentualnych 

odchyleń pomiędzy jej krawędziami a konturem referencyjnym. Znalazłem je wokół sekcji 5 (Rysunek 4.3.28): 

           

Rysunek 4.3.28 Różnice wokół sekcji 5  

Zademonstruję dopasowywanie takich powierzchni na przykładzie krawędzi natarcia: 

1. Zaznacz sekcję 5 (całą linię wierzchołków). 

2. Przesuń (Edge Slide) sekcję 5 w stronę miejsc, gdzie różnica jest największa (por. Rysunek 4.3.28 i 

Rysunek 4.3.29b). Umieść ją jak najbliżej największych odchyleń (Rysunek 4.3.29b). 

3. Zaznacz 5 wierzchołków krawędzi natarcia sekcji 5. 

4. Przesuń zaznaczone wierzchołki (Move) wzdłuż osi X o około 0.2”. Teraz krawędź natarcia pasuje do 

rysunku referencyjnego (Rysunek 4.3.29c). 

             

Rysunek 4.3.29 Końcowe poprawki kształtu łopaty 

Powtórz tę procedurę dla krawędzi spływu: w kroku 3 zaznacz jej 5 wierzchołków, a następnie wykonaj krok 4. 
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Dopóki sekcja 5 ma pozostać w płaskiej postaci (Z=const.) nie można jej końców umieścić dokładnie w tych 

maksimach. Na szczęście współrzędne Z tych odchyleń nie różnią się zbytnio, więc wystarczyło umieścić sekcję 

5 pomiędzy nimi, a potem ją rozszerzyć. Gdyby różnica wspł. Z max. odchyleń była większa, musiałbym wsta-

wić w tą łopatę dodatkową linię wierzchołków, po sekcji 4 lub przed sekcją 6, a potem wszystkie je dopasować.  

Na koniec wstawiłem (Loop Cut) pomocniczą, okrągłą sekcję w podstawę łopaty (Rysunek 4.3.30). Jej obec-

ność wymusza na dalszej powierzchni wynikowej przekrój w kształcie okręgu. Przesunąłem też pierwszą sekcję 

w dół (wzdłuż osi Z), umieszczając ją u podstawy łopaty śmigła zaznaczonej na rysunku:   

 

Rysunek 4.3.30 Kompletna siatka łopaty śmigła (bez zwichrzenia) 

Dla dalszego sprawdzania kształtu siatki możesz użyć wariantu MatCap trybu cieniowania Solid (por. str. 51) i 

wybrać jakiś ciekawszy materiał, na przykład – gładki metal (Rysunek 4.3.31): 

 

Rysunek 4.3.31 Łopata śmigła z metalicznym MatCap 

 

Rysunek 4.3.28 nie pokazuje tego zbyt dobrze z powodu przyjętej projekcji, ale maksima odchyleń na 

krawędzi natarcia i spływu mają różne współrzędne Z. Sekcję 5 można tylko przesunąć w ich pobliże.    

  

 

Środek (czy też punkt odniesienia – origin) obiektu łopaty leży w miejscu, w którym umieściłeś kursor 

3D wstawiając początkowy okrąg (por. str. 106): na osi kołpaka śmigła.     
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Nazwij ten obiekt i jego siatkę B.010.Blade. Upewnij się, że jest umieszczony w kolekcji 2.Fuselage (por. str. 

103). Do tej łopaty nie dodamy modyfikatora Solidify (por. str. 102), gdyż jej jedyny otwór będzie ukryty we-

wnątrz kołpaka śmigła. 

Pozostało nam jeszcze skręcić (zwichrzyć) tę łopatę, ale zrobimy to już w następnej, ostatniej sekcj i tego roz-

działu. Nasz rysunek referencyjny opisywał ją w „spłaszczonej” postaci, więc zdecydowałem się zatrzymać w 

tym momencie i zapisać do pliku *.blend aktualny stan tego modelu. W przyszłości ten wariant bez zwichrzenia 

jeszcze będzie można wykorzystać (por. str. 558). 

 

Summary 

• W tej sekcji poznałeś kolejne transformacje wierzchołków (przesunięcie Move: str. 107, obrót Rotate: str. 

115, przesunięcie Slide Vertices: str. 115), “ręczne” tworzenie nowych krawędzi i ścian (str. 115, 116), oraz 

tworzenie nowych wierzchołków poprzez wyciągnięcie (str. 114) lub podział krawędzi (Subdivide, str. 115). 

• Nauczyłeś się więcej o praktyce formowania i dopasowywania gładkich kształtów modelowanych za pomo-

cą powierzchni podziałowych  (str. 108, 112, 116, 118).  

• Ogólna metoda formowania łopaty śmigła była taka sama jak zaprezentowana w poprzedniej sekcji dla 

kołpaka: kolejne przekształcenia prostego przekroju początkowego. Dziwnym trafem, nawet zaczęliśmy od 

takiego samego, 12-bocznego „okręgu” (str. 106). Jednak ta łopata to bardziej złożony przypadek, wyma-

gający więcej pracy. 

• W Edit Mode, współrzędne w zakładce Item przybornika pozwalają na masowe zmiany zaznaczonych 

wierzchołków (str. 109). 

• Geometria łopaty śmigła jest zazwyczaj niedostępna: nie znajdziesz jej nawet na szczegółowych rysun-

kach, takich jak plany Jumpei Temmy. Jedyny znany wymiar to średnica śmigła, podawana często na ry-

sunkach poglądowych samolotu. Pozostałych wskazówek musisz szukać na zdjęciach archiwalnych. Cza-

sami przydaje się także uporządkować wszelkie zdobyte informacje kreśląc pomocniczy rysunek referen-

cyjny (str. 104). 

 

 

 
 

 

Podczas modelowania, czasami trzeba usuwać wierzchołki, ściany lub całe linie krawędzi (edge 

loops). Użyj w tym celu klawisza Delete  (lub X ). Szczegóły – por. str. 542.    

  

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-8.03.blend. 
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4.4 Dokończenie łopat śmigła 

Jeżeli przyjrzysz się łopatom wiatraka lub pokojowego wentylatora, zauważysz, że są skręcone. To samo doty-

czy łopat śmigieł. Niestety, nie mamy żadnych „twardych” danych o geometrii łopat śmigieł Curtiss, których uży-

to w P-40. Kilka lat temu miałem okazję odtwarzać śmigło Hamilton Standard ze skanu 3D1. To był starszy wa-

riant, montowany we wczesnych samolotach C-47. Jego rozmiar i kształt łopaty wydają się przypominać śmigło 

Curtiss (Rysunek 4.4.1): 

 

Rysunek 4.4.1 Zwichrzenie (skręcenie) łopaty śmigła Hamilton Standard, zmierzone na jej skanie 3D 

Przypuszczam, że rozkład kątów skręcenia kolejnych przekrojów w łopatach Curtiss przypominał przypadek 

pokazany na ilustracji powyżej. Teraz użyjemy tych danych do skręcenia naszej łopaty z poprzedniej sekcji: 

1. W Object Mode zaznacz obiekt łopaty i wywołaj polecenie Cursor to Selected ( Shift - S , 2  – por. str. 

454). W ten sposób zapewniamy położenie kursora 3D na osi łopaty. 

2. Przełącz się w Edit Mode, i upewnij się, że aktualny tryb Transformation Pivot to 3D Cursor. 

3. Zaznacz sekcje łopaty – od bazowej do 5 (Rysunek 4.4.2). 

4. Obróć zaznaczenie wokół osi Z ( R , Z ) o 10º (możesz to zrobić w dwóch oknach 3D):  

         

Rysunek 4.4.2 Skręcanie łopaty śmigła (do sekcji 5) 

 
1 Szczegóły znajdziesz w tym poście z 2016r. 
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Teraz wyklucz z zaznaczenia sekcję 5 ( Alt - Shift -LPM ) i obróć sekcje 1-4 o kolejne 10º (Rysunek 4.4.3): 

 

Rysunek 4.4.3 Skręcanie łopaty śmigła (do sekcji 4) 

Powtarzaj tę operację, wykluczając z zaznaczenia kolejne sekcje (Rysunek 4.4.4a). Zakończ tę sekwencję obro-

tem ostatnich sekcji z podstawy łopaty o 5º zamiast 10º (Rysunek 4.4.4b): 

        

Rysunek 4.4.4 Skręcanie łopaty śmigła (do sekcji 3 i 2) 

Na koniec sugeruję zaznaczyć sekcję 6 i obrócić ją o jakieś 3º (Rysunek 4.4.5): 

 

Rysunek 4.4.5 Skręcanie łopaty śmigła (do sekcji 3 i 2) 

Ten ostatni krok minimalnie poprawia krzywą skręcenia krawędzi natarcia i spływu łopaty. 
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Obróć by poprawić krzy-
wiznę krawędzi natarcia 
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Łopata jest gotowa, więc: 

1. Przełącz się na Object Mode. 

2. Wyłącz widoczność pomocniczych rysunków śmigła (kolekcji 1a.Propeller). Ewentualnie możesz włą-

czyć jeden z rzutów z boku z kolekcji 1.Blueprints. 

3. Włącz widoczność kołpaka śmigła (B.005.Spinner z kolekcji 2.Fuselage). 

 

Rysunek 4.4.6 Gotowa łopata śmigła 

Śmigło w tym metalowym wykończeniu robi dobre wrażenie, ale przed dalszą pracą proponuję wybrać dla tego 

cieniowania Solid:MatCap jakiś mniej połyskliwy materiał (np. „brązową glinę” – brown clay). 

Teraz stwórzmy dwie pozostałe łopaty śmigła (jako klony): 

1. Przełącz się na projekcję Front ( 1 ). 

2. Upewnij się, że aktualny tryb Pivot to 3D Cursor, i że kursor pozostaje w środku (origin) łopaty. 

3. Zaznacz obiekt łopaty. 

4. Sklonuj ten obiekt poleceniem Object→Duplicate Linked ( Alt - D  – por. str. 464). 

5. Zaraz po wywołaniu tego polecenia naciśnij R . Obróć ten nowy obiekt o 120º (Rysunek 4.4.7): 

        

Rysunek 4.4.7 Powielenie łopat śmigła 

Powtórz kroki 4 i 5, tworząc trzecią łopatę tego śmigła. 

Ukryj rysunki śmigła 

Odsłoń kołpak śmigła 

Obiekt 
łopaty 

Włącz Object 
Mode 

Opcjonalnie: możesz 
włączyć widoczność 
tego rzutu z boku 

Sklonuj ten 

obiekt ( Alt - D ) 

3. Obróć ten nowy 
obiekt o 120º dookoła 
osi śmigła 

Naciśnij R  

Widok z przodu 
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Stworzone w ten sposób trzy łopaty śmigła wykorzystują tę samą siatkę (por. Rysunek 4.4.8). To oznacza, że 

każda zmiana tych obiektów wprowadzona w Edit Mode jest natychmiast propagowana na pozostałe1. Takie 

rozwiązanie ułatwia ewentualne przyszłe poprawki kształtu łopat śmigła. Z drugiej strony, nie możesz żadnemu 

z tych „klonów” przypisać innej tekstury niż pozostałym: na finalnym renderze będą identyczne2. 

Blender skopiował także nazwę obiektu, dodając co niej numeryczną końcówkę (.001, .002, … - por. Rysunek 

4.4.8). Nie przepadam za takimi końcówkami. Zamiast tego sugeruję dodać litery A, B, C do części wspólnej 

nazw tych łopat: B.010.A.Blande, B.010.B.Blande, B.010.C.Blande: 

                  

Rysunek 4.4.8 Zmiana nazw obiektów łopat 

Teraz „przyklejmy” te łopaty do kołpaka, aby gdy jego obrót powodował obrót całego śmigła. W Blenderze mo-

żesz ten efekt uzyskać tworząc z tych obiektów hierarchię (relację parent/child):   

1. Zaznacz trzy łopaty, następnie dodaj do tego zaznaczenia kołpak (kliknięciem Shift -LPM). Upewnij się, 

że kołpak jest obiektem aktywnym (powinien mieć jaśniejsze podświetlenie – por. str. 57). 

2. Przypisz zaznaczone obiekty (children) do obiektu aktywnego (parent) poleceniem Set Parent 

To:Object (Keep Transform) ( Ctrl - P  – por. str. 479): 

 

Rysunek 4.4.9 Hierarchia obiektów zespołu śmigła 

 

1 Więcej szczegółów o tym czym są takie „klony” (linked copies) znajdziesz w sekcji 16.1, na str. 1404. 

2 Raczej tego nie zauważysz. Jakby co: zawsze możesz „odłączyć” taki klon. Aby stworzyć indywidualną (Blender określa ją jako „lokalną”) 

kopię jego siatki, użyj polecenia Object→Relations→Make Single User→Object & Data. 

 

W modelach samolotów większość klonów to lewe/prawe wersje tej samej siatki. W takich przypad-

kach sugeruję rozróżniać je końcówkami L lub R (np.: B.250.L.Aileron lub B.250.R.Aileron). jednak 

w tym przypadku chodziło o trzy łopaty, stąd użycie liter A, B, C.    

  

Ustal kołpak 
jako “rodzica” 

łopat śmigła  

We wszystkich trzech obiektach 
jest ta sama siatka (B.010.Blade) 

Numeryczne 
końcówki 

Zmienione 
nazwy Zmień nazwy  
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Kątem skoku łopat śmigła P-40 sterował elektryczny silnik umieszczony wewnątrz kołpaka. Znajdowały się tam 

także przekładnie, które obracały każdą z tych trzech łopat wokół jej indywidualnej osi Z1. Jaki był zakres tego 

ruchu? Na szczęście, podają to napisy naniesione w pobliżu podstawy łopat. Przejrzałem dostępne zdjęcia i 

znalazłem jedno z nich, wykonane w 1940e dla magazynu „Life”: 

 

Rysunek 4.4.10 Dane śmigła naniesione na łopatę (historyczne zdjęcie z fabryki w Buffalo). 

Jak widać powyżej, skok łopat zmieniał się od 24.5º do 54.5º. Przypuszczam, że mierzono to w 75% promienia  

śmigła. Kąt skoku naszego modelu łopaty w tym miejscu jest bliski 0º (por. Rysunek 4.4.2), więc: 

1. Przełącz tryb Pivot na Individual Origins (Rysunek 4.4.11). 

2. Zaznacz wszystkie trzy łopaty śmigła. 

3. Obróć (Rotate) je o 25º wokół lokalnych osi Z ( R , Z , Z ), jak pokazuje to Rysunek 4.4.11: 

 

Rysunek 4.4.11 Ustawienie łopat na „mały skok”. 

 
1 W ten sposób można zwiększyć sprawność śmigła. Podczas startu i wznoszenia łopaty śmigła są ustawione do płaszczyzny obrotu pod 

mniejszym kątem (mały skok). Podczas lotu z maksymalną prędkością łopaty są ustawione pod większym kątem (duży skok). Największą 

wydajność uzyskuje się, gdy powietrze opływa łopatę pod katem kilku stopni. Ten kąt natarcia zależy od prędkości samolotu i prędkości 

obrotu śmigła, więc należy go zmieniać dla różnych warunków lotu. 

Numer rysunku 
łopaty: 89301-3 

Największy kąt: 54.5 

Najmniejszy kąt: 24.5 

Źródło: Life 

Obróć (Rotate) te łopaty 
wokół ich lokalnych osi Z 

Lokalna oś Z 
Tryb Pivot: 
Individual 

Origins 

Lokalna oś Z 
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Warto wspomnieć o pewnym zadziwiającym (przynajmniej dla mnie) szczególe geometrii. W rzutach z boku 

wszystkich samolotów jakie kiedykolwiek widziałem, jedna łopata śmigła dokładnie zasłania drugą. Gdy po raz 

pierwszy stworzyłem model 3D trójłopatowego śmigła i popatrzyłem na nie z boku (Rysunek 4.4.12), byłem 

zaskoczony! Zobaczyłem, że łopata bliższa do obserwatora nie zasłania części drugiej łopaty: 

 

Rysunek 4.4.12 Odstęp pomiędzy końcówkami łopat w widoku z boku i jego wyjaśnienie 

Rysunek 4.4.12 pokazuje wyjaśnienie: to efekt obrotu łopat o kąt skoku śmigła. Znika, gdy ustawisz kąt skoku 

na 0º (na ilustracji powyżej ten kąt wynosi 30º). 

Gdy modelowany obiekt jest gotowy, porównaj jego kształt ze zdjęciami. Ustaw model 3D w podobnej projekcji 

do tej, która występuje na zdjęciu. Wykorzystując tę metodę, odkryłem parę różnic pomiędzy kształtem mojego 

obiektu a prawdziwym śmigłem (Rysunek 4.4.13): 

                    

Rysunek 4.4.13 Różnice pomiędzy modelem i zdjęciami referencyjnymi 

Przyglądając się tym zdjęciom myślę, że przyjąłem trochę złą skalę dla rysunku referencyjnego śmigła. Dobra-

łem ją podstawie mojego szacunku odstępu pomiędzy podstawą łopaty i osią śmigła (por. str. 104, 105). 

a b a b 
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b 
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Skok śmigła: 30º  
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Zaakcentowana 
krawędź spływu 

Źródło: NASM 
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W oparciu o te zdjęcia, zdecydowałem się zmniejszyć całą siatkę łopaty o około 3%, w stronę jej końcówki. To 

powinno skompensować mój błąd w określeniu skali tego obiektu: 

1. W Object Mode zaznacz najniższą łopatę (tę, która jest ustawiona równolegle do globalnej osi Z). 

2. Umieść kursor 3D w jej środku (Object→Snap→Cursor to Selected, lub Shift - S , 2 ). 

3. W panelu View:3D Cursor przybornika ( N ) zmień współrzędną Z kursora na -65.0. To przesunie ją na 

koniec łopaty śmigła (Rysunek 4.4.14a). 

4. Przełącz się na Edit Mode ( Tab ). 

5. Przełącz tryb Transformation Pivot na 3D Cursor. 

6. Zaznacz całą siatkę ( A ). 

7. Zmniejsz tę siatkę ( S ). Podczas skalowania zauważysz, jak łopata „wyłania się” z powierzchni kołpaka 

(Rysunek 4.4.14b). Sugeruję przerwać przy skali 0.96 lub 0.97 (zmniejszeniu o 4%-3%): 

    

Rysunek 4.4.14 Wstępna korekta łopaty śmigła 

Mógłbym zmienić skalę każdej z łopat w Object Mode, ale wołałem skorzystać z ich sklonowania. Wolę stoso-

wać takie metody „zmodyfikuj wszystko naraz” dla poprawek, wprowadzanych na bieżąco do modelu. 

Zauważyłem także kolejną małą różnicę w promieniu krawędzi spływu w pobliżu kołpaka: powinna być bardziej 

„stożkowa” niż jest w moim modelu (Rysunek 4.4.15): 

         

Rysunek 4.4.15 Drobne różnice w kształcie krawędzi spływu 

 

Dzięki sklonowaniu tych łopat, nie musisz powtarzać tej modyfikacji siatki w każdej z łopat oddzielnie. 

Blender natychmiast przenosi te zmiany do wszystkich instancji zmienionej siatki.    

  

Kursor 3D na 
końcu łopaty 
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Poprawienie tej części krawędzi spływu wymaga modyfikacji wierzchołków w sekcjach 2 i 3 (por. str. 112). Na 

skręconej siatce łopaty jest trudno zachować symetryczny kształt tych przekrojów. Aby zabezpieczyć ich pozy-

cję względem cięciwy profilu i symetrię, można skalować te wierzchołki parami. Można także przesuwać całe 

sekcje poleceniem Edge Slide. Zakładają, że nadal jesteś w trybie Edit Mode (siatki łopaty): 

1. Zaznacz całą sekcję 3 i przesuń (Edge Slide) w stronę sekcji 4 o 20% (Rysunek 4.4.16a) 

2. Zaznacz całą sekcję 2 i przesuń (Edge Slide) w stronę sekcji 3 o 50% (Rysunek 4.4.16b). 

3. Przełącz tryb Transformation Pivot na Bounding Box Center. 

4. Zaznacz wierzchołki A i E, i powiększ je (skaluj we wszystkich kierunkach) 1.2 razy (Rysunek 4.4.16c). 

5. Zaznacz wierzchołki B i C, i powiększ je 1.5 razy (Rysunek 4.4.16d):  

    

Rysunek 4.4.16 Poprawianie kształtu krawędzi spływu 

Później odkryłem, że w tych wczesnych P-40 Curtiss czasami zastępował wydrążone stalowe łopaty łopatami 

pełnymi, wykonanymi z duraluminium. Te drugie były często montowane w brytyjskich „Tomahawkach”, więc 

możesz je dostrzec także na maszynach AVG. Geometria tej pełnej łopaty różni się w wielu szczegółach od 

łopaty stalowej. W szczególności, jej przekrój przy powierzchni kołpaka był szerszy, a obrys tej sekcji – kroplo-

wy, a nie okrągły. Rysunek 4.4.17 przedstawia przykłady tego śmigła na P-40C i Tomahawkach: 

       

Rysunek 4.4.17 Pełne (aluminiowe) łopaty śmigieł w brytyjskich „Tomahawkach” 

Łopaty pokazywane przez Rysunek 4.4.10 oraz Rysunek 4.4.15b) także mogą być wariantem „pełnym”. 
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Jak mogłeś zauważyć, brak jakichkolwiek danych o geometrii śmigła zmusił nas do użycia zdjęć jako obrazów 

referencyjnych. Dopasowanie skręconego kształtu łopaty do zdjęcia jest trudne, szczególnie w przypadku śmi-

gieł o zmiennym skoku. Nie chcę komplikować tego wprowadzenia, więc pozostawmy na razie to śmigło w 

obecnym stanie. Wrócimy do tej sprawy pod koniec tej części poradnika, gdy uformujemy wszystkie powierzch-

nie zewnętrzne P-40. Wtedy dokonamy dokładnego porównania całego modelu z wybranymi zdjęciami samolo-

tu. Będzie to także okazja do dokładniejszego dopasowania śmigła (kołpaka i łopat) do obrazów o wysokiej 

rozdzielczości. 

 

Podsumowanie 

• Możesz klonować obiekty o identycznym kształcie (jak łopaty śmigła) wykorzystując polecenie Duplicate 

Linked (str. 123). To upraszcza ewentualne późniejsze poprawki, ponieważ te „klony” współdzielą tą samą, 

wspólną siatkę. 

• Ważnym aspektem tworzenia modelu 3D jest hierarchia jego obiektów. Zbuduj ją przypisując każdy nowo 

utworzony element do obiektu nadrzędnego (parent) poleceniem Set Parent To (str. 124). Od tej chwili, 

element podrzędny (child) będzie powtarzał wszystkie transformacje swojego „rodzica”: nie tylko obroty i 

przesunięcia, ale także zmianę skali. 

• Końcówki łopat śmigła nie zachodzą na siebie w widoku z boku – i to nie jest błąd (str. 126). 

• Po uformowaniu nowej części, zawsze porównaj ją ze zdjęciami (str. 126). Przygotuj się na niespodzianki! 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-8.04.blend. 
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Rozdział 5. Skrzydła 

W poprzednim rozdziale stworzyliśmy śmigło. To był dość prosty podzespół. W tym rozdziale odtworzymy 

skrzydło P-40. W pierwszej sekcji opisuję formowanie jego prostszej, trapezowej części. W sekcji 5.2 i 5.3 za-

mkniemy je zaokrągloną końcówką. W kolejnych sekcjach nauczysz się, jak „wyciąć” ze skrzydła lotki, klapy, i 

otwory na koła podwozia.  

W sekcjach 5.5 i 5.6 odtwarzam także wewnętrzny szkielet skrzydła, widoczny w otworze klapy do lądowania. 

Ten szczegółowy opis „blacharskiego rzemiosła” może się na początek wydać przytłaczający. Jeżeli chcesz, 

możesz go ominąć. Z drugiej strony zachęcam, aby jednak spróbować odtworzyć ten szkielet. Wprowadzam w 

tych dwóch sekcjach wiele nowych technik i narzędzi, do których się odwołuję w kolejnych rozdziałach tego 

przewodnika1.  

Sądzę, że po ukończeniu poprzedniego rozdziału znasz już podstawową kolejność operacji w Blenderze: „za-

znacz obiekt, a potem wywołaj polecenie”. Dlatego w listach kroków tego rozdziału skrócę nieco opisy. Na przy-

kład, podam „przesuń wierzchołek A” jako pojedynczy krok, zamiast dwóch: „zaznacz wierzchołek A” : „przesuń 

wierzchołek A”. 

Po ukończeniu tego rozdziału będziesz znał cały proces modelowania i wszystkie typowe narzędzia, których do 

tego używam.  

 
1 Poza tym – to między innymi dzięki takim szczegółom modele komputerowe mogą wiarygodnie „udawać” prawdziwe samoloty. Gdy już 

poznasz metodę odtwarzania takich „blaszanych wnętrzności” samolotu, to każdy podobny szczegół (np. wnętrza kabiny) nie będzie Ci 

straszny! 
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5.1 Kształt podstawowy 

W widoku z boku skrzydło P-40 jest zaklinowane pod katem 1º do osi kadłuba (to obrót wokół osi X). Ma także 

6º wzniosu (obrót wokół osi Y – por. rzut z przodu). Aby ułatwić formowanie, odtworzymy ten element „położony 

na płasko” na płaszczyźnie XY. Potem go obrócimy i ustawimy w odpowiednim miejscu kadłuba.  

W pierwszej części tej książki przygotowaliśmy rysunki referencyjne dla takiego „płaskiego skrzydła” (por. Tom I, 

sekcja 3.7, Rysunek 3.7.11). Ustawmy je teraz w Blenderze: 

1. Wyłącz widoczność kolekcji 2.Fuselage. 

2. Stwórz nową subkolekcję w 1.Blueprints o nazwie 1b.Wing.  

3. Skopiuj (Duplicate – Shift - D ) obraz referencyjny R.Top (Temma) (Rysunek 5.1.1a). 

4. Zastąp jego zawartość obrazem struktury skrzydła1. (Upuść ten plik na ten obraz – por. str. 91). To plik o 

nazwie Wing (blueprint).png, który znajdziesz w folderze source\reference\drawings\. 

5. Zmień nazwę tego obrazu na R.Wing (top) i umieść go w kolekcji 1b.Wing (Rysunek 5.1.1b): 

         

Rysunek 5.1.1 Ustawianie rysunku z rzutem z góry 

W widok z boku i dodaj do sceny dwa nowe obrazy profili skrzydła. To NACA-221.png i NACA-2209.png, z tego 

samego folderu. Ustaw ich środki na przecięciu krawędzi natarcia i cięciwy (Offset X = 0, por. Rysunek 5.1.2a). 

Umieść te obrazy wzdłuż krawędzi natarcia w rzucie z góry i dopasuj ich końce (Scale) do krawędzi spływu:  

 

Rysunek 5.1.2 Ustawianie obrazów kluczowych profili skrzydła 

 
1 Przygotowaliśmy ten rysunek w Tomie I. Wyeksportowałem go z Inkscape w tej samej „ramce” jaką użyłem dla rzutów z planów Jumpei 

Temmy. Dzięki temu te obrazy są „wymienne”. 

Skopiuj obraz 
R.Top (Temma) 

 

Nowa kolekcja na 
rysunki skrzydła  

Umieść w tym duplikacie 
rysunek referencyjny skrzy-
dła i nazwij go R.Wing (top) 

a) b) 

NACA-2215.png  

NACA-2209.png  
X=0.0, Y=-9.0  

X=197.0, Y=-4.5  

Skaluj (proporcjonalnie) obrazy 
profili, dopasowując je do skrzydła   

Środek obrazu  

Cięciwa profilu 

a) 



132 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Gdy rysunki referencyjne są na miejscu, zacznijmy formować płat: 

1. Stwórz w tej scenie nową kolekcję, o nazwie 3.Wing. 

2. Przełącz się na widok z boku ( 3 ). 

3. Przenieś kursor 3D do środka sceny (0, 0, 0) ( Shift - S , 1 : Cursor to World Origin). To ważne, by Blen-

der umieści w tym miejscu środek nowo utworzonego obiektu. 

4. Stwórz nowy okrąg (Add→Mesh→Cricle), otwórz jego parametry ( F9 ) i ustal jego promień na 54” a 

liczbę wierzchołków na 36 (Rysunek 5.1.3a). Na razie nie dodawaj modyfikatora Subdivison. 

5. Przejdź do Edit Mode ( Tab ). 

6. Przesuń wszystkie wierzchołki tego okręgu wzdłuż osi Y, umieszczając je wokół obrazu profilu skrzydła. 

7. Upewnij się, że aktualny tryb Pivot to 3D Cursor. 

8. Spłaszcz (skalując wzdłuż osi Z) tę siatkę, aby uzyskać elipsę o wysokości profilu (Rysunek 5.1.3b): 

   

Rysunek 5.1.3 Tworzenie pierwszej krawędzi skrzydła 

Zmień nazwę tego nowego obiektu na B.100.L.Wing a jego siatki na B.100.Wing. (Dodałem literę „L” w nazwie 

obiektu, ponieważ w przyszłości stworzymy jego lustrzanego „klona” – prawe skrzydło). Teraz kontynuujmy for-

mowanie wstępnego kształtu profilu podstawy skrzydła: 

1. Zaznacz wierzchołek na krawędzi natarcia i umieść tam kursor 3D ( Shift - S , 2 : Cursor to Selected). 

2. Zaznacz 19 lewych wierzchołków tej elipsy i zmniejsz je, skalując wzdłuż osi Y. Ustal współczynnik tego 

skalowania na 0.5. (Rysunek 5.1.4a). 

3. Umieść kursor 3D na krawędzi spływu profilu (w ten sam sposób, co w p. 1). 

4. Zaznacz 12 lewych wierzchołków (Rysunek 5.1.4b) i powiększ je wzdłuż osi Y współczynnikiem = 1.5: 

   

Rysunek 5.1.4 Wstępne przybliżanie kształtu profilu 

Skup połowę wierzchołków w 
początkowych 25% cięciwy profilu 

a) b) 
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Zachowaj te 5 wierzchołków 
na krawędź spływu  

a) b) 
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dla zespołu 
skrzydła  

Nowe Circle: 36 
wierzchołków, 
promień = 54”  

“Spłaszcz” 
ten okrąg w 

elipsę 

Widok z lewej 
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Na rysunku referencyjnym profilu krawędź natarcia jest „ostra jak brzytwa”. Oczywiście, w prawdziwym samolo-

cie jest zaokrąglona. Jeżeli nie znasz dokładnego promienia tego zaokrąglenia, przyjmij 0.04-0.05” (1-1.2mm). 

Rysunek 5.1.4b) pokazuje, że wyłączyłem z ostatniej operacji pięć wierzchołków w wokół krawędzi spływu. Te-

raz ich użyjemy do uformowania jej kształtu. Zrobimy to tak samo jak robiliśmy to w łopacie śmigła (str. 107): 

najpierw stworzymy pół ośmioboku, a potem zmniejszymy go do odpowiedniej grubości. Zacznijmy: 

1. Upewnij się, że kursor 3D jest na krawędzi spływu (powinien tam być po poprzedniej transformacji). 

2. Skaluj wierzchołki A, B, D, E (Rysunek 5.1.5a) o współczynnik 0.25. 

3. Skaluj wierzchołki A, E (Rysunek 5.1.5b) o współczynnik 0.7. 

4. Skaluj wierzchołki A, B, D, E (współczynnik: około 0.1) tak, aby odległość pomiędzy B i D wyniosła oko-

ło 0.08” (Rysunek 5.1.5c): 

           

Rysunek 5.1.5 Formowanie krawędzi spływu 

Teraz dopasujmy dolną część tej linii wierzchołków do profilu referencyjnego: 

1. Skaluj wzdłuż osi Z o współczynnik 0.67 wszystkie wierzchołki obrysu położone poniżej cięciwy. To 

umieści je blisko obrysu krawędzi natarcia (Rysunek 5.1.6a). 

2. Zaznacz A (Rysunek 5.1.6b) i umieść w tym punkcie kursor 3D ( Shift - S , 2 : Cursor to Selected). 

3. Zaznacz wierzchołki B-G i skaluj je wzdłuż osi Z aż ostatni wierzchołek z prawej (G) dotknie konturu na 

rysunku referencyjnym (Rysunek 5.1.6b). 

4. Wyklucz ostatni wierzchołek (G) z aktualnego zaznaczenia. 

5. Powtarzaj kroki 3 i 4 podstawiając kolejno jako wierzchołki końcowe: F, E, D (tzn. z coraz krótszą linią 

zaznaczonych krawędzi). To lepsze od przesuwania pojedynczych wierzchołków do konturu. 

               

Rysunek 5.1.6 Dopasowywanie dolnego konturu profilu skrzydła 
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Możesz „krążyć dookoła” tego profilu, aby obserwować kroki 3 - 5 pod ostrym kątem (Rysunek 5.1.7a). Taką 

metodę wykorzystywaliśmy już podczas formowania łopaty śmigła (patrz także str. 523): 

             

Rysunek 5.1.7 Dopasowywanie dolnego konturu profilu skrzydła (c.d.) 

Na koniec możesz dopasować pojedyncze wierzchołki A i B, przesuwając je odrobinę do dołu (Rysunek 5.1.7b). 

W podobny sposób dopasuj górny kontur tego profilu skrzydła. Rysunek 5.1.8 przedstawia rezultat – kontur 

skrzydła przybliżony przez ten wielobok: 

   

Rysunek 5.1.8 Przybliżony kształt profilu 

Teraz dodaj do tego obiektu modyfikator Subdivision Surface. Ustal jego poziom podziału na 2 (Rysunek 5.1.9): 

 

Rysunek 5.1.9 Końcowe poprawki kształtu konturu wygładzonego modyfikatorem Subdivision Surface 

Wynikowy kształt wymaga kilku drobnych poprawek. Na przykład – w tej rodzinie NACA-22xx czubek krawędzi 

natarcia jest (dość nietypowo) nieco powyżej cięciwy profilu. To oznacza, że powinniśmy przesunąć w górę naj-

bliższe wierzchołki siatki, które Rysunek 5.1.9 oznacza jako A i B. 
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Rysunek 5.1.10 pokazuje gładki wynikowy kontur profilu podstawy skrzydła. Zwróć uwagę, że wierzchołek znaj-

dujący się na krawędzi natarcia, oznaczony jako A, jest 0.5” ponad linią cięciwy: 

 

Rysunek 5.1.10 Gotowy profil podstawy skrzydła 

Można było odtworzyć ten kształt za pomocą mniejszej liczby punktów (może 18). W sekcji 4.3 na mniej do-

kładny, lecz całkiem „przyzwoity” profil łopaty śmigła wystarczyło nam tylko 12 wierzchołków siatki. Jednak 

przygotowując początkowy kontur nowego obiektu, powinieneś także wiedzieć jak zakończyć finalną siatkę. 

Najtrudniejszym elementem skrzydła jest zaokrąglona końcówka. Zamkniemy ją w ten sam sposób, w jaki za-

mykaliśmy siatkę łopaty (str. 115). Skrzydło jest o wiele większe od śmigła, więc będziemy potrzebować więcej 

wierzchołków by dokładnie odwzorować tę krzywiznę (Rysunek 5.1.11): 

 

 

 

 

 

Rysunek 5.1.11 Planowany rozkład wierzchołków na zaokrąglonej końcówce skrzydła 

5 wierzchołków krawędzi natarcia połączymy w niej z 5 wierzchołkami krawędzi spływu, tworząc zaokrąglony 

„pasek” wokół końcówki. Pozostałe 26 wierzchołków z górnego i dolnego konturu profilu utworzy 13 krawędzi 

(„węzłów”) na tym pasku. Połowa tych węzłów będzie w przedniej części, a połowa w tylnej (Rysunek 5.1.11). 

Podczas formowania tego profilu starałem się zachować górne wierzchołki ponad dolnymi. Dlatego skalowałem 

je parami, a pojedyncze przesuwałem tylko w pionie (wzdłuż osi Z). Przypuszczam, że można by było zmniej-

szyć liczbę tych par o 2 lub 3 (4 lub 6 wierzchołków), jednak wolę zachować kilka „na zapas”. Oczywiście, póź-

niej też można wstawić nowe wierzchołki (lub całe ich linie). Jednak taka późniejsza modyfikacja siatki zawsze 

wymagać dodatkowej pracy nad ponownym dopasowaniem kształtu powierzchni skrzydła. Wolę jej uniknąć. 
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Gdy profil podstawy jest gotowy, wyciągnij go w trapezowy segment płata: 

1. Włącz widoczność rysunku R.Wing.NACA-2209 (Rysunek 5.1.12a, por. także Rysunek 5.1.2). 

2. Umieść kursor 3D w X=197.0 (to jest miejsce dla obrazu NACA-2209), Y=0, Z=0. 

3. Zaznacz wszystkie wierzchołki ( A ) profilu i wyciągnij go wzdłuż osi X ( E , X ) o 197” (Rysunek 5.1.12b): 

    

Rysunek 5.1.12 Wyciąganie pierwszego segmentu skrzydła 

Teraz zmniejsz rozmiar (Scale) tego nowego profilu, przybliżając kształt konturu NACA-2209 z obrazu: 

1. Upewnij się, że aktualny tryb Transformation Pivot to 3D Cursor. 

2. Wyłącz z zaznaczenia 5 wierzchołków wokół krawędzi spływu. 

3. Skaluj pozostałe wierzchołki współczynnikiem 0.5 (to dopasuje krawędź natarcia – Rysunek 5.1.13a). 

4. Skaluj te same wierzchołki wzdłuż osi Z, współczynnik skali: 0.68 (Rysunek 5.1.13b). 

5. Zaznacz pięć wierzchołków krawędzi spływu i przesuń je o Dy=-49.5 (Rysunek 5.1.13c): 

                

Rysunek 5.1.13 Przybliżanie kształtu profilu sekcji 197 

 

Formując profil podstawy skrzydła użyj tej samej liczby wierzchołków na jego górnym i dolnym obry-

sie. Staraj się zachować je w tych samych miejscach na cięciwie profilu. 
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Kontynuujmy dopasowywanie tego konturu: 

1. Ukryj obraz R.Wing.NACA-2215 (aby lepiej widzieć obraz referencyjny R.Wing.NACA-2209). 

2. Zaznacz wierzchołki dolnego obrysu, oprócz trzech ostatnich z krawędzi spływu (Rysunek 5.1.14a). 

3. Skaluj zaznaczone wierzchołki wzdłuż osi Z, dopasowując dolny kontur do obrazu referencyjnego 

(współczynnik skali: około 0.68, jak pokazuje to Rysunek 5.1.14a): 

           

Rysunek 5.1.14 Dopasowywanie krawędzi końcówki do profilu NACA-2209 

Przełącz się na widok z boku ( 3 ) i sprawdź różnice pomiędzy konturem siatki i rysunkiem referencyjnym. Gdy 

zauważysz takie „systematyczne odchylenie” jak pokazywane przez Rysunek 5.1.14b), skoryguj je następująco: 

1. Zaznacz 11 wierzchołków A..K (Rysunek 5.1.14b). 

2. Przesuwaj je wzdłuż osi Z, dopóki A i K nie znajdą się na krawędzi profilu referencyjnego. 

3. Wyklucz z aktualnego zaznaczenia wierzchołki A i K. 

4. Powtarzaj kroki 2 i 3 dla następujących par krańcowych wierzchołków: B i J, C i I, D i H. 

Rysunek 5.1.15 pokazuje gotowy segment skrzydła (spolszczyłem angielskie station na „stację”) : 

 

Rysunek 5.1.15 Pierwszy segment skrzydła P-40 

 

 

Możesz zawsze założyć stałą grubość krawędzi spływu wzdłuż rozpiętości. Zachowujemy ją poprzez 

wykluczenie wierzchołków tej krawędzi ze skalowania (patrz Rysunek 5.1.13).     
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Dla dodatkowej weryfikacji tej powłoki użyłem danych z oryginalnej dokumentacji P-40 (por. str. 620). Te rysunki 

dostarczają m.in. informacji o prawdziwej grubości krawędzi spływu1. Porównałem także kontury mojej po-

wierzchni ze współrzędnymi z oryginalnych tabel producenta. W rezultacie odkryłem pewne niewielkie różnice 

pomiędzy geometrią profilu NACA i wymiarami podanymi przez Curtiss. Rysunek 5.1.16 pokazuje największe 

odchylenie, jakie znalazłem:   

 

 

Rysunek 5.1.16 Różnica w kształcie przekroju końcówki skrzydła P-40 i profilu NACA-2209 

Na dolnym obrysie oryginalnego profilu NACA-2209 znajduje się dość długi (15% długości cięciwy), płaski odci-

nek. To rezultat matematycznych formuł, które opisują ten kształt. Przypuszczam, że taki spłaszczenie profilu 

wyglądało dziwacznie dla doświadczonych inżynierów lotniczych ze wzorcowni zakładów w Buffalo2. Myślę, że 

„poprawili” je podczas przygotowywania współrzędnych dla prototypu P-36. A potem ta geometria została po-

wtórzona w P-40. 

Podobne różnice pomiędzy matematycznym profilem a współrzędnymi Curtiss można znaleźć w tylnej części 

profilu podstawy skrzydła (stacja 000), pomiędzy 40% i 80% długości cięciwy. Są one mniej widoczne, bo profil 

w tym miejscu jest grubszy. Nie widzę żadnej przyczyny tak drobnej modyfikacji na tym miejscu oryginalnego 

kształtu NACA-2215. Nie zapewniało to żadnej dodatkowej osłony kół podwozia, które chowało się pobliskim 

obszarze tego skrzydła. Może to był błąd w obliczeniach? Na przykład – drobna pomyłka w ustawieniu suwaka 

logarytmicznego3.  

 

 
1 Krawędź spływu za klapami była nieco grubsza, ale zajmiemy się tą różnicą pod koniec tego rozdziału. Na razie zastosowałem mniejszy 

promień, jak w krawędzi spływu lotki.  

2 Gdy po raz pierwszy zauważyłem ten płaski odcinek, sprawdziłem generator z airfoiltools.com. Nie miałem żadnych oryginalnych współ-

rzędnych NACA-2209, więc porównałem wynik airfoiltools z oryginalnymi współrzędnymi NACA-2212, które można znaleźć w oryginalnym 

raporcie NACA o „78 profilach” z 1935 r. Były zgodne.  

3 Mnożenie przez stałą jest najprostszą operacją, jaką wykonuje się na suwaku logarytmicznym. Wystarczy ustawić go raz w ustalonej 

pozycji, a potem tylko odczytywać wyniki z jego skali. Jeżeli jednak przypadkowo poruszysz tak ustawiony suwak nawet o jedną kreskę, 

zaczniesz popełniać systematyczny błąd we wszystkich dalszych obliczeniach. 

Stacja 197 
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Podsumowanie 

• Jeżeli skrzydła modelowanego samolotu mają kąt wzniosu większy niż 2-3º, przygotuj dla nich pomocniczy 

rysunek referencyjny rzutu z góry (str. 131). 

• Formowanie skrzydła zaczynamy od profilu podstawy (str. 132). 

• Zanim rozpoczniesz, przemyśl topologię finalnej siatki (liczbę wierzchołków w kolejnych sekcjach, układ linii 

krawędzi – str. 135). Zaoszczędzisz w ten sposób mnóstwo czasu podczas modelowania. 

• Aby stworzyć pierwsze przybliżenie konturu profile skrzydła wielobokiem, użyj skalowania z różnymi poło-

żeniami środka tych transformacji. To najszybsza metoda. Drobne końcowe poprawki można nanieść pole-

ceniem Move (str. 132-134). 

• Stwórz trapez skrzydła poprzez wyciągnięcie i zmniejszenie (skalowanie) nowo utworzonej krawędzi (str. 

136-137).  

• Przekroje skrzydła mogą minimalnie odbiegać od teoretycznych współrzędnych profilu (str. 138). 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.01.blend. 
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5.2 Formowanie końcówki skrzydła 

Gdy popatrzysz na rzut z przodu z oryginalnych rysunków P-40, zauważysz, że końcówki skrzydła są wygięte w 

górę (Rysunek 5.2.1a). Górny kontur skrzydła jest linią prostą, podczas gdy dolny jest zakrzywiony. To szczegół, 

który trudno dojrzeć na zdjęciach. Zwróć jednak uwagę na kilka szczegółów, które potwierdzają ten kształt z 

oryginalnej dokumentacji. To proste linie nitów na górnej powierzchni końcówki (Rysunek 5.2.1b) i wygięta dolna 

krawędź białego pasa na innej fotografii (Rysunek 5.2.1c): 

          

Rysunek 5.2.1 Kształt końcówki skrzydła w P-40 

Na nieszczęście, brakuje współrzędnych opisujących tę dolną krzywiznę końcówki pokazywaną przez Rysunek 

5.2.1a). Możemy użyć tego obrazu jako „sugestii”, ale nikt nie wymagał dokładności od rysunków złożeniowych. 

Jeżeli górna powierzchnia tej końcówki była kontynuacją trapezu skrzydła, wyciągnijmy ją z obecnej siatki.: 

1. Przełącz się na Edit Mode i zaznacz zewnętrzną krawędź skrzydła (stację 197). 

2. Wywołaj polecenie Slide Vertices ( Shift - V , por. str. 537).  

3. Przesuń odrobinę zaznaczoną krawędź do osi samolotu (1%-2%, Rysunek 5.2.2a), aby się upewnić, że 

Blender prowadzi wszystkie wierzchołki po właściwych krawędziach. Nie potwierdzaj tego przesunięcia! 

4. Naciśnij C  (Clamp OFF) aby wydłużyć aktualne „prowadnice” wierzchołków poza kontur siatki. 

5. Przesuń zaznaczoną sekcję skrzydła poza obrys końcówki widoczny na rysunku ref. (Rysunek 5.2.2b): 

               

Rysunek 5.2.2 Wydłużanie skrzydła poza obrys końcówki  

Wygięty dolny kontur 

Prosty górny kontur 

W widoku z dołu tylna krawędź 
tego białego pasa jest linią prostą 

Linia nitów a) b) 

c) 

Widok z przodu 

a) b) 

Naciśnij C  

Stacja 197  

Przesuń odrobinę tę kra-
wędź w kierunku podstawy 

Teraz przesuń tę krawędź 
poza obrys końcówki 

Tryb Clamp: wyłączony 

Widok z góry 
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Teraz wstaw w tę siatkę nową linię wierzchołków (sekcję), i przesuń ją do stacji 197: 

1. Wyłącz opcję On Cage modyfikatora Subdivision Surface. 

2. Wywołaj polecenie Loop Cut and Slide ( Ctrl - R ) I wstaw nową linię wierzchołków (sekcję) w środek 

skrzydła (Rysunek 5.2.3a). Potwierdź to położenie, pozostawiając tam na chwilę nowo utworzoną sek-

cję. Wszystkie jej wierzchołki powinny pozostać zaznaczone. 

3. Wykonaj zbliżenie na obszar wokół stacji 197. 

4. Przesuń zaznaczoną (Edge Slide) linię wierzchołków do stacji 197 (Rysunek 5.2.3b): 

              

Rysunek 5.2.3 Wstawienie nowej sekcji w stacji 197 

Przesuwanie w ten sposób krawędzi w ściśle określone położenie jest dość trudne, bo nie można po prostu 

wpisać „197” w przyborniku. (To by zepsuło „idealny trapez” obecnej siatki). Jednak podczas wykonywania Edge 

Slide możesz w polu przybornika obserwować aktualną współrzędną X (Rysunek 5.2.3b). Gdy już się zbliżysz 

do 197,  zacznij trzymać wciśnięty klawisz Shift  by zwiększyć dokładność przesunięcia. Potwierdź nowe poło-

żenie dla współrzędnej X tak bliskiej 197.0, jak to możliwe. Ewentualnie zwiększ zbliżenie i powtórz operację 

Edge Slide, dopóki nie uzyskasz zadowalającego rezultatu (powiedzmy, X = 197.0005). 

Teraz wstaw w ten sam sposób nową sekcję w X=205. To będzie podstawa końcówki skrzydła (Rysunek 5.2.4): 

             

Rysunek 5.2.4 Wstawienie nowej sekcji w stacji 205 

 

Gdy patrzysz pod kątem na częściowo przejrzysty rysunek referencyjny, możesz dostrzec pozorną 

różnicę pomiędzy jego liniami i modelem (Rysunek 5.2.4b). Ta różnica znika po zmianie projekcji na 

prostopadłą do rysunku (w tym przypadku: na rzut z góry). Znika także, gdy wyłączysz we właściwo-

ściach tego obrazu kontrolkę Opacity (por. str. 85).     
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Insert new edge 
loop (Loop Cut) 

On Cage: off 

Slide this edge 
to station 197 

While sliding, observe 
actual X coordinate of 
this edge in the sidebar 

a) b) 

Wstaw nową 
sekcję (Loop Cut) 

Przesuń tę 
krawędź do 
stacji 205 

Pozorna różnica 
na rysunku ref.   

a) b) 
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Zanim zaczniemy kształtować ściany tej siatki, dobrym pomysłem jest sprawdzić, czy aktualne rozłożenie wierz-

chołków pozwala na dokładne odtworzenie krzywizny końcówki. Wykorzystamy do tego pomocniczy okrąg: 

1. Przełącz się na widok z góry ( 7 )1. 

2. Ustaw kursor 3D na środku największego łuku, zaznaczonego na rysunku referencyjnym. Nie musisz 

być bardzo dokładny, więc użyj w tym celu narzędzie 3D Cursor (Rysunek 5.2.5a). Upewnij się jednak w 

przyborniku, że współrzędna Z tak ustawionego kursora jest 0. 

3. Wstaw okrąg odpowiadający tylnemu obrysowi końcówki (Rysunek 5.2.5b). W jego parametrach ( F9 ) 

ustaw liczbę wierzchołków na 48, aby uzyskać odstępy podobne do reszty siatki.  

4. Usuń ¾ wierzchołków tego okręgu, pozostawiając tylko łuk wokół końcówki skrzydła. Najprościej to zro-

bić wykluczając z zaznaczenia wierzchołki, które mają pozostać, a następnie usuwając ( X  lub Delete  – 

por . str. 543) pozostałe. Rysunek 5.2.5b) pokazuje, które usunąć: 

               

Rysunek 5.2.5 Wstawienie pomocniczego konturu (okrąg) 

5. We właściwościach modyfikatora Subdivision Surface wyłącz przełącznik Edit Mode (     ). To szybka 

metoda na ukrycie jego rezultatu (jego linie przeszkadzałyby w następnych krokach) . 

6. Umieść (Move) wierzchołki krawędzi pomocniczej przy przecięciach z krawędziami siatki i konturem z 

rysunku referencyjnego (Rysunek 5.2.6). 

7. Wygląda na to, że mamy więcej wierzchołków niż potrzebujemy. Użyj polecenia Dissolve Vertices ( X , 

por. str. 543) by usunąć niepotrzebne: 

                  

Rysunek 5.2.6 Formowanie pomocniczego konturu 

 

1 Aby zobaczyć skrzydło jak pokazane przez Rysunek 5.2.5, użyj lokalnego wariantu widoku z dołu. Przełącz się w Object Mode i użyj skró-

tu Shift - Ctrl - 1 , a potem przełącz się z powrotem w Edit Mode. ( Ctrl - 1  wywołuje View→Viewpoint→Back, a dodatkowy klawisz Shift  

każe Blenderowi wykorzystać zamiast globalnego układu współrzędnych lokalny system aktywnego obiektu). 

Użyj tego narzędzia 
by wstawić tu kursor 
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że jego Z = 0 

Wstaw okrąg: 
promień: 41.27, 
48 wierzchołków 

Widok z góry 

a) b) 

Usuń te wierzchołki 

Umieść wierzchołki okręgu 
ponad tymi przecięciami  

Usuń (Dissolve) wierz-
chołki nadmiarowe  

Wyrównaj końcowe 
segment tego konturu 
do krawędzi spływu 
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Dokończmy ten kontur końcówki: 

1. Wydłuż tę pomocniczą linię wierzchołków w kierunku krawędzi spływu, wyciągając (Extrude) kolejne 

krawędzie z jej ostatniego wierzchołka (Rysunek 5.2.7a). 

2. Gdy ten kontur jest gotowy (Rysunek 5.2.7b), włącz Subdivision Surface:Edit Mode (       ).  

3. Zbliż okno 3D do pomocniczej krawędzi i popraw (Move) jej wierzchołki, dopasowując gładką krzywą 

wynikową do konturu z rysunku referencyjnego. Staraj się zachować jej punkty kontrolne (wierzchołki) 

jak najbliżej poszczególnych podłużnych krawędzi siatki (Rysunek 5.2.7c): 

 

   

Rysunek 5.2.7 Formowanie pomocniczego konturu (c.d.) 

Ten pomocniczy kontur potwierdza, że obecna liczba wierzchołków jest wystarczająca do odtworzenia kształtu 

skrzydła. Zrobiłem obraz ekranu okna 3D Blendera i wczytałem go do Inkscape. Użyłem go tam jako referencji 

przy szkicowaniu planowanej topologii siatki. Przygotowałem ją dla trudniejszej, dolnej części (Rysunek 5.2.8): 

 

Rysunek 5.2.8 Szkicowanie planowanej topologii końcówki skrzydła (w Inkscape) 

Odtworzyłem wypukłą dolną część końcówki (por. Rysunek 5.2.1) za pomocą 3 sekcji „żeber”. Umieściłem je 

(mniej więcej) w stacjach 208, 213 i 220. Naniosłem także krawędzie podłużne (por. str. 135), pomijając oczywi-

stą część centralną. Wszystkie ściany są czworokątami, by uniknąć ewentualnych artefaktów po wygładzeniu.     

a) 

b) 

c) 
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Na górnej powierzchni końcówki użyję podobnej topologii (przesunę tylko sekcje „żeber” bardziej na zewnątrz)1. 

W poprzedniej sekcji spekulowałem (na str. 135), że można by użyć nieco mniejszej liczby wierzchołków do 

odtworzenia profilu skrzydła. Rysunek 5.2.8 potwierdza, że mógłbym pominąć jedną lub dwie pary wierzchołków 

z przednich 30% cięciwy. To uprościłoby nieco topologię krawędzi natarcia. Jednak na ten moment zdecydowa-

łem się kontynuować bez takiej redukcji2. 

Przygotujmy teraz tę siatkę do wycięcia konturu końcówki: 

1. Wyłącz Subdivision Surface:Edit Mode. 

2. Wstaw nowe sekcje (Loop Cut and Slide) w stacjach 208, 212 i 220 (Rysunek 5.2.9a). Nie musisz usta-

lać położenia sekcji 220 z jakąś przesadną dokładnością – różnice rzędu 0.5” są OK. 

3. Przesuń (Slide) sekcje 207 i 212 do wierzchołków na krawędzi natarcia – por. Rysunek 5.2.9b):   

          

Rysunek 5.2.9 Wstawianie sekcji końcówki 

4. Przesuń końcowe odcinki pomocniczego konturu poza siatkę skrzydła (Rysunek 5.2.10):  

       

Rysunek 5.2.10 Wydłużanie końców konturu referencyjnego  

 
1 Planowanie topologii siatki jest rzadko omawiane w poradnikach modelowania. Zazwyczaj jest ona oczywista dla takich prostych kształtów 

jak kołpak śmigła. Łopata śmigła była już trudniejsza, ale do opanowania (dzięki swoim symetriom i niewielkiej liczbie wierzchołków). W 

przypadku kadłuba czy oprofilowania podstawy skrzydła czasami wykonuję prosty, tradycyjny szkic – ołówkiem na papierze. Tworzenie 

takiego rysunku pozwala mi się lepiej „zapoznać” z ich kształtami. Jednak ta metoda zawodzi dla tej końcówki skrzydła, ponieważ jest tu 

zbyt dużo krawędzi i wierzchołków. Przygotowanie akceptowalnego planu na papierze wymagałoby to wielu prób. Stąd użycie Inkscape. 

2 Usunięcie takich par wierzchołków wymaga: 1. Usunięcia zewnętrznej krawędzi stworzonej na str. 242. To zredukuje skrzydło do dwóch 

sekcji: 000 i 197. 2. Usunięcia (Dissolve) czterech wierzchołków par (powiedzmy) 1 i 3. 3. Dopasowania pozostałych wierzchołków sekcji 

000 i 197 do profili wzorcowych. 4. Powtórzenia wszystkich kroków opisanych do tej pory w tej sekcji. Związana z tym ilość pracy jest więk-

sza niż korzyści z tego niewielkiego uproszczenia. 

 

Podobny “szkic roboczy” możesz stworzyć bezpośrednio w Blenderze, narzędziem Grease Pencil. 

Nie piszę jednak tutaj o nim, bo nie chciałem wprowadzać od razu zbyt wielu funkcji.       
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Wytnijmy teraz z siatki skrzydła obrys końcówki: 

1. Przekształć pomocniczy kontur końcówki z krzywej w „pasek”: wyciągnij ją w wzdłuż osi Z w górę i w dół 

o 10” (to dwie operacje Extrude, jak w Rysunek 5.2.11a). 

2. Zaznacz ten nowo utworzony pasek. Użyjemy go jako „noża” (”przecinaka”?). 

3. Wywołaj polecenie Face→Intersect (Boolean)  (patrz str. 527). 

4. Usuń (Dissolve) z wynikowego konturu wierzchołki stworzone przez krawędzie „paska tnącego”. Robiąc 

to, staraj się zachować bez zmian końce podłużnych krawędzi skrzydła (szczegóły – str. 529). Rezulta-

tem tej operacji ma być linia krawędzi zawierająca 38 wierzchołków (Rysunek 5.2.11b):  

           

Rysunek 5.2.11 Wycinanie z podstawowego skrzydła kształtu końcówki   

To cięcie odseparowało górną i dolną powierzchnię końcówki. Teraz zmodyfikujemy ich układ krawędzi i ścian, 

według przygotowanego wcześniej szkicu (Rysunek 5.2.8). 

Przygotujmy siatkę skrzydła dla retopologii dolnej powierzchni końcówki. Zaznacz i ukryj (por. str. 525) górną 

część je powierzchni, bo przesłaniałaby nam widok (Rysunek 5.2.12a): 

                      

Rysunek 5.2.12 Przygotowywanie dolnej powierzchni do retopologii  

Wyeksportowałem z Inkscape do obrazu rastrowego szkic (Rysunek 5.2.8). Załadowałem go jako dodatkowy 

rysunek referencyjny (Rysunek 5.2.12b), by ułatwić retopologię. Możesz przygotować podobny obraz1. 

 
1 Przypuszczam, że Twoja siatka może się różnić od mojej, więc tylko „zapakowałem” mój szkic w towarzyszący plik P40B-09.2.blend.  

 

Graficy komputerowi takie zmiany układu ścian siatki nazywają retopologią. Polega to na przełącza-

niu wierzchołków, przestawianiu krawędzi, tworzeniu nowych ścian w miejsce starych, itp. Pomimo 

swej “naukowej” nazwy, retopologia jest “chlebem powszednim” modelarzy 3D.      
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Poniżej pokazuję retopologię krawędzi natarcia końcówki skrzydła. To sekwencja prostych kroków, więc w tym 

przypadku pomijam ich opis w numerowanej liście. Myślę, że poniższe obrazki wyjaśnią cały proces: 

                      
 

                             
 

      

Rysunek 5.2.13 Retopologia krawędzi natarcia i środka końcówki skrzydła  
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Podczas tej retopologii starałem się zachować ogólny kształt siatki. Jedyna szansa na niewielką zmianę jej 

geometrii występuje podczas poleceń Slide Vertices, gdy przesuwasz wierzchołek wzdłuż krawędzi łączącej go 

z innym, który był wcześniej przesunięty w podobny sposób. Przykład pokazuje Rysunek 5.2.13c). Stąd sugeru-

ję tam przesunąć najpierw wierzchołek z prawej (ten na krawędzi 1), potem środkowy (2), a na końcu lewy (3). 

Zwróć uwagę, że Rysunek 5.2.13j) pokazuje sekcję 208 poniżej niebieskiej linii ze szkicu z mylnym oznacze-

niem „207”. Ta linia i ten napis wynikły z jakiejś drobnej pomyłki na moim szkicu. Siatka nie musi dokładnie po-

wtarzać tego rysunku referencyjnego. Wystarczy odtworzyć pokazaną na nim topologię i zachować podobne 

proporcje ścian. W przypadku sekcji 208, najważniejszy wierzchołek leży na krawędzi natarcia. Jego położenie 

steruje krzywizną (w widoku z góry/dołu) przedniej krawędzi końcówki skrzydła. 

Teraz zmodyfikujmy topologię wokół krawędzi spływu (Rysunek 5.2.14): 

             
 

     
 

     

Rysunek 5.2.14 Retopologia krawędzi spływu końcówki skrzydła  
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Rysunek 5.2.15 pokazuje siatkę końcówki po tej retopologii. Dodałem tutaj (Loop Cut and Slide) sekcję 191. 

Potrzebujemy jej tylko przy krawędzi spływu, lecz trudno byłoby „rozpuścić” jej resztę bez tworzenia n-gonów. 

 

Rysunek 5.2.15 Dolna końcówka skrzydła po retopologii  

Zwróć uwagę, że nadal istnieją w tej siatce małe trójkątne ściany. Znajdują się pomiędzy pięcioma wierzchoł-

kami krawędzi natarcia i spływu. Tymi trójkątami zajmiemy się później.  

Teraz wyświetl (odsłoń) górną powierzchnię siatki i ukryj dolną część końcówki (odwrotnie niż Rysunek 5.2.12a): 

 

Rysunek 5.2.16 Ukrywanie dolnej powierzchni końcówki  

Wykonaj retopologię tej górnej części, powtarzając kroki pokazywane przez Rysunek 5.2.13 i Rysunek 5.2.14: 

 

Rysunek 5.2.17 Górna końcówka skrzydła po retopologii  

Dodatkowa sekcja: 191 

Później wyelimi-
nujemy stąd 
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Nie ukrywaj tego segmentu 
krawędzi natarcia 

Odsłoń ukryte 

ściany ( Alt - H ) 

Ukryj dolną 

część ( H ) 

X 

Widok z przodu  

Pozostawiłem tę 
sekcję prostą 

Wkrótce 
usuniemy 
ten trójkąt 
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Usuń kilka wierzchołków i ścian z krawędzi natarcia i spływu, tak jak pokazuje to Rysunek 5.2.18: 

1. Odsłoń ukrytą poprzednio dolną część końcówki ( Alt - H ). 

2. Usuń 5 wierzchołków (str. 543) krawędzi spływu z oryginalnej krawędzi przecięcia (pomiędzy sekcjami 

197 i 205 – por. Rysunek 5.2.18a). To usunie także z tego obszaru powiązane z nimi ściany. 

3. Usuń z krawędzi natarcia trzy wierzchołki i dwie krawędzie (str. 544), znajdujące się pomiędzy sekcjami 

208 i 212, jak pokazuje to Rysunek 5.2.18b):   

             

Rysunek 5.2.18 Tworzenie tymczasowych wycięć w krawędziach natarcia i spływu   

Przygotujmy krawędzie niewielkiego zaokrąglenia, które będzie biec wzdłuż krawędzi końcówki skrzydła: 

1. Usuń zewnętrzną krawędź z dolnej części końcówki (Rysunek 5.2.19). To usunie cały „pasek” ścian. 

2. Wstaw (Loop Cut) nową linię krawędzi przy brzegu górnej powierzchni (Rysunek 5.2.20a). 

3. Zbliż (Slide) tylną część tej nowej linii krawędzi (wierzchołki od 50% cięciwy) do zewnętrznej krawędzi 

siatki. Pozostaw tam tylko niewielki odstęp, rzędu 0.07” (Rysunek 5.2.20b). 

4. Dopasuj (Slide) wierzchołki przedniej części tej linii krawędzi tak, aby ich odległość od brzegu siatki 

zwiększała się stopniowo w kierunku przy krawędzi spływu (Rysunek 5.2.20b) 

 

 

 

 

Rysunek 5.2.19 Usunięcie zewnętrznej części spodu końcówki Rysunek 5.2.20 Dodanie linii krawędzi wokół końcówki 

 

Te tymczasowe luki w siatce pomogą nam w formowaniu końcówki skrzydła. Bez nich nie można by 

było stworzyć w jednym kroku takiej linii krawędzi, jakiej wstawienie pokazuje Rysunek 5.2.20.      
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5. Zaznacz pasek ścian biegnących na górnej powierzchni, wzdłuż konturu końcówki (Rysunek 5.2.21a). 

6. Skopiuj (Duplicate – por. str. 534) zaznaczone ściany i przesuń je w dół, wzdłuż osi Z, o -0.11”. To gru-

bość krawędzi spływu tego skrzydła (Rysunek 5.2.21b). 

7. Przełącz kierunek normalnych skopiowanych ścian (Mesh→Normals→Flip, str. 568) – w przeciwnym 

razie zepsułyby wynikową powierzchnię podziałową. 

                

Rysunek 5.2.21 Kopiowanie zewnętrznego „paska” ścian   

Krawędź natarcia końcówki skrzydła przypomina wygięty stożek. Na szczegółowych zdjęciach widać, że jej 

promień zmniejsza się do ok. 50% cięciwy, gdzie staje się tak mały jak promień krawędzi spływu (0.05”). Ufor-

mujemy coś podobnego wykorzystując te skopiowane ściany:   

1. Wyłącz obecne zaznaczenie ( Alt - A ), ustaw aktualny tryb Transformation Pivot na 3D Cursor. 

2. Ustaw kursor 3D na zewnętrznym wierzchołku skopiowanych ścian najbliższym 50% cięciwy skrzydła 

(Cursor to Selected). W przypadku mojej siatki należy do pary 10. 

3. Zaznacz przednią część skopiowanych ścian (Rysunek 5.2.22a). Na potrzeby tej operacji będę określał 

zewnętrzną linię krawędzi jako A, a wewnętrzną linię – jako B. 

4. Przełącz się na widok z boku i obróć A i B, tak aby ich czubek pasował (w przybliżeniu) do dolnych 

ścian krawędzi natarcia (Rysunek 5.2.22c). W moim przypadku wymagało to obrotu o -3.2º.  

5. Wyłącz z zaznaczenia krawędź A i obróć B o kolejne -1.2º (Rysunek 5.2.22d). 

               

Rysunek 5.2.22 Poprawianie kształtu skopiowanych ścian   

Końcówki krawędzi A i B w widoku z boku powinny być ustawione tak, jak pokazuje Rysunek 5.2.22e) . 

 

Po skopiowaniu ścian zawsze sprawdzaj zwrot ich normalnych (por. str. 568). Jeżeli są zwrócone w 

przeciwną stronę niż sąsiednie ściany, stworzą nieoczekiwane ostre krawędzie.       
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Rysunek 5.2.23 pokazuje przygotowane kontury krawędzi natarcia:  

 

Rysunek 5.2.23 Kontury krawędzi natarcia   

Tylna część krawędzi B także wymaga drobnych poprawek, aby odtworzyć okrągły przekrój krawędzi spływu: 

1. Wyłącz całe zaznaczenie ( Alt - A ). 

2. Zaznacz tylną część krawędzi B (za parą 10 – por. Rysunek 5.2.22a), jak pokazuje Rysunek 5.2.24a). 

3. Przesuń zaznaczone wierzchołki wzdłuż osi Z o około -0.02”. Zrób to w dużym zbliżeniu, aby uzyskać w 

sekcji 205 podobny kąt nachylenia krawędzi jak w sekcji 197 (Rysunek 5.2.24b): 

              

Rysunek 5.2.24 Wstępne ustawienia krawędzi spływu   

Uformujmy pierwsze przybliżenie wypukłości na dolnej powierzchni końcówki skrzydła: 

1. Wyłącz całe zaznaczenie ( Alt - A ). 

2. Ustaw kursor 3D w jednym ze środkowych wierzchołków z dolnej części sekcji 212 (Rysunek 5.2.25a). 

3. Zaznacz dolną część sekcji 220 (Rysunek 5.2.25b). 

4. Obróć zaznaczone wierzchołki wokół osi Y o 10º (Rysunek 5.2.25b): 

       

Rysunek 5.2.25 Pierwsze przybliżenie wypukłości na spodzie końcówki skrzydła   

 

Pominę ten punkt w dalszych listach kroków, ale pamiętaj, aby naciskać ( Alt - A ) przed nowym za-

znaczeniem. Inaczej obrócisz/przesuniesz jakiś zapomniany element siatki z poprzedniej operacji!        
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Jesteśmy już gotowi do zamknięcia („zszycia”) tej siatki. Zacznijmy od dołu: 

1. Zaznacz dolne krawędzie sekcji 220 i linię krawędzi B (Rysunek 5.2.26a). Upewnij się, że w tym zazna-

czeniu jest parzystą liczbę wierzchołków. 

2. Wywołaj polecenie Edge→Bridge Edge Loops (str. 545). To tworzy nowy rząd ścian, łączących zazna-

czone wierzchołki. 

        

Rysunek 5.2.26 Zamykanie dolnej powierzchni końcówki 

 
Teraz zamknijmy brzegi tej końcówki skrzydła:  

1. Zaznacz linie krawędzi na górnym i dolnym brzegu powierzchni końcówki (Rysunek 5.2.27a). Upewnij 

się, że zaznaczyłeś parzystą liczbę wierzchołków. 

2. Wywołaj polecenie Edge→Bridge Edge Loops, aby połączyć je ścianami (Rysunek 5.2.27b). 

3. Wstaw (Loop Cut) nową linię krawędzie w środku tych ścian, jak pokazuje to Rysunek 5.2.27c). 

 

 

 

Rysunek 5.2.27 Zamykanie obramowania końcówki   

 

Bridge Edge Loops wymaga zaznaczenia dwóch linii krawędzi o tej samej liczbie wierzchołków. Jeże-

li masz z tym poleceniem problem, możesz utworzyć te ściany jedna po drugiej (por. str. 153).        
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a) b) 

220 220 
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Loop Cut and Slide 
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Nadajmy temu nowo utworzonemu konturowi bardziej owalny przekrój: 

1. Zaznacz górną linię krawędzi tego konturu (Rysunek 5.2.28 oznacza ją jako A). 

2. Przesuń (Edge Slide) tę krawędź do wnętrza skrzydła, o około 30% (Rysunek 5.2.28a). 

3. Przesuń (Edge Slide) tę samą krawędź na zewnątrz, o około 30% (Rysunek 5.2.28b). 

4. Wyłącz całe zaznaczenie, a potem zaznacz przeciwną linię krawędzi (Rysunek 5.2.28 - krawędź B). 

5. Powtórz kroki 2 i 3 dla linii wierzchołków B. 

              

Rysunek 5.2.28 Zaokrąglanie przekrojów krawędzi końcówki skrzydła 

Przekrój krawędzi natarcia końcówki powinien być bardziej „paraboliczny”. Aby to osiągnąć, powtórz powyższe 

kroki dla przedniej części linii wierzchołków A i B (dla wszystkich z przednich 50% cięciwy skrzydła). 

Teraz zamknijmy tymczasowy otwór w krawędzi natarcia (jego stworzenie pokazuje Rysunek 5.2.18) . W tym 

przypadku zaznaczenie dwóch odrębnych linii krawędzi dla polecenia Bridge Edge Loops wymagałoby przełą-

czenia w tryb krawędzi (por. str. 502). Zamiast tego, sugeruję utworzenie tych kilku ścian kolejnymi poleceniami 

F , tak jak to pokazuje Rysunek 5.2.29: 

         

Rysunek 5.2.29 Zamykanie tymczasowego otworów w krawędzi natarcia 

Te kroki wydają mi się oczywiste, więc nie będę tu umieszczał ich listy.  

 

 

Ilustracja powyżej pokazuje, jak przesuwanie wierzchołków wzdłuż krawędzi zmienia kształt siatki. 

Oczywiście, te zmiany są do pominięcia, gdy sąsiednie krawędzie wyglądają jak jedna linia prosta. W 

innych przypadkach taką operacją można jednak w niezamierzony sposób zmienić kształt obiektu.       
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W ten sam sposób zamknij tymczasowy otwór z tyłu końcówki (por. Rysunek 5.2.18). Po stworzeniu pierwszej 

ściany (Rysunek 5.2.30a) wykonaj zbliżenie krawędź spływu (Rysunek 5.2.30b) : 

                     

Rysunek 5.2.30 Zamykanie tymczasowego otworu w krawędzi spływu 

Ustaw projekcję okna 3D wzdłuż krawędzi spływu, aby łatwo zaznaczać wierzchołki dla kolejnych ścian. 

Rysunek 5.2.31a) pokazuje siatkę zamkniętej końcówki skrzydła: 

           

Rysunek 5.2.31 Sprawdzanie kształtu końcówki skrzydła 

Patrząc na ten rezultat, natychmiast dostrzegłem kilka wierzchołków, które wymagają drobnych poprawek (po-

leceniami Move lub Edge Slide). W mojej siatce to obszar wokół krawędzi natarcia i dwa wierzchołki w środku 

końcówki skrzydła (Rysunek 5.2.31b). To efekty uboczne przesuwania wzdłuż krawędzi całych linii wierzchoł-

ków (por. Rysunek 5.2.28). Naprawimy je w następnej sekcji tego poradnika. 

Zwróć uwagę, że w tym momencie nadal pozostawiam wyłączony efekt powierzchni podziałowej (przełącznik 

Edit Mode w modyfikatorze Subdivision Surface). Ta wynikowa powierzchnia leży wewnątrz „klatki” uformowanej 

przez ściany siatki, odtwarzając „gładszą wersję” ich kształtu. Czasami łatwiej jest zauważyć różne niewielkie 

dysproporcje patrząc na oryginalne ściany siatki niż na utworzoną na ich podstawie gładką powłokę.   

Na przykład: można łatwo utworzyć odwrócone ściany wykorzystując wynik polecenia Duplicate (por. str. 150). 

Krawędzie pomiędzy ścianami o przeciwnych orientacjach staja się ostre na wynikowej powierzchni podziałowej 

(por. str. 568), więc polecenie Recalculate Outside pozwala uniknąć takich niespodzianek.   

 

 

Gdy zamkniesz taką siatkę, zawsze wywołaj Mesh→Normals→Recalculate Outside. To polecenie 

„porządkuje” orientację ścian, która mogła zostać zaburzona w wyniku wcześniejszej edycji.      
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Podsumowanie 

• W tej sekcji nauczyliśmy się, jak kopiować element siatki (Duplicate, str. 150) i używać wybranych ścian ja-

ko „noża” (Intersect (Boolean), str. 145). Dowiedziałeś się także, jak tworzyć całe „paski” nowych ścian po-

leceniem Bridge Edge Loops (str. 152). 

• Końcówka skrzydła P-40 jest dość trudnym kształtem, ponieważ jej górna powierzchnia pozostaje płaska 

aż do brzegów (str. 140) Podobne znajdziesz w P-38 „Lighting” czy F4U „Corsair”. Końcówki skrzydeł in-

nych samolotów mają prostszy, bardziej symetryczny kształt. 

• Uzyskaliśmy podstawowy kształt końcówki poprzez wyciągnięcie trapezowej części skrzydła (str. 140), któ-

rą następnie „przycięliśmy” odpowiednio zakrzywionym, pomocniczym „paskiem” ścian (str. 145).  

• Kształt użytego to tego cięcia „paska” powstał z dodatkowego konturu, który pozwolił nam określić położe-

nia punktów sterujących na podłużnych krawędziach siatki skrzydła (str. 142 - 143). Sprawdziliśmy w ten 

sposób, gdzie umieścić te punkty, aby uzyskać poprawną krzywą końcówki. To o wiele prostsze od mozol-

nego dopasowywania całej końcowej siatki. 

• Wyciągnęliśmy (por. str. 150 - 152) zaokrąglone ściany brzegu końcówki z górnej powierzchni, a następnie 

połączyliśmy je z powierzchnią dolną (str. 152). 

• Aby uprościć te operacje, wykonaliśmy tymczasowe otwory u podstawy końcówki skrzydła (str. 149). Za-

mknęliśmy je pod koniec tej sekcji (str. 153 - 154). 

• Regularna siatka zbudowana z czworokątnych ścian zazwyczaj generuje gładką, przewidywalną po-

wierzchnię podziałową. „Surowe” ściany uzyskane w wyniku cięcia narzędziem Boolean (str. 145) wymaga-

ją nieco retopologii (str. 146 - 147), aby wyeliminować n-gony i trójkąty.   

• Zaplanuj układ swojej siatki (przynajmniej – przybliżony) zanim zaczniesz jej retopologię (str. 143). O wiele 

łatwiej jest usuwać i przełączać linie rysowane na papierze niż zmieniać finalny układ trójwymiarowych 

ścian metodą „prób i błędów”.  

 

 

Wewnątrz tego pliku, w kolekcji 1b.Wing, znajdziesz rysunek referencyjny z moim szkicem (pokazany na str. ). 

Używałem go jako referencji przy retopologii końcówki skrzydła (str. - ). Nosi nazwę R.Wing Tip (topology). Ten 

obiekt Empty (Image) wykorzystuje osadzony wewnątrz pliku *.blend obraz o nazwie PlannedTipLayout.png1. 

 

 
1 Możesz zaimportować ten obraz do swojego pliku poleceniem File→Append (str. 943). Jednak przypuszczam, że w Twoim modelu po-

dłużne krawędzie siatki skrzydła mogą mieć inne położenie, i nie będą pasować do mojego rysunku. Dlatego nie włączyłem go do innych 

obrazów referencyjnych, które towarzyszą tej książce. 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.02.blend. 
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5.3 Wykończanie końcówki skrzydła 

W poprzedniej sekcji zamknęliśmy siatkę i ustaliliśmy jej topologię, tworząc początkowe przybliżenie końcówki 

skrzydła. W tej sekcji „doszlifujemy” jej geometrię.  

W pierwszym, oczywistym kroku, sprawdź te nowo utworzone ściany pod kątem jakichś nieregularności. Aby 

lepiej widzieć szczegóły bazowej siatki, rób to z wyłączonym Subdivision Surface:Edit Mode. Na ostatniej ilu-

stracji z poprzedniej sekcji wskazałem dwa miejsca wymagające poprawek (por. str. 154). Poprawny tę najbar-

dziej widoczną: dwie wklęsłe krawędzie w środku konturu końcówki skrzydła. Występują pomiędzy wierzchoł-

kami, które oznaczyłem jako A i B (Rysunek 5.3.1a): 

               

Rysunek 5.3.1 Pierwsze poprawki geometrii siatki 

Przesunąłem (oddzielnie) A o -0.12”, potem B o -0.07”, tylko po to, aby te wklęsłe krawędzie stały się odrobinę 

wypukłe (Rysunek 5.3.1b). 

Sugeruję także okrążyć krawędź spływu tej końcówki, zatrzymując się przy każdej kolejnej sekcji/linii krawędzi. 

W każdym z tych miejsc popraw ostatnich pięć wierzchołków, tak aby rozmiar, kształt i proporcje ich łamanej 

były podobne do poprzedniej. Zacznij wprowadzać te modyfikacje od sekcji 205, wzorując się na wierzchołkach 

sekcji 197 (Rysunek 5.3.2): 

         

Rysunek 5.3.2 Ujednolicanie zaokrągleń krawędzi spływu 

Aby ujednolicić rozmiar, umieść kursor 3D na najwyższym wierzchołku krawędzi spływu (Rysunek 5.3.2a), za-

znacz te pięć wierzchołków, i skaluj je wzdłuż osi Z (Rysunek 5.3.2b). Po skalowaniu, dopasuj jeszcze (indywi-

dualnie) jeden lub dwa wierzchołki, aby zunifikować kąty pomiędzy ścianami krawędzi spływu (Rysunek 5.3.2c). 

Powtarzaj tę operację dla wszystkich końcówek „cienkiego” konturu, czyli aż do węzła 10 (Rysunek 5.3.2d). 

 

Odpowiednio dobrana projekcja (jak na ilustracjach powyżej) może pomóc w takiej unifikacji. Musisz 

wykonać zbliżenie i skierować okno 3D na najbliższy węzeł krawędzi spływu.       
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Aby wyjaśnić, co jest nie tak z krawędzią natarcia w naszym modelu, popatrzmy na zdjęcia poniżej: 

 

     

Rysunek 5.3.3 Krawędź natarcia końcówki na zdjęciach  

Rysunek 5.3.3a) potwierdza ogólny rozkład promieni zaokrągleń przyjęty w poprzedniej sekcji (str. 150-151). 

Zaokrąglenie krawędzi natarcia jest większe (grubsze), a krawędzi spływu – cieńsze, z obszarem przejściowym 

pośrodku. Jednak grubość krawędzi natarcia wydaje się mniejsza niż w naszym modelu (por. Rysunek 5.3.4 i 

Rysunek 5.3.3c). Co więcej, Rysunek 5.3.3b) pokazuje, że ta krawędź jest lekko wygięta w dół.   

Zdecydowałem się uczynić tę krawędź natarcia cieńszą poprzez obniżenie jej górnych ścian i podniesienie 

ścian dolnych. Można także zauważyć drobne zaburzenie krawędzi siatki na spodzie sekcji 212: 

 

Rysunek 5.3.4 Krawędź natarcia końcówki (projekcja jak z Rysunek 5.3.3c) 

Sugeruję zacząć tę transformację od modyfikacji linii krawędzi A, potem B, C i kolejnych (Rysunek 5.3.5): 

 

Rysunek 5.3.5 Planowane zmiany krawędzi natarcia 
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Nie wyliczam tu wszystkich kroków tej modyfikacji, bo myślę, że już jesteś w stanie wykonać je bez takiego 

„prowadzenia za rękę”. Wykorzystuj głównie skalowanie i przesuwanie wzdłuż osi Z. Dla ewentualnych przesu-

nięć poziomych wykorzystuj polecenie Slide Vertices. Rysunek 5.3.6 pokazuje zmienioną krawędź natarcia. Jak 

widać, zmodyfikowałem więcej wierzchołków niż początkowo zamierzałem. Najbardziej to widać wokół linii kra-

wędzi A. Teraz ta część sekcji 220 jest podniesiona a sekcja 212 tworzy bardziej regularny nos profilu (por. Ry-

sunek 5.3.5 i Rysunek 5.3.6). Do podniesienia przedniej części sekcji 212 użyłem obrotu wokół osi X: 

 

Rysunek 5.3.6 Skorygowana krawędź natarcia 

Reguła podana powyżej jest dość ogólna. W praktyce podczas tych wszystkich edycji mogłem nieświadomie 

przesunąć jeden czy dwa wierzchołki na płaszczyźnie XY. Dlatego teraz sprawdźmy powierzchnię wynikową: 

1. Włącz w modyfikatorze Subdivision Surface tryby Edit Mode oraz On Cage. 

2. Włącz widoczność rysunku referencyjnego R.Wing (top). 

3. Przełącz się na widok z góry, włącz cieniowanie Wireframe (Rysunek 5.3.7): 

 

Rysunek 5.3.7 Sprawdzanie konturu powierzchni wynikowej w widoku z góry 

 
1 To samo dotyczy krzywych i powierzchni NURBS. 

 

Przesuwaj swobodnie wierzchołki (punkty sterujące) wzdłuż osi Z. Dopóki ich rzuty na płaszczyznę 

XY pozostają bez zmian, rzut wynikowej powierzchni podziałowej na tę płaszczyznę XY nie ulegnie 

zmianie. To oznacza, że takie modyfikacje nie zmieniają finalnego kształtu końcówki w rzutach z 

góry/dołu. To bardzo użyteczna właściwość powierzchni podziałowych1 (por. także str. 647). 
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Obrys końcówki pokazanej przez Rysunek 5.3.7 pasuje do konturu z rysunku. Dostrzegłem tylko małe spłasz-

czenie na krawędzi natarcia przy sekcji 212. To przypadek łatwy do poprawienia: 

1. Umieść kursor 3D w wierzchołku A (Cursor to Selected, Shift - S , 2 ), por. Rysunek 5.3.8b). 

2. Przełącz aktualny tryb Pivot na 3D Cursor. 

3. Zaznacz pierwsze trzy wierzchołki siatki krawędzi natarcia, w B i C. 

4. Obróć to zaznaczenie (Rysunek 5.3.8b): 

               

Rysunek 5.3.8 Poprawianie kształtu krawędzi natarcia 

Dlaczego obróciliśmy końce tych dwóch sekcji zamiast tylko przesunąć wierzchołki w C? Ponieważ modyfikacja 

węzła C zmieni także kształt powierzchni podziałowej w B i D (por. str. 635, 642). Na szczęście, w tym przypad-

ku wierzchołki w D są współliniowe z E, co „znieczula” ten węzeł n a takie zmiany. (Nie są współliniowe na wy-

nikowej powierzchni, pokazywanej przez Rysunek 5.3.8). Niewielki obrót B i C pozwala uniknąć wzajemnego 

dopasowywania, które byłoby niezbędne w przypadku przesunięcia samego węzła C.    

W obrazie z rzutem z góry znajduje się także rzut skrzydła z przodu. Choć jego dokładność pozostawia wiele do 

życzenia, to wszystko, co mamy dla tej projekcji. Użyjmy go jako referencji dla widoku z przodu: 

1. Przełącz się na Object Mode ( Tab ). 

2. Skopiuj (Duplicate) obraz R.Wing (top). Nazwij tę kopię R.Wing (front). 

3. Przełącz aktualny tryb Pivot na Bounding Box Center. 

4. Obróć R.Wing (front) wokół osi X o 90º. 

5. Przełącz się na widok z przodu ( 1 ). Użyj pola Offset X (Properties:Object Data, panel Empty) do prze-

sunięcia obrazu rzutu z przodu ponad model skrzydła (ustaw tę wartość na -0.24, por. Rysunek 5.3.9b): 

           

Rysunek 5.3.9 Przygotowywanie obrazu z rzutem z przodu 

6. Obróć obiekt R.Wing (front) wokół osi Y o 0.1º, dopasowując kontur na obrazie do górnego i dolnego 

konturu skrzydła modelu. 

7. Minimalnie powiększ (Scale, wspc. = 1.0025), dopasowując obraz do nominalnej rozpiętości. 

Widok z przodu a) b) 

Wymaga obrotu 

Wymaga skalowania 

Zwiększ Offset X obrazu 

Offset X: -0.24 

Purpurowy łuk prze-
kracza o pół grubości 
linii prawdziwy kontur 

krawędzi natarcia 

Ten punkt umie-
ściłem wg współ-
rzędnych skrzy-
dła: (197, -4.5) 

Ten segment 
powinien być 

bardziej wypukły 
212 212 

Obróć o -1.25º 

A 

B 

C 

D 

E 

207 

205 

Środek 

b) a) 



160 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Jak nasz model pasuje do konturu końcówki skrzydła z tego rysunku? Cóż, w tym miejscu muszę użyć wymia-

rów, które znalazłem w bardziej szczegółowym rysunku z innego źródła1: 

 

Rysunek 5.3.10 Widok z przodu końcówki skrzydła 

Według tych danych, kontur końca skrzydła na tym rysunku jest zbyt cienki (dolną część narysowano nieprawi-

dłowo). Rysunek 5.3.10 pokazuje kształt wypukłości pod tą końcówką (dolne kontury sekcji 212 i 220). 

Omówmy teraz ostatnie z zagadnień: popatrz na krawędź spływu lotki na zdjęciach poniżej (Rysunek 5.3.11): 

                    

Rysunek 5.3.11 Krawędź spływu lotki w P-40 

Krawędź spływu na tych zdjęciach jest płaska aż do końca lotki. Wykorzystałem tu zdjęcia dwóch różnych ma-

szyn, aby wykluczyć możliwość, że jest to związane z pojedynczym odrestaurowanym egzemplarzem P-40.  

A na naszym modelu? Obecnie koniec lotki przy sekcji 205 jest wygięty w górę o 0.37” (Rysunek 5.3.12): 

 

Rysunek 5.3.12 Krawędź spływu lotki w naszej końcówce skrzydła 

Uzyskaliśmy ten kształt w rezultacie wycięcia obrysu końcówki z podstawowego „trapezu” skrzydła (por. str. 

145). Jeżeli ta krawędź spływu na końcu lotki leżała na płaszczyźnie cięciw skrzydła, to musimy zmodyfikować 

tę część naszej siatki. 

 
1 Oryginalnego rysunku złożeniowego Curtiss nr 87-03-532 
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W sekcjach A, B, C, D (Rysunek 5.3.13) przesuń w dół, wzdłuż osi Z, pięć wierzchołków krawędzi spływu: 

 

 

Rysunek 5.3.13 Modyfikowanie krawędzi spływu 

W sekcjach A i B umieść środkowe wierzchołki na płaszczyźnie Z=0 (Rysunek 5.3.13a), a potem przesuń w dół 

wierzchołki w C i D, by uformowały w widoku z tyłu linię prostą (Rysunek 5.3.13b).   

Dopasuj położenie innych wierzchołków siatki poprzez skalowanie wzdłuż osi Z (Rysunek 5.3.14): 

 

 

 

Rysunek 5.3.14 Modyfikowanie krawędzi spływu (c.d.) 

Skaluj cztery górne wierzchołki sekcji B i C (Rysunek 5.3.14a) wykorzystując kursor 3D jako środek transforma-

cji (ustawiony jak na tej ilustracji). Następnie umieść kursor w środku dolnego konturu sekcji 212 (Rysunek 

5.3.14b) i skaluj tylną część tej sekcji (współczynnik: około 1.25 - 1.3). To poprawi kształt spodu końcówki 

skrzydła. 

Rysunek 5.3.14c) pokazuje siatkę po tych zmianach.  
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Teraz możesz się przełączyć w Object Mode i przyjrzeć wynikowej powierzchni pod różnymi kątami, szukając 

ewentualnych lokalnych wypukłości. Nie możesz dotknąć tego obiektu, ale możesz znaleźć nawet minimalne 

odchylenia śledząc cienie na jego powłoce. Dobrym pomysłem jest też ustawić kilka różnych MatCap (por. str. 

51), ale osobiście uważam, że materiały „clay_*” (glina) sprawdzają się w tym przypadku najlepiej. Czy zauwa-

żyłeś, że do tej pory nie przełączyliśmy tego obiektu na cieniowanie Smooth? Płaskie, kanciaste ściany lepiej 

się nadawały do edycji „surowej” siatki bazowej. Teraz jednak włącz to wygładzanie (Rysunek 5.3.15): 

 

Rysunek 5.3.15 Sprawdzanie wynikowej powierzchni obiektu 

Jeżeli zauważysz coś nieprawidłowego na tym skrzydle, przełącz się do Edit Mode i sprawdź na tym obszarze 

kąty pomiędzy ścianami siatki. Poprawka to zazwyczaj drobnego przesunięcia jednego lub dwóch wierzchołków. 

Moglibyśmy zakończyć tę sekcję na akapicie powyżej: końcówka skrzydła jest uformowania. Jednak, jak wspo-

mniałem (por. Rysunek 5.3.10), korzystam także z oryginalnej dokumentacji. Wymiary końcówki są rozproszone 

wśród jej wielu rysunków. Aby wykorzystać je wszystkie, „skompilowałem” te informacje w pomocniczy „szkielet 

3D” (szczegóły: str. 605, 620). Gdy go porównałem z naszą końcówką, odkryłem, że się myliłem: jej krawędź 

spływu powinna być wyżej niż w naszym modelu (Rysunek 5.3.16): 

       

Rysunek 5.3.16 Krawędź spływu końcówki wg oryginalnych rysunków Curtiss i zdjęć 

Oczywiście, sprawdziłem to także ze zdjęciami. Dość trudno jest porównywać taki wygięty obiekt, lecz różne 

ujęcia wydają się potwierdzać kształt z tego szkieletu 3D, przygotowanego wg oryginalnych wymiarów. 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.03.blend. 
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Zawsze jestem gotowy do wprowadzenia w moim modelu tego rodzaju poprawek1. Zanim jednak cokolwiek 

zrobimy, przyjrzyjmy się bliżej tej nowej krawędzi spływu (Rysunek 5.3.17): 

   

Rysunek 5.3.17 Analiza różnic 

W widoku z tyłu, ta nowa krawędź końcówki jest linią prostą (Rysunek 5.3.17a). Kończy się 0.6” od końca lotki, 

na kośnym segmencie żebra 205. Pionowa odległość od obecnej krawędzi spływu nie przekracza jednego cala. 

Jednak rozłożenie istniejących węzłów sterujących (końcówek poszczególnych sekcji) nie pozwala uformować 

tu takiego ostrego załamania. Nie możemy przesunąć tych węzłów bez zaburzenia konturu końcówki w widoku 

z góry/dołu. By uzyskać taki kształt musimy dodać nową sekcję (Rysunek 5.3.17a). Myślę, że jej kształt powi-

nien podążać za linią połączenia końcówki ze skrzydłem, czyli kołnierza biegnącego wzdłuż żebra 205. Aby 

oddzielić wpływ ukośnych krawędzi końcówki od trapezowej części skrzydła, zaznaczyłem tę nową krawędź 

jako ostrą (Crease – por. str. 539, 645). Nowa sekcja wprowadzi także dodatkowy węzeł na krawędź natarcia. 

Na szczęście, to nawet trochę poprawi układ tej części, przesuwając na zewnątrz sąsiedni węzeł sekcji 207. 

Poniżej opisuję krótko, co zrobiłem. Najpierw skopiowałem (Duplicate) zewnętrzną linię wierzchołków końcówki 

skrzydła i spłaszczyłem ją (skalując) wzdłuż osi Z do 0 (Rysunek 5.3.18a). Potem wstawiłem (Subdivide) w tę 

linię dwa nowe wierzchołki. Poprawiłem położenie pozostałych, aby zachować kształt końcówki w rzucie z góry:  

           

Rysunek 5.3.18 Określanie nowych pozycji węzłów sterujących kształtem konturu końcówki 

Zasymulowałem na tej krzywej planowaną ostrą krawędź poprzez wprowadzenie przerwy w nowych węzłach 

(Rysunek 5.3.18b). Aby tak rozdzielić wierzchołki, użyj polecenia Rip Vertices ( V , por. str. 520).  

 
1 Zawsze buduję model z myślą o ewentualnych poprawkach, wprowadzanych w ślad za nowymi danymi, które mogą się pojawić na każ-

dym etapie projektu. Dlatego zawsze staram się zachować siatki w możliwie prostej postaci, wykorzystując jak najwięcej modyfikatorów. 

 

Gdy napotkasz taką drobną różnicę, możesz ją zignorować lub poprawić. Ignorowanie jest uzasad-

nione, gdy budujesz jakiś model na pilne zamówienie. Jeżeli jednak robisz to w ramach hobby, suge-

ruję korygować wszystkie znalezione różnice. 
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Gdy zmodyfikowany kontur był gotowy, wyłączyłem opcję Subdivision Surface:On Cage i wzdłuż konturu koń-

cówki porównałem położenie jego wierzchołków z aktualnymi węzłami. O dziwo, jedyne widoczne zmiany wy-

stąpiły na krawędzi spływu (punkty: A, B, C, D). Patrząc na obecną topologię siatki zaplanowałem, jak dopaso-

wać końcówki sekcji do zmienionych punktów nowego konturu (Rysunek 5.3.19): 

 

Rysunek 5.3.19 Planowanie zmian w topologii siatki 

Pierwsze modyfikacje były oczywiste: 

1. Obróciłem ostatnie wierzchołki sekcji 212, dopasowując jej koniec do punktu A. 

2. Obróciłem ostatnie wierzchołki sekcji 207, dopasowując jej koniec do punktu B. 

3. Obróciłem ostatnie wierzchołki sekcji 205, dopasowując jej koniec do punktu C. Zaznaczyłem tę sekcję 

jako ostrą (Crease = 1, por. str. 539). 

Następnie, zamiast tworzenia nowych linii krawędzi, przesunąłem istniejące sekcje w nowe miejsca: 

4. Przesunąłem sekcję 197 o 6”, do stacji 203 (punkt D). Zrobiłem to wzdłuż kontynuacji oryginalnych 

krawędzi trapezowej części skrzydła (polecenie Edge Slide bez opcji Clamp, jak na str. 140). 

5. Przesunąłem (Edge Slide) sekcję 191 do stacji 197 (punkt E). Oznaczyłem ją jako ostrą (Crease = 1), 

aby zakończyć w tym miejscu zakrzywiony kontur narożnika lotki. 

Rysunek 5.3.20 przedstawia siatkę końcówki po tych modyfikacjach: 

  

Rysunek 5.3.20 Zmodyfikowana siatka końcówki skrzydła 

 

Zauważ, że punkty B, C, D są współliniowe. W ten sposób możesz otrzymać gładką powierzchnię 

podziałową nawet na „ostrej” krawędzi (Crease = 1), która kończy się w C.  
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Po analizę szczegółów technicznych kołnierza łączącego końcówkę z resztą skrzydła, zdecydowałem się prze-

sunąć punkt C ponad końcówkę żebra 205 (por. Rysunek 5.3.20a, b)1. Pozostawiłem także ostrą krawędź w 

punkcie E (w następnej sekcji wyjaśnię, dlaczego mogłem tam zostawić taki narożnik) . 

Gdy kształt tej zmienionej siatki jest dopasowany do zadanego konturu w widoku z góry/dołu, czas zadbać o 

jego kształt w pionie. Przesunąłem odpowiednio węzły krawędzi spływu wzdłuż osi Z (Rysunek 5.3.21a): 

 

  

Rysunek 5.3.21 Korygowanie górnej powierzchni końcówki 

Następnie podniosłem także wierzchołki górnej powierzchni końcówki. Skalowałem tu każdą podłużną krawędź 

wzdłuż osi Z, aż stała się prosta (Rysunek 5.3.21b, c). Można tu też użyć polecenia Vertex→Align (str. 544). 

Rysunek 5.3.22 pokazuje ukończoną siatkę końcówki skrzydła: 

 

  

 

 

Rysunek 5.3.22 Gotowa końcówka skrzydła 

 
1 W „P-40 Erection & Maintenance Instructions” dla P-40N (str. 45-47) jest ilustrowana sekcja o montażu końcówki skrzydła. Widać tam, że 

aby nasunąć kołnierza końcówki skrzydła na kołnierz kończący trapezową część skrzydła (wokół żebra 205) potrzebny był drewniany mło-

tek. Górny i dolny pasek tego kołnierza był przecięty wzdłuż krawędzi spływu, czyniąc go podatnym na ewentualne wyginanie wzdłuż od-

chylonego do góry konturu końcówki. Poradni ostrzega, że końcówki są indywidualnie dopasowywane do skrzydeł. 
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Dokładny kształt krawędzi spływu w płaszczyźnie pionowej jest nadal kwestią otwartą. Ostatnie wymiary, jakie 

można znaleźć na oryginalnym rysunku końcówki opisują dźwigar #5 (por. Rysunek 5.3.22) i żebro 205. Odno-

szę wrażenie, że kształt krawędzi pomiędzy tymi dwoma punktami różni się w odrestaurowanych P-40 i P-36. 

Na niektórych zdjęciach jest zbliżony do pierwszego wariantu naszej końcówki (tego ze str. 161), podczas gdy 

na innych przypomina drugi wariant. W każdym razie, jeżeli znajdziesz lepsze zdjęcie tej części, w poprawio-

nym układzie siatki (pokazywany przez Rysunek 5.3.22) możesz łatwo uzyskać każdy z możliwych kształtów.   

 

Podsumowanie 

• W tej sekcji pokazałem, jak stworzyć ostrą krawędź na gładkiej powierzchni wykorzystując współczynnik 

Crease (str. 165, 164). W następnej sekcji tego poradnika „wyostrzymy” w ten sposób wiele krawędzi. 

Wspomniałem także, jak rozdzielić krawędź przy wierzchołku (Rip Vertices, str. 163). 

• Poprawiliśmy kształt siatki stworzonej w sekcji 5.2: ujednoliciliśmy grubość krawędzi spływu (str. 156), po-

prawiliśmy kształt krawędzi natarcia (str. 157-159) oraz dolny kontur końcówki skrzydła (str. ). 

• Traktuj widok z przodu tylko jako poglądowe przedstawienie modelowanego kształtu. Nawet w oryginal-

nych rysunkach złożeniowych Curtiss kształt końcówki skrzydła może być mylący (str. 160). 

• Gdy modyfikujesz tak złożone siatki jak wygładzony powierzchnią podziałową koniec skrzydła, zawsze za-

czynaj od przybliżonych transformacji całych segmentów (str. 161). Rób to tak długo, jak możesz, ograni-

czając krok po kroku modyfikowany obszar. Dopiero na samym końcu nanieś niezbędne drobne poprawki 

w kilku ostatnich wierzchołkach. 

• Kształt krawędzi natarcia przysporzył nam kłopotów: pierwszy wariant końcówki (str. 161) nie pasował do 

wymiarów z oryginalnych rysunków fabrycznych (str. 162). Musiałem stworzyć drugi wariant (str. 163-165). 

• Zawsze używam pomocniczych zakrzywionych konturów do określenia ostatecznego położenia sekcji siatki 

(str. 163-164). O wiele łatwiej jest przesuwać ich wierzchołki niż całe segmenty ścian. 

• Przygotuj swój model na ewentualne przyszłe poprawki. Na str. 163-164 musiałem wykonać retopologię 

końcówki skrzydła, ponieważ w sekcji 5.2 nie umieściłem węzła przy krawędzi spływu żebra 205. To jeden 

z kluczowych punktów tego skrzydła, i powinienem to uwzględnić już na etapie planowania topologii tej 

siatki (str. 143). 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera z dru-

gim wariantem końcówki ukończonej w tej sekcji: model\p40\history\P40B-9.03a.blend. 
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5.4 Lotka 

Zawsze modeluj skrzydło i jego lotkę jak dwa oddzielne obiekty. Dlaczego? Ponieważ w locie powierzchnie ste-

rujące są w nieustannym ruchu. Twój model będzie wyglądał bardziej realistycznie z lekko wychylonymi lotkami. 

Poza tym, Curtiss użył w P-36 i P-40 tak zwanych lotek Frise (Rysunek 5.4.1): 

  

 

Rysunek 5.4.1 Szczegóły lotek Frise w P-40 

Lotki typu Frise wymagają dużej szczeliny (slotu) w dolnej powierzchni skrzydła, przed krawędzią natarcia lotki1. 

Brak tego slotu w naszym modelu oznaczałby poważną niedokładność.  

Niestety, plany Jumpei Temmy nie zawierają żadnego przekroju skrzydła i lotki. Dlatego użyjemy w tym celu 

obrazów wyciętych z dwóch oryginalnych rysunków opublikowanych na portalu p40warhawk.com:  

 

       

Rysunek 5.4.2 Przekroje lotki (p40warhawk.com) 

Rysunek 5.4.2a) wyciąłem z tego rysunku złożeniowego lotki. To jest jej pierwsze żebro (zamykające lotkę przy 

stacji 122). Rysunek 5.4.2b) jest z kolei wycięty ze złożenia skrzydła. Pokazuje kontury skrzydła za dźwigarem 

#5 i krawędź natarcia lotki przy stacji 164. Możesz znaleźć te pliki w danych towarzyszących tej książce (por. 

str. 19). To Aileron (#122).jpg i Aileron (#164).jpg z folderu: source\reference\drawings\.    

 
1 Ten slot jest najszerszy na dolnej powierzchni skrzydła. W pewnych warunkach lotu (podczas lądowania lub w ostrym zakręcie) działa jak 

„dmuchawa” dostarczająca strumień świeżego powietrza na grzbiet skrzydła. To bardzo poprawia efektywność lotek.  
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http://www.p40warhawk.com/Models/Technical/Technical.htm
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http://www.p40warhawk.com/Models/Technical/Wing/14_35.TIF


168 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Dodaj do naszego modelu skrzydła obraz referencyjny pokazywany przez Rysunek 5.4.2a) :   

1. Przełącz się na Object Mode, cieniowanie Wireframe. Włącz tryb Pivot na Bounding Box Center. 

2. Włącz widoczność obrazu referencyjnego R.Wing (top) (z kolekcji 1b.Wing). 

3. Stwórz nową kolekcję w 1b.Wing, o nazwie 1b1.Aileron. 

4. Wstaw Aileron (#122).jpg w widok z boku. Nazwij ten obiekt R.Aileron@122. 

5. Ustaw środek (origin) tego obiektu na przecięciu cięciwy skrzydła i pionowej płaszczyzny osi obrotu lotki 

(Rysunek 5.4.2a). 

6. Obróć R.Aileron@122 wokół osi Z o 11.13º (to kąt osi obrotu zawiasów lotki w widoku z góry). 

7. Umieść ten obraz referencyjny na przecięciu wewnętrznej krawędzi lotki i linii zawiasu, naniesionej na 

rysunku R.Wing (top). 

8. Skaluj ten obiekt, dopasowując go do linii widoku z góry (w szczególności: krawędzi spływu skrzydła). 

           

Rysunek 5.4.3 Ustalenie pierwszego obrazu referencyjnego na stacji 122  

Teraz dodajmy do tego modelu obraz pokazywany przez Rysunek 5.4.2b):   

1. Wstaw Aileron (#164).jpg w widok z boku. Nazwij ten obiekt R.Aileron@164. 

2. Ustaw środek tego obiektu na przecięciu cięciwy skrzydła i dźwigara #5 (por. Rysunek 5.4.2b). 

3. Umieść ten obraz referencyjny na przecięciu linii dźwigara #5 i żebra 164 (X = 164”). 

4. Obróć ten obiekt Empty (Image) wokół osi Z o 11.13º i skaluj, dopasowując do linii osi lotki. 

 

Rysunek 5.4.4 Ustalenie drugiego obrazu referencyjnego na stacji 164 

 

Istnieje mnóstwo historycznych samolotów, dla których nie można znaleźć przekrojów lotek. W takim 

przypadku staraj się domyślić ich kształtu na podstawie zdjęć.      
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Teraz wstaw (Loop Cut) nową sekcję skrzydła i przesuń ją (Slide) do stacji 122 (Rysunek 5.4.5a). Ustawiłem jej 

współczynnik Crease na 1 tylko po to, by widzieć ją w tym samym miejscu na siatce i powierzchni wynikowej1:  

      

Rysunek 5.4.5 Dodatkowa linia krawędzi na stacji 122 

Robiąc to, odkryłem drobną wadę w rysunku referencyjnym. W środku skrzydła jego linie nie pasują dokładnie 

do podanych wymiarów. W szczególności, odstęp pomiędzy żebrem 122 i lotką był bliżej osi samolotu niż ten z 

rysunku R.Wing (top) (Rysunek 5.4.5b). Aby to zaznaczyć, przesunąłem obiekt R.Aileron@122 wzdłuż jego 

lokalnej osi Z od niewłaściwej linii (por. także Rysunek 5.4.2) o około 0.5”. 

Aby zachować stosunkowo prostą siatkę trapezowej części skrzydła, wytniemy miejsce na lotkę za pomocą 

modyfikatora Boolean. Przygotujmy do tego pomocniczy „obiekt tnący” : 

1. Stwórz nową kolekcję w 3.Wing i nazwij ją 3a.Booleans. To będzie nasz kontener dla tego i innych 

pomocniczych obiektów „tnących”. 

2. Umieść kursor 3D w środku obrazu referencyjnego R.Aileron@122 (Cursor to Selected). 

3. Przełącz się na widok z góry ( 7 ) i wstaw tam nowy kwadrat, 10x10” (Add→Mesh→Plane, str. 469). 

4. Nazwij ten nowy obiekt U.100.L.Aileron i obróć wokół osi Z o 11.13º (Rysunek 5.4.6a). 

5. Przełącz się na Edit Mode ( Tab ) i umieść wierzchołki tej siatki w narożnikach wycięcia na lotkę 

(Rysunek 5.4.6b). Użyj lokalnych osi tego obiektu by przesunąć wierzchołki wzdłuż ukośnych żeber: 

 

 

Rysunek 5.4.6 Formowanie pomocniczego obiektu tnącego (kontur dolny) 

 
1 Ta zmiana nie ma żadnego wpływu na kształt skrzydła, gdyż ta linia krawędzi leży w środku jego trapezu. Krawędzie podłużne po prawej i 

lewej stronie tej linii wierzchołków są współliniowe, i taka jest także wynikowa powierzchnia. Zmiana wartości Crease jest tu neutralna. 
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Przekształćmy tę płaską ścianę w bryłę: 

1. Zmień aktualną projekcję, aby widzieć nową ścianę częściowo z boku. 

2. Zaznacz całą ścianę (cztery wierzchołki) i wyciągnij je wzdłuż osi Z o -2”. 

3. Zaznacz górną ścianę i wyciągnij ją wzdłuż osi Z o +1”. 

Rysunek 5.4.7 pokazuje efekt (w cieniowaniu Solid): 

 

Rysunek 5.4.7 Formowanie pomocniczego obiektu tnącego: wyciągnięcie w górę 

Przesuń dwa wierzchołki górnej ściany do narożników wycięcia w górnej powierzchni skrzydła (Rysunek 5.4.8): 

 

Rysunek 5.4.8 Formowanie pomocniczego obiektu tnącego: przygotowanie górnej powierzchni 

Wyciągnij górną ścianę wzdłuż osi Z o +2.5” (Rysunek 5.4.9a): 

       

Rysunek 5.4.9 Formowanie pomocniczego obiektu tnącego: wyciągnięta powierzchnia górna 

Nie zapomnij zaznaczyć całej siatki ( A ) i na wszelki wypadek wywołać Mesh→Normals→Recalculate Outside. 

Aby lepiej widzieć efekt działania modyfikatora Booelan, możesz przełączyć tryb wyświetlania „obiektu tnącego” 

na siatkę (na stałe). Aby to zrobić, w Properties:Object znajdź panel Viewport Display i ustaw listę rozwijalną 

Display As na Wire (Rysunek 5.4.9b). 
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Teraz możemy wyciąć w tym skrzydle miejsce na lotkę: 

1. Dodaj do skrzydła (obiektu B.100.L.Wing) modyfikator Solidify (por. str. 521). Ustaw jego Offset na -1 

(do wnętrza) i Thickness na 0.03 (to typowa grubość poszycia samolotu). 

2. Dodaj do tego skrzydła modyfikator Boolean (por. str. 552), ustaw jego funkcję na Difference, i wskaż 

U.100.L.Wing jako drugi Object: 

 

Rysunek 5.4.10 Wycinanie otworu na lotkę 

Ten efekt jest dynamiczny: możesz zmienić kształt otworu zmieniając kształt „obiektu tnącego”. Dlatego prak-

tyczne jest „przymocować” ten „przecinak” do skrzydła za pomocą hierarchii parent/child, tak jak to zrobiliśmy z 

łopatami śmigła (por. str. 124). Jeżeli jednak zrobimy to dla obiektów powiązanych modyfikatorem Boolean, 

Blender zasygnalizuje „zależność cykliczną” (cyclic dependency). Taka „zależność” powoduje różne kłopoty, 

więc lepiej ją obejść: przypisać obydwa obiekty do wspólnego „rodzica”. Jeżeli taki nie istnieje – stwórzmy go. 

Będzie to pomocnicza „baza”, umieszczona w środku układu współrzędnych. Przypisz do niej B.100.L.Wing i 

U.100.L.Aileron:   

1. Wewnątrz kolekcji 3.Wing stwórz kolekcję o nazwie 3z.Bases. To będzie miejsce na ten i podobne 

obiekty pomocnicze. 

2. Przełącz się na widok z góry ( 7 ). 

3. Umieść kursor 3D w (0, 0, 0) (Cursor to World Origin). 

4. Wstaw obiekt Empty→Arrows (por. str. 472), ustaw jego Radius na 10, i nazwij X.100.Wing.Base. 

5. Zaznacz B.100.L.Wing i U.100.L.Aileron i przypisz je do X.100.Wing.Base ( Ctrl - P , Object (Keep 

Transform) – por. str. 479): 

 

Rysunek 5.4.11 Początkowa hierarchia zespołu skrzydła 

Teraz możesz ukryć te pomocnicze obiekty poprzez wyłączenie widoczności kolekcji 3a.Booleans i 3z.Bases. 

Widok z góry 

Dolna po-
wierzchnia 

1. Dodaj modyfikator 
Solidify (Thickness: 0.03)  

2. Dodaj modyfikator 
Boolean (Difference)  
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Do uformowania lotki potrzebujemy rysunku referencyjnego, który pokazuje jej krawędź natarcia w widoku z 

dołu. Przygotowałem taki fragment planów Jumpei Temmy i dopasowałem go do „spłaszczonego” skrzydła. W 

danych, które towarzyszą tej książce, to plik source\reference\drawings\temma\Wing.png. 

Stwórz kopię obrazu R.Wing (top) i zastąp jej zawartość obrazem temma\Wing.png (jak to zrobiliśmy na str. 

131). Nazwij ten nowy obiekt R.Wing (bottom) (Rysunek 5.4.12): 

 

Rysunek 5.4.12 Nowy obraz referencyjny: widok skrzydła z dołu 

Najprostszą metodą stworzenia lotki jest zmodyfikowanie fragmentu siatki z krawędzi spływu skrzydła:  

1. W Edit Mode zaznacz odpowiednią część siatki skrzydła (Rysunek 5.4.13a). 

2. Skopuj (Duplicate) te ściany ( Shift - D  – por. str. 534) pozostawiając je w oryginalnym położeniu ( Esc ). 

W tym momencie Blender zaznacza skopiowane ściany. 

3. Wydziel (Separate, lub P  – por. str. 547) zaznaczone ściany w nowy obiekt. Nazwij go B.150.L.Aileron, 

a jego siatkę – B.150.Aileron. 

4. Przełącz się w Object Mode, kliknij obiekt B.150.L.Aileron w oknie Outliner. W jego właściwościach 

(Properties) zakładce Modifiers usuń modyfikatory Boolean i Solidify (Rysunek 5.4.13b): 

          

Rysunek 5.4.13 Kopiowanie początkowej siatki lotki 

Zanim zaczniemy zmieniać tę siatkę: zwróć uwagę, że wszystkie żebra lotki w P-40 były prostopadłe do jej osi 

obrotu (Rysunek 5.4.14): 

 

Rysunek 5.4.14 Szczegóły geometrii lotki 

W dalszej pracy pomoże nam ustawienie lokalnego układ współrzędnych obiektu lotki wzdłuż jej osi obrotu.  

Nowy obraz referen-
cyjny: widok z dołu 

a) b) 

Wydziel w 
nowy obiekt 
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Usuń wszystkie modyfikatory 
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Oś obrotu lotki 

Żebra lotki 

11.13º 

Krawędź 
wewnętrzna 

Krawędź 
zewnętrzna 
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Poniżej opisuję kroki, które wykonałem, aby zmienić orientację lokalnego układu współrzędnych obiektu lotki 

(zmieniając położenie jej środka i obracając lokalne osie na globalnej płaszczyźnie XY o 11.13º) ).  

1. Ukryj na chwilę obiekt skrzydła (B.100.L.Wing). 

2. Umieść kursor 3D w środku (origin) obrazu R.Aileron@122 (Cursor to Selected) (Rysunek 5.4.15a). 

3. Zaznacz obiekt B.150.L.Aileron i przesuń jego środek do aktualnego położenia kursora 3D. Zrób to 

poleceniem Object→Set Origin→Origin to 3D Cursor (por. str. 487). 

4. Ustal Pivot na 3D Cursor. W zakładce Tool przybornika zaznacz Affect Only:Origins (Rysunek 5.4.15b).  

5. Obróć obiekt B.150.L.Aileron wokół globalnej osi Z o +11.13º (Rysunek 5.4.15b). 

6. Wyłącz Tool:Affect Only:Origins (Rysunek 5.4.15c). (Inaczej nie będą działać transformacje obiektów). 

             

Rysunek 5.4.15 Obrócenie lokalnego układu współrzędnych lotki 

Przytnij ściany siatki lotki wzdłuż jej zewnętrznego i wewnętrznego żebra (Rysunek 5.4.16): 

1. Ustaw aktualne okno 3D na projekcję wzdłuż lokalnej osi Z obiektu lotki ( Shift - 7 ). 

2. Przełącz się w tryb edycji ( Tab ). 

3. Stwórz na lokalnej płaszczyźnie XY (aktualny widok) prostokąt (Add→Plane, jak na str. 469) i przesuń 

jego wierzchołki na zewnątrz powierzchni lotki. Umieść ten prostokąt przy wewnętrznej krawędzi lotki (w 

pobliżu stacji 122, gdzie lokalny X = 0). Pozostaw tę ścianę zaznaczoną (Rysunek 5.4.16a). 

4. Odetnij zewnętrzne części ścian lotki poleceniem Intersect (Boolean) (Rysunek 5.4.16a). W jego para-

metrach ( F9 ) przełącz się na metodę Fast (domyślna Exact tworzy jakieś dodatkowe wierzchołki) ). 

5. Zrób to samo przy zewnętrznej krawędzi lotki, umieszczając „płaszczyznę tnącą” przy żebrze 205 

(Rysunek 5.4.16b). Nie zapomnij przestawić kierunku normalnych tej ściany (Mesh→Normals→Flip). 

6. Stwórz kolejny prostokąt na płaszczyźnie XY (Add→Plane) i umieść go przy żebrze 197 (Rysunek 

5.4.16c). Stwórz nową linię krawędzi poleceniem Intersect (Knife) (por. str. 528) z metodą Fast.   

7. Usuń (Dissolve) linie krawędzi żeber 197 i 203 (Rysunek 5.4.16c). 

                 

Rysunek 5.4.16 Przycinanie krawędzi lotki 
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W poleceniach Intersect wyliczonych powyżej sugeruję wybierać metodę Fast (por. str. 527). W tym najprost-

szym przypadku cięcia jedną ścianą, domyślna metoda Exact poprawnie usuwa ściany. Pozostawia jednak 

wzdłuż krawędzi cięcia kilkadziesiąt dodatkowych wierzchołków. To psuje topologię siatki, więc trzeba je znaj-

dować i usuwać, jeden po drugim (jak na str. 529 - 530). Z kolei metoda Fast poprawnie tworzy krawędź prze-

cięcia, ale nie usuwa żadnej ściany. Jej wynik dla metody Intersect (Boolean) wygląda tak samo, jak rezultat 

polecenia Knife pokazany na str. 528. Jednak o wiele łatwiej jest ręcznie usunąć tych kilka niepotrzebnych ścian 

z zewnętrznej strony krawędzi przecięcia niż „łowić” ukryte wierzchołki wygenerowane przez metodę Exact. 

(Opisane nieprawidłowości wystąpiły, gdy pracowałem w Blenderze 3.0). 

Rysunek 5.4.17 pokazuje wynik: przyciętą siatkę lotki. Ustaw współczynnik Crease (por. str. 539) dla krawędzi 

żeber na 1. Sprawdź w statystykach sceny, czy ta siatka zawiera obecnie 27 wierzchołków:    

 

Rysunek 5.4.17 Przycięta siatka lotki 

Jeżeli twoja siatka ma więcej niż 27 wierzchołków, a jej wygląda tak, jak na ilustracji powyżej – najprawdopo-

dobniej są w niej jakieś niewykryte pozostałości polecenia Intersect. Znajdź je i usuń. 

Teraz uformujmy krawędź natarcia lotki: 

1. Przełącz się w Object Mode ( Tab ), ustaw aktualną projekcję wzdłuż osi Z obiektu lotki ( Shift - 7 ), 

umieść kursor 3D w jej środku (Cursor to Selected). 

2. Przełącz się na Edit Mode ( Tab ) i ustaw tryb Pivot na Bounding Box Center. 

3. Stwórz 12-krawędziowy “okrąg” (Add→Circle) o promieniu 0.7”. Umieść go ponad czubkiem krawędzi 

natarcia lotki, widocznym na obrazie R.Aileron@122 (Rysunek 5.4.18a). 

4. Stwórz 32-krawędziowy “okrąg” (Add→Circle) o promieniu 5”. Przesuń go do dołu, dopasowując do 

górnego konturu lotki z rysunku referencyjnego (Rysunek 5.4.18a). 

5. Usuń niepotrzebne wierzchołki z tych okręgów i połącz je w jedną krawędź (Rysunek 5.4.18b). 

6. Włącz tryb Subdivision Surface:On Cage i dopasuj wygładzoną wersję do konturu lotki. 

           

Rysunek 5.4.18 Obrysowanie konturu krawędzi natarcia 
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7. Ustaw Crease tego konturu na 1 i wyciągnij go wzdłuż lokalnej osi Z ( E , Z , Z : Rysunek 5.4.19a). 

8. Dopasuj wyciągniętą krawędź do końcowego żebra lotki: umieść kursor 3D w jednym z wierzchołków 

żebra, ustaw Pivot na 3D Cursor i skaluj nową krawędź natarcia wzdłuż osi Z do 0 (Rysunek 5.4.19b). 

     

Rysunek 5.4.19 Wyciąganie krawędzi natarcia lotki 

Teraz musimy dopasować tę krawędź natarcia do cieńszego profilu końcówki skrzydła. To będzie wymagać 

trochę skalowania i obrotów różnych grup wierzchołków. Niestety, nie mamy żadnego rysunku referencyjnego 

tego końcowego żebra lotki. Możemy tylko przypuszczać, jak wyglądało. 

Na początek, zmniejsz (równomiernie) tę nową krawędź, dopasowując ją konturu lotki w rzucie z dołu (użyj ry-

sunku referencyjnego R.Wing (bottom), jak pokazuje to Rysunek 5.4.20a). Ukryj obraz R.Aileron@122 i prze-

łącz się na projekcję wzdłuż lokalnej osi Z obiektu lotki. Włącz tryb cieniowania Solid, aby widzieć przecięcie 

powierzchni lotki z obrazem R.Aileron@164 (Rysunek 5.4.20b). Zacznij od dopasowania dolnego, płaskiego 

konturu krawędzi natarcia i spływu (Rysunek 5.4.20b). Następnie dopasuj nosek tego profilu (Rysunek 5.4.20c), 

a potem górny kontur (Rysunek 5.4.20d, e): 

   

   

Rysunek 5.4.20 Kształtowanie krawędzi natarcia zewnętrznego żebra lotki 
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Gdy krawędź natarcia końcowego żebra pasuje do krawędzi spływu: 

1. Przesuń (Slide Vertices) wierzchołki A i B, aby wyrównać przerwę pomiędzy tylna i przednią częścią 

siatki lotki (Rysunek 5.4.21a). 

2. Wstaw (Loop Cut) w środek krawędzi natarcia nową sekcję. Przesuń ją (Slide) naprzeciwko odpowiada-

jącej jej sekcji w siatce krawędzi spływu (Rysunek 5.4.21b). 

3. Stwórz nowe ściany, wypełniające przerwę pomiędzy siatkami (Rysunek 5.4.21c). 

4. Zmień ustawienia współczynników Crease: oznacza jako ostre (por. str. 539) wszystkie krawędzie „że-

ber”. Dla wszystkich krawędzi podłużnych ustal Crease = 0 (Rysunek 5.4.21d).   

  

  

Rysunek 5.4.21 Łączenie krawędzi natarcia i spływu 

Przed uformowaniem zaokrąglenia na konturze lotki, poprawmy drobny szczegół: promień zaokrąglenia jej kra-

wędzi spływu. Z przyczyn technologicznych był większy od ostrej końcówki skrzydła. Możesz dostrzec tę różni-

cę na zdjęciach z muzeów, a także gdy porównasz jej rozmiar na naszej siatce i na rysunku referencyjnym 

R.Aileron@122 (Rysunek 5.4.22a, b). Zaznacz wierzchołki A, B, C, D, E i powiększ je (Scale) x 2. Zrób to z 

kursorem 3D umieszczonym w C (Rysunek 5.4.22b). To zachowa kontur lotki w rzutach z góry/dołu: 

                            

Rysunek 5.4.22 Powiększenie promienia krawędzi spływu 

Po przeskalowaniu, przesuń tych pięć wierzchołków minimalnie w dół (wzdłuż globalnej osi Z) o 0.02” (Rysunek 

5.4.22c). Powtórz to skalowanie i przesuwanie dla każdej z trzech krawędzi „żeber” lotki.   
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Skopiuj odcinek krawędzi spływu pomiędzy końcowym i środkowym żebrem (jak to zrobiłem na str. 163). Wstaw 

(Subdivide) w tę pomocniczą krzywą dwa nowe wierzchołki. W rzucie z góry użyj ich do odtworzenia łuku przy 

końcu narożniku lotki (Rysunek 5.4.23a): 

                   

Rysunek 5.4.23 Formowanie zaokrąglonego konturu końcówki  

Wstaw (Loop Cut and Slide) nową sekcję “żebra” przy każdym z tych dwóch wierzchołków (Rysunek 5.4.23b). 

Dopasuj krawędź spływu do tego zakrzywionego konturu przesuwając po pięć ostatnich wierzchołków każdego 

żebra wzdłuż lokalnej osi X (Rysunek 5.4.23c). Potem usuń pomocniczą krawędź.   

Na koniec zamknij wewnętrzny i zewnętrzny brzeg lotki za pomocą n-gonów (Rysunek 5.4.24): 

                 

Rysunek 5.4.24 Zamykanie żebra lotki 

Rysunek 5.4.25 pokazuje ukończoną lotkę w skrzydle. Zwróć uwagę na jej płaską powierzchnie dolną: 

   

Rysunek 5.4.25 Kompletna lotka  

 

Krawędź spływu skrzydła, biegnąca wzdłuż klap, będzie nawet grubsza i bardziej obniżona niż w tej 

lotce. Pokażę to w następnej sekcji.      

  

 

N-gony na płaszczyznach obramowanych ostrymi (Crease = 1) krawędziami nie zaburzają powłoki.      
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Płaska dolna powierzchnia, pokazywana przez Rysunek 5.4.25, powstała w wyniku formowania grubszej kra-

wędzi spływu lotki. Kontur lotki w widokach z góry/dołu odpowiada konturowi z rysunków. Odstęp pomiędzy 

żebrem zamykającym lotkę i żebrem 205 skrzydła „maskuje” ostry narożnik, który uformowaliśmy w poprzedniej 

sekcji (por. str. 165, widok z tyłu pokazywany przez Rysunek 5.3.22) – tak jak na zdjęciach. 

Dodajmy teraz do tej lotki oś obrotu. Stwórz ją jako oddzielny obiekt: 

1. Przełącz się na projekcję wzdłuż lokalnej osi Z lotki ( Shift - 7 ). Przełącz się na Object Mode ( Tab ). 

2. Ukryj obraz R.Aileron@164, wyświetl z powrotem obraz R.Aileron@122. 

3. Umieść kursor 3D w środku (origin) obiektu R.Aileron@122, a następnie ustaw współrzędną Z kursora 

na -0.7, umieszczając go w środku osi narysowanej na rysunku referencyjnym. 

4. Stwórz nowy cylinder (Add→Mesh→Cylinder, por. str. 470): 32 ściany boczne, Radius: 0.5”, Depth: 2”, 

Cap Fill Type: Nothing. Nazwij ten obiekt B.155.L.Aileron.Hinge (Rysunek 5.4.26a). 

5. Ustaw dla tego obiektu opcję Shade Auto Smooth (str. 517), ale nie dodawaj żadnego modyfikatora 

Subdivision Surface (taki prosty, ukryty pręt nie wymaga zaawansowanego wygładzania). 

6. Przejdź do Edit Mode i przesuń koniec walca wzdłuż lokalnej osi Z o 83.2” (Rysunek 5.4.26b). 

7. Przejdź do Object Mode i obróć tę oś lotki o -0.6º wokół globalnej osi Y (Rysunek 5.4.26c). 

         

          

Rysunek 5.4.26 Dodanie obiektu – osi lotki  

Żaden z rysunków referencyjnych (planów Jumpei Temmy, rysunków z p40warhawk.com) nie dostarcza żadnej 

wskazówki o pionowym położeniu osi obrotu na zewnętrznym końcu lotki. Na podstawie R.Aileron@122 i 

R.Aileron@164 założyłem, że ta oś biegła równolegle do dolnej powierzchni, jak pokazuje Rysunek 5.4.26d). 

 

Większość planów nie dostarcza żadnych wskazówek na temat osi lotek, sterów kierunku czy wyso-

kości. O ile jeszcze ich położenie dla sterów można odczytać z oryginalnych rysunków poglądowych 

(por. Tom I, sekcja 5.2), to dla lotek pozostają tylko domysły. Dokładne wymiary tych osi można zna-

leźć tylko z rysunków fabrycznych, które są dostępne tylko dla nielicznych maszyn .        
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R.Aileron@122 

0.7” 
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koniec wzdłuż   
lokalnej osi Z  

Obróć, dopasowując koniec 
tej osi do ostatniego żebra 

Y (globalna) Projekcja wzdłuż osi obrotu lotki  
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Oś obrotu 
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Wykorzystując ten obiekt osi, stwórz prostą hierarchię parent/child: 

1. Ustal B.150.L.Aileron jako potomka B.155.L.Aileron.Hinge (Set Parent, por. str. 479). 

2. Ustal B.155.L.Aileron.Hinge jako potomka B.100.L.Wing. 

Rysunek 5.4.27 pokazuje wygląd tej hierarchii w oknie Outliner: 

 

Rysunek 5.4.27 Pozycja lotki w hierarchii  

Teraz, gdy obrócisz pręt „zawiasu” wokół jego lokalnej osi Z, obróci się cała lotka (jak w samolocie). 

W tym modelu pojawi się więcej „zawiasów”: na przykład, klap skrzydła. Znajdowanie tych obiektów nie jest 

łatwe, gdyż są ukryte w środku hierarchii sceny. Co więcej, nie jest to intuicyjne. Gdy powrócisz do tego projektu 

za rok lub dwa, nie będziesz pamiętał, że jest taki pomocniczy obiekt jak ten zawias. Aby poprawić „czytelność” 

struktury modelu, sugeruję stworzyć kolejną kolekcję w 3.Wing, o nazwie 3y.Handles. Podłącz (Link, albo 

Shift - M , por. str. 451) zawias lotki do kolekcji 3y.Handles, tak że w przyszłości będziesz w stanie szybko odna-

leźć i zaznaczyć ten kluczowy obiekt. 

Musimy jeszcze odtworzyć powierzchnię skrzydła wokół tej lotki: 

1. Skopiuj (Duplicate, Shift - D ) lotkę (obiekt B.150.L.Aileron) i nazwij ją B.105.L.Trailing Edge. Nazwij jej 

siatkę B.105.Trailing Edge. 

2. Ukryj B.150.L.Aileron i ustal B.105.L.Trailing Edge jako potomka B.100.L.Wing (Rysunek 5.4.28b). 

3. Przejdź do Edit Mode i usuń większość wierzchołków tego nowego obiektu. Pozostaw tylko tylne części 

żeber, które zamykały lotkę (Rysunek 5.4.28a): 

 

Rysunek 5.4.28 Tworzenie dodatkowej krawędzi spływu skrzydła   

 

Aby zaznaczyć obiekt “zawiasu” wewnątrz lotki, rób to we włączonym trybie cieniowania X-Ray.       

  

a) b) 

Usuń z tej kopii siatki 
lotki większość wierz-
chołków, pozostawia-
jąc tylko wewnętrzne i 
zewnętrzne żebra 
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4. Przesuń żebra wzdłuż lokalnej osi Z, umieszczając je na krawędziach wycięcia lotki (Rysunek 5.4.29). 

5. Zaznacz wszystkie wierzchołki ( A ) i ustaw ich Crease na 0 („ostre” kontury rozłączonych n-gonów nie 

są wygładzane). 

6. Dopasuj zewnętrzne żebro do końcówki skrzydła (Rysunek 5.4.29b). Możesz zacząć od odwrócenia 

pogrubienia krawędzi spływu, którą wykonaliśmy na stronie 176. 

         

Rysunek 5.4.29 Dopasowanie końcowego żebra pomiędzy krawędzie wycięcia na lotkę   

Teraz uformuj część siatki pomiędzy żebrami. Zrób to tak samo, jak formowaliśmy krawędź natarcia lotki: 

1. Włącz widoczność obrazu R.Aileron@164. 

2. Przełącz się na Object Mode. Ustaw projekcję wzdłuż lokalnej osi Z obiektu B.105.L.Trailing Edge. 

3. Umieść kursor 3D w środku obiektu R.Aileron@164 (Cursor to Selected). To jest szybki sposób na 

umieszczenie go na właściwym lokalnym Z. Od tej chwili możesz go swobodnie przesuwać po ekranie. 

4. Przełącz się w Edit Mode. Stwórz dwa okręgi, jak te pokazywane przez Rysunek 5.4.30a). 

5. Połącz łuki tych okręgów w pojedynczy kontur Rysunek 5.4.30b). 

6. Wyciągnij ten kontur wzdłuż lokalnej osi Z do stacji 122. Dla zewnętrznych krawędzi tego wycinka siatki 

ustaw Crease = 1. Użyj metod ze str. 175 by dopasować je do krawędzi wycięcia (Rysunek 5.4.30c). 

7. Przesuń kontur ze stacji 164 do stacji 205 i dopasuj go do krawędzi wycięcia (Rysunek 5.4.30d). 

       

       

Rysunek 5.4.30 Formowanie powierzchni skrzydła przed lotką   

 

Dopasuj tylko grzbiet żebra ze stacji 122. Jego prosta dolna krawędź jeszcze się przyda (str. 190).        
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skrzydła 

Dopasuj te dwa narożniki 
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Dodaj do obiektu B.105.L.Trailing Edge modyfikator Solidify (str. 521). Ustaw jego Offset na 1 (do wnętrza 

skrzydła), a Thickness na 0.03 (taka sama „grubość blachy”, jaka ustawialiśmy wcześniej). Grubość, nadana 

tym ścianom, pomaga w precyzyjnym dopasowaniu ich krawędzi do wycięcia w skrzydle. 

Na koniec połącz rozetami z trójkątów ściany żebra ze ścianami zakończenia skrzydła (Rysunek 5.4.31): 

  

Rysunek 5.4.31 Łączenie żeber z tylnymi ścianami   

Taka nieregularna rozeta nie jest specjalnie estetyczna, lecz doskonale się sprawdza w tym przypadku. Zdecy-

dowałem się umieścić jej środek w wierzchołku C, na dolnym konturze żebra. To nie przypadek: najważniejszą 

częścią tej rozety jest mały trójkąt, oznaczony jako ABC (Rysunek 5.4.31). Bez tej drobnej ściany ostra linia 

krawędzi pomiędzy tyłem skrzydła i żebrem traci swój dolny kontur. ABC jest bardzo niskim trójkątem – przy 

końcówce skrzydła jego wysokość wynosi tylko 0.015”. Byłby jeszcze cieńszy, gdybym zdecydował się umieścić 

C gdzieś wyżej, wewnątrz konturu żebra!    

Rysunek 5.4.32 pokazuje ukończony obiekt B.105.L.Trailing Edge, dopasowany do wycięcia na lotkę: 

 

 

Rysunek 5.4.32 Gotowa wnęka na lotkę   

Nie sugeruj się konturem, który Blender rysuje wokół obiektów (Rysunek 5.4.32a). Gdy je wyłączysz (w panelu 

rozwijalnym Viewport Shading), ta oddzielna część wygląda tak samo, jak reszta skrzydła. 

 

 

Blender rysuje te kontury, abyś mógł łatwiej znaleźć obiekty na scenie (podczas zaznaczania).        
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Zamiast tworzenia obiektu, który zamyka otwór na lotkę, moglibyśmy wyciąć jego kształt z „litej” bryły skrzydła 

wykorzystując modyfikator Boolean. W takim przypadku, należałoby pominąć dodanie efektu „grubości blachy” 

za pomocą modyfikatora Solidify (str. 171), pozostawiając skrzydło w stanie „domyślnie wypełnionym”. Potem 

musielibyśmy wyprofilować przednią część „obiektu tnącego” użytego przez modyfikator Boolean. Powinniśmy 

w nim uzyskać taki sam przekrój o profilu „S” jaki uformowaliśmy w B.105.L.Trailing Edge. Jednak nie zdecy-

dowałem się na tę metodę, ponieważ mogłaby pozostawić różne drobne geometryczne artefakty na tym odcinku 

dolnej powierzchni skrzydła, gdzie tylny panel gładko przechodzi w dolny obrys profilu płata (por. Rysunek 

5.4.30b). Z mojego doświadczenia wynika, że najlepsze przecięcia narzędziem Boolean uzyskuje się pod kątem 

prostym, co wykorzystałem w tej sekcji.  

Rysunek 5.4.33 pokazuje ukończony zespół lotki: 

 

Rysunek 5.4.33 Zespół lotki   

Występowała tu różnica w klapkach wyważenia aerodynamicznego (trymera). W „Warhawkach” USAAC trymer 

lotki był elektryczny, sterowany w locie, a w brytyjskich „Tomahawkach” (i samolotach AVG) był małym paskiem 

blachy, wyginanym na ziemi. Tymi wariantami zajmiemy się później, podczas uszczegóławiania modelu. 

Efekt napiętego wzdłuż żeber lotki płótna poszycia (por. Rysunek 5.4.1) odtworzymy za pomocą tekstur1. Zro-

bimy to w kolejnej fazie naszego projektu. 

 

 
1 Możesz napotkać prace wielu modelarzy 3D, którzy modelują w siatce te drobne szczegóły poszycia. To ma sens, jeżeli przygotowujesz 

model do wydruku 3D. Tekstury są lepszym rozwiązaniem dla wizualizacji i symulatorów/gier komputerowych.  

Outline: wył. 

Klapkę wyważenia 
dodamy później 
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Podsumowanie 

• W tej sekcji pokazuję, jak stworzyć modyfikowalne („dynamiczne”) wycięcie w powierzchni obiektu za po-

mocą modyfikatora Boolean (str. 171). Dowiedziałeś się także, jak ustawić permanentne cieniowanie obiek-

tu na Wire dla “narzędzi tnących” (str. 170) i jak użyć pusty obiekt (Empty) nadrzędny w celu uniknięcia „za-

leżności cyklicznych” w strukturze modelu (str. 171). Zastosowaliśmy polecenie Separate do wyodrębnienia 

części siatki w nowy obiekt (str. 172) i zmieniliśmy położenie jego środka (origin) poleceniem Origin to 3D 

Cursor (str. 173). Do uzyskania krawędzi przecięcia w środku siatki możesz użyć polecenia Intersect 

(Knife) (str. 173). Często stosowaliśmy współczynnik Crease do formowania ostrych krawędzi w po-

wierzchniach podziałowych (str. 174-177, 180). Do stworzenia zawiasu lotki posłużyliśmy się nowym rodza-

jem obiektu: Cylinder (str. 178).  

• Zaczęliśmy od wycięcia otworu na lotkę w krawędzi spływu skrzydła (str. 169-171). Pod koniec tej sekcji 

zamknęliśmy to wycięcie używając przekształconej siatki lotki (str. 179-181). 

• Lotka powstała z kopii odpowiedniej części krawędzi spływu skrzydła (str. 169-171). Po skopiowaniu przy-

cięliśmy zewnętrzne krawędzie jej siatki (str. 173). Uformowaliśmy jej krawędź natarcia z dwóch połączo-

nych łuków (str. 174-175). Wyciągnęliśmy ten profil i połączyliśmy go z krawędzią spływu (str. 176). 

Ukształtowaliśmy zaokrągloną sekcja krawędzi spływu lotki w taki sam sposób, jak to robiliśmy w sekcji 5.3 

(wykorzystując tymczasową krzywą – por. str. 177). 

• Gotowa lotka jest dołączona do pomocniczego obiektu „zawiasu” za pomocą relacji parent/child (str. 178-

179). Dzięki temu można nią obracać jak w prawdziwym samolocie. 

• Większość planów samolotów nie dostarcza wiarygodnych przekrojów lotki lub położenia jej osi obrotu. 

Spróbuj ich szukać na oryginalnych rysunkach fabrycznych (str. 167, 178). W najgorszym przypadku, po-

zostaje zrobić jakieś założenia w oparciu o zdjęcia. 

• W tej sekcji często używaliśmy lokalnego systemu współrzędnych edytowanego obiektu (str. 169-170, 173-

175 , 178-180). Gdy zidentyfikujesz kluczową „koncepcję geometryczną” modelowanej części (por. str. 

172), takie dodatkowe osie są bardzo przydatne. Aby zmienić lokalny system współrzędnych, możesz wy-

konać transformację tylko na jego środku (origin) (str. 173). 

• Użyliśmy poleceń Intersect (Boolean) do przycięcia „nadmiaru” ścian siatki lotki (str. 173). Moglibyśmy to 

także zrobić narzędziem Knife (por. str. 532). To narzędzie zawsze tworzy „czyste” krawędzie, bez nadmia-

rowych wierzchołków. Jednak Knife jest mniej dokładne od pomocniczych „płaszczyzn cięcia”, które przy-

gotowaliśmy dla tych poleceń Intersect. 

• Możesz użyć skalowania wzdłuż pojedynczej osi jako sposobu na ustalenie dokładnej pozycji płaskiej sek-

cji siatki (jak to zrobiliśmy na str. 175). 

• Scalenie (ustawienie) dwóch obiektów tak, że nie widać ich krawędzi połączenia jest możliwe. Zrobiliśmy to 

ze ścianami zamykającymi wycięcie lotki w skrzydle (str. 181). 

• Gdy zawartość Twojej sceny jest zorganizowana w pojedynczą, rozgałęzioną hierarchię (parent/child), wy-

eksponuj (uczyń łatwo dostępnymi) kluczowe obiekty poprzez umieszczenie ich w specjalnych kolekcjach 

pomocniczych (str. 171, 179). 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.04.blend. 
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5.5 Wycięcie na klapy 

Klapy w skrzydłach są używane do zwiększenia siły nośnej podczas startu i lądowania. W P-40 wykorzystano 

tzw. klapy krokodylowe, które w pozycji otwartej ujawniają wewnętrzne elementy skrzydła (Rysunek 5.5.1): 

   

Rysunek 5.5.1 Klapa krokodylowa w P-40   

W tej sekcji odtworzymy to wycięcie na klapy, wraz z żebrami i podłużnicami. To prostsze niż myślisz. 

Zacznijmy od przyjrzenia się geometrii tej części skrzydła (Rysunek 5.5.2) : 

 

 

Rysunek 5.5.2 Geometria klapy w P-40   

Rysunek 5.5.2a) pokazuje widok z dołu (to fragment obrazu R.Wing (bottom)). Zwróć uwagę, że cięciwa (sze-

rokość) klapy jest stała. Linie nitów, widoczne na rysunku, ujawniają położenie żeber i podłużnic. Wydaje się, że 

żebra klapy były prostopadłe, a podłużnice – równoległe do krawędzi spływu skrzydła i dźwigara #5. 

Rysunek 5.5.2b) dodaje do tego półprzezroczysty obraz R.Wing (top), z widokiem skrzydła z góry. Widać na 

nim położenie żeber krawędzi spływu. Oryginalny szkic Curtiss podaje ich stacje (odległości od osi samolotu, 

mierzone wzdłuż dźwigara #5). Zwróć uwagę, że te żebra także są prostopadłe do tego dźwigara, i równoległe 

do żeber klap. Są jednak od nich przesunięte w bok (na zewnątrz). 

Fotografie pokazywane przez Rysunek 5.5.1 ujawniają także płaską dolna powierzchnię klap. Znajduje to po-

twierdzenia na licznych zdjęciach z innych źródeł. Ten płaski kontur pasuje także do spodu lotki (str. 177). 
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Płaska dolna 
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Zamknięta 
klapa 
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Pozycje stacji żeber krawędzi spływu (K.S.) 



Rozdział 5 Skrzydła 185 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Na p40warhawk.com znajdziesz trzy części oryginalnego rysunku złożeniowego klapy. To biało/czarne skany, w 

niskiej rozdzielczości. Widać na nich, że krawędź spływu jest dla tego zespołu bazą wymiarową. Na nieszczę-

ście, wymiary są na nich nieczytelne z powodu niskiej jakości tych obrazów1. Możesz użyć ich tak, jak użyliśmy 

wycinków ze złożenia lotki (por. str. 167). Żadne plany modelarskie nie pokazują szczegółów żeber i podłużnic, 

widocznych we wnętrzu luku klapy (Rysunek 5.5.1). Do opracowania tej sekcji użyłem rysunków z portalu 

aircorpslibrary.com2. Podążaj za ilustracjami, na których pokażę wszystkie potrzebne wymiary. 

Zacznijmy od krawędzi spływu. Rysunek 5.5.3a) to powiększony fragment prawego zdjęcia pokazywanego 

przez Rysunek 5.5.1. Widać tu, że skrzydło P-40 było zakończone otwartym profilem z duralu. Przyglądając się 

mu bliżej można oszacować grubość ścianek na 0.03” (jest podobna do grubości innych elementów skrzydła z 

tego obrazu). Kluczowe wymiary tego profilu podaje Rysunek 5.5.3b): 

                   

Rysunek 5.5.3 Szczegóły krawędzi spływu  

Zachowałem w tych wymiarach ułamki, używane w oryginalnych rysunkach Curtiss3. Gdy w polu Blendera wpi-

szesz „7/8”, zostanie to automatycznie zmienione na postać dziesiętną (0.875), więc to nie jest kłopot. Wyso-

kość „15/64” była mierzona w żebrze bazowym (stacja 000) – za chwilę do tego wrócimy. 

Stwórz w widoku z boku (globalna płaszczyzna YZ: X=0) ten profil jako nowy obiekt. Zacznij od okręgu (24 boki, 

R=27/32), umieszczonego w Y=99-R (98 27/32), Z = - 1/16 (Rysunek 5.5.4a). Następnie wyciągnij go wzdłuż lokalnej 

osi Z o 129.25” i obróć (w Object Mode) wokół globalnej osi Z o 14.11º (Rysunek 5.5.4b):  

         

Rysunek 5.5.4 Formowanie profilu zakończenia krawędzi spływu skrzydła    

 
1 Wśród zasobów aircorpslibrary.com możesz znaleźć dwa bardziej czytelne skany, o wysokiej rozdzielczości, tego samego złożenia. To 

rysunki: 75-08-001 lub 87-08-501. 

2 To złożenie krawędzi spływu (rys. nr. 87-03-826), złożenie dźwigara (75-03-015), i kilka rysunków żeber (75-03-074, -217, -226,…). 

3 Użyłem w tych wymiarach ułamków zwykłych, ponieważ dokładność rysunków P-40 jest rzędu 1/64. W postaci dziesiętnej (0.015625) 

stworzyłoby to fałszywe wrażenie co do ogólnej dokładności tych wymiarów. Na przykład, gdyby Rysunek 5.5.3b) podał liczbę „0.234375” 

zamiast „15/64”, mógłbyś założyć, że ten samolot był wykonany z tolerancją 0.0000001”, co jest niemożliwe. 

 

Bez rysunków fabrycznych, musielibyśmy określić proporcje modelowanego fragmentu na podstawie 

zdjęć. Dla wielu historycznych samolotów to jedyna możliwa metoda.         
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Nazwij ten nowy obiekt B.100.L.Trailing Edge, a jego siatkę – B.110.Trailing Edge. Przypisz go relacją 

parent/child do obiektu B.100.L.Wing. 

Teraz zmieńmy parę właściwości tego obiektu i dodajmy modyfikatory: 

1. Ustal tryb cieniowania obiektu na Shade Smooth (por. str. 515), ale nie dodawaj modyfikatora 

Subdivision Surface. Dla tak małego obiektu jak ten, 24 wierzchołki podstawowego okręgu wystarczą 

do stworzenia wrażenia gładkiej powierzchni. 

2. Zaznacz całą siatkę ( A ) i wywołaj Mesh→Normals→Recalculate Outside (na wszelki wypadek). 

3. Dodaj modyfikator Solidify: Thickness = 0.03, Offset = -1. 

4. Dodaj modyfikator Boolean (aby odciąć krawędź zewnętrzną przy lotce): zaznacz tryb Difference i 

wskaż jako drugi Object U.100.Aileron. 

5. Gdy porównujesz dwa nakładające się obiekty, możesz je łatwiej odróżnić, gdy są w kontrastujących ko-

lorach. Ustal „techniczny” kolor obiektu B.110.L.Trailing Edge na czerwony (por. Rysunek 5.5.5a), two-

rząc w tym celu nowy materiał (por. str. 575) . 

     

Rysunek 5.5.5 Skręcanie paska, który zamyka krawędź spływu skrzydła    

Gdy pasek jest czerwony, możesz łatwiej dostrzec jego zewnętrzny narożnik wystający z powierzchni skrzydła 

(Rysunek 5.5.5a). To z powodu cieńszego profilu skrzydła na stacji 122. Mógłbyś obrócić koniec tego paska, ale 

wtedy za bardzo by „zatonęła” w skrzydle jego środkowa część. Aby temu zaradzić, wstaw w ten pasek (Loop 

Cut) kilka nowych sekcji. Potem, zamiast „statycznie” obracać pojedyncze sekcje, skręć cały obiekt modyfikato-

rem Simple Deform (str. 554) wzdłuż lokalnej osi Z, o 2.3º (Rysunek 5.5.5b) .      

Teraz stwórz pomocniczy „obiekt tnący” o nazwie U.100.L.Flap. Wytniemy nim otwór klapy (Rysunek 5.5.6a, b). 

Rozszerz jego tylną ścianę o nowy segment, odcinający końcówkę krawędzi spływu skrzydła Rysunek 5.5.6c): 

       

Rysunek 5.5.6 Pomocniczy obiekt, wycinający otwór na klapę w skrzydle     

a) b) 
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jest poniżej cięciwy  0.1 

X (lokalna) 
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Umieść ten nowy obiekt w kolekcji 3a.Booleans (por. str. 169), przełącz jego tryb wyświetlania na Wire (jak na 

str. 170) i przypisz jako potomka do obiektu nadrzędnego X.100.Wing.Base (str. 171).  

Dodaj do skrzydła kolejny modyfikator Boolean (Difference) i wskaż U.100.L.Flap jako drugi obiekt. W efekcie 

powstanie wycięcie klapy (Rysunek 5.5.7): 

   

Rysunek 5.5.7 Wycięcie w skrzydle na klapę 

Rysunek 5.5.7a) pokazuje nowy otwór w dolnej powierzchni skrzydła. Rysunek 5.5.7b) przedstawia usuniętą 

końcówkę oryginalnej krawędzi spływu. 

Oczywiście, ta końcówka nadal istnieje w oryginalnej siatce skrzydła. Użyjemy jej teraz do podniesienia pozo-

stałej „blachy poszycia” skrzydła ponad czerwony pasek, jak pokazał to Rysunek 5.5.3. Powiększ teraz 2x pro-

mień ostatnich pięciu wierzchołków sekcji 000, 122 i 197 siatki skrzydła, tak jak to robiliśmy na str. 176: 

 

Rysunek 5.5.8 Zwiększanie promienia krawędzi spływu w B.100.Wing 

Tworząc wycięcie klapy, usunęliśmy dolną część skrzydła aż do lotki. Aby odtworzyć wąski pasek poszycia 

wzdłuż krawędzi lotki, wyciągnij o 9/11” dolną krawędź żebra zamykającego jej wycięcie (Rysunek 5.5.9): 

         

Rysunek 5.5.9 Odtwarzanie paska powierzchni skrzydła przy wewnętrznej krawędzi lotki 
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wycięcia klapy Zaznacz wszystkie brzegi tego 
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Możemy także przekształcić końcówkę tego żebra, upodobniając ją do oryginału (Rysunek 5.5.3). Rysunek 

5.5.10 pokazuje, jak poprzesuwałem 5 ostatnich wierzchołków żebra. Zrobiłem to przesuwając je poleceniami 

Slide lub Move (na lokalnej płaszczyźnie XY obiektu). Ostre narożniki 4 i 3 stworzyłem ustawiając Crease ich 

krawędzi na 1. Krótki odcinek |5 4| pozwala uniknąć rozciągnięcia prostych krawędzi nad całym górnym kontu-

rem. Dodałem jeden dodatkowy wierzchołek (Subdivide) by zaokrąglić narożnik przy wierzchołku 2. 

      

Rysunek 5.5.10 Dalsze modyfikacje krawędzi spływu żebra 122 

Aby zamknąć przestrzeń wewnątrz otworu na klapę, stwórzmy dźwigar #5 (por. Rysunek 5.5.2): 

1. Skopiuj (Duplicate) i wydziel (Separate – por. str. 172) przednią ścianę obiektu U.100.L.Flap1.  

2. Nazwij ten obiekt B.115.L.Web#5, a jego siatkę – B.115.Web#5. Przenieś go do kolekcji 3.Wing i przy-

pisz (Set Parent) do B.100.L.Wing. 

3. Przełącz tryb wyświetlania tego obiektu (Viewport Display) na Textured (por. str. 170). Przypisz temu 

dźwigarowi nowy, zielony materiał (nazwij go: Artificial.Green) – tak, jak to zrobiliśmy na str. 575. 

4. Ten dźwigar miał profil „C” i zawias klapy przymocowany do zewnętrznej krawędzi jego dolnej półki. 

Szerokość tej półki to 5/8”. Skopiowana ściana to pionowa część dźwigara. W tej chwili jednak leży ona 

na osi zawiasu klapy. Aby zrobić miejsce na półkę dźwigara, przesuń ten obiekt o -0.644 wzdłuż global-

nej osi Y2 (Rysunek 5.5.11a,b). 

5. Dopasuj wierzchołki ściany dźwigara do wewnętrznej powierzchni skrzydła (Rysunek 5.5.11ac,d,e). 

  

   

Rysunek 5.5.11 Tworzenie tylnej ściany otworu klapy (dźwigara #5) 

 

1 Zakładam, że ustawiłeś układ współrzędnych tego obiektu wzdłuż krawędzi spływu (por. Rysunek 5.5.6b). Kopiując tę ścianę w nowy 

obiekt, kopiujemy także lokalny układ współrzędnych. 

2 Podaję ten wymiar przeliczony wzdłuż osi globalnej. Otrzymałem go jako (5/8)/cos(14.11º) = 0.625/cos(14.11º) = 0.6444. W tej postaci jest 

on dokładny nawet w przypadku, gdybyś nie obrócił lokalnego układu współrzędnych obiektu dźwigara. 
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Zwróć uwagę, że w planach Jumpei Temmy pokazywanych przez Rysunek 5.5.11b), narożnik wycięcia klapy nie 

pasuje do narożnika odtworzonego wg oryginalnych wymiarów. Temma umieścił zawias tej klapy 22 3/8” od kra-

wędzi spływu skrzydła (pod ścianą dźwigara #5). Prawdziwe klapy były węższe: 21 3/4” od krawędzi spływu.   

Wyciągnij dolną półkę z dolnej krawędzi dźwigara #5 i umieść jej brzeg ponad krawędzią wycięcia klapy. Zwróć 

uwagę, że ta podłużna krawędź otworu klapy jest minimalnie wygięta do dołu (Rysunek 5.5.12): 

    

Rysunek 5.5.12 Zakrzywiony kontur otworu klapy w skrzydle  

Podobna szczelina istnieje między górną półką dźwigara i powierzchnią skrzydła. Odchylenia są małe – max. 

0.05” na dolnej szczelinie (Rysunek 5.5.12a) i 0.07” na górnej. To nie błąd: profil skrzydła jest zakrzywiony i 

proste podłużnice łączące żebra skrzydła muszą leżeć w takiej samej % odległości wzdłuż ich cięciw. Ukośne 

wycięcie, którego krawędź biegnie od %A do %B (Rysunek 5.5.12b) odtwarza wzdłuż swojej długości krzywą 

profilu skrzydła pomiędzy tymi dwoma miejscami na cięciwie.       

Gdy szerokość takich szczelin była znaczna – projektanci dodawali na szczycie półek dźwigarów dodatkowe 

kształtki. W P-40 te różnice są małe, więc inżynierowie Curtiss minimalnie spłaszczyli powierzchnię skrzydła na 

tym obszarze. Tak zmodyfikowane przekroje żeber pasują do prostych półek dźwigara #5. 

Zdecydowałem się odtworzyć tę modyfikację poprzez dodanie nowych wierzchołków do „żeber” siatki na sta-

cjach 000 i 122. To przekształci sąsiednie ściany w n-gony. Oceniłem, że ich obecność nie zepsuje powierzchni 

skrzydła, bo ta jest tutaj niemal płaska. Najpierw dodałem (Subdivide) wierzchołki A i B (Rysunek 5.5.13a). Na-

stępnie połączyłem je nową krawędzią ( J ) i zwiększyłem jej Crease do 1 (Rysunek 5.5.13b). To automatycznie 

stworzyło wierzchołek C. Poprawiłem jego położenie (przesunięcie wzdłuż osi Z o +0.06” – Rysunek 5.5.13c):  

               

Rysunek 5.5.13 Spłaszczanie dolnej powierzchni skrzydła wzdłuż dźwigara #5 

 

Każda przekrój skrzydła, który nie łączy miejsc o tych samych % cięciwy, odtwarza krzywą łączące-

go je fragmentu profilu. Pamiętaj o tym przy wycięciach na lotki i klapy.        
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Wykonaj podobną modyfikację na górnej powierzchni skrzydła pomiędzy żebrami 000 i 122, dopasowując ją do 

górnej półki dźwigara #51. 

Przypisz do B.115.L.Web#5 modyfikator Solidify i ustaw jego Thickness na 0.08 (Rysunek 5.5.14a). Możesz 

także obrócić tę pionową ścianę wokół lokalnej osi Y o 1º (zakładam kierunki jak pokazane przez (Rysunek 

5.5.14b). To dlatego, że skrzydło P-40 było zaklinowane do kadłuba pod kątem 1º, i w tym położeniu ściany 

wszystkich dźwigarów były pionowe. Widać to na rysunku referencyjnym R.Side.Left (compiled). 

Teraz odtwórzmy dwa żebra zamykające otwór klapy. Większą część żebra 122 już mamy (Rysunek 5.5.9). 

Teraz doprowadźmy je do dźwigara #5: 

1. Rozdziel (Rip) wierzchołki siatki B.105.Trailing Edge wzdłuż „narożnika” pomiędzy krawędzią spływu i 

żebrem 122 (por. str. 525). 

2. Uprość topologię żebra 122, ponieważ nie łączy się już z zakrzywioną krawędzią spływu. Możesz usu-

nąć “rozetę” trójkątów, którą przyłączyliśmy żebro z krawędzią spływu (por. Rysunek 5.5.9)2. 

3. Stwórz dodatkowe ściany, wydłużając żebro 122 do dźwigara #5 (Rysunek 5.5.14a):      

       

Rysunek 5.5.14 Tworzenie zewnętrznych i wewnętrznych żeber otworu klapy. 

Stwórz żebro zamykające otwór kalpy od wewnątrz. Użyj do tego tylnej części sekcji skrzydła ze stacji 000: 

1. W siatce skrzydła (B.100.Wing) zaznacz kontur krawędzi spływu sekcji 000. Zacznij to zaznaczanie od 

wierzchołka oznaczonego przez Rysunek 5.5.13a) jako B. 

2. Skopiuj (Duplicate) i oddziel (Separate) tę linię krawędzi w nowy obiekt. 

3. Przełącz się w Object Mode, znajdź ten nowo utworzony obiekt w oknie Outliner (będzie się nazywał 

B.100.L.Wing. 001) i usuń z niego wszystkie modyfikatory Boolean (inaczej będzie niewidzialny). 

4. Nazwij tę nową siatkę B.120.Rib.008, a obiekt B.120.L.Rib.008. Przypisz go (Set Parent) do obiektu 

B.100.L.Wing. 

5. Stwórz ścianę pomiędzy wierzchołkami skopiowanej krzywej ( F ). 

6. Aby ułatwić dalsze kroki, przypisz temu obiektowi inny kolor: Artifical.Green (użyj materiału dźwigara). 

7. Dopasuj tą siatkę pomiędzy dźwigar #5, wewnętrzną krawędź otworu klapy i górną powierzchnię skrzy-

dła (Rysunek 5.5.14b). Ostre narożniki przy dźwigarze uzyskasz, zmieniając Crease ich krawędzi na 1.  

 
1 Po tej modyfikacji, gdy przyjrzysz się górnej powierzchni skrzydła ustawionej pod światło, pod pewnymi kątami będziesz widział nikłe 

cienie biegnące wzdłuż dźwigara #5. Pamiętaj jednak, że skrzydła w prawdziwym samolocie nie są idealne. Ta szczególna deformacja była 

„zakodowana” w wymiarach podanych przez oryginalne rysunki wykonawcze. Jest tylko zbyt mała, by była widoczna na zdjęciach. 

2 W siatce B.105.Trailing Edge możesz także uprościć, w sposób pokazany przez Rysunek 5.5.14a), przeciwległe żebro 205. Powinienem 

zrobić to od razu, w poprzedniej sekcji! Takie rozłączone płaszczyzny nie powodują problemów na wizualizacjach. Jeżeli jednak budujesz 

model do wydruku 3D, Twoja siatka powinna być „szczelna”. To zmusza do stosowania innych topologii, nie omawianych w tej książce.  
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Zanim zaczniemy modelowanie żeber krawędzi spływu, przyjrzyjmy się ich wymiarom. Rysunek 5.5.15a) poka-

zuje pierwsze żebro (ze stacji K.S.1 15), a Rysunek 5.5.15b) – ostatnie, ze stacji K.S. 114.5. Rysunek 5.5.15c) 

przedstawia szczegóły krawędzi spływu, identyczne dla wszystkich żeber. Kluczowe wymiary zaznaczyłem na 

czerwono. Uproszczony kształt żebra, który odtworzymy w modelu, jest zaznaczony na niebiesko: 

 

 

Rysunek 5.5.15 Geometria żeber krawędzi spływu  

Wszystkie te żebra są dochodzą do dźwigara #5. Ich górny kontur kształtował poszycie skrzydła. Podaję także 

wymiary ich dolnych konturów. Kształt pozostałych żeber jest liniową interpolacją tych dwóch obrysów. 

Stworzymy te wręgi z kopii fragmentu siatki skrzydła. Po niezbędnych przygotowaniach, „potniemy” ten skopio-

wany fragment „na plasterki” (żebra). Zacznijmy: 

1. Zaznacz krawędzie spływu żeber 000 i 122 (Rysunek 5.5.16a). 

2. Skopiuj (Duplicate) i rozdziel (Separate) zaznaczone ściany siatki w nowy obiekt. 

3. Przełącz się w Object Mode, znajdź ten nowo stworzony obiekt w oknie Outliner (będzie się nazywać 

B.100.L.Wing.001) i usuń wszystkie jego modyfikatory. 

4. Nazwij tę nową siatkę B.125.Ribs, a obiekt – B.125.L.Ribs. Przypisz go (Set Parent) do B.100.L.Wing 

(Rysunek 5.5.16b): 

     

Rysunek 5.5.16 Kopiowanie fragmentu siatki krawędzi spływu w nowy obiekt 

 

1 „K.S.” oznacza „krawędź spływu”. Te stacje są odmierzane wzdłuż dźwigara #5 – por. Rysunek 5.5.17b) na następnej stronie. 

Źródło: rys. 75-03-226  
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5. Przypisz do tego obiektu materiał Artificial.Green, aby łatwiej dostrzec jego ściany. 

6. Ustaw środek tego obiektu na przecięciu żebra 000 i dźwigara #5 (X:0, Y:75.89, Z:0). Obróć jego lokal-

ny układ współrzędnych wokół globalnej osi Z o 14.11º, ustawiając lokalną oś Z wzdłuż krawędzi spływu 

skrzydła (Rysunek 5.5.17b). Zrób to tak samo, jak obróciliśmy lokalny układ lotki (por. str. 173). Bazą 

wymiarową dla tego zespołu była płaszczyzna ściany dźwigara #5. 

7. Uprość siatkę: usuń (Dissolve) wierzchołki w środku jej rozpiętości (wierzchołek C z Rysunek 5.5.13b). 

Usuń zaokrąglenie krawędzi spływu, stwórz ścianę z przodu. Przesuń (Slide) wierzchołki po konturze 

żeber, aby krawędzie podłużne były równoległe do dźwigara #5 (Rysunek 5.5.17a).  

8. Przytnij wewnętrzne i zewnętrzne fragmenty ścian wzdłuż stacji K.S. 114 1/2 i 14 3/8 
1 (Rysunek 5.5.17b). 

Zrób to w ten sam sposób, jak odcinaliśmy krańce ścian lotki (por. str. 173).   

              

Rysunek 5.5.17 Wstępna modyfikacja siatki żeber 

Ukryj ( H ) dolną powierzchnię tej siatki, a potem dopasuj pozostałe widoczne ściany do górnej powłoki skrzydła i 

dźwigara #5 (Rysunek 5.5.18). By lepiej widzieć różnice, przypisałem dźwigarowi #5 materiał Artificial.Red: 

 

 

Rysunek 5.5.18 Dopasowywanie ścian siatki do powierzchni skrzydła i dźwigara 

Oczywiście, tymi trzema płaskimi ścianami możesz tylko przybliżyć krzywiznę powłoki skrzydła. Przesuwaj ich 

wierzchołki wzdłuż globalnej osi Z aż będą wyglądać na częściowo „zatopione” w wewnętrznej stronie poszycia 

górnej powierzchni płata (Rysunek 5.5.18a). Gdy później pogrubisz te ściany modyfikatorem Solidify, stworzy to 

wystarczająco dobre wrażenie krawędzi żeber „dotykających” powłokę skrzydła. 

Zgodnie z wymiarami (Rysunek 5.5.15) dopasowałem położenie wierzchołków krawędzi spływu, umieszczając 

je na lokalnej płaszczyźnie X = 22 (Rysunek 5.5.18a). Wstawiłem także (Loop Cut) dwie nowe krawędzie. Jedną 

dodałem przy dźwigarze #5, dopasowując się do jego górnej półki. Druga jest przy krawędzi spływu (X lokalne = 

21). To miejsce ważnej przerwy w konturach żeber. Rysunek 5.5.15c) pokazuje, że była 1” od końca żebra. 

 
1 W istocie, stacja 14 3/8 to stacja (15 - 5/8) (

5/8 jest szerokością kołnierza, wygiętego wzdłuż krawędzi żebra) 
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Gdy siatka pasuje do wycięcia klapy, odkryj ( Alt - H ) jej dolne ściany. Ustaw ich wierzchołki zgodnie z wymiara-

mi podawanymi przez Rysunek 5.5.15. Dla wewnętrznej sekcji (stacja K.S. 14 3/8) użyj wymiarów żebra położo-

nego na stacji K.S. 15 ( Rysunek 5.5.15a). Rysunek 5.5.19 pokazuje moją implementację tych danych: 

      

Rysunek 5.5.19 Formowanie dolnej powierzchni 

Krawędź spływu wymaga dodatkowej uwagi. Rysunek 5.5.20 pokazuje, jak ustawiłem jej wierzchołki. Jest to 

projekcja wzdłuż lokalnej osi Z. Krawędź 14.38 jest tu pomarańczowa, a krawędź 114.5 – czarna: 

 

Rysunek 5.5.20 Szczegóły krawędzi spływu 

Możesz stworzyć dwie zaokrąglone krawędzie (R 1, R 4 – por. Rysunek 5.5.15) za pomocą modyfikatora Bevel, 

w trybie Weight (por. str. 562) . Ustaw Width Type na Offset, Amount na 0.5 i liczbę Segments na 5. Następnie 

ustaw współczynnik Bevel Weight krawędzi 1 i 2 pokazywanych przez Rysunek 5.5.21: 

 

Rysunek 5.5.21 Zaokrąglanie wybranych krawędzi 
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Waga (Bevel Weight) krawędzi 2 (=0.25) pochodzi z proporcji pomiędzy promieniami tych dwóch krawędzi (1:4 

= 0.25). W modyfikatorze Bevel ustawiłem Amount na większy z tych promieni (4”)1, odpowiadający krawędzi 1.  

Teraz stwórzmy pomocnicze „pudełka”, które użyjemy do wycięcia z tej siatki żeber: 

1. Przełącz się na Object Mode, ustaw projekcje okna 3D wzdłuż lokalnej os Z obiektu ( Shift - 7 ). 

2. Ustaw kursor 3D w środku obiektu (Cursor to Selected) i wróć do Edit Mode. 

3. Stwórz sześcian (Add→Cube, str. 473), ustaw jego Size na 5/8” (0.625” – szerokość kołnierza żebra). 

4. Włącz opcję cieniowania X-Ray. Zaznacz i przesuń (Move) narożniki tego „pudełka” po lokalnej płasz-

czyźnie XY, aby stało się szersze i wyższe od siatki krawędzi spływu (Rysunek 5.5.22). Nie zmieniaj 

„grubości” tej bryły – jej rozmiar wzdłuż lokalnej osi Z powinien pozostać równy 0.625”. 

        

Rysunek 5.5.22 Tworzenie pomocniczego „pudełka tnącego” 

5. Przesuń (Move) to „pudełko” wzdłuż lokalnej osi Z o pół szerokości (-0.3125) – tak, aby jego prawa 

ściana leżała na lokalnej płaszczyźnie odniesienia (Z=0). 

6. Skopiuj tę bryłę ( Shift - D ) i przesuń wzdłuż lokalnej osi Z o 15” (to ją ustawi w sekcji K.S. 15). 

7. Powtarzaj p. 6, przesuwając kopiowane pudełka do następujących stacji K.S.2: 2727/32, 491/8 (to żebro 

ma kołnierz po przeciwnej stronie) 5849/64, 691/2, 8027/64, 9213/32, 1033/32, 1141/2 (Rysunek 5.5.23): 

     

Rysunek 5.5.23 Ustawianie „pudełek tnących” na kolejnych stacjach żeber 

 
1 Niestety, w Blenderze nie można podać wprost promienia zaokrąglenia krawędzi. Dla kątów łuku jego przekroju zbliżonych do 90º używaj 

metody Offset. W tej metodzie, dla krawędzi łączącej ściany pod kątem prostym, wartość Amount jest promieniem zaokrąglenia. Dla łuków 

< 45º (jak w Rysunek 5.5.21) użyj metody Width, a Amount przybliż jako: [promień zaokrąglenia]*[kąt (średni, w stopniach)] * 3.14/180.    

2 Na rysunku R.Wing (top) brakuje niektórych stacji K.S, więc podaję tutaj ich pełną listę. Przesuwaj te „pudełka” wzdłuż lokalnej osi Z 

wpisując te odległości w Blenderze jak np. „27+27/32” (por. Rysunek 5.5.23). Blender sam obliczy takie wyrażenia. 
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Przed operacja cięcia, wprowadźmy ostatnie poprawki: 

1. Usuń oryginalne „pudełko” ze stacji Z = 0 (nie będziemy już go potrzebować). 

2. Przesuń linię krawędzi ze stacji K.S. 114.5 na minimalną odległość na zewnątrz ostatniego „pudełka”. 

Zrób to poleceniem Edge Slide z wyłączoną opcja Clamp (por. str. 140). W ten sposób staram się nie 

dać poleceniu Intersect szansy na pominięcie tego miejsca (Rysunek 5.5.24a). 

3. Usuń przeciwległe ściany z „pudełek” umieszczonych na stacjach K.S. 2727/32 and 491/8. 

4. Połącz „pudełka” ze stacji 2727/32 i 491/8 w jedną bryłę (Rysunek 5.5.24b). Stworzą wzmocnienie pod 

chodnikiem na skrzydle1. 

        

Rysunek 5.5.24 Końcowe dopasowania „pudełek” tnących 

Teraz jesteśmy gotowi na wycięcie żeber z tej krawędzi spływu: 

1. Wyłącz wszelkie zaznaczenia ( Alt - A , to bardzo ważne, więc na wszelki wypadek przypominam). 

2. Włącz opcję cieniowania X-Ray (aby nie pominąć przez pomyłkę żadnego wierzchołka). 

3. Zaznacz wszystkie „pudełka tnące” (Rysunek 5.5.25a). Aby to zrobić szybko i precyzyjnie, ustaw aktu-

alną projekcję wzdłuż lokalnej osi Z. W tym widoku narożniki „pudełek” tnących leżą jeden za drugim. 

Jednocześnie, są daleko od reszty siatki. Użyj Circle Select do zaznaczenia tych czterech rogów. 

4. Wywołaj Intersect (Boolean). Domyślnie, Blender wykonuje operację Difference. Po tym „pierwszym 

strzale” otwórz parametry tego polecenia ( F9 ) i zmień operację na Intersect. Aby uniknąć problemów z 

dodatkowymi wierzchołkami, zmień także metodę (Solver) na Fast (Rysunek 5.5.25b): 

       

 

Rysunek 5.5.25 Wycięcie żeber z siatki krawędzi spływu 

 
1 Dodatkowe wzmocnienie struktury skrzydła, widoczne na zdjęciach pomiędzy stacjami K.S. 2727/32 i 491/8 (str. 286, zdjęcie po lewej) 
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Wyłącz zaznaczenie wszystkich wierzchołków ( Alt - A ) i wykonaj poniższe kroki: 

1. Ustal cieniowanie tej siatki na Shade Smooth. 

2. Dodaj kolejny modyfikator Bevel, zaokrąglający krawędzie kołnierzy żeber1. Ustal Width Type na Offset, 

Amount na 0.10, Segments na 5. Pozostaw domyślną Limit Method (Angle, min. 30º). 

3. Dodaj modyfikator Solidify, ustal jego Offset na -1, a Thickness na grubość blachy tych żeber: 0.03. Dla 

lepszego efektu możesz także włączyć opcję Even Thickness. 

4. Wydziel ( P , str. 547) wzmocnienie chodnika (żebra K.S. 2727/32 i 491/8 wraz z łączącymi ścianami) w 

nowy obiekt. Ta część wymaga innej „obróbki” niż pozostałe żebra, więc łatwiej będzie to przeprowadzić 

na wydzielonej siatce. Nazwij ten nowy obiekt B.130.L.Reinforcement. 

Każde z nowo stworzonych żeber wymaga kilku poprawek, pokazywanych przez Rysunek 5.5.26: 

      

      

    

Rysunek 5.5.26 Końcowe poprawki siatki żeber 

Wszystkie kroki powyżej, oprócz h), przekształcają „bryły” końcówki żebra w dwa paski blachy. Wykonaj kroki 

pokazywane przez Rysunek 5.5.26b) w podanej kolejności. W przeciwnym razie usuniesz obydwie boczne 

ściany żebra, zamiast ściany wewnętrznej. W kroku c) świadomie usuwam krawędź stworzoną w kroku b) (1). 

Powtórz kroki pokazane przez Rysunek 5.5.26 dla każdego z żeber krawędzi spływu.  

 
1 W arkuszu blachy nie można uzyskać idealnie ostrego narożnika. Zawsze będzie mniej lub bardziej zaokrąglony. Jeżeli promień tego 

zaokrąglenia jest zbyt mały, na krawędzi zagięcia pojawi się pęknięcie. Aby go uniknąć, inżynierowie używają specjalnych tablic minimal-

nych promieni zaokrągleń. Ta wartość zależy od materiału i grubości blachy.  

 

W tym momencie opcja Geometry:Clamp Overlap ogranicza efektywny promień krawędzi zaokrąglo-

nych tym modyfikatorem Bevel do 0.06 (por. str. 561). Przyczyną jest geometria końca krawędzi 

spływu: zawiera ścianę o wysokości 0.12” (por. Rysunek 5.5.20). Jednak po zakończeniu kroków 

przedstawionych poniżej, ten promień uzyska nominalną wartość.        
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A co ze wzmocnieniem chodnika skrzydła? Na zdjęciach można dostrzec, że jego dolna powierzchnia miała 

dodatkowe, perforowane poszycie (Rysunek 5.5.27a). Rysunki fabryczne ujawniają tu solidny, duraluminiowy 

płaskownik przynitowany pod paskiem zamykającym krawędź spływu (Rysunek 5.5.27b): 

              

Rysunek 5.5.27 Szczegóły wzmocnienia chodnika na skrzydle 

Zmodyfikujmy siatkę B.130.Reinforcement, dopasowując ją do tych zauważonych szczegółów:  

1. Skopiuj jej pięć dolnych ścian (Rysunek 5.5.28a) i przesuń je wzdłuż globalnej osi Z o -0.03 (to grubość 

blachy), jak pokazuje to Rysunek 5.5.28b). Ta dodatkowa powierzchnia stanie się dolnym poszyciem 

tego wzmocnienia. 

2. Dopasuj dwie ściany przy dźwigarze #5, przesuwając je wzdłuż globalnej osi Z o +0.03. To stworzy 

prześwit pomiędzy wzmocnieniem i dolną półką dźwigara (Rysunek 5.5.28c). 

3. Przesuń (Move) w dół krawędzie 1 i 2 (Rysunek 5.5.28d), umieszczając je 0.24” od górnej powierzchni. 

4. Zbliż (Edge Slide, Clamp: wył.) krawędź 2 do krawędzi 3 (Rysunek 5.5.28e). 

5. Przesuń w dół krawędzie 4 i 5 (Rysunek 5.5.28e), umieszczając je 0.21” od górnej powierzchni. 

       

    

Rysunek 5.5.28 Wstępne modyfikacje siatki wzmocnienia 

Proporcje, pokazywane przez Rysunek 5.5.28d) i e) różnią się nieco od tych z dokumentacji (Rysunek 5.5.27b). 

To był mały szczegół z wielkiego rysunku złożeniowego, więc może to być wynikiem błędu kreślarza.    

a) b) 

1 

Fragment rys. 87-03-826 
Źródło: aircorpslibrary.com Źródło: Life 

Żebro (jak z rys. 75-02-219) 

Perforowane 
poszycie 

Wycięcie w klapie  

Płaskownik 

Zakończenie 
krawędzi 
spływu 

Obniżone 
żebra klapy 

a) b) 

d) e) 

1 
2 

1 

2 

5 

4 3 3 

Przesuń (Slide) 
krawędź 2 

Przesuń kra-
wędzie 4 i 5 

Przesuń kra-

wędzie 1 i 2 

0.24 0.21 

Projekcja wzdłuż 
lokalnej osi Z 

Projekcja wzdłuż 
lokalnej osi Z 

 

Skopiuj te 
ściany 

Przesuń te 
kopie ścian w 
dół o -0.03” 

0.13 

Przesuń te dwie 
krawędzie, aby 

zachować dystans 

Skopiowane 
ściany 



198 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Kontynuujmy: 

1. Wydziel (Separate) pięć ścian dolnego poszycia wzmocnienia w nowy obiekt i nazwij go B.135.L.Skin 

(siatka: B.135.Skin). Usuń z niego drugi modyfikator Bevel (ten z Limit Method = Angle). 

2. Wstaw dwie linie krawędzi (Loop Cut) i przesuń je (Slide) do 5/8” od zewnętrznych krawędzi siatki 

(Rysunek 5.5.29a). Te dwa paski będą kołnierzami bocznych żeber wzmocnienia. 

3. Usuń środkowe ściany tej siatki poprzez usunięcie ich krawędzi wewnętrznych. Aby było łatwiej, mo-

żesz się przełączyć w tryb zaznaczania krawędzi (Rysunek 5.5.29b). 

4. Usuń zewnętrzne ściany żeber, stwórz podobne n-gony po drugiej stronie kołnierzy (Rysunek 5.5.29c). 

             

Rysunek 5.5.29 Tworzenie kołnierzy i żeber bocznych  

5. Zmodyfikuj końcówki krawędzi spływu żeber jak pokazuje to Rysunek 5.5.30. 

6. Rozdziel (Rip) zewnętrzne wierzchołki przy dźwigarze #5, jak pokazywał to Rysunek 5.5.26h). 

               

Rysunek 5.5.30 Szczegóły końcówki żeber wzmocnienia chodnika  

Rysunek 5.5.31 pokazuje gotowe części szkieletu krawędzi spływu: 

 

Rysunek 5.5.31 Gotowe części szkieletu krawędzi spływu  

Zwróć uwagę, że po tych wszystkich zmianach, żebra wzmocnienia chodnika przypominają pozostałe żebra. 

Połącz w jeden obiekt B.130.L.Reinforcement z B.125.L.Ribs, poleceniem Join ( Ctrl - J , str. 485). Rozdzieli-

łem je tylko po to, by lepiej widzieć „pudełko” wzmocnienia podczas modyfikacji, także w Object Mode. Teraz, 

gdy rozdzieliśmy je na żebra i poszycie, nie ma już powodu do utrzymywania tych dwóch żeber oddzielnie1. 

 
1 Staraj się utrzymywać wszystkie podobne części, jak te żebra, w jednym obiekcie. Jeżeli bym je pozostawił jak obecnie, podczas dalszych 

faz projektu mógłbym często popełniać denerwujące pomyłki w zaznaczaniu. Na przykład: zaznaczyłbym wszystkie żebra krawędzi spływu 

do rozwinięcia UV, oprócz żeber wzmocnienia chodnika – bo po tylu tygodniach nie pamiętałbym, że są innym obiektem! 
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Płaskownik na końcu wzmocnienia (por. Rysunek 5.5.27b) można stworzyć z ostatniej ściany jego poszycia: 

1. Skopiuj ostatnią ścianę poszycia wzmocnienia (Rysunek 5.5.32a) i przesuń jej wierzchołki wzdłuż glo-

balnej osi Z o +0.03”. To umieści ten pasek na wewnętrznej powierzchni skrzydła (Rysunek 5.5.32b). 

2. Wydziel (Separate) tę ścianę w nowy obiekt, o nazwie B.130.L.Strip (siatka: B.130.Strip). Przypisz go 

(Set Parent) jako potomka do obiektu B.135.L.Skin. 

3. Przełącz się na Object Mode, zaznacz nowo stworzony obiekt i usuń jego modyfikator Bevel. Jednocze-

śnie zwiększ Thickness modyfikatora Solidify w tym obiekcie do 0.16” (Rysunek 5.5.32c): 

         

Rysunek 5.5.32 Wstawienie płaskownika do wzmocnienia chodnika   

Jako ostatni element w tej sekcji stworzymy dwie podłużnice przymocowane do górnej powierzchni skrzydeł (ich 

wycięcia widać w żebrach pokazywanych przez Rysunek 5.5.15). W przemyśle lotniczym profile podłużnic są 

standaryzowane (przynajmniej wewnętrznie, przez producenta). Rysunek złożeniowy krawędzi spływu podaje 

numery tych części: 59036-11-…. Szybko znalazłem ten profil „59036” w zasobach aircorpslibrary.com, i ziden-

tyfikowałem wymiary jego wariantu „11” (Rysunek 5.5.33a). 

Stworzymy pierwszą podłużnicę, a potem wykorzystamy tę samą siatkę w drugiej. Zacznijmy: 

1. Przełącz się na projekcję wzdłuż lokalnej osi Z paska krawędzi spływu i umieść kursor 3D na górnej 

krawędzi B.120.L.Rib.008, 5.81” od dźwigara #5 (mierzone prostopadle do krawędzi spływu). 

2. Wstaw nowy Plane i nazwij ten obiekt B.140.L.Stringer.001. Nazwij tę nową siatkę B.S01.Stringer#J11 

(będziemy jej używać jako „standardowej części” w innych obiektach). 

3. Przestaw krawędzie tej siatki jak pokazuje Rysunek 5.5.33b). Uwzględniłem tu grubość materiału (1/32”). 

4. Wyciągnij tę siatkę o +1.0 (długość jednostkowa) wzdłuż lokalnej osi Z. 

5. Dodaj modyfikator Bevel, ustaw Limit Mehod na Weight, Width Type na Offset i Amount na 0.1875 

(3/16), Segments na 5. Ustaw Bewel Weight krawędzi siatki jak pokazuje to Rysunek 5.5.33c). 

6. Dodaj modyfikator Solidify, ustaw jego Thickness na 0.03 (1/32”). Jeżeli trzeba, uporządkuj normalne. 

     

Rysunek 5.5.33 Formowanie profilu podłużnicy   
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7. Przestaw renderowania tej siatki na Shade Smooth i przypisz do obiektu materiał Artificial Green. 

8. Przełącz się w Object Mode i przypisz B.140.L.Stringer.001 do obiektu B.100.L.Wing. 

Teraz możesz dopasować tę podłużnicę do wewnętrznej powierzchni skrzydła: 

1. Przełącz się w Object Mode. Przestaw tryb Transformation Pivot na Bounding Box Center. 

2. Umieść środek (origin) podłużnicy na górnej krawędzi żebra zamykającego otwór klapy od strony ka-

dłuba (B.120.L.Rib.008), 5.81” od dźwigara #5. 

3. Obracaj podłużnicę wokół lokalnej osi Z aż jej półka zagłębi się w skrzydło (Rysunek 5.5.34a). 

4. Aby dopasować długość podłużnicy się do szerokości wycięcia klapy, skaluj ten obiekt wzdłuż lokalnej 

osi Z (Rysunek 5.5.34b). Oczywiście, wykonaj zbliżenie na obszar z końcówką, aby precyzyjnie określić 

współczynnik tego powiększenia (Rysunek 5.5.34c). W moim przypadku było to 118.92. 

5. Po skalowaniu, koniec podłużnicy jest częściowo zatopiony w powierzchni skrzydła (Rysunek 5.5.34c). 

Obróć ja wokół lokalnej osi X, aby lepiej dopasować ten obiekt.     

     

Rysunek 5.5.34 „Położenie” podłużnicy na powierzchni skrzydła  

Dla końcowego dopasowania, przełącz tryb cieniowania okna 3D na Wireframe. Zaznacz podłużnicę i żebra 

zamykające wycięcie klapy (obiekty: B.105, B.120, B.140) i wywołaj View→Local View→Toggle Local View 

( / ). W tym trybie Blender pokazuje tylko zaznaczone obiekty (Rysunek 5.5.35a), co teraz ułatwi pracę. (W prze-

ciwnym razie w naszym widoku byłoby zbyt wiele linii, i trudno byłoby wśród nich odnaleźć kontury żeber). Za-

znacz podłużnicę i ustaw projekcję okna 3D wzdłuż jej lokalnej osi Z (Rysunek 5.5.35b): 

   

Rysunek 5.5.35 Końcowe dopasowanie kształtu obiektu podłużnicy   

Wykonaj zbliżeni, by lepiej widzieć profil podłużnicy i krawędzie obydwu żeber. W tej projekcji możesz łatwo 

dopasować podłużnicę do tych konturów (Rysunek 5.5.35b). Jednak te krawędzie żeber nie są równoległe. 

Skręć obiekt podłużnicy, aby pasował do obydwu (Rysunek 5.5.35c). Użyj do tego modyfikatora Simple Deform 

(Twist) – tak samo, jak zrobiliśmy to dla paska zamykającego krawędź natarcia (str. 186). 

Powróć do widoku „globalnego” za pomocą tego samego polecenia Toggle Local View lub jego skrótu ( / ). 
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Sklonuj tę podłużnicę (Duplicate Linked – Alt - D ) w nową, o nazwie B.140.L.Stringer.002. Umieść ją 11.69” od 

dźwigara #5(1) (Rysunek 5.5.36) i dopasuj do powierzchni skrzydła w sposób opisany na poprzedniej stronie: 

 

Rysunek 5.5.36 Podłużnice, dopasowane do wewnętrznej strony górnej powierzchni skrzydła   

To wszystko: odtworzyliśmy szkielet zespołu krawędzi spływu P-40, widoczny w otworze klapy. Twój model po-

winien wyglądać tak, jak ten pokazywany przez Rysunek 5.5.37: 

 

Rysunek 5.5.37 Gotowa wewnętrzna struktura otworu klapy    

Okrągłe otwory ulżeniowe i wycięcia na podłużnice w pojawią się na żebrach później, gdy namalujemy je na 

tzw. „teksturze przejrzystości”. To samo dotyczy nitów (pojawią się na teksturze nierówności). Zrobimy to pod-

czas kolejnej fazy tego projektu, związanej z materiałami i teksturami. Jeszcze później, podczas uszczegóła-

wiania modelu, odtworzymy popychacze klap i ich mechanizm. Dodamy wówczas wzmocnienia na tych żebrach 

(elementy, które Rysunek 5.5.15 oznaczył na fioletowo). 

 

 
1 Jeżeli wolisz użyć odległości wzdłuż globalnej osi Y, użyj trygonometrii: w tym skrzydle krawędź spływu i dźwigar #5 są pochylone pod 

kątem 14.11º (por. str. 287). Jeżeli odległość wzdłuż lokalnej osi Y tego dźwigara wynosi 5.81, to odpowiada to 5.81*cos(14.11º) = 5.63 

wzdłuż globalnej osi Y. 

 

W zespołach złożonych z wielu części czasami trzeba lepiej się przyjrzeć tym z nich, które są zasło-

nięte przez pozostałe. Służy do tego przełącznik Local View (w Object Mode) – dostępny także pod 

klawiszem / . Local View wyświetla aktualne zaznaczenie w tymczasowej (“lokalnej”) przestrzeni, w 

której dobrze widać wszystkie szczegóły. Aby wrócić do widoku całości, naciśnij powtórnie / .        

  

B.140.L.Stringer.001 
B.140.L.Stringer.002 

513/16 

1111/16 

Odległości od płaszczyzny dźwigara #5 

Dźwigar #5 
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Podsumowanie 

• W tej sekcji nauczyłeś się, jak odtwarzać wewnętrzną strukturę samolotu: dźwigary, wręgi, podłużnice. Uży-

liśmy do tego relatywnie prostych siatek i wiele dodatkowych modyfikatorów. Zastosowaliśmy Solidify do 

odtworzenia grubości blachy, Bevel zaokrąglenia ostrych krawędzi (str. 196, 199), Simple Deform do skrę-

cania obiektów (str. 186, 200). Aby lepiej odróżniać modelowane części, pokolorowaliśmy jest wykorzystu-

jąc proste, kontrastowe materiały (str. 186, 188). Miałeś także okazję stworzyć nowy typ obiektu: Cube (str. 

194). Czasami łączyliśmy dwa obiekty w jeden, używając funkcji Join (str. 198). Poznaliśmy także prze-

łącznik Local View, który pozwala wyłączać na chwilę zaznaczone obiekty z zatłoczonej sceny głównej (str. 

200).  

• Zanim zaczniesz modelować nowy podzespół samolotu, spróbuj zidentyfikować użyte przez jego projektan-

tów płaszczyzny bazowe. W przypadku tej klapy i jej otworu, była to linia krawędzi spływu (str. 184). Użyli-

śmy jej do ustawienia lokalnego systemu współrzędnych dla modelowanych części. Jednak taki wybór ba-

zy wymiarowej nie jest oczywisty, szczególnie jeżeli patrzysz na klasyczny widok z góry całego P-401. Po-

dobne wątpliwości można by mieć w stosunku do innych szczegółów, których rysunków brakuje na popu-

larnych planach tego samolotu. Aby uprościć mój opis tego procesu, podałem kluczowe wymiary z orygi-

nalnej dokumentacji Curtiss (str. 185, 186, 188, 189, 191, 192, 194, 197, 199, 201)2. 

• Zaczęliśmy od stworzenia paska zamykającego krawędź spływu (str. 185-186). Podczas dalszej pracy czę-

sto używaliśmy projekcji wzdłuż lokalnej osi Z jako płaszczyzny odniesienia. Następnie wycięliśmy w 

skrzydle otwór na klapę (str. 186-188), i stworzyliśmy zamykające ściany: dźwigar #5 (str. 188) oraz żebro: 

wewnętrzne i zewnętrzne (str. 190). Podczas dopasowywania półek dźwigara #5 do poszycia skrzydła do-

konaliśmy drobnych poprawek w geometrii krawędzi spływu (str. 189). 

• „Wykroiliśmy” żebra krawędzi spływu ze skopiowanego fragmentu siatki skrzydła (str. 191-195). Ich koń-

cówki wymagały dodatkowej „obróbki” (str. 196, 198). Podłużnice to proste siatki złożone z czterech ścian 

(str. 199), sklonowane i dopasowane do górnej powierzchni poszycia skrzydła (str. 200-201). 

• W większości elementów tego szkieletu nie używaliśmy do wygładzania modyfikatora Subdivision Surface. 

Dla płaskich krzywych, jakie występują na przekrojach krawędzi spływu, ten efekt nie był potrzebny. Został 

częściowo zastąpiony modyfikatorem Bevel. Używaliśmy Bevel do uzyskania większych łuków na kontu-

rach żeber (str. 193) oraz do „naturalnego” zaokrąglania krawędzi łączących wygięte powierzchnie (np. 

pomiędzy kołnierzami i ścianami żeber – str. 196, 199). 

• Dopasowywanie dwóch obiektów w Blenderze często przypomina „zatapianie” ścian jednej siatki w wyni-

kowej powierzchni drugiej (str. 192, 186). Zazwyczaj, mają się tylko stykać. Nadaj tym dopasowywanym 

ścianom niewielką grubość („blachy”) za pomocą modyfikatora Solidify. Ta grubość pozwala od razu zorien-

tować się w aktualnej „głębokości zanurzenia” ścian siatki. W takim dopasowywaniu pomaga także użycie 

dwóch materiałów o kontrastowych kolorach. 

 
1 Z powodu znacznego wzniosu skrzydeł P-40, linie nitów biegnące wzdłuż żeber na tych rysunkach nie są prostopadłe do krawędzi spływu. 

Nie wspomnę już nawet o ewentualnych innych błędach, które mogą się pojawić na typowych planach modelarskich. 

2 Bez tych wymiarów, musielibyśmy się opierać wyłącznie na zdjęciach. To oznaczałoby długi proces znajdowania najlepszego przybliżenia 

metodą prób i błędów. Wyobraź sobie wielokrotną zmianę dolnej powierzchni żeber krawędzi spływu, spowodowaną zmianami założeń 

opartych na różnych zdjęciach. Wynik byłby mniej dokładny. Jednak czasami jest to jedyna droga do odtworzenia wnętrza samolotu. Co 

więcej, pozwala uzyskać zadowalający rezultat. Popatrz, na przykład, na ten model P-36. Powstał w oparciu o zdjęcia, głównie odrestauro-

wanych egzemplarzy. Gdy w przyszłości będziesz musiał robić coś podobnego, użyj podanych tu grubości blachy i promieni zaokrągleń.   

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.05.blend. 

  

https://www.artstation.com/artwork/4Gy6W
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5.6 Klapy 

Na początku poprzedniej sekcji omówiliśmy już podstawową geometrię klapy skrzydła (por. str. 184, 197). Jak 

dodatkowy rysunek referencyjny możesz użyć trzech skanów oryginalnego rysunku złożeniowego tego zespołu. 

Te trzy czarno-białe (B/W) pliki niskiej rozdzielczości (Rysunek 5.6.1) można pobrać z p40warhawk.com: 

   

Rysunek 5.6.1 Kolejne ramki mikrofilmu z rysunkiem złożeniowym klapy    

Lepsze skany tego samego zespołu (rys. nr: 75-08-001 lub 87-08-501) są dostępne na aircorpslibrary.com. 

Wymiary podane w tej sekcji pochodzą z tego rysunku złożeniowego lub kilku innych rysunków szczegółowych. 

W zasadzie ta klapa to prostokątna „krata” zbudowana z identycznych (z kilkoma wyjątkami) trójkątnych żeber, 

jednego dźwigara, jednej podłużnicy, i dwóch wzmocnień krawędzi. Są one przynitowane do cienkiego (0.025”), 

paska z płaskiej dolnej powierzchni skrzydła. Rysunek 5.6.2a) pokazuje widok klapy z boku. Są tu dwie bazy: 

krawędź spływu skrzydła (wszystkie żebra są do niej prostopadłe) i oś obrotu. Te dwie linie nie są równoległe, 

bo przednie skrzydło zawiasu klapy jest przymocowane do dolnej półki dźwigara #5 (Rysunek 5.6.2b). Całkowi-

ta długość cięciwy tej klapy wynosi 21 7/64”. Rysunek 5.6.2c) pokazuje, jak dopasowano końcówkę klapy do 

paska zamykającego krawędź spływu skrzydła. Końcówka klapy jest odległa o 22 3/8” od dźwigara #5.    

 

   

Rysunek 5.6.2 Klapa skrzydła: widok z boku i szczegóły    

Dolne krawędzie wszystkich żeber są liniami prostymi. Jednak zawias klapy leży na dolnej powierzchni skrzy-

dła. Z powodu różnic w profili u podstawy i w połowie skrzydła (stacji 122), żebra i poszycie klapy są skręcone 

(Rysunek 5.6.2a). Końcówki dźwigara i podłużnicy są podniesione, zgodnie z kształtem poszycia klapy, ale ich 

ściany boczne pozostają pionowe (prostopadłe do cięciwy skrzydła). 
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http://www.p40warhawk.com/Models/Technical/Technical.htm
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https://app.aircorpslibrary.com/drawing/viewer/75-08-001/p-40?p=3
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Zanim zaczniemy modelować pierwszą część klapy, 

popraw przekrój dźwigara #5 (siatkę obiektu 

B.115.Web#5). Rysunek 5.6.2b) pokazuje, że jego 

dolna półka była wzmocniona dodatkową kształtką. 

Ta belka o profilu „L” pogrubiła go o 0.08”. Aby być 

gotowym na ewentualne dalsze zmiany, zdecydowa-

łem się przestawić jego modyfikator Solidify. Ustawi-

łem jego Thickness na 0.08 i Offset na 0(1).  Aby 

skompensować zmianę w grubości półek, przesuną-

łem wzdłuż globalnej osi Z dolną ścianę siatki dźwi-

gara o +0.04”, a górną ścianę o -0.04”. Zaokrągliłem 

także narożniki dźwigara za pomocą typowego mo-

dyfikatora Bevel (Angle): ustawiłem jego Limit Method na Offset, a Amount na 0.125(2). 

Zacznijmy tworzenie tej klapy od jej zawiasu taśmowego: 

1. Umieść kursor 3D w środku dźwigara #5. Ustaw aktualną projekcję wzdłuż jego lokalnej osi Y ( Shift - 1 ). 

2. Stwórz nowy cylinder o 16 bokach (Vertices), i promieniu (Radius) = 0.08”. przełącz się na Edit Mode i 

wstaw kwadrat (Plane) o boku 1.25”, prostopadle do tego cylindra. To będą skrzydła zawiasu. Podziel 

je wstawiając (Loop Cut) krawędź w środek. Utwórz kształt pokazany przez Rysunek 5.6.4a). 

3. Dodaj do tego obiektu modyfikator Solidify i ustaw jego Thickness na 0.03. 

4. Wstaw w skrzydła zawiasu dwie dodatkowe krawędzie i stwórz zagłębienie wzdłuż cylindra (Rysunek 

5.6.4b). To nie jest specjalnie realistyczne, ale przynajmniej sygnalizuje, że to zawias. 

5. Zmień lokalną współrzędną Z wszystkich wierzchołków zaznaczonych przez Rysunek 5.6.4b) na 57”(3). 

6. Przypisz temu obiektowi kontrastowy materiał: Arifical.Red. Ustaw jego cieniowanie na Shade Smooth. 

7. Nazwij ten nowy obiekt B.200.L.Flap Hinge, a jego siatkę – B.200.Flap Hinge. 

     

Rysunek 5.6.4 Tworzenie zawiasu taśmowego    

 
1 Podczas uszczegóławiania dodam do tej siatki dwie nowe ściany imitujące tę dodatkową belkę i ustawię ich normalne w przeciwną stronę. 

Następnie ustawię w modyfikatorze Solidify tego obiektu: Thickness na 0.04 i Offset na +1. W ten sposób wysokość dźwigara nie zmieni się. 

2 Czyli R = 1/8” – to typowy promień zaokrąglenia krawędzi blach w tym samolocie. 

3 To była długość tego zawiasu. Możesz tę wartość wpisać w przyborniku (czasami tak jest szybciej niż przesuwać te wierzchołki). 

 

Rysunek 5.6.3 Zmiana położenia półki dźwigara #5    

 

 

Na liście modyfikatorów obiektu zawsze umieszczaj Bevel przed (tj. ponad) modyfikatorem Solidify. 

To samo dotyczy modyfikatora Subdivision Surface: zawsze poprzedza Solidify.        
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Teraz dopasuj ten zawias do otworu klapy: 

1. Przełącz się w Object Mode i umieść ten obiekt w X: 8.265, Y:74.667, Z:-2.551(1). Ten punkt określa 

położenie wewnętrznego narożnika klapy (Rysunek 5.6.5a). 

2. Rysunki fabryczne pokazują, że ten zawias był podzielony: pomiędzy dwoma odcinkami po 57” każdy 

jest przerwa: 21/4”. Dodaj do tego obiektu modyfikator Array (str. 564), i umieść go na szczycie listy mo-

dyfikatorów. Ustaw jego Constant Offset:Z na 57+2.25 = 59.25. To stworzy drugi segment zawiasu.  

3. Zaznacz dźwigar #5 i zawias, przełącz się na Local View ( / ). Obróć obiekt zawiasu tak, by jego przed-

nie skrzydło leżało na dolnej półce dźwigara. Przełącz Pivot na Bounding Box Center i zmień kąty na-

chylenia zawiasu. Zacznij od obrotu wokół jego lokalnej osi X. Potem wykonaj zbliżenie na koniec za-

wiasu (jak w Rysunek 5.6.5b) i dopasuj ją do półki drobnymi obrotami wokół wszystkich lokalnych osi.  

4. Aby ten zawias lepiej „leżał” na dźwigarze, ustaw projekcję wzdłuż lokalnej osi Z zawiasu, jak to robili-

śmy z podłużnicami (por. str. 200). Użyj modyfikatora Simple Deform (Twist) aby dopasować skręcenie 

skrzydeł zawiasu do skręcenia półki dźwigara. Ustaw ten modyfikator jako ostatni (poniżej Solid). 

       

Rysunek 5.6.5 Dopasowanie zawiasu do krawędzi otworu klapy   

Ten zawias rozciąga się wzdłuż całej klapy, więc jego końcówka pojawia się w stacji zewnętrznego żebra klapy. 

Sprawdź szerokość szczeliny pomiędzy klapą i krawędzią jej otworu. W moim modelu ten otwór wyszedł za 

szeroki. Po sprawdzeniu dokumentacji założyłem, że wąski pasek poszycia skrzydła, przynitowany do kołnierza 

żebra 122 (str. 187) miał szerokość 13/16”. To pozostawia dystans 3/8” od klapy (Rysunek 5.6.6): 

  

Rysunek 5.6.6 Poprawienie krawędzi otworu klapy Rysunek 5.6.7 Rozdzielenie skrzydeł zawiasu  

W przyszłości animujemy mechanizm klapy. Przygotowując się do tego, wydziel (Separate) przednie skrzydło 

zawiasu (to leżące na półce dźwigara #5 – por. Rysunek 5.6.7). Nazwij ten nowy obiekt B.205.L.Hinge Plate. 

 
1 Podaję tu wynikowe współrzędne, aby nie wydłużać opisu. Uzyskałem ten punkt podążając za „ścieżką” znanych wymiarów. Zacząłem od 

umieszczenia środka zawiasu w środku obiektu dźwigara #5. Potem przesunąłem zawias o 53/64” (wymiar z Rysunek 5.6.2b) wzdłuż lokalnej 

osi X. Potem przesuniecie wzdłuż lokalnej osi Z do krawędzi wycięcia klapy (wymiar z poprzedniej sekcji). Obniżyłem także ten zawias 

przesuwając wzdłuż lokalnej osi Y dopóki krawędź jego skrzydła nie „dotknęła” dolnej półki dźwigara #5. Wreszcie przesunąłem zawias 

wzdłuż lokalnej osi Z o kolejne 0.4”. To odstęp pomiędzy klapą i żebrem zamykającym (3/8”, wg 75-08-001) rzutowany na oś Z zawiasu. 
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Przypisz (Set Parent) B.205.L.Hinge Plate do obiektu B.115.L.Web #5. Przypisz także resztę zawiasu (obiekt 

B.200.L.Hinge) jako „potomka” jej nieruchomej części. 

Stwórzmy teraz dolne poszycie klapy:  

1. Włącz widoczność kolekcji 3a.Booleans. 

2. Wydziel (Separate) dolną ścianę obiektu U.100.L.Flap1 (Rysunek 5.6.8a) w nowy obiekt, o nazwie 

B.210.L.Flap (siatka: B.210.Flap). Przełącz jego tryb Viewport Display na Textured (Rysunek 5.6.8b). 

3. Przenieś B.210.L.Flap do kolekcji 3.Wing. Przypisz ją jako potomka do obiektu B.200.L.Hinge. 

4. Wyłącz widoczność kolekcji 3a.Booleans. 

       

Rysunek 5.6.8 Tworzenie siatki poszycia klapy   

Teraz przestaw projekcję w widok z dołu, przejdź do Edit Mode i odsuń krawędzie tej ściany od konturu otworu 

na klapę. Tworzysz w ten sposób szczeliny wspomniane na poprzednich stronach: 

1. Krawędź wzdłuż wewnętrznego żebra (|AB| – por. Rysunek 5.6.9a) jest najprostszym przypadkiem. 

Przesuń ją wzdłuż lokalnej osi Y tego obiektu (czyli wzdłuż krawędzi spływu – por. str. 186) o - 3/8”.  

2. Krawędź wzdłuż zewnętrznego żebra (|CD| – Rysunek 5.6.9b): Przesuń C wzdłuż lokalnej osi Y do 

końca zawiasu. Przesuwaj (Slide) D wzdłuż krawędzi spływu aż |CD| będzie równoległe do żebra 122. 

3. Krawędź spływu (|BD| – Rysunek 5.6.9c): Zaznacz kursorem 3D docelowe miejsce dla D: 7/16“ od kra-

wędzi spływu2 (Rysunek 5.6.9c). Potem przesuń (Slide) krawędź |BD| do tego punktu.    

4. Metodą z pkt. 3 odsuń krawędź |AC| o 1/8” od osi zawiasu (por. Rysunek 5.6.9b).  

              

Rysunek 5.6.9 Poprawianie konturu poszycia klapy w rzucie z góry   

 
1 To pomocniczy „obiekt tnący”, który użyliśmy na str. . 

2 Aby umieścić kursor 3D 7/16 (0.44)” od krawędzi spływu, oblicz współrzędną Y wektora przesunięcia: 0.44*cos(14.11º) = 0.42. Potem 

umieść kursor 3D w wierzchołku D (Cursor to Selected). W przyborniku, zakładce View, panelu 3D Cursor, dopisz w polu Location:Y wyra-

żenie: „-0.42” (przesuwa kursor 3D wzdłuż globalnej osi Y o -0.42). Potem zmniejszaj Location:X, aż kursor 3D będzie nad krawędzią |CD|. 
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5. Stwórz (Subdivide) na krawędzi |BD| nowy wierzchołek E (Rysunek 5.6.10a). Umieść go 7.75” od B. 

Połącz ( J ) A i E nową krawędzią (na wszelki wypadek, by nie tworzyć n-gona).  

6. Umieść kursor 3D w wierzchołku E, przełącz się na Object Mode, i ustaw ten punkt jako nowy środek 

obiektu (Origin to 3D Cursor, por. str. 487)1. 

7. Dodaj do tego obiektu modyfikator Solidify (Thickness: 0.025, Offset:-1). 

8. Ustal wspł. Z obiektu na -0.19 (Rysunek 5.6.10b), by pasował do krawędzi spływu (Rysunek 5.6.10c):  

       

Rysunek 5.6.10 Ustalanie środka (origin) i położenia klapy   

Aby zachować oryginalną orientację bazy tej klapy2, zdecydowałem dopasować jej poszycie do skrzydła zawia-

su przez prostą modyfikację siatki i zespół dwóch modyfikatorów Simple Deform:   

1. Zaznacz zawias i klapę. Przełącz się na Local View ( / ) i ustaw projekcję wzdłuż lokalnej osi Z zawiasu. 

2. Zaznacz klapę i przejdź do Edit Mode. Przesuń wierzchołki A i C wzdłuż globalnej osi Z (Rysunek 

5.6.11a) dopóki wierzchołek nie „dotknie” skrzydła zawiasu (Rysunek 5.6.11b). 

3. Dodaj do obiektu klapy modyfikator Simple Deform (Twist), ustaw go wzdłuż osi Y, i ustal taki kąt skrę-

cenia, by narożnik C także „dotknął” skrzydła zawiasu (Rysunek 5.6.11c).  

4. W wyniku skręcenia, przednia krawędź tej klapy przestała być równoległa do osi zawiasu: narożnik C 

jest minimalnie przesunięty do przodu (Rysunek 5.6.11d). Skompensuj ten efekt kolejnym modyfikato-

rem Simple Deform: wybierz funkcję Taper wzdłuż osi Y. Zmieniaj Factor tego modyfikatora aż krawędź 

|AC| będzie równoległa do zawiasu (Rysunek 5.6.11e). To minimalna deformacja: Factor to ok. 0.0035. 

   

     

Rysunek 5.6.11 Dopasowanie poszycia klapy do skrzydła zawiasu   

 
1 To jest jedna z baz wymiarowych („STAtion 1”) na rysunku złożeniowym klapy. 

2 Podłużna oś (baza) wymiarowa tej klapy jest równoległa do krawędzi spływu i leży na płaszczyźnie cięciw skrzydła – por. Rysunek 5.6.2a) 
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Och, podczas tych dopasowani zapomniałem dodać podkładkę pomiędzy poszycie klapy a skrzydło zawiasu! 

(Pokazuje ją Rysunek 5.6.2b). Skopiujmy teraz ten drobiazg z obiektu klapy: 

1. Skopiuj i wydziel (Separate) ścianę EACD (jest pokazywana przez Rysunek 5.6.10b) w nowy obiekt, o 

nazwie B.215.L.Washer. Przypisz go jako potomka (Set Parent) do B.210.L.Flap. 

2. Aby lepiej widzieć tę część, przypisz obiektowi podkładki materiał Artificial.Green.  

3. W Edit Mode przesuń (Slide) krawędź |ED| do |AC|, tworząc szeroki na 0.5” pasek (Rysunek 5.6.12a). 

4. Przesuń obiekt podkładki wzdłuż globalnej osi Z o +0.025 (grubość poszycia klapy). To przesuniecie 

powinno umieścić wierzchołki A i E podkładki na powierzchni skrzydła zawiasu. 

5. Zmień „intensywność” obydwu modyfikatorów Simple Deform tej podkładki, aby dopasować jej krawędź 

|CD| do skrzydła zawiasu1. Wskaż B.210.L.Flap jako Origin obydwu deformacji (Rysunek 5.6.12b). 

6. Zmień ustawienia modyfikatora Solidify: Offset: +1, Thickness: 0.08. 

7. Zaznacz obiekt B.210.L.Flap i powtórz poprzednią listę kroków2, dopasowując narożniki A i C klapy do 

dolnej powierzchni podkładki zamiast do skrzydła zawiasu (Rysunek 5.6.12c): 

           

Rysunek 5.6.12 Dodanie podkładki pod zawiasem klapy 

Dla większej „czytelności” modelu, możesz także ustalić środek obiektu podkładki w jej narożniku A. Ten dodat-

kowy krok nie zmieni tego paska, ponieważ przełączyliśmy środki deformacji jego modyfikatorów Simple Deform 

na środek obiektu klapy (por. krok 5 z listy powyżej). 

W ten sposób „zamontowaliśmy” tę klapę do skrzydła (Rysunek 5.6.13a) . Zwróć uwagę, że jej płaski dolny kon-

tur trochę odstaje do lekko wygiętej dolnej powierzchni skrzydła w stacji K.S. 8 1/8 (Rysunek 5.6.13b). 

         

Rysunek 5.6.13 „Zamontowana” w skrzydle klapa 

To drobne niedopasowanie nie jest wynikiem błędu – można je dostrzec na szczegółowych zdjęciach P-40. 

 
1 Nie wiem dlaczego, ale po wydzieleniu podkładki te same modyfikatory umieściły jej końcówkę (krawędź |CD|) nieco ponad płaszczyzną 

zawiasu. Skompensowałem tę różnicę zmniejszając w modyfikatorze Simple Deform kąt skręcenia o około -0.1º.   

2 Chodzi o listę ze str. 309: wykonaj z niej kroki. 1, 2, i zmień kąt skręcenia modyfikatora z kroku 3. 
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Obiekt klapy (B.210.L.Flap) wciąż nie jest przypisany do żadnego obiektu nadrzędnego. Co więcej, jego ściany 

są wciąż wyświetlane z płaskim cieniowaniem. Zróbmy z tym porządek: 

1. Ustaw cieniowanie obiektu klapy (w Object Mode) na Shade Auto Smooth (por. str. 517). 

2. Przypisz (Set Parent) B.210.L.Flap jako obiekt potomny do B.200.L.FlapHinge. 

Podkładka pod skrzydłem zawiasu była wzmocnieniem przedniej krawędzi klapy. Stwórzmy teraz wzmocnienie 

tylnej krawędzi: odcinek cienkiego, zamkniętego (trójkątnego) profilu: 

1. Ustaw projekcję okna 3D wzdłuż lokalnej osi Z paska krawędzi spływu skrzydła. Zaznacz obiekt klapy i 

umieść kursor 3D w jego środku (Cursor to Selected).    

2. Wstaw pierwszy, 16-boczny okrąg (Radius: 3/16”). Przełącz się w Edit Mode i wstaw obok mniejszy, 12-

boczny okrąg (Radius: 1/16”). Połącz ich krawędzie, tworząc profil jak pokazany przez Rysunek 5.6.14a). 

3. Przesuń ten profil wzdłuż lokalnej osi Z do narożnika B klapy (Rysunek 5.6.14a).  

4. Wyciągnij ten profil wzdłuż lokalnej osi Z i umieść nowo utworzoną sekcję końcową ponad przeciwle-

głym narożnikiem klapy (D – por. Rysunek 5.6.14b):  

         

Rysunek 5.6.14 Tworzenie wzmocnienia krawędzi spływu klapy 

5. Nazwij ten obiekt B.220.L.Tube (siatka: B.220.Tube) i przypisz go jako potomka do B.210.L.Flap. 

6. Przypisz temu obiektowi kontrastowy materiał – Artificial.Green. 

7. Dodaj do obiektu modyfikator Solidify (Thickness: 0.025, Offset: -1). Jeżeli trzeba, użyj Flip Normals. 

8. W Object Mode przesuń obiekt wzdłuż globalnej osi Z o +0.025. Obróć go wokół lokalnej osi Z, „układa-

jąc” dolną krawędź profilu na powierzchni poszycia klapy w stacji K.1 #1 (Rysunek 5.6.15a). 

9. Dodaj modyfikator Simple Deform (Twist) i dopasuj skręcenie końca profilu do wewnętrznej powierzchni 

końca klapy (na stacji K. #12 – to punkt D pokazywany przez Rysunek 5.6.15b): 

        

Rysunek 5.6.15 Dopasowanie wzmocnienia do powierzchni klapy 

 
1 „K.” = „Klapy”. W dalszym tekście będę używał tego skrótu do zasygnalizowania, że chodzi o jedną ze stacji klapy. Na oryginalnym rysun-

ku złożeniowym są ponumerowane od 1 do 12.  
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Stwórzmy teraz żebra, zaczynając od umieszczonego na wewnętrznej krawędzi klapy (|AB|, por. Rysunek 

5.6.14b). Kontur wszystkich to prosty pięciokąt. Najważniejszą rzeczą w tym przypadku jest dobrze wybrać wła-

ściwą powierzchnię bazową i punkt środkowy (origin) takiego obiektu: 

1. Ustaw projekcję w oknie 3D wzdłuż lokalnej osi Z paska krawędzi spływu (jak na poprzedniej stronie). 

Zaznacz obiekt zawiasu i umieść kursor 3D w jego środku (Cursor to Selected). 

2. Wstaw nowy Plane, nazwij ten obiekt B.225.L.Ribs (siatka: B.225.Ribs). przypisz go (Set Parent) jako 

potomka do obiektu klapy (B.210.L.Flap).  

3. Ustaw barwę (materiał) tego obiektu na Artificial.Red. 

4. Przełącz się na Edit Mode i przekształć ten kwadrat w trzy ściany pokazywane przez Rysunek 5.6.16(1): 

  

Rysunek 5.6.16 Wymiary żebra klapy ze stacji K. #1 

5. Wyciągnij (wzdłuż lokalnej osi Z) z tej ściany kołnierz szeroki na 5/8” (Rysunek 5.6.17a). 

6. Górny narożnik żebra był zaokrąglony (R = 3/4”). Przypisz Bevel Weight = 1.0 wg Rysunek 5.6.17b) i 

dodaj do tego obiektu modyfikator Bevel. W panelu modyfikatora ustaw parametry: Limit Method: 

Weight, Width Type: Width, Amount: 0.25, Segments: 3. Ustaw cieniowanie na Shading Smooth. 

7. Dodaj drugi modyfikator Bevel. Pozostaw ustawienia metody (Limit Method: Angle,  Width Type: Offset). 

Ustaw Amount na 0.1, Segments na 5 (Rysunek 5.6.17c). 

8. Dodaj modyfikator Solidify (Thickness: 0.025, Offset: -1). 

9. Usuń z krawędzi spływu żebra dwa wierzchołki pokazane przez Rysunek 5.6.17d) i dopasuj ostatnią 

ścianę górnego kołnierza do wzmocnienia krawędzi spływu (Rysunek 5.6.17e): 

   

     

Rysunek 5.6.17 Modelowanie szczegółów żebra klapy 

 
1 Pomijam szczegóły tworzeniach tych trzech ścian, ponieważ jestem pewien, że poradzisz już sobie z tym bez moich podpowiedzi. 
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Stwórz kolejne żebro i dopasuj je do wewnętrznego brzeg klapy:  

1. Skopiuj (Duplicate) całą siatkę żebra i przesuń je wzdłuż lokalnej osi Z o 5 3/8” (Rysunek 5.6.18a). To 

jest stacja K. #2. Stworzymy wszystkie żebra tej klapy jako pojedynczy obiekt (pojedynczą siatkę). 

2. Ustaw żebro ze stacji K. #1 wzdłuż krawędzi klapy (|AB| z Rysunek 5.6.18b). Aby to zrobić, obróć 

pierwsze żebro wokół globalnej osi Z o -15.15º.  

3. Przesuń wierzchołki krawędzi spływu obróconego żebra wzdłuż globalnej osi Y o 0.7” (Rysunek 

5.6.18c). To dopasuje żebro #1 do innej długości krawędzi |AB|. 

4. Przesuń (Slide) wierzchołki P i Q (Rysunek 5.6.18c), aby ustawić krawędzie |PR| i |QS| równolegle do 

wzmocnienia krawędzi spływu klapy: 

             

Rysunek 5.6.18 Dopasowanie żebra #1 do brzegu klapy 

Po tym obrocie dolny kołnierz żebra #1 nie jest idealnie dopasowany do powierzchni klapy. Te różnice są jednak 

tak małe, że nie umieściłem ich korekty na liście kroków powyżej. Sprawdź i popraw to samodzielnie. 

We wszystkich pozostałych żebrach klapy górny narożnik znajdował się w nieco innym miejscu cięciwy niż ten z 

żebra #1. Przesuń tę krawędź w żebrze #2 wg wymiarów pokazanych przez Rysunek 5.6.19: 

 

Rysunek 5.6.19 Zmiany w geometrii żebra #2 

Skopiuj żebro #2 w żebro #12, zamykające przeciwległy koniec klapy (stację K. #12) : 

1. Skopiuj żebro #2 i przesuń tę kopię wzdłuż lokalnej osi Z o -110 5/8 (Rysunek 5.6.20a). To żebro #12. 

2. Przerzuć kołnierza żebra #12 na przeciwną stronę: przesuń zewnętrzną krawędź kołnierza wzdłuż lo-

kalnej osi Z o - 5/4” (Rysunek 5.6.20b). 

3. Przełącz normalne (Flip Normals) tego żebra, aby były skierowane na zewnątrz (Rysunek 5.6.20c). 

               

Rysunek 5.6.20 Tworzenie żebra #12 na drugim końcu klapy 
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4. W widoku z góry, obróć żebro #12 wokół globalnej osi Z o -2.98º. W ten sposób ustawisz je równolegle 

do zewnętrznej krawędzi klapy (Rysunek 5.6.21a). 

5. Zaznacz zewnętrzne krawędzie kołnierza żebra #12 i przesuń je wzdłuż lokalnej osi X o 0.03”(1). To 

uczyni krawędzie poprzeczne równoległymi do brzegów klapy (Rysunek 5.6.21b). 

6. Dodaj do tego obiektu żebra (B.225.L.Ribs) dwa modyfikatory Simple Deform. Ustaw je tak, jak poka-

zuje Rysunek 5.6.12b): obiekt B.210.L.Flap jako Origin, Axis:Y. Zmień kąt skręcenia na 2º zamiast 

1.93º podanego na rysunku. To dopasuje żebro #12 do powierzchni klapy (Rysunek 5.6.21c):  

        

Rysunek 5.6.21 Dopasowanie żebra #12 do powierzchni klapy 

Gdy krawędzie klapy są już obramowane, możemy stworzyć żebra środkowe: 

1. W żebrze #2 przesuń wolną krawędź górnego kołnierza wzdłuż lokalnej osi Z o 11/4”(Rysunek 5.6.22a), 

a potem wyciągnij ją o - 1/8” wzdłuż lokalnej osi Y (Rysunek 5.6.22b). To nada żebru profil „S”. 

2. Po tej transformacji, sprawdź kierunki normalnych tego żebra. Aby uniknąć problemów z modyfikatorem 

Bevel, wywołałem Flip Normals dla całego żebra #2. Potem podniosłem dolny kołnierz o +0.025”.  

3. Kopiuj żebro #2 i odsuwaj te kopie wzdłuż lokalnej osi Z na następujące odległości (mierzone od stacji 

K. #22): 4249/64”, 541/2”, 6533/64”, 77”, 883/32”, 991/2”. To będą żebra #6 - #11 (Rysunek 5.6.22c):  

       

Rysunek 5.6.22 Tworzenie środkowych żeber 

 
1 To przybliżony ekwiwalent obrotu o 2.98º. Dla tak małej odległości (0.03”) różnica pomiędzy tymi transformacjami jest pomijalna. 

2 Obliczyłem te odległości odejmując od położenia stacji K. #6 … K. #11 dystans pomiędzy stacjami K. #1 i K.#2 (55/8”)  

 

Modyfikator Simple Deform tworzy ten sam rezultat dla siatek o takim samym rozmiarze (mierzonym 

wzdłuż osi transformacji). Dlatego stworzyłem na początku obydwa krańcowe żebra: ich obecność 

nadaje siatce B.225.Ribs taką samą długość, jak długość klapy.         
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Trzy żebra pod wzmocnieniem chodnika skrzydła (#3, #4, #5) stworzymy na końcu tej sekcji. 

Teraz odtworzymy dźwigar i podłużnicę (por. Rysunek 5.6.2). Zacznijmy od dźwigara:  

1. Ustal w oknie 3D projekcję wzdłuż lokalnej osi Z paska krawędzi spływu (lub obiektu żeber). Zaznacz 

obiekt zawiasu i umieść kursor 3D w jego środku (Cursor to Selected). 

2. Wstaw nowy kwadrat (Plane). Nazwij ten nowy obiekt B.230.L.Flap Longeron (siatka: B.230.Flap 

Longeron). Przypisz go (Set Parent) jako potomka obiektu B.210.L.Flap. 

3. Przypisz temu obiektowi kolor (materiał) Artificial.Green.  

4. Przełącz się w Edit Mode i przekształć kwadrat w otwarty profil pokazywany przez Rysunek 5.6.23: 

 

Rysunek 5.6.23 Profil dźwigara klapy (wymiary uwzględniają grubość materiału: 0.04”)  

5. Ustal w punkcie A (Rysunek 5.6.23) nowy środek (origin) tego obiektu. (Umieść w tym wierzchołku kur-

sor 3D, przełącz się w Object Mode, a dalej – jak na str. 487. Potem wróć do Edit Mode). 

6. Przesuń profil dźwigara wzdłuż lokalnej osi Z do żebra #1, potem wyciągnij go do żebra #12. 

7. Dodaj modyfikator Bevel do obiektu. Pozostaw jego domyślne ustawienia (Limit Method: Angle, Width 

Type: Offset). Ustaw Amount na 0.16, Segments na 5. Zmień cieniowanie dźwigara na Shade Smooth. 

8. Dodaj modyfikator Solidify (Thickness: 0.04, Offset: na zewnątrz, jak pokazuje to Rysunek 5.6.24): 

     

Rysunek 5.6.24 Formowanie dźwigara klapy 

Teraz dopasuj ten dźwigar do żeber i powierzchni klapy: 

1. W Object Mode, obróć dźwigar wokół lok. osi X, by krawędź 2 pasowała do klapy (Rysunek 5.6.25a). 

2. Przejdź do Edit Mode i dopasuj końce krawędzi 1, 5, 6 do powierzchni klapy (Rysunek 5.6.25b). 

3. Przesuń górne wierzchołki wzdłuż lokalnej osi Z, dopasowując je do żeber #1 i #12 (Rysunek 5.6.25c). 

       

Rysunek 5.6.25 Dopasowanie ścian dźwigara do poszycia i żeber klapy 
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Siatka tego dźwigara jest tak prosta, że jej dopasowanie do skręconej powierzchni klapy nie było problemem. 

Stwórz tylną podłużnicę tak samo, jak stworzyliśmy na poprzedniej stronie dźwigar. Rysunek 5.6.26a) pokazuje 

szczegóły jej profilu „S”, a Rysunek 5.6.26b) wymiar jej położenia na powierzchni klapy:   

     

Rysunek 5.6.26 Szczegóły przekroju podłużnicy 

Nazwij ten obiekt B.235.L.Stringer (siatka: B.235.Stringer). przypisz go jako potomka obiektowi B.210.L.Flap.  

Rysunek 5.6.27 pokazuje aktualny stan naszego modelu klapy. Jest bliski ukończenia: 

 

Rysunek 5.6.27 Aktualny stan modelu 

Ostatnimi brakującymi elementami są żebra #3, #4, #5. Znajdują się pod „pudełkiem” wzmacniającym chodnik 

na górnej powierzchni skrzydła (por. str. 197). Pomiędzy tymi żebrami widać także wycięcie w tylnej krawędzi 

klapy, dopasowane do tego wzmocnienia (Rysunek 5.6.28): 

 

Rysunek 5.6.28 Wycięcie w krawędzi spływu klapy 

 

Nie skręcam tego dźwigara, ponieważ w dokumentacji jego ściany między krawędziami 2-3 i 4-5 

(Rysunek 5.6.25b) są pionowe, a boki ściany 3-4 – równoległe do cięciwy skrzydła.      
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Poniżej podaję kluczowe wymiary tego fragmentu klapy (Rysunek 5.6.29): 

       

Rysunek 5.6.29 Szczegóły wycięcia w klapie 

Stacje klapy wymiarowane przez Rysunek 5.6.29a) są odległościami od stacji K. #1 (to narożnik A pokazywany 

przez Rysunek 5.6.18b). Wzmocnienie tylnej krawędzi wokół wycięcia składa się z dwóch identycznych odle-

wów w kształcie litery „S” (Rysunek 5.6.29 oznacza je na niebiesko) i profilu w środku (oznaczony na czerwo-

no). Rysunek 5.6.29b) pokazuje szczegóły odlewów (są symetryczne). Zwróć uwagę na różnicę ich końcowych 

przekrojów poprzecznych. Zewnętrzny kraniec pasuje do obecnego profilu wzmocnienia (Rysunek 5.6.14a). 

Profil wewnętrzny to zaokrąglony z obydwu stron prostokąt, o wymiarach 11/16“ x 3/16”. 

Takie wycięcie można stworzyć na wiele sposobów. W najbardziej oczywistym wariancie, możesz to zrobić po-

przez zmianę siatek: klapy i wzmocnienia jej tylnej krawędzi. Ja jednak zdecydowałem się posłużyć krzywą. Ta 

metoda pozwoli mi przedstawić w tej sekcji dwa użyteczne modyfikatory. 

Zacznijmy od przygotowania odpowiedniego segmentu wzmocnienia tylnej krawędzi klapy: 

1. Wstaw (Loop Cut) w siatkę B.220.Tube dwóch nowych linii krawędzi: w Z (lokalnym) = 1415/16 i w 4317/32. 

To odległości do przeciwnych końców wycięcia, obliczone z wymiarów podanych przez Rysunek 5.6.29. 

2. Wydziel ściany pomiędzy tymi sekcjami w nowy obiekt, o nazwie B.240.L.Tube (siatka: B.240.Tube).    

3. Przejdź do Object Mode, zaznacz ten obiekt, w jego modyfikatorze Simple Deform przestaw Angle na 0. 

4. Przesuń B.240.L.Tube o -1” wzdłuż jego lokalnej osi X (Rysunek 5.6.30a). 

5. Przesuń środek (origin) tego obiektu do środka segmentu: wzdłuż lokalnej osi Z o -2915/64 (1). 

6. Przesuń sekcję 2 o +2511/16” wzdłuż lokalnej osi Z (Rysunek 5.6.30b): 

        

Rysunek 5.6.30 Wydzielenie ze wzmocnienia tylnej krawędzi klapy segmentu wokół wycięcia  

 

1 W Object Mode otwórz przybornik ( N ) i wybierz jego zakładkę Tool. W panelu Transform zaznacz opcję Affect only: Origins. Następnie 

naciśnij G  i przesuń środek tego obiektu o podaną odległość wzdłuż lokalnej osi Z. Nie zapomnij wyłączyć tej opcji Affect only po tej trans-

formacji! (Przeprowadzi275liśmy już podobna operację na str. 275). 
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Przygotuj tę nową część do wygięcia wzdłuż krzywej:  

1. Dodaj modyfikator Subdivision Surface (Subdivisions: 2) i umieść go powyżej modyfikatora Solidify. 

2. Zmień przekrój krawędzi 2: umieść środek transformacji (3D Cursor) w środku obiektu, a potem po-

większ (Scale, współczynnik: 1.5) tylny łuk z zablokowana lokalną osią Z (Rysunek 5.6.31a). 

3. Wyciągnij krawędź 2 wzdłuż lokalnej osi Z aż do środka obiektu (tam, gdzie Z lokalne = 0). 

4. Oznacz sekcję 2 jako ostrą (Crease = 1). 

5. Dodaj modyfikator Mirror (por. str. 548). Wybierz odbicie wzdłuż osi Z i umieść na liście pomiędzy mody-

fikatorami Subdivison i Solidify. To wygeneruje symetryczną drugą połowę obiektu (Rysunek 5.6.31b): 

        

Rysunek 5.6.31 Modyfikacje wzmocnienia tylnej krawędzi klapy przed wygięciem wzdłuż krzywej  

Stwórz krzywą wzdłuż połowy konturu wycięcia: 

1. W kolekcji 3.Wing stwórz nową kolekcję o nazwie 3x.Curves. 

2. Umieść kursor 3D w środku obiektu B.240.L.Tube. Ustaw projekcję wzdłuż jego osi Y ( Shift - 3 ). 

3. Stwórz nową ścieżkę (Path) wg opisu ze str. 490. Nazwij ten nowy obiekt Q.240.L.Tube. Jego blok da-

nych (Curve) nazwij Q.240.Tube. Przypisz Q.240.L.Tube jako potomka do obiektu B.200.L.Flap Hinge. 

4. Upewnij się, że środek (origin) obiektu krzywej leży w środku obiektu B.240.L.Tube, i że ich osie mają 

takie same kierunki i orientacje (Rysunek 5.6.32a): 

        

Rysunek 5.6.32 Wygięcie wzdłuż krzywej (modyfikator Curve)  

5. Dodaj do obiektu B.240.L.Tube modyfikator Curve Deform, wg opisu ze str. 555. Umieść go pomiędzy 

modyfikatorami Subdivision i Solidify. Wybierz oś wygięcia Z i wskaż Q.240.L.Tube jako Curve. 

6. Wstaw (Loop Cut) 5 nowych segmentów pomiędzy sekcjami 1 i 2 (gęstsza siatka lepiej się „wygina”). 

Wynik powinien wyglądać tak, jak pokazuje to Rysunek 5.6.32b). 

7. Dopasuj skręcenie tego wygiętego profilu, dopasowując go do reszty wzmocnienia klapy (obiektu 

B.220.L.Tube). Użyj do tego modyfikatora Simple Deform (Twist), który wyłączyliśmy na str. 215 (krok 

3). Przed ponowną zmianą jego skręcenia, wskaż jako Origin obiekt B.220.L.Tube. 
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Rysunek 5.6.33 pokazuje gotowe wzmocnienie krawędzi wycięcia, stworzone na dwóch poprzednich stronach. 

Ta stosunkowo prosta cylindryczna siatka jest znacznie przekształcona przez modyfikatory: 

 

Rysunek 5.6.33 Obiekt wzmocnienia wokół wycięcia klapy i jego modyfikatory  

W tym obiekcie rezultat modyfikatora Solidify nie jest nigdzie z zewnątrz widoczne. Szczerze mówiąc, nie zau-

ważyłem, że przestał być potrzebny. Jednak zanim go usunę, stwórzmy pomocniczy „obiekt tnący” dla wycięcia 

w wgłębienia w tylnej krawędzi poszycia klapy: 

1. Wydziel (Separate) z siatki obiektu B.240.L.Tube linię krawędzi zaznaczoną przez Rysunek 5.6.34a). 

2. Nazwij ten nowy obiekt U.210.L.Trailing Edge (siatka: U.210.Trailing Edge). Przypisz go jako potomka 

do B.200.L.Hinge. Przenieś ten obiekt do kolekcji 3a.Booleans. 

3. Zaznacz nowo stworzony obiekt, przełącz się w Edit Mode i wyciągnij jego krawędzie w górę i w dół, 

wzdłuż lokalnej osi Y, o +/- 3”. Oznacz zewnętrzne krawędzie tej siatki jako „ostre” (Rysunek 5.6.34b). 

4. W modyfikatorze Solidify tego obiektu: ustaw Offset na 1 i Thickness na 1.3” (jak trzeba: Flip Normals). 

5. Przełącz tryb Viewport Display:Display As na Wire (Rysunek 5.6.34c): 

             

Rysunek 5.6.34 Tworzenie pomocniczego „obiektu tnącego” (U.210.L.Trailing Edge)  

Użyj tego nowego obiektu do wycięcia wgłębienia w tylnej krawędzi klapy: 

1. Ustaw wszystkie zewnętrzne krawędzie siatki klapy jako ostre (Crease = 1) i dodaj na szczyt listy mody-

fikatorów modyfikator Subdivision Surface. Ten krok tworzy więcej elementarnych ścian dla operatorów 

Boole’a, co zmniejsza szansę na pojawienie się jakichś artefaktów. 

2. Dodaj do obiektu klapy modyfikator Boolean i umieść go poniżej Solidify. Wybierz operator Difference i 

wskaż jako Object U.210.L.Trailing Edge (Rysunek 5.6.35): 

 

Rysunek 5.6.35 Wycięcie wgłębienia w tylnej krawędzi klapy  
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Gdy wycięcie w tylnej krawędzi klapy jest gotowe, możemy stworzyć brakujące żebra #3, #4 i #5 (por. str. 214) : 

1. Zaznacz obiekt B.225.L.Ribs i przejdź do Edit Mode. 

2. Skopiuj żebro #2 i przesuń je wzdłuż lokalnej osi Z o -12 27/32” (Rysunek 5.6.36a). To żebro #3. Dopasuj 

w nim wierzchołki krawędzi spływu do bliższego obramowania wycięcia w klapie (Rysunek 5.6.36b):  

      

Rysunek 5.6.36 Tworzenie żebra #3  

3. Skopiuj żebro #3 i przesuń je wzdłuż lokalnej osi Z o -10 5/32”. To żebro #4. 

4. Wstaw (Loop Cut) w żebrze #4, za dźwigarem, nową linię krawędzi. Przesuń (Slide) tę sekcję (krawędź 

2 z Rysunek 5.6.37a) do tylnej ściany dźwigara. Przesuń sekcję 1 do przedniej ściany dźwigara. 

5. Obniż segment górnego kołnierza żebra pomiędzy krawędziami 1 i 2 wzdłuż globalnej osi Z do poziomu 

szczytu dźwigara. Potem usuń wszystkie ściany pomiędzy 1 i 2 (Rysunek 5.6.37b). 

6. Wstaw (Loop Cut) sekcje 3 i 4 z obu stron podłużnicy klapy (Rysunek 5.6.37c). Podnieś segment gór-

nego kołnierza żebra pomiędzy tymi sekcjami do poziomu szczytu podłużnicy1. 

7. Usuń krawędź pomiędzy punktami A i B (Rysunek 5.6.37d): 

      

      

Rysunek 5.6.37 Tworzenie żebra #4  

8. Skopiuj żebro #4 i przesuń je wzdłuż lokalnej osi Z o -101/2”. To jest żebro #5. 

 
1 Na szczegółowych zdjęciach widać, że ta podłużnica była podzielona żebrami #4 i #5. W naszym modelu pominę ten drobny szczegół. 

a) b) 

Żebro 
#2 

Żebro 
#3 

Skopiuj żebro #2 
i przesuń wzdłuż 
lokalnej osi Z o 

-1227/32” 

Skróć końcówkę 
żebra #3 i dopasuj ją 
do tego wzmocnienia 

Wzmocnienie tylnej 
krawędzi klapy  

Żebro 
#3  

4 

3 

a) b) 

c) d) 

2 1 

Żebro #3  

Żebro #4  

Skopiuj żebro 
#3 w żebro #4 

Wstaw (Loop 
Cut) sekcję 2  

Przesuń (Slide) krawę-
dzie 1 i 2 do dźwigara 

1 2 

Usuń ściany 
pomiędzy krawę-
dziami 1 and 2 

Obniż górny kołnierz żebra 
do poziomu dźwigara 

2 

3 4 

Wstaw (Loop Cut) sekcje 3 
i 4 i dosuń je (Slide) do 

obydwu stron podłużnicy  

A 

B 
Podnieś ten seg-

ment siatki do 

szczytu podłużnicy 
Usuń tę 
krawędź 



Rozdział 5 Skrzydła 219 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Rysunek 5.6.38 pokazuje ukończoną klapę skrzydła. Jeżeli połączyłeś jej wszystkie części w prawidłową hierar-

chię, to obrót obiektu B.200.L.Hinge wokół lokalnej osi Z otwiera i zamyka całą klapę:  

 

 

Rysunek 5.6.38 Gotowa klapa skrzydła  

Możesz także ukryć na chwilę poszycie skrzydła i sprawdzić, czy żebra skrzydła i klapy nie kolidują ze sobą. 

Na koniec, drobna uwaga o moich źródłach. Na stronie 203 wspomniałem, że niemal wszystkie wymiary podane 

w tej sekcji pochodzą z rysunków 75-08-001 i 87-08-501. Korzystałem głównie z pierwszego (75-*), opisującego 

klapę P-36. Drugi z nich (87-*) był stworzony latem 1941 r. Na tym późniejszym rysunku wokół wycięcia w klapie 

wstawiono dodatkowe żebra (Rysunek 5.6.39): 

 

 

Rysunek 5.6.39 Różnice pomiędzy rysunkami źródłowymi  

Tabelka rysunku 87-08-501 podaje, że dotyczy on wariantu P-40D (lub typu H87-A1 w wewnętrznej nomenklatu-

rze Curtiss). Policzyłem żebra klapy na zdjęciu wykonanym w połowie 1940 w na linii produkcyjnej P-40 w 

Buffalo (por. str. 197). Okazuje się, że w P-40-cu/B/C montowano prostsze klapy z P-36 (te z rys. 75-08-001). 
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Gdy sprawdzałem te klapy na zdjęciach odrestaurowanych P-40, odkryłem, że P-40B (biała „284”) z Duxford ma 

klapy z dodatkowymi żebrami. Z drugiej strony, na zdjęciach z Australian War Memorial, które otrzymałem od 

Alexa Stewarta, znajdujący się tam P-40E ma klapy jak z P-36. Czy w egzemplarzu z Duxford wykorzystano 

klapę z późniejszego wariantu? A może Curtiss miał nadmiar wcześniejszych, 12-żebrowych klap, które monto-

wał na wczesnych P-40E, takich jak ten z Australii? Nie mam pojęcia. 

 

Podsumowanie 

• W tej sekcji kontynuowaliśmy “wirtualne blacharstwo”, odtwarzając klapę skrzydła wraz ze szkieletem. Tak 

jak poprzednio, zrobiliśmy to za pomocą prostych siatek z modyfikatorami. Większość z nich poznałeś już 

poprzednio. Nowy modyfikator Array (str. 205) przydaje się do powielenia siatki w obrębie jednego obiektu. 

Ponieważ klapa była lekko skręcona, używaliśmy często modyfikatorów Simple Deform. W tym przypadku, 

często łączyliśmy je w pary: jeden z funkcją Twist, drugi z funkcją Taper (str. 207). Modyfikator Simple 

Deform (Taper) kompensuje niewielkie różnice w szerokości, pojawiające się w wyniku skręcenia. Korzy-

staliśmy także z innego niż domyślny środka tych transformacji (str. 208). Innym modyfikatorem, który bę-

dziemy często używać w modelu samolotu jest Mirror (str. 216). Poznałeś także modyfikator Curve, zwią-

zany z obiektem typu Path (krzywą NURBS), którego użyliśmy do kształtowania wycięcia w krawędzi klapy 

(str. 216, 217). 

• Zaczęliśmy modelowanie tej klapy od jej zawiasu. Podzieliliśmy ten element na część „stałą” i „ruchomą”. 

Zawias klapy zapewnił ważną bazę wymiarową (str. 203). Ściana pomocniczego „obiektu tnącego” otworu 

klapy posłużyła nam do stworzenia wstępnej wersji poszycia (str. 206). Najpierw zmodyfikowaliśmy jej ob-

rys w rzucie z dołu (str. 207), potem ustawiliśmy jej środek w drugiej bazie – krawędzi spływu (por. str. 

207). W kolejnym kroku skręciliśmy za pomocą modyfikatora powierzchnię klapy w widoku z boku. Dopa-

sowaliśmy ją do skrzydła zawiasu (str. 207-208). Następnie odtworzyliśmy wzmocnienie wzdłuż jej tylnej 

krawędzi (str. 209) oraz żebra (str. 210-212). Potem dodaliśmy dźwigar (str. 213) i podłużnicę (str. 214). Na 

koniec uformowaliśmy wycięcie w tylnej krawędzi klapy (str. 215-218). 

• W rozwiązaniu zaproponowanym na str. 216-217, kształt wycięcia w klapie i jego wzmocnienia zależy od 

tej samej krzywej (Q.240.L.Tube). Taka zależność jest niezwykle przydatna w przypadku ewentualnych 

modyfikacji: zmiana kształtu krzywej zmienia w odpowiedni sposób wszystkie powiązane elementy.      

• Ta i poprzednia sekcja dostarczają przykładu precyzyjnego modelowania wg wymiarów. Podobne metody 

wykorzystuje się w prawdziwych konstrukcjach. Mogłeś się przekonać, jak ważne są w tym procesie bazy 

wymiarowe. Czasami są one podane w sposób domyślny (jak na str. 203). 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.06.blend. 
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5.7 Otwór na koło główne 

P-36 i P-40 używały do składania podwozia rozwiązanie licencjonowane przez Boeing. Wymaga ono otworu na 

koło w tylnej części skrzydła. W P-36 ten obszar był częściowo zakryty, gdy podwozie było schowane. Jednak w 

samolotach operujących z polowych pasów startowych te opływowe owiewki były przyczyną różnych kłopotów. 

Dlatego w P-40 z nich zrezygnowano. Rysunek 5.7.1 pokazuje szczegóły komory podwozia w tym samolocie: 

         

Rysunek 5.7.1 Otwór na koła podwozia głównego  

Wycięcie w dolnej powierzchni skrzydła otwiera przestrzeń pomiędzy żebrami 26 i 57 oraz dźwigarami #3 i #4 

(Rysunek 5.7.1a). Ponieważ koła P-40 były większe niż koła P-36, Curtiss wygiął w P-40 żebra i dźwigar #4 by 

uzyskać większy otwór. Dlatego na zdjęciu (Rysunek 5.7.1b) widać segment stożka w żebrze 26, a dźwigar #4 

jest wygięty wokół koła (Rysunek 5.7.1a). Krawędź otworu jest otoczona 1-calowym kołnierzem (Rysunek 

5.7.1b), wytłoczonym w panelu poszycia. Krawędź kołnierza jest zaokrąglona (R zewnętrzne: 0.16”). W fabrycz-

nie nowych P-40 wnętrze otworu było wyłożone tekstylną osłoną, przymocowaną do kołnierza i górnych podłuż-

nic skrzydła. Ta osłona chroniła wnętrze skrzydła przed kurzem i brudem z kół. Jednak na zdjęciach archiwal-

nych widać otwory kół bez tych osłon, tak jak pokazuje to Rysunek 5.7.1b)1. 

Tak jak w przypadku klapy i lotki, wytniemy w tym skrzydle otwór za pomocą pomocniczego cylindra (Rysunek 

5.7.2a). Jednak nie można wyciągnąć nowych ścian z krawędzi utworzonej modyfikatorem Boolean. Dlatego 

stworzymy ten kołnierz jako oddzielny obiekt, a potem „wpasujemy” go w powierzchnię skrzydła tak, jak to zrobi-

liśmy na str. 181 z wnętrzem wycięcia lotki. Zacznij od koła o 64 wierzchołkach i promieniu 16” (to promień 

otworu). Następnie wyciągnij z tego okręgu krawędź zewnętrzną, powiększając ją o współczynnik 1.02. Uzy-

skasz w ten sposób pierścień o szerokości 0.32”. Rysunek 5.7.2b) oznacza ten obiekt na czerwono: 

        

Rysunek 5.7.2 Formowanie bryły tnącej i początkowej siatki kołnierza otworu  

 
1 Przypuszczam, że wystarczyło kilka razy zapomnieć o zablokowaniu kół po starcie (hamulcami). Ich bezwładny obrót szybko porwał te 

tekstylne osłony na strzępy.  
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Najbardziej pracochłonną część tej operacji: wygięcie tego płaskiego pierścienia tak, aby dopasować go do 

dolnej powierzchni skrzydła – wykona za nas modyfikator:  

1. Dodaj do obiektu B.102.L.Flange modyfikator Shrinkwrap (por. str. 565). 

2. Ustaw Wrap Method tego modyfikatora na Project, a jego Axis na Z. Włącz opcję Negative i ustaw je-

go Subdivision Levels na 2. 

3. Wskaż jako Target obiekt B.100.L.Wing (Rysunek 5.7.3): 

 

Rysunek 5.7.3 Rzutowanie pierścienia kołnierza na powierzchnię skrzydła  

Ten Shrinkwrap rzutuje pierścień na skrzydło wzdłuż lokalnej osi Z deformowanego obiektu. Możemy także wy-

ciągnąć z tej siatki pionową część kołnierza i użyć drugiego modyfikatora Shrinkwrap do jej uformowania (ogra-

niczając jego obszar za pomocą Vertex Group – por. str. 566). Jednak cały ten efekt zniknie, gdy wytniemy w 

skrzydle otwór na koło. Dlatego teraz „utrwalimy” tę deformację w siatce: 

4. Wybierz w modyfikatorze Shrinkwrap polecenie Apply (por. str. 572). 

5. Ustaw cieniowanie obiektu w tryb Shading Smooth. 

Teraz możemy kontynuować dopasowywanie podstawy kołnierza do powierzchni skrzydła: 

6. Zwiększ średnicę cylindra U.100.L.Wheel do 32.4” (możesz wpisać tę wartość w zakładce Item przy-

bornika, panelu Dimensions). 

7. Dodaj do obiektu B.100.L.Wing kolejny modyfikator Boolean (Difference). Wskaż obiekt U.100.L.Wheel 

jako drugi (w polu Object – por. Rysunek 5.7.4a). To odsłoni część kołnierza (Rysunek 5.7.4b). 

8. Przejdź do edycji siatki kołnierza. Wyciągnij jej wewnętrzną krawędź wzdłuż globalnej osi Z o +1”. 

9. Dodaj zaokrąglenie do wewnętrznej krawędzi kołnierza (Rysunek 5.7.4c): dodaj do obiektu modyfikator 

Bevel. Ustaw jego Width Type na Offset, Amount na 0.16, Segements na 5.   

       

Rysunek 5.7.4 Formowanie wycięcia w skrzydle  
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Opcjonalnie, możesz jeszcze wygładzić ten kołnierz modyfikatorem Subdivision Surface (Subdivisions: 1). Ry-

sunek 5.7.5a) pokazuje uzyskany efekt. Gdy wyłączysz obrysowywanie konturów obiektów (str. 181), to ten 

kołnierz wygląda jak naturalna część powłoki skrzydła (Rysunek 5.7.5b):  

          

Rysunek 5.7.5 Wycięcie w skrzydle, wraz z kołnierzem  

Sugeruję odtworzyć wewnętrzne ściany tej komory jako jedną siatkę (pomimo tego, że w samolocie każda z 

nich należała do innego żebra lub dźwigara). Zacznijmy od ich konturów w rzucie z dołu. Stwórz w tej projekcji 

nowy obiekt (Plane) i przekształć go w kształt pokazany przez Rysunek 5.7.6a). Potem wstaw w tą siatkę okrąg 

(Vertices: 64, Radius: 173/16”) i przytnij go tak, jak pokazuje to Rysunek 5.7.6b): 

        

Rysunek 5.7.6 Formowanie wewnętrznych ścian komory koła: kontury w widoku z dołu  

Umieść podstawę tego obiektu w Z = -6.5 (mniej niż 2” poniżej powierzchni skrzydła). Wyciągnij (Extrude) te 

dwa kontury w bryły i zmniejsz średnicę ściany zamykającej cylindra (Rysunek 5.7.7a). Następnie scal je funk-

cją Union polecenia Intersect (Boolean), wykorzystując Solver: Fast (Rysunek 5.7.7b):  

        

Rysunek 5.7.7 Formowanie wewnętrznych ścian komory koła: scalenie w jedną bryłę  

a) b) 

a) b) 
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Kolekcja:3.Wing 

57, 23.79 

26, 25.72 

57, 52.40 

26, 57.22 

46.12, 57.54 

39.72, 58.67 

Wszystkie wymiary w 
globalnych wspł. X, Y  

1.5 

1.5 
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Przypisz temu obiektowi B.250.L.Wheel.Packet kontrastowy kolor: materiał Artificial.Green. 

Teraz dopasuj te ściany do skrzydła: 

1. Przejdź do edycji obiektu B.100.L.Wing, skopiuj (Duplicate) i wydziel (Separate) ściany pomiędzy sek-

cjami 000 i 122 (Rysunek 5.7.8a). 

2. Scal (Join) ten nowo stworzony obiekt z B.250.L.Wheel.Packet (zaznacz B.250.L jako ostatni). To usu-

nie wszystkie modyfikatory ze skopiowanego fragmentu siatki, w szczególności Subdivison Surface. 

3. Zamknij krawędzie sekcji 000 i 122 ścianami (Rysunek 5.7.8b), by uniknąć kłopotów z funkcją Boolean. 

4. Zaznacz skopiowany fragment skrzydła (Rysunek 5.7.8b) i wywołaj polecenie Intersect (Boolean). Aby 

uzyskać wynik pokazywany przez Rysunek 5.7.8c), wybierz funkcję Intersect i Solver = Fast.   

5. Usuń górne i dolne ściany (to „otworzy” tę bryłę). Obniż (wzdłuż globalnej osi Z) górne krawędzie ścian 

o -0.1” (bo wystawały ponad wygładzoną powierzchnią skrzydła). Podobnie, podnieś ich dolne krawę-

dzie o +0.05”. Wciągnij górne krawędzie żeber, tworząc kołnierze o szerokości 5/8” (Rysunek 5.7.8d). 

6. Zaznacz jako ostre krawędzie powierzchni stożkowych (Mark Sharp, str. 541) i ustaw cieniowanie 

obiektu na Shade Smooth. Przypisz Bevel Weight = 1 do pionowych krawędzi dźwigara #4 (Rysunek 

5.7.8e) i dodaj modyfikator Bevel (Weight) ustawiając Width Type na Width, Amount: 1.1, Segments:3. 

7. Według dokumentacji, wgłębienia w żebrach były fragmentami sfery. Zmodyfikuj je odpowiednio, wsta-

wiając do ich siatek (Loop Cut) i powiększając dodatkowe krawędzie „równoleżników” (Rysunek 5.7.8f). 

     

     

     

Rysunek 5.7.8 Wykończenie wewnętrznych ścian komory koła  

a) b) 

c) d) 

e) f) 
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Rysunek 5.7.9 pokazuje gotowe ściany wewnątrz komory: 

  

Rysunek 5.7.9 Wewnętrzne ściany komory podwozia  Rysunek 5.7.10 Profile podłużnic skrzydła 

Nie wygładzam tego obiektu modyfikatorem Subdivision Surface, ponieważ w renderowanych ujęciach zawsze 

te ściany zawsze będą się pojawiać jako dość odległe, a w dodatku w cieniu. W takich warunkach ostre krawę-

dzie stożkowych wytłoczeń w żebrach wyglądają jak gładkie krzywe, choć składają się z prostych odcinków. 

Z drugiej strony, sugeruję odtworzyć inny, bardziej widoczny szczegół: podłużnice, biegnące pod górnym poszy-

ciem skrzydła. Widać je na zdjęciach (por. Rysunek 5.7.1). Przygotuj cztery profile podłużnic o wysokości 1.5” 

wg wymiarów podanych przez Rysunek 5.7.10. Pierwszy z nich to górna półka dźwigara #4, a ostatni – dźwiga-

ra #3. Pochylenie ich górnych kołnierzy jest dopasowane do górnej krzywizny profilu skrzydła. Profil dźwigara 

#4 można odtworzyć jak na str. 199. W pozostałych profilach grubości ścian są różne, więc zamiast używać 

modyfikatora Solidify stwórz je jako zamknięte obrysy. Niektóre z ich narożników były „ostre” (w zakresie tech-

nologicznych możliwości) więc użyłem w tych obiektach modyfikatora Bevel (Weight) do zaokrągleń. 

Półka dźwigara #4 jest unikalna, więc nazwałem jej siatkę B.255.Web#4.U.Flange. Podobnie, siatkę czwartego 

profilu nazwałem B.255.Web#3.U.Flange. Profile C01 i C02 wystąpią w wielu obiektach, więc nazwałem ich 

siatki B.S02.Stringer#C01 i B.S03.Stringer#C02. Wszystkie obiekty podłużnic w tej komorze podwozia będą 

się nazywać B.255.L.Stringer.<###>. Na przykład: obiekt, który zawiera siatkę B.255.Web#4.U.Flange nosi 

nazwę B.255.L.Stringer.001. dopasujmy go do powierzchni skrzydła: 

1. Umieść środek (origin) tego profilu pod górnym poszyciem skrzydła, w narożniku pomiędzy żebrem 26 i 

dźwigarem #4 (Rysunek 5.7.11a).  

2. Przełącz Transformation Pivot na Bounding Box Center. W widoku z góry wydłuż tę podłużnicę do żebra 

57 skalując ją wzdłuż lokalnej osi Z. Potem ją obróć, dopasowując do dźwigara #4 (Rysunek 5.7.11b). 

3. Obracaj tę podłużnicę wokół globalnej osi Y dopóki jej koniec nie zniknie pod powierzchnią skrzydła 

(Rysunek 5.7.11c). 

     

Rysunek 5.7.11 Dopasowywanie podłużnicy do powierzchni skrzydła   
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Dopasuj w ten sam sposób górną półkę dźwigara #3. Sklonuj profile „C” pokazywane przez Rysunek 5.7.10 i 

dopasuj je do górnej powierzchni skrzydła, odtwarzając pozostałe 8 podłużnic widocznych w komorze koła. Aby 

określić ich położenia i kąty, użyj rysunku R.Wing (top), jak to zrobiliśmy na poprzedniej stronie (Rysunek 

5.7.11b). Jednak, gdy sprawdziłem dokumentację żeber 26 i 57, okazało się, że ten rysunek koncepcyjny nie 

jest dokładny. Rysunek 5.7.12 podaje wymiary z tych szczegółowych rysunków żeber1, oraz informację o typie 

profilu użytego w poszczególnych podłużnicach: 

    

Rysunek 5.7.12 Podłużnice pod górną powierzchnią skrzydła   

Na czas pracy zmieniłem kolor tych podłużnic na Artificial.Red, aby były widoczne na szarym poszyciu skrzy-

dła i zielonych ścianach komory koła. Przypisz te podłużnice jako obiekty potomne do obiektu B.100.L.Wing. 

Rysunek 5.7.13 pokazuje gotową komorę podwozia: 

 

Rysunek 5.7.13 Ukończona (dla tej fazy projektu) komora koła głównego 

Później użyjemy tekstur, aby odtworzyć otwory ulżeniowe w jej ścianach i szwy nitów w jej podłużnicach. Pod-

czas ostatniej fazy tego projektu (uszczegóławiania) dodamy drobne elementy ze zdjęcia na początku tej sekcji 

(Rysunek 5.7.1). Będą to części systemu hydraulicznego oraz wzmocnienia żebra 26. 

 
1 Oryginalne rysunki używały w stacjach 26 i 57 jako bazy wymiarowej lokalnego punktu przecięcia płaszczyzny dźwigara #3 z cięciwą 

profilu skrzydła. Wg pomiarów, to globalne punkty: (X=26, Y=25.63) oraz (X=57, Y=23.70). Oryginalne wymiary przeliczyłem z tych wspł. Y.   

Widok z boku Widok z góry 

48.99 

45.87 

42.66 

39.50 

36.33 

33.17 

29.97 

26.74 

53.30 

49.83 

46.37 

42.95 

39.54 

36.01 

32.54 

28.93 

B.255.L.Stringer.001 

B.255.L.Stringer.010 

Profil: 
C02 

Profil: 
C01 

Profil: 
Web#3 

Profil: 
Web#4 

Wszystkie wymiary są od globalnej Y=0 

Żebro 26 

Żebro 57 



Rozdział 5 Skrzydła 227 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Podsumowanie 

• W tej sekcji użyliśmy modyfikatora Shrinkwrap do dopasowania pierścienia wokół otworu koła do wygiętej 

powierzchni skrzydła (str. 222). W odróżnieniu od poprzednich modyfikatorów, tym razem użyliśmy go jako 

narzędzia modelowania, natychmiast „utrwalając” ten efekt w wierzchołkach siatki (poleceniem Apply).  

• Rozpoczęliśmy od formowania kołnierza wokół otworu koła (str. 221, 222), ponieważ modyfikator 

Shrinkwrap potrzebował oryginalnej powierzchni skrzydła, bez otworu. Następnie wycięliśmy okrągły otwór 

w skrzydle (str. 222) w ten sam sposób, jak to robiliśmy w poprzednich sekcjach. Gdy już się pojawił, do-

kończyliśmy formowanie otaczającego go, pionowego kołnierza. Jest to oddzielny obiekt, ale dopasowali-

śmy go do skrzydła tak, że wydaje się tworzyć z nim jedną całość (str. 223). 

• Gdy otwór w skrzydle był gotowy, stworzyliśmy wewnętrzne szczegóły komory podwozia. Zaczęliśmy od 

formowania jej ścian, rysując ich kontury w widoku z góry (str. 223). Potem wyciągnęliśmy je i połączyliśmy 

w jedną bryłę (str. 223), wystającą z górnej i dolnej powierzchni skrzydła. W kolejnym kroku użyliśmy kopii 

powierzchni skrzydła do „przycięcia” tej bryły (str. 224). Gdy ściany komory były gotowe, przygotowaliśmy 

profile jej podłużnic (str. 225). Na koniec dopasowaliśmy te podłużnice do dźwigarów i górnej powierzchni 

skrzydła (str. 226).  

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.07.blend. 
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5.8 Wykończenia 

Skrzydło jest już niemal gotowe (dla tej fazy projektu). W tej sekcji ustawimy je w położeniu docelowym, poniżej 

osi śmigła. Obrócimy je także o odpowiednie kąty wzniosu i zaklinowania. Dodatkowo, w oknie Outliner pogru-

pujemy obiekty stworzone w poprzednich sekcjach w nowe kolekcje. 

Najpierw musimy poprawić kilka powiązań pomiędzy obiektami stworzonymi w tym rozdziale: 

1. Przypisz (Set Parent) wszystkie obrazy referencyjne z kolekcji 1b.Wing i jej podkolekcji jako obiekty po-

tomne do obiektu B.100.L.Wing. Robimy to tylko na wszelki wypadek – aby zawsze były „na miejscu”.   

2. Włącz widoczność kolekcji 3a.Booleans i 3z.Bases, i upewnij się, że żaden z ich obiektów nie jest 

ukryty (ukrytych obiektów nie można zaznaczyć).  

3. Zaznacz obiekt X.100.Wing.Base i wywołaj polecenie Select→Select Grouped→Immediate Children. 

To powinno zaznaczyć skrzydło i jego trzy “obiekty tnące”. Upewnij się, że licznik zaznaczonych obiek-

tów w statystykach sceny wynosi 4 (Rysunek 5.8.1a). 

4. Przesuń zaznaczone obiekty wzdłuż globalnej osi Y o +9” (Rysunek 5.8.1b). To umieści obiekt 

X.100.Wing.Base na krawędzi natarcia bazowego żebra skrzydła (000). W rysunkach złożeniowych ten 

punkt jest bazą wymiarową, wykorzystywaną do określenia położenia skrzydła (por. Tom I, sekcja 5.2)1. 

 

 

Rysunek 5.8.1 Poprawienie względnej pozycji pomocniczego obiektu „bazy” skrzydła 

5. Dodaj w nazwie obiektu X.100. literę L: X.100.L.Wing.Base. (Uświadomiłem sobie, że w przyszłości 

będziemy potrzebować podobnej bazy dla prawego skrzydła. Wtedy utworzymy drugi obiekt z „R”). 

Szczerze mówiąc, powinienem umieścić ten obiekt bazowy w krawędzi natarcia skrzydła od razu, gdy tylko 

stworzyłem go w sekcji 5.4 (por. str. 171). Teraz naprawiam tę pomyłkę. 

Gdy używasz modyfikatorów Boolean, jak w tym skrzydle, wykonuj takie operacje z dużą uwagą. To ważne, aby 

przesunąć wszystkie powiązane obiekty razem. Jeżeli się pomylisz – wygenerujesz dziury nie tam, gdzie trzeba.  

 
1 Na tych rysunkach jest jeszcze inna baza: koniec krawędzi spływu. Bazę na krawędzi natarcia jest trudno fizycznie odnaleźć, gdyż w 

profilu NACA 2215 geometryczny „czubek” noska profilu jest 0.5” ponad linią cięciwy (i bazą wymiarową). Na krawędzi spływu nie ma takiej 

niejednoznaczności. Jednak w jej przypadku łańcuch wymiarowy na rysunkach złożeniowych jest bardziej skomplikowany.  

a) 

b) 
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Teraz możesz umieścić ten obiekt bazowy w Y=-9, Z=-21.5. Najlepiej wpisz te współrzędne wprost w zakładce 

Item przybornika (Rysunek 5.8.2). Możesz tam także ustawić kąt zaklinowania na 1º (technicznie – to ustawie-

nie pola Rotation:X na -1º): 

 

Rysunek 5.8.2 Umieszczenie skrzydła w położeniu docelowym 

W podobny sposób ustal kąt wzniosu: 6º  (Rysunek 5.8.3): 

 

Rysunek 5.8.3 Ustalenie wzniosu skrzydła  

Skrzydła P-40 były złożone z dwóch symetrycznych połówek, skręconych wzdłuż kołnierza biegnącego wokół 

żeber 000. Stąd to żebro było ustawione pod kątem 84º do płaszczyzny cięciw skrzydła (90º – [kąt wzniosu]). 

Odtworzymy ten efekt za pomocą kolejnego modyfikatora Boolean (Rysunek 5.8.4): 

           

Rysunek 5.8.4 Przycięcie podstawy skrzydła   

 

Czasami nadal będziesz potrzebował na chwilę „położyć płasko” to skrzydło. Przy ustawieniach jak 

powyżej, wystarczy wyzerować obroty obiektu X.100.Wing.Base. Potem je łatwo przywrócić.  
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Teraz „wygeneruj” prawe skrzydło, dodając modyfikator Mirror do obiektu B.100.L.Wing (Rysunek 5.8.5): 

 

Rysunek 5.8.5 Odtworzenie drugiej połówki skrzydła za pomocą modyfikatora Mirror   

Jako środek tej transformacji, użyj w tym modyfikatorze nowego obiektu Empty, umieszczonego w płaszczyźnie 

symetrii samolotu. Nazwij go X.000.Base. To będzie nasza „baza wszystkich baz”, czyli początek hierarchii ca-

łego modelu. Umieść go w nowej, podstawowej, kolekcji o nazwie 8.Bases (Rysunek 5.8.6): 

 

Rysunek 5.8.6 Bazowy obiekt całego modelu i jego kolekcja  

Na początek, przypisz X.100.L.Wing.Base jako obiekt potomny do obiektu X.000.Base. 

Jednak zanim zaczniemy tworzyć „lustrzane odbicia” innych części skrzydła, uporządkujmy wewnętrzną struktu-

rę kolekcji 3.Wing. Obecnie w jej głównym folderze jest zbyt wiele obiektów. Jednocześnie ważne części, jak 

klapa czy lotka są ukryte w głębi jej hierarchii obiektów potomnych. Kto mógłby się domyślić, że w oknie 

Outliner można znaleźć klapę wśród „prawnuków” dźwigara #5 (lub wśród „dzieci” jej zawiasu?). Potrzebujemy 

stworzyć w 3.Wing dodatkowe kolekcje, które „wyeksponują” te ważne części modelu. 

Sugeruję stworzyć w kolekcji 3.Wing następujące kolekcje: 

• Trailing Edge details: na część szkieletu skrzydła za dźwigarem #5 (widoczną w otworze klapy). 

• Flap details: na szkielet klapy. 

• Aileron details: na ewentualne szczegóły lotki. Na razie jest to tylko jej oś. 

• Wheel pocket: na wewnętrzne ściany i podłużnice widoczne w komorze koła głównego. 

• Other details: na inne szczegóły, widoczne, gdy klapa jest zamknięta. To kolekcja „techniczna”, którą 

będę używać do oddzielenia obiektów nadrzędnych od potomnych w innych kolekcjach1.   

 

 
1 Gdy obiekt nadrzędny („rodzic” w hierarchii modelu) jest w innej kolekcji, jego „dzieci” nie są „zwinięte” w gałęzi pod obiektem nadrzędnym, 

a zamiast tego wyświetlane wprost, jako lista. Rozdzielę w ten sposób obiekty klapy, umieszczając ich rodzica (zawias) w kolekcji Other 

details. W efekcie, w kolekcji Flap details uzyskam „płaską”, czytelną na pierwszy rzut oka, listę części klapy. 
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Mirror 
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Rysunek 5.8.7 przedstawia obiekty, które należy umieścić w kolekcji Trailing Edge details: 

 

Rysunek 5.8.7 Zawartość kolekcji 3b.Trailing Edge details  

Ta kolekcja otrzymała przedrostek „3b”, ponieważ „3a” już użyliśmy w kolekcji 3a.Booleans. To mój drobny 

błąd: w symbolach zestawów obiektów pomocniczych, jak te obiekty „tnące”, lepiej używać ostatnich liter alfabe-

tu („q”, „z”, „x”). Na szczęście możesz swobodnie zmieniać kolejność kolekcji (nie są automatycznie sortowane). 

Mogłem więc umieścić 3a.Booleans poniżej wszystkich innych podzespołów skrzydła (por. Rysunek 5.8.10).   

Rysunek 5.8.8 pokazuje obiekty, które należy umieścić w kolekcjach Flap details i Aileron details:  

 

Rysunek 5.8.8 Zawartość kolekcji 3d.Aileron details i 3c.Flap details 

Zwróć uwagę, że w 3c.Flap details nie ma poszycia klapy: obiekt B.210.L.Flap pozostał w kolekcji 3.Wing. To 

samo dotyczy obiektu lotki (B.150.L.Aileron). 

Rysunek 5.8.9 pokazuje obiekty, które należy umieścić w kolekcjach Wheel pocket i Other details: 

 

Rysunek 5.8.9 Zawartość kolekcji 3e.Wheel pocket i 3f.Other details 

Umieszczając obiekt B.200.L.Flap Hinge w kolekcji 3f.Other details uzyskałem w 3c.Flap details „płaską”, 

czytelną listę części szkieletu klapy, pokazanego przez Rysunek 5.8.8. Gdybyś umieścił ten zawias w kolekcji 

3c, Blender „zwinąłby” wszystkie te elementy potomne pod obiektem B.200.L.Flap Hinge.  

 

Obiekty sceny są zorganizowane w dwie alternatywne struktury: hierarchię obiektów potomnych 

(parent:child) i kolekcje. Kolekcji używam do “wyeksponowania” w oknie Outliner tych kluczowych 

obiektów i grup, które znajdują się głęboko w hierarchii obiektów potomnych.  

  

Na tej ilustracji otworzyłem klapę, 
abyś mógł łatwiej odróżnić części jej 
szkieletu od żeber krawędzi spływu  
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Wszystkie obrazy referencyjne, które dotychczas były przypisane do B.100.L.Wing,1 przypisz jako obiekty po-

tomne do obiektu X.100.L.Wing.Base. W ten sposób skrócimy listę bezpośrednich „potomków” skrzydła. 

Rysunek 5.8.10 pokazuje uaktualnioną zawartość kolekcji 3.Wing: 

 

Rysunek 5.8.10 Zawartość kolekcji 3.Wing i hierarchia obiektów potomnych B.100.L.Wing 

Figurują na niej tylko trzy główne obiekty tego zespołu: skrzydło, lotka i klapa. Myślę, że jest to dość czytelne, 

nawet jeżeli klapa i lotka są aktualnie „prawnukami” obiektu B.100.L.Wing. (Są wyświetlone na tym samym 

poziomie co skrzydło, gdyż ich rodzice znajdują się w subkolekcjach). Gdy „rozwiniesz” obiekt B.100.L.Wing, 

zobaczysz trzy inne obiekty, które są jego bezpośrednimi potomkami. To dwie części krawędzi spływu (jedna z 

wnęki lotki, druga sponad klapy) i kołnierz otworu na koło główne. Takie położenie w hierarchii modelu tych 

trzech szczegółów skrzydła jest oczywiste – dwa z nich wyglądają jak kontynuacja jego powierzchni. 

Teraz skopiujemy modyfikator Mirror skrzydła (obiektu B.100.L.Wing) na jego obiekty potomne: 

1. Widoczność kolekcji w 3.Wing powinna być ustawiona tak, jak pokazuje to Rysunek 5.8.10. Dodatkowo 

ukryj kolekcję 1.Blueprints (niewidzialne obiekty nie będą zaznaczone w następnym kroku). 

2. Zaznacz obiekt B.100.L.Wing i wywołaj Select→Select Grouped→Children. To wyklucza z selekcji 

skrzydło I zaznacza jego wszystkie widoczne obiekty potomne. Powinno ich być 32 (sprawdź licznik). 

3. Dołącz do tego zaznaczenia B.100.L.Wing (ma stać się obiektem aktywnym). Z menu kontekstowego 

jego modyfikatora Mirror wywoła polecenie Copy to Selected (por. str. 573). 

Rysunek 5.8.11 pokazuje rezultat tego polecenia: 

 

Rysunek 5.8.11 Kompletna „lustrzana kopia” lewego skrzydła 

 

1 Przypisaliśmy je jako obiekty potomne obiektu skrzydła na str. 330 (krok 1). W tamtym momencie to miało sens, gdyż przesuwaliśmy te 

obrazy wraz ze skrzydłem. Teraz ich obecność wśród bezpośrednich „potomków” obiektu skrzydła czyni tę listę mniej czytelną. 

Obiekty 
pierwszego 

poziomu  

Kompletne prawe skrzydło, wygenerowane 
przez skopiowane modyfikatory Mirror 
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W przyszłości zastąpimy tą „wygenerowaną” prawa lotkę jej klonem, a jej oś – nowym obiektem. To będzie nie-

zbędne do wizualizacji różnicowych wychyleń lotek P-40.  

Jednak już ruch klap do lądowania może być obsłużony przez modyfikatory Mirror. Gdy obrócisz lewy zawias 

(obiekt B.200.L.Flap Hinge) wokół jego lokalnej osi Z, uzyskasz prawidłowe wychylenie obydwu klap, pokazy-

wane przez Rysunek 5.8.12: 

 

Rysunek 5.8.12 Symetryczne uchylenie klap skrzydła 

 

Podsumowanie 

• W tej sekcji użyliśmy dwóch nowych poleceń selekcji, opartych na hierarchii obiektów: Immediate Children 

(str. 228) i Children (str. 232). Dowiedziałeś się także, jak skopiować modyfikator do wszystkich zaznaczo-

nych obiektów poleceniem Copy to Selected (str. 232). 

• Poprawiliśmy położenie pomocniczego obiektu bazy skrzydła (str. 228), a potem użyliśmy go do umiesz-

czenia skrzydła w miejscu docelowym (str. 229) oraz nadaniu mu odpowiedniego zaklinowania i wzniosu. 

Przycięliśmy także brzeg skrzydła przy płaszczyźnie symetrii samolotu (str. 229). 

• Stworzyliśmy nowy obiekt Empty o nazwie X.000.Base jak bazę hierarchii całego modelu (str. 230). Użyli-

śmy go w modyfikatorach Mirror, które dynamicznie generują prawe skrzydło (str. 230, 232). 

• Pogrupowaliśmy części zespołu skrzydła w nowe kolekcje (str. 231). W ten sposób zwiększamy czytelność 

całej sceny. Niektóre z tych kolekcji służą do eksponowania kluczowych obiektów (np. osi, zawiasów), które 

są ukryte gdzieś głęboko w hierarchii (parent/child) tego zespołu.  

 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-9.08.blend. 

  

Lustrzana kopia 
lewej klapy 

Lokalna oś Z 
lewego zawiasu 
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Rozdział 6. Usterzenie 

Tworząc usterzenie, będziemy używali tych samych metod, których użyliśmy tworząc skrzydła. Praca nad tym 

prostszym zespołem samolotu jest czymś w rodzaju „ćwiczeń dodatkowych”. Pozwala na ugruntowanie technik, 

które poznałeś w poprzednich rozdziałach. 

W tym rozdziale będę podawać wiele szczegółowych wymiarów z oryginalnej dokumentacji samolotu. To wyjąt-

kowy „luksus”: zazwyczaj w planach modelarskich brakuje informacji o profilach usterzenia, a także wielu innych 

szczegółów. W większości popularnych rysunków nawet grubość stateczników w rzucie z przodu pozostawia 

wiele do życzenia. 

 

 

 

 

 

 

 

 

 

 

Gdy budujesz model mniej udokumentowanego samolotu, musisz się opierać na zdjęciach. To mniej 

dokładna metoda „prób i błędów”. Możesz użyć informacji podanych w tym rozdziale na temat róż-

nych szczegółów technologicznych (jak promień zaokrąglenia krawędzi spływu, grubość użytych 

blach, szerokość kołnierzy żeber) jako przybliżeń podobnych wartości w innych konstrukcjach.  
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6.1 Statecznik poziomy 

W P-40, statecznik poziomy stanowił bazę całego usterzenia. Był montowany jako jedna całość i mocowany do 

kadłuba 8 śrubami, ukrytymi pod dolną częścią oprofilowania połączenia z kadłubem. Statecznik pionowy był 

mocowany do statecznika poziomego za pomocą kolejnych 8 śrub (Rysunek 6.1.1a). Ster wysokości i ster kie-

runku były mocowane do odpowiednich zawiasów w tych statecznikach: 

       

Rysunek 6.1.1 Szczegóły statecznika 

W rzucie z góry (Rysunek 6.1.1b) ten statecznik ma kształt trapezu zakończonego łukiem. „Globalną” bazą wy-

miarową tego zespołu jest oś steru wysokości, umieszczona 230 7/8” od przegrody silnika. „Wewnętrzną” bazą 

wymiarową tego statecznika jest płaszczyzna dźwigara (4 3/8” od osi steru wysokości). 

Rysunki Jumpei Temmy przedstawiają w rzucie z góry poprawny kontur tego statecznika. Na nieszczęście, jego 

rzuty z boku są mniej szczegółowe (Rysunek 6.1.2): 

  

Rysunek 6.1.2 Statecznik (rzut z boku) Rysunek 6.1.3 Współrzędne profili statecznika poziomego 

Rysunki poglądowe P-40 podają położenie w pionie osi steru (18 1/8”) i kąt zaklinowania statecznika poziomego 

(2º). W rzucie z boku Temmy widać kontur oprofilowania jego połączenia z kadłubem. Gdybyś ekstrapolował 

jego krawędź natarcia, otrzymasz całkiem dobre przybliżenie profilu statecznika w płaszczyźnie symetrii kadłu-

ba (stacji 00). Jednak brakuje tu informacji o profilu w stacji 64 (por. Rysunek 6.1.1b).  

To typowy problem, który napotkasz w większości samolotów. Wspominam o nim w rozdziałach o rysunkach 

referencyjnych (por. Tom I, sekcja 4.1). Kontury statecznika z rzutów z przodu i z tyłu autorstwa Temmy nie do-

starczają żadnej wskazówki o jego grubości w stacji 64, bo są obrócone o kąt zaklinowania. W takim przypadku 

można tylko przybliżyć ten profil, proporcjonalnie zmniejszając profil ze stacji 00. 

Na szczęście, w przypadku P-40 zachowała się oryginalna dokumentacja. Rysunek 6.1.3 przedstawia tabelę 

współrzędnych z rysunku 75-11-012. W jej ostatnim wierszu jest także promień krawędzi natarcia (LER). 
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Profile stateczników są symetryczne, więc tabela (Rysunek 6.1.3) podaje współrzędne ich górnych obrysów. To 

część dokumentacji P-36. Zaznaczyłem na niej kolumny ze współrzędnymi profili w stacjach 00 i 64. Odtworzy-

łem tam także wiele wyblakłych fragmentów (oznaczone na czerwono) korzystając z podobnego rysunku z P-40 

(87-11-512). Ten rysunek P-40 był mniej przydatny, bo nie zawierał profilu stacji 64. 

Opis powyżej tabeli – „współrzędne mierzone wewnątrz poszycia, na zewnątrz dźwigarów i żeber” – sygnalizuje 

typową konwencję, stosowaną w przemyśle lotniczym połowy XX w. Różnica wydaje się minimalna w przypadku 

skrzydła (z wyjątkiem jego krawędzi spływu). Jednak dla dużo mniejszego (i cieńszego!) statecznika grubość 

typowego arkusza blachy (0.03”) może mieć znaczący wpływ na niektóre elementy geometrii. Na przykład – na 

efektywny promień zaokrąglenia krawędzi natarcia, szczególnie w stacji 64. 

Wykorzystując współrzędne z tabeli (Rysunek 6.1.3) przygotuj dwa pomocnicze obiekty: to wzorcowe żebra dla 

stacji 00 i 64 (Rysunek 6.1.4). To niewygładzone wieloboki – każdy z ich wierzchołków odpowiada współrzędnej 

z tabeli, poprawionej o grubość poszycia (0.03”)1. Obydwa wzorcowe żebra są potomkami obiektu Empty o 

nazwie X.300.Stabilizer.Base. To baza całego tworzonego w tej sekcji zespołu statecznika. Umieść go na prze-

cięciu osi obrotu steru wysokości i płaszczyzny symetrii samolotu. Początkowo ustaw ten obiekt bazowy „na 

płasko”, czyli bez obrotu o kąt zaklinowania. Obrócimy go o te 2º później, gdy statecznik będzie gotowy. 

Rysunek 6.1.4 pokazuje te początkowe ustawienia, a także nowy zespół kolekcji (4.Empennage i jej podfolde-

ry), które przygotowałem dla statecznika w oknie Outliner:  

 

Rysunek 6.1.4  Wzorcowe żebra i baza statecznika (obiekt Empty)  

Uformowałem krzywą podziałową (łuk) wzdłuż końcówki tego statecznika (Rysunek 6.1.5a). Pozwoliło mi to 

określić liczbę i położenie wierzchołków potrzebnych do odtworzenia tego konturu: 

             

Rysunek 6.1.5  Kształtowanie konturów końcówki i żebra 00  

Znając tę liczbę (11), stworzyłem gładki kontur sekcji 00 (Rysunek 6.1.5b). Dolna część tego symetrycznego 

profilu jest wygenerowana przez modyfikator Mirror (umieszczony przed modyfikatorem Subdivision) 

 
1 Aby stworzyć prostszą wersję tego statecznika, można obrysować gładkim konturem żebro bazowe z rysunku Jumpei Temmy (Rysunek 

6.1.2). Potem stwórz żebro sekcji 64 poprzez zmniejszenie (Scale) żebra 00. Użyj do tego cięciwy i wysokości z tabeli (Rysunek 6.1.4). 
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Stwórz kontur pokazywany przez Rysunek 6.1.5b) tak, jak to zrobiliśmy na str. 131 - 135. Nazwij ten nowy 

obiekt B.300.L.Stabilizer i przypisz go jako potomka obiektu X.300.Stabilizer.Base. 

W kolejnym kroku, wyciągnij ten kontur wzdłuż osi X do sekcji 64. Zmniejsz (Scale) tę nową sekcję, dopasowu-

jąc ją do wzorcowego żebra 64 (Rysunek 6.1.6a) : 

 

Rysunek 6.1.6  Wyciągnięcie podstawowej, trapezowej części statecznika  

Zrób to tak samo, jak na str. 136 - 137. Rysunek 6.1.6b) pokazuje zbliżenie krawędzi natarcia w stacji 64: po 

analizie rysunków wykonawczych statecznika odkryłem, że w tym punkcie nakładają się na siebie 3 panele po-

szycia. Ich sumaryczna grubość znacznie zwiększa efektywny promień krawędzi natarcia: z 0.07” do 0.12”. 

Stwórz w siatce pomocniczej krzywej konturu końcówki (Rysunek 6.1.5a) prosty profil poprzeczny (Rysunek 

6.1.7a). Wyciągaj tę krawędź, obracając kolejne nowe sekcje wokół środka łuku końcówki (Rysunek 6.1.7b). 

Umieszczaj koniec każdej nowo utworzonej sekcji tego dysku  (wierzchołek D) ponad jednym z wierzchołków 

oryginalnej krzywej. Pozostaw miejsce na ostatni fragment krawędzi natarcia (Rysunek 6.1.7c):  

       

         

Rysunek 6.1.7  Formowanie dysku końcówki  

Gdy dysk jest uformowany, usuń oryginalną krawędź krzywej i połącz ten obiekt ( Ctrl - J ) z B.300.Stabilizer. 

Następnie obróć krawędzie A i B wokół globalnych osi Z (Rysunek 6.1.7c) i X (Rysunek 6.1.7d), dopasowując 

kształt ostatniej sekcji dysku do konturu krawędzi natarcia w stacji 64. 

R 0.12 
Większy efektywny 
promień noska w 

stacji 64 

1. Wyciągnij do 
stacji 64 

2. Skaluj, by dopasować 
do wzorcowego żebra 

a) b) 

a) 

Y 

X 

X 
Z 

Środek łuku 

Stwórz taki profil 

0,0 

-0.5,0.23 

-0.05,0.11 

-0.17,0.14 

b) 
Środek obrotu:  
X: 58.27, Y: 226.44 

 

Wyciągaj i 

obracaj ( E , R ) 
Wierzchołki 

krzywej konturu 

A 

B 
C 

D 

c) 

Obróć krawędzie A i B, by dopa-
sować je do krawędzi natarcia 

Środek 
obrotu 

A 

B 

A B 

d) 

Środek 
obrotu 

 

X 

Obróć krawędzie A i B 
by podnieść ich końce Stacja 64 



238 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Domknij nowymi ścianami ( F ) lukę pomiędzy podstawą końcówki w stacji 64 i jej brzegiem (Rysunek 6.1.8a). 

Użyj Knife (por. str. 532) by naciąć nową linię krawędzi na ścianach końcówki (Rysunek 6.1.8b), Gdy jest goto-

wa, zmień topologię tej siatki (wykorzystując polecenia Slide i Join, jak na str. 146-147), by wyeliminować z niej 

ściany trójkątne. Rysunek 6.1.8c) pokazuje końcówkę po tej modyfikacji: 

               

Rysunek 6.1.8  Domknięcie siatki końcówki statecznika 

Podnieś wierzchołki tej nowej linii krawędzi, przesuwając je wzdłuż globalnej osi Z (Rysunek 6.1.9): 

 

Rysunek 6.1.9  Formowanie konturu końcówki w płaszczyźnie ZX  

Umieść wierzchołki z krawędzi 6, 7 i 8 na przedłużeniu odcinków biegnących od stacji 00 do stacji 64 (por. Ry-

sunek 6.1.9). Nazywam je „głównymi segmentami” tych linii krawędzi. W przypadku linii krawędzi 3, 4, 5 – 

umieść ich wierzchołki około 0.1” poniżej ekstrapolacji ich głównych segmentów. 

Teraz warto wywołać polecenie Normals→Recaluclate Outside. Ustaw cieniowanie na Auto Smooth, nadaj po-

wierzchni grubość (modyfikator Solidify: Offset: -1, Thickness: 0.03). Obejrzyj uzyskany kształt pod różnymi 

kątami, poszukując jakichś podejrzanych cieni (Rysunek 6.1.10): 

 

Rysunek 6.1.10  Sprawdzanie uzyskanego kształtu  

a) b) c) 
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Przytnijmy tylna krawędź tego statecznika:  

1. Stwórz w 4a.Stabilizer nową kolekcję, o nazwie 4a8.Booleans. 

2. Stwórz w kolekcji 4a8.Booleans płaszczyznę (Rysunek 6.1.11a). Na rysunku podaję globalne współ-

rzędne X,Y jej wierzchołków, ponieważ na rysunkach Temmy kontur tego wycięcia odbiega nieco od 

wymiarów podanych w dokumentacji. 

3. Aby uniknąć kłopotów z operacją Boolean, przesuń wierzchołki A, B, C wzdłuż globalnej osi X o +0.001. 

4. Wyciągnij te ściany w „bryłę tnącą” (Rysunek 6.1.11b). 

5. Nazwij ten pomocniczy obiekt U.300.L.Cutout i przypisz jako obiekt potomny do X.300.Stabilizer.Base. 

6. Dodaj do B.300.L.Stabilizer modyfikator Boolean (Difference), i przypisz do niego U.300.L.Cutout jako 

obiekt „tnący”. W tym przypadku używaj metody Fast: 

        

Rysunek 6.1.11  Tworzenie wycięcia w stateczniku  

W oryginalnym samolocie to wycięcie było zamknięte przez dwa żebra i dwa dźwigary. W naszym modelu połą-

czymy widoczne części tych szczegółów w jeden obiekt:  

1. Użyj wtyczki Intersect (por. str. 482) do wyznaczenia krawędzi przecięcia ścian obiektów 

U.300.L.Cutout i B.300.L.Stabilizer (Rysunek 6.1.12a). 

2. Wydziel tę nowo utworzoną krawędź w nowy obiekt. Nazwij go B.305.L.Cutout.Ribs (siatka: 

B.305.Cutout.Ribs) i przenieś do kolekcji 4a.Stabilizer. 

3. Wytłocz tę krawędź wzdłuż globalnej osi Z. Spłaszcz jej wytłoczoną krawędź skalując jej wierzchołki 

wzdłuż globalnej osi Z do 0. Potem przesuń je na płaszczyznę symetrii statecznika (Z=18.125). 

4. Dodaj do obiektu B.305.L.Cutout.Ribs modyfikator Mirror (tworzy symetryczne „lustrzane odbicie”). 

5. Dodaj także modyfikator Subdivision Surface, ustaw w krawędziach narożników Crease = 1 i dopasuj 

kontury tych ścian do wewnętrznej strony powierzchni obiektu B.300.Stabilizer (Rysunek 6.1.12b): 

        

Rysunek 6.1.12  Zamykanie wycięcia  
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Teraz podzielmy te ściany na powierzchnie żeber i dźwigara:  

1. Dodaj modyfikator Solidify (Thickness: 0.025) do obiektu B.305.L.Cutouts.Rib. Ustaw kierunek nor-

malnych jego ścian na zewnątrz. Ustaw Solidify:Offset na -1. 

2. Rozdziel (Rip) wierzchołki narożnikach, i wyciągnij je w kołnierze pokazane przez Rysunek 6.1.13a). 

3. Przesuń elementy 1, 2 i 3 do wnętrza statecznika. Wyciągnij z nich trzy krawędzie pionowe krawędzie i 

wydłuż przeciwległe ściany, tworząc w narożnikach połączenia „na zakładkę” (Rysunek 6.1.13b). 

4. Wyciągnij kołnierze ze wszystkich górnych (poziomych) krawędzi. Dopasuj ich ściany do wewnętrznej 

powierzchni statecznika (Rysunek 6.1.13c). Podczas dopasowywania ukryj pozostałe ściany. 

5. Zaokrąglij krawędzie tych elementów modyfikatorem Bevel (Width Type: Offset, Amount: 0.125, 

Segments: 5). Umieść go powyżej modyfikatora Mirror. Rysunek 6.1.13d) pokazuje rezultat. Zwróć 

uwagę na topologię siatki odtwarzającej narożniki tych żeber. Jedną z jej ścian jest n-gon:      

      

      

Rysunek 6.1.13  Formowanie żeber i dźwigara końcówki  

W rysunkach wykonawczych końcówki zauważyłem, że jeden z wewnętrznych narożników wycięcia była zao-

krąglony (R=5/8”). By to odtworzyć, dodaj modyfikator Bevel (Weight) do obiektu „tnącego” (U.300.L.Stabilizer). 

Rysunek 6.1.14 pokazuje ten zespół w oknie 3D i zawartość kolekcji 3.Empennage w oknie Outliner: 

 

Rysunek 6.1.14  Gotowa końcówka  
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Trapezowa część statecznika była zamknięta dodatkową osłoną. Odtwórzmy ją z ostatniej ściany siatki:  

1. Skopiuj i wydziel ostatnią ścianę pomiędzy stacją 00 i stacją 64 (Rysunek 6.1.15a). Nazwij ten obiekt 

B.310.L.Web i przypisz jako potomka do X.300.Stabilizer.Base. Przypisz mu materiał Artificial.Green. 

2. Przejdź do Object Mode, zaznacz B.310.L.Web i usuń wszystkie modyfikatory oprócz Mirror i Solidify. 

3. Przesuń (Slide) jego przednią krawędź, tworząc wzdłuż tylnej krawędzi statecznika pasek o szerokości 

3/4” (Rysunek 6.1.15a). Obniż go o 0.03 (grubość poszycia). Wyciągnij z przedniej krawędzi pionową 

ścianę, umieszczając końce jej dolnej krawędzi na Y (lokalnym) = 0 (Rysunek 6.1.15b). 

4. Ustaw Bevel Weight krawędzi |AB| na 1, przesuń wierzchołek A wzdłuż globalnej osi Y o -0.52. 

5. Dodaj modyfikator Bevel (Weight) (Width Type: Width, Amount: 0.9, Segments: 5). To zaokrągli bazową 

sekcję tej ściany (R = 29/16”). Umieść ten modyfikator przed modyfikatorem Solidify. 

6. Dodaj modyfikator Bevel (Angle) (Width Type: Offset, Amount: 0.125, Segments: 5). Umieść ten mody-

fikator przed modyfikatorem Solidify. Ten Bevel zaokrągli krawędzie wewnętrzne (Rysunek 6.1.15c). 

         

Rysunek 6.1.15  Formowanie ściany zamykającej statecznik od tyłu  

Uformuj na końcu tej ściany przyłącze do żebra 64 (Rysunek 6.1.16a). Zrób to w ten sam sposób, jak pokazuje 

Rysunek 6.1.13d). Odtwórz niewielkie wycięcie u podstawy statecznika (Rysunek 6.1.16b). Dodaj w tym celu do 

siatki U.300.Cutout kolejną zamkniętą bryłę. Na ilustracji poniżej podaję jej kluczowe współrzędne. Dodaj do 

obiektu B.310.L.Web modyfikator Boolean (Difference), który używa obiektu U.300.L.Cutout:  

       

Rysunek 6.1.16  Szczegóły zamknięcia statecznika  

Rysunek 6.1.16b) pokazuje także obiekt dźwigara (B.315.L.Beam). Stworzyłem go w ten sam sposób, co 

B.310.L.Web. Ten dźwigar był prostszy: jego pionowe ściany były płaskie, więc nie użyłem tu modyfikatora 

Bevel (Width) (Rysunek 6.1.15c). B.315.L.Beam nie potrzebuje także modyfikatora Boolean. 
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W wycięciu pokazanym przez Rysunek 6.1.16c) nie umieszczamy żeber, bo nie były w nim widoczne. 

Na koniec dodaj do każdego widocznego elementu tego statecznika dodatkowy modyfikator Mirror, który tworzy 

jego kopię po przeciwnej stronie płaszczyzny symetrii samolotu (Rysunek 6.1.17):  

 

Rysunek 6.1.17  Gotowy statecznik poziomy  

Gdy dodasz taki modyfikator do pierwszego obiektu, szybko „rozpropaguj” go wśród pozostałych części sta-

tecznika poleceniem Copy to Selected (z menu kontekstowego modyfikatora), tak jak to zrobiliśmy na str. 232. 

Statecznik poziomy jest gotowy (na razie). Otwory w tylnej ścianie wygenerujemy później, za pomocą tekstur. 

Podczas fazy uszczegóławiania odtworzymy jeszcze okucia zawiasów steru wysokości. 

  

Podsumowanie 

• W tej sekcji używaliśmy głownie technik poznanych w poprzednich rozdziałach. Jedynym nowym narzę-

dziem był dodatek Intersect. Implementuje on alternatywne polecenie znajdujące krawędź przecięcia 

dwóch obiektów (str. 239). 

• Zaczęliśmy modelowanie tego statecznika korzystając z widoku z góry i dwóch pomocniczych profili, od-

tworzonych z oryginalnych współrzędnych (str. 236). Stworzyliśmy pomocniczą krzywą wokół końcówki, 

aby określić liczbę i położenie potrzebnych węzłów siatki (str. 236), po czym użyliśmy tej liczby wierzchoł-

ków do stworzenia konturu bazowego żebra. Ten kontur został następnie wyciągnięty w trapezoid (str. 

237). Zaczęliśmy formować „dysk” końcówki statecznika modelując jego zaokrąglone brzegi (str. 237). Po-

tem zamknęliśmy tę siatkę i nacięliśmy dodatkową linię krawędzi w środku tych nowo dodanych ścian. Ta 

dodatkowa krawędź pozwoliła nam dopasować kontur statecznika w widoku z przodu (str. 238). 

• Wycięcie w stateczniku wykonaliśmy za pomocą pomocniczego obiektu i modyfikatora Boolean (str. 239). 

Krawędź przecięcia tych dwóch obiektów stała się podstawą do stworzenia zamykających żeber i dźwigara 

(str. 239, 240). Tylna ściana i dźwigar, zamykające ten statecznik, zostały uformowane ze ściany skopio-

wanej z siatki poszycia statecznika (str. 241). 

• Pogrupowaliśmy części usterzenia w nowe kolekcje (str. 236, 239). Dodaliśmy także do tego zespołu obiekt 

bazowy (Empty), o nazwie X.300.Stablizer.Base (str. 236). 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-10.01.blend. 

  

Prawa strona, 
wygenerowana 
przez ten mo-

dyfikator   
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6.2 Ster wysokości 

W modelarskich seriach zdjęć „z obchodu” P-40 znajdziesz wiele ujęć steru wysokości. Rysunek 6.2.1 pokazuje 

jedno z nich, pochodzące z portalu cybermodeler.com: 

 

Rysunek 6.2.1  Ster wysokości P-40  

Zastosowano tu klasyczną konstrukcję dla tego okresu: metalowy szkielet kryty płótnem, z klapką trymera i wy-

ważeniem masowym1. Klapka trymera miała poszycie z duralu.   

Rysunek 6.2.2 pokazuje szczegóły geometrii steru wysokości w widoku z góry:  

 

Rysunek 6.2.2  Geometria steru wysokości (w rzucie z góry)  

Bazą wymiarową steru jest oś obrotu. Kontur jego końcówki jest kontynuacją łuku końcówki statecznika. Obrys 

środkowego segmentu steru jest krzywą o większym promieniu. Omawialiśmy już ten kształt w poprzedniej czę-

ści, poświęconej rysunkom referencyjnym (por. Tom I, sekcja 5.3). Na rysunkach Jumpei Temmy ten zespół jest 

odwzorowany poprawnie – zauważyłem tylko minimalne odchylenia, które zaznaczyłem na ilustracji powyżej. 

Opis geometrii rzutu z góry jest kompletny i wydaje się dokładny, ale na planach brak jest informacji o profilach 

steru wysokości. W większości samolotów możesz je „ekstrapolować” z profili statecznika (próbowałem to robić 

w pierwszej części, por. Tom I). W przypadku P-36 to byłoby OK, ale w P-40 Curtiss zmodyfikował profile steru 

wysokości2: pogrubił je o 15% i usunął z krawędzi natarcia brzegową kompensację aerodynamiczną.   

 
1 Ten wysunięty do przodu fragment krawędzi natarcia kompensował także częściowo siły aerodynamiczne, działające na ster. 

2 Choć za przegrodą silnika obydwa płatowce – P-36 i P-40 – wydają się być identyczne, to w powierzchniach sterowych XP-40 wprowa-

dzono wiele drobnych modyfikacji. Te zmiany uczyniły seryjne P-40 bardziej zwrotnymi przy większych prędkościach. Jest to opisane w tym 

raporcie NACA z sierpnia 1942, porównującego prędkość pochylenia P-36, P-40, Hurricane i Spitfire (por. wykres na jego ostatniej stronie). 
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W tym przypadku szczegółowe zdjęcia nie pomogą. Dla takiego dużego, płaskiego obiektu, nie widać na nich 

nawet różnicy w grubości sterów wysokości pomiędzy P-36 i P-40. Jedynym możliwym źródłem informacji jest 

dokumentacja producenta1. Mamy szczęście, że została zachowana! Zestawiłem podane w niej wymiary w po-

staci pomocniczych wzorcowych żeber (tak jak to zrobiliśmy w stateczniku poziomym). Zacznijmy formowanie: 

1. W kolekcji 4.Empennage stwórz dwie nowe kolekcje, o nazwach 4b.Elevator i 4y.Handles. Wewnątrz 

4b.Elevator stwórz kolejną kolekcję: 4b9.Auxiliary. 

2. W (X:3.75, Y:230.875, Z:18.125) stwórz obiekt Empty, o nazwie X.350.Elevator.Base. To będzie po-

czątek hierarchii steru wysokości. Umieść go w kolekcji 4z.Bases, i podłącz ( Shift - M , por. str. 451) do 

kolekcji 4y.Handles. Przypisz X.350.* jako obiekt potomny do obiektu X.300.Elevator.Base.  

3. Wykorzystując wymiary podane przez Rysunek 6.2.3, stwórz wzorcowe żebra, nazwij je jak na ilustracji 

poniżej i umieść w kolekcji 4b9.Auxiliary. Przypisz je jako obiekty potomne do X.350.Elevator.Base. 

   

            

Rysunek 6.2.3  Pomocnicze wzorce żeber steru wysokości  

Jak widzisz, odtworzyłem tylko kluczowe żebra. Środki promieni ich krawędzi natarcia leżą na osi obrotu steru, 

oprócz żebra ze stacji 69 7/16. Współrzędne profili są podane w stałych odstępach (1” do każdego kolejnego 

punktu). Stworzyłem także wzorcowy dźwigar łącząc punkty żeber umieszczone +1” od osi obrotu2. Zewnętrzne 

żebra (ze stacji 63 5/8 i 69 7/16) są umieszczone po obydwu stronach wysuniętej przeciwwagi. Krawędź natarcia 

tej przeciwwagi uformujemy oddzielnie (na razie nie tworzę jej żebra). 

Wszystkie wymiary w ilustracji powyżej są podane bez grubości poszycia. Dla tego steru możesz założyć, że 

było to 0.025”. Gdy stworzysz te żebra, możesz wyciągnąć z ich krawędzi dodatkowy pasek ścian tej szeroko-

ści, jak to zrobiliśmy w przypadku żeber statecznika (str. 236). Zrób to tylko dla żeber ze stacji 3.75 i 9.17, oraz 

dla krawędzi natarcia żeber ze stacji 63 5/8 i 69 7/16. Pozostałe obszary steru były pokryte płótnem. 

 
1 Rysunki nr: 87-13-501, 87-13-032, 87-13-033, 87-13-517, 87-13-016, 87-13-913, 87-13-028, 87-13-026, 87-13-018, 87-13-025. 

2 W tym miejscu steru wysokości naprawdę znajdował się jego dźwigar.  
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https://app.aircorpslibrary.com/drawing/viewer/87-13-501/
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Możesz także dodatkowo odtworzyć kluczowe linie oprofilowania statecznika, jakie pokazuje Rysunek 6.2.4. To 

nie jest niezbędne, ale takie drobne wzorce zwiększą dokładność Twojego modelu:  

      

Rysunek 6.2.4  Elementy wzorcowe oprofilowania steru  

To oprofilowanie było zamknięte przez ukośny „dźwigar”. Do odtworzenia wzorców pokazywanych przez Rysu-

nek 6.2.4 użyłem wymiarów z arkusza 87-13-033. Rysunek 6.2.5 pokazuje jego kluczowe fragmenty. Zaznaczy-

łem na nich na czerwono i niebiesko mniej czytelne wymiary oraz błąd wymiarowy na końcu „dźwigara”:   

 

    

Rysunek 6.2.5  Wymiary oprofilowania steru wysokości  

Dobrym pomysłem jest także dodać do tych wzorców skan rysunku steru z p40warhawk.com. Nazwij go 

R.Elevator, umieść w kolekcji 1.Blueprints, i dopasuj do linii osi i łuków pokazanych przez Rysunek 6.2.2:  

 

Rysunek 6.2.6  Pomocnicze okręgi i oryginalny rysunek steru 
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Zacznij siatkę tego steru od obrysowania jego konturów krzywymi podziałowymi: wzdłuż krawędzi spływu 

(Rysunek 6.2.7a), żeber i podstawy dźwigara (Rysunek 6.2.7b). Użyj modyfikatora Mirror wzdłuż osi Z:  

  

   

Rysunek 6.2.7  Tworzenie początkowych krzywych konturu 

Rysunek 6.2.7c) pokazuje cztery wierzchołki tworzące zaokrąglenie na krawędzi spływu żebra. To podobny 

kontur do użytego przez nas w „obramowaniu” końcówki statecznika (por. str. 237). Możesz odtworzyć ten 

szczegół korzystając z „kratek” (w tle tego rysunku) do określenia odległości pomiędzy wierzchołkami. 

Korzystając z punktów sterujących tych konturów, mogłem zaplanować topologię tej siatki (Rysunek 6.2.8):  

 

Rysunek 6.2.8  Szkic planowanej topologii siatki 

Pomimo zaokrąglonej krawędzi spływu, środkowa część tego steru jest trapezowa, jak statecznik czy skrzydło. 

Tworząc taki szkic, możesz zawczasu wykryć i wyeliminować potencjalne problemy, które utrudniłyby dalszą 

pracę. Na przykład – scaliłem wierzchołki A i B (Rysunek 6.2.7b) w jeden (por. Rysunek 6.2.8). Ta zmiana spo-

woduje tylko minimalne (tj. akceptowalne) odchylenie konturu dźwigara. Dzięki niej mogłem usunąć z siatki nie-

potrzebną linię krawędzi. 
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Stwórzmy teraz środkową część tego steru:  

1. „Obrysuj” krzywą kontur żebra ze stacji 63 5/8 (Rysunek 6.2.9a). Tworząc tę linię krawędzi, użyj tej sa-

mej liczby wierzchołków jak w konturze ze stacji 19, i wierzchołków z przedniej części okrągłego kontu-

ru ze stacji 3.75. 

2. Połącz odpowiednie wierzchołki w tych konturów ścianami (Rysunek 6.2.9b). Pozostaw przerwę ponad 

linią osi steru (zamkniemy ją później):   

     

Rysunek 6.2.9  Tworzenie podstawowego trapezoidu steru 

Teraz stwórz środkowe sekcje tej siatki, dopasowując ich końcówki do konturu krawędzi spływu: 

1. Wstaw nową sekcję (Loop Cut) i przesuń ją (Slide) naprzeciw najbliższego wierzchołka krawędzi spływu 

(Rysunek 6.2.10a). dziel w ten sposób tylko tylną część siatki, pozostawiając jej drugą część (z przodu 

osi steru) bez zmian. 

2. Przesuń ostatnie cztery wierzchołki tej sekcji wzdłuż globalnej osi Y, do odpowiadającego im wierzchoł-

ka na konturze krawędzi spływu (Rysunek 6.2.10b). 

3. Zaznacz wierzchołki (Rysunek 6.2.10c) i uczyń je współliniowymi. Użyj do tego celu polecenia 

Vertex→Align (por. str. 524). 

               

Rysunek 6.2.10  Wstawianie do siatki nowej sekcji („żebra”) 

Powtórz powyższe kroki (Rysunek 6.2.10) dla każdej sekcji „żebra” pomiędzy stacjami 19 i 63 5/8, zaplanowa-

nymi przez Rysunek 6.2.8. Sugeruję zacząć od jednego ze środkowych wierzchołków krawędzi spływu, a potem 

wstawiać kolejne sekcje z jego prawej i lewej strony. 

Nie przejmuj się w tym momencie, że wynikowa powierzchnia podziałowa w widoku z góry sięga poza kontur 

steru. Dopasuje się sama później, gdy wstawisz do siatki wszystkie zaplanowane sekcje. 
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Stwórzmy pierwsze ściany końcówki steru: 

1. Wyciągnij dwie nowe linie krawędzi, do stacji 64 5/8 i 69 7/16 (Rysunek 6.2.11a). 

2. Ustaw wierzchołki A, B, C, D współliniowo z „podłużnicami” środkowej części steru. (W ten sposób za-

chowujemy w widoku z przodu proste kontury jego centralnej, trapezowej części – aż do stacji 63 5/8). 

3. Dopasuj wynikową krawędź z wierzchołkami sterującymi G, H, I, J do wzoru żebra ze stacji 69 7/16.  

4. Stwórz dodatkową ścianę pomiędzy wierzchołkami D, E, F, J (Rysunek 6.2.11a). 

5. Stwórz dodatkowy kontur, złożony z 4 wierzchołków, wokół krawędzi natarcia żebra 69 7/16 (Rysunek 

6.2.11a). Zacznij od 12-bocznego okręgu, usuń jego dolną połowę, dopasuj jego promień do wzorcowe-

go żebra i usuń tylne 4 wierzchołki, pozostawiając łuk 90º.  

      

Rysunek 6.2.11  Wyciąganie pierwszych ścian końcówki 

6. Podziel krawędź |FJ| tworząc wierzchołek K. Połącz go z wierzchołkiem D (Rysunek 6.2.11b). Przesuń 

(Slide) te dwa wierzchołki wzdłuż ich krawędzi (z wyłączoną opcją Clamp), tworząc w widoku z góry z 

krawędzi |FK| i |KJ| obrys wypukły. Zachowaj oryginalny kierunek (w 3D) krawędzi |ED|! 

7. Wyciągnij ostatnie cztery wierzchołki krawędzi spływu sekcji 63 5/8 wokół końcówki (Rysunek 6.2.11b), 

w ten sam sposób, w jaki to zrobiliśmy w końcówce statecznika na str. 237.  

Teraz domknij brzeg końcówki, odtwarzając jej krawędź natarcia: 

1. Wyciągnij obrys krawędzi natarcia ze stacji 69 7/16 (4 wierzchołki) i zmniejsz tę nową krawędź (Scale) do 

promienia 0.1”, uzyskując kośny stożek (Rysunek 6.2.12a). 

2. Wstaw (Loop Cut) w ten stożek w stacji 73.2” nową sekcję (sekcja 2 – por. Rysunek 6.2.12a). 

3. Powiększ sekcję 2 wzdłuż globalnej osi Z (wspc.:1.5), tworząc w widoku z przodu zakrzywiony kontur 

krawędzi natarcia (Rysunek 6.2.12b). Jego kształt ma odpowiadać konturowi końca statecznika poz. 

4. Wstaw nowe sekcje 3 i 4 przy szczycie tej końcówki, w pobliżu wierzchołków A i B (Rysunek 6.2.12b). 

5. Dopasuj wysokości sekcji końcówki i wierzchołków A, B, C, sprawdź, czy normalne ścian są skierowane 

na zewnątrz. Połącz je nowymi ścianami ( F ), tworząc zaokrąglony koniec (Rysunek 6.2.12c): 

           

Rysunek 6.2.12  Domykanie brzegu końcówki steru 
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Gdy brzegi końcówki są gotowe, możemy ją zamknąć:   

1. Stwórz ściany w środku końcówki steru (Rysunek 6.2.13a). Zauważ, że gdy powstały, żebro 69 7/16 za-

częło wystawać ponad powierzchnię poszycia. Za chwilę to poprawimy.   

2. Natnij nową krawędź w środku nowo utworzonych ścian, zaczynając od linii osi steru w stacji 73.2 (por. 

Rysunek 6.2.13b). Zrób to za pomocą narzędzia Knife. 

3. Zamknij przestrzeń przy krawędzi spływu, tworząc dwie nowe ściany (Rysunek 6.2.13b). 

4. Podnieś (przesuń wzdłuż globalnej osi Z) wierzchołki dwóch linii krawędzi zaznaczone przez Rysunek 

6.2.13b), dopasowując poszycie do górnego konturu żebra 69 7/16. 

5. Zamknij lukę za krawędzią natarcia tworząc dwie nowe ściany (Rysunek 6.2.13c). 

6. Zwiększ współczynnik Crease krawędzi natarcia wokół żebra 69 7/16 (Rysunek 6.2.13c). 

7. Wyprostuj trzy krawędzie wskazane przez Rysunek 6.2.13c), tak jak to zrobiliśmy na str. 247. (Ta część 

końcówki była pokryta płótnem, bez wewnętrznych żeber, więc te ściany nie mogą być wypukłe).   

      

      

Rysunek 6.2.13  Zamykanie końcówki steru 

Rysunek 6.2.13d) pokazuje uzyskaną powierzchnię końcówki steru. Wystającą przeciwwagę dodamy w dalszej 

części tej sekcji. 

Teraz czas pokryć okolice oprofilowania. Zacznij od wyciągnięcia paska wzdłuż dźwigara (Rysunek 6.2.14):  

      

Rysunek 6.2.14  Wyciągnięcie paska poszycia wzdłuż dźwigara 

a) b) 

c) d) 

Widok perspektywiczny 

Stwórz te 
ściany 

Żebro 69 7/16 wystaje 
ponad wynikową po-
wierzchnię podziałową 

1. Natnij tę 
krawędź za 

pomocą Knife 
 

2. Stwórz te 
dwie ściany 

3. Podnieś te kra-
wędzie by zasłonić 
żebro 69 7/16 
 

Stwórz te 
ściany 

 Crease: 1 

 Crease: 0.5 

Wyprostuj te 
krawędzie 

Powierzchnia 
wynikowa 

1. Wyciągnij 
tę krawędź 2. Użyj trybu skoku Vertex 

( Ctrl ) by umieścić wierzchoł-

ki (A, B) w tych punktach 

Kontur 
wokół 

Sta 3.75 

Kontur wokół 
dźwigara steru A  

B
  

“Dźwigar” 

“Dźwigar” 
oprofilowania 



250 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

W narożniku oprofilowania steru i zebra 3.75 nakładają się na siebie trzy z konturów przygotowanych na str. 

246. Ich wierzchołki nie pasują do siebie (mają różne współrzędne Z – por. Rysunek 6.2.14). Dlatego, zanim 

zaczniemy wstawiać nowe ściany, trzeba ten obszar „uporządkować”. Użyłem trybu skoku Vertex by umieścić 

wierzchołki A i B, bo nie chcę scalać pomocniczego konturu dźwigara z poszyciem steru. Wystarczy wstawić 

(Loop Cut) w nowo utworzony pasek dwie krawędzie w stacjach 7.40 (|CD|) i 9.17 (|EF|) (Rysunek 6.2.15a). 

Potem usuń ten kontur dźwigara. Usuń także pierwsze dwa wierzchołki z „dźwigara” oprofilowania, które znaj-

dują się pod A i B (Rysunek 6.2.15b). W przypadku wierzchołka z konturu stacji 3.75 – scal go ( M ) z wierzchoł-

kiem B (ten kontur włączymy do finalnej siatki): 

        

Rysunek 6.2.15  Uporządkowanie topologii siatki wokół podstawy steru  

Gdy to zrobiłeś, możemy kontynuować:  

1. Stwórz kolejny rząd ścian pomiędzy stacją 19 i konturem „dźwigara” oprofilowania (Rysunek 6.2.16a). 

2. Podziel krawędź |GH|, tworząc nowy wierzchołek I (Rysunek 6.2.16a). 

3. Połącz wierzchołki D i I: w odpowiedzi Blender stworzy krawędź, która przecina cztery inne krawędzie 

występujące pomiędzy tymi punktami. Na jednym z tych przecięć znajduje się J (Rysunek 6.2.16b).  

4. Połącz wierzchołki F i J, tworząc trójkąt zaplanowany na szkicu topologii (Rysunek 6.2.8). 

Po tych krokach, twoja siatka powinna wyglądać tak, jak pokazywana przez Rysunek 6.2.16b): 

       

Rysunek 6.2.16  Tworzenie ścian pomiędzy oprofilowaniem i stacją 19  
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cia/obrotu/skali. Tryb Vertex (Rysunek 6.2.14) czasami przydaje się w poleceniach Move. Gdy trzy-

masz wciśnięty Ctrl , kursor “skacze” do najbliższego wierzchołka (może być w innym obiekcie).   
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Ukształtujmy teraz oprofilowanie: 

1. Obróć ostatnie cztery wierzchołki krawędzi sponad żebra 19, umieszczając je w wierzchołku A konturu 

steru (Rysunek 6.2.17a). Użyj jako osi tego obrotu środka wzorcowego okręgu R15 (por. Rysunek 6.2.6 

i Rysunek 6.2.2). Pozostaw bez zmian pozostałe wierzchołki, aż do Q (Rysunek 6.2.17a). 

2. Usuń ostatnie cztery wierzchołki linii krawędzi, która biegnie wzdłuż „dźwigara” oprofilowania (są w po-

bliżu wierzchołka A – por. Rysunek 6.2.17a). Nie będziemy ich potrzebować w tej siatce. 

3. Wyciągnij i obróć ostatnie cztery wierzchołki linii krawędzi, która kończy się w A. Umieść je w następ-

nym punkcie sterującym krzywej konturu (B). Potem zrób to samo dla węzła C (Rysunek 6.2.17a). 

4. Stwórz trzy nowe ściany, łączące sekcję w puncie C z konturem biegnącym wokół żebra 3.75 (Rysunek 

6.2.17b). 

5. Powiększ (Scale) cztery wierzchołki zaznaczone przez Rysunek 6.2.17c) wzdłuż globalnej osi Z, pod-

nosząc ich najwyższe punkty do tych samych wysokości co odpowiadające im punkty na konturze opro-

filowania. By „dosunąć” te wierzchołki do konturu, skaluj je z zablokowaną osią Z. Dla każdej sekcji użyj 

jako środka transformacji jej pierwszego wierzchołka, który leży na płaszczyźnie symetrii steru1. 

6. Zamknij pierwszy „narożnik” tego oprofilowania dwoma nowymi ścianami (Rysunek 6.2.17c). 

     

          

Rysunek 6.2.17  Formowanie konturu oprofilowania w widoku z góry  

7. Wstaw (Loop Cut) nową sekcję w ściany oprofilowania i przesuń ją (Slide) do węzła D (Rysunek 

6.2.17d). Sprawdź, czy krawędzie |CD| i |DE| (Rysunek 6.2.17b) są współliniowe. Rysunek 6.2.17d) 

(prawa część) pokazuje, że ta sekcja uzupełnia kontur steru w widoku z góry. Końce następnych trzech 

zaplanowanych sekcji (str. 246) będą współliniowe. 

8. Powiększ nową sekcję wzdłuż globalnej osi Z, do poziomu konturu oprofilowania (Rysunek 6.2.17e). 

9. Stwórz nową ścianę siatki, zamykającą oprofilowanie do sekcji D (Rysunek 6.2.17e). 

 
1 Zaznacz dwa wierzchołki, które chcesz skalować, potem dodaj do tego zaznaczenia ostatni wierzchołek, który leży na płaszczyźnie syme-

trii (stanie się wierzchołkiem aktywnym). Ustaw tryb Pivot na Active Element, a potem skaluj te wierzchołki. 
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Zanim zamkniemy to oprofilowanie upewnijmy się co do stanu jego siatki u podstawy, w okolicy żebra 3.75. 

Wstaw tam w pobliżu węzła E, nową, dodatkową sekcję (Rysunek 6.2.18a). Ta linia krawędzi sięga aż do stacji 

19. Nie istniała na moim oryginalnym szkicu (por. Rysunek 6.2.8). Jednak „żaden plan nie przetrwa dłuższego 

kontaktu z rzeczywistością”. Ta modyfikacja jest potrzebna, aby dopasować wynikową powierzchnię podziałową 

do zakrzywionej podstawy dźwigara steru (Rysunek 6.2.18a):  

     

Rysunek 6.2.18  Zamykanie siatki oprofilowania steru  

Gdy obydwa końce oprofilowania pasują do konturów wzorcowych, możemy wstawić w jej środek trzy zaplano-

wane sekcje (Rysunek 6.2.18b). Zrób to tak samo, jak stworzyliśmy sekcję D (Rysunek 6.2.17d,e). Zacznij od 

krawędzi pośrodku, ponieważ to ułatwi dopasowanie pozostałych dwóch sekcji.    

Teraz zamknijmy lukę pomiędzy krawędzią natarcia i resztą siatki:   

1. Sprawdź normalne ścian krawędzi natarcia. Jeżeli mają inny zwrot niż reszta siatki – przestaw go.   

2. Wstaw (Loop Cut) nowe sekcje w krawędź natarcia. Przesuń (Slide) każdą z nich naprzeciw odpowied-

nich sekcji z głównej części siatki (Rysunek 6.2.19a). 

3. Stwórz „pasek” nowych ścian pomiędzy tymi dwoma fragmentami siatki (Rysunek 6.2.19b). 

     

Rysunek 6.2.19  Dołączanie siatki krawędzi natarcia do reszty steru 

Dodaj także w stacji 3.75 rozetę ze ścian. Rysunek 6.2.20 pokazuje siatkę steru po tej i innych modyfikacjach: 
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Zanim zaczniemy formować przeciwwagę steru, dodaj do tego obiektu modyfikator Solidify (Thickness: 0.025, 

Offset: -1). Potrzebujemy jej, ponieważ pozostawimy w niej otwór na zawias pomiędzy stacjami 63 5/8 i 64 5/8. 

(W tym szczególnym przypadku otwór uprości naszą siatkę).   

Stwórz teraz poszycie tej wysuniętej przeciwwagi, rozciągające się pomiędzy stacjami 64 5/8 i 69 7/16 (Rysunek 

6.2.21a). Uformuj tę siatkę wykorzystując podane poniżej wymiary (Rysunek 6.2.21b i c):  

   

Rysunek 6.2.21  Geometria przeciwwagi steru wysokości 

Jak widać, grubość poszycia waha się od 0.040” na krawędzi natarcia do standardowego 0.025” w środku. 

Gdy górna powierzchnia tej przeciwwagi jest gotowa, zmniejsz Crease krawędzi |AB| do 0 (por. Rysunek 

6.2.21a) i połącz ją z resztą siatki, tworząc nową ścianę. 

Stwórz żebro 69 7/16 (Rysunek 6.2.22a). Wyciągnij dwie krawędzie z górnej powierzchni i spłaszcz je skalując 

wzdłuż globalnej osi Z do 0. Potem umieść wierzchołki C, D, E na płaszczyźnie symetrii i stwórz zamykające to 

żebro ściany wokół C i E. Nie zapomnij, by oznaczyć jako ostry jego zewnętrznego konturu (Crease = 1): 

        

Rysunek 6.2.22  Formowanie przeciwwagi steru 

W podobny sposób uformuj żebro 64 5/8, ale odłącz (Rip) jego wierzchołki od reszty siatki. Szczegóły pokazuje 

Rysunek 6.2.22b), na którym ten odłączony fragment jest zielony. Naturalne kontury powierzchni podziałowej 

wokół otworu zawiasu są tak zbliżone do prawdziwych, że zdecydowałem się nie ryzykować ich popsucia po-

przez dołączenie nowych, prostopadłych ścian. W odłączonym żebrze zmniejszyłem zewnętrzne krawędzie o 

grubość poszycia (0.025). Dzięki temu lepiej pasują do otaczającej je powierzchni. 

 

Rysunek 6.2.21b) i c) podaje wymiary żeber (tj. bez poszycia). Współrzędne zewnętrznej powierzch-

ni uzyskasz dodając do nich grubość blach, także podanych na tych ilustracjach.    
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Otwór na zawias, wycięty w poszyciu, był położony bliżej osi steru niż pokazuje to Rysunek 6.2.22b). Jego wy-

miary podaje Rysunek 6.2.23a). Odtworzenie takiego kształtu w naszej siatce jest całkiem proste: 

1. Stwórz dodatkowy wierzchołek A na poszyciu steru w stacji 64 5/8 (Rysunek 6.2.23a). Powinien być 

umieszczony naprzeciw (tj. w tej samej współrzędnej Y) jak wierzchołek B ze stacji 63 5/8.    

2. Stwórz nową ścianę pomiędzy stacjami 63 5/8 i 64 5/8 (Rysunek 6.2.23b). 

3. Podziel krawędź |CD|, tworząc dwa nowe wierzchołki: E i F (Rysunek 6.2.23b). 

4. Połącz ( J ) wierzchołki E i F z G i H (Rysunek 6.2.23c). 

5. Możesz szybko nadać krawędzi tego otworu półokrągły kształt umieszczając krawędź |EF| w odpowied-

nim położeniu wzdłuż osi Y i nadając jej właściwą długość (Rysunek 6.2.23c). Położenie wzdłuż osi Y 

zmieniaj przesuwając (Slide), a długość krawędzi – skalując (Pivot: Bounding Box Center).   

         

Rysunek 6.2.23  Formowanie otworu na zawias steru 

Opcjonalnie, możesz uzyskać jeszcze lepsze przybliżenie łuku dodając dwa nowe wierzchołki, oznaczone na 

Rysunek 6.2.24a) jako L i K: 

     

Rysunek 6.2.24  Szczegóły otworu na zawias steru  

Wierzchołek K przekształca trójkąt stworzony przez wierzchołek A (por. Rysunek 6.2.23a) w czworokąt. Wierz-

chołek L przekształca regularną, czworokątną ścianę krawędzi natarcia w n-gon. Na szczęście, ta ściana jest 

tak wąska, że wpływ dodatkowego wierzchołka na wynikową powierzchnię podziałową jest znikomy. 

Sugeruję odtworzyć dwie ściany wewnętrzne, które zamkną przestrzeń tego otworu (Rysunek 6.2.24b): 

1. Żebro krawędzi natarcia w stacji 63 5/8. Stwórz je w ten sam sposób, w jaki stworzyliśmy żebro 64 5/8: 

jako odłączoną część siatki, dopasowaną do wewnętrznej strony poszycia steru (Rysunek 6.2.22b). 

2. Fragment dźwigara (Rysunek 6.2.24b). W rzeczywistości ten otwór był zamknięty od wnętrza ścianą 

dźwigara, stąd jej mały fragment był widoczny pomiędzy umieszczonymi z boków otworu żebrami. 

Jak widzisz na ilustracji powyżej, stworzyłem te trzy ściany jako jeden „kawałek” siatki, ponieważ wszystkie jego 

krawędzie zewnętrzne muszą być dopasowane do wewnętrznej strony poszycia steru. 
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Wytnij miejsce na klapkę trymera:  

1. Stwórz pomocniczy „obiekt tnący”: nazwij go U.350.L.Trim.Tab, przypisz do X.350.Elevator.Base. 

Umieść ten obiekt w nowej kolekcji 4b8.Booleans, stworzonej w kolekcji 4b.Elevator. 

2. Ustaw wysokość U.350.L.Trim.Tab na 6” (+/- 3”, względem płaszczyzny symetrii steru). Umieść prze-

ciwległe ściany tego „pudełka” w narożnikach podanych przez Rysunek 6.2.2 (str. 243). 

3. Wskaż go jako Object w modyfikatorze Boolean (Difference), dodanym do obiektu B.350.L.Elevator:  

 

Rysunek 6.2.25  Wycinanie miejsca (modyfikatorem Boolean) na klapkę trymera  

Teraz stwórz ramkę wokół tego otworu: 

1. Skopiuj (Duplicate) przednią ścianę U.350.L.Trim.Tab i wydziel ją w nowy obiekt o nazwie 

B.355.L.Tab.Frame. Przypisz go jako potomka do B.350.L.Elevator i umieść w kolekcji 4b.Elevator. 

2. Dodaj do tego obiektu modyfikatory Mirror, Subdivision Surface i Solidify (Thickness: 0.025), i prze-

kształć go w kształt pokazany przez Rysunek 6.2.26a). Dopasuj jego kołnierz do poszycia steru. 

3. Wyciągnij przednią ścianę U.350.L.Trim.Tab o -0.45” wzdłuż globalnej osi Y. To powiększa wycięcie, 

tworząc miejsce na kołnierz ramki B.355.L.Tab.Frame (Rysunek 6.2.26b). 

4. Zaokrąglij krawędź kołnierza (to zaokrąglenie widać na zdjęciach). Użyj do tego modyfikatora Bevel 

(Weight) (Width Type: Offset, Amount: 0.1, Segments: 5), umieszczając go pomiędzy modyfikatorami 

Mirror i Subdivision. Ustaw Bevel Weight linii krawędzi |AB| na 1 (Rysunek 6.2.26b). 

5. Stwórz z boków tej ramki dwie pionowe ściany (nie połączone z resztą siatki). Przekształć je w trójkątne 

żebra, takie, jakie pokazuje Rysunek 6.2.26c). 

6. Dopasuj te żebra do wewnętrznej strony poszycia steru (Rysunek 6.2.26d).  

      

      

Rysunek 6.2.26  Zamykanie wycięcia klapki  
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Moglibyśmy stworzyć tę ramkę wycięcia na trymer z trzech oddzielnych obiektów: tylnej ściany i dwóch żeber. 

Jednakże, te trzy części były na tyle proste, że zdecydowałem się je uformować „w jednym kawałku”.  

Stwórzmy teraz klapkę trymera: obiekt o nazwie B.360.L.Trim.Tab (jego wymiary pochodzą z rys. 87-12-003):  

1. Zacznij od stworzenia krzywej podziałowej wokół konturu krawędzi spływu (Rysunek 6.2.27a). Ustaw 

lokalny system współrzędnych tego obiektu wzdłuż osi klapki (pod kątem: -5.92º). 

2. Dodaj przed modyfikatorem Subdivison Surface modyfikator Mirror, i stwórz ściany dźwigara wzdłuż osi 

obrotu klapki (lokalnej osi X – por. Rysunek 6.2.27b). 

3. Wyciągnij cztery wierzchołki zaokrąglenia krawędzi spływu, umieszczając je w węzłach krzywej podzia-

łowej z kroku 1 (Rysunek 6.2.27c). 

4. Stwórz nowe ściany pomiędzy dźwigarem i krawędzią spływu, a potem wydziel dźwigar w nowy obiekt o 

nazwie B.365.L.Tab.Ribs (Rysunek 6.2.27d). Usuń Subdivision Surface z listy jego modyfikatorów. 

5. Wstaw (Loop Cut) nową linię krawędzi (1 na Rysunek 6.2.27e) i przesuń ją (Slide) do 9/32” od osi obro-

tu. Przesuń też do przodu (z Clamp:off) krawędź 3 o 9/32” od osi, i wstaw krawędź 2, potem obniż 3. 

6. Ustaw Bevel Weight krawędzi 1 i 2 na 0.5 i dodaj modyfikatory Bevel (Weight) i Solidify (0.020):   

       

               

               

Rysunek 6.2.27  Tworzenie klapki trymera  

7. Przesuń obiekt B.365.L.Tab.Ribs wzdłuż globalnej osi Y o +9/32” i dopasuj go do powierzchni klapki. 

Dodaj modyfikatory Bevel (Angle) (Amount: 0.1) i Solidify (Thickness: 0.030), a następnie stwórz ze-

wnętrzne żebro (Rysunek 6.2.27f). Zrób to tak samo, jak tworzyliśmy żebra statecznika (str. 240). 
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8. Skopiuj zewnętrzne żebro, potem przesuń je wzdłuż lokalnej osi X do wewnętrznej krawędzi klapki i do-

pasuj do dźwigara i poszycia (Rysunek 6.2.27g). 

9. Stwórz oś obrotu klapki. To prosty cylinder: Radius: 0.524”, długość: 24”, umieszczony w (globalnych) 

X: 17.75, Y: 247.04 i obrócony wokół osi Z o -5.92º (Rysunek 6.2.27h). Nazwij ten obiekt 

B.370.L.Elevator Tab.Pivot. Uczyń go „rodzicem” (Parent) obiektów B.365.L.Tab.Ribs i Tab 

B.360.L.Trim Tab, oraz potomkiem X.350.Elevator.Base. Na wszelki wypadek, gdybyś w przyszłości 

chciał obracać tą klapką, dołącz także (Link) obiekt B.370.L do dodatkowej kolekcji: 4y.Handles. 

Gdy klapka jest gotowa, można usunąć z siatki poszycia steru początkową krzywą, którą obrysowaliśmy jej 

kontur (por. str. 246, Rysunek 6.2.7a). Nie dołączyliśmy jej do innych ścian, więc jest widoczna w wycięciu klap-

ki trymera (por. str. 255, Rysunek 6.2.25). 

Jako ostatnią część, stwórz oś steru wysokości (gdyż była widoczna z zewnątrz). To prosty kawałek rury o pro-

mieniu 0.75”. Przypisz go jako potomka do X.350.Elevator.Base. Umieść środek tego obiektu na płaszczyźnie 

symetrii samolotu (X=0). Wykorzystaj go w modyfikatorach Mirror do wygenerowania prawego steru wysokości. 

Rysunek 6.2.28 pokazuje gotowy zespół usterzenia poziomego w oknach 3D i Outliner:  

 

Rysunek 6.2.28  Gotowe usterzenie poziome 

Otwór na środkowy zawias steru stworzymy później, za pomocą tekstury przejrzystości. Popychacze klapek 

trymera zostaną dodane w fazie uszczegóławiania modelu. 

Teraz możesz obrócić bazę całego usterzenia (obiekt X.300.Stabilizer.Base) o kąt zaklinowania: 2º: 

 

Rysunek 6.2.29  Usterzenie, umieszczone w miejscu docelowym 
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Podsumowanie 

• Podczas modelowania ścian wokół podstawy steru, użyliśmy nowego trybu skoku: Vertex (str. 249). 

• W większości planów samolotów nie znajdziesz żadnych wiarygodnych konturów profili steru. To ten sam 

problem, który napotkaliśmy przy modelowaniu statecznika. Na szczęście, w przypadku P-40 możemy sko-

rzystać z oryginalnej dokumentacji (str. 244, 253). 

• Do modelowania steru wysokości użyliśmy widoku z góry i pomocniczych profili odtworzonych z dokumen-

tacji fabrycznej (str. 245). Otoczyliśmy pomocniczymi krzywymi kontury kluczowych elementów: krawędź 

spływu, oprofilowanie, główne żebro, dźwigar (str. 246). Ich wierzchołki dostarczyły nam informacji po-

trzebnej do naszkicowania koncepcji topologii tej siatki (str. 246). 

• Modelowanie siatki rozpoczęliśmy od wyciągnięcia z konturu głównego żebra powierzchni podstawowego 

trapezoidu i krawędź natarcia steru (str. 247). W każdym z węzłów konturu krawędzi spływu wstawiliśmy w 

trapezoid nowe sekcje (linie krawędzi) „żeber” (str. 247). Następnie stworzyliśmy końcówkę tego steru, wy-

ciągając jej brzegi (str. 248). Połączyliśmy krawędź spływu i „obręcz” wokół końcówki przy osi steru (str. 

248). Na koniec zamknęliśmy tę siatkę środkowymi ścianami (str. 249). 

• Gdy końcówka była gotowa, zaczęliśmy zamykać podstawę steru poprzez wyciagnięcie nowej ściany 

wzdłuż jego dźwigara (str. 249). Potem stworzyliśmy dalsze ściany, aż do „dźwigara” oprofilowania (str. 

250). Zaczęliśmy modelować to oprofilowanie podobną metodą, co końcówkę: wyciągając ostatnie cztery 

wierzchołki krawędzi spływu wzdłuż jej konturu. Potem dodaliśmy ściany środkowe (str. 251, 252). W 

ostatnim kroku wstawiliśmy nowe linie krawędzi w stożkową część oprofilowania i zamknęliśmy przestrzeń 

pomiędzy tymi dwoma częściami siatki za pomocą nowych ścian (str. 252). 

• Przeciwwaga steru ma stosunkowo prosty kształt, uzyskany z pokrycia dwóch sąsiednich żeber płaskim, 

rozwijalnym poszyciem (str. 253). Zdecydowałem się wymodelować „w siatce” otwór na zawias z jej prawej 

strony, bo ten otwór upraszcza topologię: możesz użyć w tym miejscu „odciętego” żebra (str. 254). 

• W prostszych modelach klapki trymera są zaledwie „sygnalizowane” za pomocą rowka (linii) tekstury nie-

równości. W tym modelu zdecydowałem się odtworzyć je ze szczegółami. Wykonaliśmy je podobnie do lo-

tek w skrzydle. Użyliśmy modyfikatora Boolean do wycięcia otworu na klapkę, a potem zamknęliśmy jego 

krawędzie dodatkowym obiektem „ramki” (str. 255). Sama klapka składa się z obiektów: poszycia i dźwiga-

ra/żeber (str. 256). Są one „przypisane” do obiektu osi, dzięki czemu w przyszłości będziemy mogli łatwo 

animować ich ewentualne obroty. 

• Pogrupowaliśmy części tego steru w nowe kolekcje (str. 244, 255, 257). Dodaliśmy także bazę (nowy 

obiekt Empty) tego podzespołu: X.350.Elevator.Base. Jest ona bezpośrednim potomkiem obiektu 

X.300.Stabilizer.Base. 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-10.02.blend. 
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6.3 Statecznik pionowy 

P-40 i P-36 miały identyczny statecznik pionowy. Był przymocowany 8 śrubami do grzbietu statecznika pozio-

mego (por. str. 235, Rysunek 6.1.1a). Podobnie jak statecznik poziomy, to trapezoid zakończony łukiem. Bazą 

wymiarową tego zespołu jest oś steru kierunku (232.5” od przegrody silnika) i dźwigar (226.5” od przegrody). 

Aby uniknąć ewentualnych błędów w odtwarzaniu geometrii statecznika, Rysunek 6.3.1a) podaje nie tylko wy-

miary, ale także współrzędne (Y, Z) jego trzech kluczowych punktów: 

         

Rysunek 6.3.1  Geometria statecznika pionowego 

Statecznik był odchylony od płaszczyzny symetrii samolotu o 1.5º (Rysunek 6.3.1b), aby kompensować wpływ 

wirującego śmigła1. Jednak dźwigar, zamykający statecznik od tyłu, był prostopadły do tej płaszczyzny symetrii 

(Rysunek 6.3.1b) – aby pasować do płaszczyzn wręg kadłuba. 

Tak, jak w poprzednich przypadkach, na planach nie znajdziesz informacji o profilu tego statecznika. Jego kon-

tury na rysunku Jumpei Temmy są zbyt grube (Rysunek 6.3.1b). Jedynym wiarygodnym źródłem jest dokumen-

tacja techniczna2. Rysunek 6.3.2 pokazuje jej fragmenty dotyczące profili na stacjach 23 1/2 i 56 19/64:  

                       

Rysunek 6.3.2  Współrzędne profili statecznika 

Zwróć uwagę, że promień krawędzi natarcia (ostatnia kolumna: „R. AT L.E.”) był jeszcze mniejszy niż w statecz-

niku poziomym: 0.141” u podstawy i 0.0374” przy końcówce. Zwiększ te wartości o grubość blachy (0.032”). 

 
1 Jednak to nie wystarczało! W USAAC twierdzono, że „doświadczonego pilota P-40 rozpoznasz po muskularnej prawej nodze”. 

2 Rysunki: 75-12-011 i 84328. 

226 1/2 

Dźwigar jest 
równoległy 

do wręg 
kadłuba  

Kąt zaklino-
wania: 1.5º  

Profil podstawy 
był cieńszy 

Widok z góry Widok z boku 

Mniejszy 
promień kra-

wędzi natarcia  

a) b) 

Y: 211.99, 

Z: 56.30   

Y: 229.50, 
Z: 50.125  

Y: 190.63, 
Z: 23.50  
 

R 18 

4 

56 19/64 

23 1/2 

Baza  
wymiarowa: 

oś steru 

232 1/2 

(od osi kadłuba) 

15.26 

5 1/4 

36.62 

Dźwigar 

Płaszczyzna 
symetrii 

samolotu 

Płaszczyzna 
symetrii  

statecznika 

Stacja 
23 1/2 

Stacja 
56 19/64 

Promień 
krawędzi 
natarcia 

. 
. 

. 

.7 
. 

. 

. 

. 

. 
. . 

. 

. 

. 

. 

. 

. 

. 

. 

. 
. 

.7 

== .48 

https://app.aircorpslibrary.com/drawing/viewer/75-12-011/
https://app.aircorpslibrary.com/drawing/viewer/84328/


260 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Stwórz ten statecznik pionowy w taki sam sposób, w jaki stworzyliśmy statecznik poziomy (Rysunek 6.3.3): 

1. Stwórz nowe kolekcje (4c.Fin, i tak dalej). 

2. Stwórz bazę statecznika (obiekt Empty) o nazwie X.400.Fin.Base, na osi steru kierunku. Jego współ-

rzędna Z jest bez znaczenia. Ja umieściłem go na poziomie pierwszego żebra statecznika (Z = 23.5). 

Przypisz tę bazę jako obiekt potomny do obiektu X.000.Base.  

3. Stwórz pomocnicze wzorce: dwa żebra i okrąg wokół łuku końcówki. Przypisz je jako obiekty potomne 

do X.400.Fin.Base: 

 

Rysunek 6.3.3  Dźwigar i wzorcowe żebra statecznika 

W tym przypadku dźwigar jest elementem widocznym (to tylna ściana statecznika), więc umieściłem go w głów-

nej kolekcji tego podzespołu (4c.Fin) zamiast w 4c9.Auxiliary. Nie zapomnij pogrubić konturów tych żeber o 

grubość poszycia (0.032”), tak jak to zrobiliśmy na str. 236. 

Użyj wzorcowego okręgu do uformowania początkowego konturu bocznego tej siatki (nazwij ją B.400.Fin). 

Stworzyłem ten łuk z 5 krawędzi (Rysunek 6.3.4a), więc użyłem tej samej liczby wierzchołków (+ dodatkowych 5 

wierzchołków krawędzi natarcia) do uformowania konturu żebra bazowego (Rysunek 6.3.4b):  

      

 

Rysunek 6.3.4  Formowanie krzywych konturu i głównego segmentu statecznika 

Następnie wyciągnij ten kontur, tworząc podstawowy trapezoid statecznika (Rysunek 6.3.4c).  
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Teraz uformujmy końcówkę statecznika:  

1. Wyciągnij pięć wierzchołków krawędzi natarcia wokół konturu końcówki. Dostosuj wysokość ich baz tak, 

jak podaje to Rysunek 6.3.5a). Wzdłuż krawędzi zachowaj stały promień zaokrąglenia noska (0.09”).  

2. Wyciągnij pięć dalszych wierzchołków w wewnętrzny obszar końcówki (Rysunek 6.3.5b). Zachowaj 

współliniowość ich krawędzi 2, 3, 4, 5 z odpowiednimi krawędziami głównego segmentu statecznika. 

3. Stwórz nowe ściany, aby „domknąć” siatkę końcówki (Rysunek 6.3.5c). 

4. Przesuń (Slide) krawędzie końcówki, upodobniając jej kształt do pokazanego przez Rysunek 6.3.5d). 

      

       

Rysunek 6.3.5  Formowanie końcówki statecznika 

Ster kierunku P-40 był wyważony masowa i aerodynamicznie. Jego przeciwwaga znajdowała się w górnej czę-

ści, wysuniętej przed oś obrotu. Sugeruję wyciąć na nią miejsce w końcówce statecznika w taki sam sposób, jak 

w stateczniku poziomym: modyfikatorem Boolean (Rysunek 6.3.6a):  

      

Rysunek 6.3.6  Tworzenie wycięcia w końcówce 

Panel poszycia miała zaokrąglenie we wklęsłym narożniku tego wycięcia. Jest ono zaznaczone na rysunku 

złożeniowym i na zdjęciach. Szacuję jego promień na około 0.3”. 

Rysunek 6.3.6b) pokazuje obiekty zamykające to wycięcie. Stworzyłem je tak samo, jak żebra zamykające sta-

tecznik poziomy (por. str. 240). Zwróć uwagę, że podstawa dźwigara (B.410.Web) znajduje się 0.25” ponad 
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żebrem 56 19/64. Pozostawiam to miejsce na okucie zawiasu steru, które dodamy podczas uszczegóławiania 

tego modelu. To okucie było wykonane z duraluminiowej płytki o grubości 0.25”.  

Końcowym krokiem w formowaniu tego statecznika jest obrócenie jego dźwigara o 1.5º (por. Rysunek 6.3.1b):  

1. Obróć dźwigar (B.410.Beam) wokół środka jego tylnej ściany o 1.5º (Rysunek 6.3.7a). 

2. Wydłuż siatkę statecznika (B.400.Fin) o około 0.15” wzdłuż globalnej osi Y (Rysunek 6.3.7a). To przy-

gotowanie do przycięcia poszycia wzdłuż przesuniętych krawędzi dźwigara. 

3. „Utrwal” (Apply) modyfikator Mirror obiektu B.410.Beam i dopasuj pochylenie jego półek. Ustaw je rów-

nolegle do poszycia statecznika (Rysunek 6.3.7a), co czyni siatkę dźwigara asymetryczną. 

4. Stwórz nowy obiekt tnący – równoległy do dźwigara prostopadłościan (obrócony wokół globalnej osi Z o 

1.5º). Nazwij go U.400.Rear i użyj w kolejnym modyfikatorze Boolean statecznika1 (B.400.Fin) do przy-

cięcia jego powierzchni tuż za tylnymi krawędziami półek dźwigara (Rysunek 6.3.7b): 

       

Rysunek 6.3.7  Ustawianie dźwigara pod kątem do płaszczyzny symetrii statecznika 

Teraz możesz ustawić statecznik pod kątem 1.5º do osi samolotu. Obróć o ten kąt bazowy obiekt tego podze-

społu (X.400.Fin.Base). Umieściłem go w bazie wymiarowej statecznika: osi steru kierunku (Rysunek 6.3.8): 

 

Rysunek 6.3.8  Gotowy podzespół, zaklinowany pod katem 1.5º 

Gdy obrócisz ten statecznik wokół takiego środka, ścianka dźwigara stanie się prostopadła do osi samolotu. 

Jego środek będzie jednak odsunięty o 0.15” od tej płaszczyzny symetrii. Początkowo sądziłem, że statecznik 

był obrócony wokół osi symetrii dźwigara (to założenie pokazuje Rysunek 6.3.1b). Gdy jednak przestudiowałem 

 

1 Początkowo, starałem się dodać tę bryłę tnącą do siatki wycięcia (Rysunek 6.3.6a). Jednak Blender nie potrafił wykonać w jednym kroku 

takich dwóch „cięć”. Rozwiązaniem było użycie każdej z tych brył w oddzielnym modyfikatorze Boolean.  
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szczegóły rysunków fabrycznych, odkryłem, że osią obrotu była linia zawiasów steru kierunku. To wyjaśnia 

większą szerokość statecznika na planach Jumpei Temmy. Przypuszczam, że ich autor odwzorował obrys lewej 

strony profilu podstawy z położenia gniazd jej śrub. Potem założył (tak jak ja, na początku tej sekcji), że płasz-

czyzny symetrii statecznika pionowego i samolotu przecinają się wzdłuż jego dźwigara. W rezultacie uzyskał 

profil podstawy szerszy (grubszy) o około 0.3” (2x 0.15”). To niedużo, ale na tak cienkim profilu nawet taka róż-

nica jest już całkiem dobrze widoczna. 

 

Podsumowanie 

• Statecznik pionowy stworzyliśmy w ten sam sposób, co statecznik poziomy w sekcji 6.1. 

• Jedyną różnicą był obrócony dźwigar (str. 259). Użyliśmy dodatkowego modyfikatora Boolean aby asyme-

trycznie przyciąć krawędzie statecznika wzdłuż półek tego dźwigara (str. 262). 

• Bądź ostrożny w identyfikacji bazy wymiarowej modelowanego podzespołu. To szczególnie ważne w przy-

padku części odchylonych pod jakimś kątem, jak skrzydła czy stateczniki. Błędne założenia co do środka 

takiej transformacji mogą prowadzić do błędnego kształtu modelu (str. 262). 

 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-10.03.blend. 
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6.4 Ster kierunku 

Ster kierunku P-40 miał konstrukcję duralową krytą płótnem, z klapką trymera. Przeciwwagę i kompensację 

aerodynamiczną zapewniały wysunięte części krawędzi natarcia. Na historycznych zdjęciach ster kierunku ze 

wczesnych P-40 (do wersji „C” włącznie) wygląda identycznie jak ster P-36. W P-40D poddano je tylko drobnym 

modyfikacjom. Dzięki temu możemy w tej sekcji używać rysunków z dokumentacji obydwu tych samolotów. 

Stery wysokości i kierunku w P-40 są do siebie podobne, ale ten drugi jest bardziej złożony (Rysunek 6.4.1):  

           

Rysunek 6.4.1  Geometria steru kierunku (widok z boku) 

Rysunek złożeniowy z P-36 (75-14-001) ujawnia, że kontur steru kierunku w widoku z boku składa się odcinków 

prostych i 6 łuków (wliczając w to dolną sferę). Ich środki i promienie pokazuje Rysunek 6.4.1a) . Przedostatni 

łuk (R 19 15/16) jest jakiś dziwny. Nie znalazłem żadnego wiarygodnych współrzędnych jego środka. Według 

rysunku klapki trymera1, łuk R 19 15/16 jest styczny do poprzedniego (R 54 5/8). Kojarząc tę informację z długo-

ścią cięciwy żebra 7 5/8 i geometrycznymi regułami styczności, wyznaczyłem jego środek2. Jednak nakreślony z 

niego łuk R 19 15/16 przecina się z ostatnim łukiem (R 17 9/16) pod niewielkim, ale niezerowym kątem. To byłby 

problem dla jakiegoś systemu CAD, ale w tamtych „analogowych” czasach, wszystko było ostatecznie wygła-

dzane ręką człowieka3. 

Kontur krawędzi natarcia steru kierunku jest dość złożony, więc zwymiarowałem ten fragment na oddzielnym 

rysunku (Rysunek 6.4.1b). Położenie stacji steru kierunku jest mierzone wzdłuż osi Z, od osi kadłuba (Z=0).  

Zdecydowałem się umieścić obiekt Empty bazy steru (X.450.Rudder.Base) na jego osi (232.5” od przegrody 

silnika), w dolnym zawiasie (w Z = 1 – por.  Rysunek 6.4.1). W ten sposób jest odsunięty od bazy statecznika 

(X.400.Fin.Base), którą umieściłem w środkowym zawiasie steru (por. str. 260).  

 
1 Rysunek 75-14-30. Podano na nim także współrzędną Y środka, lecz taki łuk nie pasuje do konturu oprofilowania poniżej żebra 75/8. 

2 Rysunek 6.4.1a) podaje jego współrzędne w kolorze niebieskim. 

3 Rysunek szczegółowy górnego segmentu oprofilowania, w którym łączą się te dwa łuki (87-14-016), zawiera prostą notatkę: że ten kształt 

powinien pasować do żebra 75/8 (por. Rysunek 6.4.1a) i dolnego segmentu oprofilowania. Żadnych łuków i problemów z ich przecięciem! 
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W związku ze złożonym kształtem tego steru, musiałem stworzyć wiele wzorcowych żeber i dźwigarów. Stwo-

rzyłem je w oparciu o oryginalne rysunki fabryczne1. Rysunek 6.4.2 podaje ich wymiary, więc możesz stworzyć 

podobny szkielet w swoim modelu:   

   

Rysunek 6.4.2  Pomocnicze obiekty wzorcowe dla steru kierunku 

Na ilustracji powyżej oznaczam stacje żeber na żółto, a dźwigary – literami w kółkach. Przekroje steru kierunku 

są dużo prostsze niż steru wysokości: to trójkąty z zaokrągloną krawędzią natarcia i spływu. Do stacji 22 1/2 

krawędź natarcia ma przekrój kołowy. Środki tych okręgów leżą na osi steru (Rysunek 6.4.2a). Powyżej stacji 22 
1/2 krawędź natarcia jest wysunięta do przodu, tworząc obszar kompensacji aerodynamicznej. Przekroje trójkąt-

ne zaczynają się za dźwigarem A, położonym 1.5” przed osią obrotu steru. Geometrię profilu krawędzi natarcia 

pokazuje Rysunek 6.4.3. Zwróć także uwagę na podane przez Rysunek 6.4.2a) szerokości dźwigara A w sta-

cjach 22 1/2 i 55 9/16. To szerokość górnej części steru. 

Rysunek 6.4.2b) pokazuje szczegóły geometrii wysuniętej z końcówki steru przeciwwagi. Przygotowałem tu 

przednią część żebra 57 3/64, tylną część żebra 55 9/16, i trzy małe, trójkątne dźwigary oznaczone literami C, D, 

E. Na tej ilustracji podaję wymiary obydwu tych częściowych żeber, przez co pojawiła się na niej „chmura” bia-

łych strzałek. Wybierz spośród nich te, których potrzebujesz. 

Rysunek 6.4.2c) to z kolei szczegóły obszaru poniżej stacji 23: jest tutaj szeroki dźwigar B, położony 2” za osią 

obrotu i mały dźwigar F, z przodu wycięcia na klapkę trymera. Szerokości dźwigara B można określić, wyzna-

czając przecięcie jego płaszczyzny z trójkątnymi sekcjami żeber. Zależą one od promienia okręgu krawędzi 

natarcia i długości poszczególnych cięciw. Dźwigar F jest trapezem, jego wymiary podaje Rysunek 6.4.2a).     

 
1 Rysunki z grup: 75-14-* i 87-14-*. O dziwo, w aircorpslibrary.com element 75-14-015 można znaleźć na rysunku 75-31-016. 

 

Użyj wymiarów podanych przez  Rysunek 6.4.1 i Rysunek 6.4.2 jako dodatku do rysunków Jumpei 

Temmy. Żadne plany modelarskie nie podają takich szczegółów, istotnych w budowie modelu 3D. 
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Rysunek 6.4.3 przedstawia fragmenty oryginalnych rysunków profili krawędzi natarcia1: panelu, który pokrywa 

przednią część steru od stacji 22 1/2 do stacji 57 3/64:  

               

Rysunek 6.4.3  Przekroje krawędzi natarcia steru 

Jak widać, te profile są opisane za pomocą miejsca o największej  szerokości i dwóch stycznych łuków. Na tej 

podstawie można łatwo określić środek łuku noska: odejmując jego promień od całkowitej długości konturu (po-

danej na każdym z rysunków). Środek większego łuk nie jest podany, ponieważ masz go dopasować do punktu 

o największej szerokości i mniejszego łuku. Na wycinku z profilem stacji 22 1/2 można odczytać, że grubość 

blachy poszycia wynosiła 0.020”. To typowa grubość dla większości elementów tego steru. Nie zapomnij skory-

gować wymiary podawane przez Rysunek 6.4.3 o tę wartość, jak to robiliśmy poprzednio (por. str. 236).  

Zazwyczaj poprawki „o grubość blachy” nie są znaczące. Wygląda to jednak inaczej na końcówce tego steru.  

Na rysunku złożeniowym2 można zauważyć dwa częściowo nakładające się na siebie panele (na wysuniętej 

przeciwwadze – por. Rysunek 6.4.4a). Ich grubość to: 0.020” i 0.040”, co przy dźwigarze D daje sumaryczne 

0.06” (Rysunek 6.4.4b). Na rysunkach widać, że te panele były przycięte wzdłuż krawędzi steru. To oznacza, że 

zwiększyły szerokość końcówki steru przy dźwigarze D z 0.08” do 0.08+2x0.06 = 0.20” (Rysunek 6.4.4c): 

               

Rysunek 6.4.4  Szczegóły poszycia końcówki 

Te wszystkie szczegóły były pokryte płótnem, i różnica ich szerokości jest zbyt mała by dostrzec ją na jakimś 

szczegółowym zdjęciu. Oczywiście, obejrzałem wiele ujęć steru kierunku P-40 z różnych „obchodów”, ale żadne 

z nich ani nie potwierdziło, ani nie zaprzeczyło takiej interpretacji. 

 
1 Rysunek 87-14-027. 

2 Rysunki: 87-14-909, 75-14-001, 87-14-021. 
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Opcjonalnie, możesz także dodać trzy dodatkowe wzorcowe „wręgi” oprofilowania steru (Rysunek 6.4.5). Po-

mogą nam w formowaniu jego dolnej części:  

         

Rysunek 6.4.5  Geometria oprofilowania steru kierunku 

Wymiary na ilustracji powyżej pochodzą z rys. 75-14-0341. Zwróć uwagę na półcalowy pionowy kołnierz biegną-

cy wokół tego oprofilowania, aż do stacji (oprofilowania) 18. Odpowiada mu kołnierz żebra steru ze stacji 1/8. 

Zacznij formowanie siatki steru (obiekt: B.450.Rudder) od obrysowania jej kluczowych konturów krzywymi po-

działowymi (Rysunek 6.4.6a). Użyłem ich wierzchołków do szkicu planowanej topologii (Rysunek 6.4.6b): 

        

Rysunek 6.4.6  Kluczowe kontury i szkic topologii siatki 

Szkic pokazany przez Rysunek 6.4.6b) wykonałem w Inkscape. Jak widać, zamierzam pozostawić w krawędzi 

natarcia otwór A. Nie ma powodów, by łączyć jej górną i dolną część, skoro ich przekroje bardzo się różnią, a ja 

i tak zamierzam powiększyć ten otwór modyfikatorem Boolean (białe linie kreskowe). Oznaczyłem także na tym 

szkicu planowane ostre krawędzie (Crease = 1). Ewentualne ściany trójkątne są w kolorze żółtym. 

 
1 Miałem problem z promieniami zaokrągleń z 75-14-034: nie pasują do innych wymiarów. W dodatku narysowane w nim kontury nie odpo-

wiadają naniesionym na nie wymiarom. W P-40D ta geometria została odrobinę zmieniona: opisuje ja rys. 87-14-533.  
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Co prawda, moglibyśmy uformować „w siatce” od razu ostateczny otwór A (Rysunek 6.4.6b) zamiast tworzyć w 

niej najpierw mniejszy otwór pomiędzy żebrami 22 1/2 i 15 3/32, a potem rozszerzać go modyfikatorem. Jednak 

wymagałoby to w siatce dodatkowej krawędzi („podłużnicy”), która powinna potem zaniknąć gdzieś pomiędzy 

końcówką a żebrem 12 1/2. Oczywiście, to byłoby do zrobienia. Skoro już jednak użyjemy modyfikatora Boolean 

do wycięcia otworów B i C, to nie ma powodu, dla którego otwór A miałby być traktowany inaczej. 

Zacznijmy od oprofilowania steru kierunku. Wyciągnij i obróć dolną część początkowego konturu 4 (por. Rysu-

nek 6.4.6a), tworząc przednią ćwiartkę sfery, a potem wyciągnij ją wzdłuż konturu (Rysunek 6.4.7):  

         

         

Rysunek 6.4.7  Formowanie oprofilowania steru 

Rysunek 6.4.7f) pokazuje siatkę uformowaną zgodnie z zaplanowaną topologią (por. jej krawędzie i Rysunek 

6.4.6b). Jednak nie podoba mi się profil z góry generowanej przez nią powierzchni wynikowej. Dlatego zmieni-

łem topologię tych ścian, zastępując umieszczone na silnie wygiętych ścianach wierzchołki o trzech krawę-

dziach trójkątami na płaskich obszarach tej siatki (Rysunek 6.4.8): 

  

Rysunek 6.4.8  Zmian w topologii krawędzi spływu  Rysunek 6.4.9  Wyciągnięcie krawędzi spływu 

Gdy oprofilowanie jest gotowe, wyciągnij z jego końcówki krawędzi spływu cztery małe krawędzie i poprowadź 

je wzdłuż konturu steru (Rysunek 6.4.9). Umieść każdą z jej sekcji w punkcie sterującym (wierzchołku) pomoc-

niczej krzywej 1 (por. Rysunek 6.4.6a).  
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Gdy tylny kontur steru jest już „otoczony” siatką końcówki, zacznij formować jego część przednią i płaskie ścia-

ny pomiędzy krawędziami natarcia i spływu (Rysunek 6.4.10) : 

        

Rysunek 6.4.10  Formowanie pozostałych elementów dolnej części steru 

Wyciągnij oddzielnie siatkę w każdym z tych dwóch obszarów (gdyż krawędź natarcia wymaga skalowania). 

Aby dopasować środkowe ściany do żeber wzorcowych, przesuwaj ich wierzchołki wzdłuż globalnej osi X. Na 

koniec zamknij nowymi ścianami luki pomiędzy krawędziami natarcia i spływu, a powierzchnią pośrodku. 

Z początkowej krzywej 3 (por. Rysunek 6.4.6a) wyciągnij centralny segment steru (ten pomiędzy stacjami 22 1/2 

i 57 3/64). Jego krawędź natarcia to trapezoid. Skaluj górny kontur, aby dopasować go do wzorcowego żebra w 

stacji 57 3/64 (Rysunek 6.4.11a). Następnie wstaw (Loop Cut) dwie sekcje pośrodku, umieszczając każdą z nich 

naprzeciwko odpowiedniego punktu sterującego konturu krawędzi spływu (Rysunek 6.4.11b): 

        

        

        

Rysunek 6.4.11  Formowanie centralnej części steru 

Ten nowo utworzony fragment nie jest jeszcze połączony z resztą siatki. Aby to zrobić, usuń z niego wierzchołki 

A i B (Rysunek 6.4.11c), i stwórz w tym miejscu nowe ściany, które zamkną tę lukę (Rysunek 6.4.11d). Zamknij 

także otwartą przestrzeń przed krawędzią spływu (Rysunek 6.4.11e). Potem przesuń (Slide) środkowe wierz-

chołki nieco do tyłu, i wyprostuj (Vertex→Align) krawędzie 1 i 2 (Rysunek 6.4.11f). 
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Zacznij formowanie końcówki steru od wyciągnięcia konturu 2 (Rysunek 6.4.6a), tak jak pokazuje to Rysunek 

6.4.12a). Dopasuj te nowe ściany do wzorcowych dźwigarów C, D, E (Rysunek 6.4.2). Potem wstaw (Loop Cut) 

środkową krawędź i dołącz ten nowy fragment do reszty siatki (Rysunek 6.4.12b):  

        

        

        

        

Rysunek 6.4.12  Formowanie końcówki steru 

W następnym kroku, usuń górną krawędź (Rysunek 6.4.12c) i połącz pozostałe wierzchołki z zewnętrzną kra-

wędzią steru (Rysunek 6.4.12d). Przesuń (Slide) środkową sekcję tej końcówki, by lepiej dopasować jej kształt 

do dźwigarów. Aby zakończyć krawędź natarcia, utnij pod katem 45º cztery ściany z górnej krawędzi (Rysunek 

6.4.12e) i zaznacz tę nową krawędź jako ostrą. Zamknij lukę poniżej nowymi ścianami (Rysunek 6.4.12f). Po-

tem stwórz żebro 57 3/64  (Rysunek 6.4.12g). W ostatnim kroku poszerz dwie sekcje końcówki (Rysunek 

6.4.12h) dopasowując je do nakładających się w tym miejscu paneli pomiędzy C i D (por. Rysunek 6.4.4). Jeżeli 

w przyszłości odkryję, że wcale nie były tak szerokie – z powrotem zmniejszę te końcówki.   
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Gdy końcówka została zamknięta, usuń z siatki wszystkie pozostałe kontury pomocnicze, pozostawiając tylko 

gotowe ściany. Rysunek 6.4.13a) pokazuje gotową siatkę powierzchni steru. Rysunek 6.4.13b) przedstawia ster 

kierunku w Object Mode, razem ze statecznikiem pionowym:  

        

Rysunek 6.4.13  Uformowana powierzchnia steru kierunku 

Gdy porównasz topologie siatki przedstawiane przez Rysunek 6.4.13a) i Rysunek 6.4.6b), zauważysz pewne 

różnice. To normalny wynik adaptacji początkowego pomysłu do rzeczywistego kształtu.  

Dodaj teraz do obiektu steru modyfikator Solidify (Thickness: 0.02) i stwórz pomocniczy „obiekt tnący” o nazwie 

U.450.Rudder (użyj wymiarów podanych przez Rysunek 6.4.1). To trzy „kostki”: jedna na klapkę trymera i dwie 

na wycięcia w krawędzi natarcia (Rysunek 6.4.14a):  

       

Rysunek 6.4.14  Wycinanie otworów w sterze i dopasowywanie kształtu powierzchni wokół otworów 

Tworząc je, minimalnie przesuń linie krawędzi steru ze stacji 25 1/2 (do 25.49999) i 1/8 (do 0.12501), aby uniknąć 

ewentualnych problemów z modyfikatorem Boolean. Rysunek 6.4.14b) pokazuje, że musiałem znów zmienić 

topologię siatki oprofilowania, aby dopasować powierzchnię wynikową do trójkątnych krawędzi spływu wokół 

otworu na klapkę trymera. Po analizie profili żeber pomiędzy stacjami 1/8 and 7 5/8 oceniłem, że końcówka żebra 
1/8 nie była łukiem (jak założyłem wcześniej – por. Rysunek 6.4.2c), tylko elipsą1. 

 
1 Okrągły (nie zwymiarowany) kształt końcówki pochodzi z rysunku żeber. Rysunek szczegółowy (75-14-034) pokazuje inny kształt. 
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Za pomocą metod opisanych w poprzednich sekcjach, zamknij wycięte otwory żebrami (Rysunek 6.4.15):  

       

Rysunek 6.4.15  Żebra i ściany, wpasowane w wycięcia steru kierunku 

Szerokość kołnierzy tych żeber i ścian to 0.5” (mniejsza niż w innych podzespołach). Rysunek 6.4.15a) i b) 

pokazują elementy zamykające otwory na krawędzi natarcia. Zwróć uwagę, że obydwa otworzy są zamknięte w 

pionie przez dźwigar główny (1 15/16 za osią steru). Stąd pionowa ściana w mniejszym otworze (pomiędzy stacją 

3 7/16 i stacją 1/8) jest skryta we wnętrzu. Zewnętrzne krawędzie kołnierzy żeber biegną wzdłuż krawędzi otwo-

rów, oprócz żebra 12 1/2, którego kołnierz jest zorientowany w przeciwną stronę (Rysunek 6.4.15b). 

Gdy zacząłem analizować szczegóły pionowej ściany otworu na klapkę trymera, odkryłem dodatkowe, małe 

wycięcie przy górnej krawędzi (Rysunek 6.4.15c). Na wszystkich zdjęciach jest częściowo zasłaniane przez 

rożek i cięgna klapki. Zmodyfikuj naszą „bryłę tnącą” by odtworzyć ten szczegół powierzchni steru. Aby uzyskać 

zaokrąglony narożniki kołnierzy ściany pionowej, zaokrąglij te wierzchołki jej siatki. Nadaj im Bevel Weight = 1 i 

dodaj do obiektu ściany modyfikator Bevel:Vertices (szczegóły – patrz str. 563). 

Stwórz klapkę trymera w oparciu o wymiary podane przez Rysunek 6.4.1a). Zrób to w ten sam sposób, jak 

stworzyliśmy klapkę trymera w sterze wysokości (str. 256). W tym przypadku oś obrotu jest zupełnie pionowa, 

co czyni cały proces łatwiejszym (Rysunek 6.4.16):  

      

Rysunek 6.4.16  Szczegóły klapki trymera 

Jak w sterze wysokości, stwórz tę klapkę z trzech obiektów: osi (prosty cylinder), poszycia, oraz dźwigara i że-

ber (Rysunek 6.4.16a). Uczyń obiekt osi „rodzicem” (Parent) dwóch pozostałych. 

Proponuje wprowadzić w tym modelowaniu małe usprawnienie: promień zaokrąglenia krawędzi natarcia jest 

stały wzdłuż rozpiętości klapki, więc można go odtworzyć modyfikatorem Bevel (Rysunek 6.4.16b). Możesz 

także użyć modyfikatora Bevel:Vertex do uzyskania zaokrągleń na końcach krawędzi spływu żeber. 
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Na koniec wstaw oś tego steru. Na razie to zwykły cylinder (R = 0.65). Rysunek 6.4.17 pokazuje gotowy ster 

kierunku, wraz ze statecznikiem pionowym:  

        

Rysunek 6.4.17  Gotowy ster kierunku 

Wg rysunków Curtiss, ster kierunku w pozycji neutralnej leżał na płaszczyźnie symetrii samolotu, a jego kąty 

maksymalnego wychylenia były w obydwu kierunkach takie same. Dlatego przypisz jego obiekt bazowy 

(X.450.Rudder.Base) jako potomka do obiektu bazowego całego modelu (X.000.Base). Nie stworzyłem tu żad-

nej hierarchicznej zależności pomiędzy statecznikiem i sterem kierunku (inaczej niż w sterze wysokości, który 

jest „przypisany” do bazy statecznika poziomego).  

Podczas teksturowania odtworzymy boczną szczelinę na zawias (poniżej stacji 57) i ostre krawędzie żeber pod 

napiętym płótnem poszycia. Podczas uszczegóławiania dodamy rożek i cięgna klapki trymera, zawiasy steru, i 

inne widoczne z zewnątrz okucia. 

 

Podsumowanie 

• W tej sekcji użyliśmy w modyfikatorze Bevel nowego trybu: Vertices. W połączeniu ze współczynnikiem 

Bevel Weight (wierzchołków, nie krawędzi!) ten tryb pozwala zaokrąglać wybrane narożniki siatki (str. 272). 

• Ster kierunku stworzyliśmy tak samo, jak ster wysokości w sekcji 6.2. Jego bardziej złożony kształt wyma-

gał większej liczby pomocniczych obiektów referencyjnych (żeber, dźwigarów). 

 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-10.04.blend. 

  

Oś steru 
(cylinder) 

Statecznik 
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o 1.5º 

Ster w pozycji neutralnej: 
bez odchylenia 



274 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Rozdział 7. Kadłub 

Najbardziej skomplikowany zespołem typowego samolotu jest kadłub. W tym rozdziale zaczniemy od uformo-

wani jego głównej części, rozciągającej się od przegrody silnika do steru kierunku. Potem zajmiemy się okapo-

towaniem silnika. Opis tej pracy zajmie nam trzy kolejne sekcje. 

Dlaczego nie stworzymy od razu całego kadłuba? Po pierwsze, z powodu skomplikowanego kształtu osłony 

silnika. Po drugie – ponieważ wolę odtwarzać główne podzespoły prawdziwego samolotu jako oddzielne części 

modelu. Po trzecie – kształt nosa P-40 zmieniał się pomiędzy wersjami. Pozostała część kadłuba, pomimo tych 

zmian, była identyczna w P-36 i w P-40 (B, C). Stąd, taki podział pozwoli nam użyć powtórnie odpowiednie czę-

ści w innych modelach. 
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7.1 Część główna 

W tej sekcji odwzorujemy główną część kadłuba P-40, którą Rysunek 7.1.1 zaznacza na czerwono: 

 

Rysunek 7.1.1  Część kadłuba, którą stworzymy w tej sekcji 

Oprofilowania „kila” pod płatem odtworzymy oddzielnie, gdyż jego przekroje nie mają nic wspólnego z kadłubem 

znajdującym się ponad skrzydłem.  

Kadłub ma trzy bazy wymiarowe: płaszczyzny symetrii (X=0) i przegrody silnika (Y=0) oraz oś podłużną (Z=0). 

Jego wręgi są ponumerowane od #1 (przegroda silnika, w stacji 0) do #16 (w stacji 2261/2). W dokumentacji 

P-40 te numery kolejne są używane jako nazwy wręg. Aby uniknąć pomyłek, zawsze będę je poprzedzał zna-

kiem „#”, stąd „stacja #6” i „stacja 75” oznacza tą samą płaszczyznę, znajdująca się 75” od przegrody silnika. W 

przypadku wątpliwości, Rysunek 7.1.1 pokazuje położenia i numery wszystkich wręg/stacji kadłuba. 

Górna część przegrody silnika P-40 jest wysunięta do przodu o 2”1. Odtworzymy ten efekt formując kompletną 

przednią wręgę w stacji Y=-2, a potem odcinając jej dolną część za pomocą modyfikatora Boolean. Modyfikator 

Boolean posłuży nam także do wycięcia otworu na kółko ogonowe. 

Otwór kokpitu to jednak zupełnie inna sprawa. Przekroje poprzeczne wręg #3 (pod wiatrochronem) i #5 (grzbiet 

kadłuba za kabiną pilota) nie mają ze sobą nic wspólnego powyżej linii szyn owiewki kabiny. Formowanie „po-

wierzchni przejściowej pomiędzy tymi dwoma konturami (w sekcji #4?) tylko po to, aby ją zaraz usunąć modyfi-

katorem Boolean nie ma sensu. Dlatego zamodelujemy ten otwór bezpośrednio w siatce. Ostre narożniki tego 

wycięcia w powierzchni podziałowej uzyskamy sterując współczynnikami Crease jego krawędzi (str. 645).  

Podczas pracy będziemy używać rysunków J. Temmy i mojej „kompilacji”, które wstawiliśmy w tą scenę Blende-

ra w sekcji 4.1. Ze względu na zidentyfikowane na planach Temmy drobne odchylenia w konturach przekrojów 

kadłuba w rzutach z przodu i z tyłu, przygotowałem dodatkowe obrazy wzorcowe z tymi przekrojami. Zamiast 

tworzyć oddzielne pliki dla każdej z tych wręg, zdecydowałem się je pogrupować w trzy rysunki. Znajdziesz je w 

folderze source\reference\drawings (por. str. 19). Są to pliki: 

• Sections (cowling).png; 

• Sections (middle).png; 

• Sections (tail).png; 

Te obrazy mają większą rozdzielczość niż rysunki J. Temmy. Załaduje je do Blendera i umieść w nowej subko-

lekcji 1.Blueprints, o nazwie 1d.Fuselage.  

 
1 W chłodzonym powietrzem przedziale silnika P-36, z przodu przegrody umieszczono dwie pary małych szczelin wentylacyjnych (por. Tom 

I, sekcja 5.1, Rysunek 5.1.2). Górny fragment przegrody była zamontowany ponad tymi „skrzelami”. Szczeliny znikły w chłodzonych cieczą 

P-40, ale kształt przegród silnika w pierwszych wariantach tego samolotu pozostał taki, jak w P-36 (bo to była „szybka adaptacja” płatowca 

do silnika rzędowego). Curtiss ostatecznie uprościł kształt tej wręgi w przeprojektowanym kadłubie P-40D. 

Otwór kabiny pilota zmodelu-
jemy bezpośrednio “w siatce” 
(bez modyfikatora Boolean)  

1 2 3 4 6 7 8 9 10 11 12 13 14 15 16 

5 

2 

17 

0 131/8 48 30 621/4 75 106 901/2 124 142 160 174 188 201 214 2261/2 

2311/4 

76.5º 

Przegroda 
silnika 

Podłużna oś 
kadłuba 

“Kil” 



276 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Nazwij te obrazy w Blenderze tak, jak nazywają się ich pliki (Rysunek 7.1.2a):  

      

Rysunek 7.1.2  Obrazy referencyjne przekrojów kadłuba 

W każdym z nich znajdziesz co najmniej jeden wymiar poziomy i jeden wymiar pionowy (Rysunek 7.1.2b). Użyj 

ich do precyzyjnego skalowania tych obrazów, dopasowując je do pozostałych rysunków referencyjnych. Nie 

podaję stacji, w których masz je umieścić: podczas modelowania będziemy je od czasu do czasu przesuwać 

wzdłuż osi kadłuba. Na razie możesz ukryć obraz z sekcjami osłony silnika. 

Aby uniknąć „zatłoczenia” kolekcji 2.Fuselage, proponuję utworzyć w niej subkolekcje o nazwach: 2a.Spinner, 

2b.Cowling i 2c.Tail. Przenieś obiekty śmigła (kołpak i łopaty) do 2a.Spinner. Stwórz w 2c.Tail nowy obiekt, o 

nazwie B.500.Fuselage (Rysunek 7.1.3):  

 

Rysunek 7.1.3  Odwzorowanie konturów kadłuba za pomocą krzywych podziałowych 

Początkowo jego siatka będzie się składać z trzech linii łamanych, odwzorowujących kontury kadłuba w rzutach 

z boku i z góry. Oczywiście, wygładź je modyfikatorem Subdivison Surface, i stwórz symetryczną drugą stronę 

modyfikatorem Mirror.  
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Dla większej precyzji w dopasowaniu tak długich, łagodnych krzywych, sugeruję rysowanie tych konturów w 

projekcji nachylonej pod dużym kątem (techniką opisaną na str. 523). Rysunek 7.1.4a) pokazuje, że mój kontur 

w rzucie z góry różni się minimalnie od rysunku Temmy, bo biegnie wg oryginalnych szerokości kadłuba1: 

            

Rysunek 7.1.4  Szczegóły konturów kadłuba 

Od przegrody silnika do stacji 106 (#8) kontur kadłuba w rzucie z góry jest linią prostą. Aby być dokładnym, 

umieść jego koniec po wewnętrznej stronie konturu Temmy (Rysunek 7.1.4a). Zwróć także uwagę, że zrobiłem 

„ostry” narożnik w stacji 106 (Rysunek 7.1.4b). Ująłem słowo „ostry” w cudzysłów, bo jest to niewielka niecią-

głość kierunków stycznych, niewidoczna w zwykłym widoku z góry. Początkowo miała być tu gładka krzywa 

(linia przerywana pokazywana przez Rysunek 7.1.4b). Ostatecznie zdecydowałem jednak, że blacha poszycia 

raczej zaginała się na wrędze #8, i nie tworzyła gładkiego wybrzuszenia pomiędzy wręgami #8 i #9 (stacja 124). 

Rysunek 7.1.4c) pokazuje kolejny długi prosty odcinek konturu kadłuba, rozciągający się od krawędzi spływu 

skrzydła do steru kierunku (dokładniej: do stacji 231 1/4). 

Gdy uformowałeś już te kontury, dopasuj liczbę i położenie ich wierzchołków (Rysunek 7.1.5): 

 

Rysunek 7.1.5  Określanie położenia krawędzi „wręg” siatki kadłuba 

Zazwyczaj wymaga to wstawiania w te krzywe dodatkowych wierzchołków i ponownego dopasowywania tak 

zmodyfikowanych konturów do rysunków referencyjnych. W szczególności, dodaj „ostry” węzeł do górnego i 

dolnego konturu kadłuba w stacji 106. Za chwilę umieścimy w tym miejscu „ostrą” krawędź siatki.  
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Obecność prostych odcinków w konturach upraszcza ten proces, ponieważ dodatkowe punkty sterujące (nawet 

„ostre”) nie zmienią ich kształtu. Możesz do woli wstawiać dodatkowe węzły w linię dolnego konturu kadłuba. 

Jednak wygięty górny kontur wymaga więcej pracy. Aby zachować ciągłość stycznych w B, powinieneś ustawić 

w jednej linii wierzchołki A, B i C. Jak pokazuje to Rysunek 7.1.6, niewielkie obniżenie zewnętrznych końców 

tego odcinka nie psuje wizualnej „gładkości” tego konturu1: 

 

Rysunek 7.1.6  Wygładzanie „ostrego” narożnika konturu górnego za pomocą dwóch dodatkowych węzłów  

Siatka kadłuba to „topologiczna rura”, stworzona ze ścian rozciągających się pomiędzy liniami krawędzi „wręg” i 

„podłużnic”. Dopasowując do siebie wierzchołki tych trzech konturów, określasz położenie „wręg” tej siatki. Ten 

proces wymaga kilku iteracji, ale podobne zmiany kompletnej siatki wymagałyby o wiele więcej pracy. Na 

szczęście, położenie tych krawędzi „wręg” nie musi odpowiadać stacjom pokazywanym przez Rysunek 7.1.1. W 

przeciwnym razie, nasza siatka byłaby dwa razy gęstsza! 

Gdy wierzchołki konturów są uzgodnione, obrysuj nowymi krzywymi dwie lub trzy kluczowe wręgi. W przypadku 

P-40 stworzyłem je wokół przegrody silnika i wręgi #8 (stacji 106). Stwórz te kontury w oparciu o dwa obrazy 

referencyjne, które załadowaliśmy na początku tej sekcji (Rysunek 7.1.7): 

 

Rysunek 7.1.7  Określanie położenia krawędzi „wręg” siatki kadłuba 

W środkowej części każdego z tych konturów wręg umieść taką samą liczbę wierzchołków. W ten sposób unik-

niesz kłopotów z topologią podczas formowania ścian bocznych kadłuba. 

 
1 Jest to możliwe dzięki „przybliżonej” postaci krzywych podziałowych. Gdy wybierasz poziom Subdivision = 2, każdy odcinek krzywej po-

między dwoma sąsiednimi punktami sterującymi jest przybliżony za pomocą linii łamanej złożonej z 4 prostych krawędzi. Dopóki kąt „ostry” 

w węźle B jest porównywalny do kątów pomiędzy tymi elementarnymi krawędziami, zachowujemy efekt wizualnej ciągłości krzywizny.  

 

Zwróć uwagę, że na tej krzywej stworzyłem ostry narożnik wyciągając dodatkową, trzecią krawędź z 

wierzchołka B (Rysunek 7.1.6). Podobny efekt osiągnąłbyś przerywając krzywą podziałową w tym 

węźle (tak jak to robiliśmy w przypadku końcówki skrzydła – por. str. 163, Rysunek 5.3.18b). 
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Sugeruję także umieszczenie w tym kadłubie, jako wzorca, pochylonej wręgi #5. Stwórz ją jako oddzielny obiekt 

Plane, obrócony o 13.5º (por. Rysunek 7.1.1) wokół globalnej osi X. Nazwij go B.510.Frame#5. Ta wręga przy-

da się także w przyszłości, gdy będziemy odtwarzać szczegóły wnętrza kokpitu. Teraz dopasuj jej kontur do 

zewnętrznego konturu na obrazie referencyjnym R.Sections (tail). Zrób to w widoku z przodu, blokując przesu-

nięcia wierzchołków wzdłuż lokalnej osi Y obiektu ( G , Shift - Y , Shift - Y ). W ten sposób Twoje wierzchołki będą 

się przesuwać po pochyłej płaszczyźnie tej wręgi (Rysunek 7.1.8): 

       

Rysunek 7.1.8  Obrys wręgi #5 (obiekt B.510.Frame#5) Rysunek 7.1.9  Wyciąganie grzbietu kadłuba za kabiną 

Ustaw kolor tej nowej wręgi na czerwony (przypisz jej materiał: Artificial.Red). Następnie wyciągnij do przodu 

górną część konturu ze stacji 106 i dopasuj ją do wręgi #5 (Rysunek 7.1.9). W ten sposób uformowaliśmy 

pierwszą część grzbietu kadłuba za kabiną pilota.  

Teraz podłącz ścianami środkowe wierzchołki przegrody silnika i konturu ze stacji 106 (Rysunek 7.1.10):  

  

Rysunek 7.1.10  Tworzenie bocznych ścian środka kadłuba Rysunek 7.1.11  Dodanie częściowej sekcji #3A 

Skopiuj górną część konturu przegrody i umieść ją w Y = 39.75. Dopasuj tę krzywą do konturu z rysunku refe-

rencyjnego R.Sections (middle) (Rysunek 7.1.11). Oryginalna dokumentacja Curtiss nazywa ten kontur „czę-

ściową stacją #3A”. W tym miejscu zaczyna się linia podziału pomiędzy stałym wiatrochronem i odsuwaną 

owiewką kabiny1. Kształt przekroju kadłuba w stacji 39.75 jest w dużej mierze rezultatem mojej ekstrapolacji, 

ponieważ prawdziwa wręga #3A była ucięta przy krawędzi kabiny.  

 
1 Możesz zobaczyć tę linię podziału zaczynająca się od stacji 39.75 na rysunku referencyjnym R.Side.Left (compiled). Na planach Jumpei 

Temmy wiatrochron jest umieszczony w stacji 40.75, a ruchoma owiewka kabiny jest krótsza o 1”. Przypuszczam, że to jakiś błąd w inter-

pretacji wymiarów z rysunku Curtiss 75-25-001. Długość owiewki jest w nim zwymiarowana w nietypowy sposób. 
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W samolotach z przesuwanymi osłonami kabiny zewnętrzny kontur brzegu kokpitu często skrywa różne niespo-

dzianki. Po pierwsze, szerokość kadłuba wzdłuż szyn osłony powinna być stała. Aby ją zapewnić wzdłuż zawę-

żającego się kadłuba, szyny owiewki za kokpitem są często wygięte do dołu. Tak jest w przypadku P-36 i wcze-

snych P-40. Co więcej, dokumentacja ujawnia1, że krawędź kokpitu wznosiła się od wręgi #3 do wręgi #5 o 7/16”. 

Tak niewielkiej różnicy nie dostrzeżesz na zdjęciach! Kolejną niespodzianką była mała różnica w rozstawie szyn 

owiewki: 0.1”. Ten brak równoległości musiał być chyba jakoś kompensowany na rolkach ruchomej ramki osło-

ny kabiny? Ten niemal równoległy kształt brzegów kokpitu powodował wklęsły kontur poziomic kadłuba powyżej 

dźwigara (tj. dla Z > 17”). Pokazuje to Rysunek 7.1.12a). Poprowadziłem na nim linię krawędzi kabiny pilota i 

podaję dokładne współrzędne jej końców:  

      

Rysunek 7.1.12  Formowanie ramy kokpitu 

Wklęsły kontur poziomic kadłuba z przodu kabiny jest jeszcze podkreślony przez wręgę #2A ze stacji 21 11/16. 

Stwórz ściany siatki pomiędzy przegroda silnika i konturem #3A, a potem wstaw w ten segment nową linię kra-

wędzi w Y = 21 11/16 (Rysunek 7.1.12b). Ukształtuj ten kontur, dopasowując wynikową powierzchnie podziałową 

na tej stacji do odpowiedniego przekroju z obrazu referencyjnego. 

W następnym kroku, wstaw trzy nowe linie krawędzi w środkową część kadłuba (Rysunek 7.1.13a) i zamknij 

nowymi ścianami lukę w siatce biegnącą wzdłuż krawędzi dźwigara (Rysunek 7.1.13b): 

      

Rysunek 7.1.13  Zamykanie luki pomiędzy górną i środkową częścią kadłuba 

Jak widać, zaznaczyłem linie krawędzi w stacjach 39.75 i 67.29 jako ostre (Crease = 1), aby uzyskać ostre na-

rożniki otworu kokpitu. 

 
1 Rysunek 75-21-176. 
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Po kilku próbach zdecydowałem, że muszę dodać jeszcze jedną krawędź, która rozdzieli ściany w luce za-

mkniętej na poprzedniej stronie. Ta linia krawędzi kończy się w tylnym narożniku kokpitu (Rysunek 7.1.14), po-

nieważ trójkątna ściana w tym miejscu nie zaburza powierzchni wynikowej. Jej obecność pozwoliła mi zacho-

wać na powierzchni podziałowej prosty kontur poziomicy 17”:  

  

Rysunek 7.1.14  Kolejna krawędź siatki ponad poziomicą 17”  Rysunek 7.1.15  Kontur górnej części kadłuba  

Skąd się wzięły wklęsłe poziomice na smukłym kadłubie P-40? Przecież wąski, rzędowy silnik V12 Allisona nie 

wymaga takiej przestrzeni. Odpowiedź podaje Rysunek 7.1.15: te kontury były przygotowane dla szerokiego 

okapotowania gwiazdowego silnika P-36. Dlatego we wczesnych wariantach P-40, na przegrodzie silnika wy-

stępuje załamanie ciągłości stycznych konturu kadłuba1.   

Kadłub P-40 był „wycięty” wzdłuż górnej powierzchni skrzydła. Jednak, zanim „przytniemy” tę siatkę, dopasujmy 

jej boki do konturów z rysunków referencyjnych. W tym celu wyciągnij kontur z wręgi #8 (Rysunek 7.1.16):  

  

Rysunek 7.1.16  Wyciąganie dolnego kontury wręgi #8 Rysunek 7.1.17  Pierwsze przybliżenie dolnej części kadłuba  

Wypełnij ścianą lukę powstałą pomiędzy powierzchnią środkową i dolną (Rysunek 7.1.16), potem wyciągnij 

dolne krawędzie boczne w kontur grzbietu skrzydła (Rysunek 7.1.17). Umieść obraz R.Sections (tail) w stacji 

75. Przekształć dolny kontur stacji 67.29, dopasowując wynikową powierzchnię kadłuba w stacji 75 do konturu z 

obrazu referencyjnego (Rysunek 7.1.17). W tym momencie zrób to w sposób zgrubny, pozostawiając odchyle-

nia od konturu wzorcowego nie większe niż 1”. Dopasujemy je dokładniej po dodaniu dwóch kolejnych zapla-

nowanych linii „wręg” pomiędzy stacjami 67.29 i 106 (por. Rysunek 7.1.16). 

 
1 W P-40D Curtiss przeprojektował cały kadłub, oprócz dolnej części ogona. Począwszy od tej wersji, konstrukcja stała się bardziej racjo-

nalna: na przykład, przesunięto zbiornik oleju z ogona (gdzie sprawiał kłopoty podczas akrobacji) na przegrodę silnika.   
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Wstaw pierwszą z zaplanowanych linii krawędzi w stacji 90 1/2 (Rysunek 7.1.18a). Umieść w tym samym miej-

scu obraz R.Sections (tail) i dopasuj kształt wynikowej powierzchni do wzorcowego konturu wręgi #7.  

       

Rysunek 7.1.18  Wstawienie dwóch kolejnych linii krawędzi 

Gdy to zrobiłeś, wstaw kolejną linię krawędzi w stacji 79 (Rysunek 7.1.18b). Przesuń obiekt R.Sections (tail) do 

stacji 75 i dopasuj wynikową powierzchnię podziałową do konturu z tego rysunku referencyjnego. Aby ułatwić  

sobie to zadanie, dodaj dodatkową krawędź podłużną pomiędzy wręgami #4 i #7 (Rysunek 7.1.18b). 

 
Wyciągnij powierzchnię kadłuba z przegrody silnika na (2” do przodu – Rysunek 7.1.19). Zrób to poleceniem 

Slide z wyłączoną opcją Clamp1. W następnym kroku przytniemy jej dolną część (por. Rysunek 7.1.1). Na 

wszelki wypadek wstawiłem w stacji Y = 0 dodatkową linię krawędzi (Rysunek 7.1.19):  

  

Rysunek 7.1.19  Inne drobne modyfikacje siatki kadłuba   Rysunek 7.1.20  Mocowanie skrzydeł do kadłuba w P-40 

Możesz także poprawić kształt krawędzi 1 (Rysunek 7.1.19), by lepiej pasowała do skrzydła. Potem podnieś jej 

wierzchołki o około 0.7” ponad skrzydło. Upewnij się także, że ściany oznaczone na żółto są na tej samej 

płaszczyźnie. Dlaczego? Gdyż kadłub P-36/P-40 był mocowany do dwóch wygiętych profili „T”, przynitowanych 

do powierzchni skrzydła (Rysunek 7.1.20). Te profile, o wysokości 2”, były w rzucie z góry płaskie. Ich pionowe 

ściany były dopasowane do wzmocnionych, płaskich (lokalnie) ścian kadłuba. Dolna krawędź kadłuba kończyła 

się nieco powyżej skrzydła, by zmieściły się pod nią podstawy tych teowników.      

 
1 Użyliśmy tej metody przy formowaniu końcówki skrzydła – por. str. 242. 

 

Dolna część kadłuba, którą teraz modelujemy, będzie potem przycięta i ukryta pod oprofilowaniem 

połączenia skrzydła i kadłuba. Jednak nadanie temu obszarowi oryginalnego kształtu może w przy-

szłości oszczędzić nam kłopotów z dopasowaniem zewnętrznych krawędzi tego oprofilowania.     
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Teraz możemy przyciąć tę siatkę modyfikatorami Boolean. Przygotuj bryły tnące (Rysunek 7.1.21a):  

       

Rysunek 7.1.21  Przycinanie krawędzi środka kadłuba modyfikatorami Boolean 

Fioletowe bryły z ilustracji powyżej należą do siatki pomocniczego obiektu U.500.Fuselage. Tylną, pochyłą kra-

wędź otworu kokpitu (wzdłuż wręgi #5) mógłbym odciąć narzędziem Knife. Jednak w następnym rozdziale uży-

jemy tego fragmentu siatki kadłuba do formowania tylnej części oszklenia kabiny i jej ramek. Ich kontury wzdłuż 

wręgi #5 powinny pasować do kadłuba. Trudno byłoby zachować taką zgodność pochyłych krawędzi, gdy do-

okoła przesuwasz wszystkie wierzchołki siatki. Dlatego zdecydowałem się zachować wszystkie krawędzie 

„wręg” siatki w pionie, a pochyły kontur uzyskać za pomocą modyfikatora Boolean. Obiekt tnący, o nazwie 

U.501.Cockopit, jest tu obrócony o 13.5º. Użyjemy go także do „przycięcia” oszklenia kabiny. 

Rysunek 7.1.21b) pokazuje przyciętą siatkę. Zwróć uwagę, że w U.500.Fuselage pozostawiłem lukę pomiędzy 

jego dwoma bryłami tnącymi. Przednia część otworu skrzydła pozostaje wymodelowana w siatce, a obiekt tnący 

płynnie przedłuża ten kontur (por. Rysunek 7.1.21a). Oczywiście, mogłem przygotować dłuższą bryłę tnącą, 

rozciągniętą się wzdłuż całej cięciwy skrzydła. Wtedy jednak przecinałaby „pudełko” umieszczone przed prze-

grodą silnika. Użyty w modyfikatorze Boolean, taki „wewnętrznie przenikający” się obiekt wygenerowałby różne 

artefakty. Unikam więc tych problemów korzystając z oddzielnych brył.  

Teraz możemy zabrać się za ogon. Wyciągnij ze stacji 106 nową linię krawędzi i przesuń ją do stacji 188, 

umieszczając jej najniższy wierzchołek na dolnym konturze kadłuba. To nasza wręga #13. Skaluj tę krawędź, 

dopasowując ją do konturu z obrazu referencyjnego R.Sections (tail) (Rysunek 7.1.22a):  

       

Rysunek 7.1.22  Formowanie ogona samolotu 

Skalując, użyj dolnego wierzchołka tej wręgi (Rysunek 7.1.22a zaznacza go kursorem 3D) jako środka trans-

formacji. Gdy wręga #13 pasuje do konturu, wstaw kolejną linię krawędzi w stacji 139.5 (Rysunek 7.1.22b). Do-

pasuj ją, skalując, do górnego i bocznego konturu kadłuba, w ten sam sposób jak skalowałeś wręgę #13. 
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Wstaw dwie pozostałe linie krawędzi w Y=122.75 i Y=161.22 (Rysunek 7.1.23). Dopasuj je do bocznego i gór-

nego konturu kadłuba, tak jak to zrobiliśmy z poprzednimi sekcjami. Gdy to zrobiłeś, umieść w stacjach: 142, 

124 obraz R.Section (tail). W każdej z tych stacji porównaj kontur wzorcowy z aktualnym przekrojem wynikowej 

powierzchni kadłuba z płaszczyzną obrazu. Gdy zauważysz odchylenie, popraw odpowiednie wierzchołki w 

najbliższych liniach wręg znajdujących się po przeciwnych stronach obrazu (oprócz wręgi #8): 

  

Rysunek 7.1.23  Wstawianie i dopasowanie pozostałych wręg Rysunek 7.1.24  Wyciąganie ostatniego segmentu ogona  

Wyciągnij z wręgi #13 ostatni segment ogona i przesuń jego koniec do stacji 231 1/4. Dopasuj tę krawędź do 

konturów kadłuba i kształtu wzorcowego przekroju, jak robiliśmy to z poprzednimi wręgami (Rysunek 7.1.24).  

Wstaw w środek tego segmentu kadłuba nową linię krawędzi, w stacji 215.1. Dopasuj ją do konturów kadłuba. 

Potem umieść obraz R.Section (tail) w stacjach: 188, 160, 101, 226.5 i dopasuj przekroje wynikowej po-

wierzchni podziałowej do konturów odpowiednich wręg (Rysunek 7.1.25a).  

     

Rysunek 7.1.25  Formowanie końca kadłuba 

Na koniec, aby lepiej dopasować obrys „U” ostatniego konturu, usunąłem górną część ostatniej linii krawędzi 

(Rysunek 7.1.25b). I tak za chwilę usuniemy (modyfikatorem Boolean) większy obszar z tego segmentu kadłu-

ba, a prościej jest dopasować się do górnego narożnika ostatniej wręgi bez tych ścian siatki.    

 

Podczas wstawiania kolejnych wręg ogona (Rysunek 7.1.22b) nie trzeba poprawiać ich położenia. To 

dzięki temu, że dół ogona P-40 jest linią prostą. Gdy tylko ustawisz wręgi #8 i #13, każda nowa linia 

krawędzi wstawiona pomiędzy nimi pasuje do dolnego obrysu kadłuba. 

  

 

Kolejność sprawdzania wręg kadłuba jest istotna. W tekście powyżej sugeruję zacząć od weryfikacji 

linii krawędzi wręgi #13 (stacja 188). Jestem pewien, że wyciągnięcie ostatniego segmentu kadłuba 

zmieniło w tym miejscu kształt powierzchni wynikowej. Gdy z powrotem ją dopasujesz, sprawdź sta-

cje 160 i 201 pod kątem ewentualnych odchyleń. Nie spodziewam się żadnych widocznych różnic w 

sekcji 226.5. Jednak dobrą praktyką jest sprawdzenie wszystkich konturów wzorcowych.  
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Dodaj do obiektu U.500.Fuselage nową bryłę (Rysunek 7.1.26), która odcina „nadmiar materiału” wokół sta-

tecznika poziomego1. Zwróć uwagę na wymiary narożnika przy stacji 231.25 (nie znajdziesz ich na planach):  

 

Rysunek 7.1.26  Dodatkowa bryła tnąca wokół podstawy statecznika 

Ten odcięty kawałek kadłuba przyda się nam jeszcze przy formowaniu oprofilowania usterzenia. Dlatego zdecy-

dowałem się wykonać ten otwór w sposób „odwracalny”, za pomocą modyfikatora Boolean. 

Szczegółowe wymiary2 wykazały, że na otwór kółka ogonowego był dłuższy niż na planach (Rysunek 7.1.27a):  

     

Rysunek 7.1.27  Szczegóły otworu na kółko ogonowe i przybliżenie geometrii jego pokryw 

Zawiasy taśmowe pokryw otworu koła były przymocowane do podłużnicy #9. W P-40 tylna część ogona (za 

wręgą #11 i poniżej osi kadłuba) została przeprojektowana. W porównaniu z P-36, podłużnica #9 została odchy-

lona w górę, tworząc więcej miejsca na podwozie, podczas gdy podłużnica #8 została zakończona na wrędze 

#15. Byłem w stanie dokładnie określić położenie początku i końca tego otworu podwozia (por. Rysunek 

7.1.27a). Jednak jego szerokość jest przybliżona: wykorzystałem tu wymiary pokryw, szacunkowe odchylenie 

podłużnicy #9 i kształt wręg z P-36 (#13, #14, #15, #16)3.  

Kolejnym problemem były zaokrąglone narożniki tego otworu. Dokumentacja podaje ich promienie dla rozwi-

niętej  blachy poszycia. Przybliżmy je za pomocą pomocniczego obiektu (Rysunek 7.1.27b). Nazwij go 

X.500.Tail Wheel.Door. Zaokrąglij jego narożniki za pomocą Bevel (Vertex) (skaluj promienie za pomocą wag) i 

wygładź modyfikatorem Subdivision. Wynikową powierzchnię „połóż” na kadłubie modyfikatorem Shrinkwrap. 

Później w tej książce stworzymy pod tymi pokrywami otwór koła i jego kołnierze (Rysunek 7.1.27a). 

 
1 W tym samolocie statecznik poziomy leżał na wyprofilowanym fragmencie struktury kadłuba. Był przymocowany do jego bocznych okuć 8 

śrubami. Te okucia i łby śrub kryły się pod dolną częścią oprofilowania krawędzi przecięcia statecznika i kadłuba.    

2 Pochodzą z rysunku 87-21-523. Zgodnie z jego tabelką, to ramka otworu na koło ogonowe z P-40B i późniejszych wariantów. W P-40-cu 

ten otwór był krótszy, gdyż pierwsze P-40 miały kółka ogonowe o mniejszej średnicy.     

3 Założyłem, że promienie ich podstawowych konturów pozostały takie same jak w P-36. Użyłem także wymiarów pokryw otworu. 
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Podstawowa części kadłuba jest już uformowana, więc możesz usunąć z jego siatki kontury pomocnicze stwo-

rzone na początku tej sekcji (por. Rysunek 7.1.3). Rysunek 7.1.28 pokazuje rezultat: 

 

Rysunek 7.1.28  Uformowany kadłub za przegrodą silnika 

Oczywiście, w dalszych sekcjach zmodyfikujemy wiele szczegółów tego obiektu. Wytniemy otwór kółka ogono-

wego, stworzymy zagłębienia za kabiną pilota i wiele innych detali.  

 

Podsumowanie 

• Sugeruję podzielić kadłub na (co najmniej) dwa oddzielne obiekty: okapotowanie silnika (od kołpaka śmigła 

do przegrody silnika) i część główną, rozciągającą się od przegrody silnika do steru kierunku (str. 275). 

• Siatka kadłuba jest formowana z krawędzi „podłużnic” i „wręg” (str. 284). Zaczęliśmy od obrysowania po-

mocniczymi krzywymi podziałowymi konturu kadłuba z boku i z góry (str. 276). Ich wierzchołki determinują 

położenie krawędzi „wręg” na siatce. 

• Położenie krawędzi „podłużnic” określiliśmy obrysowując krzywymi podziałowymi kontury dwóch kluczo-

wych wręg (str. 278). 

• Stworzyliśmy pierwsze segmenty powierzchni kadłuba łącząc te początkowe kontury wręg (str. 279, 280). 

Następnie wyciągnęliśmy z nich kolejne segmenty (str. 279, 281, 283, 284). By lepiej odwzorować krzywi-

znę kadłuba, w środku tych segmentów wstawialiśmy dodatkowe linie krawędzi „wręg” (str. 282, 283, 284). 

• Uważaj na krawędzie kokpitu i szyny odsuwanych osłon kabiny (str. 280, 281). 

• Wykorzystaj modyfikatory Boolean i pomocnicze bryły do „przycięcia” wynikowej powierzchni kadłuba i 

stworzenia ewentualnych otworów (str. 283, 285). 

• Czasami możesz zdecydować się modelować otwór bezpośrednio w siatce (str. 275). To jest proste, jeżeli 

narożniki jego krawędzi leżą na płaskim fragmencie kadłuba. Tak uformowaliśmy otwór kokpitu (str. 280). 

• Aby uzyskać ostry narożnik otworu modelowanego bezpośrednio w siatce wygładzonej modyfikatorem 

Subdivision Surface, w co najmniej dwóch z jego krawędzi ustaw współczynnik Crease na 1 (str. 280).    

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-11.01.blend. 

  

Przegroda 
silnika 
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7.2 Osłona silnika 

W tej sekcji uformujemy podstawową bryłę osłony silnika P-40 (Rysunek 7.2.1). Następne sekcje tego rozdziału 

poświęcę szczegółom w jej górnej i dolnej części (osłonie chłodnicy), ze względu na ich złożoną geometrię. 

 

Rysunek 7.2.1  Przednia część kadłuba, którą stworzymy w tej sekcji 

Jedną z baz wymiarowych osłony jest oś śmigła. Ta oś leży 1” ponad osią kadłuba (Z=0), której używaliśmy w 

poprzedniej sekcji. Stacje osłony mają ujemne numery, odpowiadające ich współrzędnym na osi Y. Na przykład: 

podstawa kołpaka śmigła leży na stacji -92 5/16, chwyt powietrza do chłodnicy cieczy na stacji -74, i tak dalej. 

Stacja 0 to płaszczyzna dolnej części przegrody silnika. . 

W tej sekcji użyjemy następujących obrazów referencyjnych (dodaliśmy je do tego projektu już wcześniej): 

• R.Side.Left (compiled) - widok z boku. 

• R.Top (Temma) - widok z góry. Na tym rysunku zaznaczyłem na czerwono dokładniejszy kontur 

osłony silnika. 

• R.Sections (middle) - zawiera kontury ostatnich 4 przekrojów (pomiędzy stacjami -32 i 0). 

• R.Sections (cowling) - zawiera kontury przekrojów od podstawy kołpaka śmigła do stacji -44.  

Oryginalna dokumentacja tego zespołu dla wczesnych wariantów P-40 zaginęła. Będę tu korzystał z wymiarów 

odcyfrowanych z kilku zachowanych szkiców XP-40 (por. Tom I, sekcja 9.7). Opisują one końcową wersję tego 

prototypu, wg stanu z zimy 1939/40. Porównując te obrysy ze zdjęciami doszedłem do wniosku, że kontur osło-

ny chłodnic w seryjnych P-40-cu/B/C był głębszy o 1.5” niż w XP-40. Naniosłem jego przypuszczalny kształt na 

rysunek referencyjny R.Side.Left (compiled) (niebieskie linie – por. Rysunek 7.2.1).   

Najpierw uformujemy nieco uproszczoną, główną bryłę tej osłony. Potem użyjemy modyfikatorów Boolean do 

wycięcia w tej powierzchni miejsc na szczegóły, takie jak chwyt powietrza do silnika, osłony km, czy wlot chłod-

nicy. W prawdziwym samolocie były one także tworzone z oddzielnych części (Rysunek 7.2.2): 

 

Rysunek 7.2.2  Szczegóły osłony silnika na fabrycznie nowym P-40 (jeszcze bez km) 
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Zacznijmy formowanie od obrysowania krzywymi konturów osłony w rzucie z góry. W tym rzucie promień krzy-

wizny wokół stacji -74 wydaje się mniejszy niż na konturach z boku1 (Rysunek 7.2.3a):  

      

Rysunek 7.2.3  Przygotowanie wstępnych konturów okapotowania silnika  

Stwórz nowy obiekt Plane w kolekcji 2b.Cowling. Nazwij go B.600.Cowling i od razu dodaj modyfikatory Mirror 

i Subdivision Surface. Przekształć tę początkową ścianę w pojedynczą krzywą podziałową, obrysowując czer-

wony kontur zaznaczony na obrazie R.Top (Temma). W stacji -74 musiałem utworzyć „ostry” narożnik: tak się 

objawia nieciągłość promieni krzywizny. Być może będziemy musieli wstawić w tym miejscu „ostrą” krawędź, tak 

jak w ogonie, w stacji 106 (por. str. 277, 283). Jednak kształt wynikowej powierzchni podziałowej zazwyczaj 

odrobinę się różni od takich wstępnych krzywych2, więc może obędzie się tutaj bez zwiększania wspc. Crease. 

Górny i dolny kontur osłony wydają się być podobne do konturów bocznych. Stwórz je więc poprzez obrót kopi 

krzywej bocznej (Rysunek 7.2.3b). Potem przesuń ich wierzchołki wzdłuż osi Z, dopasowując do konturów w 

rzucie z boku. W ten sposób nie musisz uzgadniać liczby i położenia odpowiednich wierzchołków, jak to robili-

śmy w przypadku konturów kadłuba za przegrodą silnika (por. str. 277).     

Rysunek 7.2.4 pokazuje dolny kontur chłodnicy. Zwróć uwagę na przerwę w stacji -74. W docelowej siatce bę-

dzie tu otwór. Potem modyfikatorem Boolean wytniemy obszar dookoła (do stacji -72) i wstawimy w to miejsce 

bardziej szczegółową siatkę (oddzielny obiekt) wlotu powietrza do chłodnicy. 

  

Rysunek 7.2.4  Szczegóły konturów bocznych Rysunek 7.2.5  Formowanie przekroju ze stacji -74 

Gdy kontury z boku, góry i dołu są gotowe, uformuj pierwszy z kluczowych przekrojów w stacji -74 (Rysunek 

7.2.5). Zacząłem od 24-bocznego okręgu, który powiększyłem i dopasowałem do konturów na rysunku. Aby 

odtworzyć kontur dolny, dodałem dwa dodatkowe wierzchołki w narożniku wlotu chłodnicy.   

 
1 Nie biorę pod uwagę zaokrągleń wlotów powietrza do silnika czy chłodnicy. Na razie tworzymy uproszczoną wersję powierzchni  

2 Powierzchnie podziałowe Carmull-Clarka „degradują” się w krzywe podziałowe tylko wzdłuż swoich brzegów (oraz tych krawędzi, których 

Crease = 1). Wszystkie inne punkty są wyznaczane w nieco inny sposób (por. str. 1498, 1504, 1509) 
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Drugi kluczowy przekrój leży w stacji 0. Obrysowałem jego górną część (ponad skrzydłem) korzystając z po-

wierzchni obiektu B.500.Fuslage (Rysunek 7.2.6a). Aby uzyskać zaokrąglone narożniki osłon km, musiałem 

dodać kolejne trzy wierzchołki, zwiększając ich liczbę ponad osią kadłuba do 10:  

     

Rysunek 7.2.6  Formowanie przekroju kadłuba w stacji 0  

Kształt niższej części przekroju kadłuba w stacji 0 (tej pod skrzydłem) był czystą spekulacją, dopóki nie znala-

złem wymiarów jego dolnych 120º we współrzędnych kila1 (por. Rysunek 7.2.1). Rysunek 7.2.6b) podaje poło-

żenie odpowiednich punktów sterujących (wierzchołków siatki) tej krzywej podziałowej, ponieważ nie ma jej na 

obrazie referencyjnym. Na koniec, aby uzgodnić liczbę wierzchołków pomiędzy kolejnymi „wręgami”, wstawiłem 

trzy dodatkowe punkty do konturu w stacji -74 (Rysunek 7.2.6c). Oczywiście, ich obecność zmieniła kształt tej 

krzywej, więc musiałem znów dopasować zmodyfikowany fragment do rysunku referencyjnego.  

Według szkiców XP-40, przekrój osłony w stacji -90 3/4 był regularnym okręgiem. Aby dopasować się do liczby 

wierzchołków w poprzednich dwóch „wręgach”, stwórz go jako 32-boczne Circle. Potem wstaw dodatkowy 

wierzchołek w górny kontur i przekształć kontur wynikowy z powrotem w okrąg (Rysunek 7.2.7): 

  

Rysunek 7.2.7  Formowanie przekroju kadłuba w stacji -90 3/4  Rysunek 7.2.8  Dodatkowy przekrój w stacji -74 

Na koniec dodaj kolejny kontur w stacji -74, ponad wlotem chłodnicy (Rysunek 7.2.8). Choć zamierzamy usunąć 

tę część finalnej powierzchni modyfikatorem Boolean, spodziewam się użyć jej jako wzorca podczas formowa-

nia szczegółowej siatki tego wlotu.  

 
1 Na dostępnych zdjęciach, „kil” pod skrzydłem wydaje się identyczny we wszystkich wariantach P-40 (od P-40-cu do P-40N). Wśród rysun-

ków z AirCorps Library można znaleźć trzy segmenty tego kila (87-23-504, 87-23-503, 87-23-502). Każdy z nich zawiera współrzędne jego 

kolejnych przekrojów. Co interesujące, tabela ze współrzędnymi przedniej części zawiera także wiersz dla stacji 0. Jednak ten rysunek 

pochodzi z wrzęśnia 1940, najprawdopodobniej z P-40D. Potem jednak znalazłem te same współrzędne w całkiem niespodziewanym miej-

scu: na rysunku przyłącza pokrywy kila (87-23-015). Według jego tabelki tytułowej, pierwsza setka tych części była przygotowana dla P-40-

cu. To byłoby potwierdzenie, że te współrzędne dotyczą wszystkich wariantów P-40.  
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Stwórz pierwszą część powierzchni osłony silnika łącząc początkowe kontury przy przegrodzie (stacji 0) i stacji 

-74 (Rysunek 7.2.9a):  

     

Rysunek 7.2.9  Formowanie podstawowej powierzchni (od przegrody silnika do stacji -74) 

Potem wstaw w Y=-52.21 (Rysunek 7.2.9b) pierwszą z zaplanowanych sekcji środkowych. Potem ustaw środek 

transformacji na przecięciu osi śmigła z tą stacją (X:0, Y:-52.21, Z:1). W pierwszym kroku skaluj tą linię wierz-

chołków, dopasowując ją do wierzchołków (punktów sterujących) krzywych przygotowanych na str. 288.    

Choć w tym momencie szerokość i wysokość powierzchni wynikowej mogą odbiegać od krzywych wzorcowych, 

to jej przekrój poprzeczny powinien przypominać poprawny kontur. Dopasujmy ją do stacji najbliższej do tej 

środkowej sekcji. Umieść obraz referencyjny w stacji -54 (Rysunek 7.2.9b). Na czas tej operacji wyłącz jego 

przejrzystość i włącz w oknie 3D opcję X-Ray (Rysunek 7.2.10a). W widoku z przodu przesuwaj wierzchołki 

środkowej krawędzi tak, aby przekrój powierzchni wynikowej biegł wzdłuż konturu stacji -54 (Rysunek 7.2.10b):   

     

Rysunek 7.2.10  Przybliżanie kształtu środkowej sekcji (w stacji -54) 

Zachowaj takie odstępy obrysu od wzorcowego konturu -54, jaki widzisz na osiach Z i X (Rysunek 7.2.10). Użyj 

tej samej metody do dopasowania dolnego przekroju powierzchni wynikowej do dolnego konturu stacji -54.  

 

Dopasowujemy na razie tylko wysokość i szerokość takich środkowych sekcji. To pierwsze przybli-

żenie ich kształtu. Na razie kształt nowo wstawionych krawędzi może odbiegać od rysunków refe-

rencyjnych. Dokładnie dopasujemy ich kontury po wstawieniu wszystkich zaplanowanych sekcji.    
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Gdy przygotujesz w ten sposób pierwszą środkową sekcję, będziesz miał mniej pracy z dopasowywaniem po-

zostałych krawędzi „wręg” zaplanowanych dla tej siatki. Wstaw je teraz (Rysunek 7.2.11a):  

      

Rysunek 7.2.11  Wstawianie wszystkich linii krawędzi „wręg” przewidzianych dla tego segmentu 

Po wstawieniu, skaluj ich szerokości i wysokości, dopasowując do wierzchołków pomocniczych konturów (por. 

Rysunek 7.2.9b). Potem dopasuj je do wzorcowych konturów przekrojów (por. Rysunek 7.2.10b). Tym razem 

zrób to dokładnie (ponieważ wszystkie zaplanowane punkty sterujące tej siatki są już na swoim miejscu). Mo-

żesz sobie pomóc kopiując obraz R.Sections (cowling) i umieszczając każdą z tych kopii w odpowiednich sta-

cjach: -64, -54, -44, -32. Dla dolnych części sekcji -32, -22, -11, 0 użyj kopii obrazu R.Sections (middle).   

Abyś mógł się przekonać, jaka jest różnica pomiędzy używaniem obrazów a obiektów referencyjnych, przygo-

towałem pełen „wzorcowy szkielet” P- 40B. Znajdziesz go w materiałach, które towarzyszą tej książce (por. str. 

620, Rysunek 15.2.7). Zaimportuj z tego pliku do swojego projektu scenę o nazwie Reference (por. opis na str. 

620) i ustaw ją jako „tło” – tzw. Background Scene (Rysunek 7.2.12): 

 

Rysunek 7.2.12  Dokładniejsza technika: dopasowywanie powierzchni wynikowej do wzorcowego „szkieletu” 

Podczas formowania tej części osłony, na stacji -64 możesz nadal dopuścić jakieś niewielkie różnice (poniżej 

0.1”). Ostatecznie uformujemy ją wraz przednią częścią osłony (od kołpaka śmigła do stacji -74). 

 

W takim rzędzie wielu obrazów jeden często zasłania drugi. Jeżeli chcesz odtworzyć ten kształt z 

większą dokładnością, możesz przygotować, jako oddzielne obiekty, wzorcowe kontury tych przekro-

jów. (Coś w rodzaju pomocniczego „wzorcowego szkieletu” formowanej bryły).      
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Stwórzmy przednią część osłony. Zacznij od połączenia konturów ze stacji -74 i -90.75 (Rysunek 7.2.13a). Po-

tem wstaw w środek linię krawędzi w Y = -81.15 (Rysunek 7.2.13b) i dopasowaniu wynikowej powierzchni do 

obrazów referencyjnych (lub do „wzorcowego szkieletu”):   

        

Rysunek 7.2.13  Formowanie przedniej części osłony silnika 

Dzięki temu, że przekroje od stacji -90.75 to regularne okręgi, możemy uformować zaokrągloną przednią kra-

wędź osłony silnika poprzez wyciąganie i skalowanie. Wstaw w środek tego ostatniego, krótkiego segmentu 

siatki dwie dodatkowe linie krawędzi, aby uzyskać taki kształt, jak na konturach wzorcowych (Rysunek 7.2.14): 

      

Rysunek 7.2.14  Formowanie zaokrąglenia za kołpakiem  Rysunek 7.2.15  Dodatkowa ściana w narożniku stacji -74 

W związku z tym, że ostatecznie nie oznaczyliśmy krawędzi w stacji -74 jako „ostrych” (Crease = 1), stwórz w 

narożniku jej otworu trójkątną ścianę (Rysunek 7.2.15). 

Linia krawędzi ze stacji -81.15 wystarcza do dopasowania powierzchni wynikowej do konturów z boku i z góry. 

Jednak okazuje się, że nie wystarcza do dokładnego dopasowania kolejnych przekrojów pomiędzy osią pozio-

mą i pionową. Aby odwzorować ten kształt, wstawiłem dodatkową linię krawędzi w Y = -89.19. Jej obecność 

zmusiła mnie do przesunięcia dwóch przednich krawędzi „wręg” (-90.75→-91.80, por. Rysunek 7.2.16): 

  

Rysunek 7.2.16  Końcowe dopasowywanie powierzchni  Rysunek 7.2.17  Usuwanie konturów pomocniczych 

Gdy powierzchnia osłony silnika jest dopasowana, sprawdź jeszcze raz wszystkie jej kontury. Gdy nie widzisz 

żadnego błędu, możesz usunąć jej krzywe pomocnicze z siatki (Rysunek 7.2.17). 
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krawędzi, formując 

zaokrąglenie z przodu 

-90.75 

-90.75 
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Gdy powierzchnia osłony jest uformowana, możemy ją przyciąć modyfikatorami Boolean. Zanim jednak to zro-

bimy, wytnijmy linie łączenia paneli. W widoku z przodu są to linie proste (Rysunek 7.2.18a): 

      

Rysunek 7.2.18  Pomocniczy obiekt do wycięcia linii połączeń paneli 

Te panele były mocowane zamkami dzus do rozciągniętych pod nimi podłużnic. Przygotuj pomocniczy obiekt 

tnący o nazwie U.600.Panel Seams składający się z czterech płaszczyzn. Obróć te płaszczyzny wokół osi śmi-

gła (Rysunek 7.2.18a). Potem uczyń je symetrycznymi (modyfikatorem Mirror) i nadaj im grubość 0.05” (modyfi-

katorem Solidify). W rezultacie ten pomocniczy obiekt powinien wyglądać tak, jak pokazuje Rysunek 7.2.18b). 

Teoretycznie, moglibyśmy połączyć te „płaszczyzny podziału” z blokami, którymi przytniemy tę osłonę (Rysunek 

7.2.19a). Jednak taka kombinacja wymagałaby użycia przy przecinaniu wolniejszej opcji Exact. Lepszym pomy-

słem jest stworzyć z tych bloków drugi obiekt tnący i zastosować dla obydwu opcję Fast.  

      

Rysunek 7.2.19  Pomocniczy obiekt do przycięcia powierzchni osłony 

Jak widać powyżej, zacząłem od pojedynczego bloku, wycinającego górną panel (Rysunek 7.2.19a). Stworzymy 

ją oddzielnie, wraz z chwytem powietrza do silnika. Potem wyciągnąłem na bok z tego klina „pudełko”, które 

przycina powierzchnię wzdłuż pokryw km, aż do głównego dźwigara (do Z=17, por. Rysunek 7.2.19b). 

Rozbudujmy ten obiekt tnący o bloki przycinające dolne powierzchnie (Rysunek 7.2.20): 

      

Rysunek 7.2.20  Dodatkowe bryły tnące 
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W oparciu o wyblakłe, niemal nieczytelne szkice Curtiss, oszacowałem, że kontur wlotu do chłodnicy w stacji 

-72 był łukiem o promieniu = 14.125 i środku w Z = -13.75 (Rysunek 7.2.21). Stworzyłem taki obiekt wzorcowy. 

Gdy w dalszej części tego rozdziału będziemy formować szczegóły tego wlotu, użyjemy centrum tego okręgu 

jako środka transformacji. Oczywiście, takie założenia dotyczące kształtu osłony chłodnicy wymagają dalszej 

weryfikacji (por. Rozdział 14).   

  

Rysunek 7.2.21  Wzorcowy okrąg wlotu chłodnicy  Rysunek 7.2.22  Obiekt wycinający otwór rur wydechowych 

W bokach osłony silnika P-40 znajdowały się otwory na rury wydechowe. Ich kształt jest także przybliżeniem, 

opartym na geometrii silnika Allison i częściowych rysunkach Curtiss. Dlatego użyłem do ich wycięcia dedyko-

wanego obiektu tnącego, który będzie łatwo poddać ewentualnym modyfikacjom (Rysunek 7.2.22). 

Rysunek 7.2.23 pokazuje szczegóły geometrii tego obiektu. To proste „pudełko”, z narożnikami zaokrąglonymi 

modyfikatorem Bevel (Weight) (promień: 1”). Prawa strona jest wygenerowana przez modyfikator Mirror 

(względem płaszczyzny symetrii kadłuba). Użyj tego obiektu w kolejnym modyfikatorze Boolean, dodanym do 

obiektu osłony. Określ długość i położenie tego „pudełka” dopasowując kształt uzyskanego otworu w po-

wierzchni okapotowania silnika z rzutem z boku. Użyłem do tego obrazu R.Side.Left (compiled):   

   

Rysunek 7.2.23  Szczegóły otworów rur wydechowych 

W przyszłości taki obiekt tnący można będzie łatwo zmodyfikować (gdyby się okazało, że otwory na rury wyde-

chowe nie pasują do zdjęć rzutowanych na ten model). 

 

Osłona silnika jest najmniej udokumentowanym podzespołem wczesnych wariantów P-40. Na przy-

kład – linia podziału górnej paneli (por. Rysunek 7.2.18a) jest oparta na zdjęciach i różnych założe-

niach. To samo dotyczy szczegółów osłony chłodnic cieczy. 
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Rysunek 7.2.24 pokazuje rezultat w tej sekcji – wstępną wersję osłony silnika:  

 

Rysunek 7.2.24  Ukończona w tej sekcji osłona silnika 

 

Podsumowanie 

• Osłona silnika jest najmniej udokumentowanym podzespołem wczesnych wariantów P-40 (do P-40C 

włącznie). Wiele jej szczegółów jest opartych na przypuszczeniach (założeniach) i może ulec zmianie w 

wyniku odnalezienia nowych materiałów referencyjnych. 

• Zaczęliśmy od obrysowania pomocniczymi krzywymi konturów osłony z góry i z boku (str. 288). Ich wierz-

chołki określiły położenie (stacje) krawędzi „wręg” przyszłej siatki. Następnie uformowaliśmy kontury trzech 

kluczowych przekrojów, w stacjach 0, -74 i -95.75 (str. 288, 289). Wszystkie trzy mają taką samą liczbę 

wierzchołków. 

• Uformowaliśmy powierzchnię osłony silnika łącząc trzy przygotowane kontury przekrojów (str. 290 - 292). 

W środku tych segmentów wstawiliśmy dodatkowe linie krawędzi (str. 291, 292). Każda z nich odpowiada 

jednemu z wierzchołków pomocniczych konturów (str. 291). Wynikowa powierzchnia podziałowa jest dopa-

sowana do konturów wzorcowych przekrojów (str. 290, 291, 292). Aby dokładniej dopasować ją do tych ob-

rysów, czasami musieliśmy wstawić dodatkową („niezaplanowaną”) linię krawędzi (str. 292). 

• Aby przyciąć tę osłonę, użyliśmy pomocniczych obiektów tnących i modyfikatorów Boolean (str. 293). Jed-

nym z nich jest obiekt wycinający krawędzie (połączenia) paneli (str. 293). Przypuszczam, że w przyszłości 

będziemy musieli poprawiać kształt otworu na rury wydechowe. Dlatego stworzyłem ich bryłę tnącą jako 

oddzielny obiekt, skojarzony z trzecim modyfikatorem Boolean dodanym do obiektu osłony silnika.    

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-11.02.blend. 
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wyłącz tę opcję 



296 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

7.3 Chwyt powietrza do silnika 

Odtworzenie szczegółów osłony silnika wczesnych wariantów P-40 wymaga dużo pracy, więc zdecydowałem 

się poświęcić każdemu z tych elementów odrębną sekcję tego rozdziału. W tej opiszę formowanie chwytu po-

wietrza do silnika. Pokazywałem go już na początku poprzedniej sekcji (Rysunek 7.3.1): 

 

Rysunek 7.3.1  Szczegóły chwytu powietrza do silnika 

Ten chwyt miał okrągły wlot powietrza. Dalszy kanał, ukryty pod osłoną silnika, doprowadzał je do gaźnika 

Stromberg, umieszczonego za cylindrami silnika Allison. Wlot do tego gaźnika był prostokątny. Zakładam, że 

przekroje poprzeczne kanału powietrza P-40 płynnie przechodziły z okręgu na początku w prostokąt na końcu.     

Szukałem jakiegokolwiek rysunku tego podzespołu. Jedyne, co znalazłem, to szkic (SK-2603) odlewu wlotu 

powietrza. Według tabelki znamionowej, jest to część dokumentacji XP-40 (Rysunek 7.3.2): 

 

Rysunek 7.3.2  Szkic SK-2603 z dokumentacji XP-40 

Wygląda podobnie do tej samej części z seryjnych P-40-cu, pokazywanych przez Rysunek 7.3.1. Jednak nie 

zakładaj, że były identyczne – nie mamy nic na potwierdzenie takiej hipotezy. 

W naszym modelu, sugeruję podzielić tę górną panel na dwie części wzdłuż tylnej krawędzi tego odlewu (jak w 

oryginalnym samolocie). Najpierw uformujemy część tylną, potem bardziej złożoną siatkę części z wlotem. 
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https://app.aircorpslibrary.com/drawing/viewer/SK-2603/p-40


Rozdział 7 Kadłub 297 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

W związku z brakiem dokumentacji, kształt osłony za wlotem ze szkicu SK-2603 będzie moją spekulacją. Stwo-

rzyłem ją korzystając z dostępnych zdjęć i geometrii wlotu do gaźnika silnika Allison. 

Na początek, uformujmy wewnętrzny kanał, który przenosił napływające powietrze ponad cylindrami silnika do 

wlotu gaźnika. Zacznij od stworzenia prostej rury, łączącej okrągły przekrój z przodu (o średnicy 6.5”) z prosto-

kątnym przekrojem z tyłu (4.75” x 7.45”), tak jak to pokazuje Rysunek 7.3.3a):  

        

Rysunek 7.3.3  Formowanie wewnętrznego kanału powietrza do gaźnika 

Nazwij ten obiekt B.610.Carburetor duct. Wstaw w środek tej siatki dwie nowe sekcje, a potem wygnij go 

wzdłuż pomocniczej krzywej (Q.610.Carburetor duct) za pomocą modyfikatora Curve (str. 555). Pokazuje to 

Rysunek 7.3.3b). Kształt przecięcia tego kanału z podstawową powierzchnią osłony (Rysunek 7.3.3c) pozwala 

się zorientować, co mają zasłonić kolejne kontury przekrojów poprzecznych górnej paneli.   

Jak zazwyczaj, zacznijmy formowanie siatki tego zewnętrznego panelu od podprowadzenia konturów jego klu-

czowych krzywych. W tym przypadku są to jego kontury zewnętrzne (Rysunek 7.3.4a):  

     

Rysunek 7.3.4  Wstępne kontury panelu zewnętrznego 

Unikaj umieszczenia zbyt wielu wierzchołków w tylnym łuku. Z tego powodu, na początek nie tworzyłem łuków 

w narożnikach przedniego konturu. Są tam zwykłe krzywe podziałowe rozciągnięte na trzech wierzchołkach. 

Krzywe przednia i tylna zawierają po 7 węzłów (wierzchołków), odbitych względem płaszczyzny symetrii. 

Krawędź boczna biegnie wzdłuż linii podziału paneli (por. str. 293, Rysunek 7.2.18). Aby łatwo odtworzyć ten 

pochylony kontur, utworzyłem ją jako oddzielny obiekt, obrócony o 10º (por. Rysunek 7.3.4b). Taka orientacja 

pozwala mi przesuwać wierzchołki krzywej wzdłuż lokalnych osi tego obiektu, zachowując nienaruszony prosty 

kontur tej krawędzi w rzucie z przodu.  
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Stwórz pierwsze ściany siatki łącząc wierzchołki jej przedniej i tylnej krawędzi (Rysunek 7.3.5a):  

     

Rysunek 7.3.5  Połączenie przedniego i tylnego konturu 

Wstaw dwie dodatkowe krawędzie „podłużne” (Rysunek 7.3.5b), które pozwalają nam uzyskać w narożniku 

przedniej krawędzi regularny łuk. Teraz w naturalny sposób wyjaśniło się, gdzie na tylnej krawędzi mają leżeć te 

dodatkowe dwa wierzchołki. 

Teraz wstaw w środkowym z zaplanowanych miejsc nową linię krawędzi „wręg” (Rysunek 7.3.6a): 

     

Rysunek 7.3.6  Wstawianie środkowych linii krawędzi 

Zmniejsz tę krawędź wzdłuż osi Z i wygładź jej kontur („S”) przesuwając wierzchołki. Gdy już ją uformowałeś i 

dopasowałeś do rysunku referencyjnego i krawędzi panelu, wstaw kolejną linię krawędzi (Rysunek 7.3.6b). 

Umieszczaj każdą z nich w odpowiednim wierzchołku krzywej krawędzi panelu i dopasowuj do linii na obrazie. 

W ten sam sposób wstaw i dopasuj trzy linie krawędzi z przodu (Rysunek 7.3.7a), także zaczynając od środko-

wej (tej ze stacji -73.34). Potem dopasuj tylną i boczne krawędzie powierzchni wynikowej do oryginalnej osłony 

silnika (Rysunek 7.3.7b): 

     

Rysunek 7.3.7  Dokończenie formowania górnej paneli 

Aby widzieć tę część podstawowej powierzchni osłony, wyłącz opcję Realtime w pierwszym z jej modyfikatorów 

Boolean (por. str. 295). (W przykładzie pokazanym przez Rysunek 7.2.24 to modyfikator Boolean (blocks)). 
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Rysunek 7.3.8 pokazuje ukończoną tylną część górnego panelu osłony. Nazwij ją B.615.Cowling.Top.Rear: 

 

Rysunek 7.3.8  Tylna część górnego panelu osłony silnika  

Teraz możesz usunąć pomocniczy kontur boczny (nazwałem go X.615.Panel side – por. Rysunek 7.3.8), po-

nieważ nie będziemy już go potrzebować. 

Zacznijmy przednią część – wlot powietrza – od narysowania jego kluczowych konturów (Rysunek 7.3.9):  

     

Rysunek 7.3.9  Wlot powietrza – kontury początkowe 

Stwórz te krzywe jako nowy obiekt, o nazwie B.620.Cowling.Top.Forward. Dla tego pierścienia będziemy po-

trzebować nieco gęstszej siatki niż dla tylnej części, więc oprzyj ją o 16-boczne Circle. W widoku z boku uformuj 

także przekrój poprzeczny pierścienia. Odwzoruj go korzystając ze szkicu pokazanego przez Rysunek 7.3.2.  

Zacznij formowanie siatki wlotu od wyciągnięcia tego poprzecznego konturu. Obracaj wyciąganie krawędzie o 

22.5º wokół lokalnej osi Z, tworząc pierścień (Rysunek 7.3.10a):  

     

Rysunek 7.3.10  Wlot powietrza – wyciąganie podstawowego pierścienia 

Skaluj promień przedniej krawędzi kanału powietrza (B.610.Carburetor duct), aby dopasować go do szeroko-

ści wewnętrznego pierścienia, mierzonej wzdłuż globalnej osi X. Potem w widoku z boku dopasuj krzywą 

Q.610.Carburetor duct, tak aby kontur boczny kanału także pasował do pierścienia wlotu (Rysunek 7.3.10b). 
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Zwróć uwagę, że Rysunek 7.3.10b) pokazuje dolny kontur kanału powietrza poniżej konturu krawędzi podsta-

wowej bryły osłony silnika, podczas gdy na SK 2603 (Rysunek 7.3.2) leży on na tym konturze. To wynik porów-

nania ze zdjęciami referencyjnymi – widać w seryjnych P-40 dokonano drobnej korekty tego kształtu. 

W następnym kroku, połącz odpowiednie wierzchołki z tylnej i przedniej krawędzi tej siatki. Wstaw w uzyskany 

„pasek” trzy dodatkowe krawędzie. Dopasuj te ściany do powierzchni osłony silnika (Rysunek 7.3.11a): 

     

Rysunek 7.3.11  Łączenie pierwszych fragmentów przedniej i tylnej krawędzi siatki 

Usuń dolne wierzchołki z pierścienia wlotu (por. Rysunek 7.3.10a), a potem połącz wewnętrzną stronę pierście-

nia z odpowiednimi wierzchołkami z przedniej krawędzi siatki (Rysunek 7.3.11b).  

Wyciągnij dolną krawędź natarcia pierścienia (Rysunek 7.3.12a) a potem wyciągnij jego przednie ściany w kra-

wędź natarcia oprofilowania wlotu (Rysunek 7.3.12b): 

     

Rysunek 7.3.12  Wyciąganie ścian bocznych 

 

 

 

 

Pamiętaj, że używamy szkicu z dokumentacji prototypu. Wygląda na to, że przygotowując P-40 do 

produkcji seryjnej wprowadzono kilka modyfikacji. Można je zidentyfikować tylko na zdjęciach.    
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Stwórz nowe ściany ( F ), które zamykają luki w tej siatce (Rysunek 7.3.13):  

     

Rysunek 7.3.13  Zamykanie luk w siatce 

Rysunek 7.3.14a) pokazuje uzyskany kształt, a Rysunek 7.3.14b) – szczegóły topologii jego siatki: 

     

Rysunek 7.3.14  Uformowany wlot powietrza i jego siatka 

Skróć do stacji -86 górny blok pomocniczego obiektu przycinającego powierzchnię osłony silnika (Rysunek 

7.3.15). Użyj go także w modyfikatorze Boolean (Intersection) do przycięcia powierzchni wlotu:  

      

Rysunek 7.3.15  Przycinanie powierzchni wlotu   Rysunek 7.3.16  Szczegóły tylnej krawędzi wlotu  

Podczas formowania tych dwóch części górnej paneli, zapomniałem, że tylna część zachodziła na odlew wlotu 

(Rysunek 7.3.16). W rezultacie linia podziału była w stacji -82, podczas gdy ja umieściłem ją nieco bliżej prze-

grody silnika. Aby przesunąć tą linię podziału, dodamy nowe paski ścian o szerokości 7/8” do tylnej części pane-

lu i kanału powierza. O tę samą szerokość przytniemy tylną krawędź wlotu.  
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Najpierw, wyciągnij do przodu przednią krawędź tylnej części o 7/8” (0.875) (Rysunek 7.3.17a). Potem wstaw w 

środek tego paska kolejną linię krawędzi (Rysunek 7.3.17b). Zmniejsz wspc. Crease krawędzi ze stacji -81.125 

na 0, i dopasuj przód paska do powierzchni pierścienia wlotu (użyj kontrastowej barwy obiektu):  

     

Rysunek 7.3.17  Wyciąganie przednich krawędzi tylnej części panelu 

Gdy tylna panel pasuje do wlotu, stwórz kolejną pomocnicza bryłę tnącą i dodaj do obydwu części górnego pa-

nelu modyfikatory Boolean, które przytną je wzdłuż tej linii (Rysunek 7.3.18):  

     

Rysunek 7.3.18  Przycinanie powierzchni wzdłuż linii podziału   Rysunek 7.3.19  Dopasowanie kanału powietrza  

Dopasuj i przytnij w podobny sposób za pierścieniem wlotu wewnętrzny kanał powietrza (Rysunek 7.3.19). 

Rysunek 7.3.20 pokazuje gotową górną panel, z włączonymi obrysami obiektów i bez tych obrysów: 

     

Rysunek 7.3.20  Gotowy chwyt powietrza do silnika 
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Podsumowanie 

• Znalazłem tylko pojedynczy szkic chwytu powietrza do silnika z XP-40 (str. 296). Nawet ten rysunek różni 

się w pewnych szczegółach od części użytych w P-40-cu, B, C (str. 299). W praktyce, cała ta geometria 

jest oparta na różnych założeniach i wymaga dokładniejszego sprawdzenia ze zdjęciami. 

• Chwyt powietrza do gaźnika zajmuje większą część górnej paneli osłony silnika (str. 296), więc stworzyli-

śmy go jako tę panel. Był podzielony na część przednią (od kołpaka śmigła do stacji -82: por. str. 299) i tyl-

ną (od stacji -82 do pokrywy km: por. str. 301). Odtworzyliśmy te części jako oddzielne obiekty. Dodatkowo 

wykorzystaliśmy przycięty przód podstawowej powierzchni osłony jako dodatkową, trzecią część (str. 301). 

• Zaczęliśmy od uformowania wewnętrznego kanału powietrza (str. 297), jako „rury” wygiętej wzdłuż pomoc-

niczej krzywej. Jeden z jej końców jest dopasowany do okrągłego przekroju wlotu powietrza, podczas gdy 

drugi – do prostokątnego kształtu gaźnika silnika Allison. Kształt wynikowych konturów tego kanału dostar-

czył wskazówek co do kształtu „okrywającego” go górnego panelu. 

• Początkowo, tylna część tego panelu była obrysowana przez przednią, tylną i boczną krzywą (str. 297). 

Liczby wierzchołków (węzłów) przedniej i tylnej krzywej były identyczne. Wierzchołki (węzły) bocznej krzy-

wej określały położenie środkowych linii krawędzi „wręg” przyszłej siatki. 

• Uformowaliśmy górną panel łącząc jej przednią i tylną krawędź (str. 298), a potem wstawiając dodatkowe 

linie krawędzi w środku (str. 298). Brzegi powierzchni wynikowej zostały dopasowane do powierzchni ba-

zowej osłony silnika. 

• Nowa, przednia część górnego panelu została ograniczona do obiektu odpowiadającego oryginalnemu od-

lewowi (str. 301). Reszta tej części, pomiędzy kołpakiem śmigła i stacją -86 została „zaadoptowana” z pod-

stawowej powierzchni osłony silnika. 

• Odtworzyliśmy odlew wlotu powietrza zaczynając od kilku wstępnych konturów (str. 299). Na początek, 

utworzyliśmy regularny pierścień z przodu kanału powietrza (str. 299). Potem usunęliśmy dolną część tego 

pierścienia i podłączyliśmy jego środkowe i boczne wierzchołki z przednią krawędzią (str. 300). Na koniec 

wyciągnęliśmy krawędzie natarcia oprofilowania wlotu (str. 300) i zamknęliśmy pozostałe luki w siatce no-

wymi ścianami (str. 301). 

• Aby przyciąć krawędzie tej osłony, użyliśmy dwóch obiektów tnących i modyfikatorów Boolean (str. 301, 

302). Jednego z tych obiektów już używaliśmy do przycinania podstawowej osłony (U.600.Blocks), pod-

czas gdy drugi (U.620.Air scoop) został dodany specjalnie z myślą o tym wlocie powietrza. 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-11.03.blend. 
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7.4 Osłony luf km 

W tej sekcji odtworzymy osłony wokół luf nkm 12.7mm (a właściwie ich przedłużenia), montowanych w kadłu-

bach wczesnych wersji P-40 (Rysunek 7.4.1): 

 

Rysunek 7.4.1  Szczegóły osłon luf km 

W większości samolotów z II W.Ś. napotkasz „negatyw” takich osłon: wgłębienia w kadłubie. Metoda modelo-

wania i jednych, i drugich, jest jednak taka sama. 

Podobnie jak w przypadku chwytu powietrza do silnika, znalazłem tylko jeden szkic (SK-2605) tego podzespołu 

z dokumentacji XP-40. Ukazuje on kluczowy element: odlewaną z aluminium ramkę, do której było przynitowa-

ne blaszane poszycie tylnej części osłony. W tej ramce była mocowana wymienna przednia płytka, która mogła 

być zaślepiona (Rysunek 7.4.2) lub z otworem na przedłużenie lufy nkm. 

 

Rysunek 7.4.2  Szkic SK-2605 z dokumentacji XP-40 

Jedną z baz wymiarowych tej osłony jest oś lufy karabinu. Wg SK-2605, znajdowała się w tym samym miejscu, 

co w P-36: 9” od płaszczyzny symetrii. Współrzędnej Z tej osi nie ma na tym szkicu, więc przyjąłem, że jest 

taka, jak w P-36: 22” od osi kadłuba, lub 21” od osi śmigła. Średnica tego przedłużenia lufy to 2”, a grzbiety 

iskrowników silnika Allison, ponad którymi biegły te osłony, znajdowały się na wysokości Z około 20.5”. Pomię-

dzy nimi pozostałby więc jeszcze prześwit 0.5”. Podstawa wymiennej przedniej płytki znajdowała się w XP-40 

na stacji -74. Zauważyłem, że linia podziału tej płytki i ramki na zdjęciach różni się od tej ze szkicu. Myślę, że to 
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kolejny szczegół zmieniony podczas przygotowania produkcji seryjnej. Nie mam pewności co do szerokości tej 

przedniej płytki – niebieskie kontury naniesione na Rysunek 7.4.2 są oparte o pomiary proporcji na zdjęciach.   

Korzystając z wymiarów ze szkicu SK-2605 (Rysunek 7.4.2), zacznij tę osłonę od stworzenia okręgu o promie-

niu 1.5” i środku w X:9, Y:-74, Z:23. Użyj do tego ośmiokąta (lub nawet sześciokąta) wygładzonego modyfikato-

rem Subdivision Surface (Rysunek 7.4.3a).  

     

Rysunek 7.4.3  Pierwsze kontury osłony lufy 

Nazwij ten nowy obiekt B.625.Gun Fairing. Przekształć jego kontur w odwrócone „U” (Rysunek 7.4.3b), zacho-

wując regularny łuk w części górnej. Stwórz krawędzie przedniej powierzchni poprzez kopiowanie bocznych 

krawędzi tego konturu początkowego (zaznacz wszystkie jego wierzchołki oprócz najwyższego). Obróć te nowe 

krawędzie wokół środka obiektu i globalnej osi Z o 45º i 90º. 

Stwórz ściany ( F ) pomiędzy tymi nowymi krawędziami (Rysunek 7.4.4a): 

     

Rysunek 7.4.4  Formowanie przedniej płytki 

Aby uzyskać kontur „U” w widoku z góry, dwa razy wyciągnij tylną krawędź siatki. Możesz także dodać obiekt 

przedłużenia lufy (nazwij go: B.630.Blast Tube), tak jak pokazywany przez Rysunek 7.4.4b)1. 

 
1 Takie krótsze przedłużenia luf były wprowadzone pod koniec 1940. Na zdjęciach początkowy, dłuższy wariant, zdaje się kończyć u pod-

stawy kołpaka śmigła (w stacji -93.31). W [20] znalazłem wymiary krótszego wariantu. Na nieszczęście, nie mogłem określić ich bazy! Tyle, 
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Wyciągnij tylną część tej osłony, aż „utonie” w powierzchni okapotowania silnika (Rysunek 7.4.5):  

     

Rysunek 7.4.5  Wyciąganie tylnej części oprofilowania Rysunek 7.4.6  Porównanie ze zdjęciami    

Rutynowo porównuję każdy formowany obiekt ze zdjęciami. W tym przypadku zauważyłem różnicę: moje oprofi-

lowanie było dłuższe niż to na zdjęciu (Rysunek 7.4.6). 

No cóż, budujemy to okapotowanie silnika w oparciu o różne założenia. Jednym z nich była przypuszczenie, że 

geometria górnej części osłony silnika w P-40 była taka sama, jak w XP-40 (por. Tom I, sekcja 9.6). W oparciu o 

to założenie i różnicę ujawnioną przez Rysunek 7.4.6, doszedłem do wniosku, że w seryjnych P-40 osłony luf 

km zostały obniżone o 0.5”. W istocie, brak jest przyczyny, dla której musiały być tak wysokie jak na SK-2605: 

po obniżeniu i tak zachowany jest dystans wokół przedłużeń luf (por. Rysunek 7.4.2). Oczywiście, jeżeli moje 

założenie o tym samym kształcie okapotowania w P-40 i XP-40 jest błędne, wówczas błędne są powyższe kon-

kluzje. Na koniec tej fazy projektu porównamy model ze zdjęciami, by sprawdzić tę hipotezę.   

Rysunek 7.4.7a) pokazuje osłonę obniżoną o 0.5”, dzięki czemu jej koniec „tonie” w osłonie w tym samym miej-

scu, co na zdjęciu referencyjnym: 

     

 

że w opisie towarzyszącym temu rysunkowi znalazłem takie zdanie: „Air Corps zwyczajnie odciął ostatnie czternaście cali z każdej z tych 

rur”. Korzystając z proporcji z innych zdjęć, założyłem, że ta nowa końcówka znajduje się w stacji -79 (+/- 1”). 
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Rysunek 7.4.7  Dalsze zmiany siatki 

Po tej aktualizacji, uformuj tą część oprofilowania lufy, która leży na podstawowej osłonie silnika. Zacznij od 

umieszczenia czterech wierzchołków na jej powierzchni (Rysunek 7.4.7b). 

Ukryj ( H ) wszystkie wierzchołki siatki oprócz czterech dodanych przed chwilą (Rysunek 7.4.7b). Wstaw w ten 

płaski wycinek nowe krawędzie i dopasuj go do powierzchni siatki (Rysunek 7.4.8a). Potem użyj polecenia 

Edge→Intersect Faces (z dodatku Intersect, por. str. 531, 482) aby uzyskać wydzieloną krawędź przecięcia 

ścian siatki osłony (Rysunek 7.4.8b):  

   

   

   

   

Rysunek 7.4.8  Formowanie podstawy osłony luf 

Dopasuj topologię tej podstawy osłony tak, by pasowała do krawędzi przecięcia (Rysunek 7.4.8c). Następnie 

usuń środkowe wierzchołki z tej części siatki (Rysunek 7.4.8d) i połącz pozostałe ściany z krawędzią przecięcia 

(Rysunek 7.4.8e).  
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Odkryj pozostałe ściany siatki (Rysunek 7.4.8f) i wstaw nowe linie krawędzi, pasujące do położenia krawędzi 

podstawy. Gdy jest to potrzebne, możesz także przesuwać te wierzchołki wzdłuż globalnej osi Y, tworząc „uko-

śne” krawędzie (zamiast tworzyć kolejne). Następnie usuń wszystkie dolne ściany (Rysunek 7.4.8g) i stwórz 

nowe, które łączą powierzchnię podstawy z resztą siatki osłony (Rysunek 7.4.8h). 

Modyfikacje siatki, pokazywane przez Rysunek 7.4.8e-h) powinny stworzyć wzdłuż krawędzi przecięcia rząd 

czworokątnych ścian. Idealnie byłoby, gdyby wysokość tych ścian wynosiła około 1”. Jak widać na przykładzie 

poniżej, nie zawsze jest to możliwe.  

Przypisz do tej linii krawędzi przecięcia współczynnik Bevel Weight. Ze względu na różne promienie zaokrągleń 

po wewnętrznej i zewnętrznej stronie osłony (por. Rysunek 7.4.2) zróżnicuj te wagi (Rysunek 7.4.9):  

 

Rysunek 7.4.9  Przygotowanie do zaokrąglenia krawędzi modyfikatorem Bevel 

Dodaj do obiektu osłony nowy modyfikator Bevel (Weight). Umieść go na liście modyfikatorów powyżej 

Subdivision Surface. Ustal szerokość tego fazowania na 1 i wyłącz opcję Geometry:Clamp Overlap (por. str. 

561). Na początek, pozostaw pojedynczy segment tej fazki. Włącz w oknie 3D w tryb X-Ray i sprawdź wynikowe 

krawędzie (Rysunek 7.4.9). Gdy zauważysz miejsce, gdzie fazowanie zakrywa jakiś wierzchołek boku siatki, 

odsuń ten wierzchołek od obszaru fazowania. Aby uzyskać gładki kształt powierzchni wynikowej, staraj się 

utrzymać te wierzchołki około 0.5” od krawędzi fazki. 

Gdy krawędzie fazki są sprawdzone i wolne od bocznych wierzchołków, zwiększ liczbę jej segmentów do 4, 

tworząc w ten sposób zaokrąglenie wokół tej osłony (Rysunek 7.4.10a): 

    

Bevel Weight: 0.75  

Bevel Weight: 1.0  

X-Ray: wł. 

Odsuń te wierzchołki 
od krawędzi fazki 

Fazowana krawędź  

a) b) 

U.625.Gun Fairing 

Boolean 
(Intersect) Boolean 

(Difference) 

Zwiększ liczbę segmentów 

modyfikatora Bevel do 4 

Lustrzane odbicie 
(względem X.000.Base) 
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Rysunek 7.4.10  Dalsze modyfikacje obiektu osłony luf km 

W widoku z góry stwórz bryłę tnącą zewnętrzne kontury osłony luf. Użyj jej w nowych modyfikatorach Boolean 

do przycięcia krawędzi zewnętrznych osłony i uzyskania otworu w okapotowaniu silnika (Rysunek 7.4.10b). 

Na koniec, stwórz obiekt, który wycina w przedniej płytce otwór wokół przedłużenia lufy nkm  (Rysunek 7.4.11): 

    

Rysunek 7.4.11  Wycięcie otworu w przedniej płytce  Rysunek 7.4.12  Gotowe osłony luf km    

Kształt i proporcje tego otworu dobrałem na podstawie zdjęć. Obiekt tnący to zwykłe „pudełko” krawędziami 

zaokrąglonymi modyfikatorem Bevel (Weight), aby można go było łatwo w przyszłości zmienić (w oparciu o 

jakieś nowe dane). Założyłem, że ten otwór miał rozmiary 2”x3”, z narożnikami zaokrąglonymi łukami R=0.9”. 

Rysunek 7.4.12 pokazuje gotowe osłony luf km. 

 

Podsumowanie 

• Tak jak w poprzedniej sekcji tego rozdziału, mieliśmy tylko jeden rysunek osłony lufy km (str. 304). Pokaza-

no na nim stałą część przedniego odlewu („ramkę”), z przedprodukcyjnego wariantu XP-40. Ten detal różni 

się w szczegółach od ramki montowanej w seryjnych P-40, m. in. kształtem wyjmowanej przedniej płytki. 

Mam także wątpliwości co do jego wysokości (str. 306). Ta geometria jest oparta na różnych założeniach i 

wymaga dokładnego sprawdzenia ze zdjęciami referencyjnymi. 

• Przekrój poprzeczny tej osłony ma kształt odwróconego „U”. Zaczęliśmy go tworzyć od okręgu o średnicy 

odpowiadającej szerokości osłony (str. 305). Potem przekształciliśmy ten kontur w odwrócone „U”. Wierz-

chołki przedniej płytki uzyskaliśmy obracając kontur początkowy wokół osi pionowej, a tylną część – po-

przez wyciągnięcie wzdłuż globalnej osi Y (str. 306). 

• Najtrudniejszą częścią w tej części jest zaokrąglona krawędź podstawy. Zaczęliśmy ją od odtworzenia czę-

ści powierzchni osłony silnika wokół tego obiektu. Potem wyznaczyliśmy krawędź przecięcia jej ścian z 

resztą siatki osłony luf (str. 307). Po poprawkach w topologii, połączyliśmy obydwie części siatki wzdłuż 

krawędzi przecięcia. Następnie zaokrągliliśmy tę krawędź modyfikatorem Bevel (str. 308). 

• Aby dopasować to oprofilowanie do osłony silnika, przygotowaliśmy obiekt tnący (U.625.Gun Fairing), któ-

rego użyliśmy w modyfikatorach Boolean (str. 309). W jednym z tych modyfikatorów wykorzystaliśmy tryb 

Intersect, do przycięcia zewnętrznych brzegów panelu osłony. Do wycięcia w okapotowaniu silnika dopa-

sowanego otworu na tę panel, użyliśmy modyfikatora Boolean w trybie Difference. 

• Nie zachowały się żadne rysunki otworu w przedniej części tej osłony. Odtworzyliśmy go za pomocą kolej-

nego obiektu tnącego, którego rozmiar i kształt powstał w oparciu o zdjęcia.  

 

U.625.Opening 

Boolean 
(Difference) 

Kształt uformowany 
w oparciu o zdjęcia 
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Pracując nad innymi częściami osłony silnika, miałem okazję „świeżym okiem” porównać mój model z archiwal-

nymi zdjęciami1. Tym razem porównałem obszar, w którym chwyt powietrza do silnika „zagłębia” się w okapoto-

waniu. Ostatecznie oceniłem, że ich trudno dostrzegalna (wygładzona) krawędź przecięcia w moim modelu jest 

dłuższa, niż na tych zdjęciach. Wysokość osłony chwytu powietrza była wcześniej zweryfikowana ze zdjęciami i 

potwierdzona przez wymiary z dokumentacji (por. str. 296). Dlatego zdecydowałem się na podniesienie środko-

wego segmentu osłony silnika o 0.5”. To przywraca wysokość osłon luf nkm do 24.5”, tak jak na szkicu z XP-40 

(22”+1”+1.5” – por. str. 304). 

 
Zacząłem od podniesienia środkowego fragmentu górnej osłony (Rysunek 7.4.13): 

   

Rysunek 7.4.13  Podniesienie górnej części osłony silnika 

Aby zamknąć szczeliny, które pojawiły się wzdłuż krawędzi paneli, zmodyfikowałem siatkę chwytu powietrza do 

silnika. Dopasowałem jej boczne krawędzie do nowego kształtu okapotowania (Rysunek 7.4.14): 

 

Rysunek 7.4.14  Dopasowanie siatki chwytu powietrza do silnika 

 
1 Porównywałem jej kształt z różnymi historycznymi zdjęciami fabrycznie nowych P-40. W ten sposób starałem się wykluczyć ewentualne 

błędów popełnione przez zespoły odbudowujące obecnie latające samoloty. (Zespoły odbudowujące okapotowanie silnika we wczesnych 

P-40 opierają się na wcześniej odbudowanych egzemplarzach, przez co mogą powtórzyć błędy popełnione przez poprzedników). 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-11.04.blend. 

  

 

Na koniec tej fazy „formowania” modelu zamierzam sprawdzić, który z tych wariantów osłony najlepiej 

odwzorowuje jej rzeczywisty kształt. Zrobimy to odtwarzając projekcję zdjęcia (por. Rozdział 14). 

a) b) 

Unieś te 
wierzchołki Proste 

krawędzie 
Szczeliny 

(0.5”) 

Dopasuj powierzchnię 
wynikową do zmodyfi-
kowanej osłony silnika 

Zachowaj oryginalny kontur 
tej osłony w widoku z boku  
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Jak widać powyżej, tymczasowo przypisałem do tej siatki kolor czerwony. Aby lepiej widzieć całą powierzchnię 

osłony, wyłączyłem także modyfikator Boolean (blocks) obiektu B.600.Cowling (jak pokazane na str. 295, 

Rysunek 7.2.24). W ten sposób mogłem łatwo sprawdzić, kiedy wynikowa powierzchnia „dotknęła” osłony.  

W podobny sposób mógłbym także zmodyfikować siatkę osłon luf km. Jednak oszacowałem, że stworzenie ich 

od nowa wymaga podobnej ilości pracy. Przy okazji chciałem się też przekonać, czy ich siatka oparta o sześcio-

kąt (zamiast ośmiokąta – por. str. 305, Rysunek 7.4.3) będzie dużo prostsza. 

Poniżej widać powtórkę z tworzenia osłony luf km, opisanej w tej sekcji. Rysunek 7.4.15a) pokazuje nową siatkę 

podstawową, opartą o sześciokąt. Rysunek 7.4.15b) pokazuje przecięcie tych ścian ze ścianami osłony: 

     

Rysunek 7.4.15  Formowanie nowych osłon luf km 

Z pokazanej przez Rysunek 7.4.15b) krawędzi przecięcia usunąłem już wszystkie dodatkowe, niepotrzebne 

wierzchołki. Pozostawiłem tylko te, należące do krawędzi siatki osłony luf, oraz dwa inne, w przedniej części, 

oznaczone jako A (Rysunek 7.4.15b). Te dwa wierzchołki pozwolą lepiej dopasować kontur do okapotowania. 

W następnych krokach wstawiłem nową linię krawędzi, w pobliżu wierzchołków A (Rysunek 7.4.16a). By ta linia 

krawędzi była „płaska” w płaszczyźnie ZX, przesunąłem obydwa punkty A1. Następnie usunąłem zewnętrzne 

krawędzie oryginalnej siatki i stworzyłem nowe ściany wzdłuż krawędzi przecięcia (Rysunek 7.4.16b) 

     

Rysunek 7.4.16  Włączanie do siatki osłony krawędzi przecięcia 

 
1 Ponieważ krawędź przecięcia osłony luf z okapotowaniem silnika była zaokrąglona (R od 0.75” do 1.0”), istnieje pewna tolerancja (+/- 

0.05”) w dopasowaniu tego konturu do powierzchni okapotowania. Ta pozwala na niewielkie poprawki położenia wierzchołków A. 
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Po tej retopologii, dopasowałem wynikowy brzeg osłony do powierzchni okapotowania silnika. Aby zachować 

oryginalny kształt „korytka” tej osłony, wykonałem te poprawki przesuwając wierzchołki ścian z obszaru a (por. 

Rysunek 7.4.16b) wzdłuż globalnej osi Z. Wierzchołki z obszaru b przesuwałem wzdłuż globalnej osi Y. 

 

Rysunek 7.4.17 pokazuje dalsze kroki formowania tej osłony lufy km: 

      

      

Rysunek 7.4.17  Dalsze formowanie nowej osłony luf km 

Rysunek 7.4.17a) to wyciągnięcie ścian bazy osłony z jej krawędzi przecięcia (por. tę metodę z przedstawiona 

przez Rysunek 7.4.8a-e). Stwierdziłem, że w tym przypadku takie uproszczenie tworzy zadowalające rezultaty. 

Jak widać (Rysunek 7.4.17d), siatka uzyskana z sześciokąta jest prostsza niż ta pokazywana przez Rysunek 

7.4.9. Pomimo to nadal tworzy zadowalający kształt (odchylenia przekrojów powierzchni wynikowej grzbietu od 

idealnego łuku są na poziomie 0.01”).   

 

 

Te modyfikacje wprowadziłem podczas pracy nad wlotem powietrza do chłodnic, więc możesz je 

znaleźć w pliku z wynikiem następnej sekcji: model\p40\history\P40B-11.05.blend. 
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7.5 Wlot powietrza do chłodnic  

W P-40 chłodnice glikolu i oleju były umieszczone pod silnikiem (Rysunek 7.5.1a). Ich wlot powietrza dzielił się 

na 3 kanały: centralny do chłodnicy oleju, boczne do chłodnic glikolu (Rysunek 7.5.1b), znanego w USA pod 

nazwą handlową Prestone. Aby zwiększyć przepływ powietrza w kanałach bocznych, projektanci stworzyli 

wgłębienia przed chwytem powietrza (Rysunek 7.5.1b, c). W tej sekcji odtworzymy ten złożony kształt tego wlo-

tu, a także same chłodnice (ponieważ pod pewnymi kątami są widoczne z zewnątrz). 

       

Rysunek 7.5.1  Chłodnice cieczy P-40 i ich wlot powietrza 

Znalazłem tylko kilka wyblakłych szkiców tego zespołu, w dokumentacji XP-40 (por. Tom I, sekcja 9.7). Na ich 

podstawie założyłem, że krawędź natarcia wlotu powietrza znajdowała się w stacji -741. Jednak przygotowując 

model dla tej sekcji, odkryłem, że w widoku z przodu kontury z XP-40 nie pasują do zdjęć seryjnych P-40. Obraz 

referencyjny przekrojów okapotowania silnika, wstawiony jako R.Sections (cowling) (por. str. 276) odtwarza 

kształt z XP-40, więc na ilustracji poniżej podaję szczegóły poprawionej geometrii wlotu. Projektanci Curtiss 

często konstruowali krzywe z łuków, więc przygotowałem ten opis w podobny, zwięzły sposób. Wstaw w swój 

model Blendera te okręgi jako obiekty pomocnicze, a potem pociągnij wzdłuż nich początkowe, kluczowe krzy-

wizny krawędzi natarcia wlotu. Pamiętaj, że to tylko przybliżenie (oceniam zakres jego błędu na +/- 0.1”).  

Rysunek 7.5.2 opisuje geometrię wlotu w stacji -74. Narysowałem je na tle obrazu referencyjnego z konturami 

ze szkiców XP-40. Dzięki temu od razu dostrzeżesz różnice: 

 

Rysunek 7.5.2  Uaktualniony wg zdjęć kontur krawędzi natarcia wlotu (stacja -74)  

 
1 Na rysunku Jumpei Temmy krawędź natarcia tego wlotu jest bliżej kołpaka śmigła o 0.7”. 
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Rysunek 7.5.2a) pokazuje rozkład wierzchołków wzdłuż tego konturu. Ich układ zdeterminuje topologię siatki, 

którą stworzymy. Dlatego umieść więcej wierzchołków przy obydwu końcach „szprychy”, która rozdziela kanały 

powietrza: jeden pośrodku i dwa kolejne po każdej ze stron. W sumie – po 5 wierzchołków na każdym końcu. 

Rysunek 7.5.3 pokazuje przekrój osłony odpowiadający krawędzi paneli za aluminiowym odlewem wlotu, w 

stacji -72 (por. Rysunek 7.5.1c). Kształtując te krzywe, umieść taką samą liczbę wierzchołków wzdłuż ich łuków, 

jaka pokazuje Rysunek 7.5.2a): za chwilę będziemy łączyć je ścianami.  

     

Rysunek 7.5.3  Uaktualniony wg zdjęć kontur krawędzi natarcia wlotu (stacja -74)  

Rysunek 7.5.4 pokazuje przekrój okapotowania silnika przed wlotem powietrza, w stacji -82.31. 

        

Rysunek 7.5.4  Przekrój poprzeczny w stacji -82.3 Rysunek 7.5.5  Wstępny kontur obiektu B.645.Coolers Inlet    

Skopiowałem także górną część krawędzi natarcia (stacja -74) i wyciągnąłem jej koniec (Rysunek 7.5.5). To 

pierwsza krawędź siatki wlotu powietrza chłodnic. Nazwij ten obiekt B.645.Coolers Inlet.  

Myślę, że najtrudniejszym fragmentem tej siatki jest przednia część wlotu, ze względu na zagłębienia przed 

wlotami chłodnic Prestone. Koncepcyjnie, są one kontynuacją stożka kołpaka śmigła połączoną z dwoma wklę-

słymi powierzchniami. Zaczniemy modelowanie wlotu od uformowania tego obszaru, ponieważ czasami topolo-

gie najtrudniejszych fragmentów mają niespodziewany wpływ na resztę siatki.    

 

1 Kontury pokazywane przez Rysunek 7.5.2 i Rysunek 7.5.4 odtworzyłem z precyzyjnego rzutowania modelu na zdjęcie (por. Rozdział 14) 

wczesnego P-40-cu. Na nosach tych samolotów USAAC malował szerokie na 10” pasy w kontrastowym kolorze. Przekrój pokazany przez 

Rysunek 7.5.4 to tylna krawędź takiego pasa (pokazuje ją Rysunek 7.5.17)  
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Rozpocznij od wyciągnięcia wklęsłej powierzchni z górnego konturu krawędzi natarcia w stacji -74 (Rysunek 

7.5.6a). Ukształtuj ją tak, by pasowała do przekroju w stacji -82.3. Ta powierzchnia powinna przeciąć stożek 

podstawowej bryły okapotowania silnika w pobliżu stacji -89:  

     

Rysunek 7.5.6  Formowanie pomocniczej wklęsłej powierzchni przed wlotem  

Użyj dodatku Intersect aby znaleźć krawędź przecięcia tej siatki i okapotowania silnika (Rysunek 7.5.6b). 

Skopiuj krawędź przecięcia i przedni segment uformowanej siatki (por. Rysunek 7.5.6b), wydziel je, a następnie 

dołącz do siatki obiektu B.645.Coolers.Inlet (Rysunek 7.5.5). Pozostaw powierzchnie, której przygotowanie 

pokazywał Rysunek 7.5.6, wśród pomocniczych obiektów. Będzie wzorcem podczas pracy nad wlotem.  

Teraz połącz te ściany i krawędź przecięcia z poprzednio stworzoną wstępną krawędzią (por. Rysunek 7.5.5): 

     

     

Rysunek 7.5.7  Formowanie wklęsłych części przed wlotem powietrza  

a) b) 
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Skopiuj, wydziel i przyłącz 
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Gdy scaliłeś te elementy we wklęsłą powierzchnię, wyciągnij krawędzie boczne wzdłuż jej brzegów (Rysunek 

7.5.8a). Aby dopasować kontury boczne tej powierzchni do kształtu okapotowania silnika (B.600.Cowling), tak 

jak pokazuje to Rysunek 7.5.8b), tymczasowo wyłącz widoczność jego modyfikatora Boolean (blocks):  

      

Rysunek 7.5.8  Dopasowanie brzegów powierzchni  

 
Zanim stworzymy ściany zamykające lukę pomiędzy „wypukłym” i „wklęsłym” segmentem tej siatki, musimy 

przygotować ich topologię. Uwierz mi, jeżeli zaczniesz to robić bez żadnego planu, uzyskasz brzydką, nieregu-

larną siatkę. Taka siatka nadal może wygenerować przeciętnie wyglądającą powierzchnię, ale kłopoty się za-

czną, gdy będziesz chciał ją poprawić, przesuwając niektóre z jej wierzchołków1. 

Zacząłem od przesunięcia krawędzi „wręg” w częściach: środkowej i wklęsłej, dopasowując je do położenia 

podobnych linii krawędzi na pasku biegnącym wzdłuż linii podziału paneli (Rysunek 7.5.9a): 

         

Rysunek 7.5.9  Planowanie topologii siatki  

Potem zrobiłem zrzut ekranu z siatką tego obiektu. Użyłem go jako obrazu referencyjnego do narysowania pla-

nowanej topologii w Inkscape (Rysunek 7.5.9b). Zgodnie z tym planem, potrzebujemy dodać z przodu tej siatki 

łuk złożony z 6 krawędzi. 

 
1 Szczerze: siatka pokazana w tej sekcji jest moją trzecią próbą, ale pierwszą z zaplanowaną wcześniej topologią. Porzuciłem dwie pierw-

sze wersje, bo ich siatki były nieregularne („brzydkie”). Co chwila miałem potem problemy ze zmianą kształtu ich wynikowych powierzchni. 

 

W tej sekcji często przełączamy widoczność modyfikatora Boolean (blocks) obiektu B.600.Cowling, 

tak jak opisuje to Rysunek 7.2.24 (str. 295). Będę pisał o takim przełączeniu “wyłącz/włącz widocz-

ność Boolean (blocks)” – mam nadzieję, że ten skrót myślowy będzie zrozumiały. 
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Zmodyfikowałem topologię siatki zgodnie z tym szkicem Inkscape. Rysunek 7.5.10a) pokazuje zmiany, które 

wprowadziłem do obszaru wklęsłego (porównaj je z układem pokazanym przez Rysunek 7.5.8a). Dodałem tak-

że 6-krawędziowy łuk w stacji -90.8. Połączyłem go z obydwoma wypukłymi „paskami” siatki. Potem dopasowa-

łem zmienioną, wklęsłą część do pomocniczej powierzchni (tej pokazywanej przez Rysunek 7.5.6). 

W następnym kroku, zamknąłem tylną cześć luki w siatce ścianami (Rysunek 7.5.10b), które potem podzieliłem 

zgodnie ze szkicem Inkscape (Rysunek 7.5.10c): 

     

     

     

Rysunek 7.5.10  Zamykanie luki wokół wklęsłej części siatki  

Dopasowałem powierzchnię wynikową tej siatki do wzorcowego konturu ze stacji -82.3. Podczas pierwszego 

przybliżenia obróciłem odpowiednie linie krawędzi wokół ich wierzchołków ze stacji -74 (Rysunek 7.5.10d), a 

potem indywidualnie dopasowałem każdy z tych punktów kontrolnych. Potem stworzyłem kolejną parę nowych 

ścian, która zamyka następny segment luki w siatce (Rysunek 7.5.10e). Wyciągnąłem środkowe ściany wąskie-

go „paska”, biegnącego wzdłuż przedniego łuku (Rysunek 7.5.10f). Potem zamknąłem kolejnymi ścianami 

ostatnie przerwy po tej stronie w siatki.  
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Użyj tych samych metod do zamknięcia luku po drugiej stronie wklęsłego obszaru wlotu, tworząc siatkę podob-

ną do tej, pokazanej przez Rysunek 7.5.11: 

     

Rysunek 7.5.11  Zamknięta siatka przodu wlotu Rysunek 7.5.12  Dopasowywanie wynikowej powierzchni 

Po zamknięciu tej siatki, dopasuj obszary wzdłuż jej brzegów do podstawowej bryły okapotowania (Rysunek 

7.5.12). W tym celu, na chwilę wyłączyłem widoczność modyfikatora Boolean (blocks) osłony silnika. 

Włącz z powrotem ten modyfikator i włącz także jego opcję Edit Mode, aby lepiej widzieć wynikową krawędź 

osłony w stacji -72. Ponieważ jej obecny kształt różni się nieco od nowego konturu referencyjnego (por. Rysu-

nek 7.5.3a), dopasuj powtórnie jej przednią część (Rysunek 7.5.13):  

      

Rysunek 7.5.13  Dopasowanie osłony do konturu w STA -72  Rysunek 7.5.14  Łączenie konturów STA -72 z wlotem 

Połącz kontur przekroju ze stacji -72 z siatką wlotu (B.645.Coolers Inlet), jak pokazuje to Rysunek 7.5.14. Wy-

ciągnij zewnętrzny kontur STA -72 o 2”, i dopasuj go do powierzchni osłony (Rysunek 7.5.15a): 

     

Rysunek 7.5.15  Formowanie krawędzi natarcia  

Wstaw w środek tego paska kolejną linię krawędzi, potem wyciągnij jej przednie krawędzie (Rysunek 7.5.15b), 

tworząc kształt pokazywany przez Rysunek 7.5.15c). Aby zmienić promień wyciągniętych konturów, skaluj je z 

zablokowaną osią Y, używając jako środka transformacji kursora 3D umieszczonego w Z = -15. 
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Rysunek 7.5.16 pokazuje, jak zamknąłem w tej siatce narożnik krawędzi natarcia:  

       

       

Rysunek 7.5.16  Zamknięcie krawędzi natarcia wlotu  

Przez cały czas sprawdzałem ten kształt ze zdjęciami. Rysunek 7.5.17a) pokazuje ekstremalny przypadek ta-

kiego testu. Ustawiłem model w identycznej projekcji jak P-40-cu na zdjęciu w tle. Potem użyłem tego obrazu 

jako bezpośredniego wzoru, w ten sam sposób jak używa się rzutów z przodu czy z boku na planach. (szczegó-

ły tej metody wyjaśnia Rozdział 14):  

     

Rysunek 7.5.17  Sprawdzanie i dopasowywanie kształtu powierzchni wynikowej  

W wyniku tych testów, poprawiłem nieco kształt i topologię siatki wlotu (Rysunek 7.5.17b). 
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Teraz możemy uformować „szprychę” tego wlotu. Zacznij od wyciągnięcia jej konturu ze stacji -72 wzdłuż glo-

balnej osi Y o 1” (Rysunek 7.5.18a):  

         

     

Rysunek 7.5.18  Formowanie środka i dolnej części „szprychy” wlotu  

W jednym z okien ustaw projekcję równolegle do bocznej ściany „szprychy” (zaznaczając tę ścianę i naciskając 

Shift - 7 ). W tym oknie przesuń wzdłuż osi Y widoku przednie wierzchołki nowo utworzonych ścian, czyniąc ich 

boki równoległymi do boków sąsiednich ścian z pierścienia wlotu (Rysunek 7.5.18b). Stwórz ściany pomiędzy 

przednimi krawędziami tej „szprychy”, a potem je wyciągnij do przodu o około 0.4” (Rysunek 7.5.18c). To nada 

jej krawędzi natarcia zaokrąglony przekrój. Przesuń do przodu (wzdłuż globalnej osi Y) dwa zewnętrzne wierz-

chołki tej krawędzi (Rysunek 7.5.18d). To początek zakrzywionego konturu „szprychy”, który widać na zdjęciach. 

Na koniec, stwórz nowe ściany, które zamykają lukę pomiędzy podstawą szprychy i krawędzią natarcia wlotu 

(Rysunek 7.5.18e). 

Przesuń środkową część krawędzi natarcia szprychy o 0.4” do tyłu. Ten krok kończy formowanie zakrzywienia 

konturu przy zewnętrznych narożnikach wlotu (Rysunek 7.5.19a). Potem przesuń do przodu najwyższe wierz-

chołki krawędzi natarcia (Rysunek 7.5.19b) i zamknij lukę w tej siatce nowymi ścianami (Rysunek 7.5.19c): 

       

Rysunek 7.5.19  Formowanie górnej części „szprychy” wlotu  
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Przypisz obiektowi wlotu modyfikator Solidify (Thickness: 0.04”), a następnie przytnij jego zewnętrzne krawę-

dzie za pomocą tych samych brył, których użyliśmy do przycinania okapotowania (Rysunek 7.5.20):  

    

Rysunek 7.5.20  Przycinanie brzegów wlotu  

Rysunek 7.5.20 pokazuje gotowy obiekt wlotu chłodnicy. Teraz musimy odtworzyć wewnętrzne kanały powietrza 

i chłodnice, ponieważ były widoczne z zewnątrz (pod pewnymi kątami). Chłodnice przydadzą się także w na-

stępnej sekcji, do formowania kanałów wylotowych. 

Stwórz chłodnice jako proste cylindry: wzór „plastra miodu” ich czołowych i wylotowych powierzchni odtworzymy 

później, używając tekstur. Rysunek 7.5.21 pokazuje położenie i rozmiary tych chłodnic:  

    

Rysunek 7.5.21  Wymiary chłodnic  

Aby odtworzyć kanał powietrza do chłodnicy, skopiuj z siatki wlotu jej kontur w stacji -72 i wydziel go w nowy 

obiekt. Przed chłodnicą wstaw w tej siatce okrąg o średnicy jej cylindra i liczbie boków równej liczbie krawędzi 

skopiowanego konturu (Rysunek 7.5.22a). Potem połącz te krawędzie ścianami (Bridge Edge Loops):  

       

Rysunek 7.5.22  Formowanie kanału do chłodnicy oleju  

Wstaw w środek tej „rury” cztery lub pięć pośrednich sekcji (Loop Cut, Rysunek 7.5.22b), a następnie wygnij tę 

siatkę wzdłuż pomocniczej krzywej (Rysunek 7.5.22c). W ten sam sposób stwórz kanał do chłodnicy Prestone.  

Outline: wył. 
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Rysunek 7.5.23 pokazuje gotowe kanały chłodnic i ich wloty: 

     

Rysunek 7.5.23  Gotowy wlot chłodnic  

 

Podsumowanie 

• Przygotowując produkcję seryjną P-40, Curtiss nieco zmienił kształt osłony chłodnic. Różni się on od kilku 

zachowanych szkiców XP-40 (L-10202, L-10276, SK-2692). Zaprezentowana na str. 313-314 geometria 

jest przybliżeniem tego kształtu i wymaga dalszej dokładnej weryfikacji ze zdjęciami (takiej jak ta, pokazana 

na str. 319).  

• Najpierw przygotowaliśmy kluczowe kontury (str. 313-314) tej osłony. Odwzorowując wewnętrzne i ze-

wnętrzne kontury przekrojów ze stacji -72 (str. 314) pamiętaj, że ich wierzchołki będą połączone siatką 

krawędzi natarcia wlotu. Zawczasu pomyśl o przyszłym łączeniu odpowiednich węzłów tych krzywych w 

pary. 

• Zaczęliśmy formowanie od przedniej części wlotu, będącej kontynuacją stożka kołpaka śmigła z wgłębie-

niami przed chłodnicami Prestone (str. 313). Najpierw określiliśmy kształt tych wgłębień poprzez wycia-

gnięcie górnej części konturu ze stacji -74 i dopasowaniu tej nowej powierzchni do przekroju w stacji -82.3. 

Zanikają one w stacji -89 (str. 315). Potem określiliśmy krawędź przecięcia siatek tego zagłębienia i stożka 

osłony silnika. Połączyliśmy tę linię krawędzi z siatką wlotu (str. 315). Następnie wyciągnęliśmy wypukłe 

fragmenty powierzchni wzdłuż granic paneli, dopasowując je do konturu osłony (str. 316). Na koniec, za-

mknęliśmy luki w siatce wlotu (str. 317, 318), tworząc nowe krawędzie zgodnie z zaplanowaną topologią 

(str. 316). 

• Krawędź natarcia wlotu została wyciągnięta z konturu jego przekroju w stacji -72 (str. 318). Zamknęliśmy ją 

włączając w siatkę wewnętrzny kontur tego samego przekroju (str. 319). Potem zamknęliśmy luki w naroż-

nikach (str. 319) i wyciągnęliśmy „szprychę” wlotu (str. 320). 

• Uzyskana siatka została porównana z kilkoma zdjęciami referencyjnymi (str. 319) i przycięta za pomocą 

tych samych obiektów tnących, których użyliśmy do przycięcia podstawowej osłony silnika (str. 321). 

• Odtworzyliśmy także same chłodnice i ich wewnętrzne kanały powietrza (str. 321). 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-11.05.blend. 

  

Outline: wł. Outline: wył. 

https://app.aircorpslibrary.com/drawing/viewer/L-10202/p-40
https://app.aircorpslibrary.com/drawing/viewer/L-10276/p-40
https://app.aircorpslibrary.com/drawing/viewer/SK-2692/p-40
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7.6 Kil pod kadłubem 

Pod skrzydłami P-40 widać przedłużenie osłony chłodnic, sięgające się aż do wręgi #9 (Rysunek 7.6.1). Doku-

mentacja Curtiss określa je jako „kil” (jak w statkach), więc i ja będę dalej używał tej nazwy.  

 

Rysunek 7.6.1  Wylot powietrza z chłodnic i „kil” pod spodem P-40B 

Ten kil składa się z czterech odejmowanych paneli. Segment 0 jest geometryczną kontynuacją osłony chłodnic 

(początkowo wydawało mi się, że różni się szerokością). Segment 1 był mocowany zamkami dzus, podczas gdy 

segmenty 2 i 3 - klasycznymi śrubami. Wszystkie cztery osłaniały przewody paliwa i oleju (Rysunek 7.6.2): 

 

Rysunek 7.6.2  Instalacje zakryte przez panele kila P-40 

Przekroje tego kila na rysunkach Jumpei Temmy mają pewne niedociągnięcia. Jeżeli chcesz poprawić swój 

model, wykorzystaj współrzędne z oryginalnej dokumentacji (rys. nr 87-23-504, -503, -502). Rysunek 7.6.3 po-

kazuje diagram i tabelę współrzędnych od przegrody silnika (stacja 0 kadłuba) do stacji 75 57/64: 

                        

Rysunek 7.6.3  Współrzędne przedniej części kila 
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Sekcje „MODEL” w tabelkach tych rysunków wymieniają także najwcześniejsze warianty P-40. Geometria kila 

jest wyrażona we współrzędnych cylindrycznych, których środek leży w Z=-20. Zwróć uwagę na dwa górne 

wiersze współrzędnych pokazanych przez Rysunek 7.6.3: to przekroje Segmentu 0 w stacjach 0 i 8 9/32. Praw-

dopodobnie to jedyne potwierdzone wymiary osłony silnika w P-40-cu/B/C.      

Rysunek 7.6.4 pokazuje współrzędne z rys. 87-23-503, -502. Częściowo się „nakładają” (w stacji #8):  

    

Rysunek 7.6.4  Współrzędne środkowej i tylnej części kila 

Możesz odtworzyć ten kil korzystając z planów Temmy i „skompilowanego” widoku z boku (R.Side.Left 

(compiled) – por. str. 85 i 90). Jednak w tym poradniku zdecydowałem się użyć oryginalnych wymiarów. 

Aby skorzystać ze wszystkich, odtworzyłem te punkty w przestrzeni 3D modelu jako wierzchołki pomocniczych 

wieloboków. Rysunek 7.6.5 pokazuje szczegóły tej metody:  

 

 

 

Rysunek 7.6.5  Odwzorowanie współrzędnych kila w przestrzeni modelu 

W zasadzie ten kil był wygiętym stożkiem, więc jeżeli chcesz, możesz odtworzyć tylko jego kluczowe przekroje. 

 

Przygotowanie takich pomocniczych wzorców wymaga nieco czasu. Jeżeli chcesz pominąć ten etap, 

możesz zaimportować do projektu gotową „scenę ze wzorcem” (por. sekcja 15.2, str. 620). 
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https://app.aircorpslibrary.com/search?Q=87-06-502&M=P-40
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Aby uformować Segment 0, skróć tylne wycięcie w okapotowaniu silnika do stacji -5 i wyciągnij dolną część 

tylnej krawędzi tej osłony (6 wierzchołków) do stacji 8 9/32 (Rysunek 7.6.6a). Nie martw się „narożnikiem” ufor-

mowanym przez najwyższe wierzchołki wyciągniętego segmentu: będzie skryty w skrzydle1. 

    

Rysunek 7.6.6  Formowanie Segmentu 0 (kontynuacji osłony silnika) 

Dopasuj linie krawędzi w stacjach 0 i 8 9/32 do odpowiednich konturów wzorcowych (Rysunek 7.6.6b). Na razie 

pomiń „blister” i inne szczegóły wylotu z chłodnic. Ukształtujemy je w dalszej części tej sekcji. 

Skopiuj tylną krawędź okapotowania silnika w nowy obiekt, o nazwie B.660.Keel.001 (Rysunek 7.6.7a). Wycią-

gnij go aż do stacji 62 23/32 i dopasuj jego tylną i przednią krawędź do wzorca (Rysunek 7.6.7b):   

    

    

Rysunek 7.6.7  Formowanie Segmentu 1 (przedni panel kila) 

Dolny (boczny) kontur tego segmentu jest niemal prosty. Musimy jednak wstawić w tę siatkę dodatkowe linie 

krawędzi, aby dopasować ją do dolnej powierzchni skrzydła (Rysunek 7.6.7c). Zanim to zrobimy, wstaw modyfi-

kator Solidify (0.032”) na spód jego listy modyfikatorów (łatwiej jest dopasować powłokę o niezerowej grubości). 

Na koniec, wyciągnij zaokrągloną „krawędź natarcia” tego panelu (Rysunek 7.6.7d). 

 
1 Jeżeli bardzo ci się ten narożnik nie podoba, możesz go przyciąć dodając kolejny modyfikator Boolean (Difference) do obiektu osłony. 
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Zacznij formować środkowy segment (2) poprzez wyciagnięcie powierzchni kila do stacji 991/4. Zachowaj ostrą 

krawędź (Crease = 1) w stacji 62 23/32 i wstaw dodatkowe krawędzie w środek, dopasowując tę panel do kontu-

rów wzorcowych (Rysunek 7.6.8a). Potem wydziel ściany pomiędzy stacjami 62 23/32 i 991/4 w nowy obiekt, o 

nazwie B.660.Keel.002 (Rysunek 7.6.8b):  

    

    

Rysunek 7.6.8  Formowanie Segmentu 2 (środkowy panel kila) 

Wyciągnij boczne kołnierze (szerokość: ¾”) i dopasuj je do dolnej powierzchni skrzydła (Rysunek 7.6.8c). Na 

razie „toną” w listwie na krawędzi spływu. To nie błąd: wg rys. 87-23-503 końce tych kołnierzy były podniesione 

o 1/8” aby dopasować się do tego „zawieszonego” profilu (str. 185). By uformować ten szczegół, wstaw 2.7” od 

końca tego panelu dodatkową linię krawędzi. Wstaw w kołnierz kolejną, dodatkową krawędź, 0.3” od tej pierw-

szej. Przesuń ostatni odcinek kołnierza pionowo o 0.125” (Rysunek 7.6.8d). Zaokrąglij te krawędzie wieloseg-

mentowym modyfikatorem Bevel (Weight) (umieszczonym przez modyfikatorem Subdivision Surface).   

Aby stworzyć ostatni segment kila (3), skopiuj i wydziel ostatnią krawędź siatki B.665.Keel.002 w obiekt o na-

zwie B.665.Keel.003. Potem wyciągnij tę krawędź do stacji 124 (Rysunek 7.6.9a):  

    

Rysunek 7.6.9  Formowanie Segmentu 3 (tylny panel kila) 

Wstaw kilka środkowych linii krawędzi i dopasuj wynikową powierzchnię do konturów wzorcowych. Wyciągnij 

zaokrągloną „krawędź natarcia” i boczne kołnierze mocujące (tutaj ich szerokość to 7/8”). Ustaw współczynnik 

Bevel Weight ich wewnętrznych krawędzi na 1, aby uzyskać regularne zaokrąglenie (Rysunek 7.6.9b).    
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https://app.aircorpslibrary.com/drawing/viewer/87-23-503/p-40
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Podczas formowania Segmentu 3, pomiń dodatkowy otwór zrzutu oleju/paliwa w środku tego panelu, pokazany 

na rys. 87-23-502. Nie widać go na archiwalnych zdjęciach P-40-cu/B/C. Przypuszczam, że został dodany w 

późniejszych wariantach (może w P-40N). 

Analizując rysunek Segmentu 1 (87-23-504) zauważyłem także niewielką fazkę wzdłuż jego bocznych krawędzi. 

Widać ją na przekroju G-G (Rysunek 7.6.10a)1. Odtworzyłem ten szczegół wstawiając dodatkowe sfazowane 

krawędzie wzdłuż brzegów panelu (Rysunek 7.6.10b,c):  

     

Rysunek 7.6.10  Fazka na krawędzi bocznej Segmentu 1 

W tym momencie mamy już gotowe trzy panele tego kila (Rysunek 7.6.11): 

 

Rysunek 7.6.11  Gotowe części kila 

Teraz uformujmy wylot powietrza z chłodnic (m.in. „blister” z przodu kila). 

Rozpocznij ten zespół od odtworzenia wręgi przymocowanej do chłodnic. Była prostopadła do ich osi, a więc 

obrócona o 3.5º (por. str. 321). Stwórz ją jako zwykły prostokąt (Plane). Znajdź jej przecięcie z siatkami osłony i 

chłodnic (Rysunek 7.6.12a), a potem użyj tych krawędzi do uformowania wręgi (Rysunek 7.6.12b):  

    

Rysunek 7.6.12  Formowanie wręgi chłodnic 

 
1 Przypuszczam, że taki dystans był wymagany przez geometrię zamków dzus, które mocowały tę panel do wewnętrznego kołnierza poka-

zywanego przez Rysunek 7.6.2.  
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https://app.aircorpslibrary.com/drawing/viewer/87-23-504/p-40


328 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Formowanie wylotu powietrza rozpocznij od uformowania z krzywych wokół chłodnic kształtu przypominającego 

„M”. Umieść go na płaszczyźnie wręgi chłodnic (Rysunek 7.6.13a). Nazwij go B.670.Coolers.Outlet. Stwórz w 

jego siatce prostokątna ścianę (Plane) w stacji kadłuba -5 i znajdź jej krawędź przecięcia z osłoną silnika 

(Rysunek 7.6.13b). W ten sposób mamy już pierwszą i ostatnią krawędź wylotu („blister” będzie tylną częścią tej 

siatki). Aby uzgodnić liczbę ich wierzchołków, podziel zewnętrzny segment tylnej linii krawędzi. W mojej siatce, 

umieściłem tam dodatkowe 10 wierzchołków (Rysunek 7.6.13c). W ten sposób uzyskałem tą samą liczbę kra-

wędzi w obydwu konturach:  

   

   

   

Rysunek 7.6.13  Formowanie wylotu powietrza 

Połącz (Bridge Edge Loops) te kontury ścianami (Rysunek 7.6.13d). Wstaw pierwszą krawędź środkową w po-

bliżu stacji -10, potem przesuń i skaluj jej niższe wierzchołki, tworząc pierwsze przybliżenie kształtu „blistera” 

(Rysunek 7.6.13e). Nie przejmuj się na razie zagęszczeniem krawędzie przy zewnętrznym narożniku tej siatki 

(Rysunek 7.6.13f). Będziemy ich potrzebować na następnej stronie. 
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Aby określić liczbę i pozycję środkowych sekcji siatki wylotu, użyłem pomocniczych obiektów do odwzorowania 

jego górnych i dolnych konturów (Rysunek 7.6.14a). Na każdym z tych konturów zaznaczyłem wymagane punk-

ty sterujące za pomocą krótkich, wyciągniętych krawędzi poprzecznych:  

    

    

Rysunek 7.6.14  Formowanie wylotu powietrza (ciąg dalszy) 

Wstaw kolejne linie krawędzi w siatkę wylotu, w miejscach oznaczonych na konturach pomocniczych (Rysunek 

7.6.14b). Zmień kształt tych nowych krawędzi, tworząc przestrzeń dla górnej klapy ustawionej w pozycji „za-

mknięte” (Rysunek 7.6.14c, d). Załóż, że powierzchnia wlotu była prostopadła do osi tej klapy. 

Do dalszych, końcowych poprawek, potrzebujemy klap wylotu. Stwórz dwie identyczne, płaskie prostokątne 

płytki. Ustal środki (origin) tych obiektów w ich narożnikach. Umieść je w stacji -24.25 (Rysunek 7.6.15a). Dopa-

suj ich tylne krawędzie do konturów z rzutu z boku. Dopasuj szerokości tych prostokątów do kształtu i rozmiaru 

osłony w stacji -24.5 (Rysunek 7.6.15b):  

    

Rysunek 7.6.15  Ustalanie płaszczyzn klap wylotu powietrza  
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Ustaw środek transformacji na Individual Origins. W tym trybie, gdy obrócisz obiekty klap (Rysunek 7.6.15) wo-

kół ich lokalnych osi X, będą się otwierać/zamykać jak w oryginale (spróbuj!). Na zdjęciach można zauważyć, że 

górne i dolne klapy wylotu miały różne kształty. Zmierzyłem na tych zdjęciach wartości ich proporcji a/b i a/c 

(Rysunek 7.6.16a). Te proporcje pozwoliły mi ustalić przybliżony kąt obrotu tych klap w pozycji „zamknięte”: 

−25º. Przekształć te prostokąty w trapezy, które, gdy obrócone pod tym katem, stykają się bocznymi krawę-

dziami. Potem ustaw z powrotem obrót klap wokół osi X na 0 (do pozycji neutralnej). Wstaw w ich siatki kilka 

środkowych krawędzi i dodaj modyfikatory Subdivision Surface. Dopasuj ich wynikowy kształt do powierzchni 

osłony, przesuwając (Slide) wierzchołki i/lub zmieniając ich lokalne współrzędne Z (Rysunek 7.6.16b):  

    

    

    

Rysunek 7.6.16  Dopasowywanie klap osłony i wewnętrznej powierzchni wylotu 

Dodaj do obiektów klap modyfikatory Mirror i wskaż X.000.Base jako ich Mirror Object. To stworzy ich lustrzane 

odbicia po drugiej stronie osłony (Rysunek 7.6.16c). Zakładam, że górny tylny narożnik górnej klapy tworzył kąt 

prosty, więc poprawiłem górny kontur powierzchni wylotu chłodnic, aby pasował do tej klapy (Rysunek 7.6.16d). 

Potem obróciłem te klapy w pozycję „zamknięte”. Poprawiłem kształt powierzchni wylotu, dopasowując ją do 

krawędzi klap (Rysunek 7.6.16e) i brzegów otworu w osłonie silnika (Rysunek 7.6.16f). 
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W ostatnim kroku stworzymy otwory wyrzutnika łusek (i ogniw taśm). Oczywiście, zrobimy to za pomocą dodat-

kowej „bryły tnącej”. Przeglądając dostępne dane, znalazłem wymiary tych otworów na rysunkach złożeniowych 

skrzydeł P-361. Przygotowałem nową bryłę – „pudełko”, pasujące do tych wymiarów (Rysunek 7.6.17a):  

    

    

Rysunek 7.6.17  Wycinanie otworu wyrzutnika łusek  

Aby stworzyć otworzy w skrzydle, włączyłem tę bryłę do obiektu U.100.L.Root (Rysunek 7.6.17b). Osłona kila 

jest minimalnie szersza niż ten otwór (Rysunek 7.6.17a). Na zdjęciach te otwory przecinają zewnętrzne krawę-

dzie kila (Rysunek 7.6.17c). Aby uzyskać taki efekt, stworzyłem kolejne, nieco szersze „pudełko” i połączyłem je 

z obiektem U.600.Blocks (Rysunek 7.6.17d). 

Jednak porównując zdjęcie (Rysunek 7.6.17c) z moim modelem, możesz zauważyć, że tylna krawędź „blistra” 

powinna być bliżej otworu wyrzutnika. Zrobiłem ten błąd, przygotowując rzut z boku, który używamy tutaj jako 

obraz wzorcowy R.Side.Left (compiled)2. Zdecydowanie potrzebujemy porównać te szczegóły osłony silnika z 

precyzyjnie nałożonymi zdjęciami (por. Rozdział 14), tak jak to zrobiliśmy w przypadku wlotu do chłodnic (por. 

str. 319)! Jednak wolę zacząć to pracochłonne porównywanie, gdy wszystkie elementy modelu będą już na 

swoim miejscu (każdy z nich pomaga dopasować się do projekcji zdjęcia). W tym momencie poprawimy tylko 

ten kil, by uzyskać jakieś wstępne przybliżenie tego kształtu. 

 
1 Patrz rys. 75-03-064. Te P-36 były wyposażone w dwa km M2: 0.50” i 0.30”, zamontowane obok siebie w kadłubie. Rysunki pokazują, że 

ich wyrzutniki łusek były identyczne po obu stronach kadłuba. W P-40-cu/B/C na tych samych podstawach umieszczono dwa nkm 0.50”. 

Początkowo (w P-40-cu) zachowano nawet oddzielne zasobniki z amunicją, jak w P-36. W skrzydłach wczesnych P-40 otwory tych wyrzut-

ników wyglądają tak samo jak w P-36, więc założyłem, ze mogę tu użyć wymiarów z jego dokumentacji.  

2 Szczegóły przygotowania tego rzutu opisuje Tom I, sekcje 9.4-9.7. W szczególności, popełniłem błąd w interpretacji szczegółów wyrzutni-

ka łusek pokazywanego przez rys. 75-69-902. Założyłem, że jego otwór był o 2” bliżej przegrody silnika i nieco szerszy. W efekcie, wszyst-

kie długości Segmentu 0 kila i jego „blistra”, pokazane przez rysunek R.Side.Left (compiled) są nieprawidłowe. 
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https://app.aircorpslibrary.com/drawing/viewer/75-03-604/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-69-902/p-40
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Przesuń tylną ścianę siatki U.600.Blocks do stacji -1 (Rysunek 7.6.18a). Przesuń tylną krawędź „blistra”, dopa-

suj ją do tego zmodyfikowanego otworu i wstaw krawędź A (Rysunek 7.6.18b). Ukryj na chwilę górną klapę 

wylotu i poszerz (pogłęb) narożniki na linii krawędzi A i B (Rysunek 7.6.18c), za rogiem klapy. W widoku z boku 

skaluj wzdłuż osi Z dół linii krawędzi B i C, tworząc mniej „kanciasty” kontur blistra (Rysunek 7.6.18d):  

    

    

Rysunek 7.6.18  Modyfikacje, wprowadzone do „blistra” i Segmentu 0  

Nadal pozostaje w tym obszarze wiele elementów do odtworzenia: trójkątne płytki „uszczelniające” pomiędzy 

klapami, wręgę klap, ich osie i popychacze, przewody wentylacyjne, pionowe ściany wyrzutnika łusek, itd. Bio-

rąc pod uwagę możliwą modyfikację tego obszaru w wyniku dokładnego porównania ze zdjęciami, zdecydowa-

łem się jednak na stworzenie tych szczegółów później, w ostatniej części tego przewodnika. 

Na ten moment, pozostawiamy kil i wylot chłodnicy w takim stanie, jaki pokazuje Rysunek 7.6.19: 

 

Rysunek 7.6.19  Wątpliwości dot. geometrii wylotu z chłodnic (do późniejszego sprawdzenia)  
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Podsumowanie 

• Aby odtworzyć geometrię kila, użyliśmy współrzędnych z oryginalnych rysunków (str. 323-324). Obejmują 

one segmenty 1, 2 i 3. Dla segmentu 0 mamy tylko współrzędne w dwóch stacjach: -89/32 i 0 (por. str. 323). 

Przy formowaniu „blistra” i klap z przodu tego kila, musieliśmy opierać się wyłącznie na zdjęciach. Używa-

łem do tego tylko zdjęć historycznych, gdyż Segment 0 w odrestaurowanych samolotach wygląda inaczej1. 

Tradycyjne porównywanie ze zdjęciami (opisane w Tom I, sekcja 5.1) prowadzi do mozolnego przybliżania 

właściwego kształtu metoda „prób i błędów”, który możesz obserwować na stronach 325, 331, 332. 

• Aby efektywnie wykorzystać wszystkie spółrzędne segmentów kila, stworzyliśmy pomocnicze kontury w 

przestrzeni 3D (str. 324). 

• Formowaliśmy każdy z segmentów jako oddzielny obiekt, ponieważ panele 1 i 2 były mocowane w różny 

sposób (str. 327), a pomiędzy panelami 2 i 3 był slot (str. 326). 

• Aby uformować każdy z segmentów kila, kopiowaliśmy jego przednią krawędź z poprzedniego panelu (str. 

325, 326). W przypadku Segmentu 1 była to dolna część brzegu osłony silnika. Wyciągnęliśmy ten kontur 

we wstępną powierzchnię, potem wstawiliśmy kilka linii krawędzi w środek jej siatki. Na koniec dopasowali-

śmy powierzchnię wynikową do wzorcowych „wręg” i konturu spodu skrzydła. W panelach 1 i 3 wyciągnęli-

śmy zaokrąglone krawędzie natarcia (str. 325, 326). W panelach 2 i 3 wyciągnęliśmy boczne kołnierze. Za-

okrągliliśmy ich wewnętrzne krawędzie wykorzystując modyfikatory Bevel (Weight). 

• Uformowaliśmy wylot powietrza z chłodnicy i „blister” z przodu kila w podobny sposób jak pozostałe seg-

menty (str. 328). Z powodu bardziej złożonego kształtu tej części, użyliśmy pomocniczych konturów bocz-

nych do określenia położenia środkowych linii krawędzi tej siatki (str. 329). 

• Przygotuj każdą z klap jako oddzielny obiekt. Zacznij od płaskich prostokątów, ustawionych wzdłuż konturu 

osłony (str. 329). Ich lokalne osie X powinny biec wzdłuż osi obrotu klap. Następnie przekształć te prosto-

kątne klapy w trapezy, wstaw kilka środkowych krawędzi i dopasuj do powierzchni osłony (str. 330). 

• Aby wyciąć otwory na wyrzutniki łusek km, dodaliśmy dwie dodatkowe bryły do siatek obiektów tnących. 

(Chodzi o obiekty wykorzystywane do „przycinania” osłony silnika i skrzydła – por. str. 331). 

 

 

 

 
1 Sądzę, że to wynik jakiegoś błędu popełnionego przy restauracji pierwszego z „długonosych” P-40. Kolejne zespoły używały zdjęć tego 

dobudowanego P-40 jako wzoru (por. Tom I, sekcja 9.3, Rysunek 9.3.4). W ten sposób powtórzyły ten sam błąd. 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-11.06.blend. 

  



334 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Rozdział 8. Kabina pilota 

Zdecydowałem się opisać modelowanie kabiny pilota w oddzielnym rozdziale, ze względu na jego mieszaną 

strukturę (metalowa ramka + szkło organiczne), która wymaga specyficznych metod modelowania.  
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8.1 Oszklenie za głową pilota 

Zacznijmy modelowanie osłony kabiny od stworzenia jego tylnej części, za zagłówkiem fotela pilota. Rysunek 

8.1.1a) pokazuje tę część w Hawk 75 (wariant eksportowy P-36), dla której zachowała się oryginalna dokumen-

tacja1. W P-40-cu projektanci zmodyfikowali wewnętrzny kontur tej ramki. Skrócili tylne wycięcie, umieszczając 

pomiędzy wręgami #8 i #9 mały otwór inspekcyjny2 (Rysunek 8.1.1b):  

   

Rysunek 8.1.1  Oszklenie za głową pilota w P-36 i P-40-cu  

Te osłony znikły w późniejszych wariantach (P-40B/C), ale kształt wycięcia pozostał już taki, jak w P-40-cu. W 

obydwu obrazach referencyjnych, których używamy – R.Side.Left (Temma) i R.Side.Left (compiled) – położe-

nie i promień tego tylnego „narożnika” został skopiowany ze zdjęć. W R.Side.Left (compiled) kontur ramki do-

pasowałem także do podłużnic kadłuba (Rysunek 8.1.2): 

 

Rysunek 8.1.2  Wzorcowy kontur w widoku z boku (R.Side.Left (compiled))  

Pracując nad tym modelem, użyłem oryginalnego rysunku ramki tego panelu z P-36: 75-21-078. Włączyłem 

jego kontur w obraz R.Side.Left (compiled), i dodatkowo obrysowałem go czerwoną linią (na tym obrazie kolor 

czerwony oznacza „potwierdzone”). Zaokrąglony narożnik za wręgą #8 jest narysowany na niebiesko (ten kolor 

oznacza „przypuszczenie”), ponieważ został skopiowany ze zdjęć. 

 

1 Por. rys. 75-21-078 i -080. Zwróć uwagę na poprawiony kontur końcówki ramki tej paneli pokazany przez Rysunek 8.1.1a). Naniosłem go 

w oparciu o te rysunki. Wydaje mi się, że to drobny błąd w tym bardzo starannie odtworzonym egzemplarzu Hawk 75. 

2 Dokładniej: w tym samym miejscu po lewej stronie P-40-cu znajdowała się większa osłona, zamykająca wlew do zbiornika oleju. Projek-

tanci umieścili ten zbiornik pomiędzy wręgami #8 i #9, ponad zbiornikiem paliwa (por. rys. 87-46-003). Jednak wkrótce się okazało, że tak 

radykalna zmiana (w P-36 zbiornik oleju był przed przegroda silnika) ograniczyła manewrowość P-40-cu. Aby temu zaradzić, w P-40B/C 

zmniejszono długość (i zwiększono wysokość) zbiornia paliwa, by umieścić za nim zbiornik oleju – bliżej osi kadłuba. W rezultacie, wlewy do 

obydwu zbiorników znalazły za lewą tylną szybą kabiny. Były dostępne poprzez okrągłe wycięcia w jej szkle. Dopiero w P-40D zbiornik oleju 

wrócił przed kabinę pilota (blisko środka ciężkości samolotu) – w miejsce usuniętych z kadłuba km.    
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https://app.aircorpslibrary.com/drawing/viewer/75-21-078/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-21-078/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-21-080/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-46-003/p-40
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Na początek, użyj jako wzorca obrazu R.Sections (tail). Stwórz prostokąt (Plane) przed wręgą #5 (Rysunek 

8.1.3a), potem dodaj modyfikator Subdivision Surface i obrysuj kontur wręgi (Rysunek 8.1.3b):  

       

Rysunek 8.1.3  Formowanie pomocniczego obiektu tnącego  

Gdy już go uformowałeś, wyciągnij tę ścianę wzdłuż globalnej osi Y za stację #9 (Rysunek 8.1.3c). Nazwij ten 

obiekt U.500.Cockpit Recesses i umieść w kolekcji 2c8.Booleans. W kolejnym kroku musimy widzieć linię 

przecięcia zaokrąglonej części tej „tuby” z powierzchnią kadłuba, więc tymczasowo usuń z jej siatki ( X , Only 

Faces) dwie płaskie ściany boczne (Rysunek 8.1.3c). 

Teraz dopasuj zaokrągloną część tego pomocniczego obiektu do kształtu wręg #6, #7 i #8 z obrazu referencyj-

nego. Jako pierwsze przybliżenie, ustaw kursor 3D (środek obrotu) na przecięciu z wręgą #5 (Rysunek 8.1.4a) i 

obróć ten obiekt wokół globalnej osi Z, obserwując jego linię przecięcia z kadłubem. Dla kąta -2.1º linia przecię-

cia pasuje do środka ramki. Co ciekawe, ustawiona pod tym kątem pasuje także do wręg (#5...#8):  

     

 

Rysunek 8.1.4  Wycinanie miejsca na wgłębienia za zagłówkiem pilota  

Użyj modyfikatora Mirror (z X.000.Base jako Mirror Object) by stworzyć lustrzane odbicie tej „tuby” po prawej 

stronie. Odtwórz dwie usunięte ściany boczne by zamknąć tę bryłę. Następnie użyj jej w nowych modyfikatorach 

Boolean (Difference), dodanych do obiektów B.500.Fuselage i B.510.Frame #5 (Rysunek 8.1.4b). 
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Wgłębienia poszycia za wręgą #5 odtworzymy wykorzystując modyfikator Shrinkwrap (por. str. 565). 

Utwórz najpierw powierzchnię wyjściową: prosty, płaski trapez. Ustaw go jak pokazuje Rysunek 8.1.5a) i b):  

     

  

     

Rysunek 8.1.5  Przygotowywanie zagłębionej części poszycia kadłuba  

Nazwij ten nowy obiekt B.515.Recesses. Dodaj do jego modyfikatorów Subdivision Surface. Ustaw jego poziom 

podziału na 3. Potem dołącz modyfikator Shrinkwrap. Ustaw jego metodę na Project i wskaż jako Target obiekt 

U.500.Cockpit.Recesses (Rysunek 8.1.5c). Włącz opcję Skrinkwrap:On Cage, a potem przesuń dolną krawędź 

siatki B.515.Recesses wzdłuż lokalnej osi Y, by zakryć całe wycięcie w kadłubie. 

Początkowo, przekroje powierzchni wynikowej są nieco kanciaste, ponieważ modyfikator Subdivision dzieli każ-

dą oryginalną krawędź na osiem równych części. Aby je wygładzić, wstaw w tę siatkę dwie lub trzy dodatkowe 

krawędzie (Rysunek 8.1.5d). Zrób to z włączoną opcją On Cage modyfikatora Shrinkwrap. Przesuń (Slide) te 

nowe krawędzie do obszarów o większej krzywiźnie. Wówczas ich ostre krawędzie ulegną wygładzeniu.   

Użyjmy oryginalnego kształtu kadłuba do przycięcia zewnętrznych konturów tych wgłębień. W tym celu sklonuj 

obiekt B.500.Fusleage (Duplicate Linked lub Alt - D , por. str. 464). Nazwij ten klon X.500.Fuselage i umieść w 

kolekcji 2c9.Auxiliary. Usuń z niego wszystkie modyfikatory oprócz Mirror i Subdivision Surface. Do szybkiej 

identyfikacji, która z kopii kadłuba jest aktualnie widoczna, włącz w X.500.Fuselage dodatkową opcję Viewport 

Display:Wireframe (Rysunek 8.1.5e). 
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Dodaj do obiektu B.515.Recesses modyfikator Solidify (Thickness: 0.032”) i modyfikator Boolean (Intersect), 

który używa X.500.Fuselage jako obiekt tnący (Rysunek 8.1.6a):  

 

     

Rysunek 8.1.6  Przycinanie powierzchni zagłębień kadłuba 

Na zdjęciach kokpitu widać, że poszycie kadłuba sięga za płaszczyznę wręgi #5. Rysunek ramki tylnego 

oszklenia (por. []) podaje jej szerokość: ¾”. Zmodyfikuj właściwy obiekt tnący (U.501.Cockpit) przesuwając 

jego tylną ścianę do przodu o 0.73” (cos(13.5º) * 0.75). Potem użyj tego obiektu do przycięcia wklęsłej paneli za 

pomocą kolejnego modyfikatora Boolean (Difference) (Rysunek 8.1.6b). Powiel ten rezultat na drugą stronę 

samolotu dołączając do listy modyfikatorów B.515.Recesses kolejny: Mirror (Mirror Object: X.000.Base). Zmie-

niony kształt bryły tnącej zmusił mnie do dodania dwóch dodatkowych ścian do siatki kadłuba w narożniku ko-

kpitu (Rysunek 8.1.6c). W przeciwnym razie pojawiłaby się luka pomiędzy dolna krawędzią ramki tylnego 

oszklenia i boczną krawędzią otworu kokpitu.  

Rysunek 8.1.7 pokazuje kadłub P-40 z gotowymi zagłębieniami za kabiną pilota: 

 

Rysunek 8.1.7  Kadłub z zagłębieniami  

W prawdziwym samolocie, górne krawędzie tych zagłębień były zaokrąglone (R: ok. 0.2”). Jednak odtworzenie 

tego szczegóły wymagałoby znacznej pracy, podczas gdy rezultat byłby i tak zupełnie zasłonięty przez ramkę 

tylnego oszklenia kabiny. Dlatego pozostawiłem te krawędzie jako „ostre”. 

a) 

b) c) 

Wręga #5  

Lustrzane 
odbicie 
panelu  

Przytnij tę 
przednią kra-
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Stwórzmy szkło tylnej części kabiny. Zacznij od płaskiego trapezu, wygładzonego modyfikatorem Subdivision 

Surface (Rysunek 8.1.8a). Nazwij go B.520.Glass.Rear. Aby nie zawracać sobie głowy nachyleniem przedniej 

krawędzi (pochylenie: 13.5º), obróć cały obiekt o ten kąt (Rysunek 8.1.8b). Zgodnie z dokumentacją, przednia 

krawędź tej szklanej paneli była 3/8” za wręgą #5. Umieść środek (origin) obiektu B.520.Glass.Rear na tej 

płaszczyźnie, w lewym, dolnym narożniku panelu. Ten panel powinen być nieco odsunięty (~1”) od kadłuba:  

       

 

        

Rysunek 8.1.8  Formowanie powierzchni szkła  

Użyłem modyfikatora Shrinkwrap w trybie Project (Rysunek 8.1.8c) aby „położyć” tę panel na powierzchnię ka-

dłuba (Target: X.500.Fuselage). Początkowo użyłem w Subdivision Surface 3-ci poziom podziału. Aby nie prze-

sadzać z liczbą ścian modelu, zmniejszyłem potem ten poziom do 2 i wstawiłem w tę siatkę dodatkowe krawę-

dzie by wygładzić jej powierzchnię (Rysunek 8.1.8d). Dodaj do modyfikatorów tego obiektu: Solidify (Thickness: 

0.2”) i Mirror (Mirror Object: X.000.Base). Zewnętrzne krawędzie tego panelu będą ukryte po ramką, ale mo-

żesz poprawić jego kształt w rzucie z boku, by lepiej pasował do jej konturu (Rysunek 8.1.8e).  

a) b) 

c) 

d) e) 
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Stwórz nowy materiał (por. str. 574) dla szkła organicznego i przypisz go do tego panelu. Nazwij go 

B.Glass.Organic1. Na razie ustaw tylko jego właściwości z panelu Viewport Display (Rysunek 8.1.9):  

   

Rysunek 8.1.9  Początkowe ustawienie materiału B.Glass.Organic  

Najważniejszym z tych ustawień jest przejrzystość. Użyj czwartego składnika Color, o symbolu A(lfa), do okre-

ślenia tej wartości (por. str. 457). Ustawmy Color:A na 0.2. Aby zwiększyć połyskliwość powierzchni szkła, 

zmniejsz Roughness do około 0.1. Te połyski będą jednak tylko widoczne tylko po przełączeniu okna 3D w tryb 

cieniowania Studio. (Wyraźnie w trybie cieniowania MatCap Blender nadpisuje współczynniki szorstkości usta-

wione w panelu Viewport Display). 

Gdy szkło jest na miejscu, stwórzmy ramkę tego okna. Tak jak w przypadku szyby, zacznij od stworzenia w rzu-

cie z boku prostego czworokąta, wygładzonego modyfikatorem Subdivision (poziom: 2). Dołącz także modyfika-

tor Shrinkwrap (Project), ustawiony tak, jak pokazuje Rysunek 8.1.8c). Nazwij ten nowy obiekt 

B.525.Glass.Frame. Aby zmniejszyć deformacje górnej krawędzi „owiniętej” powierzchni (por. Rysunek 8.1.8e) 

w widoku z przodu obróć B.525.Glass.Frame o 18º, ustawiając obiekt równolegle do powierzchni kadłuba 

(Rysunek 8.1.10a). Dodatkowo, obróć ten obiekt w widoku z boku o 13.5º, aby jego przednia krawędź biegła 

wzdłuż wręgi #5 i przedniej krawędzi szkła (Rysunek 8.1.10b):  

     

Rysunek 8.1.10  Wstępne ustawienia obiektu ramki 

 
1 Jest to pierwszy z materiałów, których użyjemy w finalnych renderach. W kolejnej części tego poradnika, o materiałach i teksturach, stwo-

rzymy materiał B.Camouflage dla zewnętrznych powierzchni, B. Inner (Curtiss Green) dla wewnętrznych, i tak dalej. Sugeruję poprzedzać 

nazwy tych wszystkich „normalnych” materiałów tą samą literą, np. – „B”.  

 

Podczas edycji siatki zdeformowanej modyfikatorem Shrinkwrap, zachowuj jej wierzchołki na orygi-

nalnej płaszczyźnie. W tej sekcji to lokalne XY – gdy przesuwasz wierzchołki, zablokuj lokalną oś Z.         
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Włącz tryb Shrinkwrap:On Cage i rozdziel początkowy prostokąt w dwa mniejsze, umieszczone na górnej i dol-

nej krawędzi wgłębienia w kadłubie (Rysunek 8.1.11a). Przesuń narożniki tych czworokątów po lokalnej płasz-

czyźnie XY, tak aby ich środki na wynikowej (rzutowanej na kadłub) powierzchni biegły wzdłuż krawędzi wgłę-

bienia1. Upewnij się, że narożniki wynikowych (rzutowanych) czworokątów leżą 1” od tych krawędzi:  

     

Rysunek 8.1.11  Formowanie ramki okna 

Przesuń tylne krawędzie tych ścian po lokalnej pł. XY wzdłuż krawędzi wgłębienia (Rysunek 8.1.11b). 

Teraz przełącz projekcję okna 3D na lokalny widok z góry obiektu B.525.Glass Frame ( Shift - 7  w ObjectMode). 

Wyłącz tryb Shrinkwrap:On Cage (bo dziwnie deformuje krawędzie nie połączone z żadną ścianą). Wstaw 

8-bok (Circle) w wewnętrzny narożnik ramki (Rysunek 8.1.12a). Usuń większość jego krawędzi oprócz 1 i 2 

(por. Rysunek 8.1.12b). Wyciągnij wierzchołki A i B (Rysunek 8.1.12b) i połącz je nową krawędzią: 

      

      

Rysunek 8.1.12  Formowanie ramki okna (c.d.) 

Stwórz nowe ściany pomiędzy tymi krawędziami (Rysunek 8.1.12c). Potem włącz tryb Shrinkwrap:On Cage, 

przełącz się na rzut z boku i popraw topologię tej siatki dzieląc n-gony i wyciągając nowe ściany (Rysunek 

8.1.12d). Przesuwaj te wierzchołki po lokalnej płaszczyźnie XY, dopasowując ramkę do rysunku wzorcowego. 

 
1 Pamiętaj, aby podczas tych przesunięć zablokować lokalną oś Z! Dla ułatwienia, możesz tymczasowo przełączyć domyślną orientację 

transformacji na Local (por. Rysunek 8.1.11c). Gdy to zrobisz, możesz użyć skrótu G , Shift - Z , a potem przesunąć wierzchołki tej siatki.  
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Aby lepiej dopasować „paski” ramki rozciągające się pomiędzy wręgami #5 i #8 do wzorcowego konturu, wstaw 

w każdy z nich dodatkowe krawędzie (Rysunek 8.1.13a):  

 

 

       

Rysunek 8.1.13  Formowanie ramki okna (c.d.) 

Po tych znacznych zmianach, dobrym pomysłem jest przyjrzeć się tym „paskom” ramki pod ostrym kątem, by 

sprawdzić czy ich krawędzie pozostały równoległe (Rysunek 8.1.13b). Jak widać, musiałem przesunąć (Slide) 

kilka wierzchołków by wyrównać szerokość ramki (Rysunek 8.1.13c). Zrób to samo z jej dolną częścią. 

Rysunek 75-21-078 pokazuje szczegóły narożników ramki przy wrędze #5. Rysunek 8.1.14a) pokazuje wymiary 

dolnego narożnika. To całkiem złożony kształt! Zauważ, że jego wymiary wykorzystują wręgę #5 jako bazę. 

      

Rysunek 8.1.14  Formowanie narożnika ramki okna 

Odwzoruj ten kształt na lokalnej płaszczyźnie XY obiektu ramki (Rysunek 8.1.14b).  

Wstaw dodatkową krawędź by 
lepiej odwzorować kontur wzorca 

Wstaw dodatkowe krawędzie by 
lepiej odwzorować kontur wzorca 
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https://app.aircorpslibrary.com/drawing/viewer/75-21-078/p-40
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W podobny sposób odtwórz górny narożnik ramki okna (Rysunek 8.1.15a)1. Dla takiego rzutowanego pod du-

żym kątem kształtu trzeba zmniejszyć wysokość siatki na lokalnej płaszczyźnie XY:  

    

Rysunek 8.1.15  Formowanie ramki okna (c.d.) 

Gdy górny narożnik jest gotowy, dołącz do listy modyfikatorów obiektu B.525.Glass Frame modyfikatory 

Solidify (Offset: 1, Thickness: 0.032) oraz Mirror (Mirror Object:X.000.Base). Rezultat powinien wyglądać jak 

pokazywany przez Rysunek 8.1.15b).  

W B.525.Glass Frame górne końce prostych pionowych krawędzi rzutowanych na powierzchnię kadłuba są 

zagięte do tyłu z powodu obrotu tego obiektu wokół dwóch osi (por. Rysunek 8.1.10). Aby uniknąć takich kłopo-

tów, odtwórzmy dwa pionowe paski ramki okna jako oddzielny obiekt2. Stwórz pierwszy, przedni pasek w widoku 

z boku. Umieść jego środek (origin) w tym samym miejscu, co środek B.525.Glass Frame. Obróć obiekt paska 

tylko wokół globalnej osi X o 13.5º (Rysunek 8.1.16): 

    

Rysunek 8.1.16  Odtwarzanie pionowych pasków ramki okna 

Nazwij ten nowo stworzony obiekt B.530.Glass Frame. Dodaj do niego te same modyfikatory, jak użyte przez 

obiekt B.525.Glass Frame (Subdivision Surface, Shrinkwrap, Solidify, Mirror). 

Umieść kursor 3D na lokalnej płaszczyźnie XY, przełącz aktualną projekcję na widok z boku, i stwórz tylny pa-

sek jak prostokąt wyrównany do globalnej osi Z (Rysunek 8.1.16b).  

 
1 Wykorzystaj wymiary ze szczegółu C na rysunku 75-21-078. 

2 W prawdziwym samolocie każdy z tych pasków był oddzielną częścią, więc ten podział odpowiada podziałowi technologicznemu.  
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https://app.aircorpslibrary.com/drawing/viewer/75-21-078/p-40
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Uformuj końcówki tylnego paska zgodnie z wymiarami (Rysunek 8.1.17a)1. Wstaw kilka środkowych krawędzie, 

aby wygładzić powierzchnie wynikowe „położone” na krzywiznę kadłuba. Dopasuj pionowe współrzędne górne-

go i dolnego końca paska, aby ich wynikowe rzuty pasowały do ramki okna (Rysunek 8.1.17b):  

         

 

Rysunek 8.1.17  Odtwarzanie pionowych pasków ramki okna (c.d.) 

Zwróć uwagę, że końce tylnego paska „toną” w ramce okna (Rysunek 8.1.17b). W prawdziwym samolocie były 

nałożone (przynitowane) do blachy ramki. Na szczęście, łatwo można ten efekt odtworzyć. W modyfikatorze 

Shrinkwrap obiektu B.530.Glass Frame wskaż B.525.Glass Frame jako Auxiliary Target (Rysunek 8.1.17c). 

Rysunek 8.1.18 pokazuje gotowe oszklenie za głowa pilota:  

 

Rysunek 8.1.18  Gotowe oszklenie za wręgą #5 

 
1 Źródło: 75-21-078. 
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https://app.aircorpslibrary.com/drawing/viewer/75-21-078/p-40
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W tym oszkleniu nadal brakuje kilku szczegółów: wlewów do zbiorników paliwa i oleju oraz ich wycięć w lewej 

szybie, wewnętrznych wzmocnień (widocznych na zdjęciach pod przednią krawędzią ramki). Odtworzymy je w 

ostatniej części tego poradnika.   

 

Podsumowanie 

• Do odtworzenia oszklenia za wręgą #5 wykorzystaliśmy obrazy referencyjne (str. 335-336). Skompilowałem 

je z oryginalnej dokumentacji P-36 i archiwalnych zdjęć. Zrobiłem to w oparciu o założenie (potwierdzone 

przez różne zdjęcia), że jedyną różnicą w geometrii tego zespołu pomiędzy P-36 i P-40 jest kształt wycięcia 

ramki w pobliżu stacji #8 (str. 335). Użyliśmy także szczegółowych rysunków ramki okna P-36 (str. 335, 

342, 343, 344). 

• Zaczęliśmy od pomocniczego obiektu wycinającego wgłębienie w kadłubie (str. 336). Okazało się, że pro-

ste wyciagnięcie początkowego konturu wgłębienia z wręgi #5, po niewielkim obrocie pasuje do konturów 

pozostałych wręg (str. 336). Wykorzystaliśmy go w kolejnym modyfikatorze Boolean, dołączonym do ka-

dłuba.  

• Aby szybki uformować wewnętrzną powierzchnię wgłębienia, „położyliśmy” za pomocą modyfikatora 

Shrinkwrap na obiekcie tnącym płaszczyznę podziałową (str. 337). Potem ją przycięliśmy za pomocą po-

mocniczego klona powierzchni kadłuba (str. 338). 

• Uformowaliśmy szkło tylnej szyby jako płaszczyznę podzieloną modyfikatorem Subdivision Surface. „Poło-

żyliśmy” ją na powierzchnię kadłuba za pomocą modyfikatora Shrinkwrap (Project) (str. 339). To szkło or-

ganiczne było osiem razy grubsze (0.2”) od blachy pokrycia (0.025”-0.032”). Zdefiniowaliśmy nowy mate-

riał dla tej i innych szklanych części (str. 340). 

• Nasza ramka okna jest zbudowana z dwóch obiektów: głównej części i pionowych pasków. Płaszczyzna 

głównej części ramki jest obrócona do powierzchni kadłuba (str. 340). W ten sposób zmniejszamy defor-

mację jej projekcji na powierzchnię kadłuba, generowaną przez modyfikator Shrinkwrap (Project). Pionowe 

paski mają podobne ustawienia do tej ramki, ale nie są pochylone do kadłuba (str. 343). Aby stworzyć efekt 

końców paska nakładających się na ramkę, użyliśmy w jego modyfikatorze Shrinkwrap opcji Auxiliary 

Target (str. 344). 

• Wszystkie komponenty tego oszklenia używają relatywnie prostych, płaskich siatek, rzutowanych na po-

mocnicze powierzchnie za pomocą modyfikatorów Shrinkwrap.  

• Wykorzystanie klon siatki kadłuba w ukrytym obiekcie pomocniczym nie zwiększa wynikowej liczby ścian 

modelu ani rozmiaru pliku *.blend. Dzieje się tak dlatego, że obydwa obiekty współdzielą tę samą siatkę. 

Zalecam używanie takich klonów jako „celów” w modyfikatorach Shrinkwrap i Boolean. 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-12.01.blend. 
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8.2 Wiatrochron (wczesna wersja) 

Wiatrochron wydaje się być stosunkowo prostą częścią myśliwca z lat czterdziestych XX w. Jednak w większo-

ści przypadków jego krawędź przecięcia z kadłubem ujawni każdy błąd w ich przekrojach. W P-40-cu wiatro-

chron bardziej przypominał P-36 (Rysunek 8.2.1a), podczas gdy w P-40B/C ma powiększone otwory zamków 

km. Te większe otwory „wypchnęły” dolną ramkę wiatrochronu na powierzchnię szyby (Rysunek 8.2.1b,c):  

    

Rysunek 8.2.1  Różnice w wiatrochronach P-40-cu i P-40B/C  

Ten wiatrochron był wykonany z trzech cylindrycznych kawałków szkła organicznego (grubość: 0.25”)). Ich ze-

wnętrzne krawędzie były osadzone w dwóch ramkach: tylnej i dolnej. Ramki były odlewami z aluminium. Połą-

czono je dwoma prętami, biegnącymi za szkłem wiatrochronu. Dolna ramka była ukryta pod poszyciem kadłuba.  

Gdy zaczynałem pisać tę sekcję, zakładałem, że geometria wczesnych P-40 za przegrodą silnika była identycz-

na z P-36. Pracując nad wiatrochronem P-40-cu używaj następujących rysunków wzorcowych1: 

• R.Side.Left (compiled) (Rysunek 8.2.2a): rzut z boku, złożony z dokumentacji P-36 i szkiców XP-40 

(por. także str. 90). 

• R.Sections (middle) (Rysunek 8.2.2b): przekroje środkowych sekcji kadłuba (por. str. 276). 

      

Rysunek 8.2.2  Rysunki referencyjne wiatrochronu (oparte o dokumentację P-36) 

 

 
1 Skompilowano w nich informację z następujących rysunków P-36: 75-25-001, 75-26-001, -011, -012, -020, -021. Nie znalazłem żadnej 

dokumentacji wczesnych wariantów P-40 związanych z tym wiatrochronem.  
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https://app.aircorpslibrary.com/drawing/viewer/75-25-001/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-26-001/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-26-011/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-26-012/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-26-020/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-26-021/p-40
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W pierwszym kroku, uformuj podstawową powierzchnię osłony kabiny. Użyj do tego pomocniczego okręgu 

(R=103/32”) i trapezu, obróconego wokół globalnej osi X o 5.40º (Rysunek 8.2.3a). Nazwij ten trapez 

X.720.Canopy i umieść w pomocniczej kolekcji. Wygładź go modyfikatorem Subdivision Surface. Wykorzystu-

jąc pomocniczy okrąg jako wzór, w widoku z przodu odtwórz zaokrąglony kontur osłony kabiny (Rysunek 

8.2.3b). Podczas tej edycji przesuwaj wierzchołki konturu po lokalnej płaszczyźnie XY tego obiektu:  

           

Rysunek 8.2.3  Formowanie powierzchni osłony kabiny 

Na koniec, wyciągnij ten kontur wzdłuż globalnej osi Y (Rysunek 8.2.3c). 

Gdy osłona kabiny jest ukształtowana, uformuj podstawową powierzchnię wiatrochronu (Rysunek 8.2.4):  

     

Rysunek 8.2.4  Formowanie powierzchni wiatrochronu 

Zacznij od cylindra o R=103/4”, obróconego o 52.5º wokół globalnej osi X (Rysunek 8.2.4a). Potem usuń wszyst-

kie jego ściany oprócz przedniej części i wyciągnij nowe, płaskie ściany boczne. Dopasuj ich krawędzie do dol-

nych narożników osłony kabiny (Rysunek 8.2.4b). Nazwij ten obiekt B.705.Windshield.Glass. 
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Przygotuj pomocniczą bryłę do przycięcia tego wiatrochronu. Nazwij ją U.700.Glass.Contour i umieść w kolek-

cji 2e8.Booleans. Rysunek 8.2.5a) pokazuje jej rzut z boku, a Rysunek 8.2.5b) rezultat użycia w modyfikatorze 

Boolean (Intersect) w obiekcie B.705.Windshield.Glass:  

      

Rysunek 8.2.5  Przycinanie szyby wiatrochronu 

Grubość tego szkła (0.25”), pokazywana przez Rysunek 8.2.5b), została wygenerowana przez modyfikator 

Solidify. Jak widzisz, przypisałem także temu obiektowi materiał B.Glass.Organic. 

Teraz stwórzmy ramki wiatrochronu. Wydziel z osłony kabiny (por. Rysunek 8.2.3c) pasek o szerokości 0.5”. To 

będzie wstępny kontur tylnej ramki wiatrochronu. Stwórz pierścień wokół szyby wiatrochronu: to będzie kołnierz 

dolnej ramki (Rysunek 8.2.6a):  

       

Rysunek 8.2.6  Wstępne elementy ramek wiatrochronu 

Stwórz ten pierścień na lokalnej płaszczyźnie XY obiektu B.705.Windshield.Glass (przełącz się na jego lokalny 

widok z góry: Shift - 7 ). Po dodaniu standardowych modyfikatorów Mirror i Subdivision Surface, przekształć ten 

pierścień w „U”, dopasowany do poprzecznego przekroju wiatrochronu (Rysunek 8.2.6b). Potem użyj modyfika-

tora Shrinkwrap (Project) wzdłuż lokalnej osi Z do „położenia” tego paska na powierzchnię kadłuba (Rysunek 

8.2.6c). Jako powierzchnię docelową tego modyfikatora wskaż pomocniczy X.500.Fuselage. Nazwij tak prze-

kształcony pierścień B.710.Windshield.Frame (lower).  
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Dodaj do tego paska modyfikator Solidify (Thickness: 3/16”). Zgrupuj wszystkie elementy kabiny w nową kolekcję 

w 2.Fuselage, o nazwie 2e.Cockpit (Rysunek 8.2.7):  

 

Rysunek 8.2.7  Elementy wiatrochronu i ich kolekcje 

Tak jak w przypadku innych podzespołów kadłuba, stwórz w 2e.Cockpit subkolekcje dla obiektów pomocni-

czych i brył tnących (tj. brył używanych w modyfikatorach Boolean). 

Teraz uformujemy wewnętrzną część dolnej ramki. Była odlana jako jeden element wraz z kołnierzem, ale my 

uprościmy ten złożony kształt dzieląc go na dwa obiekty. Takie uproszczenie wyklucza możliwość wygładzenia 

ich wewnętrznych krawędzi przecięcia, ale jest akceptowalne, gdy nie przewidujesz renderowania zbliżeń. 

Zacznij od wyznaczenia krawędzi przecięcia siatki wiatrochronu i jego bryły tnącej (obiektów B.705.* i U.700.*). 

Użyj w tym celu polecenia Object→Intersect, wskazując szybę jako drugi obiekt. Wydziel znalezioną krawędź w 

nowy obiekt, o nazwie B.711.Windshield.Frame (lower) (Rysunek 8.2.8a): 

     

Rysunek 8.2.8  Tworzenie wewnętrznej części ramki: formowanie wstępnego „paska” 

Ten nowy obiekt odziedziczył po wiatrochronie obrócony lokalny układ współrzędnych. Przesuń tę krawędź 

wzdłuż lokalnej osi Z o -0.25” poniżej przyciętej krawędzi szkła. Wyciągnij z niej nową krawędź wzdłuż lokalnej 

osi Z o około +0.75”, aby znalazła się na takim poziomie, jak górna krawędź kołnierza ramki (obiektu B.710.*). 

W ten sposób stworzyliśmy pasek leżący na zewnętrznej powierzchni szkła wiatrochronu (Rysunek 8.2.8b).  
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Teraz pogrub ten pasek modyfikatorem Solidify. Ustal jego grubość na 0.6”, a jego Offset na -0.78, aby zakrył z 

trzech stron dolną krawędź szkła wiatrochronu (Rysunek 8.2.9a):  

     

Rysunek 8.2.9  Tworzenie wewnętrznej części ramki: kroki końcowe 

Aby stworzyć w tej ramce rowek na krawędź szkła, przypisz jej (tj. obiektowi B.711.*) modyfikator Boolean 

(Difference). Wskaż w nim jako obiekt „tnący” szkło wiatrochronu (B.705.*) – jak pokazuje Rysunek 8.2.9b).  

Rozpocznij formowanie tylnej ramki od skopiowania „paska” z wzorcowej osłony (por. Rysunek 8.2.7, Rysunek 

8.2.6a) w nowy obiekt, o nazwie B.700.Windshield.Frame (rear) (Rysunek 8.2.10a): 

     

Rysunek 8.2.10  Tworzeniu tylnej ramki: czynności wstępne   

Wyciągnij jego przednią krawędź wzdłuż globalnej osi Y o -0.5” w nowy segment siatki, i przypisz do tego 

obiektu modyfikator Solidify. Na razie, ustaw jego grubość na 0.15”. Teraz zewnętrzna powierzchnia tego obiek-

tu odpowiada zewnętrznej powierzchni ramki odsuwanej osłony kabiny. To nam będzie potrzebne do dopaso-

wania tej ramki do szyby. Później zmniejszymy jej grubość do 1/16”, jednocześnie przełączając ją na zewnętrzną 

stronę tej siatki1. W ten sposób uformujemy właściwą ramkę, zakrywającą ruchomą część osłony. 

Dodatkowo, stworzyłem w rzucie z boku wzór konturu szczytu wiatrochronu (Rysunek 8.2.10b). Wykorzystałem 

w nim wymiary z rys. 75-26-020. Ten kontur opisuje wewnętrzną powierzchnię szczytu tylnej ramki. 

 
1 Por. wymiary na rysunku R.Sections (middle). 
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https://app.aircorpslibrary.com/drawing/viewer/75-26-020/p-40
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Na szczycie wiatrochronu znajduje się mała górna ramka. Jest przymocowana do ramki tylnej. Rozpocznij jej 

formowanie od wyznaczenia nowej krawędzi przecięcia: z górną powierzchnią bryły tnącej (Rysunek 8.2.11a). 

Wydziel tą krawędź w nowy obiekt, o nazwie B.701.Windshield.Frame (upper) i wyciągnij wzdłuż lokalnej osi Z 

w pasek o szerokości 0.4” (Rysunek 8.2.11b) – tak samo, jak stworzyliśmy dolną ramkę (por. Rysunek 8.2.8).   

    

    

Rysunek 8.2.11  Tworzeniu tylnej ramki: szczyt i boki    

Dodaj do tego obiektu modyfikator Solidify (grubość: 0.6”, Offset: 0.47) – jak w Rysunek 8.2.11c). Wytnij rowek 

w tej ramce za pomocą modyfikatora Boolean (tak, jak pokazuje to Rysunek 8.2.9). 

Dopasuj krawędź boczną ramki B.700.* do szyby wiatrochronu przesuwając wierzchołki jej pierwszej linii kra-

wędzi w kierunku prostopadłym, bliżej powierzchni szyby (Rysunek 8.2.11d). 

W modyfikatorze Solidify obiektu B.700.* ustaw Offset = 1 i zmniejsz Thickness do 1/16”. Stwórz wewnątrz łuku 

ramki pionową ścianę (Rysunek 8.2.12a). Pozostaw ją bez połączenia z siatką kołnierza:   

    

Rysunek 8.2.12  Szczegóły tylnej ramki    

Stwórz dodatkowy obiekt: ramkę o przekroju „U”, biegnącą wzdłuż bocznej krawędzi szyby wiatrochronu 

(Rysunek 8.2.12b). Użyj modyfikatora Solidify by nadać jej grubość 0.15”. 
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Gdy górna i tylna ramka są uformowane, można nad nimi „rozpiąć” szczyt wiatrochronu. Zacznij od skopiowania 

dwóch pasków ścian z tych ramek (Rysunek 8.2.13a). Potem połącz je w narożniku (Rysunek 8.2.13b,c):  

      

    

    

Rysunek 8.2.13  Formowanie szczytu wiatrochronu    

Zamknij lukę pomiędzy paskami za pomocą nowych ścian (Rysunek 8.2.13d), potem wstaw dodatkowe krawę-

dzie, dopasowując powierzchnię do wzorca (Rysunek 8.2.13e). Dodaj modyfikator Solidify (grubość: 0.04”, 

Offset: +1) by przykryć ramki (Rysunek 8.2.13f). Rysunek 8.2.13g) pokazuje uzyskany rezultat. 

 

Nie mogłem stworzyć bocznej części ramki (Rysunek 8.2.12b) jako paska “pogrubionego” do 0.6” 

(por. Rysunek 8.2.9 i Rysunek 8.2.11), bo jej ściany po dwóch stronach szkła nie są równoległe.         
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Moglibyśmy wyciąć w kadłubie otwór dla wiatrochronu. Zamierzamy jednak odtworzyć ten obszar w dwóch wa-

riantach: P-40-cu z małymi otworami inspekcyjnymi i P-40B/C, z dużymi otworami (por. Rysunek 8.2.1a). Dlate-

go lepiej uformujmy panel kadłuba pod wiatrochronem jako oddzielną część. Aby zrobić miejsce na ten nowy 

obiekt, wytnij fragment kadłuba za pokrywami nkm, od stacji 219/16 i ponad krawędzią kokpitu (Rysunek 8.2.14). 

Zrób to dodając kolejną bryłę tnącą (prostopadłościan) do siatki obiektu U.500.Fuselage:  

    

Rysunek 8.2.14  Wycięcie kadłuba wokół wiatrochronu  Rysunek 8.2.15  Dopasowanie ramki do brzegu kokpitu 

Zanim jednak zaczniemy formować ten nowy panel kadłuba, dokończmy ramkę wiatrochronu. Brakuje w niej 

niewielkiego fragmentu. W wyciętym przed chwilą obszarze kadłuba łatwiej jest uformować niewielki kołnierz 

pomiędzy ramką i brzegiem kokpitu. Rysunek 8.2.15 pokazuje ten szczegół w kolorze niebieskim. W prawdzi-

wym samolocie była to kolejna „wypustka” odlewu ramki. Uprośćmy ją jednak na nasze potrzeby, modelując 

jako odrębny obiekt. Uformuj jej siatkę z kilku prostych ścian (Rysunek 8.2.15a), potem dodaj modyfikator 

Solidify (grubość: 1/8”), aby uzyskać bryłę pokazywaną przez Rysunek 8.2.15b,c).     

Za szybą wiatrochronów P-36/P-40 widać dwa cienkie pręty. Nazwę je tutaj „szprychami”, ponieważ przenosiły 

tylko siły rozciągające – jak szprychy w kole roweru. Zacznijmy od uformowania ich podstaw w dolnej ramce. 

Stwórz przy niej pochylony pod kątem 52.5º cylinder ze „skrzydełkami” (Rysunek 8.2.16a):  

    

Rysunek 8.2.16  Formowanie „szprychy” (pręta) i jego okucia    

Stwórz teraz pręt szprychy: długi, cienki cylinder (Ø 0.19”), ustawiony równolegle do powierzchni wiatrochronu 

(Rysunek 8.2.16b). Najlepiej ustal środek (origin) tego obiektu w górnym końcu cylindra. Umieść go przy piono-

wej ścianie tylnej ramki, a potem dopasuj długość tak, by pasowała do okucia w ramce dolnej. 
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Stwórz małe okucie na u góry szprychy wiatrochronu, wykorzystując siatkę pokazaną przez Rysunek 8.2.17. (To 

okucie wiązało pręt z tylną ramką): 

      

Rysunek 8.2.17  Górne okucie „szprychy” Rysunek 8.2.18  Podział szkła wiatrochronu 

Istnieje jeszcze jeden szczegół, którego nie znajdziesz we współcześnie odrestaurowanych maszynach: wiatro-

chron P-36 i P-40 składał się z trzech paneli szkła, sklejonych „na styk” wzdłuż linii szprych. Aby odtworzyć ten 

efekt, stwórz pomocnicze płaszczyzny, ustawione tak, jak pokazuje Rysunek 8.2.18. Nazwij ten obiekt 

U.700.Glass.Seams. Przypisz mu grubość 0.032” (modyfikatorem Solidify). Użyj go w nowym modyfikatorze 

Boolean (Difference), przypisanym do obiektu B.705.Windshield.Glass. 

Stwórzmy teraz panel kadłuba wokół wiatrochronu. Zacznij od powielenia i wydzielenia odpowiedniego fragmen-

tu siatki kadłuba w nowy obiekt, o nazwie B.501.Windshield. Panel (Rysunek 8.2.19a). Dopasuj jego przednią 

krawędź do przekroju kadłuba w stacji 21 9/16. Przesuń (Slide) wierzchołki jego siatki, tworząc zakrzywioną tylną 

krawędź, dopasowaną do dolnej ramki wiatrochronu (Rysunek 8.2.19b):  

    

Rysunek 8.2.19  Formowanie panelu wokół wiatrochronu   

 

 

Na archiwalnych zdjęciach, klejone połączenie paneli wiatrochronu często wygląda jak druga para 

„szprych”. Można ją zauważyć na wielu fotografach P-36 i „długonosych” P-40. Z przyczyn technolo-

gicznych tego szczegółu nie odtworzono w żadnym z odrestaurowanych samolotów.          
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Zdjęcia sugerują, że w P-40 tylna część dolnej ramki była mniej „kanciasta” niż w P-36. Wydaje mi się, że tylny 

brzeg poszycia kadłuba nakłada się odrobinę na płaskie boki szkła wiatrochronu. W rezultacie cienki pasek 

(około 0.5”) na tym obszarze wygina się na zewnątrz, zgodnie z kształtem oszklenia. Aby odtworzyć ten efekt, 

wstaw przy tym brzegu dodatkową krawędź i zwiększ jej współczynnik Crease do 0.5 (Rysunek 8.2.20a):  

     

Rysunek 8.2.20  Formowanie boków panelu    

Zmodyfikowałem także kształt kołnierza dolnej ramki (B.710.Windshield.Frame (lower)), dopasowując ją do 

tego odchylenia (Rysunek 8.2.20b). Opcja Auxiliary Target w jego podstawowym modyfikatorze Shrinkwrap 

(fuselage) nie działa poprawnie dla projekcji pod kątem ostrym, które tu występują. Dlatego dodałem kolejny 

modyfikator Shrinkwrap, który wykorzystuje jako geometrię wejściową rezultat poprzedniego modyfikatora. Na-

zwałem go Shrinkwrap (glass) (Rysunek 8.2.21): 

 

Rysunek 8.2.21  Szczegóły nowego modyfikatora Shrinkwrap kołnierza ramki wiatrochronu 

Ten modyfikator jest ograniczony do grupy wierzchołków o nazwie Edge i używa domyślnego trybu Nearest 

Surface Point. Do grupy Edge należy tylko kilka wierzchołków, które chciałem wygiąć wzdłuż powierzchni wia-

trochronu (Rysunek 8.2.21). Użyłem tu pomocniczego, „nieprzyciętego” klona siatki jego oszklenia. Nazwałem 

ten obiekt X.700.Windshield i umieściłem w kolekcji 2e9.Auxiliary. Wykorzystamy go w przyszłości w innych 

modyfikatorach. Parametr Offset modyfikatora Shrinkwrap (glass) steruje intensywnością tej deformacji. 

 

Jeżeli chcesz, możesz pominąć modyfikację pokazywaną przez Rysunek 8.2.21. Służy do zamknię-

cia, małej szczeliny pomiędzy odchylonym poszyciem kadłuba i ramką wiatrochronu. Umieściłem ją 

tutaj jako przykład użycia grupy wierzchołków w modyfikatorach.          

a) b) 
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siatki oszklenia 
wiatrochronu 

Dodatkowy 
modyfikator 
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Zwróć uwagę, że narożniki ramki wiatrochronu wystaje za brzeg kokpitu. Te miejsca były zakryte małymi owiew-

kami, przynitowanymi do kadłuba. Porównując rysunki P-36 ze zdjęciami P-40 zauważyłem, że kształt tego 

detalu w tych samolotach jest różny. Rysunek 8.2.22 pokazuje, tworzenie tej owiewki (kształt wg zdjęć):  

     

     

     

Rysunek 8.2.22  Formowanie oprofilowania narożnika wiatrochronu    

 

a) b) 

c) d) 

e) f) 
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(0.032”) 

Zaokrąglij te 
krawędzie 

modyfikatorem 
Bevel (Weight)  

Gotowy 
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W tej sekcji stworzyliśmy wiele obiektów. Często nie podawałem ich nazw, by nie zaciemniać tekstu. Teraz 

zróbmy ich inwentaryzację. Rysunek 8.2.23 pokazuje po prawej stronie sugerowaną strukturę kolekcji dla tego 

zespołu. Stwórz w 2e.Cockpit kolekcje dla głównych podzespołów: 2e1.Windshield, 2e3.Canopy (na razie 

pusta i 2e4.Internal. Wewnątrz 2e1.Windshield stwórz dwie kolekcje dla obiektów specyficznych dla konkret-

nego wariantu (por. Rysunek 8.2.1a): jedną dla P-40-cu, drugą dla P-40B/C. Zdecydowałem się używać prefiksu 

A dla elementów z P-40-cu, i prefiksu C dla elementów z P-40B/C (stworzymy je w następnej sekcji).  

 

Rysunek 8.2.23  Zespół wiatrochronu i jego kolekcje 

Prefiksu B będę używać dla części wspólnych dla obydwu wariantów P-401. 

Rysunek 8.2.24a) pokazuje elementy podzespołu dolnej ramki wiatrochronu. Każda z tych nazw po numerze 

zawiera frazę Windshield.Frame, którą w większości etykiet poniżej zastąpiłem „…” – myślę, że w ten sposób 

ta ilustracja będzie bardziej czytelna: 

    

Rysunek 8.2.24  Elementy ramek wiatrochronu 

Podobnie, Rysunek 8.2.24b) wylicza składniki tylnej ramki wiatrochronu. Każdy z tych obiektów możesz znaleźć 

w oknie Outliner pokazywanym przez Rysunek 8.2.23. 

 
1 Wiem, że na początku książki mogłem wymyślić lepsze przedrostki nazw obiektów, np. neutralny prefiks 0 dla części wspólnych. 
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Podsumowanie 

• W tej sekcji odtworzyliśmy wiatrochron P-40-cu, opierając się na dokumentacji P-36 (str. 346). Założyłem, 

że ten zespół był identyczny w obydwu samolotach. Zauważyłem tylko niewielką różnicę w kształtach dol-

nych ramek (str. 355). 

• Zaczęliśmy od formowania pomocniczego obiektu: powierzchni odsuwanej osłony kabiny (str. 347). Sko-

piowaliśmy je przednią krawędź i przekształciliśmy w półcalowy pasek, który posłużył do stworzenia tylnej 

ramki wiatrochronu (str. 348). 

• Podstawowa powierzchnia wiatrochronu to obrócony cylinder połączony z dwoma płaskimi skrzydłami (str. 

347). Użyliśmy także nowej bryły do „przycięcia” krawędzi tego obiektu (oszklenia wiatrochronu – str. 348). 

• Dolna ramka wiatrochronu jest złożona z czterech oddzielnych obiektów (str. 348, 349, 353). Takie uprosz-

czenia pomija zaokrąglenia jej krawędzi wewnętrznych. Z drugiej strony, te zaokrąglenia byłyby ledwo wi-

doczne na jakimkolwiek renderze. Części tej ramki są oparte o relatywnie proste siatki. Użyliśmy modyfika-

torów Shrinkwrap, Solidify i Boolean aby przekształcić te paski w bardziej realistyczne bryły. Pomogło w 

tym ustawienie lokalnego układu współrzędnych wzdłuż cylindra owiewki (str. 349). 

• Podobnej metody użyliśmy do uformowania tylnej ramki wiatrochronu (str. 350, 351). Aby stworzyć jej 

szczyt, posłużyliśmy się kopiami odpowiednich pasków siatki (str. 352). 

• Przygotowując się do wielowariantowego modelu wiatrochronu (str. 346) uformowaliśmy panel wokół jego 

dolnej ramki jako oddzielny obiekt, skopiowany i wydzielony z siatki kadłuba (str. 354). Przygotowaliśmy 

także kolekcje dla każdego z tych wariantów (str. 357). Oznaczyliśmy elementy występujące wyłączenie w 

P-40-cu prefiksem „A” na początku nazwy. 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-12.02.blend. 
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8.3 Wiatrochron (późna wersja) 

W tej sekcji przygotujemy ramkę wiatrochronu dla P-40B/C. Ich otwór inspekcyjny do zamka nkm jest większy 

od podobnego otworu w P-40-cu (Rysunek 8.3.1, por. Rysunek 8.2.1a): 

       

Rysunek 8.3.1  Powiększony otwór inspekcyjny w P-40B/C Rysunek 8.3.2  Wstępne przybliżenie kształtu otworu 

Dokumentacja P-40B/C nie zachowała się, więc zaczniemy od przybliżenia kształtu tego otworu. Użyłem do 

tego prostej, łatwej do zmiany siatki, rzutowanej (Shrinkwrap) na powierzchnie kadłuba i szkła wiatrochronu 

(Rysunek 8.3.2). Starałem się dopasować wynikowy kształt do dostępnych zdjęć. 

Aby zrobić to dokładniej, zdecydowałem się dopasować mój model do archiwalnych zdjęć, tak jak to zrobiłem w 

sekcji 7.5 (por. str. 319). Jednak mój zespół kokpitu (wiatrochron, tylne okna, i brzegi wycięcia) nijak nie paso-

wały do tych obrazów, choć długo starałem się znaleźć tę właściwą projekcję! Wreszcie zamiast dopasowywa-

nia ujęć z bliska samej okolicy kabiny, zacząłem dopasowywać projekcję modelu do kilku zdjęć całego samolo-

tu. Gdy usterzenie, osłona silnika i skrzydła „trafiły” w swoje miejsca, odkryłem przyczynę niepowodzeń: błąd w 

założeniach! Osłona nkm i wiatrochron wczesnych wersji P-40 różnią się od tej z P-36. Rysunek 8.3.3 pokazuje 

te różnice na unikalnym zdjęciu stojących obok siebie, odrestaurowanych P-40C i P-36:  

 

Rysunek 8.3.3  Elementy ramek wiatrochronu 

Zwróć uwagę na różnicę położenia wręgi 3A: wiatrochron w P-40 był dłuższy i cofnięty w tył o około 1”. 

 

Gdy patrzysz na zdjęcie, nie jesteś neutralnym obserwatorem. Podświadomie szukasz na nim po-

twierdzenia swoich założeń. Dokładne dopasowywanie modelu do zdjęć jest metodą weryfikacji tych 

hipotez. W przeciwnym razie widziałbyś na tych obrazach to, w co aktualnie wierzysz.        
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Łagodna 
krawędź 
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W ujęciu „trzy czwarte” porównałem także ze zdjęciem kontur przegrody silnika (tzn. kształt z P-36) – pasował 

(Rysunek 8.3.4a). Jednak na tych zdjęciach okazało się, że zaokrąglone „narożniki” osłon zamków nkm w stacji 

2A (21 11/16) były nieco wyżej. Rysunek 8.3.4b) porównuje przekrój tej sekcji kadłuba w P-40 (linia czerwona) z 

analogicznym przekrojem z P-36 (linia czarna):  

     

Rysunek 8.3.4  Inny przekrój kadłuba w stacji 2A (P-40-cu)  

To „odkrycie” oznacza, że musimy poprawić ukończony w poprzedniej sekcji tego rozdziału wiatrochron 

P-40-cu, zanim zaczniemy modelować jego odmianę z dużymi otworami inspekcyjnymi.  

Wiatrochron składa się z wielu obiektów, więc zacznijmy od ostatniego z nich: przesuń tylną ramkę wzdłuż glo-

balnej osi Y o 1”, a resztę wiatrochronu – o 0.5”. Pozostaw bez zmian promień cylindrycznej części szkła (to 

kolejne założenie!) i obróć nieco jego płaskie boczne ściany, dopasowując je do tylnej ramki (Rysunek 8.3.5a):  

     

Rysunek 8.3.5  Pierwsze zmiany wiatrochronu P-40-cu 

W następnym kroku, zmień siatkę kadłuba: popraw jego przekroje w stacjach 2A (21 11/16) i 3A (39 3/4), jak po-

kazuje to Rysunek 8.3.5b).  

 

Bądź zawsze gotowy na takie niespodzianki: twórz możliwie najprostsze siatki, współdziel je pomię-

dzy podobnymi obiektami (klonami), i używaj w każdym obiekcie jak najwięcej modyfikatorów.    
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Oczywiście, te modyfikacje zmieniły kształt krawędzi przecięcia pomiędzy kadłubem i wiatrochronem. Dlatego w 

kolejnym kroki należy poprawić bryłę „przycinającą” krawędzie oszklenia (por. 349, Rysunek 8.2.8) tak, aby 

pasowała do jej nowego konturu (Rysunek 8.3.6a). 

       

Rysunek 8.3.6  Pierwsze zmiany wiatrochronu P-40-cu 

Po przesunięciu wiatrochronu musimy także stworzyć od nowa otaczający ją panel. Następnie dopasuj wszyst-

kie elementy dolnej ramki do tej zmienionej geometrii. Rysunek 8.3.6b) pokazuje jej szczegóły. Zwróć uwagę, że 

ten nowy kontur doskonale pasuje do rysunku Jumpei Temmy (to ja byłem w błędzie, on miał rację). Zauważ 

także, że w P-40 zmieniono kąt nachylenia szyby wiatrochronu do ~51º. Co ciekawe, kąt „szprych” ściągających 

ramki pozostał taki sam, jak w P-36: 52.5º. Nie są już równoległe do linii podziału szyby wiatrochronu. 

Korzystając ze zmapowanych zdjęć, poprawiłem kształt osłony narożnika wiatrochronu (Rysunek 8.3.7). To 

zdjęcie brytyjskiego wariantu P-40B/C, więc widać w nim także powiększony otwór inspekcyjny:  

       

Rysunek 8.3.7  Poprawiony kształt osłony narożnika Rysunek 8.3.8  Wstępne przybliżenie kształtu otworu 

Użyłem tego i kilku innych zdjęć do określenia kształtu tego otworu i otaczającego go z tyłu wybrzuszenia na 

dolnej ramce wiatrochronu (Rysunek 8.3.8), Dla tego przybliżenia użyj pomocniczego obiektu pokazanego 

przez Rysunek 8.3.2, i dodatkowego paska („ramki”), rzutowanego na szkło wiatrochronu. 

 

Gdybym nawet wcześniej znał prawidłowe położenie wiatrochronu w P-40, i tak zacząłbym od wy-

modelowania udokumentowanego wariantu (P-36). Dopiero potem bym go dopasował do zidentyfi-

kowanych wymiarów P-40. Łatwiej jest bowiem modyfikować gotowy, kompletny zespół niż domyślać 

się od początku, jaki właściwie miał kształt ten nieudokumentowany wariant.     
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Dopasowując te pomocnicze obiekty do zdjęć, użyłem m.in. ujęcia ze str. 346, Rysunek 8.2.1c). To obraz tego 

samego szczegółu, ale z innej strony. Takie „sprawdzanie krzyżowe” jest ważne w określaniu możliwie najbar-

dziej precyzyjnego przybliżenia.    

Gdy te pomocnicze kształty wydają się pasować do zdjęć, sklonuj oszklenie wiatrochronu (obiekt A.705.*, por. 

str. 357, Rysunek 8.2.23). Nazwij ten nowy obiekt C.705.Windshield.Glass i umieść w kolekcji dla późniejsze-

go wariantu: 2e1b.P-40B/C. To jest kolekcja dla wszystkich obiektów „C.” wiatrochronu (stworzyliśmy ją wcze-

śniej, na str. 357). W przypadku panelu wokół wiatrochronu (A.501.* → C.501.*) stwórz kopię, a nie klona, po-

nieważ będziemy modyfikować jego siatkę. 

Przygotuj dodatkowe obiekty tnące, jak pokazuje to Rysunek 8.3.9:  

       

Rysunek 8.3.9  Przygotowanie dodatkowych brył tnących Rysunek 8.3.10  Formowanie dolnej ramki 

Skopiuj wewnętrzną część dolnej ramki (A.711.* → C.711.*) i przekształć jej siatkę, układając ją wzdłuż pomoc-

niczego paska otaczającego otwór inspekcyjny (Rysunek 8.3.10). Skopiuj także bryłę przycinającą szkło wiatro-

chronu i zmodyfikuj jej dolne ściany, dopasowując je do nowej dolnej ramki (Rysunek 8.3.11): 

       

Rysunek 8.3.11  Przycinanie szyby wiatrochronu Rysunek 8.3.12  Formowanie kołnierza ramki 

Skopiuj kołnierz dolnej ramki (A.710.* → C.710.*). Aby uniknąć ręcznego formowania, zdecydowałem się wy-

ciąć jego środkową część za pomocą jednej z nowych brył tnących, i częściowo zasłonić ją nowym obiektem 

(C.726.*). Modyfikator Shrinkwrap „układa” pasek C.726.* tylko na powierzchni wiatrochronu (Rysunek 8.3.12). 
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Rysunek 8.3.13 pokazuje formowanie ostatniej części ramki wiatrochronu. Prościej jest wymodelować ten 

kształt „w siatce” niż go składać za pomocą modyfikatorów Shrinkwrap. Oczywiście, używam tu nadal innych 

typowych modyfikatorów, w szczególności Boolean (Difference), który przycina krawędź otworu inspekcyjnego:  

             

Rysunek 8.3.13  Formowanie zewnętrznej strony ramki wiatrochronu 

Gdy ramka jest gotowa, uformuj nową osłonę otworu. Zacznij od płaskiego obrysu, rzutowanego na płaszczyznę 

kadłuba za pomocą modyfikatora Shrinkwrap (Rysunek 8.3.14a):  

    

    

Rysunek 8.3.14  Formowanie osłony większego otworu inspekcyjnego 

Ponieważ tylna krawędź tej osłony wznosi się do ramki wiatrochronu wzdłuż krawędzi „wybrzuszenia”, użyłem 

tego modyfikatora Shrinkwrap jako narzędzia do szybkiego „położenia” tej siatki na kadłub. Potem „utrwaliłem” 

(Apply) ten efekt w siatce, i wprowadziłem poprawki w topologii przygotowujące ją do wygięcia wzdłuż tylnej 

ramki (Rysunek 8.3.14b). Rysunek 8.3.14c) pokazuje tę osłonę po wygięciu. Na koniec przytnij jej krawędzie za 

pomocą pomocniczej bryły U.501.Gun Door (Rysunek 8.3.14d).  

Początkowy kształt, 

uformowany z Plate  

Powierzchnia podziałowa 

dopasowana do ramki  

Dodaj modyfikator Solidify 

(Thickness: 0.15”)  

Przytnij tę krawędź 

modyfikatorem Boolean   

a) b) 

c) d) 

Wstępny, płaski 
kształt (z Plate) 

Zagęszczona siatka, rzutowana na 
powierzchnię kadłuba (X.500.Fuselage) 

Podnieś tę krawędź, dopasowując 
wynikową krzywą do ramki 

Przytnij krawędzie modyfika-
torem Boolean (Intersect) 
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Rysunek 8.3.15 pokazuje ostatni szczegół dolnej ramki wiatrochronu: nowe okucie końca „szprychy”. To kopia 

siatki A.713.* (por. str. 357, Rysunek 8.2.24a), o nazwie C.713.Windshield.Frame (rod). Popraw kąt pochyle-

nia jej cylindra i przekształć „skrzydełka”, dopasowują je do nowej ramki:  

       

Rysunek 8.3.15  Nowe okucie „szprychy” w dolnej ramce Rysunek 8.3.16  Gotowy wiatrochron P-40B/C 

Rysunek 8.3.16 pokazuje kompletny zespół wiatrochronu dla wariantu z dużym otworem inspekcyjnym. Szkło 

pancerne i inne wewnętrzne szczegóły dodamy później, w ostatniej fazie tego projektu. 

  

Podsumowanie 

• W trakcie pracy nad wariantem wiatrochronu z dużym otworem inspekcyjnym (str. 359) rozpoczęliśmy do-

pasowywanie naszego modelu do zdjęć. To zawsze weryfikuje różne poczynione założenia, często w za-

skakujący sposób. W tym przypadku znaleźliśmy nowe różnice pomiędzy P-36 i P-40 w geometrii wiatro-

chronu i kadłuba przed wiatrochronem (str. 359, 360). 

• Te nowe informacje zmusiły nas do powrotu do ukończonego w poprzedniej sekcji wariantu wiatrochronu z 

małym otworem inspekcyjnym (P-40-cu) i poprawienia jego kształtu. To oznaczało wprowadzenie różnych 

modyfikacji do różnych części tego zespołu (str.  360, 361). 

• Korzystając z uaktualnionego modelu, ustaliłem przybliżone kształty pokrywy dużego otworu i jego ramki. 

Użyłem do tego dwóch pomocniczych obiektów wzorcowych (str. 359, 361). W tym przypadku łatwiej było 

dopasowywać do zdjęć takie uproszone kształty zamiast bardziej złożone, końcowe części.   

• Dla każdego z wariantów wiatrochronu przygotowaliśmy oddzielną kolekcję (str. 357, 362). Sugeruję także 

odróżniać ich obiekty za pomocą innych prefiksów w nazwach („A” lub „C” zamiast „B”). 

• Model wiatrochronu z P-40B/C jest tworzony ze zmodyfikowanych kopii elementów wiatrochronu z P-40-cu, 

które przygotowaliśmy w poprzedniej sekcji (str. 362). Ponieważ zdecydowałem się podzielić ten zespół na 

dwa panele i osłonę otworu, przygotowałem dwie nowe bryły tnące (str. 362). Użyłem ich do wycięcia otwo-

ru w panelu kadłuba i otworu inspekcyjnego, oraz do przycięcia krawędzi jego osłony a także tylnej ramki 

(str. 363).  

• Zacząłem od modyfikacji dolnej ramki wiatrochronu (str. 362), potem oszklenia. Podzieliłem kołnierz dolnej 

ramki na trzy części (str. 362, 363), ponieważ każda z nich wymaga innych modyfikatorów. Gdy ramka była 

gotowa, stworzyłem siatkę osłony otworu inspekcyjnego (str. 363). 

 

Mógłbyś uformować jako całość panel wokół tego wiatrochronu wraz z osłoną otworu i tylną ramką. 

Jednak prowadzi to do złożonej topologii siatki. Lepiej jest odtworzyć taki przypadek z oddzielnych 

obiektów, podzielonych tak jak oryginalne panele. W przyszłości to ułatwi nam mapowanie tekstur.     

  

Dolna ramka (widok z fotela pilota) 

Dopasuj tę część siatki 
do zmodyfikowanej ramki   

“Wybrzuszenie” 
za otworem 

Popraw kąt pochyle-
nia tego cylindra  
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Abyś mógł przyjrzeć się bliżej metodom opisanym w tej sekcji, osadziłem w tym pliku kamery, których projekcja 

jest dopasowana do zdjęć (Rysunek 8.3.17)1: 

 

Rysunek 8.3.17  Formowanie osłony większego otworu inspekcyjnego 

Możesz się łatwo przełączać pomiędzy tymi projekcjami za pomocą dodatku Reference Cameras, który towa-

rzyszy tej książce. Zwróć uwagę, że niektóre ze zdjęć nie są idealnie dopasowane – w większości ujęć „¾” mia-

łem problemy z uzgodnieniem końcówek skrzydła. Dlatego użyłem wielu zdjęć by zmniejszyć zakres błędu tej 

metody. Te niezgodności mogą wynikać np. z tzw. „zniekształcenia beczkowatego” fotografii. Nawet korzystając 

z implementowanych przez ten dodatek ułatwień w zmianie długości ogniskowej, znalezienie projekcji odpowia-

dającej zdjęciu odbywa się metoda „prób i błędów”. Czasami pomaga przerwać te mozolne próby na parę dni, 

aby wrócić ze „świeżym spojrzeniem” na analizowany obraz. Mam nadzieję, że poprawię jeszcze trochę projek-

cje tych kamer przed końcową weryfikacją, zaplanowaną na koniec fazy modelowania.     

 

 
1 Dopasowując tę projekcję mogłem znaleźć przyczynę napięcia, widocznego na twarzy Roberta Smitha na zdjęciu powyżej. Wygląda na to, 

że reporter robiący to ujęcie stał wyprostowany na środku osłony silnika. Przypuszczam, że Robert Smith myślał w tym momencie coś w 

rodzaju „kiedy ten facet spadnie z tego okapotowania?”. Z tego miejsca, to były jakieś niebagatelne 3m do ziemi.  

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-12.03.blend. 

  

Panel Reference 
Cameras  

Zawartość kolekcji alter-
natywnego wiatrochronu 
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8.4 Owiewka kabiny 

Odsuwana do tyłu osłona kabiny P-40 ma szkielet typowy dla końca lat 30. XX w. (Rysunek 8.4.1): 

 

Rysunek 8.4.1  Odsuwania osłona kabiny w P-40 

Pomimo wyglądu, te ramki nie są wykonane z blachy. Są to elementy odlewane z duraluminium, tak samo jak 

ramki wiatrochronu. Są tylko od nich cieńsze, z uwagi na mniejszą grubość oszklenia tej osłony: 0.18”.  

Osłona kabiny P-40 wygląda podobnie do osłony z P-36. Ma identyczny przekrój poprzeczny, ale istnieją także 

różnice. Rysunek 8.4.2 pokazuje złożenie oryginalnych rysunków osłony kabiny P-36 i różnic w osłonie z P-40 

(te drugie oznaczyłem kolorem niebieskim):   

 

Rysunek 8.4.2  Poprawione kontury osłony P-40 

Po lewej stronie tej osłony kabiny znajduje się odchylane do góry wyjście awaryjne. Jego kontur w P-36 to zwy-

kły czworokąt, podczas gdy w P-40 ma bardziej złożony kształt (Rysunek 8.4.2).  

W szynach osłony P-40 Curtiss użył teownika (profilu o przekroju „T”) zamiast stosowanego w P-36 ceownika 

(profil „C”). To wymusiło podniesienie wózków osłony wraz z górną krawędzią ich oprofilowania. W rezultacie 

dolna krawędź ramki wyjścia awaryjnego znajduje się w P-40 o 0.6” wyżej niż w P-36. 

 

Podane w tej sekcji wymiary osłony P-40 są przybliżeniem, opartym o zdjęcia zmapowane metodą 

pokazaną w sekcji poprzedniej. Nie zachowała się żadna dokumentacja tych wczesnych wersji.      

  

Szyna osłony 
(teownik)    

Oprofilowanie 
wózków osłony    

Oryginalne rysunki P-36   Osłona P-40 
jest krótsza o 1”     

Linia brzegu kokpitu     

Ta ramka biegnie wzdłuż brzegu 
kokpitu i jest wyżej niż w P-36      

Different lower con-
tour of the emergen-

cy exit door        

Podniesiona górna krawędź oprofilo-
wania (równoległa do brzegu kokpitu)      

Dolna krawędź oprofilowania w P-36 
i w P-40 jest w tym samym miejscu     

Ta ramka jest pozioma     
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Zacznijmy od uformowania przedniej ramki osłony. Wyciągnij krawędź wzorcowego obiektu przygotowanego w 

sekcji 8.2 (X.750.Canopy) za linię podziału wiatrochronu i osłony oraz brzeg kokpitu. Następnie wydziel z tego 

pomocniczego obiektu pasek równoległy do tylnej krawędzi wiatrochronu, szeroki na 11/8” (Rysunek 8.4.3a)1.  

     

Rysunek 8.4.3  Formowanie przedniej ramki osłony 

Pogrub ten pasek (Solidify: Thickness: 0.32”, Offset: -0.6). Te parametry pozostawiają zewnętrzną stronę wyni-

kowej bryły ramki 0.064” ponad powierzchnią szkła osłony (Rysunek 8.4.3b) – jak w prawdziwym samolocie. 

Wydziel w ten sam sposób pasek tylnej ramki osłony (Rysunek 8.4.4a). W tym przypadku ustaw lokalny system 

współrzędnych tego obiektu równolegle do wręgi #5 (13.5º). To w przyszłości ułatwi przesuwanie wierzchołków 

wzdłuż ramki. Dodaj nowe ściany, by odtworzyć jej skomplikowany profil poprzeczny (Rysunek 8.4.4b):   

      

      

Rysunek 8.4.4  Formowanie tylnej ramki osłony 

Użyj modyfikatora Bevel (Weight) do zaokrąglenia narożników, i Solidify (Thickness: 0.064”) by uzyskać profil 

pokazywany przez Rysunek 8.4.4c). Dodaj jeszcze nowy obiekt Empty o nazwie X.750.Canopy.Base, wyrównaj 

go do brzegu kokpitu i uczyń „rodzicem” (Parent) tego zespołu (Rysunek 8.4.4d). Przyda się w animacjach.  

 
1 W tej sekcji będziemy używać X.750.Canopy w różnych modyfikatorach Shrinkwrap jako obiekt docelowy (Target). W ten sposób upew-

nimy się, że wszelkie „nałożone” elementy (ramki) zawsze będą pasować do tej bazowej powierzchni wiatrochronu. 

a) b) 
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Środkowa ramka tego szkieletu jest prostopadła do osi kadłuba. Można ją odtworzyć nakładając modyfikatorem 

Shrinkwrap płaski pasek na powierzchnię osłony (Rysunek 8.4.5a). Umieść końce tego paska 2.4” ponad brze-

giem kokpitu (Rysunek 8.4.5b):  

     

     

Rysunek 8.4.5  Formowanie górnej ramki osłony 

Wygląda na to, że szerokość tej ramki jest identyczna jak w P-36: 11/8”. W następnym kroku, stwórz górną ram-

kę osłony (Rysunek 8.4.5c). Założyłem, że jej szerokość jest identyczna. Wyjątkiem jest dużo szerszy segment, 

ciągnący się od przedniej krawędzi osłony do środka przedniej sekcji. To element specyficzny dla P-40. We-

wnątrz tego poszerzenia był uchwyt odrzucenia osłony (Rysunek 8.4.5d). Odtworzymy go później. 

Podobnie, możesz obrysować na globalnej płaszczyźnie YZ (tzn. w widoku z boku) kontury ramki bocznej, a 

potem rzutować ten kształt na powierzchnię osłony modyfikatorem Shrinkwrap (Rysunek 8.4.6): 

     

Rysunek 8.4.6  Formowanie bocznej ramki osłony 
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Pogrub (Solidify) siatki górnej i dolnej ramki (grubość: 0.32”, Offset: -0.6, por. Rysunek 8.4.3b). Potem wstaw 

trójkąty w narożniki tych ramek. Stwórz je jako oddzielne ściany, ale w tej samej siatce (Rysunek 8.4.7a):  

    

Rysunek 8.4.7  Wstawianie trójkątów w narożniki ramek 

Dopasuj pionowe położenia tych trójkątów do krawędzi ramek. W rezultacie połączenia efektów modyfikatorów 

Shrinkwrap i Solidify, oryginalne ściany tych trójkątów na płaszczyźnie YZ są przesunięte w górę w stosunku do 

ścian poziomego paska (Rysunek 8.4.7b). 

Sklonuj obiekt X.750.Canopy w oszklenie osłony (B.750.Canopy.Glass). Pogrub ten obiekt (0.18”). Narysuj w 

widoku z boku jego kontur (Rysunek 8.4.8a). Pogrub tę ścianę (32”, Offset: 0), tworząc pomocniczą bryłę tnącą. 

Użyj jej do przycięcia modyfikatorem Boolean (Intersect) krawędzi szkła osłony (Rysunek 8.4.8b):  

    

    

Rysunek 8.4.8  Przycinanie brzegów oszklenia i wycinanie szczelin na ramki  

Stwórz dodatkowe płaszczyzny tnące, potem dodaj im modyfikatory Mirror i Solidify (grubość: 0.4”). Użyj ich w 

modyfikatorach Boolean (Difference) do wycięcia szczelin wzdłuż wewnętrznych ramek osłony (Rysunek 

8.4.8c). Potem użyj tego przyciętego szkła do wycięcia rowków w ramkach osłony (Rysunek 8.4.8d). 
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c) d) 
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Stwórzmy szyny tej osłony (Rysunek 8.4.9). Były wykonane z teownika, który biegł wzdłuż brzegu kokpitu, a 

następnie łagodnie wyginał się w dół do pierwszej podłużnicy pod oszkleniem za kabiną pilota (Rysunek 

8.4.9b). Aby uniknąć ręcznego dopasowywania podstawy tej szyny do powierzchni kadłuba, zdefiniuj wierzchoł-

ki tej części siatki jako grupę o nazwie Base. Użyj tej grupy do ograniczenia zakresu działania modyfikatora 

Shrinkwrap, który rzutuje siatkę tego obiektu na powierzchnie kadłuba (Rysunek 8.4.9a):  

     

Rysunek 8.4.9  Formowanie szyny osłony kabiny  

Uformuj potem „pionową” część tego teownika (tutaj jest prostopadła do kadłuba). Stwórz ją jako oddzielny „pa-

sek” ścian siatki, nie połączony z rzutowana na kadłub grupą Base (to uprości modelowanie). Pogrub (Solidify: 

0.125”) ten obiekt, a potem wykonaj lustrzane odbicie (Mirror) po prawej stronie samolotu. 

Oprofilowanie wózków osłony zacznij od płaskiej ściany, równoległej do ramek i szkła (Rysunek 8.4.10a):  

         

     

Rysunek 8.4.10  Formowanie oprofilowania wózków osłony kabiny  

Pogrub tę ścianę (na „grubość blachy”: 0.032”). W tym przypadku nie potrzebujemy wygładzenia (Subdivision 

Surface). Zaokrąglij modyfikatorem Bevel (Weight) trzy wewnętrzne krawędzie (Rysunek 8.4.10b). Potem wstaw 

kolejne trzy krawędzie i też je zaokrąglij, tworząc „rowek” wzdłuż szyny osłony (Rysunek 8.4.10c). 

Stwórz kolejną bryłę tnącą (Rysunek 8.4.10d) aby przyciąć tylną krawędź tej osłony (Rysunek 8.4.10e). 
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Po lewej stronie osłony kabiny P-36 i P-40 znajdowało się wyjście awaryjne. Zacznijmy od stworzenia bryły do 

wycięcia jego krawędzi. Były one prostopadłe do powierzchni oszklenia, więc narysuj jego kontur na powierzch-

ni równoległej do boku osłony (Rysunek 8.4.11a). Dodaj modyfikator Subdivison i „połóż” wynikową powierzch-

nię na osłonie modyfikatorem Shrinkwrap. Dodaj także modyfikator Solidify (Thickness: 2”).  

   

   

   

Rysunek 8.4.11  Formowanie oprofilowania wózków osłony kabiny  

Użyj tej pomocniczej bryły do wycięcia otworu na to wyjście we wszystkich ramkach osłony. Rysunek 8.4.11b) 

pokazuje przycięcie górnej ramki kolejnym modyfikatorem Boolean. Zrób to samo w pozostałych ramkach. Sko-

piuj obiekt ramki bocznej i usuń jego modyfikator Mirror (Rysunek 8.4.11c). Dodaj do tej siatki pionowe paski 

(Rysunek 8.4.11d) i trójkąty w narożnikach (Rysunek 8.4.11e). Na koniec, stwórz zawias: zwykły cienki cylinder 

o promieniu 0.08” (Rysunek 8.4.11f). Nie dziel oszklenia, bo nie będziemy tego wyjścia animować.     

a) b) 

c) d) 

e) f) 

lokalne Z 

lokalne Y 

Rzutowanie 
(Shrinkwrap) 

 

Solidify (2”) 
 

Bryła tnąca 

Bryła 
tnąca 

Górna krawędź 
bryły tnącej 

biegnie wzdłuż 
tej ramki 

Przycięta 
górna ramka 

Przytnij inne 
ramki w ten 
sam sposób  

Przycinanie 
górnej ramki 

Skopiuj ramkę 
boczną i usuń 
z niej m. Mirror   

0.75 0.80 

On Cage: włączone 

0.6 

Stwórz 
pionowe 

paski 

11/8 

0.7 

Ten trójkąt jest tylko po 
lewej stronie osłony 

Zamknięty cylinder 
(zawias wyjścia) 

Wstępna siatka ramki wyjścia awaryjnego 

On Cage: włączone 
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Rysunek 8.4.12 pokazuje gotową osłonę kabiny (wariant dla P-40B/C) 

 

Rysunek 8.4.12  Gotowa osłona kabiny  

Oczywiście, jest w niej do dodania jeszcze wiele szczegółów. Wykonamy je na ostatnim etapie tego projektu. 

 

Podsumowanie 

• W tej sekcji często używaliśmy modyfikator Shrinkwrap (str. 368-370). To pozwoliło nam „rysować” ramki 

osłony w rzucie z góry (str. ) lub z boku, a potem rzutować wynikowe ściany na powierzchnię oszklenia 

osłony. 

• Osłona kabiny z P-40 różni się w wielu szczegółach od osłony z P-36 (str. 366). Jedynym materiałem refe-

rencyjnym do identyfikacji tych różnic są zdjęcia.  

• W tej sekcji użyliśmy pomocniczego obiektu (X.750.Canopy), który odpowiada zewnętrznej powierzchni 

oszklenia osłony. Sklonowaliśmy tę siatkę by stworzyć to oszklenie (str. 369). Używaliśmy także siatki 

X.750.Canopy jako źródła „pasków” ścian, z których potem tworzyliśmy tylną i przednią ramkę (str. ). Była 

także powierzchnią docelową dla modyfikatorów Shrinkwrap ramki górnej, bocznej i wyjścia awaryjnego. 

Wszystkie ramki osłony oprócz tylnej zostały stworzone jako proste paski ścian, z włączonym odbiciem lu-

strzanym (Mirror) i wygładzone modyfikatorami Subdivision Surface. Te paski zostały pogrubione modyfika-

torami Solidify do 0.32”.  

• Użyliśmy przyciętego obiektu oszklenia do wycięcia „rowków” w ramkach osłony (str. 369). 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-12.04.blend. 
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Rozdział 9. Pozostałe elementy samolotu 

W tym rozdziale zajmiemy się ważnymi szczegółami, których stworzenie wymaga znacznej ilości pracy: osło-

nom podwozia głównego, oprofilowania krawędzi: skrzydło/kadłub, usterzenie/kadłub.  
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9.1 Osłony podwozia głównego 

Rysunek 9.1.1 przedstawia osłony podwozia głównego P-40. Jest to element specyficzny dla linii rozwojowej P-

36/P-40, i nie występuje chyba w żadnym innym myśliwcu z okresu II wojny światowej1.  

   

Rysunek 9.1.1 Osłony goleni podwozia głównego P-40 

To uproszczona wersja bardziej złożonej owiewki z P-36. Rysunek 9.1.1 pokazuje, że jej bryła składa się z czę-

ści o kształcie kroplowym i bocznej, podłużnej „przybudówki”. Zachowała się część dokumentacji tej owiewki z 

późniejszych wersji P-40 oraz z P-362. Kształt kołnierzy wokół otworu koła, w miejscu pokazanym przez Rysu-

nek 9.1.1a), różni się we „wczesnych” i „późnych” P-40. Na zdjęciach tych pierwszych, narożnik panelu osłony 

ostry – taki sam, jak w P-36. W późniejszych wersjach został skrócony. Nie zachowały się rysunki przekrojów 

osłony z P-40. Na rysunkach ich wręg brakuje niektórych kluczowych wymiarów. Zachowało się tylko zestawie-

nie przekrojów poprzecznych osłon P-36 (rys. 75-34-030), ale nie ma na nim żadnej tabeli współrzędnych. Mo-

żemy tylko szacować (korzystając ze zdjęć), na ile ta geometria osłon P-36 różni się od osłon P-40. Założyłem, 

że w P-40 Curtiss usunął pokrywę koła głównego i uprościł dwie pozostałe, ale poza tym zachował ogólną geo-

metrię tej owiewki (tj. że jej przekroje poprzeczne z P-36 będą pasować do P-40).  

 
1 Coś takiego na pewno pogarszało osiągi samolotu. Myślę, że te "gondole" zmniejszały prędkość maksymalną o jakieś 10-20 km/h. Skąd 

takie rozwiązanie? Mam na ten temat własne przypuszczenia. Pojawiło się w czasach, gdy takie "wybrzuszenia" nie były niczym niezwy-

kłym: pod koniec 1934 r. Opracowywano wówczas prototyp samolotu Hawk 75, który miał w przyszłości być produkowany seryjnie jako P-

36. Była to pierwsza prawdziwa konstrukcja półskorupowa budowana przez firmę Curtiss. Specjalnie do tego projektu został "podkupiony" z 

firmy Northrop (która była pionierem takich rozwiązań) inżynier prowadzący (Donovan Berlin). Patrząc na koncepcję struktury P-36/P-40, 

można dostrzec założenie "jak najmniej otworów w płacie". Dotyczyło to szczególnie przedniej części skrzydła (do drugiego dźwigara), która 

w zamyśle konstruktorów tworzyła profil zamknięty, przenoszący większość obciążeń. Otwór na koło podwozia głównego został umieszczo-

ny poza tym obszarem. Zgodnie z tą koncepcją, to nie skrzydło zostało wycięte wokół kadłuba (jak w większości późniejszych konstrukcji), 

tylko kadłub wokół skrzydła. Sądzę, że był to przejaw ostrożności projektantów: każdy otwór w strukturze, której powłoka przenosi główne 

obciążenia, to jej poważne osłabienie. Inżynierowie Curtissa nie wiedzieli wtedy jeszcze, na jakie otwory może sobie w konstrukcji półskoru-

powej pozwolić.  

Skoro nie wycięto płata "pod kadłub", tym bardziej nie wykonano w nim wgłębienia na goleń podwozia. To byłby karb w głównym dźwigarze, 

znacznie osłabiający konstrukcję! Pozostało poprowadzić złożoną goleń równolegle do dolnej powierzchni płata i nieco ją oprofilować. Jak 

pomyślano, tak zrobiono. Wykonano oprzyrządowanie, samolot zapuszczono "w serię", a dwa lata później dodano mu silnik rzędowy, zmie-

niając w P-40. I tak już zostało – do końca historii konstrukcji. Eliminacja tych owiewek oznaczałaby zbyt poważną zmianę konstrukcyjną, a 

produkcja wojenna wymagała "masówki" (szczególnie w latach 1940-43), a nie wymuskanych projektów... 

2 P-40 (warianty D…N): 87-34-501, 87-34-504, 87-34-505, 87-34-506, 87-34-524, 87-34-525, 87-34-534, 87-34-912, P_36: rysunek złoże-

niowy: 75-34-001, geometria: 75-34-030. 

a) b) 

Część 
“kroplowa”  

Część 
podłużna 

Pokrywa 
boczna 

Główna 
pokrywa 

Część 
“kroplowa”  

 

Część 
podłużna 

 

Kształty tego obszaru różnią się pomiędzy 
“długonosymi” P-40 (wczesne wersje) i 
„krótkonosymi” P-40 (pozostałe). W tym 
odrestaurowanym P-40B przypominają 

oryginał, choć jeszcze nieznacznie odbie-
gają od wyglądu z historycznych zdjęć. 

https://app.aircorpslibrary.com/drawing/viewer/75-34-030/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-501/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-504/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-505/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-506/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-524/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-525/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-534/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-912/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-34-001/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-34-030/p-40
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Starałem się złożyć z tych rysunków i archiwalnych zdjęć prawdopodobną geometrię osłony1. Rysunek 9.1.2a) 

pokazuje rezultat: scenę z trójwymiarowym wzorcem (szczegóły – str. 620). Kontury tego wzorca w rzucie z 

boku są zgodne z planami J. Temmy, a w rzucie z dołu występują tylko niewielkie różnice. Za to poważne od-

chylenia pomiędzy moją wersją osłony i rysunkami J. Temmy występują w rzucie z przodu (Rysunek 9.1.2b):   

     

Rysunek 9.1.2 Mój wzorzec 3D osłony i porównanie różnic z planami Jumpei Temmy    

Może Jumpei Temma założył, że pionowa oś tej osłony leży na osi goleni podwozia? Popełniłem ten sam błąd w 

moim poprzednim modelu P-40. Dopiero później znalazłem rysunki 87-34-501 i 87-34-506, na których widać, że 

oś osłony jest odsunięta do środka o 1 3/8”. Co więcej, kształt tej „kroplowej” bryły nie był symetryczny! 

Sam zdecyduj, według której wersji wymodelujesz tę 

osłonę. Nie twierdzę, że rysunek Temmy jest błędny, 

gdyż, jak widziałeś w poprzednich sekcjach, zdarza mi 

się mylić. W materiałach towarzyszących tej książce, 

w pliku source\reference\drawings\temma\Nacelles.png 

znajdziesz jego widok z boku owiewki podwozia. Jest 

dopasowany do tej samej standardowej ramki co inne 

widoki z boku tego autora. Dzięki temu możesz sko-

piować jego rzut z boku (R.Side.Left (Temma) – por. 

str. 90) i podmienić w nim obraz na owiewkę. Nazwij 

ten nowy obiekt R.Nacelles (Temma).   

Rysunek 9.1.3 pokazuje, jak go umieścić. Osobiście 

jednak sugeruję użyć w tej sekcji mojego wzorca 3D. 

Na końcu tego rozdziału i tak zweryfikujemy ten kształt w inny sposób, i wprowadzimy ewentualne poprawki. 

 
1 Porównywałem kontury osłony z P-40D do geometrii z P-36 (rys. 75-34-030). Wydaje się, że mają taki sam kształt do stacji 7V (por. rys. 

87-34-501). Za tą stacją główna bryła osłony P-40 nadal przypomina poprzednika, ale jest nieco szersza, by zapewnić prostą krawędź 

wzdłuż zawiasu taśmowego głównej pokrywy podwozia. W P-40-cu/B/C tylna część cylindrycznej „przybudówki” osłony (por. Rysunek 

9.1.1a) wydaje się identyczna jak w P-36, podczas gdy w P-40D jej kształt uległ modyfikacji. 

 

Rysunek 9.1.3 Rysunek referencyjny osłony z P-40 

 

 

Przy modelowaniu tak złożonego kształtu jak ta osłona, trójwymiarowy wzorzec jest bardziej uży-

teczny. Na przykład – jest w nim wiele konturów, których brakuje w rysunkach J. Temmy.          
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a) b) 
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wy głównej  

Przeciwległa 
krawędź po-

krywy głównej 
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pokrywy 
bocznej 

Wręga 

https://app.aircorpslibrary.com/drawing/viewer/87-34-501/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-506/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-34-030/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-34-501/p-40
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Na początku przygotuj pomocnicze kontury z dołu i z boku (Rysunek 9.1.4a). Wygładź je modyfikatorem 

Subdivision Surface. Uzgodnij położenie wierzchołków ich siatek wzdłuż tych dwóch krzywych, określając w ten 

sposób położenie kolejnych linii krawędzi „wręg” w siatce osłony. Zacznij formowanie obiektu osłony 

(B.160.L.Nacelle) od 16-boku (Circle) wygładzonego modyfikatorem Subdivision (Rysunek 9.1.4b). Wyciągaj z 

tego wstępnego konturu kolejne segmenty. Dopasowuj je do wzorcowych przekrojów (są asymetryczne):  

   

   

   

Rysunek 9.1.4 Modelowanie głównej bryły osłony podwozia    

Uformuj w ten sposób wstępny kształt tej osłony, a potem wstaw w środek jej siatki kolejne linie krawędzi. 

Umieść je w miejscach oznaczonych na konturach pomocniczych (Rysunek 9.1.4c). Dopasuj tę siatkę do wzor-

cowych konturów z boku i z dołu poprzez przesuwanie i skalowanie jej sekcji (Rysunek 9.1.4d). Usuń niepo-

trzebne ściany osłony, które znalazłyby się wewnątrz skrzydła (Rysunek 9.1.4e) i dopasuj wynikową powierzch-

nię do wzorcowych przekrojów poprzecznych (Rysunek 9.1.4f).  

a) b) 

c) d) 

e) f) 
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ściany  
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skrzydła 
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Kontur 
wzorcowy  

Zawias 
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Rozdział 9 Pozostałe elementy samolotu 377 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Rozpocznij formowanie bocznej bryły tej osłony od utworzonego jako nowy obiekt czworokąta (Plane). Potem 

wyciągnij jego ściany wzdłuż części kroplowej (Rysunek 9.1.5a). Dodaj modyfikator Subdivision Surface i dopa-

suj ten „pasek” do wzorcowych konturów przekrojów poprzecznych (Rysunek 9.1.5b):  

   

   

         

Rysunek 9.1.5 Modelowanie bocznej bryły osłony podwozia   

Jednocześnie popraw w tej nowej siatce położenia linii krawędzi „wręg”, aby pasowały do podobnych linii kra-

wędzi w części „kroplowej”. Aby osiągnąć ten efekt, czasami trzeba wstawić dodatkowe krawędzie. Udało mi się 

dopasować do konturów wzorcowych siatkę z krawędziami dopasowanymi do krawędzi części „kroplowej” bez 

konieczności wstawiania dodatkowych linii krawędzi. Potem możesz wyciągnąć ściany boczne (Rysunek 

9.1.5c). Upewnij się, że cały zawias pokrywy bocznej (jest na szkielecie 3D) leży na ich płaszczyźnie.  

Użyj dodatku Intersect aby wyznaczyć dwie oddzielne krawędzie przecięcia: pomiędzy tym obiektem i skrzy-

dłem, oraz pomiędzy tym obiektem i kroplową częścią osłony (Rysunek 9.1.5d). Scal linie krawędzi z resztą 

siatki, aby stały się jej brzegami. Scal ten obiekt z częścią kroplową (B.160.L.Nacelle), Usuń niektóre ściany 

boczne (Rysunek 9.1.5e), i stwórz nowe, łączące te dwie bryły w całość (Rysunek 9.1.5f,g). 

a) b) 

c) d) 

e) f) g) 
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Stwórz 
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Wyciągnij nowy rząd ścian z zewnętrznych krawędzi osłony (Rysunek 9.1.6a). Przekształcimy je w zaokrąglone 

oprofilowanie za pomocą modyfikatora Bevel.  

     

Rysunek 9.1.6 Formowanie „kołnierzy” wokół brzegów osłony    

Na początek, oznacz wewnętrzną i zewnętrzną krawędź tego paska jako ostrą (Crease = 1) i dopasuj do po-

wierzchni skrzydła. Aby dopasować je do krawędzi natarcia, trzeba dodać nowe krawędzie (Rysunek 9.1.6b). 

Sfazuj kontury tej osłony modyfikatorem Bevel (Weight), różnicując wagi Bevel Weight na kolejnych krawę-

dziach siatki. Aby lepiej widzieć wynikową szerokość fazek, tymczasowo ustaw w tym modyfikatorze Segements 

na 1 i wyłącz widoczność w Edit Mode efektów pozostałych modyfikatorów (Rysunek 9.1.7):  

 

Rysunek 9.1.7 Wykorzystanie modyfikatora Bevel do zaokrąglenia krawędzi osłony 

Nie zapomnij wyzerować współczynniki Crease wszystkich krawędzi, których Bevel Weight jest > 0.  

Na szczęście, w tej osłonie nie ma znacznych zmian promienia zaokrąglenia, więc mogliśmy użyć do tego 

współczynników Bevel Weight. Alternatywnie, musielibyśmy wymodelować te zaokrąglenia w siatce, wstawiając 

nowe krawędzie. Nie polecam takiej metody, gdyż bardzo komplikuje topologię siatki.  

 

Wartości Bevel Weight nie sterują w pełni wynikową szerokością fazek. Zazwyczaj musisz je zwięk-

szyć/zmniejszyć dwukrotnie na trzech kolejnych krawędziach by uzyskać widoczną zmianę.         
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Po ustawieniu wzdłuż fazek odpowiednich Bevel Wights, zwiększ liczbę segmentów w modyfikatorze Bevel 

do 4. Włącz opcję Edit Mode w innych modyfikatorach, aby uzyskać rezultat pokazywany przez Rysunek 9.1.8: 

 

Rysunek 9.1.8 Ostatnie szczegóły kształtu osłony 

Aby uzyskać „czyste” zaokrąglenia, zachowaj granice fazek w odległości ok. 1” od kolejnych krawędzi ścian.   

Dopasowując osłonę do wzorca, wyciągnąłem dodatkowy fragment jej powierzchni przy otworze na koło.  

Teraz przytnij tylne brzegi tej osłony wokół krawędzi otworu na koło podwozia. Użyj do tego tej samej bryły 

(U.100.L.Wheel), której użyliśmy w sekcji 5.7, i modyfikatora Boolean (Difference) (Rysunek 9.1.9): 

      

Rysunek 9.1.9 Przycinanie tylnej krawędzi osłony wzdłuż otworu na koło 

Rysunek 9.1.9b) pokazuje osłonę o kształcie przypominającym oryginał. Brakuje w niej jeszcze szczegółów. 

Ponieważ tę geometrię ustalałem w oparciu o różne założenia, na razie chciałbym utrzymać siatkę tej osłony w 

jak najprostszym stanie. Może się zdarzyć, że po szczegółowym dopasowaniu mojego modelu do archiwalnych 

zdjęć (metoda opisaną przez Rozdział 14) będę musiał zmieniać jej kształt. Dlatego w tym rozdziale nie będę 

odtwarzać wewnętrznych wręg tej osłony, choć są widoczne z zewnątrz, szczególnie przy otwartych pokrywach 

podwozia. Z tego samego powodu zdecydowałem się tylko zaznaczyć kontury tych pokryw wykorzystując dwa 

proste bryły tnące: jedną dla pokrywy głównej i drugą dla pokrywy bocznej. Dodałem do nich modyfikatory 

Solidify. Generowana przez nie grubość odpowiada za szerokość szczeliny pomiędzy pokrywą a resztą stałą 

częścią osłony. Później odtworzymy te pokrywy jako oddzielne obiekty, obracane wokół zawiasów.    

Dopasuj ze-
wnętrzne brzegi 

do konturów 
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Krawędź zao-
krąglona mody-
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wszystkich modyfikatorach 

Pomocnicza bryła 
tnąca otworu koła 
(U.100.L.Wheel) 

Boolean 
(Difference) 

a) b) 
Przycięty 

tylny brzeg 
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Rysunek 9.1.10 podaje zewnętrzne wymiary tych dwóch brył tnących (skopiowałem je z dokumentacji P-40): 

      

Rysunek 9.1.10 Wycinanie konturów pokryw goleni podwozia  

Rysunek 9.1.11 pokazuje osłony z zaznaczonymi konturami odchylanych pokryw podwozia. W tej postaci jest 

gotowa do ewentualnego porównania ze zdjęciami: 

 

Rysunek 9.1.11 Osłony podwozia, przygotowane do porównania ze zdjęciami 

Wszystkie obiekty stworzone w tej sekcji przypisz (relacją Parent) do bazy skrzydła (X.100.L.Wing.Base). 

Umieść je w subkolekcjach 3.Wing, pokazanych na ilustracji powyżej. 
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-1.81 

Bryła tnąca bocz-
nej pokrywy 

Solidify 
(0.1”) 

„Lustrzane 
odbicie” osłony   
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Podsumowanie 

• W tej sekcji użyliśmy wzorcowego „szkieletu” 3D, który przygotowałem wcześniej, w oparciu o dostępne 

rysunki (str. 374-375). Przekroje poprzeczne jego osłon podwozia różnią się od rysunku Jumpei Temmy 

(str. 375). 

• Dokumentacja P-40 dostarcza tylko kilka kluczowych wymiarów osłon goleni podwozia. Nie ma w niej żad-

nych tabel współrzędnych z geometrią tego kształtu, więc i moje kontury, i kontury Temmy są oparte na 

różnych domysłach i założeniach (str. 374, 375). 

• Rozpoczęliśmy tworzyć te osłony od uformowania ich pomocniczych, gładkich konturów w rzutach z boku i 

z dołu (str. 375). Dopasowując położenie ich poszczególnych wierzchołków, określiliśmy położenie kolej-

nych linii krawędzi w docelowej siatce osłony. Następnie uformowaliśmy asymetryczną, „kroplową” część 

osłony. Zaczęliśmy od 16-boku (Circle), wygładzonego modyfikatorem Subdivision Surface.  

• Bryłę boczną tej osłony uformowaliśmy jako odrębny obiekt, wyciągając krawędź z początkowej płytki (str. 

377). Potem połączyliśmy ten obiekt z siatką części „kroplowej”. 

• Uformowaliśmy zewnętrzne oprofilowania tej osłony wyciągając dodatkowy „pasek” ścian z jej zewnętrz-

nych krawędzi (str. 378). Potem dopasowaliśmy te zewnętrzne ściany do powierzchni skrzydła. 

• Zaokrąglenia krawędzi stworzyliśmy modyfikatorem Bevel (Weight), nadając kolejnym krawędziom różne 

współczynniki Bevel Weight (str. 378-379).  

• Użyliśmy bryły tnącej otworu koła w skrzydle do przycięcia tylnego brzegu osłony (str. 379). Dodatkowe 

bryły tnące, pogrubione modyfikatorami Solid, tworzą kontury odchylanych pokryw podwozia (str. 380). To 

tymczasowe rozwiązanie, aby przed ostatecznym (dokładnym) porównaniem ze zdjęciami, zachować siat-

kę tej osłony tak prostą, jak tylko możliwe. Może się bowiem zdarzyć, że w wyniku tego porównania będzie 

trzeba coś w niej poprawić. 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-13.01.blend. 
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9.2 Oprofilowania połączenia kadłuba i usterzenia  

Oprofilowanie wokół krawędzi połączenia stateczników i kadłuba było identyczne w P-36 i w „krótszych” warian-

tach P-401. Rysunek 9.2.1 pokazuje je na archiwalnym zdjęciu P-40-cu: 

     

Rysunek 9.2.1 Szczegóły oprofilowania usterzenia 

Oprofilowanie składało się z panelu górnego i dolnego, rozdzielonych w płaszczyźnie statecznika poziomego. 

Te panele były wykonane z blachy Alcald (grubość: 0.032”) i przymocowane do kadłuba i stateczników śrubami. 

Górny panel jest niesymetryczny z powodu odchylenia statecznika pionowego (o 1.5º od płaszczyzny symetrii 

samolotu – por. str. 259). Była to także osłona okuć, mocujących stateczniki (por. str. 235). 

Nie znalazłem współrzędnych tego oprofilowania. Zachowana dokumentacja (Rysunek 9.2.2)2 podaje dokładne 

położenie śrub, ale brakuje w niej takich wymiarów, jak promienie zaokrąglenia przekrojów poprzecznych:  

 

Rysunek 9.2.2 Dostępna dokumentacja 

Co więcej, kontury tego podzespołu w pewnych miejscach różnią się od konturów z archiwalnych zdjęć. Dlatego 

sugeruję tu korzystać z rysunków Jumpei Temmy, które są oparte o zdjęcia. 

 
1 W trakcie produkcji P-40F Curtiss wydłużył ogon samolotu, dołączając do niego nowy segment o długości 20”. Oczekiwano, że taki dłuż-

szy ogon poprawi jego stabilność kierunkową. Ta modyfikacja była stosowana we wszystkich późniejszych wariantach P-40. 

2 Rysunki osłony: dla P-36: 75-15-010, dla P-40: 87-15-010 
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górny    
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malowana barwą Olive Drab 

Oryginalny P-40-cu Odrestaurowany P-40B 

Zdjęcie: David Spurgeon-Jackson Zdjęcie: NASM 

Oprofilowanie 
usterzenia   

(87-15-010) 
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statecznik 
pionowy    

Widok 
z góry 

Widok 
z boku 

Czy tu 
były łuki?    

https://airplanes3d.wordpress.com/2019/12/19/a-new-finding-about-the-long-tail-p-40s/
https://app.aircorpslibrary.com/drawing/viewer/75-15-010/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-15-010/p-40
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Formowanie tej osłony rozpocznij od skopiowania i wydzielenia trapezowych części statecznika poziomego i 

pionowego (Rysunek 9.2.3):  

     

Rysunek 9.2.3 Kopiowanie powierzchni stateczników 

Usuń z tych nowych obiektów wszystkie niepotrzebne modyfikatory. W kopii statecznika poziomego „utrwal” 

(Apply) modyfikator Mirror (Rysunek 9.2.3a) oraz obrót o 2º. Ustaw kopię statecznika pionowego w płaszczyzny 

symetrii samolotu (obróć ją o 1.5º – Rysunek 9.2.3b). To tymczasowa modyfikacja. Na razie będzie nam o wiele 

łatwiej uformować symetryczna połówkę tej osłony. „Wykrzywimy” ją na samym końcu pracy.    

Przesuń (Slide) zewnętrzne krawędzie obydwu skopiowanych siatek bliżej kadłuba (Rysunek 9.2.4a), a potem 

użyj dodatku Intersect do wyznaczenia ich krawędzi przecięcia (Rysunek 9.2.4b): 

    

    

Rysunek 9.2.4 Formowanie podstawowych powierzchni 

Połącz te dwa obiekty w jedną siatkę (Rysunek 9.2.4c), o nazwie B.370.Fairing. Przypisz ją (relacją Parent) do 

obiektu X.000.Base, i umieść w kolekcji 4.Empennage. Wyciągnij tylną część dolnej powierzchni i dopasuj ze-

wnętrzne krawędzie oprofilowania do bocznych i pionowych rzutów z rysunków J. Temmy (Rysunek 9.2.4d). 
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Podobnie, przesuń (Slide) zewnętrzne krawędzie statecznika pionowego (Rysunek 9.2.4d) i poziomego 

(Rysunek 9.2.5), dopasowując je do konturów z rysunku referencyjnego:  

     

Rysunek 9.2.5 Dopasowanie konturów w widokach z góry i z dołu 

Aby uniknąć ewentualnych błędów w zaznaczaniu wierzchołków, przed dopasowaniem górnych konturów ukryj 

( H ) dolną część tej siatki (Rysunek 9.2.5a), a potem na odwrót przy dopasowywaniu dołu (Rysunek 9.2.5b). 

Stwórz ściany pomiędzy krawędziami przecięcia z kadłubem, a potem wstaw w ich środek nową krawędź, two-

rząc pierwsze przybliżenie przedniej części oprofilowania (Rysunek 9.2.6):  

 

Rysunek 9.2.6 Tworzenie wstępnych zaokrągleń 

Umieść pod najwyższym modyfikatorem Mirror modyfikator Bevel (Weight) (por. Rysunek 9.2.6). Ustaw w nim 

Width Type = Width, Amount = 7.1, Segments = 4. Wyzeruj współczynniki Crease na dwóch krawędziach na-

rożników za luką w siatce i ustaw ich Bevel Weights: 0.6 dla górnej i 0.5 dla dolnej krawędzi (dopasuj to zaokrą-

glenie do krawędzi zewnętrznych). Aby lepiej widzieć rezultat, tymczasowo wyłącz opcję Edit Mode modyfikato-

ra Subdivision Surface i włącz w Properties:Object opcję Viewport Display:Show Wireframe. 

 

Używamy tu modyfikatora Bevel do szybkiego wygenerowania krawędzi siatki tego oprofilowania. 

Potem je “utrwalimy” (Apply). Dlatego stosujemy tylko 4 segmenty zaokrąglenia (nie zmieniaj tego). 
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Crease: 0, Bevel 
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Zrób to samo z przodu tej osłony, zachowując lukę pośrodku (Rysunek 9.2.7):  

      

Rysunek 9.2.7 Tworzenie wstępnych zaokrągleń (część przednia) 

Dopasuj (zmniejsz) Bevel Weights tych krawędzi, tak aby zewnętrzne granice wygenerowanych zaokrągleń 

ledwo „dotykały” wierzchołek A (Rysunek 9.2.7a). Przesuń wierzchołek B do Y = 188.68 (Rysunek 9.2.7b). 

Zgodnie z rysunkami Curtiss, krawędź natarcia tego oprofilowania zaczyna się w stacji 188.68. 

Wyciągnij z trzech krawędzi wokół statecznika poziomego nowe ściany (Rysunek 9.2.8a), potem stwórz kolejne 

ściany z przodu krawędzi natarcia statecznika pionowego (Rysunek 9.2.8b). „Wygładź” ich przecięcia z po-

wierzchnią kadłuba kontynuacjami zaokrągleń generowanych przez modyfikator Bevel (Rysunek 9.2.8c):  

        

      

Rysunek 9.2.8 Formowanie krawędzi natarcia osłony 

Zmniejsz wartości Bevel Weights wzdłuż krawędzi natarcia statecznika poziomego, zmniejszając w tym obsza-

rze wynikowy promień zaokrąglenia do 2” (Rysunek 9.2.8d). Na koniec, wstaw w przednie ściany dwie dodat-

kowe linie krawędzi, dopasowując ich kontur do kształtu kadłuba (Rysunek 9.2.8e). 

a) b) 

A 
B 

STA 
188.68 

1.  Wyciągnij 
te ściany  

2.  Kontynuuj dol-
ne zaokraglenie  

Pierwszy 
wierzchołek 

krawędzi 
natarcia 

Sfazuj 
te kra-
wędzie 

Tu zostaw 
lukę 

Dopasuj szerokość 
fazy zmieniając 
Bevel Weight 

a) b) c) 

d) e) 

STA 
188.68 

Stwórz 
te  

ściany 

Stwórz 
te  

ściany 
Połącz 
te fazki 

Wydłuż tę fazkę 

Zmniejsz te 
Bevel Weghts 
do 0.2 - 0.1 

R 2” 

Pomocniczy 
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Zachowałem nadal lukę w górnej części siatki. Pozostawiłem ją, bo topologia generowana przez modyfikator 

Bevel dla połączenia trzech zaokrągleń w tym przypadku nie wyglądała dobrze. Ponieważ już dopasowaliśmy te 

zaokrąglenia wzdłuż pozostałych krawędzi osłony, można utrwalić (Apply) ten modyfikator.  

Ponieważ na liście ten Bevel jest poprzedzony modyfikatorem Mirror (por. Rysunek 9.2.6): 

1. Utrwal (Apply) modyfikator Mirror (to tworzy siatkę po prawej stronie samolotu). 

2. Utrwal (Apply) modyfikator Bevel. 

3. Usuń wszystkie wierzchołki siatki z prawej strony samolotu. 

4. Powtórnie dodaj na szczyt listy modyfikator Mirror, by dynamicznie generował prawą stronę osłony. 

W siatce pokazanej przez Rysunek 9.2.9a) usunąłem już trójkąty zamykające oryginalne zaokrąglenia krawędzi. 

Stworzyłem także pojedynczą krawędź poprzez tę lukę. W jej środku umieściłem wierzchołek (A).   

 

      

 

Rysunek 9.2.9 Zamykanie luki w środku siatki 

Na początek dodaj dwie trójkątne ściany łączące wierzchołki A B C D (Rysunek 9.2.9b). Potem możesz stwo-

rzyć kolejne, czworokątne ściany. Stwórz linię krawędzi pomiędzy E, A i F (Rysunek 9.2.9c). W ostatnim kroku, 

przekształć te trójkąty w środku siatki na czworoboki (Rysunek 9.2.9d).  
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Dopasuj to oprofilowanie do powierzchni kadłuba i sprawdź jeszcze raz łuki zaokrąglenia wokół statecznika 

poziomego. Użyj do tego sprawdzania pomocniczych kół, jak to pokazywane przez Rysunek 9.2.8d). 

Gdy wszystko jest dopasowane, utrwal modyfikator Mirror (por. Rysunek 9.2.9d) by stworzyć prawą część siatki. 

Potem zacznij stopniowo obracać ściany wokół statecznika pionowego (Rysunek 9.2.10):  

          

Rysunek 9.2.10 Dopasowanie siatki osłony do odchylonego statecznika pionowego 

Umieść kursor 3D w osi steru kierunku (X=0, Y=232.5) i używaj go jako osi obrotu. Najpierw zaznacz prawie 

całą podstawę statecznika i obróć ją wokół globalnej osi Z o 0.3º (Rysunek 9.2.10a). Potem wyklucz z zazna-

czenia najniższą linię krawędzi i obróć pozostałe wierzchołki o 0.4º (Rysunek 9.2.10b). Powtarzaj tę sekwencję, 

dopóki odchylenie nie osiągnie 1.5º i ostatni „pasek” ścian ułoży się wzdłuż powierzchni statecznika (Rysunek 

9.2.10c). Potem wyprostuj krawędź natarcia oprofilowania (Rysunek 9.2.10d). 

Oprofilowanie jest niemal gotowe, ale jego tylny brzeg wciąż wymaga małego przycięcia. Najpierw wyciągnij 

jego dolną część do tylnej krawędzi kadłuba (Rysunek 9.2.11a). Stwórz z płaskiej ściany (Plate) obrys bryły 

tnącej (Rysunek 9.2.11b). Wyciągnij ten kontur. Użyj modyfikatora Bevel (Weight) do zaokrąglenia niektórych 

krawędzi, a Subdivision do wygładzenia fragmentu u góry tej bryły (Rysunek 9.2.11c). Pogrub oprofilowanie 

(0.032”, na zewnątrz). Użyj bryły i modyfikatora Boolean (Difference) do przycięcia (Rysunek 9.2.11d):    

   

   

Rysunek 9.2.11 Formowanie tylnej krawędzi 
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Rysunek 9.2.12a) pokazuje ostateczną topologię siatki: 

    

Rysunek 9.2.12 Szczegóły siatki oprofilowania 

Na zdjęciach archiwalnych można zauważyć odblaski od zaokrąglonych krawędzi blach tej osłony. Możemy 

łatwo odtworzyć ten efekt (Rysunek 9.2.12b) ustawiając Bevel Weight = 1 na tych brzegach i dodając nowy 

modyfikator Bevel (Weight) przed modyfikatorem Boolean (ta kolejność jest istotna). Ustaw Width Type tej fazki 

na Offset, Amount na 0.031 i Segments na 2. Aby „zatopić” połowę tej zaokrąglonej krawędzi w poszyciu kadłu-

ba, w modyfikatorze Solidify zwiększ Thickness do 0.062, a Offset ustaw na 0. 

Rysunek 9.2.13a) pokazuje gotowe oprofilowanie: 

    

Rysunek 9.2.13 Gotowe oprofilowanie 

W rzucie z boku (Rysunek 9.2.13b) możesz dostrzec niewielkie różnice pomiędzy moim modelem i rysunkiem 

Temmy. W przyszłości zamierzam dokładniej porównać ten kształt ze zdjęciami archiwalnymi. 

 

Thickness: 1/16” 

Offset: 0  

Bevel (Width): 
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a) b) 
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Podsumowanie 

• Nie znalazłem żadnych tabeli współrzędnych opisujących geometrię oprofilowania usterzenia (str. 382). Z 

tego powodu użyliśmy jako wzorca rysunków Jumpei Temmy (str. 383, 384). Wpasowaliśmy okrągłe prze-

kroje poprzeczne pomiędzy kontury oprofilowania, narysowane na jego rzucie z boku, góry i dołu. 

• To oprofilowanie wygładza krawędzie przecięcia stateczników z kadłubem. Zaczęliśmy jego formowanie od 

skopiowania odpowiednich fragmentów stateczników (str. 383). Scaliliśmy te dwie siatki wzdłuż ich krawę-

dzi przecięcia i przycięliśmy wynik wzdłuż powierzchni kadłuba (str. 383). 

• Po dopasowaniu zewnętrznych brzegów oprofilowania do rysunków wzorcowych (str. 383, 384) użyliśmy 

4-segmentowego zaokrąglenia, wygenerowanego przez modyfikator Bevel (Weight), do stworzenia pierw-

szego przybliżenia ostatecznego kształtu tej osłony (str. 384). Zróżnicowaliśmy wagi fazowania (Bevel 

Weights) by wpasować te zaokrąglenia pomiędzy brzegi osłony. Współczynnik Bevel Weight zmniejszył się 

znacznie przy krawędzi natarcia statecznika (str. 385). Promień zaokrąglenia był w tym miejscu dwa razy 

mniejszy niż przy tylnych brzegach oprofilowania. 

• Stworzyliśmy trójkątną powierzchnię z przodu tej osłony łącząc przednie sekcje ścian stateczników (str. 

384, 385). Dopasowaliśmy ten obszar do powierzchni kadłuba i do zaokrągleń wygenerowanych przez mo-

dyfikator Bevel (str. 385).   

• Sugeruję pozostawić przerwę w siatce tam, gdzie łączyłyby się trzy zaokrąglenia (str. 385). Ściany wygene-

rowane w tym miejscu przez modyfikator Bevel nie są najlepszym rozwiązaniem dla tego przypadku. O 

wiele łatwiej jest stworzyć je ręcznie, po „utrwaleniu” w siatce (Apply) zaokrągleń wygenerowanych modyfi-

katorem Bevel (str. 386). 

• Tak długo, jak to było możliwe, formowaliśmy to oprofilowanie jako symetryczne, bo o wiele łatwiej jest pra-

cować nad jej jedną połową, zamiast nad obydwoma stronami. Na koniec jednak „utrwal” odpowiedzialny 

za ten efekt modyfikator Mirror i obróć górną część siatki, dopasowując ją do asymetrycznej podstawy sta-

tecznika pionowego (str. 387). 

• Na koniec przycięliśmy tylne brzegi tego oprofilowania za pomocą pomocniczej bryły tnącej i modyfikatora 

Boolean (Difference) (str. 387). 

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-13.02.blend. 
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9.3 Oprofilowanie połączenia kadłuba i płata 

Obydwa myśliwce Curtiss miały bardzo duże oprofilowanie połączenia skrzydła z kadłubem. Jego całkowita 

długość to prawie połowa długości samolotu! Wydaje się, że tak wielkie osłony były „modne” w pierwszej gene-

racji dolnopłatów, projektowanych w połowie lat 30. XX w1. NACA opisała je w jednym ze swoich raportów, a 

P-40 odziedziczył je po P-36, który pojawił się na deskach kreślarskich jesienią 1934 r.  

Koncepcyjnie, ten kształt jest oparty o dwa wygięte, przyległe stożki: mniejszy i większy. Rysunek 9.3.1a) poka-

zuje ich teoretyczne kontury. Panele poszycia oprofilowania są połączone wzdłuż linii styku tych stożków: 

         

Rysunek 9.3.1 Geometria oprofilowania krawędzi przecięcia skrzydła z kadłubem 

Przednia część tej osłony (pomiędzy krawędzią natarcia skrzydła i osłoną silnika) miała inną geometrię, o wy-

dłużonych przekrojach poprzecznych2. Tylna dolna część oprofilowania (za krawędzią spływu skrzydła) jest 

płaską kontynuacją dolnej powierzchni płata (Rysunek 9.3.1b). Za przegrodą silnika, to oprofilowanie składało 

się z trzech paneli (przedniej, środkowej i tylnej), przymocowanych do kadłuba śrubami.  

Na szczęście, zachowały się współrzędne tego oprofilowania z „krótkonosych” wariantów P-40. Są to rysunki 

87-06-502, 87-06-503, 87-06-705. Rysunek 9.3.2 pokazuje zawartość 87-06-503: 

            

Rysunek 9.3.2 Oryginalny rysunek środkowego panelu oprofilowania 

W rysunku 87-06-502 (największa, tylna panel) zastosowano podobne konwencje. 

 
1 Wśród tych samolotów tylko Messerschmitt Bf-109 miał mniejsze oprofilowanie. Może dlatego, że opracowano go na podstawie starszego 

poprzednika: sportowego Bf-108? (Bf-108 był opracowany jeszcze wcześniej, w 1933 r.).   

2 Był to wynik modyfikacji wprowadzonej pod koniec 1940. Oryginalnie, przednia panel oprofilowania P-40 była niewielką powierzchnią 

stożkową „owiniętą” wokół krawędzi natarcia skrzydła, jak w P-36. Jednak taki kształt w połączeniu z węższą osłoną silnika znacznie zwięk-

szył tendencję do kapotażu podczas lądowań. Aby choć częściowo temu zapobiec, Curtiss stworzył większy przedni panel oprofilowania 

połączenia skrzydła z kadłubem. Te nowe panele były także montowane w wyprodukowanych wcześniej P-40. 
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https://app.aircorpslibrary.com/drawing/viewer/87-06-502/p-40?p=3
https://app.aircorpslibrary.com/drawing/viewer/87-06-503/p-40?p=2
https://app.aircorpslibrary.com/drawing/viewer/87-06-705/p-40?p=3
https://app.aircorpslibrary.com/drawing/viewer/87-06-503/p-40?p=2
https://app.aircorpslibrary.com/drawing/viewer/87-06-502/p-40?p=3
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Przednia część osłony skrzydła, pokazana na rysunku 87-06-705, pochodzi z P-40D i późniejszych wersji z 

silnikiem Allison. Rysunek zawiera tylko linie teoretyczne, bez tabeli współrzędnych. Dopasowałem go do osłony 

silnika z wcześniejszych wersji, zakładając, że poza tymi brzegami ich kształt był identyczny.       

Aby zastosować w praktyce wszystkie wymiary z dokumentacji, trzeba stworzyć pomocnicze „wręgi” i obryso-

wać kontury oprofilowania na kadłubie i skrzydle. Zrobiłem to w szkielecie referencyjnym (por. str. 620), który 

możesz teraz użyć w swoim modelu zamiast tworzyć swój własny (Rysunek 9.3.3):  

 

Rysunek 9.3.3 Pomocnicze kontury wzorcowe oprofilowania 

Zacznijmy od odwzorowania zewnętrznych konturów tej osłony. Zacznij od widoku z boku (Rysunek 9.3.4a), 

potem widoku z góry. Dopasuj te dwie powierzchnie do skrzydła i kadłuba (Rysunek 9.3.4b):  

    

    

Rysunek 9.3.4 Określanie położenia poprzecznych krawędzi siatki 

W ten sposób określisz położenie linii krawędzi w finalnej siatce. Pamiętaj też o krawędzi spływu (Rysunek 

9.3.4c). Aby być gotowym do jej formowania, zmodyfikuj ostatnie sekcje tego obiektu (Rysunek 9.3.4d).  
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https://app.aircorpslibrary.com/drawing/viewer/87-06-705/p-40?p=3
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Do zaokrąglenia tej narożnej krawędzi moglibyśmy wykorzystać modyfikator Bevel (Weight) (Rysunek 9.3.5):  

    

Rysunek 9.3.5 Wykorzystanie modyfikatora Bevel (Weight) 

Modyfikator Bevel szybko tworzy takie zaokrąglenia. Jednak kryją się tu kłopoty, bo współczynniki Bevel Weight 

nie sterują wprost ich promieniem wynikowym (Rysunek 9.3.5a). Co więcej, wynikowa powierzchnia podziałowa 

oparta o te zaokrąglenia nie tworzy regularnych łuków w przekrojach poprzecznych. Ich kształty wymagają po-

prawienia po „utrwaleniu” modyfikatora (Rysunek 9.3.5b). To oznacza dużo ręcznych poprawek. Dlatego wolę 

stworzyć to oprofilowanie przez „ręczne” wyciąganie krzywej podziałowej o kształcie regularnego łuku:     

         

         

Rysunek 9.3.6 „Ręczne” Formowanie okrągłego przekroju 

Stwórz okrąg wzorcowy (Rysunek 9.3.6a), dopasowany do jednej z wzorcowych sekcji pomocniczego obiektu 

(por. Rysunek 9.3.4d). (Aby widzieć jego sekcje, włącz w Properties:Object opcję Wireframe). Stwórz pierwszą 

sekcję tej siatki: 12-boczny okrąg, wygładzony Subdivision Surface (Rysunek 9.3.6b). Usuń 7 niepotrzebnych 

wierzchołków i podziel pierwszy i ostatni bok (Rysunek 9.3.6c). Przesuń cały profil, aby trzeci wierzchołek (C) 

znalazł się na wzorcowym konturze (Rysunek 9.3.6d). Obróć wierzchołki A i B wokół C, tak, aby leżały na jednej 

linii (Rysunek 9.3.6e). teraz możesz sterować lokalną krzywizną konturu wynikowego przesuwając (Slide) 

wierzchołek B wzdłuż krawędzi |AC| (Rysunek 9.3.6f). Dopasuj tak samo drugi koniec tej krzywej. 
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Nazwijmy przygotowane pomocnicze ściany (por. Rysunek 9.3.4) X.170.Fairing. Łuk, którego tworzenie poka-

zuje Rysunek 9.3.6 jest pierwszą krawędzią siatki oprofilowania. Nazwijmy ten nowy obiekt B.170.Fairing.  

Umieść te nowe elementy w odpowiednich subkolekcjach kolekcji 3.Wing (Rysunek 9.3.7): 

 

Rysunek 9.3.7 Nowe obiekty w strukturze modelu 

W odróżnieniu od pozostałych części skrzydła, „rodzicem” (Parent) tych dwóch obiektów jest X.000.Base. 

Wyciągnij krawędź początkowego łuku siatki B.170.Fairing wzdłuż wzorcowych ścian. Robiąc to, tymczasowo 

wyłącz w modyfikatorze Subdivision Surface opcję Edit Mode (por. str. 384, Rysunek 9.2.6). Umieść każdą no-

wo wyciągniętą linię krawędzi w odpowiedniej sekcji pomocniczej X.170.Fairing (Rysunek 9.3.8):  

   

   

Rysunek 9.3.8 Wyciąganie kolejnych segmentów siatki oprofilowania 

Aby dopasować taką nową sekcję siatki do krawędzi referencyjnej #4, wykonaj poniższe kroki: 

1. Przesuń nowo utworzoną krawędź, aby wierzchołek C znalazł się na krawędzi #4 (Rysunek 9.3.8a).  

2. Obróć wierzchołki A i B wokół C, aby znalazły się na tej samej krawędzi wzorca (Rysunek 9.3.8b). 

3. Ustaw środek transformacji w wierzchołku A i skaluj całą linię krawędzi, dopóki wierzchołek D nie „do-

tknie” poziomego odcinka #4 (Rysunek 9.3.8b).  

4. Obróć E i F wokół D, aby te trzy wierzchołki leżały na tej samej krawędzi #4 (Rysunek 9.3.8c). 

5. Przesuń (Slide) wierzchołek F, umieszczając go na brzegu wzorcowego konturu (Rysunek 9.3.8d). 

 W rezultacie, odcinki |AC| i |DF| formowanej linii krawędzi leżą w odpowiednim miejscu wzorca. 
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Od czasu do czasu włączaj w modyfikatorze Subdivision Surface opcję Edit Mode, aby wprowadzić drobne po-

prawki dopasowujące powierzchnię wynikową do konturów wzorcowych (Rysunek 9.3.9a):  

    

Rysunek 9.3.9 Dopasowywanie dalszych części siatki osłony 

Jedna z podłużnic wzorcowego szkieletu biegnie wzdłuż linii styku małego i dużego stożka (por. Rysunek 9.3.1). 

Aby się do niej dopasować, za skrzydłem przekroje oprofilowania nie są już łukami (Rysunek 9.3.9b).  

Odetnij (narzędziem Knife) część tej siatki za linią styku stożków (Rysunek 9.3.10a). Wyciągnij z tej krawędzi 

nowy segment siatki do wzorcowej krawędzi spływu (Rysunek 9.3.10b). Wstaw potem w środek dodatkową linię 

krawędzi (Rysunek 9.3.10c):  

    

    

    

Rysunek 9.3.10 Formowanie stożka krawędzi spływu 

Wyciągnij linię krawędzi do dolnego konturu wzorcowego (Rysunek 9.3.10d), potem wyciągnij płaską krawędź, 

która leży na wzorcowej dolnej powierzchni. Wstaw w środek tego nowego segmentu kolejną linię krawędzi 

(Rysunek 9.3.10e), potem wyciągnij kolejną krawędź i dopasuj pomiędzy kil i kadłub (Rysunek 9.3.10f). 
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Popraw wierzchołki stożka krawędzi spływu, dopasowując powierzchnię wynikową do wzorcowych konturów 

przekrojów (Rysunek 9.3.11a). Czasami możesz stwierdzić, że kołnierz kila nie jest dobrze dopasowany do 

kształtu oprofilowania. W takim przypadku, popraw ten kołnierz (Rysunek 9.3.11b).  

    

Rysunek 9.3.11 Formowanie stożka krawędzi spływu (c.d.) 

Gdy stożek jest gotowy, uformuj końcówkę tej krawędzi spływu. Najpierw wyciągnij jej środkowe ściany 

(Rysunek 9.3.12a). potem wyciągnij z ich wierzchołków „narożniki” tej siatki, podziel, gdzie jest to potrzebne i 

połącz ścianami (Rysunek 9.3.12b, c). Gdy do dopasowania do konturu wzorcowego potrzeba dodatkowego 

wierzchołka, możesz podzielić krawędź z brzegu siatki (tak dodałem wierzchołek A – por. Rysunek 9.3.12b).  

            

Rysunek 9.3.12 Formowanie końcówki krawędzi spływu 

Jako dodatkowych referencji użyłem nałożonych na model zdjęć (Rysunek 9.3.13a). Odkryłem, że zewnętrzna 

krawędź oprofilowania była bliżej kadłuba niż wynika to z wymiarów z dokumentacji P-36 i P-40:  

     

Rysunek 9.3.13 Dopasowanie modelu do zdjęć 

Różnica wynosi około 0.5” przy krawędzi spływu skrzydła. Nie potrafię tego wyjaśnić. Obydwie alternatywy ja-

koś pasują do wzmocnienia chodnika, które stworzyliśmy w sekcji 5.5 (por. str. 197, Rysunek 5.5.27). Założy-

łem, że zdjęcie pokazuje stan prawdziwy, i odpowiednio zmodyfikowałem model (Rysunek 9.3.13b). 
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Przednią część oprofilowania można by uzyskać z profilu krawędzi natarcia skrzydła, wyciąganego wzdłuż glo-

balnej osi X. Jednak w tym P-40 możemy także użyć gotową żółtą powierzchnię ze szkieletu referencyjnego 

(por. Rysunek 9.3.3). Nazywa się R.Wing Fairing Fwd. Możesz połączyć ten obiekt ze sceny Reference1 lub 

importować go z pliku source\reference\3D_model\P-40_ref.blend (por. str. 437). Gdy pojawi się już w scenie 

Model (Rysunek 9.3.14a), scal jego siatkę z obiektem osłony (B.170.Fairing): 

         

         

Rysunek 9.3.14 Dopasowywanie krawędzi natarcia oprofilowania zaimportowanej ze wzorca  

Po scaleniu, usuń ostatnią linię krawędzi z zaimportowanej części i upewnij się, że wszystkie wektory normalne 

są skierowane do wewnątrz. Stwórz nowe ściany łączące część przednią i tylną (Rysunek 9.3.14b). Sprawdź 

zewnętrzne brzegi tej osłony, dopasowując je do powierzchni skrzydła lub okapotowania (Rysunek 9.3.14c). 

Użyj „częściowo zatopionych” powłok do stworzenia efektu nałożenia osłony na owiewkę podwozia (Rysunek 

9.3.14d). W dolnym zewnętrznym narożniku siatki użyj częściowych wyostrzeń (Rysunek 9.3.14d) do „wygięcia” 

oprofilowania wzdłuż owiewki i skrzydła. Porównaj także kształt brzegu ze zdjęciami (Rysunek 9.3.14e).  

Rysunek 9.3.15 pokazuje gotową dolną część oprofilowania, wraz z wygenerowaną prawą stroną:  

 

Rysunek 9.3.15 Gotowa dolna część oprofilowania 

 
1 Zaznacz ten obiekt w scenie Reference i wybierz z menu Object→Link/Transfer Data→Link Objects to Scene scenę Model.  
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Obejrzyj całą osłonę pod różnymi kątami, szukając ewentualnych zaburzeń powierzchni wynikowej. Aby widzieć 

lepiej wzorcowe kontury, wyłącz na chwilę w modyfikatorze Solidify opcje Edit Mode i Realtime1. Rysunek 

9.3.16a) pokazuje osłonę „obraną” z warstwy o grubości blachy oraz wystające z niej zarysy elementów szkiele-

tu wzorcowego. Aby lepiej dopasować powierzchnię oprofilowania do tych konturów, zdecydowałem się zmienić 

lokalną topologię jego siatki, dodając kilka nowych wierzchołków (Rysunek 9.3.16b):  

    

Rysunek 9.3.16 Ostatnie poprawki w siatce osłony  

Dla porównania, poprzednią topologię tego obszaru pokazuje Rysunek 9.3.12c). W podobny sposób możesz 

poprawić tę siatkę we wszystkich miejscach, w których powierzchnia wynikowa nie pasuje dobrze do konturów 

wzorcowych, lub gdzie zauważyłeś nieregularności spowodowane przez ściany trójkątne lub n-gony. 

Rysunek 9.3.17 pokazuje gotowe oprofilowanie (i resztę modelu) nałożone na archiwalne zdjęcie P-40:  

 

Rysunek 9.3.17 Nasz model, zmapowany na zdjęcie archiwalne 

Zgodnie z dokumentacją, wszystkie panele osłony krawędzi skrzydła i kadłuba były łączone „na zakładkę” z 

wyjątkiem jednej, zaznaczonej powyżej. Wykorzystamy tę informację podczas teksturowania, do rysowania 

„mapy nierówności”. W prawej krawędzi natarcia tej osłony znajdował się mały otwór wentylacyjny. Odtworzymy 

ten detal na ostatnim etapie uszczegóławiania modelu. 

 
1 W tej osłonie modyfikator Solidify generuje efekt „grubości blachy” po zewnętrznej stronie powierzchni podziałowej. Dlatego ukrycie tego 

efektu przenosi nas o 0.032” głębiej, odsłaniając kontury szkieletu wzorcowego.  
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Podsumowanie 

• Oprofilowanie połączenia skrzydła z kadłubem ma kształt części dwóch wygiętych, połączonych stożków 

(str. 390). Zachowały się oryginalne rysunki tego zespołu dla P-36 i P-40D. Aby użyć wszystkie z podanych 

w nich współrzędnych, przygotuj wzorcowy „szkielet” złożony z wręg i konturów (str. 391). Później odkryje-

my, że na zdjęciach zewnętrzny brzeg tej osłony był o ~0.5” bliżej kadłuba niż linia poprowadzona wg wy-

miarów z dokumentacji (str. 395). Ta poprawna linia jest zbliżona do konturu z rzutu z góry Jumpei Temmy.  

• Zacznij od odtworzenia w jednej siatce konturów osłony na kadłubie i na skrzydle (str. 391). Zamodeluj 

obydwie krzywe za pomocą tych samych linii krawędzi, złożonych z dwóch wierzchołków. Położenie tych 

krawędzi wzdłuż globalnej osi Y określa położenie kolejnych sekcji w finalnej siatce osłony.     

• Mógłbyś stworzyć pierwsze przybliżenie głównego stożka za pomocą zmiennego zaokrąglenia Bevel 

(Weight) (str. 392). Jednak wielosegmentowy Bevel generuje przekroje poprzeczne w kształcie regularnych 

łuków. Gdy wygładzisz taką siatkę modyfikatorem Subdivision, to z takich punktów sterujących nie uzy-

skasz idealnych przekrojów w kształcie łuku na wynikowej powierzchni podziałowej. W przypadku mniej-

szych łuków te różnice są pomijalne. Jednak ta osłona jest na tyle duża, że po „utrwaleniu” modyfikatora 

Bevel musiałbyś ręcznie poprawiać każdą z sekcji siatki oprofilowania. Dlatego zdecydowałem się stworzyć 

ten stożek w inny sposób: wyciągając jego kolejne sekcje z początkowego profilu (str. 393). Ten profil 

ukształtowałem na początku jako krzywą podziałową o kształcie regularnego łuku (str. 392). 

• Formowanie mniejszego stożka (krawędzi spływu osłony) zacznij od odcięcia części siatki za linią styku 

stożków (str. 394). Potem wyciągnij kolejne linie krawędzi bocznych tego stożka, dopasowując powierzch-

nię wynikową do szkieletu wzorcowego (str. 395). 

• W podobny sposób mógłbyś uformować osłonę wokół krawędzi natarcia skrzydła. Jednak w tej książce 

wykorzystałem gotową powierzchnię ze szkieletu wzorcowego (str. 396). 

• Prawą osłonę stwórz za pomocą modyfikatora Mirror (str. 396).    

 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-13.03.blend. 
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9.4 Weryfikacja końcowa i poprawki 

Uformowaliśmy już wszystkie zewnętrzne powierzchnie naszego modelu, ale nie ma w nim jeszcze szczegó-

łów1. To dobra chwila na dodatkową weryfikację jego geometrii, bo łatwiej będzie nanieść ewentualne poprawki.   

Pomimo zachowanych rysunków fabrycznych, w tym P-40 nadal jest wiele nieudokumentowanych obszarów. 

Teraz zamierzam je porównać ze zdjęciami, do których dopasowałem projekcję modelu (por. Rozdział 14). 

Wspominałem już o tej metodzie (str. 319, 360, 361, 365, 395, 396). Najtrudniejszą rzeczą w tej technice jest 

dokładne „dopasowanie” modelu do zdjęcia. Gdy tylko to się uda, uzyskujesz wspaniały wzorzec, który możesz 

używać tak, jak plany samolotu (Rysunek 9.4.1): 

 

Rysunek 9.4.1 Identyfikacja różnic pomiędzy modelem a zdjęciem 

Zacznijmy od ramki oszklenia za kabiną. W naszym modelu oparliśmy się na rys. 75-21-076 z P-36. Zmodyfi-

kowaliśmy w nim tylko wewnętrzny kontur z tyłu (str. 335). Położenie pionowego paska ramki jest zgodne z tym 

rysunkiem: jego środkowa oś biegnie wzdłuż stacji #7. Jednak w odrestaurowanych samolotach tylna krawędź 

tego paska biegnie wzdłuż łączenia paneli kadłuba, czyli dokładnie na płaszczyźnie #7. Podobnie, dolna część 

ramki jest nieco wyżej niż na rysunku z P-36 (Rysunek 9.4.1). Widać tu także różnice w kształcie tylnej końców-

ki ramki. Sprawdźmy, czy potwierdzi to zdjęcie archiwalne (Rysunek 9.4.2):  

 

Rysunek 9.4.2 Porównanie ze zdjęciem archiwalnym (P-40B z AVG) 

Na archiwalnym zdjęciu P-40B można dostrzec dwie z trzech różnic wykrytych pokazanych przez Rysunek 

9.4.1. Wydaje się tu także, że tylna krawędź ruchomej owiewki jest pod innym kątem niż w naszym modelu.  

 
1 Z wyjątkiem skrzydła (por. str. 286 - 328). Zdecydowałem się jednak odtworzyć te szczegóły, bo powstawały w oparciu o oryginalną doku-

mentację. Nie stworzyliśmy jeszcze struktur wewnętrznych w owiewkach podwozia, bo nie są w ten sposób potwierdzone. (Stworzyłem je w 

oparciu o kilka pozostawionych rysunków i wiele założeń).     
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Każde z tych dopasowani do zdjęć jest wykonywane z pewną tolerancją1. Spróbowałem nieco „naciągnąć” pro-

jekcję na to zdjęcie archiwalne, poprawiając dopasowanie mojego modelu do obrazu (Rysunek 9.4.3): 

 

Rysunek 9.4.3 Poprawione mapowanie archiwalnego zdjęcia 

Jak widać powyżej, udało mi się zmniejszyć różnicę przy końcówce ramki oszklenia (por. Rysunek 9.4.3 i Rysu-

nek 9.4.2). W przypadku odrestaurowanego samolotu, poszukałem innego zdjęcia tej samej maszyny. Rysunek 

9.4.4 potwierdza dla tego P-40C #N80FR różnice wyliczone przez Rysunek 9.4.1: 

 

Rysunek 9.4.4 Inne ujęcie tego samego samolotu (odrestaurowany P-40C N80FR) 

Te różnice widać na niektóre odbudowanych P-40 (Rysunek 9.4.5a), a na innych – nie (Rysunek 9.4.5b): 

         

Rysunek 9.4.5 Porównanie modelu z innymi P-40 („białą 284” i białą „160”), odrestaurowanymi przez różne zespoły 

 
1 Zazwyczaj jest to tolerancja „na szerokość piksela”: często musisz decydować, po której stronie „ząbkowanego” rzędu pikseli umieścić 

gładki kontur modelu. W przypadku niektórych zdjęć archiwalnych poddałem się, gdy nie mogłem jednocześnie dopasować go do środka 

obrazu i obszarów wzdłuż brzegów. W takim przypadku koncentrowałem się na dopasowaniu modelu do środka zdjęcia. 
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Sprawdziłem także kolejne archiwalne zdjęcie P-40-cu z NASM (Rysunek 9.4.6a):  

     

Rysunek 9.4.6 Porównanie ramek kabiny z innym zdjęciem P-40 

W tym przypadku pionowy pasek dokładnie pasuje do zdjęcia (żadnych różnic). Przesunięcie zewnętrznej ramki 

jest mniejsze, zresztą może być spowodowane błędem w mapowaniu (lub jakąś deformacją fotografii). Ta 

„przymiarka” pokazuje za to pewne różnice w ramce odsuwanej osłony kabiny (Rysunek 9.4.6b)1.  

Dopasowanie odsuwanej osłony jest trudniejsze, ponieważ na każdym zdjęciu może się znajdować w innym 

miejscu swoich szyn. Na przykład, dopasowując model do obrazu pokazywanego przez Rysunek 14.2.20, za-

stanawiałem się, czy pilot nie dosunął jej do końca, zostawiając sobie wąską szczelinę do lepszej wentylacji. 

Dopasowałem model do ponad 20 zdjęć. Rezultaty były różne. W niektórych przypadkach widać różnice wyli-

czone przez Rysunek 9.4.1, podczas gdy w innych ramka z modelu pasuje do fotografii.  

Ostatecznie, zacząłem podejrzewać, że wiatrochron w odrestaurowanym N80FR jest zamontowany o jakieś 

0.3” wyżej niż w oryginale. Poszukałem więc jakiegoś odbudowanego P-40 z oryginalną osłoną kabiny. Znala-

złem P-40C #41-13390. Został porzucony po lądowaniu na brzuchu w okolicach Murmańska w lutym 1942. 

Wrak samolotu został znaleziony w 1993 z nienaruszonymi ramkami kabiny (Rysunek 9.4.7): 

 

Rysunek 9.4.7 Wrak P-40C #41-13390, odnaleziony w 1993 w okolicach Murmańska  

 
1 Aby ułatwić sobie dopasowywanie odsuniętych osłon, dodałem do modelu instancję kolekcji 2e2.Canopy (por. str. 1146), ustawioną w 

tylnym położeniu. W zależności od aktualnie wybranego zdjęcia tła, przełączałem widoczność tej kolekcji i jej przesuniętej instancji.  

 

Dokładność mapowania modelu do tych archiwalnych zdjęć to około 0.5”. Może być lepsza w przy-

padku współczesnych zdjęć, ale na nich trzeba zidentyfikować i pominąć zmodyfikowane elementy.  
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Dolna część okapotowania silnika #41-13390 została zniszczona w rezultacie awaryjnego lądowania, ale poza 

tym płatowiec był w zadziwiająco dobrym stanie. Rysunek 9.4.8 pokazuje jego kokpit po odrestaurowaniu: 

 

Rysunek 9.4.8 Dopasowanie modelu do odrestaurowanego #41-13390 

Ostatecznie, zdecydowałem się pozostawić bez zmian dolną ramkę oszklenia, bo jej różnice pokazane przez 

Rysunek 9.4.1 nie pojawiają się ani na archiwalnych zdjęciach, ani na tym odrestaurowanym P-40C. 

W przypadku pionowej ramki, zacząłem podejrzewać, że w P-40-cu była przynitowana jak na rysunku z P-36 

(i.e. jak w naszym modelu). Potem w późniejszych wariantach (P-40B,C) mogła zostać wyrównana do krawędzi 

biegnącego pod spodem panelu, bo to uprościło nitowanie. Przygotowaliśmy wcześniej dwie alternatywne ko-

lekcje dla wiatrochronów tych wariantów (por. str. 357). Teraz wydziel ten pasek w oddzielny obiekt o nazwie 

B.540.Glass Frame (M). Umieść go w kolekcji 2e1a.P-40-cu, a jego kopię (C.540.Glass Frame (M)) w kolekcji 

2e1b.P-40B/C (Rysunek 9.4.9b)1. 

Następnie zmodyfikowałem siatkę z P-40B/C, przesuwając ja wzdłuż globalnej osi Y (Rysunek 9.4.9a):  

 

Rysunek 9.4.9 Przesunięcie paska na oszkleniu z tyłu kabiny  

Dzięki modyfikatorom (por. str. 341) to była łatwa modyfikacja. Tę siatkę możesz zmieniać bezpośrednio w pro-

jekcji z kamery, dopasowując jej krawędzie do linii widocznych na zdjęciu (tylko zablokuj jej lokalną oś Z). 

 
1 Wiem, że to może być trochę mylące, ponieważ obydwie kolekcje należą do 2e1.Windshield, podczas gdy ten pasek należy do innej 

części osłony kabiny. Jednak wolę trzymać wszystkie różnice związane z tymi wariantami w dwóch kolekcjach, bo taki układ upraszcza 

przełączanie pomiędzy tymi dwoma konfiguracjami modelu. Przełączanie czterech kolekcji w dwóch oddzielnych „gałęziach drzewka” sceny 

mogłoby się stać źródłem późniejszych pomyłek.  

 

Różnice w kształcie owiewki kabiny (por. Rysunek 9.4.6b), wymagają jeszcze dalszych porównań. 

Przesunięcie 
(~0.7”) 

 

Ramka pasu-
je do zdjęcia 
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a) b) 
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Gdy formowaliśmy tylną część kadłuba, zaznaczyliśmy także kontur otworu kółka ogonowego za pomocą siatki 

„rozwiniętej” na powierzchni kadłuba. Została nazwana X.500.Tail Wheel.Doors (por. str. 285). Teraz, do po-

równania za zdjęciami, potrzebujemy odchylanych pokryw tego otworu, abyśmy mogli je ustawić jako otwarte. 

Jednocześnie chciałbym zachować prostotę siatki użytej w tym pomocniczym obiekcie. Co więcej, wolałbym 

także użyć tej samej siatki do uzyskania otworu kółka ogonowego i jego pokryw1. 

Można to osiągnąć korzystając z klonów obiektów. Zacznijmy od wycięcia otworu. Zmień nazwę obiektu 

X.500.Tail Wheel.Door na U.500.* i przesuń do kolekcji 2c8.Booleans. Na wszelki wypadek przełącz w jego 

modyfikatorze Shrinkwrap obiekt Target na powierzchnię kadłuba X.500.Fuselage (Rysunek 9.4.10a). Ustaw 

grubość modyfikatora Solidify na 1.0 i przełącz tryb wyświetlania na Wire (tak jak innych brył tnących). Użyj tego 

obiektu w nowym modyfikatorze Boolean (Difference) dodanym do B.500.Fuselage (Rysunek 9.4.10b): 

    

Rysunek 9.4.10 Wycinanie otworu na kółko ogonowe 

Teraz stwórzmy pokrywy tego otworu. Powstaną z części powierzchni kadłuba przyciętej bryłą tnącą podobną 

do tej, której użyliśmy do stworzenia otworu kółka ogonowego. 

Skopiuj i wydziel w nowy obiekt fragment siatki kadłuba wokół otworu kółka (Rysunek 9.4.11a): 

    

Rysunek 9.4.11 Kopiowanie fragmentu siatki kadłuba wokół otworu kółka ogonowego  

Nazwij ten nowy obiekt X.535.Tail Door.Surface. Jego siatka wymaga kilku drobnych poprawek, które dopasują 

ją do zakrzywionej powierzchni kadłuba. Aby ułatwić te modyfikacje, przełącz domyślną orientację transformacji 

na Normal, a domyślny środek transformacji – na Individual Origins (Rysunek 9.4.11b). Potem przesuwaj grupy 

tych wierzchołków wzdłuż ich normalnych (Z), szczególnie w narożnikach tej siatki. 

 
1 To zasada „jednego parametru”: gdy zmodyfikujesz siatkę osłony, Blender automatycznie dopasuje do niej kształt otworu. 
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Skopiuj ten fragment siatki kadłu-
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Teraz stwórzmy zespół pokrywy kółka ogonowego: 

1. Stwórz obiekt zawiasu (B.505.Tail Door Hinge). Przypisz do niego (Parent) X.535.Tail Door.Surface.  

2. Sklonuj X.535.Tail Door.Surface. Nazwij ten nowy obiekt B.535.Tail Door i umieść w kolekcji 2c.Tail. 

3. Sklonuj U.500.Tail Wheel.Doors. Nazwij ten nowy obiekt U.535.Tail Door.Contour.  

4. Przypisz U.535.Tail Door.Contour do zawiasu osłony (B.505.Tail Door Hinge). 

5. W obiekcie U.535.Tail Door.Contour zmień w modyfikatorze Shrinkwrap obiekt Target na X.535.Tail 

Door.Surface. W ten sposób jego kształt się nie będzie zmieniać podczas obrotu osłony.     

6. Usuń modyfikator Mirror z listy modyfikatorów obiektu U.535.Tail Door.Contour. 

Powyższe kroki wymagają trochę klikania, ale żaden z nich nie wymaga edycji siatki. Pamiętaj, aby klonować 

(nie kopiować!) w p. 2 i 3 obiekty, aby współdzieliły te same siatki. Rezultat powinien wyglądać tak, jak pokazuje 

to Rysunek 9.4.12:  

 

Rysunek 9.4.12 Organizacja podzespołu pokryw kółka ogonowego  

Dodaj do obiektu B.535.Tail Door modyfikator Solidify, nadający standardową „grubość blachy”: 0.032”.  Potem 

przytnij tę pokrywę modyfikatorem Boolean (Intersect), używając U.535.* jako bryły tnącej (Rysunek 9.4.13a): 

        

Rysunek 9.4.13 Przycinanie pokrywy kółka ogonowego 

Aby uzyskać szczelinę pomiędzy pokrywą i otworem (Rysunek 9.4.13b), dodaj do obiektu U.535.Tail 

Door.Contour modyfikator Geometry Nodes:Surface Offset (to pomocniczy modyfikator, który sam stworzyłem 

– por. str. 570). Ustaw jego Offset na -0.1. 

Usuń modyfikator Mirror 
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otworu kółka ogonowego 
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Na koniec dodaj na końcu listy modyfikatorów B.535.Tail Door kolejny modyfikator Mirror i wskaż jako jego 

środek obiekt X.000.Base. To wygeneruje prawą pokrywę kółka ogonowego (Rysunek 9.4.14):  

 

Rysunek 9.4.14 Gotowy otwór i pokrywy kółka ogonowego 

Teraz możesz otwierać i zamykać te pokrywy poprzez obrót lewego zawiasu wokół jego lokalnej osi Z (ten sam 

mechanizm, jaki przygotowaliśmy w sterach). Wewnętrzne wzmocnienia tego otworu stworzymy podczas 

uszczegóławiania, gdy już potwierdzimy jego kształt.  

Korzystając z podobnego rozwiązania, „uruchomiłem” także pokrywy goleni podwozia (Rysunek 9.4.15): 

 

Rysunek 9.4.15 Ruchome pokrywy goleni koła głównego  

Zacząłem od dodania dwóch zawiasów (B.165.L.Hinge.Main i B.167.L.Hinge.Side). Potem sklonowałem osło-

nę (B.160.L.Nacelle) w obiekty B.180.L.Door.Main i B.185.L.Door.Side. Usunąłem z nich niepotrzebne mody-

fikatory Boolean. Dla każdej z tych odchylanych pokryw stworzyłem klona jej bryły tnącej: U.160.Door.Main → 

U.180.Door.Main i U.160.Door.Side → U.185.Door.Side. Zmniejszyłem U.180.Door.Main i U.185.Door.Side 

za pomocą modyfikatorów Geometry Nodes:Surface Offset (ustawiłem ich Offset na 0.1”). Potem użyłem 

U.180.* do przycięcia B.180.*, i U.185.* do przycięcia B.185.*. Te pokrywy i ich bryły tnące są “przymocowane” 

(relacją Parent) do odpowiednich zawiasów (B.165.* lub B.167.*).  
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dyfikatorem Mirror   
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Ustawiłem osłony kółka w pozycji otwartej i porównałem ze zdjęciami archiwalnymi. Te pokrywy modelowaliśmy 

zgodnie z oryginalnym rysunkiem (por. str. 285). Rysunek 9.4.16a) pokazuje, jak pasują do P-40-cu, podczas 

gdy Rysunek 9.4.16b) przedstawia dopasowanie do P-40B (a dokładniej – do Tomahawka IIA):  

      

Rysunek 9.4.16 Różnica w długości osłon kółka ogonowego  

Wydają się pasować do zdjęć, oprócz tylnej części: te pokrywy są krótsze niż w modelu. Zastanawiając się nad 

tą różnicą, uświadomiłem sobie, że mogła być rezultatem modyfikacji z września 1941. Aby zapobiec kapota-

żom, które prześladowały wszystkie P-40, Curtiss podniósł jego ogon o ~2”1. Zmodyfikowane „długonose” P-40 

używały większe kółka ogonowe, które nie mieściły się do końca w kadłubie. Dlatego w pokrywach tego kółka 

wycięto dodatkowy otwór na oponę, częściowo wystającą na zewnątrz2. Ta modyfikacja była wprowadzona we 

wszystkich P-40-cu/B/C stacjonujących w kontynentalnych USA. Mam wrażenie, że nie wprowadzono jej w eks-

portowych Tomahawkach i w P-40 USAAC używanych w Panamie i na Hawajach (to większość samolotów). 

Dlatego w odrestaurowanych „długonosych” P-40 można znaleźć starsze, mniejsze kółko ogonowe. Na przykład 

– krótsze pokrywy widać w P-40C #41-13390 (Rysunek 9.4.17a). Jednak osłony kółka w „srebrnym” N80FR z 

Duxford nie pasują do żadnego z tych historycznych wariantów. Tylna krawędź tych pokryw biegnie tak, jak w 

naszym modelu, ale całość jest nadal o ~2.5” krótsza niż u nas (Rysunek 9.4.17b):  

      

Rysunek 9.4.17 Różnice w kółkach ogonowych odrestaurowanych „długonosych” P-40  

Przypuszczam, że ekipa remontowa N80FR przesunęła do tyłu oryginalne „krótkie” pokrywy kółka, aby zmieścić 

większe koło, pochodzące z późniejszego P-40 (np. P-40E). Właśnie z powodu takich adaptacji wolę używać 

zdjęć archiwalnych zamiast bardziej szczegółowych, współczesnych fotografii odrestaurowanych samolotów!  

 

 

1 Patrz [20] , str. 3 i 54. Wydłużono golenie kółek ogonowych i zwiększono średnicę ich opon z 10” do 12.5”. Dodatkowo, skrócono golenie 

podwozia głównego o 1” (zmniejszając ciśnienie w amortyzatorach). Po tych zmianach, kąt pomiędzy osią śmigła i płaszczyzną podłoża 

przy 100% masy startowej został zmniejszony o 1º, do 13.25º (taki sam kąt był w P-36). To była kolejna z modyfikacji wprowadzonych w 

celu wyeliminowania skłonności do kapotażu P-40, po powiększeniu owiewek krawędzi natarcia pod koniec 1940.  

2 Poprawiono to w P-40D, którego pokrywy kółka ogonowego przedstawia wykorzystany w naszym modelu rys. 87-21-523. Po analizie zdjęć 

myślę, że informacja figurująca w jego tabelce jest myląca: takie osłony nie były nigdy użyte w P-40C i wcześniejszych wariantach. 
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https://app.aircorpslibrary.com/drawing/viewer/87-21-523/p-40
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Na wszelki wypadek zdecydowałem się zachować aktualny, dłuższy wariant siatki pokrywy tworząc jego kopię o 

nazwie U.500.Tail Wheel.Doors (Longer). Potem użyłem zdjęć #41-13390 jako wzorca (ponieważ wiedziałem, 

że jego ogon jest oryginalny) do skrócenia siatki pokryw (Rysunek 9.4.18):  

       

Rysunek 9.4.18 Poprawianie siatki pokrywy kółka ogonowego  

Zmodyfikowałem siatkę pomocniczej bryły tnącej U.535.Tail Door.Contours (por. Rysunek 9.4.12). Jak widać 

na ilustracji powyżej, to było proste przesunięcie (Slide) tylnej krawędzi, zmniejszenie współczynnika Vertex 

Data:Bevel Weight wierzchołka A. Otwór w kadłubie automatycznie dopasował się do tych zmian, ponieważ jest 

wycięty przez bryłę wykorzystującą tą samą siatkę. 

Analizując dwa archiwalne zdjęcia (z NASM) wykonane lecącym z fabryki w Buffalo P-40-cu, doszedłem do 

wniosku, że oprofilowanie usterzenia było nieco szersze (Rysunek 9.4.19a):  

 

   

Rysunek 9.4.19 Poprawianie brzegu oprofilowania statecznika  

Nie znalazłem żadnych jawnych wymiarów tego konturu (por. str. 382). Odwzorowałem jego kształt z rysunku 

Jumpei Temmy (por. str. 384), więc po znalezieniu tej różnicy na obydwu zdjęciach, nie miałem wątpliwości. 

Zmieniłem tę siatkę przesuwając (Slide) jej brzeg wzdłuż powierzchni statecznika (Rysunek 9.4.19b,c). 

Na tym zdjęciu częściowo zamkniętej po-
krywy z #41-13390 lepiej widać jej kształt 

Pokrywy i otwór kółka ogo-
nowego po poprawkach    

A 

Przesuń (Slide) ten 
wierzchołek i zmniejsz 

jego Bevel Weight  
Przesuń (Slide) 
tę linię krawędzi 

Siatka bryły tnącej 
pokrywy kółka 

 

a) 

b) c) 

Osłona usterzenia 
była szersza  

Przesuń krawędź 
zewnętrzną (Slide, 

Clamp wyłączone)  

Wstaw nową linię 
krawędzi blisko 
brzegu osłony 



408 Formowanie modelu 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Kolejnym punktem na naszej „liście rzeczy do sprawdzenia” jest kształt osłony podwozia. Wydaje się pasować 

do zdjęć archiwalnych1 (Rysunek 9.4.20). Oczywiście, dookoła zauważyłem różne drobne odchyłki: 

 

Rysunek 9.4.20 Sprawdzanie kształtu osłon podwozia 

Celowo czekałem ze szczegółowym przycinaniem pokryw goleni na to porównanie. Tylna krawędź pokrywy 

tworzyła ukośną linię z zaokrąglonym narożnikiem. Jego promień znalazłem na rys. 87-34-506 (P-40E). Jednak 

nie ma tam kąta pochylenia ukośnego odcinka. W dodatku przymiarki do archiwalnych zdjęć (Rysunek 9.4.21a) 

wykazują mniejszy promień narożnika (2” zamiast 3”). Skoro kontur głównego otworu w osłonie pasuje do 

zdjęć, przekształciłem jego bryłę tnącą (U.180.Main Door) z klona w pełną kopię, z oddzielną siatką. Potem 

zmodyfikowałem tylną krawędź tej siatki, dopasowując ją do zdjęcia w tle (Rysunek 9.4.21b):  

     

Rysunek 9.4.21 Przycinanie głównej pokrywy goleni 

 
1 Dla łatwiejszego odróżnienia elementów modelu od zdjęcia, na czas porównań w zakładkach Properties:Object tej osłony i pokryw włączy-

łem dodatkową opcję Viewport Display:Show Wireframe. Jeżeli wyświetlana siatka jest za rzadka, dodatkowo wyłącz w jej modyfikatorze 

Subdivision Surface opcję Optimal Display. 

 

Oprofilowanie usterzenia nie ma „lustrzanego odbicia” (por. str. 387). Po zmodyfikowaniu lewej stro-

ny pamiętaj, aby to samo zrobić z prawej. Użyj na chwilę modyfikatora Mirror by widzieć lewy kontur 

(jako wzór) obok wierzchołków kształtujących prawego brzegu tej osłony.      
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https://app.aircorpslibrary.com/drawing/viewer/87-34-506/p-40
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Oczywiście, poprawiłem także różnicę w kształcie linii podziału paneli okapotowania (por. Rysunek 9.4.20). Zro-

biłem to modyfikując siatkę bryły tnącej U.600.Panel Seams (por. str. 293) i brzegu oprofilowania skrzydła. 

Teraz przeanalizujmy najmniej udokumentowaną część tego samolotu: wylot powietrza z chłodnic cieczy („bli-

ster” z przodu kila). Zazwyczaj był niszczony podczas awaryjnych lądowań „na brzuchu”. Nie zachowała się też 

jego dokumentacja. W odrestaurowanych P-40 płytki kontur tego „blistra” nie pasuje do zdjęć archiwalnych1. 

Dlatego użyłem fotografii z NASM (Rysunek 9.4.21) do sprawdzenia jego konturu z boku (Rysunek 9.4.22):  

     

Rysunek 9.4.22 Poprawianie bocznego konturu „blistra” za chłodnicami cieczy 

Aby dopasować się do konturu ze zdjęcia, skróciłem (skalując) siatkę blistra wzdłuż globalnej osi Y (Rysunek 

9.4.22b). Rysunek 9.4.22a) pokazuje także, że kalpy osłony mogły być nieco dłuższe, i że kąt odchylenia górnej 

pary klap różni się od kąta pary dolnej (muszę sprawdzić to spostrzeżenie na innych zdjęciach). Póki co, trzeba 

teraz uporządkować obszar wokół blistra. Inne zmapowane zdjęcie (Rysunek 9.4.23a) pokazało błędy, które 

popełniłem w moich poprzednich, relatywnych pomiarach (por. str. 331-332)2. Kolejna niespodzianka: otwór 

wyrzutnika łusek był 2” bliżej przegrody silnika niż w P-36. Był także nieco szerszy:  

     

Rysunek 9.4.23 Inne różnice wokół tego „blistra” 

Te różnice potwierdziłem na innych zdjęciach, których tu już nie pokazuję. Zgodnie z nimi, kształt przekroju po-

przecznego kila w stacji -4 był nieco węższy niż kontynuacja kształtu osłony chłodnic, którą przyjąłem w naszym 

modelu (por. str. 325). Dlatego zdecydowałem się skopiować część osłony silnika spod skrzydeł w oddzielny 

obiekt. Odciąłem ten obszar z oryginalnej siatki osłony. Usunąłem także tylną część osłony silnika, aż do prze-

grody (stacji 0 – por. Rysunek 9.4.23b) ponieważ nie będziemy już jej potrzebować. 

 
1 Jedynym wyjątkiem jest “srebrny” P-40C N80FR. Dolna część jego osłony silnika jest najbliższa oryginałowi. 

2 Przyjąłem błędną stację dla linii podziału paneli, którą później używałem jako bazy dla dalszych pomiarów względnych. 
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Powiększyłem odpowiednią bryłę tnącą osłony silnika (Rysunek 9.4.24a). Wydzieliłem z niej w oddzielny obiekt 

„pudełka” wycinającego otwory wyrzutników łusek w kilu. Teraz mogłem swobodnie dopasować przekrój po-

przeczny tej części kila do zdjęć, pozostawiając kształt podstawowej osłony silnika bez zmian. Na koniec dopa-

sowałem krawędzie boczne siatki „blistra” do konturów wycięcia w okapotowaniu silnika (Rysunek 9.4.24b):   

      

Rysunek 9.4.24 Szczegóły poprawionego wylotu z chłodnic cieczy 

Teraz obszar modelu wokół tych wyrzutników bardziej przypomina kontur z rysunku R.Side.Left (compiled) 

(por. str. 86). Rysowałem jego linie w oparciu o to samo zdjęcie, ale za pomocą miej dokładnych metod. 

Geometria kila wydaje się pasować do zmapowanych zdjęć. Znalazłem tylko różnice w położeniu linii podziału 

jego paneli (Rysunek 9.4.25a):  

 

Rysunek 9.4.25 Różnice w położeniu linii podziału paneli kila 

Te różnice występują na wszystkich historycznych zdjęciach i w żadnym z odrestaurowanych samolotów. Myślę, 

że zespoły odbudowujące te maszyny korzystały z tych samych rysunków, co my (87-23-504, -503, -502: por. 

str. 324). W kolumnie „stosowane w” ich tabelek można znaleźć tak P-40B/C, jak i H81A (tzn. „Tomahawk”). W 

oparciu o tę informację można założyć, że panele z tych rysunków były stosowane także we wczesnych wer-

sjach P-40. Jednak zdjęcia archiwalne pokazują, że informacja z tych tabelek nie jest prawdziwa (albo, że taka 

jej interpretacja jest błędna). 

Poprawiłem siatki paneli kila, dopasowując je do zdjęć. 

a) b) 
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https://app.aircorpslibrary.com/drawing/viewer/87-23-504/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-23-503/p-40
https://app.aircorpslibrary.com/drawing/viewer/87-23-502/p-40
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Nadal dwa zagadnienia pozostają niewyjaśnione: 

• Kształt odsuwanej owiewki kabiny (por. str. 401). 

• Chwyt powietrza do silnika: rozmiar i położenie ponad osłoną silnika (czy był mniejszy niż w modelu?). 

Nie zdecydowałem się zmienić tych elementów, ponieważ niektóre ze zmapowanych zdjęć potwierdzają ich 

obecne kształty. 

W istocie, już wprowadziliśmy pewne zmiany do przesuwanej osłony kabiny. Jest krótsza niż w P-36 (por. str. 

391), a jej dolna część jest oparta na zdjęciach i dwóch założeniach: 

1. Dolne krawędzie osłony są równoległe do krawędzi kokpitu. 

2. Szerokość osłony wzdłuż globalnej osi Y jest stała.   

Obydwa są oparte na geometrii z dokumentacji P-36. Oczywiście, jeżeli każde z tych dwóch założeń może zo-

stać zanegowane przez zdjęcie. Jednak na razie nie zgromadziłem żadnych „twardych dowodów” świadczących 

przeciwko nim. Mam wrażenie, że zauważone na zdjęciach odchylenia różnią się od siebie (każde jest inne). 

Jeżeli chodzi o chwyt powietrza do silnika: jego położenie i kształt są oparte na dokumentacji XP-40 (por. str. 

296). Na niektórych zdjęciach ten chwyt z naszego modelu wydaje się za duży (Rysunek 9.4.26a), podczas gdy 

na innych idealnie pasuje do fotografii (Rysunek 9.4.26b):    

     

Rysunek 9.4.26 Zanikająca różnica konturu chwytu powietrza do silnika 

Nie potrafię wyjaśnić powyższych rezultatów. Rysunek 9.4.26a) wykorzystuje zdjęcie odrestaurowanego #41-

13390, którego chwyt powietrza powinien być oryginalny (por. str. 401). Rysunek 9.4.26b) to jedno ze zmapo-

wanych zdjęć archiwalnych1, na którym ten wlot z naszego modelu doskonale pasuje do fotografii.  

Ostatecznie zdecydowałem się zachować aktualny kształt tego chwytu powietrza. Zawsze coś musi zostać dla 

ewentualnych dalszych poprawek. Myślę, że taki ewentualny błąd w geometrii jest mniej znaczący niż płytki 

blister za chłodnicami cieczy, powtórzony na niemal wszystkich odrestaurowanych „długonosych” P-402! 

Zdecydowałem się także przygotować alternatywny wariant śmigła – te wykonane z duraluminium (por. str. 

128). Mam wrażenie, że był montowany w większości eksportowych „Tomahawków II” i w P-40B/C. Porównując 

jego kształt z łopatami stalowymi, zauważyłem, że okrągłe podstawy łopat aluminiowych były krótsze, ale miały 

o 15% większa średnicę. Dla ułatwienia zmiany kształtu łopat, zdecydowałem się zmienić ich siatki ze „skręco-

nych na stałe” na płaskie, skręcone za pomocą modyfikatora Curve (por. str. 558). 

 
1 Ten obraz pochodzi ze zdjęcia, którego mapowanie opisaliśmy na str. 1496. 

2 Z wyjątkiem blistra zamontowanego w P-40C N80FR z Duxford. 

a) b) 

Górny kontur osłony luf 
nkm pasuje do zdjęcia 

Górny kontur chwytu powietrza 
do silnika z naszego modelu nie 

pasuje do tego zdjęcia 

Obydwa kontury 
pasują do zdjęcia 

Odrestaurowany #41-13390 
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Zamiast tworzenia 3 klonów krzywych i 3 klonów łopaty (każdy klon ma swoją własną listę modyfikatorów) zde-

cydowałem się użyć instancji (por. str. 493). Przygotowałem nową kolekcję „pierwszego poziomu” dla kolekcji, 

których będę używał jako instancji. Nazwałem ją Z.Instances1. Wewnątrz stworzyłem dwie subkolekcje: Z2a.* 

dla łopaty stalowej i Z2b.* dla łopaty aluminiowej (Rysunek 9.4.27): 

 

Rysunek 9.4.27 Ustawienia modelu do dopasowywania kształtu łopat śmigła 

Każda z kolekcji Z2* zawiera pojedynczą łopatę. To obiekty skręcone wokół tej samej krzywej: Q.010.Blade2. 

Obiekty zgrupowane w kolekcjach-wzorcach instancji są wyłączone z hierarchii (parent-child) modelu3. Robię 

tak dlatego, że środki tych kolekcji są definiowane w globalnym układzie współrzędnych sceny. Gdyby pozosta-

wić je przypisane do kołpaka, przy jego obrocie odsuwałyby się w różne, zaskakujące strony.  

Umieściłem trzy instancje kolekcji Z2a.* w 2a.Spinner:2a1.Hollow Blades (Rysunek 9.4.27), a trzy instancje 

kolekcji Z2b.* w 2a1.Solid Blades. Gdy jedna z tych kolekcji jest widoczna, druga powinna być ukryta. W przy-

szłości może się zdarzyć, że każda z nich zawierać będzie klon kołpaka, gdyż łopaty aluminiowe wymagają 

wykonania w jego powierzchni otworów o innym kształcie niż łopaty stalowe. 

Możesz zmieniać skok śmigła przez obrót tych instancji, w ten sam sposób jak w sekcji 4.4 (str. 125). Jednak 

nie możesz bezpośrednio zmieniać ich kształtu, jak to mogliśmy robić w przypadku klonów. Nie mogę dopaso-

wać źródłowego obiektu z sekcji Z2b.* do zmapowanego zdjęcia. Dlatego stworzyłem kolekcję Z.2z.Auxiliary i 

umieściłem w niej klony łopaty i jej krzywej (Rysunek 9.4.27). Przypisałem (relacją Parent) te pomocnicze obiek-

ty do kołpaka śmigła, aby obracały się wraz z pozostałymi łopatami. 

Za pomocą tak zorganizowanej sceny, mogłem dopasować łopaty śmigła do zdjęcia wzorcowego, w szczegól-

ności ich siatki. W tym specyficznym przypadku możesz jednocześnie widzieć modelowany kształt pod trzema 

różnymi kątami. To pozwoliło mi uniknąć części błędów, które popełniłbym opierając się na jednej projekcji. 

 
1 Przedrostka „Z” będę używał dla kolekcji – wzorców instancji. Ich instancje (obiekty) będą także miały nazwy z przedrostkiem „Z”. 

2 W bardziej ogólnym przypadku, każda z łopat powinna mieć swoją własną krzywą „skręcającą”. Jednak porównałem już ze sobą kształty 

obydwu wariantów łopat na zdjęciach. Kształt moich łopat ze stali, oglądany pod różnymi kątami, pasował do konturów łopat z aluminium, z 

wyjątkiem sekcji u podstawy. Dlatego zdecydowałem się w tym modelu zastosować w łopatach z aluminium tą samo rozłożenie kątów 

skręcenia, co w łopatach ze stali.  

3 To oznacza, że nie są przypisane do kołpaka śmigła, ani nie są w żaden sposób powiązane z obiektem X.000.Base. 

instancje 

instancje 

Używane 
przez 

obiekty 
łopat  

Pomocniczy klon łopaty 
i jej siatki, “upozowany” 

jak na zdjęciu 

Instancje 
kolekcji  
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Analizując różnice pomiędzy naszym modelem i zmapowanymi zdjęciami, odnoszę wrażenie, że: 

• Większa część kształtu łopaty pozostaje identyczna w obydwu wariantach śmigła. Różnią się tylko u 

podstawy (do 25” od osi obrotu śmigła). 

• Pogrubiłem cylindryczną podstawę łopaty z duraluminium o 15% w stosunku do średnicy łopaty ze stali 

(Rysunek 9.4.28a). To czysta spekulacja, ale w ten sposób lepiej pasuje do jej szerszych cięciw. 

• Łopaty z aluminium były montowane 1.5” bliżej do silnika niż łopaty stalowe1 (Rysunek 9.4.28b). 

      

Rysunek 9.4.28 Różnice w geometrii łopat z aluminium 

Rysunek 9.4.29 pokazuje zawartość tego pliku: 

 

Rysunek 9.4.29 Nasz model po ostatnich zmianach 

To ostateczny rezultat fazy modelowania. W następnej części tego przewodnika dobierzemy materiały i tekstury. 

W ostatniej fazie odtworzymy pozostałe szczegóły tego P-40. 

 
1 Lite łopaty aluminiowe były cięższe od wydrążonych łopat stalowych. Przypuszczam, że taka modyfikacja poprawiła wyważenie samolotu. 

Przesunięcie cięższego śmigła bliżej środka ciężkości maszyny pozwala zachować ten punkt w pobliżu oryginalnego położenia (wariantu ze 

śmigłem wyposażonym w stalowe łopaty). 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-13.04.blend. 

  

a) b) 
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Podsumowanie 

• Ta sekcja prezentuje opcjonalną weryfikację geometrii modelu. Sugeruję wykonać ją przed rozpoczęciem 

fazy teksturowania. 

• Głównym pomysłem jest dopasowanie projekcji modelu do projekcji wzorcowego zdjęcia. Gdy tylko zosta-

ną dopasowane, możesz szukać ewentualnych niezgodności. Dopasowanie projekcji jest najtrudniejszą 

częścią tego procesu, szczególnie w przypadku fotografii archiwalnych (por. sekcja 14.2). 

• Fotografie archiwalne są bardziej wiarygodnym źródłem niż współczesne zdjęcia odrestaurowanych samo-

lotów. Szczegóły tych odbudowanych maszyn mogą odbiegać od oryginału (str. 406). 

• Ograniczając transformacje w Blenderze do jednej osi (X, Y, Z) lub płaszczyzny (XY, YZ, ZX), można edy-

tować siatki czy obiekty w projekcji z kamery. To pozwala na użycie umieszczonych w tle tych kamer zdjęć 

w ten sam sposób, w jakich używasz planów samolotu (str. 407, 409). 

• W modelu możesz używać klonów całych kolekcji (nazywa się je „instancjami” – Instances). W tej sekcji 

użyliśmy ich do tworzenia odsuniętej osłony kabiny (str. 402) oraz jako łopat śmigła (str. 412). 

• Użyj mojego modyfikatora (zbudowanego z tzw. węzłów geometrii) o nazwie Surface Offset do tworzenia 

szczelin pomiędzy pokrywą i brzegiem otworu (str. 404). Surface Offset pozwala na użycie tej samej siatki 

do przycinania obydwu tych elementów (str. 407). Możesz importować jego definicję z jednego pliku Blen-

dera do drugiego (poleceniem File→Append…).    
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Szczegóły obsługi Blendera 3D 

W Blenderze jest tak dużo funkcji, że gdybym umieścił je w jednym rozdziale, tak samo jak polecenia GIMP czy 

Inkscape, byłby on wyjątkowo długi. Aby uczynić całość bardziej czytelną, podzieliłem te opisy na kilka mniej-

szych rozdziałów – po jednym dla każdego edytora Blendera. Największa grupa poleceń z okna 3D została 

podzielona na dwie części: jedną dla trybu Object Mode i drugą – dla trybu Edit Mode. 
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Rozdział 10. Blender – ogólne 

W tym rozdziale przedstawione są zagadnienia, które dotyczą więcej niż jednego okna (edytora) Blendera lub 

więcej niż jednego trybu pracy. 

 

Pomijam tu zagadnienia, które przedstawiłem wcześniej (Rozdział 3). Były to:  

• wprowadzenie do programu. Opisałem je już w sekcji 3.1 (str. 26); 

• metody zmiany projekcji (zoom, pan, obrót wokół obiektu). Opisałem je już w sekcji 3.5 (str. 67); 
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10.1 Instalacja standardowa 

Pobierz plik instalacyjny z http://www.blender.org/download (por. str. 21) i go uruchom (to wymaga uprawnień 

Administratora). Najpierw zobaczysz ekran powitalny, a następnie tekst umowy licencyjnej, którą powinieneś 

zaakceptować (Rysunek 10.1.1): 

           

Rysunek 10.1.1  Instalacja Blendera (dla Windows) – pierwsze dwa ekrany 

Następnie kliknij w oknie umowy przycisk Next,  aby przejść do dostosowania programu (Rysunek 10.1.2): 

           

Rysunek 10.1.2  Blender – opcje instalacji 

W oknie Change destination folder możesz zmienić katalog Blendera (lepiej jednak zostawić go bez zmian). 

Kliknij OK aby przejść do następnego okna, a następnie kliknij przycisk Install by rozpocząć (Rysunek 10.1.3): 

           

Rysunek 10.1.3  Finalne okno i pasek postępu instalacji 

Kliknij, by 
zaakceptować 

http://www.blender.org/download/
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Program instalacyjny umieści na pulpicie ikonę Blendera. Kliknij w nią, by uruchomić program (Rysunek 10.1.4): 

 

Rysunek 10.1.4  Ekran Blendera przy pierwszym uruchomieniu 

Podczas pierwszego uruchomienia Blender wykrywa sprzęt zamontowany w Twoim komputerze (głównie: kartę 

graficzną). To może trwać kilka minut. Potem będzie się uruchamiał o wiele szybciej – w kilka sekund. 

Jeżeli zainstalowałeś nowszą wersję (tzn. wykonujesz upgrade) na ekranie powitalnym pojawi się dodatkowy 

przycisk, który pozwala skopiować ustawienia z poprzedniej wersji Blendera (Rysunek 10.1.5): 

 

Rysunek 10.1.5  Ekran powitalny po upgrade 

Ten przycisk pojawia się 
tylko raz – po przy 
pierwszym uruchomieniu 
nowej wersji 
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Po aktualizacji, nie przeocz przycisku Load Settings. Pojawia się tylko przy pierwszym uruchomieniu! 

 
 Jeżeli już go przeoczyłeś, istnieje pewne obejście, pozwalające później przenieść te ustawienia (por. str. 435) – 

jest ono jednak o wiele bardziej złożone niż kliknięcie tego przycisku. 

Domyślnie, program instalacyjny umieszcza każdą nową wersję Blendera w odrębnym folderze katalogu 

Program Files\Blender Fundation. 

 

Jeżeli podczas instalacji pozostawisz te ustawienia bez zmian, będziesz mógł uruchomić także po-

przednie wersje Blendera (uruchamiając ich plik blender.exe). 

 
 Czasami zachowanie poprzednich wersji programu może być przydatne. (Na przykład: do sprawdzenia czy jakiś 

efekt, który zauważyłeś po aktualizacji, występował także w wersji poprzedniej). 
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10.2 Alternatywna metoda instalacji 

Ta sekcja opisuje instalację Blendera ze spakowanego pliku *.zip. Taki sposób instalacji jest często określany 

jako „przenośny” (ang. „portable”) – bo pozwala umieścić program gdziekolwiek – nawet na nośniku USB.  

Osobiście wolę tę metodę, bo zawsze chcę dokładnie wiedzieć, co się dzieje z ich komputerem1. Rzecz w tym, 

że Blender prawie „nie dotyka” reszty systemu. Dlatego najlepszym (jak uważam) sposobem instalacji Blendera 

jest rozpakowanie pliku *.zip. W ten sposób wiesz dokładnie, co robisz. Poniżej przedstawiam jak uaktualniam 

mojego Blender do nowej wersji. Jeżeli instalujesz go po raz pierwszy, pomiń Rysunek 10.2.2. 

Pobierz ze strony http://www.blender.org/download plik *.zip z Blenderem (Rysunek 10.2.1): 

 

Rysunek 10.2.1 Pobieranie pliku *.zip z Blenderem 

Zmień nazwę aktualnego folderu Blendera, dodając końcówkę z numerem wersji (Rysunek 10.2.2): 

 

Rysunek 10.2.2 Zmiana nazwy aktualnego folderu Blendera 

 
1 Dzięki temu przez lata używam tej samej instalacji Windows – nigdy nie musiałem ich instalować na nowo! I nawet z upływem czasu nie 

spowalniają swojego działania, jak to nieraz widziałem na komputerach innych użytkowników… 

Z listy rozwijalnej 
wybierz tę pozycję 

Zmień nazwę aktualnego 
folderu Blendera  

http://www.blender.org/


Rozdział 10 Blender – ogólne 421 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Pobrany plik *.zip rozpakuj do folderu C:\Program Files\Blender Foundation (Rysunek 10.2.3): 

  

Rysunek 10.2.3 Rozpakowanie plików Blendera 

Potem zmień nazwę rozpakowanego folderu na podstawową: Blender (Rysunek 10.2.4): 

                     

Rysunek 10.2.4 Zmiana nazwy folderu Blendera 

Jeżeli instalujesz Blendera po raz pierwszy, uruchom plik blender.exe, umieszczonym w tym katalogu (Rysunek 

10.2.5): 

 

 

Rysunek 10.2.5 Uruchomienie Blendera 

 

Oczywiście, wygodniej jest dodać skrót do tego pliku na pulpit i do menu Start (na pasku Windows). 

Będziesz mógł ich używać do uruchamiania Blendera – także po każdej takiej aktualizacji. 

 
 

Na swoim komputerze możesz używać jed-
nocześnie wielu wersji Blendera. Wystarczy 
każdą z nich umieścić w oddzielnym folderze 

To archiwum *.zip z 
blender.org zawiera 
pojedynczy folder 

Skopiuj ten folder z pliku 
*.zip do katalogu Program 
Files\Blender Foundation  
 

Uruchom 
ten program 
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Jeżeli instalujesz Blendera na tym komputerze po raz pierwszy, warto także przypisać ten program 

jako domyślny edytor plików o rozszerzeniu *.blend1. 

 
 Zwróć uwagę, że w przedstawionej tu metodzie aktualna wersja Blendera zawsze jest w tym samym folderze: 

Program Files\Blender Foundation\Blender. Dzięki temu wszystkie skróty (na pulpicie i menu Start) oraz skoja-

rzenia z plikami *.blend przenoszą się automatycznie na nową wersję Blendera – po upgrade nie musisz nic 

zmieniać. 

Chwilę po uruchomieniu zobaczysz okno Blendera wraz z ekranem powitalnym (Rysunek 10.2.6) – tak, jak to 

pokazuje sekcja 10.1 („Instalacja standardowa”): 

 

Rysunek 10.2.6 Ekran po uruchomieniu blender.exe 

Po aktualizacji do nowej wersji, okno powitalne Blendera wyświetli dodatkowy przycisk umożliwiający przenie-

sienie ustawień z wersji poprzedniej, jak to pokazuje Rysunek 10.1.5 na str. 418. 

 

 
1 To najwygodniej zrobić, gdy już zapiszesz jakąś scenę na dysku. Wystarczy wówczas w Eksploratorze Windows z menu kontekstowego 

wybrać polecenie Otwórz za pomocą… i wskazać blender.exe. Ci z Was, którzy mają nieco większe doświadczenie z Windows, mogą w 

Eksploratorze wywołać polecenie Narzędzia→Opcje folderów, i tam w zakładce Typy plików zmienić nazwę typu np. na „Blender file”. 
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10.3 Otwieranie pliku 

Wybierz polecenie File→Open z głównego menu Blendera (Rysunek 10.3.1): 

 

Rysunek 10.3.1 Wybór polecenia z menu 

To polecenia otwiera okno File View – Rysunek 10.3.2: 

 

Rysunek 10.3.2 Okno File View 

Jak widać, Blender ma własne okno do wskazywania pliku – jest to konsekwencja decyzji o zastosowaniu wła-

snego interfejsu użytkownika. Omówmy pokrótce jego obsługę.  

Znajdziesz w nim tą samą funkcjonalność jak w systemowym oknie dialogowym, a jego kontrolki wyglądają 

podobnie. Są tu przyciski do nawigacji wśród folderów, przycisk do tworzenia nowych katalogów, pasek opcji 

wyświetlania listy, filtr na typy plików, pole wyszukiwania (Rysunek 10.3.3): 

 
 

 

 

 

Rysunek 10.3.3 Elementy interfejsu użytkownika okna File View 

Menu główne  

Wybierz Open... 

Wybierz jeden 
z dysków … 

Skróty do 
„znanych” 
folderów 

… aby tu zobaczyć 
jego zawartość. 

Nawigacja po folderach: 
następny, poprzedni, nad-

rzędny, odśwież(widok) 

Układ listy 

Opcje 

polecenia 

Filtr na 
typ pliku 

Tworzy 

nowy folder 

Quick search (by name, 
in the current folder) 

Aktualna ścieżka  
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Pobierz towarzyszący tej książce plik la5.zip (por. str. 19) i rozpakuj jego zawartość do folderu o nazwie 

model\la5. Załóżmy że folder model znajduje się na dysku G:. Aby otworzyć plik E:\model\la5\la5.blend, wykonaj 

poniższe kroki: 

Wyświetl zawartość katalogu głównego dysku G: w oknie File View (Rysunek 10.3.4). Możesz go znaleźć w 

panelu Volumes lub po prostu wpisać „G:\” w pole ścieżki:  

 

Rysunek 10.3.4 Ustalenie katalogu 

Jeżeli bezpośrednio wpisałeś ścieżkę, naciśnij Enter  aby wyświetlić jej zawartość. Kliknij dwukrotnie (LPM) w 

folder model, aby go otworzyć. W podobny sposób przejdź do folderu la5 (Rysunek 10.3.5): 

 

Rysunek 10.3.5 Zawartość folderu model 

Kliknij w plik, który chcesz otworzyć – jego nazwa pojawi się w polu na nazwę pliku do otwarcia (Rysunek 

10.3.6). (Można było, oczywiście, wpisać ją z klawiatury, ale komu by się chciało...): 

          

Rysunek 10.3.6 Wybór i otworzenie pliku Blendera 

Blender zaznaczy wybrany plik niebieskim podświetleniem. Aby go otworzyć, kliknij przycisk Open. W zależno-

ści od mocy obliczeniowej Twojego komputera, może to zająć od jednej do paru sekund. 

 

Bieżąca ścieżka 

Przejdź do katalogu la5 … 

Kliknij ten przycisk aby 
otworzyć zaznaczony plik. 

Kliknij ten plik, aby go 
zaznaczyć. Jego nazwa 
pojawi się u dołu okna 
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Warto jeszcze wspomnieć o dwóch innych przydatnych poleceniach z menu File: 

• File→Open Recent: pozwala otworzyć jeden z dziesięciu ostatnio zapisywanych plików; 

• File→Recover Auto Save… Jeżeli masz w konfiguracji programu włączone okresowe zapisywanie ko-

pii pliku, tym poleceniem możesz go otworzyć po np. zawieszeniu programu. Więcej o odtwarzaniu da-

nych – str. 439. 
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10.4 Zapisanie pliku 

Aby zapisać aktualnie otwarty plik, wybieramy polecenie File→Save (Rysunek 10.4.1). Alternatywnie możesz 

nacisnąć na klawiaturze Ctrl - S  – to skrót do tego polecenia: 

 

Rysunek 10.4.1 Polecenie - zapisanie pliku 

Jeżeli chcesz zapisać plik pod inną nazwą, wybierz polecenie File→Save As. Analogicznie jak przy otwarciu 

pliku (por. str. 423), na ekranie pojawi się na chwilę okno wyboru pliku (Rysunek 10.4.2): 

 

 

 

 

Rysunek 10.4.2 Okno zapisu pliku 

Zwróć uwagę, że w polu z nazwą do zapisania domyślnie pozostaje oryginalna nazwa pliku. Aby zapisać go pod 

nową nazwą, musisz ją zmienić – wpisując z klawiatury lub klikając w inny plik (który chcesz nadpisać). Zapis 

pod nową nazwą nastąpi po naciśnięciu przycisku Save As Blender File. 

 
Osobiście używałem tego polecenia co najmniej raz dziennie – do zapamiętania kolejnej wersji pliku. Nazywa-

łem to „wersją dzienną”. Takie wersje bywają przydatne. Na początku pracy z Blenderem, zdarzało mi się po-

przestawiać dziesiątki parametrów i nie uzyskać oczekiwanego efektu. Czułem, że szukając rozwiązania za-

brnąłem w „ślepą uliczkę”. Wycofanie dokonanych zmian do stanu początkowego wyglądało często na bardzo 

pracochłonne, a czasami na praktycznie niemożliwe. O wiele prościej było zacząć jeszcze raz od „czystej” wer-

sji z poprzedniego dnia.  

Wybierz to polecenie 

(lub użyj Ctrl - S ) 

Ta gwiazdka oznacza, 
że aktualny plik zawiera 
niezapisane zmiany 

Czerwony kolor tego pola sygnalizuje, że plik 
o takiej nazwie już istnieje w tym folderze! 

Domyślne (czarne) tło tego pola oznacza brak 
konfliktu nazw. Teraz możesz zapisać ten plik 
bez obawy o nadpisanie istniejących danych! 

Blender otwiera okno File View i proponuje zapisa-
nie pliku w tym samym folderze, pod tą samą nazwą: 

Zmień proponowaną nazwę pliku 
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Twórcy Blendera z myślą o takich jak ja, dodali do okna zapisu pliku dodatkowy „gadżet”. Są to przyci-

ski [+], [-] po prawej stronie pola z nazwą pliku (Rysunek 10.4.2). Po kliknięciu, dopisują, zwiększają lub 

zmniejszają cyfrę (numer wersji) na końcu nazwy pliku (1, 2, 3, …). 

 
 Z innych poleceń, które warto wspomnieć: 

• Save Screenshot: zapisuje obraz aktualnego ekranu Blendera. Format obrazu (JPG, PNG, ...) ustala-

my w przyborniku z opcjami okna File View (por. str. 423, Rysunek 10.3.3) ;  

• Image→Save As Image: Polecenie menu edytorów UV/Image. W szczególności, możesz go użyć do 

zapisania wyrenderowanego, finalnego obrazu sceny. (Blender zawsze umieszcza taki plik w oknie 

Image Editor).  
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10.5 Ustawienie środowiska pracy 

Wygląd i szczegóły i działania programu (układ ekranu, kolory, skróty klawiatury, itd.) są wynikiem złożenia 

dwóch grup ustawień. Są to: 

• Ustawienia „ogólne” z okna Edit→Preferences. Są one przechowywane w pliku o nazwie 

userpref.blend. Te ustawienia nie są związane z jakimkolwiek aktualnym projektem (plikiem *.blend). 

Traktuj je jako konfigurację Twojej instancji Blendera. 

• Ustawienia „lokalne”, przechowywane w pliku Blendera (*.blend). Dotyczą one przede wszystkim in-

terfejsu użytkownika: układu okien, alternatywnych układów ekranu (workspaces). Gdy nie załado-

wałeś jeszcze żadnego pliku lub gdy tworzysz nowy plik poleceniem File→New, Blender wykorzystu-

je tzw. plik startowy, o nazwie startup.blend. Możesz ten wzorzec nadpisać poleceniem 

File→Defaults→Save Startup File. 

W pliku source.zip (por. str. 19) umieściłem foldery z konfiguracją Blendera, której używałem pisząc tę książkę. 

Aby przenieść je do Twojego Blendera wystarczy je skopiować do odpowiedniego folderu, jak to pokazuję na 

str. 436. Dodatkowo możesz także zainstalować wtyczki, których użyjemy w dalszych rozdziałach tej książki. 

Szczegóły znajdziesz na str. 443. Wymagane pliki Pythona (*.py) są w folderze source\scripts\addons. 

 
Poniżej pokazuję, jakie ustawienia domyślne Blendera zmieniłem w plikach towarzyszących tej książce. 

 

Niektóre z tych ustawień są opcjonalne. Te, które są niezbędne do prawidłowego podążania za tym 

poradnikiem, zaznaczam na ilustracjach na czerwono. 

 
 Zacznijmy od ustawień lokalnych w pliku wzorcowym (startup.blend): 

 

Rysunek 10.5.1 Przeniesienie zmian dokonanych w pliku startup.blend, dostarczonym z tą książką 

Wyłączyłem pasek opcji narzędzi w nagłówku okna 3D Viewport, ponieważ są one dostępne także w jednej z 

zakładek przybornika ( N ). Zmieniłem jednostki sceny na None gdyż sądzę, że ten „matematyczny” format zapi-

su liczb jest bardziej czytelny. (W naszym modelu po prostu zakładam, że 1 jednostka Blendera = 1 cal).  

Wyłącz pasek opcji aktualnego 
narzędzia (por. str. 32) 

Usuń (scal) obszar 
Timeline (por. str. 

Błąd! Nie 
zdefiniowano 

zakładki.) 

Usuń ten domyślny 

sześcian ( Delete ) 

W zakładce Scene 
przełącz jednostki 

na None 
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W sekcji Interface okna Edit→Preferences włączyłem wyświetlanie w pasku stanu informacji o liczbie zazna-

czonych obiektów. W Blenderze można całkiem łatwo przypadkowo zaznaczyć dodatkowy obiekt. Ten licznik 

pomoże w sprawdzaniu czy nie zrobiliśmy tego przed wywołaniem jakiegoś polecenia. Dodatkowo, wyłączyłem 

wygładzanie tekstów kontrolek. Wydaje mi się, że bez tej opcji są bardziej czytelne (Rysunek 10.5.2): 

 

       

Rysunek 10.5.2 Ustawienia Blendera – sekcja Interface 

W sekcji Editing włączyłem New Objects:Align To:View  oraz Link Materials To: Object  (Rysunek 10.5.3). Te 

dwie zmiany są krytyczne do poprawnego odtworzenia kroków opisanych w tej książce:  

 

Rysunek 10.5.3 Ustawienia Blendera – sekcja Editing 

Dodatkowo sugeruję wyłączyć opcję Cursor Surface Project z sekcji 3D Cursor. Gdy jest włączona i klikniesz 

ponad jakimś obiektem, aby przenieść w to miejsce kursor 3D, Blender umieści ten kursor na powierzchni jego 

siatki. W precyzyjnym modelowaniu mechanizmów ta opcja powoduje nieco zamieszania. 

W panelu Editors włącz 
opcję Scene Statistics 

(jest w sekcji Status Bar) Wyłącz wygładzanie 
liter w etykietach 

kontrolek 

Te dwa ustawienia są konieczne 
do odtworzenia tego, co opisuję 
w tym poradniku 

Wyłącz tę opcję 
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W sekcji Input – włączyłem opcję Emulate Numpad  (Rysunek 10.5.4). Jest to praktyczne przede wszystkim 

dla notebooków, ale także to na tradycyjnych komputerach: pozwala trzymać lewą rękę w centrum klawiatury. 

 

Rysunek 10.5.4 Ustawienia Blendera – sekcja Input 

W sekcji Navigation wybierz Trackball jako metodę obracania widoku, i włącz opcję Orbit Around Selection 

(Rysunek 10.5.5). To ułatwia „krążenie” wokół detali modelu: 

 

Rysunek 10.5.5 Ustawienia Blendera – sekcja Navigation 

W oknie pokazywanym przez Rysunek 10.5.5 możesz także przełączyć dwie opcje „Auto”: 

• Wyłącz Auto:Perspective. W precyzyjnym modelowaniu często używa się widoków ortograficznych, a 

ta opcja po każdej zmianie projekcji samoczynnie włącza tryb perspektywiczny. 

• Włącz Auto:Depth. Zapobiega tzw. „blokadom powiększenia” w widoku perspektywicznym.  

Włącz tę 
opcję 

Zapewnia pełną kontrolę 
and kierunkiem projekcji  Upraszcza 

“okrążanie” 
sceny 
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W panelu Keymap:Preferences sugeruję przypisać do klawisza spacji polecenie Tools. Zwróć uwagę, że w tej 

sekcji możesz znaleźć i przestawić wszystkie skróty Blendera (Rysunek 10.5.6): 

      

Rysunek 10.5.6 Ustawienia Blendera – sekcja Keymap 

Widać tu setki różnych skrótów, przypisanych do różnych edytorów. Oczywiście, w praktyce będziesz potrzebo-

wał z mienić tylko kilka z tych kombinacji myszki i klawiatury. Możesz tu wyszukiwać skróty po nazwie polece-

nia, które uruchamiają lub po klawiszu. Aby szukać skrótów z konkretnym klawiszem, wpisz w pole tekstowe 

jego znak (literę). Na przykład: S, jeżeli chcesz znaleźć wszystkie skróty używające klawisza S .  

Czasami możesz potrzebować stworzyć nowy skrót. Na przykład: zauważyłem, że nieświadomie staram się 

powiększyć widok w oknie 3D Blendera jak w Inkscape i GIMP-ie: używając Ctrl -KM . W Blenderze można zro-

bić to samo obracając samo KM , ale nic się nie działo, gdy towarzyszyło mu wciśnięty klawisz Ctrl . Dlatego 

zdecydowałem się dodać taki skrót do edytora 3D View(port) (Rysunek 10.5.7): 

 

 

Rysunek 10.5.7 Dodawanie nowego skrótu (klawiatury lub myszki)  

3D View dzieli się jeszcze na różne tryby, ale polecenia zmiany widoku są w dziale 3D View (Global). 

Użyj tego pola do filtrowania 
wg polecenia lub klawisza 

Wybierz 
tutaj Tools  

Ten przycisk dodaje nowy skrót  

Rozwiń sekcję odpowiedniego edytora 
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Wypełniłem pola definicji nowych skrótów wartościami, które znalazłem w domyślnych skrótach dla poleceń 

Zoom View:Wheel In/Out. Dodatkowo, włączyłem w nich opcję Ctrl (Rysunek 10.5.8) : 

 

Rysunek 10.5.8 Szczegóły definicji skrótu Ctrl -KM  

 

Jeżeli chcesz dodać lub zmienić skrót dla jakiegoś polecenia z menu, istnieje prostsza metoda. Wyko-

rzystaj w tym celu polecenie Assign Shortcut z menu kontekstowego (PPM) menu rozwijalnego.  

 
 Brzmi dziwnie? Otwórz menu kontekstowe kliknięciem PPM  na menu rozwijalnym (Rysunek 10.5.9): 

                                       

Rysunek 10.5.9 Prostsza metoda przypisywania skrótów  

Oczywiście, czasami zdarzają się bardziej złożone przypadki. Na przykład: podczas modelowania często prze-

łączam się pomiędzy różnymi środkami transformacji (to takie tryby Transformation Pivot Center jak Bounding 

Box czy 3D Cursor – por. str. 67). O wiele łatwiej jest wybrać te opcje z menu myszki niż z listy rozwijalnej 

umieszczonej w nagłówku okna 3D. Jednak domyślny skrót dla tego menu myszki (Pivot) to . . Jego użycie 

wymaga szerokiego ruchu lewą ręką (jestem praworęczny). Dlatego zdecydowałem, że potrzebuję skrótu który 

znajdowałby się bezpośrednio pod palcami lewej ręki w jej typowym położeniu, po lewej stronie klawiatury. 

Większość pojedynczych klawiszy jest już w Blenderze przypisana do różnych ważnych poleceń. Na szczęście 

udało mi się znaleźć klawisz nadający się do wykorzystania: ` . (Znajduje się w lewym, górnym rogu standardo-

wej klawiatury). Domyślnie, otwiera inne menu myszki (View). 

Zdecydowałem się zamienić te dwa skróty ze sobą, przypisując .  do menu View i `  do menu Pivot. Aby to zro-

bić, musiałem znaleźć definicje tych skrótów w sekcji Keymap. 

Skopiowałem wszystkie pola ze skrótu 
Zoom View: Wheel In do nowego wpisu 

Dodatkowo zaznaczyłem Ctrl  

Kliknij PPM  na 

pozycji menu 

Wybierz to 
polecenie 

Naciśnij klawisze 
dla nowego skrótu 
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Aby znaleźć definicję skrótu dla menu myszki Pivot, użyłem filtra wg nazwy polecenia, wpisując słowo „pivot” w 

polu wyszukiwania (Rysunek 10.5.10): 

 

Rysunek 10.5.10 Znajdowanie skrótów klawiszy wg części nazwy powiązanego polecenia  

Jak widać, skróty do menu Pivot są zdefiniowane dla czterech różnych edytorów. Dla zachowania spójności 

zdecydowałem się zmienić je wszystkie. 

Kliknij (LPM) w każdym z tych wpisów w pole z symbolem klawisza. W odpowiedzi Blender przełącza się w tryb 

„naciśnij klawisz”. Naciśnij nowy klawisz skrótu ( ` ), jak to pokazuje Rysunek 10.5.11: 

 

 

 

 

 

 

 

Rysunek 10.5.11 Zmiana klawisza skrótu 

Istnieje bardzo dużo poleceń Blendera, których nazwy zawierają słowo „view”. Dlatego zdecydowałem się szu-

kać skrótów do menu myszki View po jego aktualnym klawiszu. Przełączyłem się w tryb Key-Binding i wpisałem 

`  w pole filtra (Rysunek 10.5.12): 

 

Rysunek 10.5.12 Wyszukiwanie skrótów wg użytego klawisza 

  

Znalezione 
definicje skrótów 

Kliknij (LPM ) w tym polu 

Naciśnij nowy klawisz ( ` )  

Blender 
wyświetla 
taki tekst 

Przywraca 
domyślny 

skrót 

Wpisz `  by znaleźć 

skróty z tym klawiszem  

Zmień tylko ten wpis 
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Jak pokazuje to Rysunek 10.5.12, Blender wyświetla wszystkie skróty zawierające wskazany w filtrze klawisz 

(nie tylko sam ` , ale także jego kombinacje z Ctrl  i Shift ). Te definicje są pogrupowane wg przypisanych edyto-

rów. W tym przypadku potrzebowałem zmienić tylko skrót do menu View w edytorze 3D View(port). 

Nie bądź zdziwiony, gdy zmodyfikowany wpis zniknie z takiej odfiltrowanej listy (Rysunek 10.5.13): 

 

 

 

Rysunek 10.5.13 Zmiana skrótu na liście odfiltrowanej wg klawisza 

To normalne – po zmianie klawisza znajdziesz ten zapis po zastosowaniu innego filtra ( . ).  

 

*        *        * 

 

W sekcji System (Rysunek 10.5.14) możesz włączyć jedną z opcji równoległego przetwarzania danych, o ile są 

one obsługiwane przez Twój procesor graficzny:  

 

Rysunek 10.5.14 Ustawienia Blendera – sekcja System 

To ustawienie silnika renderującego (Cycles). Jeżeli Twój komputer jest wyposażony w nowoczesną kartę gra-

ficzną NVIDIA, włącz opcje CUDA i OptiX. 

Możesz także zwiększyć liczbę Undo Steps. Domyślna wartość – 32 – bywa czasami niewystarczająca. 

 

Kiedy wpiszesz tu . , 

ten zapis zniknie, ale 
Blender wyświetli przy-

cisk Restore 

Skrót zniknął z listy, bo jego 

nowy klawisz ( . ) nie pasuje 

do aktualnego filtra ( ‘ ) 

If you have an NVIDIA graphics 
card, enable it in the CUDA and 
OptiX sections 

You can also increase 
the default number of 
undo steps (32) 
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10.6 Pliki konfiguracji Blendera 

Gdy użyjesz polecenie File→Defaults→Save Startup File, lub zmienisz jakąś opcję w oknie Preferences, Blen-

der zapisze w Twoim profilu użytkownika zmienioną konfigurację. W Windows możesz znaleźć te dane w kata-

logu AppData (znajduje się w Twoim profilu użytkownika). To miejsce jest także wyświetlane pod nazwą „Dane 

Aplikacji”. Blender przechowuje swoje pliki w podkatalogu AppData/Roaming/Blender Foundation/Blender. 

W pliku source.zip (por. str. 19) przygotowałem skrót o nazwie Blender configuration. Wykorzystuje zmienną 

środowiskową Windows (APPDATA) by otworzyć w Eksploratorze Windows Twój folder z konfiguracją Blendera 

(Rysunek 10.6.1): 

           

Rysunek 10.6.1 Otwarcie folderu na konfiguracje Blendera  

Każda z wersji Blendera przechowuje tu swoje pliki w oddzielnym katalogu (Rysunek 10.6.1). Dzięki temu mo-

żesz z nich korzystać jednocześnie (np. aby sprawdzić, jak coś działało poprzednio). Gdy instalujesz nową wer-

sję programu, przy pierwszym uruchomieniu Blender proponuje skopiowanie konfiguracji z wersji poprzedniej. 

 
Wewnątrz katalogu każdej wersji znajdują się dwa foldery: 

 
- config\: zawiera dwa ważne pliki (Rysunek 10.6.2) Pierwszy z 

nich nazywa się userpref.blend. Są w nim przechowywane 

wszelkie ustawienia z okna Preferences. Drugim plikiem jest 

startup.blend. Zawartość tego pliku Blender wyświetla bezpo-

średnio po uruchomieniu, lub gdy wybierzesz polecenie 

File→New. Plik startup.blend determinuje m.in. domyślny 

układ ekranu Blendera Możesz go zastąpić jakimś bieżącym 

rysunkiem (Służy do tego polecenie File→Defaults→Save 

Startup File). 

 
- scripts\addons\: w folderze addons Blender przechowuje do-

datki (add-ons) zainstalowane przez użytkownika (Rysunek 

10.6.3, por. także str. 443). Dzięki temu podczas aktualizacji 

są przenoszone z całą konfiguracją do nowej wersji programu. 

  

  

 

Rysunek 10.6.2 Zawartość folderu config  

 

 

 

Rysunek 10.6.3 Zawartość scripts\addons 

Wtyczki, zainstalowane 
przez użytkownika 

Wzorcowy (domyślny) 
plik Blendera 

Konfiguracja 
Blendera 

Ten link otwiera nowe okno 
Windows Explorer, które 
wyświetla folder z konfigura-
cją Blendera  

Każda wersja Blendera 
ma swój własny podka-
talog z konfiguracją 

Struktura wewnętrzna 
każdego z tych katalo-
gów jest identyczna 
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W operowaniu konfiguracją Blendera nie ma żadnej „ukrytej magii” . Wystarczy zmieniać odpowiednie pliki. Na 

przykład, instalację grupy dodatków (add-on), możesz wykonać na dwa sposoby: 

• Prosty: używając GUI Blendera (tak jak to jest opisane na str. 443) – ale wtedy musisz wgrywać po kolei 

każdą wtyczkę. 

• Zaawansowany: jednym ruchem skopiować wszystkie pliki wtyczek do podkatalogu scripts\addons\ fol-

deru z konfiguracją Blendera. Wymaga to tylko wiedzy, gdzie ten folder się znajduje, i za pierwszym ra-

zem należy po prostu tam założyć takie podkatalogi. 

 

Możesz się przełączać pomiędzy się różnymi konfiguracjami Blendera – wystarczy przechowywać pod 

inną nazwą lub w innym miejscu alternatywne pliki userpref.blend i startup.blend. Gdy skopiujesz do 

folderu config\ ich nowe wersje – Blender posłuży się nimi przy najbliższym uruchomieniu. 

 
 Abyś mógł podążać za przykładami umieszczonymi w tej książce, w pliku source.zip dostarczyłem podkatalogi 

config i scripts z odpowiednią konfiguracją Blendera. Na wszelki wypadek najpierw skopiuj wszystkie pliki z 

Twoją oryginalną konfiguracją w jakieś inny miejsce. Potem po prostu przenieś odpowiednie te dwa podkatalogi 

z source.zip do folderu z konfiguracją Twojej aktualnej wersji Blendera (Rysunek 10.6.4): 

 

        

 

 

Rysunek 10.6.4 Przeniesienie konfiguracji Blendera, wymaganej dla tej książki  

Wygląda na to, że Blender akceptuje pliki konfiguracji utworzone w poprzedniej wersji (jest wstecznie zgodny). 

Jest tylko jeden mały problem: skopiowane wtyczki są początkowo wyłączone (widać to w oknie 

Edit→Preferences, por. Rysunek 10.6.5): 

 

Rysunek 10.6.5 Skopiowane wtyczki (add-ons)  

W tym oknie możesz włączyć skopiowane wtyczki (wystarczy zaznaczyć pole z lewej strony nazwy). 

Skopiuj te dwa foldery z archiwum 
source.zip do folderu z konfiguracją 
aktualnej wersji Blendera 

source.zip Katalog z konfiguracjami Blendera 

Wybierz tę opcję, by widzieć tylko 
wtyczki dodane przez użytkownika 

Kliknij tutaj, aby aktywować wtyczkę 
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10.7 Import obiektów z innego pliku Blendera 

Aby wstawić do aktualnej sceny obiekty z innego pliku, wybierz polecenie File→Append (Rysunek 10.7.1a): 

        

Rysunek 10.7.1 Polecenie - import elementów innego pliku 

Na ekranie pojawi się okno wyboru plików 

(Rysunek 10.7.1b). Przejdź w nim do folderu 

z plikiem, z którego coś chcesz wczytać 

(Rysunek 10.7.2). W naszym przypadku to 

pilot.blend z folderu model\p40\ (por. str. 19).  

 

 

W trybach Append lub Link możesz w oknie wyboru pliku wejść „do środka” rysunku Blendera, jak gdyby był 

podkatalogiem (klikając LPM ). W środku zobaczysz „foldery” (Rysunek 10.7.3a): 

 

Rysunek 10.7.3 Wybór elementów do importu 

Te „foldery” to klas obiektów, przechowywanych w rysunku Blendera. To taka konwencja – zawartość każdego 

pliku *.blend jest wyświetlana, jak gdyby jej struktura była przedłużeniem struktury katalogów i plików na dysku.  

Przejdź do folderu Object (zazwyczaj importujemy obiekty – Blender sam zadba o to, by przeniosły się za nimi 

wszystkie siatki, materiały i tekstury). W środku zobaczysz wszystkie obiekty, znajdujące się w pliku pilot.blend 

(Rysunek 10.7.3b). Aby ułatwić wybór, elementom składającym się na model pilota nadałem przedrostek „000.”. 

 

Rysunek 10.7.2 Wybór pliku, z którego chcesz coś wczytać 

... a otworzy 
się okno 
File View 

Należy kliknąć LPM  by 

wejść do wnętrza folderu 

a) 
b) 

Kliknij LPM , by wejść 

do środka tego pliku 

Wywołaj to 
polecenie… 

a) b) 

Zaznacz (klikając LMB ) 

obiekty, które chcesz 
wczytać, a potem naci-
śnij przycisk Append  

Zawartość 
pliku Blen-

dera 

Otwórz 
Object 

Możesz użyć pola filtra do 
wyszukiwania wg nazwy 
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Pozaznaczaj je tak, jak to się robi w eksploratorze plików Windows: klikniecie LPM  zaznacza pojedynczy obiekt, 

Shift -LPM  zaznacza cały zakres. 

Potem naciśnij przycisk Append. Blender automatycznie zadba o importowanie wszystkich bloków danych po-

wiązanych z zaznaczonymi obiektami: siatek, materiałów i tekstur, których używają. 

W efekcie pilot pojawi się w aktualnej scenie (Rysunek 10.7.4): 

 

Rysunek 10.7.4 Model pilota, wczytany do aktualnej sceny 

Użyliśmy tu polecenia Append, które wstawia do aktualnego pliku kopie wybranych elementów. Gdybyś wybrał 

alternatywne polecenie Link  – do aktualnej sceny wstawione zostałyby tylko „odsyłacze” (referencje) do obiek-

tów umieszczonych we wskazanym pliku Blendera (w tym przykładzie byłby to pilot.blend). Możesz w ten spo-

sób wykorzystywać pewne pliki *.blend jako biblioteki. Przechowywałbyś w nich wzorce elementów wykorzysty-

wanych w wielu różnych projektach. Gdybyś zmienił definicję takiego „odsyłacza” – uległby zmianie wszędzie 

tam, gdzie jest użyty. Podłączać w ten sposób możesz nie tylko całe obiekty, ale – na przykład – same siatki. 

Wymaga to jednak przemyślanej struktury projektu. Poza tym – nie można modyfikować takich „podłączonych” 

elementów tam, gdzie są użyte. W praktyce często kończy się to i tak stworzeniem ich lokalnej kopii. 

Zaraz po wczytaniu, 
wszystkie zaimportowane 

obiekty są zaznaczone 
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10.8 Kopia bezpieczeństwa i odtwarzanie 

To zdarza się bardzo rzadko, ale gdy Blender zgłasza „fatalny” błąd i się zamyka, nie popadaj w rozpacz. W 

domyślnej konfiguracji opcja Auto Save jest włączona, więc możesz jeszcze odzyskać swoją pracę. Uruchom 

ponowie Blender, a następnie wywołaj polecenie File→Recover→Auto Save (Rysunek 10.8.1): 

 

Rysunek 10.8.1 Wywoływanie funkcji odzyskiwania pliku 

Blender otworzy wówczas w oknie File View Twój folder tymczasowy (Rysunek 10.8.2): 

 

Rysunek 10.8.2 Wybór pliku do odzyskania 

Funkcja Auto Save Blendera zapisuje kopię Twojego bieżącego pliku w systemowym katalogu na pliki tymcza-

sowe. Ta kopia nosi nazwę Twojego pliku, z dodatkowym przyrostkiem numerycznym1. Pliki w oknie File View w 

ilustracji powyżej są uporządkowane wg daty/czasu, w porządku malejącym. Przypuszczalnie pierwszy od góry 

plik pochodzi sprzed ostatnich kilku minut – i to jest ten, którego szukamy! Zaznacz go (kliknięciem) a potem 

naciśnij przycisk Recover Auto Save. Gdy się przekonasz, że to jest właściwy rysunek, zapisz go pod inną 

nazwą w tym samym folderze, w którym trzymasz poprzednie wersje swoich prac. Potem po prostu pracuj dalej. 

Pliki, odzyskane w ten sposób, są zupełnie normalne – bez żadnych luk w danych czy innych skaz. 

 

Każda uruchomiana instancja Blendera tworzy kopię Twojego pliku w katalogu tymczasowym. Następ-

nie uaktualnia ją co dwie minuty. Dzięki temu nie zajmuje za dużo miejsca na dysku. 

 
1 Jest to tzw. „identyfikator procesu” (ang. process ID – skrót: PID) – id nadawane każdemu procesowi przez system operacyjny. 

Wybierz (kliknij) pierwszy plik. To rezultat 
ostatniej operacji Auto Save – najprawdopo-
dobniej to jest plik, który chcesz odzyskać 
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Jeżeli chciałbyś zmienić ustawienia tych kopii bezpieczeństwa, znajdziesz je w oknie Preferences, sekcji Save 

& Load (Rysunek 10.8.3): 

 

Rysunek 10.8.3 Ustawienia funkcji Auto Save 

Pole wyboru Auto Save włącza/wyłącza tę funkcję. Wartość w polu Timer określa interwał czasu dla zapisywa-

nia kopii aktualnego pliku Blendera. 

Domyślnie te kopie są zapisywane w katalogu na pliki tymczasowe w Twoim profilu użytkownika. Jednak mo-

żesz zmienić to ustawienie w sekcji File Paths (Rysunek 10.8.4): 

 

Rysunek 10.8.4 Ustawienia w sekcji File Paths 

Pusta wartość Temporary Files oznacza użycie domyślnego katalogu systemu dla plików tymczasowych. 

Włącza funkcję 
Auto Save 

Interwał pomiędzy 
kolejnymi kopiami 

Kopie bezpieczeństwa są 
zapisywane w tym katalogu 
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10.9 Zarządzanie układami ekranu (workspaces) 

Blender domyślnie proponuje kilka różnych układów ekranu (workspace), przygotowanych do różnych faz pracy 

nad projektem. Są wyświetlane jako zakładki w górnym pasku ekranu (Rysunek 10.9.1): 

 

  

Rysunek 10.9.1 Menu Workspace 

Kliknij którąś z tych zakładek, aby przełączyć się na alternatywny układ ekranu. Istnieją dwa menu zarządzające 

tymi układami. Pierwszym z nich jest menu kontekstowe zakładki (menu 1, Rysunek 10.9.1). Możesz je otwo-

rzyć kliknięciem PPM  na odpowiedniej zakładce. Znajdziesz tam polecenia kopiowania (Duplicate) i usuwania 

(Delete) zakładki, a także polecenia zmieniające kolejność zakładek (Reorder to Front | Reorder to Back). 

Inne menu (menu 2) dodaje nowe zakładki do projektu. Otworzysz je kliknięciem LPM  w zakładkę [+]. 

Jeżeli wybierzesz polecenie Duplicate Current lub Duplicate z menu 1, Blender stworzy kopię wskazanej za-

kładki (Rysunek 10.9.2a): 

                 

 

 

 

                 

 

Rysunek 10.9.2 Dodanie własnego układu ekranu 

Blender kopiuje związany z zakładką układ ekranu i dodaje numeryczny przyrostek („.001”) do jego nazwy. Aby 

go zmienić, kliknij dwukrotnie (LPM) w tę zakładkę. To przełącza to pole w tryb edycji (Rysunek 10.9.2b). 

Aktualny układ ekranu Inne układy ekranu 

Dodaje nową 

zakładkę  
LPM  

 
PPM 

Menu 
zakładki 

To samo 
polecenie Usuwa tę 

zakładkę 

Sterowanie głównym 
menu Blendera 

Predefiniowane 

układy ekranu 

1 

2 

a) 

b) 

… a Blender stworzy kopię 
tego układu ekranu. 

Kliknij dwukrotnie (LPM ) 

aby zmienić tę nazwę…    
… i wpisz tutaj nową 
nazwę dla tej zakładki  

Wybierz Duplicate… 
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Potem możesz już go pozmieniać, jak chcesz (Rysunek 10.9.3): 

 

Rysunek 10.9.3 Nowy układ ekranu: General 

Oczywiście, jeżeli nie będziesz zadowolony ze swojego układu – zawsze możesz go usunąć. Wystarczy wywo-

łać polecenie Delete z jego menu kontekstowego (Rysunek 10.9.1, menu 1). Gdy to zrobisz, znajdziesz się w 

poprzednim układzie (w tym przykładzie byłby to Layout). 

 

Blender przed usunięciem układu ekranu nie zadaje żadnego pytania typu „jesteś pewien?”! 

 
Z drugiej strony – usuwając zakładkę, usuwasz tylko okno/okna do Twojej sceny. Wszystkie inne obiekty i usta-

wienia pozostają bez zmian. 

Układy ekranów są zachowywane w pliku projektu Blendera (*.blend). Na przykład, w plikach stworzonych w 

Blenderze 2.7 znajdziesz inny zestaw układów ekranu niż przedstawiony w tej sekcji. 

 

Aby stworzyć układ, którego będziesz używać we wszystkich swoich rysunkach, musisz zapisać go do 

pliku startowego, poleceniem File→Defaults→Save Startup File (por. str. 428). 

 

To jest nowy 
układ ekranu o 
nazwie General 
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10.10 Instalacja i usuwanie dodatków (add-ons) 

Benderowi towarzyszy dużo dodatków rozszerzających jego funkcjonalność. Są to skrypty napisane w języku 

programowania Python, zazwyczaj przez samych użytkowników. Dodatki to zazwyczaj niewielkie pliki z rozsze-

rzeniem *.py. Oprócz tych, które są dostarczane wraz z Benderem, możesz znaleźć inne np. na forach Blendera 

w Internecie. Także do tej książki dodałem kilka narzędzi, które wykorzystuję od lat i uważam za bardzo przy-

datne i godne polecenia (znajdziesz je w pliku source.zip, w scripts\addons – por. str. 19). Instalacja dodatku 

Blendera może polegać na wgraniu pliku wtyczki do odpowiedniego podkatalogu w folderze z konfiguracją pro-

gramu (por. str. 435). Jeżeli jednak nie czujesz się w tej materii zbyt pewnie, pokażę tutaj inną, mniej „hakerską” 

metodę. W oknie Preferences, sekcji Add-ons, naciśnij przycisk Install… (Rysunek 10.10.1): 

 

Rysunek 10.10.1 Wywołanie instalacji dodatku (okno User Preferences) 

Blender wyświetli wówczas okno File View Przejdź w nim do katalogu, w którym umieściłeś dodatki do zainsta-

lowania, wskaż jeden z nich, i naciśnij przycisk Install Add-on (Rysunek 10.10.2): 

 

Rysunek 10.10.2 Wybór pliku skryptu do zainstalowania 

Kliknij ten przycisk 

1. Zaznacz plik, który 
chcesz zainstalować  

2. Kliknij w 
ten przycisk 
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W oknie File View wskazuj zawsze tylko jeden skrypt! Choć Blender w tym oknie pozwala zaznaczyć 

wiele plików dodatków, to zainstaluje tylko jeden – ten, który zaznaczyłeś jako ostatni. 

 
 Dodatek jest już zainstalowany. Abyś ją dostrzegł wśród innych, Blender przełączył wyświetlane kategorie na All 

i w polu filtra wpisał jego nazwę (Rysunek 10.10.3): 

 

 

Rysunek 10.10.3 Wygląd okna Preferences po zainstalowaniu dodatku (Handle Panel) 

W razie czego nie bądź przerażony, że z Blendera znikły wszystkie pozostałe dodatki. Wystarczy usunąć filtr 

(Rysunek 10.10.4): 

 

Rysunek 10.10.4 Wygląd okna Preferences po usunięciu filtra 

Aby zobaczyć tylko wtyczki, które sam dodałeś, wybierz kategorię User (Rysunek 10.10.5): 

 

Rysunek 10.10.5 Lista wtyczek zainstalowanych przez użytkownika 

Zainstalowany 
dodatek 

Na liście nie widzisz żadnych innych 
pozycji, ponieważ Blender umieścił 
w filtrze nazwę dodanej wtyczki! 

 

Kliknij tutaj, aby go 
włączyć (aktywować) 

Wystarczy wyczyścić pole filtra, 
by wszystkie się pojawiły! 

Kategoria User to wtyczki 
dodane przez użytkownika 
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Aby usunąć dodatek z Blendera, po prostu naciśnij jej przycisk Remove (Rysunek 10.10.6): 

 

Rysunek 10.10.6 Usuwanie dodatku 

 

 

Nieprzemyślanym kliknięciem w Remove możesz stracić plik wtyczki, jeżeli nie masz jego kopii gdzieś 

indziej. W większości przypadków lepszym pomysłem jest jej dezaktywacja (wyłączenie pola z lewej 

strony nazwy). 

 
 

Kliknij ten przycisk. To usuwa plik 
wtyczki z folderu Blendera 

Rozwiń panel wtyczki 
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10.11 Używanie „miarki” (Measure) 

Narzędzie Measure jest dostępne wśród ikon paska narzędzi w trybach Object Mode i Edit Mode. Włącz je, gdy 

chcesz sprawdzić odległość na swojej scenie. Następnie naciśnij LPM  na początku mierzonego dystansu i prze-

ciągnij myszkę. Blender podąża za tym ruchem rysując „linijkę” i wyświetlając jej długość (Rysunek 10.11.1a): 

      

Rysunek 10.11.1 Pomiar odległości 

Blender kończy tę linię w punkcie, w którym zwolnisz LPM  (Rysunek 10.11.1b) ). Zmierzona długość jest wy-

świetlana w jej środku. Zwróć uwagę, że kursor myszki zmienia się w ikonę „czterech strzałek” gdy przesuwasz 

go ponad końcami linii (Rysunek 10.11.1b). To sygnalizuje, że możesz „złapać” ( LPM) i przeciągnąć taki koniec 

w inne miejsce (na przykład: aby coś dokładniej zmierzyć).  

Aby mierzyć kąty, wstaw w środek linii dodatkowy punkt (Rysunek 10.11.2a) 

 

 

Rysunek 10.11.2 Pomiar kąta 

Następnie przesuń ten środek „kątomierza” w środek mierzonego kąta (Rysunek 10.11.2b). 

1. Wybierz 

to narzędzie 

2. Naciśnij 
tu LPM   

3. Przeciągnij 
myszkę 

4. Zwolnij 
myszkę Możesz “złapać” 

i przesunąć 
koniec tej linii 

Zmierzona 
odległość  

a b 

a 

b 

1. „Wyciągnij” nową 
linię pomiarową 

2. Kliknij po-
środku LPM   

3. Przeciągnij (LPM ) środek tego 

„kątomierza” w miejsce docelowe 

Wielkość kąta 
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Wszystkie te „linijki” i „kątomierze” stają się widoczne, gdy włączysz narzędzie Measure. W tym trybie nadal 

możesz zaznaczać obiekty lub wierzchołki i wywoływać różne polecenia transformacji (Move, Rotate, Scale, …). 

Niestety, Blender ukrywa wszystkie naniesione na scenę „miarki” gdy wywołasz jedną z tych transformacji i po-

kazuje je z powrotem po ich zakończeniu.  

Aby usunąć umieszczoną w scenie „linijkę” lub „kątomierz”, zaznacz ją klikając w jeden z jej końców (kiedy kur-

sor myszki zmienia się na „poczwórną strzałkę”, jak to pokazuje Rysunek 10.11.3) . Wtedy naciśnij klawisz X : 

      

Rysunek 10.11.3 Usunięcie wybranej linijki  

 

Czasami możesz niechcący zaznaczyć i usunąć zwykły obiekt znajdujący się za taką „miarką”. To się 

zdarza, gdy klikniesz obok “linijki” lub “kątomierza”, który chcesz usunąć. (Zwracaj uwagę na kształt 

kursora myszki!) W takim przypadku użyj polecenia Edit→Undo ( Ctrl - Z ). 

 
 Możesz także usunąć wszystkie takie „miarki” ze sceny poprzez usunięcie wszystkich tzw. „adnotacji” stworzo-

nych przez Measure. Znajdziesz je w panelu View:Annotations w przyborniku (Rysunek 10.11.4): 

 

Rysunek 10.11.4 „Adnotacje” do sceny, stworzone przez narzędzie Measure 

 

Szczegółowy opis narzędzia do pomiarów w Blenderze znajdziesz w sekcji "Editors: 3D Viewport: Tool-

bar: Measure" instrukcji Blendera.  

 
Delete  lub X  

Zaznacz tę linię 
klikając (LPM ) 

jeden z jej końców 

Linia usunięta 

Przybornik ( N ) 

Wszystkie takie 
miarki są częścią 

tej „adnotacji” 

Kliknij tutaj by 
usunąć wszystkie 
„miarki” ze sceny 

https://docs.blender.org/manual/en/latest/editors/3dview/toolbar/measure.html
https://docs.blender.org/manual/en/latest/editors/3dview/toolbar/measure.html
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10.12 Kolekcje – zarządzanie 

Kolekcje w Blenderze przypominają warstwy w Inkscape czy GIMP. Używaj ich do łączenia obiektów sceny w 

grupy ułatwiające ich odnajdowanie lub ukrywanie.  

W przykładach pokazywanych w prostej sceny zawierającej 3 obiekty geometryczne: sześcian Cube, kulę 

Sphere i stożek Cone, oraz dwóch obiektów pomocniczych: Camera i Light (Rysunek 10.12.1): 

 

Rysunek 10.12.1 Scena używana w tej sekcji 

Początkowo wszystkie te obiekty są w pojedynczej kolekcji o nazwie Collection. W większości przypadków do 

obsługi kolekcji będziemy wykorzystywać okno Outliner, a czasami także okno 3D. 

Aby dodać nową kolekcję, podświetl kolekcję, w której chcesz ją stworzyć, a następnie kliknij w przycisk [+] w 

nagłówku okna Outliner (Rysunek 10.12.2a): 

                         

                         

Rysunek 10.12.2 Dodanie nowej kolekcji 

Blender umieszcza nową kolekcję wewnątrz zaznaczonej. Początkowo otrzymuje ona automatyczną, nazwę (w 

tym przypadku to Collection 2). Kliknij podwójnie w tę etykietę (Rysunek 10.12.2b) aby tę nazwę zmienić (w 

tym przykładzie na: Objects). 

Camera 

Light 

Outliner Okno 3D 

2. Kliknij ten 
przycisk 

1. Zaznacz 
kolekcję – 
„rodzica” Nowa 

kolekcja 

a) 

b) 

Kliknij podwójnie (LPM ) 

by zmienić nazwę 

Zmieniona 
nazwa 

kolekcji 

Cube 
Sphere 

Cone 
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Jeżeli chcesz przenieść kolekcję, „złap ją i przeciągnij” w nowe miejsce (Rysunek 10.12.3): 

                       

Rysunek 10.12.3 Przenoszenie kolekcji w oknie Outliner  

Zwróć uwagę, że gdy przesuwasz tę kolekcję, Blender sygnalizuje podświetleniami co się stanie, jeżeli zostanie 

„upuszczona” w aktualnym miejscu. 

Aby przenosić obiekty pomiędzy kolekcjami, można je w oknie Outliner „łapać i przeciągać”, tak jak kolekcje. 

Istnieje także inna metoda: w oknie 3D zaznacz obiekty, które chcesz umieścić w innej kolekcji i naciśnij skrót 

M  (Object→Collection→Move to Collection) . To otwiera „wyskakujące” (popup) menu, w którym możesz 

wskazać docelową kolekcję (Rysunek 10.12.4): 

 

Rysunek 10.12.4 Przenoszenie obiektów pomiędzy kolekcjami 

 

Używając skrótu M  nie musisz wiedzieć, jakie są aktualne kolekcje zaznaczonych obiektów. To często 

jest zaleta, szczególnie gdy w oknie Outliner są one rozproszone w wielu miejscach struktury projektu. 

 
 Aby ukryć zawartość kolekcji w oknie 3D, przełącz ikonkę „oka” z jej prawej strony (Rysunek 10.12.5): 

 

Rysunek 10.12.5 Ukrywanie kolekcji 

Szeroki pasek = 
umieść w środ-
ku tej kolekcji Przeciągnij (LPM ) 

tę kolekcję 

Cienka linia = 
umieść przed 
tą kolekcją 

3. Wybierz ko-
lekcję docelową 

2. Naciśnij M  by 

otworzyć menu 

Alternatywnie, możesz prze-
ciągnąć te obiekty w nowe 
miejsce struktury projektu 

1. Zaznacz 
obiekty 

Kliknij w tę ikonkę, 
aby ukryć/wyświetlić 
obiekty z tej kolekcji 
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W podobny sposób możesz przełączać widoczność pojedynczego obiektu (Rysunek 10.12.6): 

         

Rysunek 10.12.6 Zmiana widoczności pojedynczego obiektu 

 

Obiekty z ikonką zamkniętego “oka” będą nadal obecne na finalnym obrazie sceny. Aby wyłączyć obiekt 

lub całą kolekcję z renderowania, przełącz jej ikonę „kamery”. 

 
 Dokumentacja Blendera nazywa te ikony „restriction toggles”. Oprócz „oka” i „kamery” są także inne. Możesz 

sterować ich wyświetlaniem w oknie Outliner za pomocą jego arkusza rozwijalnego Filter (Rysunek 10.12.7): 

 

Rysunek 10.12.7 Zmiana widoczności ikon sterujących w arkuszu Filter 

W praktyce używałem tylko ikon 2, 3 i 5. Opcje 6 i 7 dotyczą tylko renderera Cycles. Odkryłem, że po włączeniu 

opcji 2 zdarzało mi się niechcący wyłączyć ją dla kolekcji lub pojedynczego obiektu. Potem odkrycie, dlaczego 

nie mogę zaznaczyć jakiegoś obiektu, wymagało dłuższej chwili. Dlatego nie włączam wyświetlania tej kontrolki. 

 

W tym projekcie będę używał tylko dwóch z tych przełączników: 3 (“oko”) i 5 (“kamera”). 

 
 Dlatego w tym panelu Filter możesz wyłączyć opcję 1 (Hide in View Layer). 

Jak widać powyżej, panel Filter zawiera także dużo innych przełączników. Na przykład – możesz włączyć auto-

matyczną kolejność obiektów w kolekcji (Sort Aplhabetically). Czasami to się przydaje. 

 

Struktura sceny Blendera jest hierarchiczna. Dlatego zmiana którejś z tych ikon (np. „oka”) w kolekcji 

nadrzędnej dotyczy wszystkich zawartych w niej jej obiektów i kolekcji. 

 
 Możesz używać kolekcji Blendera do sterowania widocznością obiektów. Rób to w podobny sposób do tego, w 

jaki używałeś warstw w programach rysunkowych 2D. 

Kliknij w tę ikonę by 
przełączyć widoczność 
obiektu Sphere 

1. Uwzględnij w View Layer 
(dotyczy tylko kolekcji) 

Filter dropdown 

2. Obiekty można zaznaczać  

3. Pokaż w oknie 3D 
4. Włącz (globalnie) w 
oknach 3D 

5. Renderowany 

6. Wstrzymaj (Holdout) 

7. „Tylko pośredni” 
(Indirect only) 
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Od czasu do czasu, w dużych scenach, możesz chcieć zidentyfikować kolekcję jakiegoś obiektu, który widzisz 

w oknie 3D. Znajdziesz ją w oknie Properties, panelu Object:Collections (Rysunek 10.12.8a): 

   

Rysunek 10.12.8 Identyfikacja kolekcji, do której należy obiekt 

Rysunek 10.12.8b) pokazuje dodatkowe wyjaśnienie tego przypadku. Widać w nim aktualne położenie tego 

obiektu w hierarchii kolekcji sceny. Jak widzisz, podzieliłem Objects na dwie subkolekcje: Circular i Angular. 

Obiekt Sphere należy do kolekcji Circular. 

Dlaczego nazwa tej paneli (Collections) jest liczbą mnogą? Ponieważ obiekt Blendera może należeć do więcej 

niż jednej kolekcji. Popatrz na przypadek pokazywany przez Rysunek 10.12.9: 

  

Rysunek 10.12.9 Obiekt należący do dwóch kolekcji 

Dokumentacja Blendera opisuje taką relację jako (powiązanie) (linking), tzn. obiekt Cone jest powiązany z 

dwoma kolekcjami. W oknie Outliner możesz stworzyć takie powiązanie trzymając wciśnięty klawisz Ctrl  pod-

czas przesuwania obiektu do nowej kolekcji. W oknie 3D użyj skrótu Shift - M  (do Object→Collection→Link to 

Collection). Obsługa wygląda tak samo jak Move to Collection, pokazany przez Rysunek 10.12.4. 

 

W moich projektach większość obiektów należy do pojedynczej kolekcji. Jednak w kilku przypadkach 

używam tej funkcjonalności dodatkowych powiązań.   

 
 

Ten obiekt należy 
do kolekcji Circular 

a b 

Zaznacz ten obiekt i 
sprawdź jego Collections 

Properties 

a b 

Obiekt Cone jest w dwóch 
kolekcjach jednocześnie 
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Aby usunąć kolekcję, podświetl ją w oknie Outliner i naciśnij X  lub Delete  (Rysunek 10.12.10): 

                         

Rysunek 10.12.10 Usunięcie kolekcji 

Blender usunął podświetloną kolekcję (Cameras & Lights), lecz jej zawartość została przesunięta do kolekcji 

nadrzędnej (Scene Collection). 

Jeżeli chcesz usunąć kolekcję z całą zawartością, użyj polecenia Delete Hierarchy. Znajdziesz je w menu kon-

tekstowym kolekcji (Rysunek 10.12.11): 

 

Rysunek 10.12.11 Polecenie, które usuwa kolekcję wraz z zawartością 

Zauważ, że to polecenie nie ma skrótu. Prawdopodobnie twórcy Blendera stwierdzili, że dla takiej „niszczyciel-

skiej” operacji nie jest potrzebny. 

 

Jeżeli w kolekcji usuniętej poleceniem Delete Hierarchy znajdował się obiekt powiązany z inną kolek-

cją, spoza usuniętego fragmentu hierarchii sceny – to dzięki temu powiązaniu nie zostanie usunięty.   

 

 

 
Kompletny opis okna Outliner znajdziesz w sekcji ”Editors: Outliner” dokumentacji Blendera online.  

2. Naciśnij Delete  
1. Zaznacz (kliknięciem LPM) 

kolekcję, którą chcesz usunąć 
 

Zaznaczona kolekcja 
znikła, ale jej obiekty 
znalazły się w kolekcji 
nadrzędnej  

Kliknij RPM  aby 

otworzyć menu 
kontekstowe kolekcji 

Wybierz Delete Hierarchy  

https://docs.blender.org/manual/en/2.82/editors/outliner.html
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10.13 Sceny – zarządzanie 

Każda scena to odrębna "przestrzeń", w której można umieszczać obiekty. Projekt (plik) Blendera może zawie-

rać wiele scen. Domyślnie w nowym pliku istnieje tylko jedna, o nazwie Scene. Do zarządzania scenami służy 

zespół kontrolek umieszczony u góry ekranu (Rysunek 10.13.1). Składa się z pola, pokazującego nazwę aktu-

alnej sceny, przycisku rozwijającego listę scen oraz przycisku usuwającego aktualną scenę. Aby zmienić nazwę 

aktualnej sceny, kliknij LPM  w jej nazwę i wpisz nową (Rysunek 10.13.1): 

 

 

 

 

 

Rysunek 10.13.1 Zmiana nazwy aktualnej sceny 

Aby stworzyć nową scenę, naciśnij przycisk , umieszczony z prawej strony nazwy (Rysunek 10.13.2): 

 

 

Rysunek 10.13.2 Dodanie nowej sceny 

Spowoduje to pojawienie się menu New Scene, z którego możesz wybrać jedną z opcji: 

• New: tworzy nową, pustą scenę (z globalnymi ustawieniami jak w pliku startowym); 

• Copy Settings: tworzy nową, pustą scenę, kopiując globalne ustawienia ze sceny aktualnej; 

• Linked Copy: wypełnia nową scenę referencjami do obiektów z aktualnej sceny. (Ten sam obiekty bę-

dzie "użyty" przez obydwie sceny. Więcej na ten temat – str. 630); 

• Full Copy: cała zawartość nowej sceny będzie niezależną kopią aktualnej; 

W praktyce stosuję zazwyczaj opcję Copy Settings (pojedyncze obiekty można później dodać do innej sceny 

poleceniem Object→Link/Transfer Data→Link Objects to Scene). Nowa scena otrzyma taką nazwę, jak scena 

oryginalna, z dodanym na końcu ".001". Zmień ją na właściwą. 

Aby usunąć aktualną scenę, naciśnij przycisk  (jest z prawej strony przycisku ). 

 

 

Blender nie zadaje już żadnego pytania „czy jesteś pewien”: po naciśnięciu przycisku [x] scena znika. 

Jeżeli usunąłeś ją przez pomyłkę – możesz się z tej operacji wycofać, wywołując polecenie Undo 

(skrót: Ctrl - Z ).  

 
 

1. Kliknij tutaj (LPM ) 

2. Wpisz nową nazwę 

1. Kliknij ten przycisk 

2. Wybierz 
Copy Settings 

3. Nadaj jej 
nazwę 

Blender tworzy 
nową scenę 
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10.14 Kursor 3D – ustalanie położenia 

Rozdział 3 (str. 67, 68) omówiliśmy krótko jak ustalić dokładną pozycję kursora 3D. Te metody są identyczne w 

Object Mode i Edit Mode, więc umieściłem ten opis w rozdziale z ogólnymi zagadnieniami Blendera. 

W modelowaniu obiektów mechanicznych nigdy nie ustawiałem kursora 3D w „swobodny” sposób za pomocą 

myszki (narzędziem Cursor z paska, por. str. 67). Zawsze używam jednej z opisanych poniżej metod. 

Pierwszą z nich jest Snap submenu (Mesh→Snap, lub Object→Snap) . Możesz także otworzyć je jako menu 

myszki, skrótem Shift - S . Rysunek 10.14.1 pokazuje wybór jednej z jego opcji: 

           

Rysunek 10.14.1 Ustawianie kursora 3D w zaznaczonym wierzchołku/wierzchołkach 

Jeżeli chcesz umieścić kursor w jakimś wierzchołku, zaznacz go, a potem otwórz menu myszki Snap ( Shift - S ) i 

wybierz polecenie Cursor to Selected ( 2 ). 

 

Jeżeli przed wywołaniem Snap:Cursor to Selected zaznaczyłeś wiele wierzchołków,  Blender umieści 

kursor 3D w ich medianie („środku ciężkości”). Na przykład: aby umieścić kursor 3D w środku okręgu, 

zaznacz dwa wierzchołki na końcach jego średnicy, a potem wywołaj Cursor to Selected. 

 
Opcja Cursor to Active działa w podobny sposób, ale gdy zaznaczysz wiele wierzchołków, umieści kursor 3D 

w wierzchołku aktywnym (por. str. 496). Czasami używam także Cursor to World Origin, które umieszcza kur-

sor 3D w punkcie (0, 0, 0). 

 

W Object Mode, polecenia Cursor to Active i Cursor to Selected) wykorzystują środki (origins) aktywne-

go/zaznaczonych obiektów. 

 
Inną metodą ustalenia położenia kursora jest wpisanie jego nowych współrzędnych w zakładce View przyborni-

ka ( N ) . Służy do tego panel Cursor:Location (Rysunek 10.14.2): 

 

Rysunek 10.14.2 Ustalanie/zmiana współrzędnych kursora 3D 

3. Wybierz Cursor to Selected 

1. Zaznacz 
wierzchołek 

 

2. Shift - S  

 

Blender umieścił 
kursor 3D we wska-
zanym wierzchołku   

Tu możesz wpisać/zmienić 
współrzędne kursora 3D 

Przybornik ( N ) 
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10.15 Kontrolka wyboru barwy 

Kontrolka służąca do ustalania koloru jest w Blenderze niewielkim prostokątnym polem. Aby zmienić kolor, który 

wyświetla, kliknij w nią LPM  (Rysunek 10.15.1): 

 

                 

Rysunek 10.15.1 Kontrolka w trybie RGB  

 

Rysunek 10.15.2 Kontrolka w trybie HSV  

Spowoduje to rozwinięcie chwilowego okna (menu?) z zestawem kontrolek służących do zmiany barwy. W gór-

nej części okna znajduje się koło braw i pasek intensywności. Wykorzystaj je do ustalenia koloru za pomocą 

myszki. Jeżeli jednak chcesz wpisać dokładną wartość numeryczną – możesz skorzystać z zestawu pól 

umieszczonych poniżej. Blender oferuje trzy tryby wpisywania wartości koloru: RGB, HSV i Hex. W trybie RGB 

(Rysunek 10.15.1) możesz zmieniać wprost intensywności składników R, G, B barwy. Są one tu wyrażone jako 

liczby z zakresu od 0.0 do 1.0. Niezależnie od tego, którego zestawu kontrolek użyjesz, Blender na bieżąco 

aktualizuje pole, z którego rozwinęliśmy to okno, wyświetlając tam bieżący kolor. 

Parametry z zestawu HSV są alternatywną metodą opisu koloru (Rysunek 10.15.2): 

- H (Odcień – ang. Hue): determinuje barwę. Ta wartość odpowiada poruszaniu się „wzdłuż spektrum 

barw”, czyli w naszym przypadku po obwodzie koła pokazywanego przez Rysunek 10.15.2; 

- S (Nasycenie – ang. Saturation): Wartość 0.0 to zupełny brak barwy (wszystko jest w odcieniach szaro-

ści), a 1.0 – czyste barwy. Ta wartość odpowiada przesuwaniu punktu wzdłuż promienia koła barw 

(Rysunek 10.15.2); 

- V (Intensywność – ang. Value): determinuje „jasność” barwy (widać ją na suwaku po prawej); 

Czasami wygodniej jest po prostu wskazać jakąś istniejącą barwę. Służy do tego przycisk z „pipetką”. Gdy klik-

niesz w niego myszką, okno zniknie, a kursor zmieni postać (Rysunek 10.15.3): 

                                                                          

Rysunek 10.15.3 Podstawienie barwy wskazanego piksela ekranu  

Końcówką tej „pipetki” kliknij w dowolne miejsce ekranu, a w polu kontrolki pojawi się jego kolor. 

1. Kliknij 
tutaj 

2. Kliknij w wybrane 
miejsce ekranu… 

… i masz skopiowany 
kolor tego piksela: 

Intensywność 

Nasycenie 

Odcień 

Zestaw kontrolek 
do wyboru koloru 
za pomocą myszki 

Numeryczne 
wartości RGB 
aktualnej barwy 

Aktualna brawa 

Okno rozwijalne  

Kliknij myszką, 
by rozwinąć to 
okno 

Wybór zestawu 
kontrolek nume-
rycznych 

S H V 
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Tryb Hex (heksadecymalny) przydaje się, gdy chcesz np. przenieść kolor z innego programu, np. z GIMP (tam 

to się nazywa HTML notation). Kopiujesz w nim do schowka 6-znakowy kod barwy, a następnie wklejasz w tym 

trybie do okna Blendera (Rysunek 10.15.4): 

Zwróć uwagę, że np. kolor materiału, 

przypisany do obiektu, jest w oknie 3D 

ciemniejszy niż na kontrolce. To przede 

wszystkim wpływ domyślnego oświe-

tlenia OpenGL, używanego przez 

Blender w wariantach Studio i Matcap 

trybu cieniowania Solid. Zgodne kolory 

w oknie 3D i w kontrolce pojawią się 

tylko w trzecim wariancie: Flat. 

Inną przyczyną może być także brak 

tzw. „korekty gamma” . Pod tą tajemni-

czą nazwą kryje się proces lepszego 

dopasowania zakresu wyświetlanych 

barw do czułości ludzkiego oka. Blen-

der od wersji 2.64 wyświetla barwy 

stosując taką korektę. Jednak w pli-

kach stworzonych we wcześniejszych 

wersjach programu ta korekta jest wyłączona. Musisz ją w nich sam włączyć. 

W panelu Render:Color Management (Rysunek 10.15.5a) wybierz z listy rozwijalnej Display Device pozycję 

sRGB. Wtedy kolory ulegną rozjaśnieniu. Ten tryb to nieliniowa konwersja intensywności wejściowej barwy 

(Rysunek 10.15.5b) poprzez krzywą gamma (Rysunek 10.15.5c) na barwę wyświetlaną (Rysunek 10.15.5d): 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rysunek 10.15.5 Efekt korekty gamma (sRGB): nieliniowe rozjaśnianie barw 

 

Rysunek 10.15.4 Kontrolka w trybie Hex 

1.00 

0.75 

0.50 

0.25 

0.00 

1.00 0.75 0.50 0.25 

a) c) 

Kolor bez korek-
ty (tak wygląda 
w trybie Linear)  

Kolor po korekcie (tak 
wygląda w trybie sRGB)  

sRGB: linia zbli-
żona do czułości 
ludzkiego wzroku 

Barwa materiału w oknie 
3D View jest zazwyczaj 
ciemniejsza od tej w 
kontrolce 

Heksadecy-
malne warto-
ści RGB 
barwy 

d) 

b) 

Uaktywniona nieliniowa 
korekta barw (sRGB) 
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Należy pamiętać, że ta konwersja działa także w drugą stronę. Gdy wkleisz do okna koloru w trybie Hex tekst 

„808080”, odpowiadający mieszance 50% czerni i bieli, to w trybie sRGB Blender wcale nie przyjmie dla niego 

wartości R=G=B=0.5, jak można by się było spodziewać”Arytmetyka barw” w Tom I lub Tom III. Zamiast tego 

zobaczysz R=G=B=0.216 (por. Rysunek 10.15.5b). I mimo to wyświetlany w kontrolce kolor dokładnie odpowia-

da temu, który uzyskasz dla kodu hex. „808080” w GIMP! Dlaczego? Bo korekta gamma jest wbudowana w 

system operacyjny. I Windows, i Linux używają takiej samej krzywej sRGB. Dla większej części jej zakresu 

(gdzieś tak od 0.25 do 1.0) jej współczynnik gamma = 2.2. Mac OS używa krzywej o nieco innym współczynni-

ku: 1.8, więc dla tych samych wartości heksadecymalnego kodu odcień koloru na ekranie komputera od Apple 

może wyglądać nieco inaczej. Przypuszczam, że Color Management Blendera uwzględnia i takie przypadki, 

dokonując odpowiedniej konwersji. 

 

W węzłach materiałów Blendera (np. Image Texture) włączysz korektę gamma (sRGB) wybierając im 

tryb Color. Dla tekstur nieodwzorowujących barwy (np. nierówności) używa się trybu bez żadnej korek-

ty: Non-Color Data. To „surowe” (ang. „raw”) dane wejściowe, bez żadnej korekty. 

 
Czasami kontrolka wyboru barw zawiera czwarty, dodatkowy suwak: A (Rysunek 10.15.6):   

 

Rysunek 10.15.6 Panel koloru ze sterowaniem przejrzystością (A)  

Ten suwak reprezentuje współczynnik nieprzejrzystości (określany także jako Alfa): A = 1.0 oznacza zupełny 

brak przejrzystości, a A = 0.0 to zupełna przejrzystość. Dla A=0 nie będziesz widział żadnego koloru, więc na-

wet A szkła ma pewną niewielką wartość. 

Zwróć uwagę na prawą stronę prostokąta kontrolki koloru: pokazuje aktualną nieprzejrzystość. Ta szachownica 

jest zmieszana z kolorem po lewej zgodnie z aktualną wartością A. Dla A = 1 ten wzór znika zupełnie. 

% nieprzejrzystości 
(od 0.0 do 1.0) 

Ta część kontrolki 
pokazuje aktualną 
przejrzystość 



458 Szczegóły obsługi Blendera 3D 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

10.16 Obsługa listy 

W niektórych panelach okna Properties znajdują się listy. Służą do zarządzania materiałami, grupami wierzchoł-

ków, alternatywnymi rozwinięciami UV i dziesiątką innych rzeczy. Obsługę listy Blendera zademonstruję na 

przykładzie listy Vertex Groups (z zakładki Object Data okna Properties). Inne listy są podobne, ale mogą nie 

mieć niektórych z opisanych tu kontrolek. 

Zacznijmy od krótkiego wprowadzenia do grup wierzchołków. W Blenderze można zadeklarować zbiór wierz-

chołków siatki jako nazwaną grupę. Takie grupy przydają się do ograniczania wpływu modyfikatorów1. Rysunek 

10.16.1 pokazuje przykład takiej grupy, o nazwie Base. Jej wierzchołki są podświetlone w oknie 3D po lewej: 

 

 

 

Rysunek 10.16.1 Przykład grupy wierzchołków 

Aby dodać nową pozycję (nową grupę wierzchołków) do tej listy: 

3. Kliknij przycisk [+], aby dodać nową, pustą pozycję (Rysunek 10.16.2a). 

4. Kliknij podwójnie (LPM ) na jej etykietę, aby zmienić nazwę tej pozycji2 (Rysunek 10.16.2b). 

5. Zaznacz wierzchołki w oknie 3D i naciśnij przycisk Assign, aby przypisać je do tej nowoutworzonej gru-

py (Rysunek 10.16.2c). 

         

 

Rysunek 10.16.2 Dodawanie do listy nowej pozycji (tworzenie nowej grupy wierzchołków) 

Ten sam wierzchołek siatki może należeć do wielu grup. Aby sprawdzić, które wierzchołki należą do podświetlo-

nej na liście grupy, kliknij w przycisk Select. Jeżeli dostrzeżesz w tym zbiorze jakieś niepotrzebne wierzchołki – 

zaznacz je i kliknij przycisk Remove pod listą. To usuwa przypisania do aktywnej pozycji. 

 
1 W ustawieniach większości modyfikatorów obiektów można (zazwyczaj) znaleźć listę rozwijalną Vertex Group wyświetlającą zdefiniowane 

w siatce grupy. Ta kontrolka pozwala ograniczyć działanie modyfikatora do wskazanej grupy wierzchołków. 

2 Nie ma żadnego widocznej kontrolki związanej ze zmianą nazwy pozycji listy. Tym niemniej, ta funkcja „podwójnego kliknięcia” powtarza 

się we wszystkich miejscach interfejsu użytkownika Blendera. Możesz w ten sposób zmieniać nazwy obiektom, kolekcjom, scenom, itp. 

Ikona stanu (różna dla każdej z list). 
Kliknij (LPM ) aby przełączyć. 

Przeciągnij (LPM ) by 

zmienić rozmiar listy 

Dodaje nową pozycję  

Otwiera sekcję Search tej listy 
(filtrowanie i sortowanie)  
 

Usuwa pozycję aktywną 

Menu kontekstowe listy  

Przesuwa pozycję ak-
tywną w górę/dół (zmie-
nia kolejność na liście) 

Podświetlona (aktywna) pozycja 

Group 
vertices 

a) b) 

c) 

Kliknij by dodać 
nową pozycję  

Kliknij podwójnie, 
by zmienić nazwę 

Przypisz zaznaczone 
wierzchołki do tej pozycji 
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Aby wyszukać na długiej liście element zawierający w nazwie jakiś charakterystyczne słowo, rozwiń sekcję wy-

szukiwania i wpisz to słowo w polu Search (Rysunek 10.16.3): 

                    

Rysunek 10.16.3 Wyszukiwanie pozycji na liście 

Listy Blendera można uporządkować „ręcznie” (ustawienie domyślne) lub alfabetycznie. Uporządkowanie „ręcz-

ne” wyświetla pozycje w naturalnej kolejności utworzenia. Możesz je zmieniać za pomocą przycisków Up/Down 

z prawej strony listy (Rysunek 10.16.4a):  

 

                       

Rysunek 10.16.4 Zmiana uporządkowania listy 

W obszarze wyszukiwania znajdziesz przełącznik sortujący w kolejności alfabetycznej (Rysunek 10.16.4b). 

Dodatkowy przycisk z prawej strony pozwala przełączyć się pomiędzy kolejnością rosnącą i malejącą. 

 

Niektóre listy mają dodatkowy przycisk, rozwijający jej menu 

kontekstowe (Rysunek 10.16.5). Jego zawartość zależy od 

rodzaju elementów listy – inne menu zobaczysz dla grup 

wierzchołków, a inne dla alternatywnych współrzędnych UV. 

Polecenia z menu kontekstowego mogą dotyczyć całej zawar-

tości listy (np. Lock All) albo aktywnego (podświetlonego) 

elementu (np. Mirror Vertex Group). 

 

 

 

 

 

 

 

 

 

 

  

Rysunek 10.16.5 Menu kontekstowe listy 

 

Kliknij, by rozwinąć menu 
kontekstowe listy 

Kliknij, aby rozwinąć 
sekcję wyszukiwania 

Wpisz frazę  

Pozycje, które 
zawierają tę frazę 

Odwraca kolejność 
wyświetlania rezultatów 

a) b) Uporządkowanie “ręczne” (domyślne) Uporządkowanie alfabetyczne 

Pozycje wg 
nazwy 

Przełącznik: 
rosnąco/ 
malejąco 

Pozycje w kolej-
ności wstawienia 
(+ modyfikacje 

przez Up/Down) 
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Rozdział 11. Blender – edytor obiektów (Object Mode) 

Z trybem Object Mode miałeś już okazję się zetknąć (Rozdział 3, "Blender – pierwsze kroki"). Ten rozdział 

omawia podstawowe pojęcia związane z tym trybem oraz polecenia których, uzywamy w tej książce.  

 

Pominę tu zagadnienia, które przedstawiał już Rozdział 3. Chodzi tu o:  

• Metody selekcji. Opisałem je już w sekcji 3.4 (str. 56). 

• Podstawowe transformacje (przesunięcie, obrót obiektu). Opisałem je już w sekcji 3.5 (str. 62). 
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11.1 Wstawianie obrazu (referencyjnego) 

W scenę Blendera możesz wstawiać obrazy rastrowe. Blender obsługuje je jako jeden z rodzajów tzw. „pustych” 

(Empty) obiektów1. W sekcji 4.1 (str. 84) pokazałem szybką metodę tworzenia takich obiektów poprzez „upusz-

czanie” plików obrazu do okna 3D. W tej sekcji zrobię to samo za pomocą poleceń z menu (może to się przy-

da?). Omówimy tutaj także szczegóły ustawień wyświetlania takiego obrazu. 

Istnieją trzy polecenia, których możesz użyć, aby wstawić do sceny Blendera obraz rastrowy (Rysunek 11.1.1): 

         

Rysunek 11.1.1 Trzy różne polecenia do wstawienia obrazu referencyjnego 

W istocie, ich rezultaty są niemal identyczne: obiekt Empty z przypisanym obrazem. Różnią się tylko kilkoma 

mało istotnymi ustawieniami w oknie Properties. 

Gdy wywołasz jedno z poleceń Add→Image→*, Blender wyświetli okno File View. Możesz stamtąd wybrać je-

den z obrazów rastrowych (Rysunek 11.1.2): 

 

Rysunek 11.1.2 Wybór obrazu (okno File View) 

 
1 Te obiekty są określane jako Empty (puste) ponieważ nie zawierają siatek, za pomocą których odtwarza się geometrię w Blenderze. 

Trzy polecenia, których możesz 
użyć aby wstawić obraz rastrowy 

Użyteczna opcja: 
duże ikony plików 



462 Szczegóły obsługi Blendera 3D 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

Blender zawsze umieszcza środek nowego obrazu tam, gdzie aktualnie jest kursor 3D (Rysunek 11.1.3): 

 

Rysunek 11.1.3 Nowo dodany obraz 

 

Przed wstawieniem nowego obrazu poleceniem z menu Add, umieść kursor 3D tam, gdzie chcesz 

umieścić środek tego nowego obiektu. 

 
 Aby niepotrzebnie nie zwiększać rozmiaru danych, Blender przechowuje w plikach *.blend tylko linki do obrazów 

(ścieżki do ich plików). Możesz je znaleźć w oknie Properties, panelu Object Data:Image (Rysunek 11.1.3). 

Jeżeli używasz polecenia Add→Empty→Image, sam musisz tę ścieżkę wpisać w tym panelu. W tym przypadku 

użyj ikony folderu z prawej strony tego pola, które otwiera okno File View.  

Domyślnie, geometryczny środek obrazu przypada w środku (origin) obiektu, ale możesz go przesunąć w do-

wolny inny punkt. Użyj w tym celu kontrolek Offset X/Y z panelu Object Data:Empty (Rysunek 11.1.4): 

 

Rysunek 11.1.4 Ustalanie nowego (relatywnego) położenia środka obrazu 

Jeżeli jest to obraz referencyjny, możesz także włączyć kontrolę nieprzejrzystości (Opacity) i zmniejszyć jej 

wartość. (Na półprzejrzystych obrazach łatwiej jest porównywać linie rysunku z modelem 3D). 

Polecenia z menu Add zaw-
sze umieszczają środek 
obrazu w aktualnym położe-
niu kursora 3D 

Ścieżka do pliku z obrazem 
Zastępuje obraz 

Odświeża obraz 

Object 

Data 

Nowo dodany obraz 

Użyj tych kontrolek 
aby umieścić inny 
punkt obrazu w 
środku obiektu 

Włącz kontrolkę Opacity 
i zmniejsz jej wartość, by 
uzyskać półprzejrzysty 

obraz referencyjny 
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Od czasu do czasu możesz także użyć innych opcji z panelu Empty (Rysunek 11.1.5): 

 

Rysunek 11.1.5 Inne opcje wyświetlania obrazu 

Na obiektach Empty możesz stosować wszystkie trzy podstawowe polecenia transformacji, w szczególności 

Object→Transform→Scale (str. 70). Wolę zmieniać rozmiary obrazów tą metodą. „Zwykłe” skalowania pozwala 

na rozciąganie obrazu wzdłuż jednej osi, czego nie można zrobić za pomocą kontrolki Empty:Size. 

 

 

Skaluje obraz 
względem środka 

(origin) obiektu 

Ustaw Depth:Front by 
widzieć ten obraz nawet 

gdyby był zasłonięty 
przez inne obiekty 

Ustaw Side:Front lub 
Back by przeciwna 

strona obrazu była zu-
pełnie przejrzysta 

Tutaj możesz ograniczyć 
typy projekcji, w których 
Blender pokazuje ten obraz 



464 Szczegóły obsługi Blendera 3D 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

11.2 Kopiowanie obiektów (Duplicate) 

W Blenderze istnieją dwa polecenia do kopiowania (powielenia) obiektu: 

1. Object→Duplicate Objects ( Shift - D ). To “pełne” kopiowanie. Powielony obiekt w żaden sposób nie 

zależy od oryginału. 

2. Object→Duplicate Linked ( Alt - D ). Kopia może mieć oddzielną skalę, położenie, obrót, ale korzysta 

nadal z tych samych danych (zazwyczaj – siatki), co wzorzec. 

Zademonstruję pierwsze polecenie na przykładzie obiektu – rysunku rastrowego (Rysunek 11.2.1): 

                   

Rysunek 11.2.1 Łopata śmigła, do której dodamy dwie dalsze — jako powiązane kopie 

Zaznacza obiekt do skopiowania a potem naciśnij Shift - D  (Object→Duplicate Objects). W odpowiedzi Blen-

der tworzy jego duplikat, zaznacza go i włącza tryb Move, więc możesz od razu przesunąć tę kopię w nowe 

miejsce. Jeżeli ma pozostać w oryginalnym położeniu – naciśnij Esc .  

 
Początkowo ta kopia otrzymuje nazwę pierwowzoru, rozszerzoną o numeryczny przyrostek („.001”).  

 
 Z punktu widzenia użytkownika, klonowanie – poleceniem Duplicate Linked – jest identyczne z kopiowaniem. 

Rysunek 11.2.2 pokazuje tworzenie klonów łopat śmigła: 

        

Rysunek 11.2.2 Powielenie (poprzez obrót) 

W tym przypadku zaraz po wywołaniu tej funkcji (naciśnięciu Alt - D ) nacisnąłem klawisz R . W ten sposób prze-

łączyłem się z domyślnego trybu Move na tryb Rotate. Możesz to robić także po wywołaniu Duplicate Obejcts. 

1. Zaznacz ten obiekt 

 

2. Shift - D  

 

Duplikat jest 
automatycznie 
w trybie Move 

1. Zaznacz 
ten obiekt 

Naciśnij R  by obrócić  

nowo utworzony obiekt 
(zamiast przesuwania) 

2.  Alt - D  
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Jaka jest w takim razie praktyczna różnica pomiędzy kopią zwykłą, a kopią powiązaną? Pokażę to na przykła-

dzie śmigła (w którym dodałem już także trzecią łopatę). Wszystkie trzy łopaty wykorzystują tą samą siatkę. Gdy 

zmodyfikujesz jedną z nich w Edit Mode, zmiana stanie się widoczna we wszystkich trzech instancjach 

(Rysunek 11.2.3): 

         

Rysunek 11.2.3 Obiekty powiązane — siatka jest zmieniana we wszystkich równocześnie 

Dopóki jednak jesteś w Edit Mode, zmiany widoczne w tych kopiach nie są „przetworzone” przez ich modyfika-

tory. Na przykład – nie są wygładzone. To nastąpi dopiero po przełączeniu się z powrotem w Object Mode. 

Wówczas zobaczysz ostateczne, zmodyfikowane kształty siatki we wszystkich trzech instancjach. 

 

Więcej na ten temat — patrz "Struktura danych modelu i sceny w Blenderze", str. 626. 

 
  

 

Gdy zmieniasz 
siatkę, modyfikujesz 

także jej „klony” Zmiany są widocz-
ne we wszystkich 
instancjach 

Tab  

Przesuń wierzchołki 

Edit Mode Object Mode 
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11.3 Tworzenie okręgu (Circle) 

Umieść kursor 3D tam, gdzie chcesz wstawić nowy okrąg (Rysunek 11.3.1a). Następnie wywołaj polecenie 

Add→Mesh→Circle (Rysunek 11.3.1b): 

              

Rysunek 11.3.1 Stworzenie okręgu (wieloboku) 

Po wywołaniu tego polecenia Blender zawsze wstawia do rysunku okrąg o promieniu = 1 jednostki. Domyślnie 

jego siatka składa się z 32 wierzchołków, połączonych w pojedynczą krawędź (Rysunek 11.3.2a).  

Aby zmienić te domyślne wartości, otwórz panel Adjust Last Operation. Możesz go rozwinąć klikając w nazwę 

ostatniego polecenia wyświetlaną w lewym dolnym narożniku okna 3D (Rysunek 11.3.2a), ale możesz także 

użyć skrótu F9 . Zmień w tym oknie liczbę wierzchołków i promień okręgu (Rysunek 11.3.2b):  

                                        

Rysunek 11.3.2 Ustalanie parametrów okręgu 

W tym przypadku ustaw umiarkowaną liczbę wierzchołków: 12 (Rysunek 11.3.2c). Zwróć uwagę, że Blender 

przy każdej zmianie wartości w oknie parametrów polecenia na bieżąco zmienia nowo utworzony obiekt. 

Dlaczego stworzyłem regularny 12-kąt zamiast gładkiego okręgu? Bo prostsza siatka jest łatwiejsza do zarzą-

dzania. W Blenderze możesz zmienić takie wielokąty w okręgi za pomocą tzw. modyfikatorów (zaraz to pokażę). 

 

Następnym razem, gdy wywołasz polecenie Add→Mesh→Circle, Blender będzie “pamiętał” ostatnio 

użyty promień oraz liczbę wierzchołków, i zaproponuje je jako nowe wartości domyślne. 

 

2. Wybierz 
Circle 

 

1. Umieść kursor 3D w 
środku przyszłego okręgu. 

Blender zawsze tworzy 
okrąg o 32 wierzchoł-
kach i promieniu = 1 

Powiększony okrąg 

a) 

b) 

2. Zmniejsz liczbę 
wierzchołków do 12 

1. Otwórz panel Adjust 
Last Operation  

3. Zwiększ promień, 
aby go zgrubnie dopa-
sować do rysunku refe-
rencyjnego 
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W oknie Properties nowo dodanego obiektu wybierz zakładkę Modifiers. Z listy rozwijalnej Add Modifier wy-

bierz modyfikator Subdivision Surface (Rysunek 11.3.3): 

  

 

 

 

 

 

 

 

Rysunek 11.3.3 Dodanie do obiektu modyfikatora Subdivision Surface 

Nowo dodany modyfikator natychmiast zmienia wygląd obiektu.  

Możesz sterować tym efektem w jego panelu (Rysunek 11.3.4). Ustaw tam wartości Levels:Viewport i Render 

na 2. Zobacz rezultat wygładzenia: 

 

Rysunek 11.3.4 Okrąg wygładzony za pomocą modyfikatora Subdivision Surface 

Do wygładzania okręgu i elips najlepiej jest używać schematu obliczeniowego o nazwie Catmull-Clark. To do-

myślne ustawienie modyfikatora Subdivision (Rysunek 11.3.4).  

 

Schemat Catmulla-Clarka całkiem dobrze przekształca wieloboki regularne na okręgi. Różnice pomię-

dzy tymi krzywymi I regularnymi łukami są niewielkie, nawet dla sześcio- i ośmiokątów. 

 

 

1. W oknie Properties 
okręgu otwórz zakład-
kę Modifiers 

2. Rozwiń listę modyfikatorów 

3. Wybierz 
Subdivision 

Surface 

Gładki 
okrąg 

Ustaw te poziomy 

podziałów na 2 
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W przypadku, gdy stworzone koło ma być podstawą do 

utworzenia jakiegoś niewielkiego, mało istotnego elementu (np. 

rurek, kabli) – jako siatkę bazową możesz użyć sześciokąt. W 

takim przypadku możesz także zmniejszyć poziomy podziału do 

1. Zmniejszy to ogólną liczbę ścian modelu. Gdy chodzi o duży 

obiekt, jak kołpak śmigła, użyj ośmio- a może i 12-kąta. Możesz 

także zwiększyć ich poziomy podziału do 3. W praktyce to na 

pewno pozwli wyeliminować nawet najmniejsze widoczne 

odchylenia od idealnego okręgu.   

 

Jeżeli chcesz dowiedzieć się więcej o krzywych i 

powierzchniach podziałowych – patrz str. 632. 

 

 

 

 

 

 

 

 

Rysunek 11.3.5 Linia podziałowa, uzyskana z 8 wierz-

chołków linii bazowej i poziomu podziału (Levels) = 3 

Siatka 
bazowa 

Krzywa Catmull-Clarka 
– prawie idealny okrąg 
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11.4 Tworzenie kwadratu (Plane) 

Umieść kursor 3D w miejscu, gdzie ma być środek kwadratu i wywołaj polecenie Add→Mesh→Plane (Rysunek 

11.4.1): 

                    

Rysunek 11.4.1 Stworzenie kwadratu 

W odpowiedzi Blender stworzy kwadrat o boku = 2 jednostki (Rysunek 11.4.2a). Aby zmienić ten domyślny roz-

miar, naciśnij F9 . W oknie parametrów zmień wartość pole Size (Rysunek 11.4.2): 

                    

Rysunek 11.4.2 Rezultat i parametry polecenia Plane 

 

Gdy następnym razem wywołasz polecenie Add→Mesh→Plane, Blender stworzy kwadrat o takim roz-

miarze jak stworzony ostatnio (program „pamięta” ostatnią wartość Size i stosuj ją jako domyślną). 

 
Rozmiar każdego obiektu można także zmieniać w inny sposób: zaraz po utworzeniu naciśnij S  (Scale) i po-

większ lub zmniejsz. 

Kwadrat, 
2x2 jedn. 

1. Umieść kursor 3D 
tam, gdzie ma być 
środek kwadratu. 
 

2. Wybierz Plane 
 

Parametry 
polecenia 

( F9 ) 

a) b) 

Tu można 
zmienić bok 

kwadratu 
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11.5 Tworzenie walca (Cylinder) 

Umieść kursor 3D tam, gdzie ma być umieszczony nowy walec i wywołaj polecenie Add→Mesh→Cylinder 

(Rysunek 11.5.1): 

 

Rysunek 11.5.1 Stworzenie walca  

W odpowiedzi Blender stworzy walec o promieniu = 1, wysokości 2 i 32 ścianach bocznych (Rysunek 11.5.2a)1. 

Aby zmienić te parametry, zaraz po wykonaniu polecenia Cylinder otwórz panel Adjust Last Operation ( F9 ): 

      

Rysunek 11.5.2 Vertices: zmiana liczby boków  

Rysunek 11.5.2b) pokazuje walec o liczbie boków (Vertices) zredukowanej do 8 (to właściwie graniastosłup).  

Z kolei opcja Cap Fill Type steruje rodzajem ścian podstaw walca (Rysunek 11.5.3): 

       

Rysunek 11.5.3 Cap Fill Type:włączanie i wyłączanie ścian podstaw walca  

Parametr Depth steruje wysokością cylindra. Domyślnie, środek tego obiektu (umieszczony tam, gdzie kursor 

3D) znajduje się w jego połowie. Radius steruje odległością ścian bocznych od tego punktu.  

 
1 W Twoim przypadku może być inny, bo Blender „pamięta” ostatnio użyte parametry i stosuje je jako nowe wartości domyślne. 

1. Umieść kursor 3D tam, 
gdzie ma być środek 

nowego cylindra 

2. Wybierz  
polecenie 
Cylinder 

a 
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Możesz także stworzyć walec za pomocą polecenia z paska (Rysunek 11.5.4): 

 

Rysunek 11.5.4 Polecenie Add Cylinder z paska  

Polecenia z grupy Add paska są intuicyjne i łatwe w użyciu. Jednak nie pozwalają na precyzyjne ustalania po-

zycji nowego obiektu, tak jak to robi polecenie z menu (które korzysta z kursora 3D). Dlatego w praktyce nigdy 

nie korzystam z tej alternatywy. 
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11.6 Tworzenie pustego obiektu (Empty) 

W Blenderze istnieją obiekty „puste” (Empty), bez żadnej siatki, krzywej czy podobnych danych. Istnieje wiele 

odmian obiektów tej klasy. Jedną z nich jest rysunek referencyjny, który już poznałeś (str. 461). W tej sekcji 

stworzymy pusty obiekt, który nawet nie będzie zawierał takiego odsyłacza do pliku obrazu, o nazwie Arrows. To 

samo „opakowanie”: zawiera wszystkie typowe własności obiektu: środek (położenie), obrót, a także skalę. Ska-

la nie ma wpływu na sam obiekt Empty, ale może mieć na inne, zwykłe elementy „siatkowe”, dla których jest 

„rodzicem”. Obiekty Empty służą do różnych funkcji pomocniczych.  

Aby dodać do rysunku nowy obiekt Empty, umieść kursor 3D w miejscu, gdzie ma być jego środek. Następnie 

wywołaj polecenie Add→Empty→Arrows (Rysunek 11.6.1): 

                   

Rysunek 11.6.1 Stworzenie pustego obiektu 

W odpowiedzi Blender wstawi w miejscu wskazanym kursorem 3D punkt z trzema osiami (Rysunek 11.6.2a). 

Jeżeli chcesz zmienić ich rozmiar, naciśnij F9 . W panelu z parametrami polecenia zmień wartość Radius 

(Rysunek 11.6.2): 

                          

Rysunek 11.6.2 Parametry polecenia Add Empty 

 

Następnym razem, gdy wywołasz polecenie Add→Empty→Arrows, Blender będzie „pamiętał” ostatnio 

użyty Radius. Zaproponuje go jako nową wartość domyślną. 

 

 

1. Umieść kursor 
3D tam, gdzie ma 
powstać obiekt 
Empty . 
 

2. Wybierz Arrows 
 

Empty, oznaczony 
trzema osiami 
 

Parametry 
polecenia 

( F9 ) 

a) b) 

Tu możesz 
zmienić 

długość osi 
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11.7 Tworzenie prostopadłościanu (Cube) 

Umieść kursor 3D w miejscu, gdzie ma być środek sześcianu i wywołaj polecenie Add→Mesh→Cube 

(Rysunek 11.7.1): 

                    

Rysunek 11.7.1 Stworzenie sześcianu 

W odpowiedzi Blender stworzy sześcian o boku = 2 jednostki (Rysunek 11.7.2a). Aby zmienić ten domyślny 

rozmiar, naciśnij F9 . W oknie parametrów zmień wartość pole Size (Rysunek 11.7.2): 

                    

Rysunek 11.7.2 Rezultat i parametry polecenia Cube 

 

Gdy następnym razem wywołasz polecenie Add→Mesh→Cube, Blender stworzy sześcian o takim 

rozmiarze jak stworzony ostatnio (program „pamięta” ostatnią wartość Size i stosuj ją jako domyślną). 

 
Rozmiar każdego obiektu można także zmieniać w inny sposób: zaraz po utworzeniu naciśnij S  (Scale) i po-

większ lub zmniejsz. 

 

W pasku narzędzi także zajdziesz polecenie Add Cube. Jego obsługa jest zupełnie inna. Może “bar-

dziej intuicyjna”, ale nie pozwala na precyzyjne ustalenie rozmiaru i położenia (nie używa kursora 3D).  

 

Sześcian, 
2x2x2. 

1. Umieść kursor 3D 
tam, gdzie ma być 
środek sześcianu. 
 

2. Wybierz Cube 
 

Tu można 
zmienić 
rozmiar 

sześcianu 

Parametry 
polecenia 

( F9 ) 

a) b) 
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11.8 Tworzenie kamery (Camera) 

Umieść kursor 3D w miejscu, gdzie ma być umieszczona nowa kamera. Następnie wywołaj polecenie 

Add→Camera (Rysunek 11.8.1):  

              

Rysunek 11.8.1 Wstawienie nowej kamery 

Jeżeli dodajesz do sceny drugą kamerę, tylko jedna z nich może być kamerą aktywną – czyli wykorzystaną 

przez silnik renderujący i przez skrót wyboru projekcji 0 . Aby uczynić zaznaczoną kamerę aktywną, użyj pole-

cenia View→Cameras→Set Active Object as Camera (Rysunek 11.8.2): 

 

Rysunek 11.8.2 Przełączanie aktywnej kamery 

Kamera aktywna jest oznaczana na rysunku wypełnioną „strzałką” (Rysunek 11.8.2) – we wszystkich innych 

kamerach sceny ten trójkąt jest przejrzysty. 

Kierunek kamery 
(lokalna oś Z) 

“Strzałka” przy 
górnej krawędzi 

kamery 

2. Wybierz to 
polecenie 
 

1. Umieść kursor 
3D, tam, gdzie 
chcesz wstawić 
nową kamerę 

 
 

Użyj tego polecenia 
do „uaktywnienia” 

zaznaczonej kamery 

Strzałka kamery aktyw-
nej jest wypełniona  
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11.9 Zmiana właściwości kamery (Camera) 

Widok z kamery ( 0 , albo View→Cameras→Active Camera) jest w oknie 3D pokazywany w następujący spo-

sób (Rysunek 11.9.1): 

 

Rysunek 11.9.1 Właściwości kamery (zakładka Object Data w oknie Object Properties)  

Prostokątna ramka narysowana linią ciągłą, którą widzisz w oknie 3D, to obiekt kamery. Zaznacza w ten sposób 

obszar, który będzie renderowany. Możesz np. kliknąć w tę ramkę LPM , aby zaznaczyć tę kamerę (tak, jak w 

przypadku wszystkich inny obiektów sceny). 

Aby dostać się do właściwości kamery, zaznacz ją i otwórz zakładkę Object Data w oknie Properties1. Przyjrzyj 

się panelowi Lens (Rysunek 11.9.1). Najpierw warto wydłużyć wartość Clip Start z domyślnego 0.1 do 1.0 (lub 

więcej) jednostki, aby w oknie 3D blisko położone powłoki modelu nie generowały artefaktów "przebić" jednej 

powierzchni przez drugą (Rysunek 11.9.2): 

       

Rysunek 11.9.2 Artefakty na powierzchni modelu, powstałe przez zbyt małą wartość Clip Start 

Co prawda, często "przebicia" pokazywane przez Rysunek 11.9.2 nie pojawią się na ostatecznym renderze. Po 

co jednak mają nas drażnić podczas edycji obiektu!? Lepiej zmienić pole Clip Start i po kłopocie! 

 
1 Właściwości specyficzne dla kamery są umieszczone w tej samej zakładce – Object Data – co siatki w „zwykłym” („bryłowym”) obiekcie. 

To ogólne miejsce do zmiany ustawień „zawartości” obiektu, niezależnie od jego typu. Na przykład, w zakładce Object Data obiektu Light 

znajdziesz parametry źródła światła (kolor, intensywność, itp.). 

Zakładka 
Object Data  

Ramka kamery 

Aktywna kamera (obiekt) 

Tu możesz zmienić nazwę 
(bloku danych) kamery 

Clip Start = 0.1 Clip Start = 2 

“Przebicia” we-
wnętrznych ścian Brak “przebić” 
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Czasami kamera potrafi "odciąć" zbyt odległe części modelu. Jej zasięgiem steruje parametr Clip End. W razie 

potrzeby zwiększ jego wartość (Rysunek 11.9.3):  

                  

Rysunek 11.9.3 "Obcięcie" modelu przez zbyt małą wartość Clip End 

Innym parametrem kamery jest ogniskowa (Focal Length, por. Rysunek 11.9.1). Domyślna długość ogniskowej 

kamery w Blenderze to 35mm. Odpowiada to kątowi rozwarcia 50º. Gdy ją zwiększysz do 70mm, obiekt w ka-

merze stanie się „większy” (Rysunek 11.9.4): 

    

Rysunek 11.9.4 Kamera – efekt zmiany ogniskowej z 35mm do 70mm 

Możesz skompensować ten efekt odsuwając kamerę od modelu wzdłuż lokalnej osi Z jej obiektu. 

Czasami w większej scenie trudno jest znaleźć kamerę, ze względu na relatywnie niewielki domyślny rozmiar 

tego obiektu. Można to łatwo skorygować, powiększając parametr Viewport Display:Size (Rysunek 11.9.5):  

 

Rysunek 11.9.5 Zmiana rozmiaru (Size) kamery 

Ten parametr nie ma wpływu na efektywne „pole widzenia” z kamery. 

Clip End = 575 Clip End = 1000 

Focal Length = 50mm Focal Length = 70mm 

Zwiększ rozmiar 
obiektu kamery 
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11.10 Nadanie obiektowi nazwy 

Każdy element rysunku Blendera musi mieć unikalną nazwę. Blender nadaje pewne nazwy domyślne, ale w 

bardziej złożonym modelu konieczne jest wprowadzenie nazewnictwa w sposób bardziej kontrolowany. Stąd, po 

utworzeniu każdego nowego obiektu powinieneś nazwać go na nowo. 

Nazwy obiektów i ich siatek możesz zmieniać w oknie Outliner (Rysunek 11.10.1): 

 

Rysunek 11.10.1 Przykłady nazw obiektów i siatki 

Jaki system nazewnictwa przyjąć dla elementów naszego modelu? Nazwa nie powinna być długa (staraj się nie 

przekraczać 20 znaków). Proponuję stosować tekst składający się z dwóch segmentów: 

1. Pierwszy segment: unikalny identyfikator, składający się z 2 lub 3 części, oddzielonych kropkami: 

a. 1 znak: wyróżnik wersji samolotu. Wszystkie jej części będą używać takiej samej litery. Na 

przykład w modelu P-40B będą zaczynać się od "B". Okaże się to przydatne później1. 

Wyjątkiem są elementy pomocnicze: rysunki referencyjne, „narzędzia” Boole’a, 

uchwyty animacji itp. Te używają przedrostków R, U, X,… 

b. 3 cyfry: unikalny symbol części. Pierwsza cyfra jest związana z „podzespołem”. Pozostałe dwie 

to numer części w obrębie tego podzespołu. Staraj się, aby elementy podzespołów 

miały zbliżone numery. W takim przypadku radziłbym zwiększać numerację nie co 1, a 

co 5 (np. "P05", "P10", "P15", "P20",..., gdzie “P” oznacza cyfrę podzespołu). W ten 

sposób pozostawiamy sobie miejsce w numeracji na ewentualne dodatkowe elementy. 

(Podczas pracy często się okazuje, że trzeba przekonstruować gotowy zespół. Takie 

luki w numeracji są wtedy jak znalazł!); 

c. 1 znak: opcjonalny znacznik "powielenia". Może to być "L" lub "R" dla części lewej lub prawej, 

które są symetryczne. Może także być "nr kolejny", np. dla 3 łopat śmigła jest to "A", 

"B", "C"; 

2. segment z dodatkową, "ludzką" nazwą. To fragment jest pomocniczy – ma ułatwić identyfikację przez 

użytkownika. Pamiętaj, że nigdy nie wiesz, do kogo kiedyś trafi Twoja praca. Dlatego najlepiej jest sto-

sować nazwy angielskie. 

 

 
1 Gdy będziesz tworzył, w innym pliku Blendera, model P-40D, nadasz jego elementom przedrostek "D". Podczas pracy nad wariantem "D" 

może okazać się przydatne np. dołączenie do rysunku kadłuba z P-40B. Dzięki temu przedrostkowi unikniesz konfliktu nazw tych części! 

Czasami nazwy obiektów mogą 
się różnić od nazw ich siatek 

Nazwa siatki 

Nazwa siatki 

Nazwa obiektu 

Nazwa obiektu 
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Zgodnie z regułami podanymi na poprzedniej stronie, siatka łopaty śmigła pokazana przez Rysunek 11.10.1 

nosi nazwę "B.010.Blade", gdzie: 

• B – przedrostek, którego będę używał do wszystkich części P-40B; 

• 010 – numer kolejny tej części: "0" zastosowałem dla podzespołu śmigła, a "10" – to numer kolejny 

tego obiektu. Inna część tego podzespołu – kołpak – nosi numer kolejny „05”, aby zachować w 

numeracji miejsce na ewentualne przyszłe dodatki; 

• Blade –  nazwa opisowa.  

Zwróć uwagę, że obiekty poszczególnych łopat śmigła pokazywane przez Rysunek 11.10.1 różnią się znaczni-

kiem „powielenia”. Dodatkowo, nazwa siatki (B.010.Blade) i nazwa obiektu (B.010.B.Blade) różnią się od sie-

bie. Stało się tak dlatego, że wszystkie trzy łopaty śmigła (B.010.A.Blade, B010.B.Blade, B.010.C.Blade) uży-

wają jednej i tej samej siatki, o nazwie B.010.Blade. Są one trzema klonami tej samej siatki. Obiekty - klony 

(linked duplicates) mają zawsze ten sam kształt. (Więcej szczegółów na temat klonów – str. 464). 

Przedrostki obiektów pomocniczych to: 

• X: uchwyt lub “baza” obiektu (np. X.100.Wing.Base, por. str. F9.4.11); 

• Y: inne pomocnicze obiekty (np. Y.300.Stabilizer@64, por. str. F10.1.4); 

• U: obiekt “tnący”, używany przez modyfikator Boolean (np. U.100.L.Aileron, por. str. F9.4.6); 

• Q: krzywa NURBS (np. Q.240.L.Tube, por. str. F9.6.32); 

• R: obiekt referencyjny (zazwyczaj – obraz, np. R.Side.Left (compiled), por. str. 90). 

Aby uczynić strukturę modelu bardziej “czytelną”, pierwsze cztery typy obiektów używają tego samego numeru 

kolejnego NNN jako powiązany “regularny” obiekt B.NNN.*. 

Dlaczego trzeba nadawać oddzielne nazwy obiektowi i siatce? Skąd w ogóle taki podział i czym w Blenderze 

jest w takim razie "obiekt"? Jeżeli nurtują Cię takie pytania, zajrzyj na str. 626, do sekcji "Struktura danych mo-

delu i sceny w Blenderze". 
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11.11 Przypisanie do hierarchii (Parent) 

Aby stworzyć relację parent/child, zacznij od zaznaczenia obiektów podrzędnych („dzieci”). W przypadku poni-

żej to trzy łopaty śmigła (obiekty B.010.*.Blade). Gdy wszystkie już zaznaczysz, włącz do zbioru selekcji obiekt, 

który ma być ich obiektem nadrzędnym (kliknięciem Shift -LPM). W tym przypadku to kołpak (B.005.Spinner). 

Koniecznie upewnij się, że jego nazwa pojawiła się w lewym, dolnym narożniku ekranu, (tzn., że stał się obiek-

tem aktywnym – Rysunek 11.11.1a). Następnie użyj skrótu Ctrl - P  aby otworzyć menu Set Parent To (Rysunek 

11.11.1b). Wybierz z tego menu opcję Object (Keep Transform) : 

 

 

 

 

 

 

 

Rysunek 11.11.1 Tworzenie powiązań hierarchicznych 

Rezultat pokazuje Rysunek 11.11.1c), W oknie 3D (po lewej) nic się nie zmieniło. W oknie Outliner (po prawej) 

znikły obiekty odpowiadające trzem łopatom śmigła. Za to po prawej stronie obiektu kołpaka pojawiła się ikona 

która sygnalizuje, że teraz zawiera on 3 obiekty potomne. 

Gdy rozwiniesz zawartość pozycji B.005.Spinner, zobaczysz wszystkie trzy łopaty (Rysunek 11.11.2): 

 

Rysunek 11.11.2 Utworzone powiązanie hierarchiczne 
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Przedstawione powiązanie tworzy w Twojej scenie struktury hierarchiczne. Przypisując w ten sposób łopaty do 

kołpaka, "skleiłeś" je ze sobą. Od tej chwili, gdy tylko obrócisz lub przesuniesz kołpak, łopaty będą także się 

obracać i przesuwać – jak w prawdziwym śmigle (Rysunek 11.11.3). 

 

Rysunek 11.11.3 Obracanie obiektem nadrzędnym 

Czasami będziesz chciał zidentyfikować „rodzica” konkretnego obiektu. Znajdziesz tę informację w oknie 

Properties, zakładce Object, polu Relations:Parent (Rysunek 11.11.4): 

 

Rysunek 11.11.4 identyfikacja obiektu nadrzędnego  

Nazwy obiektów są unikalne, więc jeżeli chcesz znaleźć teraz ten obiekt w scenie, skopiuj jego nazwę do pola 

filtru okna Outliner.  

Nie zalecam używania ikony „X” z lewej strony pola Parent (Rysunek 11.11.4) do zerwania relacji hierarchicznej. 

To ekwiwalent polecenia Object→Parent→Clear Parent, które może nagle przenieść „osierocony” obiekt w 

zupełnie inne miejsce sceny. Zamiast tego, użyj polecenia Clear and Keep Transformation z tego samego 

menu (Rysunek 11.11.5): 

 

Rysunek 11.11.5 Usunięcie relacji parent/child  
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3. Wybierz to 
polecenie 
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Aby ułatwić ewentualną animację modelu oraz ogólną „obsługę”, zorganizuj wszystkie jego obiekty w 

podzespoły (“kadłub”, “skrzydło”, itd.). Następnie przypisz obiekty nadrzędne tych podzespołów do 

pojedynczego “rodzica” (może to być obiekt Empty). Przesunięcie lub obrót tego jednego obiektu spo-

woduje przesunięcie lub obrót całego modelu.   

 
 Hierarchie relacji parent/child i kolekcji są niezależne. Jednak sugeruję używać kolekcji jako metody do „ekspo-

nowania” w oknie Outliner tych obiektów potomnych, do których często zaglądasz (na przykład: aby przełączyć 

widoczność, lub zaznaczyć). 

Rysunek 11.11.6 pokazuje śmigło podzielone na dwie kolekcje, o nazwach 2a1.Spinner i 2a2.Blades:  

                            

Rysunek 11.11.6 Używanie kolekcji do eksponowania obiektów podrzędnych 

Łopaty i kołpak są nadal powiązane relacją parent/child, lecz teraz łopaty śmigła są łatwo dostępne do „klikania” 

(Rysunek 11.11.6a). Gdy rozwiniesz obiekt B.005.Spinner, nadal tam zobaczysz je jako jego „dzieci” (Rysunek 

11.11.6b). Jednak ich nazwy są tu wyszarzone, ponieważ należą do innej kolekcji. 

 

Gdy w oknie Outliner przenosisz obiekt nadrzędny pomiędzy kolekcjami, jego „dzieci” pozostają w ory-

ginalnych miejscach. Aby przenieść je razem z “rodzicem”, wybierz najpierw polecenie Select 

Hierarchy z menu kontekstowego obiektu nadrzędnego.   

 
 Gdybyś chciał zobaczyć w oknie Outliner wyłącznie hierarchię sceny, w filtrze tego okna wyłącz wyświetlanie 

kolekcji (Rysunek 11.11.7): 

 

Rysunek 11.11.7 Wyświetlanie hierarchii sceny 

Wykonuj taki przegląd od czasu do czasu, aby znaleźć wszystkie „zagubione” obiekty, których zapomniałeś 

przypisać do jakiegoś „rodzica” w hierarchii modelu. 
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11.12 Wyznaczenie krawędzi przecięcia dwóch powłok  

Czasami potrzeba znaleźć krawędź przecięcia dwóch obiektów, np. jako bazę do nowej siatki. 

W Blenderze takie polecenie nie istnieje, więc przygotowałem do tego celu specjalną wtyczkę. Nazwałem ją 

Object Intersection1. Jeżeli zainstalowałeś już towarzyszące tej książce skrypty (por. str. 435), powinieneś ją 

znaleźć w oknie Preferences, sekcji Add-ons, kategorii User (Rysunek 11.12.1): 

 

Rysunek 11.12.1 Aktywacja dodatku do wyznaczenia krawędzi przecięcia siatek dwóch obiektów 

Włączenie tej wtyczki dodaje do menu Object polecenie Intersect (Rysunek 11.12.2). Zaznacz najpierw dwa 

obiekty, dla których chcesz znaleźć krawędź przecięcia:  

 

Rysunek 11.12.2 Zaznaczenie obiektów i wywołanie polecenia 

Kolejność zaznaczania jest ważna: najpierw wskaż obiekt który pełni rolę „narzędzia tnącego”, a potem obiekt, 

do którego siatki wtyczka doda rezultat tej operacji – krawędź przecięcia. Następnie wywołaj polecenie 

Object→Intersect (Rysunek 11.12.2). 

 
1 , lecz ich zakres jest ograniczony do pojedynczej siatki.   

Jeżeli nie zainstalowałeś jeszcze dodatków do tej książki 
(por. str. 435), możesz zainstalować tą wtyczkę tak, jak 
jest to opisane na str. 443. Pełna ścieżka do tego pliku: 
source\scripts\addons\object_intersection.py. 

Włącz ten dodatek 

2. Zaznacz obiekt, 
w którym pojawi się 
krawędź przecięcia 
(to obiekt aktywny) 

1. Zaznacz 
obiekt „tnący” 

3. Wywołaj 
polecenie 
Intersect 
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Po uruchomieniu na ekranie pojawi się okno dialogowe z opcjami polecenia (Rysunek 11.12.3a): 

 

Rysunek 11.12.3 Wyznaczenie krawędzi przecięcia 

Na razie niczego w nim nie zmieniaj, tylko naciśnij przycisk OK. W zależności od liczby ścian przecinanych sia-

tek operacja może potrwać sekundę lub dwie. Intersection dodaje wyznaczoną krawędź przecięcia do siatki 

aktywnego obiektu, zaznacza jej wierzchołki i przełącza Blender w tryb Edit Mode, abyś mógł je od razu zoba-

czyć (Rysunek 11.12.3b).  Jeżeli nie jesteś zadowolony z rezultatów – wystarczy nacisnąć X , aby je usunąć. 

Potem można powrócić ( Tab ) do Object Mode i wywołać polecenie jeszcze raz, z innymi ustawieniami. 

Pierwsza z opcji operacji – Use selected faces – ma znaczenie tylko wtedy, gdy wcześniej w Edit Mode zazna-

czyłeś jakieś ściany przecinanych siatek. Dodatek Intersection ograniczy wówczas zakres operacji tylko do tego 

zaznaczonego obszaru. Jeżeli nic nie jest na siatkach zaznaczone – sprawdzane są ich wszystkie ściany. 

Gdy druga opcja – Use both meshes – jest włączona, skrypt buduje rezultat z punktów przecięcia krawędzi 

obydwu siatek (Rysunek 11.12.4a): 

       

Rysunek 11.12.4 Wpływ opcji Use both meshes na krawędź przecięcia 

Gdy ją wyłączysz, rezultat będzie zawierać wyłącznie punkty przecięcia krawędzi aktywnego obiektu ze ścia-

nami obiektu „tnącego” (Rysunek 11.12.4b). Taki efekt może być przydatny przy odpowiednio gęstych siatkach. 
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Ta wtyczka wyszukuje punkty przecięcia krawędzi jednej z siatek ze ścianami drugiej i łączy je krawędziami w 

jedną wspólną linię. Podczas obliczeń każda czworokątna ściana jest dzielona przekątną (diagonal), aby za-

mienić ją na dwie ściany trójkątne. Intersect wykorzystuje punkty znalezione na tych przekątnych do określenia 

kolejności łączenia w jedną linię poszczególnych wierzchołków. Domyślnie, punkty z tymczasowych przekąt-

nych są pomijane w krawędzi wynikowej. 

Jeżeli jednak włączysz opcję Use diagonals, zobaczysz je wszystkie (Rysunek 11.12.5a): 

        

Rysunek 11.12.5 Wpływ opcji Use diagonals na krawędź przecięcia 

Rysunek 11.12.5b) przedstawia przekątną wybranej ściany i jej punkty przecięcia ze ścianami drugiej siatki. 

Opcję Use diagonals pozostawiłem tylko na wszelki wypadek – zazwyczaj jej nie używam. 

Te same operacje są dostępne także w Edit Mode jako Edge→Intersect Faces (por. str. 531).  

Dodatek Intersection jest od 2009 r. udostępniany na zasadach Open Source (jak wszystkie dodatki do Blende-

ra, które napisałem). Sądząc z liczby pobrań, wielu użytkowników uznało go za przydatny. Przypuszczam, że 

jest „przodkiem” polecenia Intersect (Knife), dodanego do Blendera w 2014 r. przez jednego z jego głównych 

programistów (Campbella Bartona). W odróżnieniu od mojego Intersection, który tworzy pojedynczą krawędź 

niepowiązaną z resztą siatki, Intersect (Knife) dzieli jej ściany. 
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11.13 Scalanie obiektów (Join) 

Scalenie dwóch obiektów oznacza scalenie ich siatek. Jednocześnie wszystkie wskazane obiekty, poza obiek-

tem aktywnym, przestają istnieć.  

Operację tę wykonuję często by przenieść fragment siatki z jednego do drugiego obiektu. Rysunek 11.13.1 

przedstawia jedną z takich sytuacji. Są tu dwa obiekty: zielony i szary. Chcę przenieść podświetlone ściany 

siatki obiektu zielonego do siatki obiektu szarego: 

 

Rysunek 11.13.1 Typowe zagadnienie: przeniesienie fragmentu siatki pomiędzy obiektami 

Najpierw, w Edit Mode, wydziel zaznaczoną część zielonej siatki w tymczasowy obiekt (poleceniem Separate – 

por. str. 547). Następnie przełącz się na Object Mode. 

Następnie: 

1. Zaznacz nowo utworzony obiekt („źródło”). 

2. Zaznacz obiekt docelowy (stanie się obiektem aktywnym). 

3. Wywołaj Object→Join ( Ctrl - J  – Rysunek 11.13.2): 

                

Rysunek 11.13.2 Połączenie siatek dwóch obiektów 

Tymczasowy obiekt, zaznaczony jako pierwszy (Rysunek 11.13.2) został usunięty. Jego siatka jest włączona do 

siatki docelowego obiektu. 

Polecenie Join zachowuje materiały przypisane do ścian siatki. Jednak w przypadku z ilustracji powyżej, doce-

lowy obiekt był szary, gdyż nie miał przypisanego żadnego materiału. Importowany wraz z siatką zielony mate-

riał stał się pierwszym (domyślnym) materiałem, i cały obiekt zrobił się zielony.   

Z drugiej strony – obiekt docelowy używał do wygładzenia powierzchni modyfikatora Subdivision Surface. Jak 

widać powyżej, został on automatycznie zastosowany do nowego fragmentu siatki. 
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Aby powrócić obiekt docelowy do „szarego” stanu, możesz usunąć slot materiału z jego właściwości (Properties, 

zakładka Material – por. str. 575). Następnie, w Edit Mode, ustaw współczynnik Crease nowo zaimportowanych 

krawędzi na 1 (Rysunek 11.13.3): 

 

Rysunek 11.13.3 Rezultat – połączone siatki 

 

Operacją odwrotną do scalenia siatek obiektów jest wydzielenia siatki (polecenie Separate, które wyko-

rzystaliśmy w pierwszym kroku tej sekcji).   

  

Importowany 
fragment 

siatki 

Jeżeli ten obiekt używa modyfikatora 
Subdivision, oznacz te krawędzie jako 
ostre (Crease = 1) 
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11.14 Zmiana położenia środka obiektu (Set Origin) 

Punkt odniesienia obiektu, używany dla określenia położenia, obrotu, i skali, nazywany jest w Blenderze 

środkiem obiektu. To polskie tłumaczenie angielskiego terminu origin wywołuje czasem niewłaściwe skojarze-

nia, bo taki „środek” obiektu często wcale nie leży w jego środku geometrycznym. Środek jest oznaczany przez 

pomarańczowy punkt. 

Aby zmienić położenie środka obiektu (Rysunek 11.14.1): 

1. Umieść kursor 3D w miejscu, w którym chcesz umieścić nowy środek obiektu. 

2. Zaznacz obiekt. 

3. Wywołaj polecenie Object→Set Origin→Origin to 3D Cursor:  

    

Rysunek 11.14.1 Zmiana położenia środka obiektu 

W efekcie środek obiektu znajdzie się w miejscu wskazanym przez kursor 3D. Zmiana położenia środka obiektu 

jest "jego wewnętrzną sprawą". Nie ma wpływu na jego rozmiar ani położenie w przestrzeni. 
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obiektu jest tam, 
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2. Zaznacz 
obiekt 
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11.15 Przypisanie ograniczenia Track To  

Obiekt z ograniczeniem Track To jest zawsze zorientowany w przestrzeni tak, by jego oś była skierowana na 

środek wskazanego celu (innego obiektu). Domyślnie jest to lokalna oś -Z, ale można wskazać inną (X lub Y).  

Najszybszy sposób utworzenia ograniczenia Track To to:  

1. zaznaczenie obiektu/obiektów podlegających ograniczeniu; 

2. zaznaczenie obiektu - celu (to musi być ostatni zaznaczony – tzn. to musi być obiekt aktywny!); 

3. wybranie z submenu Object→Track polecenia Track To Constraint. 

 
Rysunek 11.15.1 pokazuje, jak to zazwyczaj wygląda:  

 

Rysunek 11.15.1 Dodanie ograniczenia Track To do obiektu 

Istnieje także bardziej ogólna metoda, pozwalająca dodać każde ograniczenie. Polega na zaznaczeniu najpierw 

„celu” a potem obiektu "ograniczanego" (tutaj: kamery), i wywołaniu polecenia Object→Constraints→Add 

Constraint (with Targets). W odpowiedzi Blender wyświetla listę rozwijalną, z której możesz wybrać każdy 

rodzaj ograniczeń. W tym przypadku, wybierz z niej ograniczenie Track To (znajdziesz je w kolumnie Tracking). 

Właściwości ograniczenia Track To, a także wszystkich innych przypisanych do tego obiektu, znajdziesz zakład-

ce Object Constraints (Rysunek 11.15.2). To lista ograniczeń (podobna do listy modyfikatorów):  

 

 

 

 

Rysunek 11.15.2 Właściwości ograniczenia Track To  

W przypadku tworzenia powiązania kamery z celem, nie zapomnij włączyć przełącznika Target Z. 
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Nazwa (instancji) 
ograniczenia  

Nazwa obiektu-celu 

Gdy włączysz tę opcję, 
wskazana oś Up jest zaw-
sze równoległa do lokalnej 
osi Z obiektu Target.  

Wpływu ograniczenia: za-
zwyczaj pozostawiaj = 1.0 

Usuwa to ograniczenie z 
listy ograniczeń obiektu 
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Aby usunąć ograniczenie Track To, użyj polecenia Object→Track→Clear Track lub polecenia Clear 

Track and Keep Transform. W tym drugim przypadku, Blender przed usunięciem na stałe przypisuje 

aktualną transformację spowodowaną ograniczeniem do obiektu. W ten sposób jego aktualne położe-

nie i orientacja w przestrzeni sceny pozostają niezmienione. 

 
Innymi drogami do usunięcia ograniczenia są: 

• polecenie Object→Constraints→Clear Object Constraints; 

• usunięcie pojedynczego ograniczenia ze stosu ograniczeń aktualnego obiektu (Rysunek 11.15.2). 

Jednak te metody nie gwarantują jednak zachowania aktualnej transformacji obiektu, jak to ma miejsce przy 

użyciu polecenia Clear Track and Keep Transform. 
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11.16 Wstawienie krzywej (Curve) 

Umieść kursor 3D tam, gdzie zamierzasz wstawić krzywą i wywołaj polecenie Add→Curve→Path (Rysunek 

11.16.1). Spośród innych poleceń z menu Curve, to tworzy najbardziej ogólną, przestrzenną krzywą NURBS.  

 

 

Rysunek 11.16.1 Tworzenie krzywej (Path) 

Początkowo, Path jest linią prostą o długości 4 jednostek. Możesz zmienić tę długość w parametrach ostatniego 

polecenia ( F9 , pole Radius). Oczywiście, możesz także skalować ten obiekt do dowolnego rozmiaru. 

Zazwyczaj będziesz tworzyć krzywą, która odtwarza jakiś kontur. Jako przykład takiej sytuacji, przygotowałem 3 

pary stycznych łuków. Dopasujmy krzywą do pary środkowej. Zacznij od przejścia w Edit Mode ( Tab ) i przesu-

nięcia ( G ) , obrotu ( R ), skalowania ( S ) i wyciągania ( E ) węzłów krzywej (Rysunek 11.16.2): 

     

     

     

Rysunek 11.16.2 Dopasowywanie krzywej do konturu na rysunku 

Rysunek 11.16.2f) pokazuje dolną, symetryczną połowę uformowanej krzywej, dopasowanej do konturu. 

Domyślna długość: 4 jednostki 

Początkowo Blender 
tworzy linię prostą  

1. Umieść kursor 3D 
tam, gdzie ma być 
wstawiona krzywa 
 

2. Wybierz Path 
 

Wszystkie inne krzywe 
z tego menu można 
także utworzyć z Path  

a) b) 

c) d) 

e) f) 

Edit Mode 

Punkty kontrolne 
krzywej (“węzły”) 

Kontur referencyjny 
(dwa styczne łuki) 

Zbliżenie 
uzyskanej 

krzywej 

Drobne odchylenie od 
konturu referencyjnego 

Środek transformacji 

Skaluj wzdłuż osi 
X te dwa węzły 

Przesuń te dwa 
odcinki o tę 

samą odległość 

Podobne 
długości 

Skaluj te dwa węzły by 
skrócić ostatnie odcinki 

Wyciągnij końcowe węzły 
i skaluj je wzdłuż osi X, 
tworząc nowe odcinki  

Ustaw te dwa odcinki 
stycznie do łuków 

Podobne 
długości 

 

Y 

X 
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W przekształceniach pokazywanych przez Rysunek 11.16.2 skorzystałem z symetrii konturu referencyjnego 

(obydwa jego łuki są identyczne). Dlatego użyłem skalowania zamiast przesuwania. Rozpocząłem od środko-

wego węzła, umieszczonego na styku łuków (Rysunek 11.16.2a). Po początkowym przesunięciu (Rysunek 

11.16.2b) użyłem skalowania do ustawienia dwóch środkowych odcinków wieloboku sterującego stycznie do 

łuków konturu (Rysunek 11.16.2c). Rysunek 11.16.2d) pokazuje skracanie zewnętrznych odcinków tego wielo-

boku (do odwzorowania łuku ich długość powinna być taka sama). Na koniec, dodałem dwa nowe odcinki wie-

loboku sterującego, wyciągając (Extrude) jego węzły końcowe (Rysunek 11.16.2e). Obecność tych dodatko-

wych węzłów poprawiła kształt wynikowej krzywej (to NURBS, 4-go stopnia). Dla takiej krzywej, „obszar wpły-

wu” pojedynczego węzła rozciąga się na 3 odcinki wieloboku sterującego w każdą stronę1. 

 
Jeżeli chcesz poprawić krzywą pokazaną przez Rysunek 11.16.2f), użyj dodatkowej opcji, dostępnej tylko dla 

krzywych i powierzchni NURBS: wagi punktów sterujących. W trybie Edit Mode krzywej znajdziesz je w zakład-

ce Item przybornika, panelu Transform. Figuruje tam jako czwarta współrzędna węzła: W (Rysunek 11.16.3):  

 

 

 

Rysunek 11.16.3 Dopasowywanie krzywej do konturu za pomocą wag punktów sterujących  

Dla łuków, zachowaj w ich drugim węźle oryginalne W = 1. Dlatego zaznaczyłem węzły B i D (Rysunek 

11.16.3a), a także ich odpowiedniki na drugim, symetrycznym łuku. Zmniejszenie w polu W przybornika ich 

wspólnej wagi spłaszcza kontur krzywej w pobliżu B. Wydaje się, że W = 0.71 jest optymalną wartością dla 

węzła B (Rysunek 11.16.3b). Jednak nadal widać niewielkie odchylenie od konturu referencyjnego przy C. Mo-

żesz poprawić kształt tego fragmentu zmniejszając wartość W węzła D do 0.14.   

 

W węzłach współliniowych, waga węzła ma większy wpływ na kształt krzywej niż jego położenie. 

 
1 Porównaj to z obszarem wpływu punktu kontrolnego krzywej podziałowej (2 odcinki w każdą stronę – por. str. 1494). Krzywe podziałowe 

są ekwiwalentem krzywej NURBS stopnia trzeciego (tzw. „krzywych sześciennych” – ang. „cubic curves”) 

 

Możesz tworzyć nowe węzły wieloboku sterującego krzywą wyciągając (Extrude) jego końce, lub przez 

podział dowolnego z jego odcinków poleceniem Segments→Subdivide. 

a) 

b) 

c) 

A 

B 

C D 

A 

B 

C D 

B C D 

Chcemy zbliżyć naszą krzywą 
(kolor czarny) do łuku konturu 
referencyjnego (kolor szary) 

Zmniejsz wagę (W) 
tych dwóch węzłów   

Dalsze zmniejszanie wagi W 
węzła  D poprawia kształt 

krzywej wokół węzła C 
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Do odwzorowania konturu referencyjnego stworzonego z dwóch stycznych łuków o różnych promieniach R1 i 

R2 (Rysunek 11.16.4), możesz użyć wielobok kontrolny krzywej z poprzedniej strony. Trzeba tylko w nim zmie-

nić proporcjonalnie do stosunku R1/R2 długości odcinków A-E (|AB|/|DE| = |BC|/|CE| = R1/R2). To brzmi bardzo „nauko-

wo” i „matematycznie”, ale w praktyce sprowadza się do dwóch prostych kroków: 

1. Zmniejszaj (Scale) węzły A i C (Rysunek 11.16.4b) aż ich segmenty krzywej dopasują się do konturu. 

2. Przesuń węzeł E wzdłuż lokalnej osi X, aby poprawić kształt krzywej wokół węzła D. 

 

 

Rysunek 11.16.4 Dopasowywanie krzywej do dwóch stycznych łuków o różnych promieniach 

 

Dla węzłów krzywej nie ma polecenia Slide Vertex. Takie skalowanie, jak pokazywane przez Rysunek 

11.16.4b), jest ekwiwalentem tej operacji. 

 
Punkt środkowy (origin) obiektu Curve można zmieniać tak samo, jak robiliśmy to w przypadku siatek: 

 

Rysunek 11.16.5 Ustalenie nowego środka obiektu krzywej  

W przypadku pokazanym przez Rysunek 11.16.5 wyciągnąłem kolejny współliniowy odcinek z końca wieloboku 

sterującego i umieściłem na jego końcu kursor 3D. Potem przełączyłem się w tryb Object Mode i wskazałem go 

jako nowy środek (Origin to 3D Cursor – str. 487) 

 

R1 

R2 
R1 / R2 = 0.875 

A 
B 

C 

D E 

To krzywa dopaso-
wana do dwóch rów-
nych łuków ze środka 

Symetryczna krzywa środkowa przesu-
nięta ponad ten asymetryczny kontur   

A 

B 

C 

D E 

Skaluj te 
dwa węzły 

Przesuń 
ten węzeł 

Środek 
skalowania 

a) 

b) 

Wyciągnij (Extrude) ten 
nowy, współliniowy węzeł 

Umieść tu 
kursor 3D Kontury referencyjne, 

wykorzystane w tej sekcji 
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11.17 Wstawianie kopii (instancji) kolekcji 

W scenę można także wstawiać klony całych kolekcji. To obiekty typu Instance. W odróżnieniu od klonów siatek 

(por. str. 465) nie można ich bezpośrednio edytować. Są bardzo przydatne, gdy potrzebujesz powtórzyć w mo-

delu zespół składający się z kilku części. 

Zanim stworzysz instancję kolekcji, określ położenie jej środka (origin). Znajdziesz je w zakładce 

Properties:Collection, w panelu Instancing (Rysunek 11.17.1): 

 

Rysunek 11.17.1 Wybór obiektów według nazwy 

Wartości Instance Offset są mierzone od środka globalnego układu współrzędnych: umieść w tych polach 

współrzędne „punktu odniesienia” instancji, wyrażone w globalnych współrzędnych sceny.  

By wstawić instancję kolekcji, umieść kursor 3D w miejscu, gdzie ma powstać nowy obiekt (Rysunek 11.17.2a). 

Wywołaj polecenie Add→Collection Instance i wskaż na liście kolekcję źródłową (Rysunek 11.17.2b):  

    

 

Rysunek 11.17.2 Wybór obiektów według nazwy 

Pamiętaj, że lokalne osie kolekcji są równoległe do globalnych osi sceny. Gdy wstawiasz instancję, jej lokalna 

oś Z jest zawsze prostopadła do płaszczyzny ekranu (por. sugerowane ustawienia Blender na str. 429). Właści-

wości instancji wyglądają podobnie jak obiektu Empty (por. str. 472). W oknie Outliner jest ona oznaczana przez 

specjalną ikonę instancji (Rysunek 11.17.2c). 

1. Zaznacz 
kolekcję 
źródłową  

2. Wpisz współ-
rzędne jej środka  

a) b) 

c) 

1. Umieść kursor 3D 
tam, gdzie chcesz 
wstawić instancję 

2. Wybierz to 
polecenie 

3. Wskaż na liście 
kolekcję źródłową 

Specjalna ikona 
obiektu-instancji  

Własności instancji przy-
pominają obiekt Empty 
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Kolekcję źródłową można ukryć (to nie będzie miało wpływu na jej instancje).   

 

 

W odróżnieniu od klonów siatek, instancje są zoptymalizowane do szybkiego renderowania. Czyni to z 

nich doskonałą metodę na powtarzanie złożonych zespołów, np. cylindrów silnika gwiazdowego. 
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Rozdział 12. Blender – edytor siatki (Edit Mode) 

W Blenderze każdy kształt odwzorowany jest za pomocą ścian, połączonych w tzw. „siatkę” (mesh). Tryb okna 

3D o nazwie Edit Mode służy do zmiany siatki zaznaczonego obiektu (/obiektów). 
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12.1 Pojęcia podstawowe 

Siatka (mesh) w Blenderze to zbiór elementarnych ścian (face), krawędzi (edge) i wierzchołków (vertex). Ry-

sunek 12.1.1 pokazuje przykład takiej siatki: 

 

Rysunek 12.1.1 Elementy siatki (mesh) 

Ostatni zaznaczony wierzchołek jest nazywany wierzchołkiem aktywnym (active vertex)  i oznaczony kolorem 

białym. Możesz go wykorzystywać jako środek transformacji1. Ściana w Blenderze może mieć więcej niż cztery 

boki. Staraj się jednak używać w modelu ścian czworobocznych (quads), a w miejscach, gdzie jest to niemożli-

we – trójkątnych. W ten sposób unikniesz wielu problemów podczas eksportu swoich modeli do innych progra-

mów lub silników gier. W szczególnych przypadkach mogą w siatce mogą także istnieć krawędzie bez ścian, 

czy wręcz "osamotnione" wierzchołki bez krawędzi. 

W Blenderze występuje także pojęcie linii krawędzi (edgeloop – Rysunek 12.1.1). Najłatwiej wskazać je na 

siatkach o ścianach prostokątnych. Blender potrafi jednak także znaleźć takie linie także na siatkach o ścianach 

trójkątnych. W tekście używam tego terminu wymiennie z linią wierzchołków (oznacza to samo). 

Pomimo „kanciastej” siatki z ilustracji powyżej, powierzchnia wynikowego obiektu jest gładka. Jest to możliwe 

dzięki modyfikatorowi, który zmienia kształt oryginalnej siatki. W Blenderze istnieje wiele modyfikatorów, lecz 

w tym przypadku użyłem mojego ulubionego – Subdivision Surface. Ten modyfikator zaokrągla wszystkie na-

rożniki w sposób podobny do powierzchni NURBS z systemów CAD (por. str. 632). Dodatkowo, aby ten modyfi-

kator nie musiał generować zbyt wielu ścian, łączę go z ustawieniem cieniowania ścian siatki w tryb „gładki” 

(Shade Smooth – por. str. 515).  

W naszym modelu będziemy często używać Subdivision Surface oraz wiele innych modyfikatorów, ponieważ 

pozwalają tworzyć proste (a przez to łatwe do późniejszych modyfikacji) siatki bazowe. 

 
1 Wybierając z listy Pivot Point nagłówka okna 3D tryb Active Element. 

Krawędź 

Wierzchołek (biały = 
wierzchołek aktywny) 

Linia krawędzi 
(edge loop) 

Ściana 

Wynikowa powierzchnia jest 
wygładzona modifikatorem 
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12.2 Włączenie trybu edycji (Edit Mode) 

Tryb edycji siatki włączasz naciskając przycisk Tab . Alternatywnie możesz także zrobić to za pomocą menu z 

nagłówka okna 3D (Rysunek 12.2.1): 

      

Rysunek 12.2.1 Okno widoku: włączenie trybu edycji 

Powtórne naciśnięcie Tab  przełączy Cię z powrotem do poprzedniego trybu (np. obiektu – Object Mode). Mo-

żesz także wybrać inny tryb z nagłówka widoku, listy rozwijalnej Mode.  

Oprócz kontrolek, które widziałeś już w Object Mode, nagłówek okna 3D w trybie edycji (siatki) wyświetla pasek 

opcji zaznaczania elementów siatki: 

 

 

 

 

 

 

              

Rysunek 12.2.2 Okno 3D: kontrolki dostępne w trybie edycji 

Naciśnij Tab  lub wybierz 

stąd Edit Mode... 

... i jesteś w trybie 
edycji siatki! 

Tryb zaznaczania:            
wierzchołki, krawędzie, ściany 

Te kontrolki występują 
także w Object Mode  

 

Wierzchołki to 
małe kropki 

Środki ścian 
są oznaczane 

kropkami 

wierzchołki krawędzie ściany 
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12.3 Zaznaczanie elementów siatki 

W zasadzie, wierzchołki można zaznaczać tak samo, jak całe obiekty (por. str. 58). Gdy klikniesz w jeden z nich 

LPM  – stanie się zaznaczony i zmieni swój kolor na jasnopomarańczowy (Rysunek 12.3.1): 

 

Rysunek 12.3.1 Zaznaczenie pojedynczego wierzchołka 

Zwróć uwagę, że kolor krawędzi, wychodzących z zaznaczonego wierzchołka ulega stopniowej zmianie. Im 

bliżej zaznaczenia, jest jaskrawszy. To ułatwia szybkie odnalezienie zaznaczonego na siatce obszaru.  

 

Kliknięcie LPM  w jakiś wierzchołek powoduje wyłączenie wszystkich poprzednio wybranych wierzchoł-

ków. To samo dotyczy innych elementów siatki (krawędzie, ściany). 

 
 Aby wybrać wiele wierzchołków: Klikaj w kolejne LPM , trzymając wciśnięty klawisz Shift  (Rysunek 12.3.2): 

 

Rysunek 12.3.2 Wybór wielu wierzchołków 

Kombinacja Shift  - PPM  działa jak przełącznik stanu zaznaczenia: pierwsze kliknięcie w wierzchołek włącza go 

do wybranych wierzchołków. Następne kliknięcie – wyklucza z tego zbioru. 

Tak jak w przypadku obiektów, ostatni zaznaczony wierzchołek jest nazywany wierzchołkiem aktywnym. 

Blender zaznacza go jaśniejszym kolorem. Wszystkie pozostałe zaznaczone elementy są nieco ciemniejsze. 

 

Możesz używać aktywnego wierzchołka jako środka transformacji (obrotu, skalowania). W tym celu 

przełącz aktualny środek (Transformation Pivot Point – por. str. 67) w tryb Active Element. 

Kliknięcie LPM  w wierzcho-

łek zaznacza (lub wyklucza 
z zaznaczenia)  

Podświetlenie 
zanika wzdłuż 
krawędzi 

Klikaj LPM  w ten wierzchołek z 

wciśniętym klawiszem Shift … 

… a na 
koniec 
w ten. 

Ściana, której wszystkie 
wierzchołki są zaznaczone, 
także staje się zaznaczona 

Krawędź łącząca zaznaczo-
ne wierzchołki także staje 
się zaznaczona 

… a potem w te... 

Wierzchołek 
aktywny 
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Aby szybko porzucić aktualne zaznaczenie – naciśnij Alt - A  (Select→None). Jeżeli chcesz zaznaczyć 

wszystko – naciśnij A  (Select→All). 

 
 Na siatce złożonej z czworoboków można także szybko wskazać cały rząd wierzchołków, tworzących topolo-

gicznie linię (edgeloop) . Trzymając wciśnięty Alt , kliknij LPM  w jedną z krawędzi siatki (Rysunek 12.3.3): 

 

Rysunek 12.3.3 Zaznaczanie linii wierzchołków 

Analogicznie, jak w przypadku pojedynczych wierzchołków, możesz wyłączać/wykluczać z selekcji całe linie. 

Trzymaj na klawiaturze wciśnięte Alt - Shift , i klikaj LPM  w krawędzie odpowiednich linii (Rysunek 12.3.4): 

 

Rysunek 12.3.4 Wykluczanie z wyboru linii wierzchołków 

Aby wykluczyć pojedynczą linię wierzchołków z zaznaczenia, kliknij ją LPM  z wciśniętymi Alt - Shift . 

 

Możesz także odwrócić aktualną selekcję (tzn. wybrać to, co nie jest zaznaczone): wystarczy nacisnąć 

na klawiaturze Ctrl - I  (to skrót polecenia Select→Invert). 

 
  

Trzymając wciśnięty 

Alt  kliknij LPM  na tej 

krawędzi… 

… a Blender całą linię 
połączonych wierzchołków 

Trzymając wciśnięte 

Alt - Shift , kliknij  tutaj 

LPM  ... 
.. a potem tutaj ... 

.. i tutaj. 
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W Edit Mode istnieją takie same narzędzia do grupowego zaznaczania jak w Object Mode (str. 58). Na przykład, 

można zaznaczyć grupę wierzchołków obszarem prostokątnym. W tym celu wybierz ikonę Select Box z paska 

narzędzi lub użyj skrótu B  (Select→Box Select – Rysunek 12.3.5): 

 

     

Rysunek 12.3.5 Zaznaczanie obszarem prostokątnym 

Zaznaczone w ten sposób wierzchołki są dodawane do wybranych poprzednio. Pozwala to zaznaczać jakieś 

złożone kształty „kawałek po kawałku”.  

Osobiście wolę jednak posługiwać się inną odmianą wyboru obszarem: wyborem okręgiem. Aby włączyć ten 

tryb, użyj skrótu C  (Select→Circle Select). W odpowiedzi Blender wyświetla na ekranie wokół kursora okrąg 

służący do selekcji (Rysunek 12.3.6):  

                 

 

 

Rysunek 12.3.6 Zaznaczanie okręgiem 

W tym trybie, gdy klikniesz LPM , zaznaczysz wierzchołki, które są wewnątrz okręgu. Rozmiar okręgu możesz 

zwiększać lub zmniejszać, obracając KM . Klikając w różne miejsca, możesz włączać kolejne wierzchołki do 

zbioru selekcji.  

 

Aby użyć trybów wyboru obszarem lub okręgiem do wykluczenia z aktualnego zaznaczania – klikaj 

SPM  zamiast LPM . 

 
Każdy z tych trybów wyboru możesz przerwać (zrezygnować), naciskając Esc . 

1. Naciśnij tu LPM , aby wska-

zać pierwszy narożnik obszaru 

3. Zwolnij LPM  gdy 

ramka selekcji obejmu-
je wszystkie elementy 
do zaznaczenia 
 

2. Przeciągnij  

(LPM ) drugi 

narożnik. 

Kliknij LPM  aby 

zaznaczyć wierz-
chołki w kole 

Obracaj KM  aby zmniejszyć lub 

zwiększyć rozmiar koła selekcji 
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Podczas zaznaczania w oknie 3D ważne jest właściwe dobranie widoku. Rysunek 12.3.7 pokazuje, co się może 

stać, gdy starasz się zaznaczyć górną część siatki z wyłączoną opcją X-Ray: 

 

Rysunek 12.3.7 Typowy błąd zaznaczania przy wyłączonym trybie X-Ray 

Gdy włączysz X-Ray, będziesz widział wszystkie wierzchołki siatki.  Jednak w tym przypadku łatwo o pomyłkę i 

zaznaczenie czegoś dodatkowego (Rysunek 12.3.8): 

 

Rysunek 12.3.8 Typowy błąd zaznaczania przy włączonym trybie X-Ray 

 

Opcja X-Ray bardzo się przydaje przy selekcji elementów siatki, podczas gdy w wielu innych sytua-

cjach będziesz wolał mieć ją wyłączoną. Każde z okien 3D może mieć ten tryb ustawiony inaczej.  

 
 Przy zaznaczaniu pamiętaj o typowych błędach pokazanych na ilustracjach powyżej. Włączaj opcję X-Ray aby 

uniknąć sytuacji, którą pokazuje Rysunek 12.3.7. Wybieraj zawsze projekcję, w której wierzchołki do zaznacze-

nia nie nakładają się na inne, aby uniknąć sytuacji pokazywanej przez Rysunek 12.3.8. 

Zaznaczając te wierzchołki 
w widoku z boku możesz 
myśleć, że zaznaczyłeś 
całą górną część siatki… 

X-Ray: wyłączony 

… podczas gdy wierzchołki 
niewidoczne w widoku z boku 
pozostają nie zaznaczone! 

Zaznaczając te wierzchołki 
z opcją X-Ray możesz 
myśleć, że zaznaczyłeś 
tylko górną część siatki… 
 

X-Ray: włączony 

… podczas gdy niechcący 
zaznaczyłeś także te dwa 
wierzchołki! 
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Do tej pory omówiłem szczegółowo tryb wybierania wierzchołków (Vertex select). Ale na tym możliwości pro-

gramu się nie kończą. W nagłówku okna widoku mamy do dyspozycji jeszcze dwa dalsze tryby: Edge select i 

Face select. Możesz się pomiędzy nimi przełączać używając paska w nagłówku okna 3D (Rysunek 12.3.9):  

 

 

 

Rysunek 12.3.9 Włączony tryb selekcji wierzchołków w nagłówku okna 3D 

 

W każdym z trzech dostępnych trybów selekcji (wierzchołków, krawędzi, ścian) możesz stosować 

wszystkie metody zaznaczania, które opisałem na poprzednich stronach. 

 
Gdy włączysz tryb zaznaczania krawędzi, zmieni się sposób wyświetlania siatki (Rysunek 12.3.10): 

 

Rysunek 12.3.10 Tryb zaznaczania krawędzi 

Tryb zaznaczania krawędzi jest przydatny do zaznaczenia dwóch przeciwległych krawędzi ściany (np. do po-

działu lub zmiany współczynnika Crease). W przypadku pokazanym Rysunek 12.3.10, w trybie Vertex select 

Blender zaznaczyłby wszystkie cztery krawędzie tej ściany.  

Ostatnim trybem zaznaczania jest zaznaczanie całych ścian (Rysunek 12.3.11): 

 

Rysunek 12.3.11 Tryb zaznaczania ścian 

Kliknij LPM  

by zaznaczyć 
całą ścianę 

Środki 
ścian 

Tryb Face select 
X-Ray: 

włączony 

W trybie X-Ray narzędzia Circle i Box 
pomijają ściany, których środki leżą poza 
granicą zaznaczanego obszaru  

 

Kliknij LPM  by 

zaznaczyć tę 
krawędź 

Tryb Edge select 

Vertex select Face select 

Edge select 
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12.4 Wyciąganie (Extrude) 

Aby wytłoczyć wybraną krawędź, zaznacz ją. Naciśnij E   (Mesh→Extrude→Extrude Edges). W odpowiedzi 

Blender tworzy jej kopię, za którą „ciągnie” nowe krawędzie i ściany, łączące nowe wierzchołki z wierzchołkami 

oryginału. Kliknij LPM  w miejscu, gdzie ma zostać ostatecznie umieszczona nowa krawędź (Rysunek 12.4.1): 

              

Rysunek 12.4.1 Wyciąganie krawędzi 

 

Podczas przesuwania wytłoczonych elementów możesz ograniczyć ich ruch do osi X , Y , lub Z  – te 

skróty działają tak samo, jak w standardowym poleceniu przesunięcia (por. str. 506). 

 
Aby wytłoczyć wybrany obszar, zaznacz go. Naciśnij E  (Mesh→Extrude→Extrude Region - ten skrót zależy 

od zaznaczenia). Blender kopiuje zaznaczone ściany i zaczyna przesuwać je w kierunku normalnym. Ten kieru-

nek to średnia wektorów normalnych (prostopadłych) zaznaczonych ścian (Rysunek 12.4.2): 

                     

Rysunek 12.4.2 Wyciąganie obszaru 

Kliknięcie LPM  kończy operację.  

 

Naciśnij Z  aby przełączyć się z tego domyślnego kierunku na swobodne przesuniecie wzdłuż global-

nego układu współrzędnych. Następne, będąc nadal w trybie Move uruchomionym przez polecenie 

Extrude, użyj skrótów X , Y  lub Z  aby ograniczyć przesuniecie do jednej osi. 

3. Przesuń te 
nowe krawędzie 

i kliknij LPM  

1. Zaznacz 
krawędzie 

Kopie zaznaczonych 
krawędzi 

2. Naciśnij E  

Aktualne przesunięcie 

Przesuwasz 
prostopadle do 
zaznaczonych 
ścian! 

3. Przesuń te 
nowe krawędzie 

i kliknij LPM  

1. Zaznacz 
krawędzie 2. Naciśnij E  
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Jeżeli zaraz po wywołaniu polecenia Extrude naciśniesz Esc  – przerwana zostanie (tylko!) druga część 

operacji. Tego zazwyczaj nie dostrzeżesz, ale zaznaczone krawędzie/ściany/wierzchołki uległy już po-

wieleniu i teraz zaznaczone są te kopie. Aby usunąć z siatki także te duplikaty – wywołaj polecenie 

Edit→Undo ( Ctrl - Z ). 

 
Aby zamiast przesunięcia rozpocząć skalowanie wytłaczanych elementów, natychmiast po wywołaniu polecenia 

Extrude naciśnij S  ( E , S ). A gdy naciśniesz po E  klawisz R , zaczniesz je obracać. W takim przypadku suge-

ruję ustawiać wcześniej tryb Pivot na 3D Cursor. W tym trybie możesz precyzyjnie określić środek transformacji 

przed wywołaniem polecenia Extrude. Używaj innych opcji środka: Median Point czy Bounding Box Center gdy 

nabierzesz więcej doświadczenia1. 

Narzędzie Extrude znajdziesz także w przyborniku (Rysunek 12.4.3): 

 

Rysunek 12.4.3 Narzędzie Extrude i jego ornamenty 

Jak widać na ilustracji powyżej, możesz wybierać spośród różnych wariantów polecenia Extrude. Domyślnie jest 

to Extrude Region, odpowiadający poleceniom Extrude Edges/Extrude Region z menu. W tym trybie nadal mo-

żesz używać wszystkich opcji zaznaczania, omówionych w sekcji 11.2 (str. 503) 

Ornament narzędzia Extrude (Rysunek 12.4.3) składa się z dwóch elementów: białego kręgu i żółtego „drążka”: 

• Przeciągnij (LPM) biały krąg aby skopiować zaznaczony fragment siatki i przesunąć go w dowolne 

miejsce (precyzyjniej: dowolne miejsce na płaszczyźnie równoległej do aktualnej płaszczyzny ekranu). 

• Przeciągnij (LPM) żółty „drążek” aby skopiować zaznaczony fragment siatki i przesunąć go w kierunku 

prostopadłym (uśredniony kierunek normalny wszystkich zaznaczonych ścian) 

Gdy wybrany wariant narzędzia Extrude nie pozwala na swobodne przesuwanie po ekranie (na przykład – 

Extrude Along Normals), Blender nie wyświetla białego kręgu. 

 
1 Median Point leży w „środku ciężkości” zaznaczonych wierzchołków. Bounding Box Center jest w środku najmniejszego „pudełka” które 

obejmuje wszystkie zaznaczone wierzchołki. Bardziej intuicyjnym trybem jest Active Element. W tym trybie możesz widzieć ten punkt (to 

ostatni z zaznaczonych wierzchołków, podświetlony nieco jaśniejszym kolorem niż pozostałe). 

Warianty Extrude  

Złap (LPM ) biały 

krąg, aby przesuwać 
zaznaczenie po 

płaszczyźnie ekranu 

Do przesuwania w kierunku 
normalnym – pociągnij (LPM ) 

ten „drążek” 

Ornament 
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Czasami zachodzi także konieczność wytłoczenia wybranych wierzchołków (np. po to, by utworzyć "ręcznie" 

nową ścianę). Operację zaczynasz tak, jak zazwyczaj – zaznacz wierzchołki do powielenia. Następnie naciśnij 

Alt - E  (to skrót do submenu Mesh→Extrude). Wybierz polecenie Extrude Vertices 1. W tym momencie Blender 

utworzył kopie zaznaczonych wierzchołków. Kopie te będzie podążać za ruchem myszki, "ciągnąc" za sobą 

krawędzie łączące je z oryginałami. Te krawędzie nie są połączone ścianami (Rysunek 12.4.4): 

                     

Rysunek 12.4.4 Wyciąganie pojedynczych wierzchołków w krawędzie 

Kliknij LPM  w miejscu, gdzie nowe wierzchołki mają zostać ostatecznie umieszczone. 

 
1 Polecenia Extrude Vertices nie ma w przyborniku: jest tylko w menu. 

2. Naciśnij Alt - E  

i wybierz Extrude 
Vertices 

1. Zaznacz 
wierzchołki 

3. Przesuń nowe wierz-
chołki i kliknij LMB   
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12.5 Skalowanie (Scale) 

Zaznacz grupę wierzchołków, które chcesz powiększyć/pomniejszyć, oraz ustal środek transformacji (na liście 

Pivot – Rysunek 12.5.1). W praktyce stosuję trzy rodzaje (tryby) określające te środki: Bounding Box Center, 

Active Element oraz Cursor 3D. Bounding Box Center to środek „pudełka” nadpisanego na zaznaczonych 

wierzchołkach. Active Element to aktywny wierzchołek lub środek aktywnej krawędzi/ściany (por. str. 498, 

502). W trybie 3D Cursor środkiem jest aktualna pozycja kursora 3D (por. str. 67). Zacznijmy od trybu, w którym 

środkiem skalowania jest Bounding Box Center. 

Naciśnij S  (Mesh→Transfrom→Scale). Przełączysz się w ten sposób w tryb skalowania. Na rysunku pojawi się 

kreskowana linia od kursora myszy do środka transformacji. Każde przesunięcie myszy będzie powodować 

zmianę skali zaznaczonych wierzchołków – proporcjonalnie do zmiany długości kreskowanej linii. Dokonywane 

zmiany w kształcie siatki są pokazywane na bieżąco we wszystkich oknach 3D (Rysunek 12.5.1): 

             

Rysunek 12.5.1 Skalowanie względem środka zaznaczonych wierzchołków 

W nagłówku aktywnego okna jest wyświetlana bieżąca zmiana skali wzdłuż każdej osi. Aby zatwierdzić nowe 

położenie wierzchołków (zakończyć transformację), należy kliknąć LPM . Aby zrezygnować z operacji, możesz w 

każdej chwili nacisnąć Esc .  

 

Narzędzie Scale z przybornika (por. str. 70) jest także dostępne w Edit Mode.  

 
 W transformacjach trybu edycji możesz używać tych samych klawiszy modyfikujących co w Object Mode: 

Trzymając wciśnięty klawisz Ctrl  wymuszasz skokową zmianę proporcji (np. co 0.1). Klawisz Shift  "wyhamowu-

je" zmianę skali na ekranie, pozwalając na uzyskanie większej precyzji. Wreszcie kombinacja obydwu – Shift -

Ctrl  – umożliwia skokową zmianę skali o niewielkie wartości (np. co 0.01). 

Jeżeli w trakcie przesuwania naciśniesz X , Y , lub Z  – ograniczysz zmianę skali do jednej z tych osi. W pozo-

stałych kierunkach żaden rozmiar nie ulegnie zmianie. Po pierwszym naciśnięciu klawisza jest wybrana oś glo-

balna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz – przełączysz się na lokalną oś obiektu. To rozróż-

nienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy obiekt jest w jakiś sposób obrócony. 

Aby ograniczyć skalowanie do jednej płaszczyzny, użyj skrótu Shift -[blokowana oś]. Np. Shift - Z  blokuje zmiany 

wzdłuż globalnej osi Z. Gdy naciśniesz taki skrót jeszcze raz, zablokujesz skalowanie wzdłuż lokalnej osi obiek-

tu. (Dlatego aby zablokować zmiany wzdłuż lokalnej osi Z, naciśnij powtórnie Shift - Z ). 

Aktualna 
skala 

3. Przesuwaj 
myszkę ... 

Wybrany środek dla tej 
transformacji: 
Bounding Box Center 

2. Naciśnij S   

4. Kliknij LPM  aby zakoń-

czyć tę transformację 

1. Zaznacz 
wierzchołki 



Rozdział 12 Blender – edytor siatki (Edit Mode) 507 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Często używam skalowania do 0 wzdłuż pojedynczej osi do „spłaszczenia” krawędzi siatki. Poniżej przedstawia 

taką operację. Rysunek 12.5.2a) pokazuje mój cel – spłaszczenie zaznaczonych krawędzi do wskazanej płasz-

czyzny. Środkiem transformacji (Pivot) będzie tu kursor 3D. Zaznaczyłem jeden z wierzchołków leżących na 

płaszczyźnie docelowej (Rysunek 12.5.2a). Potem wywołałem Mesh→Snap→Cursor to Active ( Shift - S , 3 , 

Rysunek 12.5.2b) aby przenieść kursor 3D do tego punktu (Rysunek 12.5.2c):   

 

                       

Rysunek 12.5.2 Spłaszczenie krawędzi – ustawienie kursora 3D w odpowiednim miejscu 

Przełączyłem typ punktu odniesienia (Pivot) na 3D Cursor i zaznaczyłem krawędzie, które chcę zmienić. Potem 

nacisnąłem S , Y . Następnie nacisnąłem klawisz 0  by natychmiast przesunąć wierzchołki od środka skalowa-

nia (por. str. 69) – kursora 3D. Rysunek 12.5.3 przedstawia tę transformację: 

           

Rysunek 12.5.3 Spłaszczenie krawędzi – poprzez zmianę skali do zera 

 

Zmianę skali do zera wzdłuż jednej lub wszystkich osi można także stosować do dokładnego “spłasz-

czania” lub ustalania pozycji grupy wierzchołków nie połączonych krawędziami. 

 
  

Kursor 3D jest 
w miejscu 

docelowym 

2. Wybierz 
Cursor to Active 

b) a) c) 

Y 

Chcę “spłaszczyć” 

te krawędzie 

Alternatywnie: użyj Shift - S  by 

otworzyć menu myszki Snap 

(str. 67) i wybierz opcję 3 . 
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1. Zaznacz wierz-
chołek na docelo-
wej płaszczyźnie  

 

Wszystkie krawę-
dzie są na jednej 

płaszczyźnie 

3. Naciśnij S , Y  

1. tryb Pivot = 
3D Cursor  

2. Zaznacz 
krawędzie 

 

Y 

4. Napisz 0  
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12.6 Przesunięcie (Move) 

Zaznacz wierzchołki do przesunięcia, a następnie naciśnij G  (Mesh→Transfrom→Move) (Rysunek 12.6.1a): 

                

Rysunek 12.6.1 Zaznaczenie wierzchołków 

Przełączysz się w ten sposób w tryb przesuwania, w którym każdy ruch myszy przesuwa zaznaczone wierz-

chołki. Dokonywane zmiany w kształcie siatki są pokazywane na bieżąco we wszystkich oknach 3D. W nagłów-

ku aktywnego okna jest wyświetlane bieżące przesunięcie (Rysunek 12.6.1b). Aby zatwierdzić nowe położenie 

(zakończyć operację), należy kliknąć LPM . Aby zrezygnować, możesz w każdej chwili nacisnąć Esc  .  

 

Narzędzie Move z paska (por. str. 65) jest także dostępne w Edit Mode.  

 
 Wciśnięcie Ctrl  podczas przesuwania przesuwa „skokowo” (np. co 0.1 jednostki). Gdy wciśniesz klawisz Shift  – 

przesunięcia na ekranie "wyhamują", pozwalając na dokładniejsze ustalenie pozycji. Wreszcie kombinacja oby-

dwu – Shift - Ctrl  – umożliwia skokową zmianę położenia o niewielkie wartości (np. co 0.01 jednostki). 

 

Istnieją jeszcze inne tryby “skoku”. Jeżeli wybierzesz z listy rozwijalnej Snap (z nagłówka okna 3D – 

por. str. 64) tryb Vertex, i będziesz trzymał wciśnięty Ctrl  podczas przesuwania, Blender umieści za-

znaczony fragment siatki w najbliższym wierzchołku. “Najbliższy” tu oznacza wierzchołek w pobliżu 

kursora myszki. Ten tryb “znajduje” wszystkie wierzchołki, także w niezaznaczonych obiektach. Przyda-

je się do szybkiego odtworzenia fragmentów pomocniczych konturów w siatce modelu.    

 
 Jeżeli w trakcie przesuwania naciśniesz X , Y , lub Z  – ograniczysz swój ruch tylko do translacji wzdłuż jednej z 

tych osi. Po pierwszym naciśnięciu klawisza jest to oś globalna. Jeżeli jednak naciśniesz ten sam klawisz po raz 

drugi – przełączysz się na lokalną oś obiektu. Takie rozróżnienie pomiędzy osią globalną i lokalną ma znaczenie 

wtedy, gdy obiekt jest w jakiś sposób obrócony.  

Jeżeli chcesz ograniczyć przesunięcie do pojedynczej płaszczyzny, użyj skrótu Shift -[Oś] . Na przykład, Shift -

Z  pozostawia współrzędne Z bez zmian (przesunięcie wzdłuż globalnej osi Z jest zawsze 0). Gdy naciśniesz 

ten skrót ponownie, zablokuje przesuniecie wzdłuż lokalnej osi obiektu. Na przykład: aby zablokować przesu-

nięcie wzdłuż lokalnej osi Z, naciśnij powtórnie Shift - Z . 

1. Zaznacz 
wierzchołek/ 
wierzchołki 

2. Naciśnij G  

by zacząć… 

4. Kliknij LPM  

by zakończyć tę 
transformację 

Aktualne przesunięcie 

3. … przesuń zaznaczo-
ne wierzchołki (podążają 
za ruchem myszki) 
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Rysunek 12.6.2 pokazuje przykład przełączania pomiędzy globalną i lokalną osią X. Łopata śmigła została naj-

pierw obrócona o 120º w prawo (jako obiekt). Następnie przełączyłem się w tryb edycji, zaznaczyłem kilka 

wierzchołków siatki i nacisnąłem G , X . W efekcie zacząłem przesuwać wierzchołki wzdłuż globalnej osi X 

(Rysunek 12.6.2b). Jeżeli nacisnę jeszcze raz X  – przełączę się na przesunięcie wzdłuż lokalnej osi X obiektu 

(Rysunek 12.6.2c): 

                  

Rysunek 12.6.2 Przesuwanie wzdłuż globalnej osi X ( X ) i lokalnej osi X ( X , X ) 

W związku z tym, że obiekt został wcześniej obrócony, jego lokalna oś X jest pochylona. Przesunięcie "na bok" 

zaznaczonych wierzchołków oznacza w tym przypadku przemieszczenie pod kątem (Rysunek 12.6.2c)! 

 

a) b) 

Ruch wzdłuż 
globalnej osi 

Ruch wzdłuż 

lokalnej osi  

c) 

Zaznacz 
wierzchołki 

Siatka obróco-
nego obiektu 

G , X  X  

X 

X (globalna) 
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12.7 Obrót (Rotate) 

Polecenie Rotate (Mesh→Transform→Rotate, skrót: R ) działa w ten sam sposób co w Object Mode (por. str. 

66-68). Jednak w Edit Mode możesz połączyć tę transformację z poleceniem Extrude. Rysunek 12.7.1 pokazuje 

właśnie taki przypadek. 

Zaznacz grupę wierzchołków, które chcesz obrócić, oraz ustal środek tej transformacji (Pivot) (por. Rysunek 

12.7.1a). Możesz wybrać jeden z trybów Pivot w liście rozwijalnej z nagłówka okna 3D lub z menu myszki Pivot, 

dostępnym pod skrótem .  (kropka). W tym przypadku środkiem obrotu będzie 3D Cursor: 

                

Rysunek 12.7.1 Przygotowanie operacji 

Naciśnij E  by wyciągnąć (Extrude) zaznaczone krawędzie, i zaraz potem naciśnij R . Przełączysz się w ten 

sposób w tryb obrotu. Na ekranie pojawi się nowo utworzony segment siatki i kreskowana linia od kursora my-

szy do środka transformacji. Każde przesunięcie myszy będzie powodować obrót zaznaczonych wierzchołków – 

proporcjonalnie do zmiany kąta kreskowanej linii (Rysunek 12.7.1b).  

Domyślnie obrót następuje w płaszczyźnie aktywnego widoku. W nagłówku aktywnego okna jest wyświetlany 

aktualny kąt obrotu. Aby zatwierdzić nowe położenie wierzchołków (zakończyć transformację), należy kliknąć 

LPM . Aby zrezygnować z operacji, możesz w każdej chwili nacisnąć Esc  .  

Jeżeli w trakcie obrotu naciśniesz X , Y  lub Z  – przełączysz się na obrót wokół jednej z tych osi. Po pierwszym 

naciśnięciu klawisza jest wybrana oś globalna. Jeżeli jednak jeszcze raz naciśniesz ten sam klawisz – przełą-

czysz się na lokalną oś obiektu. To rozróżnienie pomiędzy osią globalną i lokalną ma swój sens wtedy, gdy 

obiekt jest w jakiś sposób obrócony. 

 

Narzędzie Rotate z paska (por. str. 66) jest także dostępne w Edit Mode.  

 
 Podczas obrotu możesz dodatkowo trzymać wciśnięty klawisz Ctrl . Jeżeli w liście rozwijalnej Snap nagłówka 

okna 3D (por. str. 64) jest wybrany domyślny Increment, spowoduje to skokową zmianę kąta obrotu (co 5º). W 

przypadku na ilustracji powyżej możesz użyć klawisza Ctrl  by obrócić nowe krawędzie dokładnie o 45º. Jeżeli 

będziesz trzymał wciśnięty klawisz Shift  – zmiana obrót na ekranie "wyhamuje", pozwalając na dokładniejsze 

ustalenie kąta. Wreszcie kombinacja obydwu – Shift  i Ctrl  – umożliwia skokową zmianę obrotu o niewielkie 

wartości (np. co 0.5º). 

1. Określ środek 
tej transformacji 

2. Zaznacz wierzchołki 

3. E , R   

4. Przesuń myszkę, obracając 
nowo utworzony fragment siatki… 

5. Kliknij LPM  

by zakończyć tę 
transformację 
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12.8 Wstawienie nowej linii wierzchołków (Loop Cut) 

Operacja polega na wstawieniu nowej linii wierzchołków (edge loop) pomiędzy istniejące linie siatki. 

Możesz wywołać to polecenie z menu okna 3D: Edge→Loop Cut and Slide lub używając jego skrótu ( Ctrl - R ). 

W pasku narzędzi także znajdziesz narzędzie Loop Cut (Rysunek 12.8.1): 

 

Rysunek 12.8.1 Wywołanie polecenia Loop Cut 

Najpierw masz wybrać, w jakim kierunku i pomiędzy którymi liniami chcesz wstawić nowy rząd wierzchołków. W 

zależności od tego, gdzie ustawisz mysz, Blender pokazuje aktualną możliwość za pomocą fioletowej linii. 

Dla uproszczenia tłumaczenia, nazwijmy okręgi na siatce stożka „równoleżnikami”, a krawędzie do nich po-

przeczne – „południkami”. Rysunek 12.8.2a) pokazuje, że gdy zbliżysz kursor do jakiegoś „południka” siatki, 

Blender zaproponuje utworzenie nowego „równoleżnika”. Ta nowa linia zostanie utworzona pomiędzy dwoma 

sąsiednimi „równoleżnikami”, które są najbliższe kursora. Jeżeli z kolei zbliżysz kursor w pobliże „równoleżnika” 

– Blender zaproponuje nowy „południk” (Rysunek 12.8.2b): 

 

      

Rysunek 12.8.2 Wybór kierunku i pary sąsiednich linii 

Wybór kierunku i sąsiednich linii siatki zatwierdzasz kliknięciem LPM . 

W tym trybie Blender dyna-
micznie rysuje proponowaną 
linię na powierzchni siatki. 

Loop Cut  

Skrót: Ctrl - R  

a b 

“Południk” 
Gdy zbliżysz 
kursor myszki 

do “południka”… 

Sąsiednie 
“równoleżniki” 

… Blender 
zaproponuje 
stworzenie 

“równoleżnika” 

“Równoleżnik” Gdy zbliżysz 
kursor myszki do 
“równoleżnika”… 
 

Sąsiednie 
“południki” 

… Blender 
zaproponuje 
stworzenie 
“południka” 
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Stwórzmy nowy "równoleżnik" (Rysunek 12.8.2a). Po klik-

nięciu LPM  Blender wstawi w zaznaczony obszar nową linię 

wierzchołków (Rysunek 12.8.3). Teraz każde przesunięcie 

myszy przesuwa tą linię po powierzchni siatki – jak w pole-

ceniu Edge Slide (por. str. 513).  

 

Narzędzie Loop Cut z paska i polecenie z menu 

różnią się od siebie. Po wywołaniu polecenia z 

paska, poruszaj myszką z wciśniętym LPM , aby 

przesuwać nową linię po siatce. 

 
 W nagłówku okna 3D program wyświetla % dystansu po-

między sąsiednimi krawędziami. (0% odpowiada krawędzi 

leżącej dokładnie równej odległości od najbliższych „połu-

dników”). Aby zakończyć całą operację, naciśnij powtórnie 

LPM . Oczywiście, w każdej chwili możesz z niej zrezygno-

wać, naciskając Esc . 

W przypadku narzędzia z paska Blender kończy aktualna 

operację gdy zwolnisz LPM . Nie możesz jej przerwać klawiszem Esc .   

 

Jako “stary blenderowiec”, wolę używać wariantu polecenia Loop Cut z menu (skrót: Ctrl - R ). 

 
 Wariant z menu polecenia Loop Cut and Slide udostępnia dodatkową możliwość: możesz stworzyć naraz wiele 

linii krawędzi. Wystarczy obrócić KM  przed kliknięciem myszki (Rysunek 12.8.4): 

              

Rysunek 12.8.4 Tworzenie wielu linii krawędzi naraz 

 

Rysunek 12.8.3 Przesuwanie nowej linii wierzchołków po 

powierzchni siatki 

Nowa linia 
wierzchołków 

Ruch myszy przesu-
wa tę linię „równoleż-
nika” wzdłuż „połu-
dników” siatki 

Względne położenie:  
-1.0  → przy lewej krawędzi; 
  0.0  → dokładnie w środku; 
+1.0 → przy prawej krawędzi. 

Przesunięcie 
myszki przesuwa 
te wszystkie linie 

1. Ctrl - R  

3. Kliknij LPM  

4. Kliknij LPM  

by zakończyć  

2. Obróć KM  by zwiększyć/ 

zmniejszyć liczbę tych linii 
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12.9 Przesuwanie linii wierzchołków (Edge Slide) 

Operacja polega na przesunięciu po ścianach siatki jednej z jej linii wierzchołków (egde loop) w nowe położenie. 

Zaznacz linię wierzchołków, który ma być przesunięta. Te wierzchołki muszą być połączone krawędziami, więc 

zaznaczaj używaj Alt  - PPM . Następnie wywołaj z menu polecenie Mesh→Edges→Edge Slide (nie ma bezpo-

średniego skrótu – por. niżej) lub użyj narzędzia Edge Slide z paska (Rysunek 12.9.1).  

            

Rysunek 12.9.1 Użycie narzędzia Edge Slide 

To narzędzie z paska rysuje żółty „drążek” zakończony okrągłym uchwytem. „Złap i przeciągnij” ten uchwyt 

myszką. Dopóki trzymasz wciśnięty LPM , przesunięcie myszki przesuwa zaznaczoną linię krawędzi. Blender 

wyświetla jej względną pozycję w nagłówku aktywnego okna 3D. Gdy Edge Slide = 0.0, przesuwana krawędź 

znajduje się w oryginalnym położeniu. Gdy zbliżymy ją do linii z prawej (Rysunek 12.9.1), kształt będzie zmie-

niał, aż w końcu stanie się identyczny z lewym rzędem (Edge Slide = -1.0). Gdy zbliżymy zaznaczoną linię do 

linii z lewej, kształt będzie proporcjonalnie się zmniejszał, aż stanie się taki sam jak lewa krawędź (Edge Slide = 

+1.0) . Zwolnij LPM  by zakończyć tę operację. 

Możesz także wywołać drugi wariant tego polecenia używając skrótu Ctrl - E , który otwiera menu Edges w po-

bliżu kursora myszki (jako tzw. popup menu). Następnie możesz wybrać polecenie Edge Slide za pomocą we-

wnętrznego skrótu tego menu: G 1. W tym wariancie nie musisz „łapać” żadnego uchwytu ani trzymać wciśnięty 

LPM . Blender przesuwa tu zaznaczone krawędzie za każdym przesunięciem myszki. Aby zakończyć tę opera-

cję, kliknij LMB . Możesz ją zawsze przerwać naciskając Esc . 

 

 

 

1 Czyli sekwencja klawiszy do wywołania tej wersji Edge Slide to Ctrl - E , G . To dość kłopotliwy skrót dla tak podstawowego polecenia! 

1. Zaznacz 
linię krawędzi 

( Alt -LMB ) 

2. Wybierz z paska 
Edge Slide 

3. Przeciągnij (LPM ) ten 

uchwyt by przesunąć 
zaznaczone krawędzie 
po powierzchni siatki 

Położenie względne 

4. Zwolnij LPM  

by zakończyć 
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12.10 Wygładzanie siatki (Subdivision Surface) 

W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modifier. Spośród dostępnych "modyfi-

katorów" siatki wybierz Subdivison Surface (Rysunek 12.10.1):  

   

 

 

 

 

 

 

 

 

 

Rysunek 12.10.1 Dodanie modyfikatora wygładzenia siatki (Subdivision Surface) 

Dodanie modyfikatora wygładziło powierzchni – wszystkie narożniki uległy zaokrągleniu. W rezultacie podziału 

oryginalnych 12 ścian jest ich teraz 192. To tak zwana "powierzchnia podziałowa". Wierzchołki oryginalnej siatki 

pełnią rolę tzw. punktów sterujących (control points). Możesz zmienić kształt powłoki, zmieniając ich położenie. 

Jednocześnie w zestawie Modifiers pojawiła się panel z parametrami tego modyfikatora (Rysunek 12.10.2): 

 

Rysunek 12.10.2 Modyfikator Subdivision Surface 

Proponuję ustalać liczbę podziałów powierzchni (Levels) na 1, 2, w wyjątkowych przypadkach 3. To zapewni 

odpowiedni kompromis pomiędzy liczbą ścian a wizualną „gładkością” wynikowej powierzchni. Zwróć uwagę, że 

możesz w każdej chwili zmienić liczbę podziałów powierzchni. To może mieć znaczenie, gdy dla potrzeb gry 

chcesz mieć model o jak najmniejszej liczbie ścian. Dzięki Subdivision Surfaces możesz używać tego samego 

modelu raz w roli „dokładnego” (więcej ścian), a innym razem – „uproszczonego” (mniej ścian).  

 

Więcej szczegółów o powierzchniach podziałowych znajdziesz w sekcji 16.2, str. 632. 

 

1. Otwórz 
zakładkę 
Modifiers 

2. Rozwiń tę listę 

„Gładka” 
powierzchnia 

wynikowa 

Wierzchołki siatki 
są jej punktami 

sterującymi 

Liczba 
podziałów 

Otwiera menu 
modyfikatora Usuwa 

modyfikator 

3. Wybierz Subdivision Surface  
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Rezultaty modyfikatorów obiektów, jak Subdivision Surface, są „dynamiczne” (odwracalne). Wystarczy, że usu-

niesz taki modyfikator, klikając w mały przycisk  w lewym, górnym narożniku jego paneli (Rysunek 12.10.2). 

Wówczas wygładzona powierzchnia zniknie, i pozostaniesz z powrotem z podstawową siatką. 

Możesz także "utrwalić" podział siatki, wybierając polecenie Apply z menu modyfikatora (dostępne pod strzał-

ką, którą pokazuje Rysunek 12.10.2). Spowoduje to usunięcie modyfikatora i trwałe przyjęcie przez siatkę 

kształtu powierzchni podziałowej. 

 

Przed wywołaniem polecenia Apply dla modyfikatora, przełącz się do Object Mode ( Tab ). 

 
 Początkowo cienie na wygładzonej siatce zdradzają przebieg krawędzi elementarnych ścian (Rysunek 12.10.1). 

Aby temu zaradzić, zmienimy model cieniowania. Zaznacz wszystkie wierzchołki siatki (naciskając A ). Następ-

nie wywołaj polecenie Face→Shade Smooth (Rysunek 12.10.3a):   

     

Rysunek 12.10.3 Zmiana modelu cieniowania na "gładki" 

Czasami zobaczysz na powierzchni ciemne cienie, biegnące wzdłuż oryginalnych krawędzi. To rezultat niewła-

ściwego skierowania wektorów normalnych w niektórych wierzchołkach siatki! Na szczęście łatwo jest to skory-

gować. Naciśnij Shift - N  (Mesh→Normals→Recalulate Outside). Rysunek 12.10.4 przedstawia rezultat: 

                 

Rysunek 12.10.4 Uporządkowanie kierunku normalnych 

I tym razem rezultat (Rysunek 12.10.4) jest już tym, o co nam chodziło – gładką powierzchnią, bez załamań i 

cieni w miejscu podziału ścian. 

 

1. Zaznacz ściany 

Gładka po-
wierzchnia 
wynikowa 

2. Wywołaj Shade Smooth 

Dziwne 
cienie? 

a) b) 

Gładka po-
wierzchnia 
bez “cieni” Shift - N   
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Po przełączeniu trybu cieniowania ścian na Shade Smooth, wykonaj dodatkowy krok w oknie Properties, za-

kładce Object Data. Znajdź tam panel Normals i włącz w niej opcję Auto Smooth (Rysunek 12.10.5): 

 

Rysunek 12.10.5 Włączenie w siatce opcji Auto Smooth 

To opcja “inteligentnego cieniowania”. Gdy jest włączone Shade Smooth, cieniuje jako „płaskie” (ostre) krawę-

dzie łączące ściany pod kątem większym od progu podanego w panelu Normals. 

Jak to działa? Załóżmy, że wyłączasz opcję Auto Smooth i dodajesz do podstawy stożka pokazywanego przez 

Rysunek 12.10.5 dodatkową wręgę (Rysunek 12.10.6) : 

 

Rysunek 12.10.6 Ostre krawędzie (Auto Smooth wyłączone) 

W tym przypadku Blender stara się cieniować ostrą zewnętrzną krawędź tej wręgi jako „gładką”. To tworzy wi-

doczne artefakty, wyglądające jak dziwne cienie. 

Te artefakty znikają, gdy włączysz opcję Auto Smooth (Rysunek 12.10.7): 

 

Rysunek 12.10.7 Ostre krawędzie (Auto Smooth włączone) 

Własności (Properties) obiektu 

Object Data (siatka) 

Włącz Auto Smooth 

Kąt graniczny 

Ostra 
krawędź 
wręgi  

Auto Smooth: nie 
Artefakty 

cieniowania 

Brak artefaktów 
cieniowania 

Auto Smooth: tak 
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W Object Mode tryby cieniowania siatki są dostępne w menu kontekstowym ( PPM): 

 

Rysunek 12.10.8 Tryby cieniowania siatki w menu kontekstowym obiektu 

W tym trybie polecenia Shade * są stosowane do całej siatki obiektu. Zwróć uwagę na trzecie polecenie: Shade 

Auto Smooth. Ta komenda ustawia cieniowanie Smooth dla wszystkich ścian siatki i włącza jej opcję 

Normals:Auto Smooth. Z okna parametrów tego polecenia ( F9 ) możesz nawet ustawić kąt graniczny.  

Na koniec wskazówka związana z cieniowaniem: 

 

Różne obszary tej samej siatki mogą używać różnych metod cieniowania (jedne mogą być “gładkie”, 

inne – “płaskie”). Aby uzyskać ten efekt, zaznacz tylko część ścian siatki przed wywołaniem polecenia 

Shade Smooth lub Shade Flat.  

 
  

 

Możesz się z powrotem przełączyć z cieniowania “gładkiego” na “płaskie” poleceniem Face→ Shade 

Flat. W trym trybie wszystkie krawędzie są „ostre” (por. Rysunek 12.10.1 lub Rysunek 12.10.2). 

Ustawia cieniowanie 
Smooth i włącza opcję 

Auto Smooth siatki 

Cieniowanie z tego menu jest 
przypisywane do całej siatki  
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12.11 Scalanie wierzchołków (Merge) 

Zaznacz wierzchołki, które powinny zostać scalone w jeden. Mogą się na siebie nakładać, więc zaznacz je na-

rzędziem Box lub Circle, z włączoną opcją X-Ray (por. str. 48). Następnie naciśnij M  (otwiera menu 

Mesh→Merge). Wybierz z niego polecenie At Center (Rysunek 12.11.1a):  

      

Rysunek 12.11.1 Scalanie wierzchołków 

Wizualnie podstawowa siatka pozostaje bez zmian (tylko znikła biała kropka aktywnego wierzchołka). Jeżeli 

jednak ten obiekt używa modyfikatora Subdivision Surface, po połączeniu zobaczysz małą, płaską „falbankę” w 

środku każdej trójkątnej ściany (Rysunek 12.11.1b). Przed scaleniem, te ściany topologicznie były czworokąta-

mi. Taka wypukłość pojawia się na powierzchniach podziałowych wygenerowanych z połączenia ściany trójkąt-

nej z czworokątną). Wypukłość tych „falbanek” zależy od kąta połączenia tych ścian. Znika całkowicie dla kąta 

wynoszącego 180º (tzn., gdy połączone ściany leżą na tej samej płaszczyźnie). 

Aby uniknąć tego efektu, stwórz wokół scalonego wierzchołka nową linię krawędzi. Teraz kąt pomiędzy trójkąt-

nymi ścianami w centrum i przylegającymi do nich ścianami czworokątnymi będzie 180º (Rysunek 12.11.2): 

 

Rysunek 12.11.2 Usuwanie „falbanek” powierzchni podziałowej 

 

Scalanie wierzchołków często tworzy ściany trójkątne. Najlepiej, aby były jakiejś płaskiej powierzchni. 

1. Zaznacz 
wierzchołki 

3. Wybierz to 
polecenie 

2. Naciśnij M  

Jeżeli obiekt ma modyfikator 
Subdivision Surface: scalenie 
wierzchołków może zmienić 
powierzchnię wynikową 

a

) 

b

) 

Wstaw nową linię kra-
wędzi wokół scalonego 

wierzchołka 
Te krawędzie łączą 
ściany leżące na tej 
samej płaszczyźnie 

„Falbanki” 
znikły 

Sugeruję wstawić tę nową linię 
krawędzi przed scaleniem 
środkowego wierzchołka. Zrób 
to narzędziem Loop Cut  

 

“Falbanka” na 
powierzchni 
wynikowej 
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Alternatywnie możesz wybrać inne polecenie scalania, które przydaje się od czasu do czasu do „oczyszczenia” 

siatki z zapomnianych, nakładających się na siebie wierzchołków. Zrób tak: 

1. Zaznacz wszystkie wierzchołki siatki (Select→All lub A ). 

2. Wywołaj polecenie Mesh→Merge→By Distance. 

Zazwyczaj nie potrzebujesz zmieniać domyślnej odległości „granicznej” (= 0.0001). Po wykonaniu tej funkcji, 

Blender informuje o liczbie scalonych wierzchołków w pasku stanu (Rysunek 12.11.3): 

 

Rysunek 12.11.3 Parametry i komunikat polecenia Merge by Distance 

 

Komunikaty w pasku stanu znikają po kilku sekundach. Jednak nadal możesz je znaleźć w dzienniku 

poleceń sesji wyświetlanym w oknie Info (patrz w liście rozwijalnej typów edytora, kolumnie Scripting). 

To jest zaokrąglone 0.0001 
(czwarte miejsce dziesiętne 
nie jest wyświetlane) 

Ta wiadomość znika po 
kilku sekundach  

F8 
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12.12 Rozdzielenie wierzchołków (Rip) 

Zaznacz wierzchołek i wywołaj polecenie Vertex→Rip Vertices (skrót: V ): 

            

Rysunek 12.12.1 Rozdzielenie wierzchołka siatki 

Blender tworzy kopie zaznaczonych wierzchołków i rozłącza w tym miejscu krawędzie siatki. Początkowo nowo 

utworzone wierzchołki znajdują się w oryginalnym położeniu. Blender automatycznie przełącza się w tryb Move 

(por. str. 503), więc możesz je zaraz rozsunąć. Możesz tu także używać takich samych skrótów. Na przykład, 

klawisz Z  ogranicza przesunięcie do osi Z, a trzymanie wciśniętego klawisza Ctrl  włącza tryb „skoku” (Snap). 

 

Jeżeli chcesz pozostawić te zdublowane wierzchołki w oryginalnym położeniu – naciśnij Esc  zaraz po 

wywołaniu polecenia Vertex→Rip Vertices.  

 
 Sugeruję jednak zawsze odsunąć je choć trochę, aby uniknąć trudności z późniejszym zaznaczaniem tych 

wierzchołków.  

Gdy użyjesz polecenia Rip dla wierzchołków łączących ściany, to rozdzieli te ściany wzdłuż ich wspólnej krawę-

dzi (Rysunek 12.12.2): 

                

Rysunek 12.12.2 Rozdzielenie krawędzi siatki  

1.  Zaznacz wierzchołek 

2. Naciśnij V  

Po rozdzieleniu 
wierzchołków 

Blender przełącza 
się w tryb Move 

2. Naciśnij V  

1.  Zaznacz 
wierzchołki 
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12.13 Pogrubienie (Solidify) 

W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modifier. Spośród dostępnych "modyfi-

katorów" siatki wybierz Solidify (Rysunek 12.13.1):  

   

 

 

 

 

 

 

 

 

Rysunek 12.13.1 Dodanie modyfikatora Solidify 

To tworzy kopię powierzchni obiektu, której ściany są przesunięte wzdłuż lokalnych wektorów normalnych o 

zadeklarowaną grubość (Thickness – Rysunek 12.13.2). Blender tworzy także ich obramowanie: 

 

Rysunek 12.13.2 Sterowanie szerokością pogrubienia 

Wartość Offset steruje względnym położeniem wygenerowanej powierzchni. 

1. Otwórz 
zakładkę 
Modifiers 

2. Rozwiń listę 

3. Wybierz Solidify  

Ujemne przesunięcie two-
rzy nowe ściany po we-
wnętrznej stronie siatki 

Ta grubość jest zawsze mie-
rzona prostopadle do po-
wierzchni obiektu    

Zawsze dodawaj mody-
fikator Solidify poniżej 
modyfikatora Subdivision 

Surface (o ile występuje) 



522 Szczegóły obsługi Blendera 3D 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

 

Gdy Offset = 0, zewnętrzne ściany są odsunięte o 0.5∙Thickness ponad oryginalną powłokę obiektu, a 

wewnętrze ściany są 0.5∙Thickness poniżej. Offset = -1 oznacza, że zewnętrzne ściany leżą na orygi-

nalnej powłoce, a wewnętrzne są 1.0∙Thickness poniżej. Oczywiście, możesz tu używać różnych war-

tości Offset z zakresu [-1.0 .. 1.0].  

 
 Jeżeli po dodaniu modyfikatora Solidify zauważysz dziwne cienie wzdłuż zewnętrznych krawędzi powierzchni 

(Rysunek 12.13.3a). W takim przypadku, sprawdź w oknie Properties, zakładce Object Data, opcję Auto 

Smooth (w panelu Normals): 

                         

 

 

Rysunek 12.13.3 Wpływ opcji Auto Smooth 

Powinna być zawsze włączona, jak pokazuje to Rysunek 12.13.3b).  

 

 

Ten modyfikator ma wiele innych opcji. Pełen opis znajdziesz w sekcji “Modeling: Modifiers: Solidify 

Modifier” podręcznika online Blendera.  

a) b) 

Aby usunąć takie 
artefakty cieniowania, 

włącz w tej siatce 
opcję Auto Smooth 

https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/solidify.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/generate/solidify.html
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12.14 Prostowanie linii wierzchołków 

Uzyskanie prostej, poziomej lub pionowej linii krawędzi jest proste: wystarczy zmniejszyć do 0 skalę jej wierz-

chołków wzdłuż prostopadłej osi (por. str. 506)1. Uzyskaną poziomą lub pionową linię można potem obrócić, aby 

uzyskać ukośny ciąg wierzchołków. Oczywiście, istnieją jeszcze inne metody na osiągnięcie podobnego rezulta-

tu. Jednak w tej sekcji chcę pokazać dwie metody, które stosuję w praktyce. 

Powiedzmy, że odtwarzamy kontur profilu płasko-wypukłego za pomocą pojedynczej linii wierzchołków wygła-

dzonej modyfikatorem Subdivision Surface. Kontur na rysunku referencyjnym jest obrócony, więc jego płaski 

dolny obrys jest ukośny. Mamy przybliżyć ten kształt linią złożoną z kilku odcinków (Rysunek 12.14.1). Po prze-

sunięciu i kilku poprawkach w rzucie z boku, udało mi się ustawić krawędzie siatki w coś, co przypomina linię 

prostą. Jednak, gdy się jej przyglądam uważniej, wciąż widzę niewielkie odchylenia: 

 

Rysunek 12.14.1 Sformułowanie problemu: prosta krawędź na dolnym obrusie profilu 

W takim przypadku najprostszym sposobem na zwiększenie dokładności jest zmienić projekcję okna 3D. 

„Okrąż” kontur wokół osi Y tego widoku z boku, aby widzieć ten profil pod ostrym kątem (Rysunek 12.14.2a). 

Zbliż się do modyfikowanego obszaru siatki (Rysunek 12.14.2b): 

                         

Rysunek 12.14.2 Dopasowanie do konturu widzianego pod kątem ostrym 

Teraz możesz lepiej widzieć wszystkie drobne odchylenia od konturu narysowanego na planach. Skoryguj je 

przesuwając poszczególne wierzchołki wzdłuż osi Y ( G , Y ). 

 

Ta prosta metoda jest wystarczająco dokładna w większości przypadków. Można ją także stosować do 

dopasowywania do konturów zakrzywionych. W ich przypadku ogranicz przesunięcia wierzchołków 

do płaszczyzny rysunku referencyjnego (na ilustracji powyżej byłby to skrót G , Shift - Z ).   

 
1 Mam na myśli następujące kroki: 1. Zaznacz wierzchołki które mają utworzyć linię prostą. 2. Przełącz tryb Transformation Pivot na 

Bounding Box Center. 3. Zmniejsz do 0 skalę wzdłuż prostopadłej osi (globalnej lub lokalnej)  

Wynikowa 
gładka 
krzywa 

Kontur referencyjny 
(największa sekcja) 
 

Ten dolny obrys 
ma być linią prostą 

X 

Y 

Y 

X 

1. Okrąż 
wokół osi Y 

2. Zbliżenie 

 

a) b) 
Y 

3. Dopasuj te wierz-
chołki przesunięciami 
wzdłuż osi Y 
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Jeśli chcesz uzyskać „matematycznie prostą” linię krawędzi, możesz to szybko zrobić za pomocą wtyczki Vertex 

Tools. To jeden z dodatków umieszczonych w archiwum source.zip, towarzyszącemu tej książce (por. str. 19). 

Jeżeli skonfigurowałeś Blendera i pliki skryptów wg sekcji 10.6 (str. 435), wystarczy tylko aktywować tę wtyczkę 

w sekcji Add-ons okna Edit→Preferences (Rysunek 12.14.3): 

 

Rysunek 12.14.3 Włączenie wtyczki Vertex Tools 

Jeżeli nie skopiowałeś tych plików konfiguracji Blendera, musisz najpierw zainstalować ten dodatek. Zrób to tak, 

jak opisano w sekcji 10.10 (str. 443), instalując plik: source\Blender cfg\scripts\addons\mesh_vertex_tools.py. 

Po aktywowaniu, Vertex Tools dodaje trzy nowe polecenia u dołu menu Vertex. 

Aby wyprostować linię krawędzi, zaznacz jej wierzchołki i wywołaj polecenie Vertex→Align (Rysunek 12.14.4): 

       

Rysunek 12.14.4 Prostowanie linii wierzchołków poleceniem Vertex→Align 

W odpowiedzi, wtyczka wyrównuje położenia wewnętrznych wierzchołków zaznaczonej linii krawędzi, tak że 

leżą one na linii prostej łączącej dwa najdalsze zaznaczone wierzchołki. 

 

Aby uniknąć ewentualnych “skutków ubocznych” tego wyrównywania, sugeruję wywoływać to polece-

nie dla wstępnie wyrównanych linii wierzchołków, tak jak na ilustracji powyżej. 

1. Otwórz sekcję 
Add-ons 

2. Wybierz dodatki 
użytkownika 

3. Włącz Mesh: Vertex Tools  

2. Wywołaj Align  

1. Zaznacz wierzchołki 
 

Wyrównuje wszystkie 
wewnętrzne wierzchołki 

Prosta linia pomiędzy 
dwoma zewnętrznymi 

wierzchołkami 
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12.15 Tymczasowe ukrywanie elementów siatki (Hide Selected) 

Czasami przydaje się tymczasowo ukryć część siatki. Możesz to zrobić za pomocą poleceń z submenu 

Mesh→Show/Hide. 

Aby ukryć część siatki: zaznacz ją, a potem naciśnij H  (Mesh→Show/Hide→Hide Selected): 

          

Rysunek 12.15.1 Tymczasowe ukrywanie części siatki 

Naciśnięcie Alt - H  (Show/Hide→Reveal Hidden) przywraca widoczność wszystkim ukrytym elementom: 

           

Rysunek 12.15.2 Odsłanianie ukrytych części siatki 

Ukrywanie przydaje się szczególnie przy pracy z rezultatem podziału siatki (Rip – por. str. 520). W przypadku 

poniżej rozdzieliłem wierzchołki zaznaczonej krawędzi i pozostawiłem je w tym samym miejscu. Teraz chciał-

bym zmodyfikować ściany żebra, pozostawiając pozostałe fragmenty siatki bez zmian (Rysunek 12.15.3): 

           

Rysunek 12.15.3 Rozdzielanie (topologiczne) krawędzi siatki   

Jeżeli masz szczęście, po poleceniu Rip Blender podświetli wierzchołki ścian, które zamierzasz zostawić bez 

zmian (jak w ilustracji powyżej). Wszystko co należy zrobić to nacisnąć H , by ukryć ten fragment siatki. 

1. Zaznacz 
fragment, który 
chcesz ukryć 

 

2. Naciśnij H  

 

Odsłonięte fragmenty 
są zaznaczone 

Alt - H  

 

Rip Vertices 
Żebro 

Krawędź natarcia 

Wspólna 
krawędź 

W każdym z tych 
miejsc są po dwa 

wierzchołki  
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Gorzej, gdy w rezultacie polecenia Rip Blender zaznaczy drugą z wydzielonych linii wierzchołków (Rysunek 

12.15.4a). W tym przypadku będziesz miał problemy z zaznaczeniem poprzez kliknięcie punktów należących do 

ścian krawędzi spływu, bo przypadkiem możesz zaznaczyć znajdujące się w tym samym miejscu wierzchołki 

żebra (Rysunek 12.15.4b): 

           

Rysunek 12.15.4 Problemy z zaznaczeniem nakładających się wierzchołków   

W tym przypadku zaznacz lepiej wszystkie ściany krawędzi natarcia ( Alt - Shift -LPM  – por. Rysunek 12.15.5a), a 

potem wyklucz z tego zaznaczenia (np. używając narzędzia Circle Select) wierzchołki, których nie chcesz ukryć 

(Rysunek 12.15.5b): 

       

Rysunek 12.15.5 Alternatywna metoda zaznaczenia jednej z dwóch nakładających się linii wierzchołków  

Teraz możesz ukryć zaznaczoną linię wierzchołków ścian krawędzi natarcia (Rysunek 12.15.6): 

       

Rysunek 12.15.6 Alternatywna metoda zaznaczenia jednej z dwóch nakładających się linii wierzchołków  

 

Wierzchołki żebra, 
zaznaczone w wyni-

ku polecenia Rip  

a) b) 

Klikałem tu LPM , ale 

Blender zaznacza 
wierzchołek żebra! 

a) b) 

X-Ray: wł.  

Zaznacz całe 
linie krawędzi 

Wyklucz wierzchołki 
nie do ukrycia  

H  

 

Teraz można łatwo 
zmodyfikować to żebro   
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12.16 Przecinanie powierzchni 

W trybie edycji dostępne są dla siatek trzy operacje Boole’a: część wspólna (przecięcie), suma i różnica. Blen-

der wykonuje je pomiędzy zaznaczonymi i niezaznaczonymi częściami siatki. W przypadku przecięcia i sumy 

nie ma znaczenia, którą część siatki zaznaczyłeś, a którą nie. Ma to znaczenie w przypadku różnicy, którą 

omówimy w tej sekcji. Różnica (Difference) jest domyślną opcją polecenia.  

Zaznacz część siatki, którą zamierzasz użyć jako „narzędzia tnącego”, a następnie wywołaj polecenie 

Face→Intersect (Boolean)  (Rysunek 12.16.1): 

           

Rysunek 12.16.1 Odcinanie części siatki (Boolean:Difference)  

Blender znajduje przecięcia pomiędzy zaznaczonymi i niezaznaczonymi ścianami, a następnie usuwa ściany z 

wnętrza uzyskanej krawędzi przecięcia. 

Jedną z kluczowych kwestii w tej operacji jest obszar, który jest interpretowane jako „wnętrze”. Blender stara się 

je znaleźć wykorzystując zwrot wektorów normalnych do zaznaczonych ścian. Jednak w przypadku powierzchni 

otwartych, takich jak na ilustracji powyżej, to może prowadzić do zaskakujących rezultatów (Rysunek 12.16.2): 

            

Rysunek 12.16.2 Opcje polecenia i ich rezultaty  

Zaraz po wywołaniu tego polecenia otwórz panel z jego parametrami ( F9 ). Rysunek 12.16.1 wykorzystuje do-

myślny algorytm (Solver): Exact. Gdy jednak przełączysz go na Fast, ujrzysz inną część tego obiektu (Rysunek 

12.16.2a). Jest tu także dostępny przełącznik Swap, który przełącza orientację usuwanej części siatki. Na nie-

szczęście, nawet gdy go włączysz, rezultat pozostawia wiele do życzenia (Rysunek 12.16.2b).  

 

2.  Intersect (Boolean) 

1. Zaznacz “tnącą” 
część siatki 

Przycięta 
siatka 

Naciśnij F9  aby 

otworzyć ten panel 

Efekt dla  
metody Fast 

Przełączanie 
usuwanej 

strony siatki 

a) b) 
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Jeżeli napotkałeś podobne problemy do tych, pokazywanych przez Rysunek 12.16.2, to możesz ich uniknąć 

zamykając tnące powierzchnie w „bryłę”. Rysunek 12.16.3a) pokazuje zamkniętą w ten sposób powierzchnię z 

poprzedniej ilustracji. Zmieniłem ją w „bryłę” poprzez wytłoczenie brzegów i zamknięcie góry i dołu 2 n-gonami:  

            

Rysunek 12.16.3 Wykorzystanie do odcinania bryły (powłoki zamkniętej) 

Wykorzystując poprawne narzędzie w kształcie bryły uzyskasz przewidywalny rezultat (Rysunek 12.16.3b). 

Zwróć uwagę, że parametry tego cięcia są takie same jak pokazywane przez Rysunek 12.16.2a). 

 

Jeżeli chcesz wykluczyć część siatki z operacji Boole’a – ukryj ją (por. str. 525) przed wywołaniem po-

lecenia Intersect (Boolean).  

 
 Istnieje także drugie polecenie cięcia: Face→Intersect (Knife) . Tworzy ono w siatce krawędź przecięcia po-

między ścianami zaznaczonymi i niezaznaczonymi. W odróżnieniu od Intersect (Boolean) nie usuwa żadnych 

ścian: 

           

Rysunek 12.16.4 Tworzenie nowej linii wierzchołków poleceniem Intersect (Knife)  

 

*    *    * 

 

Polecenia przecinania są przydatne, lecz zazwyczaj tworzą dodatkowe wierzchołki, przekształcając wiele wyni-

kowych ścian w n-gony. Zazwyczaj trzeba potem „czyścić” siatkę z takich pozostałości „powierzchni tnących”. 

Pokazuję ten proces na następnych dwóch stronach, na przykładzie końcówki skrzydła (Rysunek 12.16.3b). 

 

Intersect (Boolean) 

a) b) 
Przewidywalny 
rezultat 

Zamknięta “w bryłę” 
powierzchnia tnąca 

2.  Intersect (Knife) 

1. Zaznacz 
powierzchnie 
tnące 

Krawędź 
przecięcia 
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Zaraz po operacji Intersect wywołaj Select→Select All by Trait→Loose Geometry, aby upewnić się, że nie ma 

w siatce „zagubionych” wierzchołków lub krawędzi. Następnie możesz zacząć „czyszczenie” (Rysunek 12.16.5):  

                   

Rysunek 12.16.5 Usuwanie niepotrzebnych wierzchołków ze ścian wokół krawędzi przecięcia  

Sprawdź wynikowe ściany, zaczynając od krawędzi natarcia. Zwiększ zbliżenie i poszukaj wierzchołków, które 

łączą tylko dwie krawędzie. Usuń je poprzez „rozpuszczenie” ( X , Dissolve Vertices – por. str. 543). Sprawdź w 

ten sposób każdą ścianę wzdłuż krawędzi przecięcia. 

 

Sprawdzaj te ściany w projekcji perspektywicznej – ponieważ w widoku ortograficznym Blender czasa-

mi pokazuje wierzchołki, które powinny być zakryte przez inne elementy siatki.  

 
 Czasami możesz napotkać małe ściany trójkątne, jak ABC pokazywana przez Rysunek 12.16.6a) lub odcinki 

jak DE na tej samej ilustracji. Zwróć uwagę, że wszystkie te wierzchołki łączą trzy lub więcej krawędzi: 

                                      

Rysunek 12.16.6 Usuwanie innych niepotrzebnych wierzchołków  

W przypadku pokazanym przez Rysunek 12.16.6a), C i E są wierzchołkami wypukłymi1 (dlatego zaznaczyłem je 

na żółto). W typowym przypadku przesunąłbym A i B do C, D do E, i tam bym je scalił (por. str. 518). Jednak w 

przypadku końcówki skrzydła bardziej zależy mi na zachowaniu kierunku trzech krawędzi oznaczonych przez 

Rysunek 12.16.6ab). Dlatego zdecydowałem się usunąć (Dissolve) krawędzie FE i BC. Wiem, że w ten sposób 

tracę dokładny punkt krawędzi przecięcia C (teraz A stanie się wypukłym wierzchołkiem). Powstała różnica w 

wynikowym kształcie wydaje się być w tym przypadku akceptowalna. B i F należą teraz do n-gonów, ale zamie-

rzam poprawić je później, podczas innej operacji.  

 

 
1 Dwie z trzech krawędzi, które łączą, przecinają się pod kątem ostrym  
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Podobnie, w przypadku pokazanym przez Rysunek 12.16.7, powinienem scalić w A wierzchołki B, C, D. Jednak 

chciałem także zachowa oryginalny kierunek krawędzi zawierającej odcinek CD. Ostatecznie wybrałem rozwią-

zanie częściowe: wstawiłem nową krawędź AD ( J  – por. str. 546), a potem usunąłem krawędzie BD i CD:  

                               

Rysunek 12.16.7 Usuwanie niepotrzebnych ścian (czworokątnych)  

 

Moim celem jest uzyskanie wzdłuż całego konturu końcówki wierzchołków łączących krawędzie w „T”.  

 
 Gdy zakończysz to „czyszczenie”, włącz Scene Statistics (w panelu Viewport Overlay – por. str. 53). Zaznacz 

jedną z sekcji skrzydła ( Alt -LPM), która nie była przycięta (np. sekcję 197) i odczytaj liczbę jej wierzchołków. W 

przypadku pokazywanym przez Rysunek 12.16.8a) jest ich 36: 

           

Rysunek 12.16.8 Sprawdzanie krawędzi przecięcia po „oczyszczeniu”  

Teraz zaznacz ( Alt -LPM) całą krawędź przecięcia i sprawdź jej liczbę wierzchołków. Powinna zawierać o 2 wię-

cej, ponieważ oprócz wszystkich podłużnych krawędzi przecina także krawędź spływu sekcji 205 (Rysunek 

12.16.8b)1. 

 

Jeżeli nie możesz zaznaczyć całego brzegu końcówki jednym kliknięciem Alt -LPM , to znaczy, że nadal 

zawiera jakiś nadmiarowy wierzchołek. Znajdź go, usuń i potem sprawdź znowu.  

 
  

 
1 W rezultacie „czyszczenia” tej siatki, inne krawędzie „żeber” nie „dotykają” krawędzi przecięcia biegnącej wzdłuż brzegu tej końcówki.: 

umieściliśmy tam kilka n-gonów. To tymczasowe. Zrobimy z nimi porządek w trakcie retopologii tej siatki (por. str. 248). 
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Jeżeli znużyło cię już „polowanie” na nadmiarowe wierzchołki generowane przez standardowe polecenia prze-

cinania, możesz użyć wtyczki Intersect (por. str. 482) . Analogiczna operacja jest także dostępna w Edit Mode 

jako polecenie Edge→Intersect Faces. Tak jak w przypadku obydwu poleceń standardowych, ta operacja wy-

znacza krawędź przecięcia pomiędzy zaznaczonymi i niezaznaczonymi ścianami siatki (Rysunek 12.16.9): 

    

Rysunek 12.16.9 Wykorzystanie polecenia Intersect Faces  

Jednak ten dodatek wykorzystuje inną metodę wyznaczania przecięcia. Wynikowa linia krawędzi nie jest połą-

czona z pozostałymi ścianami siatki i nie zawiera żadnych dodatkowych wierzchołków. Nawet zdarzają się sytu-

acje odwrotne: w pewnych przypadkach potrafi pominąć któryś z nich. Użyty algorytm jest zbliżony do metody 

Fast z poleceń Intersect (Boolean) i Interesect (Knife). Czasami łatwiej jest ręcznie zbudować nowe ściany wo-

kół takiej odłączonej krawędzi stworzonej przez Intersect Faces niż „czyścić” z nadmiarowych wierzchołków 

rezultaty standardowych poleceń Blendera.    

W odróżnieniu od wariantu dla Object Mode, opcje Intersect Faces są dostępne w panelu Adjust Last Operation 

( F9 ) . Możesz je tu zmienić w sposób interaktywny, obserwując rezultat na ekranie: 

 

Rysunek 12.16.10 Opcje polecenia Intersect Faces  

Opisy tych opcji znajdziesz na str. 483 – 484. 
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12.17 Nacinanie krawędzi na siatce (Knife) 

Polecenie Knife „przecina” ściany siatki nową krawędzią. Jest dostępne w pasku narzędzi (Rysunek 12.17.1a) i 

poprzez skrót klawiatury. Aby uniknąć omyłkowego stworzenia dodatkowych krawędzi, sugeruję korzystać z 

wariantu dostępnego poprzez skrót, w sposób przedstawiony poniżej. 

 
Zaznacz na siatce ściany, które mają zostać przecięte (Rysunek 12.17.1a). Poniżej zaznaczyłem obszarem ( B ) 

ściany po obydwu stronach krawędzi spływu skrzydła (Rysunek 12.17.1b): 

          

Rysunek 12.17.1 Zaznaczenie ścian do przecięcia 

Ustaw projekcję w oknie 3D pionowo ponad zamierzoną powierzchnią cięcia (To narzędzie „tnie” siatkę prosto-

padle do aktualnej płaszczyzny widoku). Naciśnij Shift - K  (Knife, selected faces only). Zwróć uwagę, że kursor 

myszy zmienił się teraz w mały "skalpel". Kliknij LPM  w miejsce ekranu, w którym ma się znaleźć pierwszy punkt 

krawędzi tnącej (Rysunek 12.17.2a). Od tej chwili za kursorem myszy zaczęła teraz podążać linia, pokazująca 

przebieg ostatni segmentu linii cięcia (to mogłaby być linia łamana):  

          

Rysunek 12.17.2 Cięcie siatki za pomocą narzędzia Knife 

Kliknij LPM  w drugi punkt – w ten sposób zakończysz rysowanie pierwszego segmentu (Rysunek 12.17.2b). 

Blender automatycznie ciągnie od ostatnio narysowanego punktu do kursora myszy kolejną linię (Rysunek 

12.17.2c). Aby zakończyć i wykonać cięcie – naciśnij Enter  lub Spację . To spowoduje dodanie proponowanych 

krawędzi do siatki. (Aby zrezygnować z polecenia, w każdym momencie możesz nacisnąć Esc  lub PPM). 
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Rezultat operacji przedstawia Rysunek 12.17.3. Obejrzyj tę siatkę z różnych stron, a zobaczysz, że nowa kra-

wędź biegnie tak na górnej, jak i na dolnej powierzchni lotki (Rysunek 12.17.3b): 

                  

Rysunek 12.17.3 Rezultat dwustronnego cięcia – w rzucie z góry i w przestrzeni 

Linia tnąca Knife może być także wielobokiem. W trybie cut trough (opisany powyżej, wywoływany skrótem 

Shift - K ), gdy w aktualnej projekcji jedna ściana zasłania drugą, Knife przecina (tworzy nową krawędź) na oby-

dwu. Jeżeli użyjesz narzędzia Knife z paska lub wywołasz je skrótem K , Knife przetnie tylko widoczne ściany 

(trym cut trough będzie wyłączony). 

 

Za pomocą Knife można przypadkowo stworzyć ściany o liczbie boków większej niż 4. W grafice kom-

puterowej określa się je jako n-gony. Takie ściany są bardzo przydatne w trakcie formowania siatki. 

Potem jednak staraj się je zastąpić zespołami kwadratów i trójkątów (por. str. 550).  

 
 Zwróć uwagę na informację, wyświetlaną w nagłówku okna w trakcie polecenia Knife. Program wyświetla tam 

bieżące wartości wewnętrznych flag i klawisze, którymi możesz je przełączyć (Rysunek 12.17.4): 

 
 

 

       

Rysunek 12.17.4 Skróty klawiatury i bieżący stan narzędzia Knife, wyświetlane w pasku stanu 

Flagi te odpowiadają następującym trybom działania noża: 

• midpoint snap: skok do środków przecinanych krawędzi; 

• ignore snap: wyłączenie wszelkich skoków do punktów charakterystycznych (trochę pokrętnie, bo stan 

OFF oznacza, że skok jest aktywny); 

• angle constrain: prowadź linię cięcia pod „równymi” kątami: 0º, 30º, 45º, 60º, 90º… Te kąty są ustalone 

względem osi X aktualnej projekcji (tzn. względem widoku w aktywnym oknie 3D); 

• cut through: przecinanie wszystkich zaznaczonych ścian – także gdy są zasłonięte przez inne. 

 

 

Gdy zależy Ci na cięciu dokładnie wzdłuż linii poziomej lub pionowej, użyj trybu angle constrain ( C ).  
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nych i dolnych ścianach lotki 

Widok w płaszczyźnie cięcia Inna projekcja ortograficzna 
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trakcie przecinania 

Aktualny stan flag narzędzia Knife 



534 Szczegóły obsługi Blendera 3D 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

12.18 Kopiowanie fragmentu siatki (Duplicate) 

Zaznacz wierzchołki, które chcesz skopiować i wywołaj polecenie Mesh→Duplicate (skrót: Shift→ D ): 

             

Rysunek 12.18.1 Odsunięcie powielonych wierzchołków 

Blender stworzy kopię zaznaczonego fragmentu siatki. W chwili początkowej, ta nowa część siatki znajduje w 

tym samym miejscu co oryginał. Jest też zaznaczona (Rysunek 12.18.1). Blender automatycznie przełącza się 

w tryb Move (tak jak w poleceniu Extrude – por. str. 503), dzięki czemu możesz od razu odsunąć nowy fragment 

od oryginału. Możesz tu użyć tych samych skrótów. Na przykład, naciśnij klawisz Z , aby przesunąć je wzdłuż 

osi Z, i trzymaj wciśnięty klawisz Ctrl , jeżeli mają zostać przesunięte na jakąś równą odległość. 

 

Jeżeli chcesz pozostawić skopiowany fragment siatki w oryginalnym położeniu – zaraz po wywołaniu 

polecenia Mesh→Duplicate naciśnij Esc . 

 
  

1.  Zaznacz wierzchołki, 
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2.  Shift - D  

Blender zaznacza skopiowa-
ne element i automatycznie 

przechodzi w tryb Move 
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12.19 Podział krawędzi (Subdivide) 

Zaznacz krawędź/krawędzie, które chcesz podzielić. Kliknij PPM  by otworzyć menu kontekstowe. Wybierz stam-

tąd polecenie Subdivide (Rysunek 12.19.1): 

                  

Rysunek 12.19.1 Korzystanie z polecenia Subdivide 

W środku zaznaczonej krawędzi pojawi się nowy wierzchołek.  

 

To samo polecenie możesz znaleźć w menu rozwijalnym Edit Mode okna 3D: Edge→Subdivide. Ta 

funkcja nie ma żadnego skrótu klawiatury. Jednak jeżeli stwierdzisz, że często ją wywołujesz, możesz 

stworzyć swój własny skrót (por. str. 432). 

 
 Zaraz po wywołaniu tego polecenia możesz zmienić jego parametry w panelu Adjust Last Operation ( F8 ), do-

stępnym w dolnym lewym narożniku aktywnego okna 3D (Rysunek 12.19.2). W szczególności, możesz tu zmie-

nić liczbę nowo dodanych wierzchołków (liczbę podziałów): 

 

 

 

 

 

 

 

 

Rysunek 12.19.2 Wielokrotny podział krawędzi Rysunek 12.19.3 Podział krawędzi ścian 

Rysunek 12.19.3 pokazuje efekty działania Subdivide na krawędzie ścian. Rezultat podziału pojedynczej kra-

wędzi ściany wygląda tak, jak pokazuje Rysunek 12.19.1. Jeżeli jednak zaznaczysz wszystkie jej cztery wierz-

chołki (Rysunek 12.19.3a), Subdivide dzieli taką ścianę na cztery części (Rysunek 12.19.3b) . Zwróć uwagę, że 

to polecenie może stworzyć nawet więcej mniejszych ścian, gdy zwiększysz wartość Number of Cuts w panelu 

z jego parametrami. 
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Ale co zrobić, jeżeli chcesz podzielić ścianę na pół (na dwie nowe ściany) ? W trybie Vertex Select (por. str. 502) 

to niemożliwe, ponieważ gdy zaznaczasz czwarty wierzchołek ściany, Blender zaznacza jej wszystkie cztery 

krawędzie. Aby podzielić ścianę na pół, przełącz się w tryb Edge select (Rysunek 12.19.4): 

                  

Rysunek 12.19.4 Podział przeciwległych krawędzi ściany 

W tym trybie możesz zaznaczyć dwie przeciwległe krawędzie ściany. Gdy teraz wywołasz polecenie Subdivide, 

Blender podzieli tę ścianę na pół. 

 

 

Rysunek 12.19.2 pokazuje, że to polecenie ma jeszcze dużo innych opcji. Ich opis znajdziesz w sekcji 

“Modeling: Meshes: Editing: Edge Tools: Subdivide” podręcznika Blendera online.  

Włącz tryb 

Edge Select 

Subdivide 
 

Zaznacz przeciw-
ległe krawędzie 

Blender dzieli ściany 
nową linią wierzchołków 

– produktów podziału 

https://docs.blender.org/manual/en/latest/modeling/meshes/editing/edge/subdivide.html
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12.20 Przesuwanie wierzchołków po krawędziach (Vertex Slide) 

Aby przesunąć pojedynczy wierzchołek wzdłuż jednej z krawędzi, które łączy, zaznacz go (Rysunek 12.20.1a) i 

naciśnij Shift - V  (Vertex→Slide Vertices): 

               

Rysunek 12.20.1 Przesuwanie wierzchołka po krawędzi 

Po wywołaniu tego polecenia Blender zaczyna przesuwać wierzchołek podążając za ruchem kursora myszki. 

Ten ruch odbywa się po krawędzi, do której jest zbliżony kursor. (Podczas operacji jest zaznaczona grubszą 

linią – Rysunek 12.20.1b). W nagłówku okna jest wyświetlane jego względne położenie od pozycji początkowej 

(Vertex Slide = 0.0) do końcowej (przy przeciwległym wierzchołku Vertex Slide = 1.0). Gdy przesuniesz wierz-

chołek w nowe miejsce, zakończ operację kliknięciem LPM  (Rysunek 12.20.1c). Możesz także w każdej w chwili 

z niej zrezygnować, naciskając Esc . 

Możesz także zaznaczyć wiele wierzchołków i wywołać polecenie Slide Vertices. Blender będzie przesuwał 

wszystkie naraz – ale każdy będzie się poruszać po „swojej” krawędzi (Rysunek 12.20.2): 

                       

Rysunek 12.20.2 Przesuwanie kilku wierzchołków jednocześnie 

 

Jeżeli zaznaczysz wszystkie wierzchołki linii krawędzi, Slide Vertices przypomina polecenie Edge Slide 

(por. str. 513). Jednak Slide Vertices jest bardziej czułe na różnice pomiędzy indywidualnymi krawę-

dziami. W siatkach o skomplikowanej topologii może to prowadzić do zadziwiających rezultatów. 
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Aby uniknąć niespodziewanych przełączeń krawędzi w trakcie operacji, możesz wyłączyć tryb Clamp naciskając 

klawisz C . Zrób to po rozpoczęciu przesuwania, gdy wszystkie zaznaczone wierzchołki wydają się być „na wła-

ściwych torach” (Rysunek 12.20.3b): 

         

Rysunek 12.20.3 Przesuwanie wierzchołków wzdłuż ekstrapolacji krawędzi służących im za „tory” ruchu 

Rysunek 12.20.3c) pokazuje dodatkową możliwość przy wyłączonym trybie Clamp. Taki „nieograniczony” wa-

riant polecenia Slide Vertices pozwala na przesuwanie wierzchołków poza granice siatki, wzdłuż ekstrapolacji 

krawędzi służących im za „tory”. Porównaj początkowe krawędzie siatki pokazywane przez Rysunek 12.20.3a) i 

Rysunek 12.20.3c). 

Naciśnij C  

Zaznacz wierzchołki i 

naciśnij Shift - V  
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12.21 Zmiana ostrości krawędzi (Edge Crease) 

Blender pozwala na zmianę ostrości wybranych krawędzi "wygładzonej" siatki. Możesz ten efekt płynnie stop-

niować. Sprowadza się to do tego, że każda krawędź ma dodatkowy parametr – Crease – który może przyjmo-

wać wartości od 0.0 (zupełnie gładka) do 1.0 (zupełnie ostra). Zmianę ostrości pokażę na przykładzie zwiększe-

nia ostrości krawędzi podstawy stożka. (Analogicznie możesz wygładzić ostrą krawędź). 

Zaznacz krawędzie do wyostrzenia, a potem naciśnij Shift - E   (Edges→Edge Crease) (Rysunek 12.21.1): 

 

Rysunek 12.21.1 Stan początkowy: krawędź "naturalnie zaokrąglona" 

Spowoduje to pojawienie się pomocniczej, przerywanej linii, biegnącej od środka zaznaczonych wierzchołków 

do aktualnej pozycji kursora myszy (Rysunek 12.21.2): 

 

Rysunek 12.21.2 Wyostrzanie krawędzi 

Od tej chwili położenie kursora określa poziom wyostrzenia (Crease). Jego wartość jest pokazywana na bieżąco 

w nagłówku aktywnego okna (Rysunek 12.21.2). Do dyspozycji masz zakres wartości od Crease = 0 (naturalna, 

gładka powierzchnia), do Crease = 1.0 (ostra krawędź). Rysunek 12.21.2 pokazuje, na ile wyostrzyła się kra-

wędź przy Crease = 0.4. 

Zwykła wygładzona 
krawędź (Crease = 0) 

Zaznacz 
krawędzie do 
wyostrzenia 

Widok z boku 

Częściowe 
wyostrzenie  

Kursor myszki 

Linia 
pomocnicza 

Dla Crease = 0.4 
zmalał promień 

zaokrąglenia 
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Zmieniając ostrość krawędzi naciśnij klawisz Ctrl , aby zmieniać Crease o stałe kroki (+/- 0.1). 

 
 Gdy zwiększysz ostrość (Crease) do poziomu = 1.0, uzyskasz absolutnie ostrą krawędź (Rysunek 12.21.3): 

 

Rysunek 12.21.3 Krawędź ostra (Crease = 1.0) 

Zwróć uwagę, że krawędź jest ostra tylko w jednym kierunku. W kierunku poprzecznym nadal jest gładka, dzięki 

czemu zachowała kształt okręgu. (Gdybyś chciał uzyskać kształt ośmiokąta – powinieneś wyostrzyć także kra-

wędzie "południków" tego stożka) . 

Zmianę ostrości krawędzi zatwierdzamy kliknięciem LPM . Jeżeli chcesz zrezygnować z operacji – naciśnij Esc . 

Możesz także sprawdzić lub zmienić współczynnik Crease krawędzi w przyborniku ( N ), w zakładce Item, sekcji 

Edges Data (Rysunek 12.21.4): 

 

Rysunek 12.21.4 Alternatywna metoda sterowania współczynnikiem Crease wybranych krawędzi 

W polu Mean Crease możesz sprawdzić średnią wartość tego współczynnika dla zaznaczonych krawędzi. 

Można ją także tutaj zmienić. W przypadku z ilustracji powyżej, jeżeli wpiszesz „0” w to pole, to powierzchnia 

podziałowa na krawędziach powróci do naturalnego, gładkiego kształtu (taki, jaki pokazuje  

Rysunek 12.21.1). 

Zupełnie 
ostra 

krawędź 

W kierunku 
prostopadłym, 
ta krawędź jest 
nadal gładka 

„Ciągnij” myszkę 
aż osiągniesz 
Crease = + 1.0 

 

Blender zaznacza 
ostre krawędzie na 
purpurowo 

Współczynnik Crease 
zaznaczonych krawędzi. 

Można go tu zmieniać 
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Dla wynikowej powierzchni poddziałowej używamy gładkiego cieniowania (opcji Shade Smooth – por. str. 516). 

W tym trybie ustawiona we właściwościach siatki opcja Auto Smooth wystarcza, aby wyświetlać jako ostre 

większość krawędzi z Crease = 1. Jednak czasami możesz ustawić Crease = 1 dla linii krawędzi, która łączy 

sąsiednie ściany pod niewielkim kątem, bliskim 0º (czyi poniżej „progu czułości” funkcji Auto Smooth). W takim 

przypadku będziesz w tym miejscu widział tylko słaby cień (Rysunek 12.21.5a): 

 

 

 

Rysunek 12.21.5 Wykorzystanie flagi cieniowania Sharp w trybie Shade Smooth 

Jeżeli chcesz widzieć tę krawędź jako ostrą, zaznacz ja w Edit Mode (Rysunek 12.21.5b) i wywołaj polecenie 

Edge→Mark Sharp. Gdy przełączysz się w Object Mode, zobaczysz ostre cienie wokół tej krawędzi (Rysunek 

12.21.5c). 

 

Aby powrócić do gładkiego cieniowania, użyj polecenia Edge→Clear Sharp.  

 
W odróżnieniu od współczynnika Crease, Sharp jest tzw. „flagą” i może być tylko ustawiane na „tak/nie”. Nie 

zmienia geometrii wynikowej powierzchni. Jej działanie polega na zmianie kierunku wektorów normalnych (por. 

str. 568) wzdłuż oznaczonej ściany. 

a) 

b) 

c) 

Krawędzie z 
ustawionym 
Crease = 1 

Object Mode 

Edit Mode 

Object Mode 

Zaznacz tę 
linię krawędzi 

jako Sharp 

Teraz te krawędzie są 
cieniowane jako ostre   
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12.22 Usuwanie linii wierzchołków 

Usuwanie linii wierzchołków zachowuje ciągłość ścian siatki. Jest to operacja odwrotna do wstawienia nowej linii 

wierzchołków poleceniem Loop Cut (str. 511). 

Zaznacz linię wierzchołków, którą zamierzasz usunąć (najlepiej – użyj PPM  i klawisza Alt , aby na pewno zazna-

czyć całą linię). Następnie naciśnij X  (lub Mesh→Delete...) i z menu Delete, które się pojawi, wybierz opcję 

Edge Loops (Rysunek 12.22.1): 

 

                                             

Rysunek 12.22.1 Usuwanie linii wierzchołków 

W efekcie rząd wierzchołków, który chcieliśmy usunąć, znikł z siatki. Ciągłość powierzchni została jednak za-

chowana – sąsiadujące wzdłuż usuwanej krawędzi ściany uległy scaleniu. 

 

1. Zaznacz linię 
wierzchołków  

Usunięto linię 
wierzchołków 

Blender zaznaczył 
połączone ściany 

2.Naciśnij 

X  

 3. Wybierz Edge 
Loops 
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12.23 Usuwanie wierzchołków 

Zaznacz wierzchołki, które chcesz usunąć, a następnie naciśnij Delete  (lub X ). Z menu Delete wybierz Vertices 

(Rysunek 12.23.1): 

                                               

Rysunek 12.23.1 Usuwanie wierzchołków z siatki 

W rezultacie usunięcia wierzchołka znikną także wszystkie powiązane krawędzie i ściany. Stąd zazwyczaj rezul-

tatem takiej operacji jest "dziura" w siatce. Jednak rozpoczęcie tworzenia nowych ścian od takiego otworu może 

być najszybszą metodą na zmianę lokalnej topologii siatki. 

Aby usunąć wierzchołek bez usuwania ścian, użyj polecenia Dissolve Vertices (Rysunek 12.23.2): 

                                                

Rysunek 12.23.2 Usuwanie wierzchołków z siatki (bez usuwania ścian) 

 

Usuwając wierzchołek poleceniem Dissolve tworzysz zazwyczaj jakiś n-gon. Pamiętaj, aby po zakoń-

czeniu modelowania wyeliminować wszystkie takie ściany (więcej na ten temat – patrz str. 550). 

 
  

2. Naciśnij 

X  

 

3. Wybierz 

Vertices 

Blender usuwa także krawędzie i 
ściany powiązane ze wskazanymi 

wierzchołkami 

1. Zaznacz 
wierzchołki 

Blender scalił 
powiązane 
ściany  

3. Wybierz 
Dissolve Vertices 
 

2. Naciśnij 

X  

 1. Zaznacz 
wierzchołki 
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12.24 Usuwanie krawędzi 

Zaznacz krawędzie, które chcesz usunąć (wygodniej to zrobić w trybie wyboru krawędzi – por. str. 502). Na-

stępnie naciśnij Delete  (lub X ). Z menu Delete wybierz opcję Edges (Rysunek 12.24.1): 

                                              

Rysunek 12.24.1 Usuwanie wierzchołków z siatki (wraz ze ścianami) 

Jak widać powyżej, gdy usuniesz krawędź, Blender usunie także ściany, które łączyła, ale zachowa wierzchołki. 

Aby usunąć krawędź bez usuwania ścian, użyj polecenia Dissolve Edges (Rysunek 12.24.2): 

                                            

Rysunek 12.24.2 Usuwanie krawędzi z siatki (bez usuwania ścian) 

 

Usuwając krawędź poleceniem Dissolve tworzysz zazwyczaj jakiś n-gon. Pamiętaj, aby po zakończeniu 

modelowania wyeliminować wszystkie takie ściany (więcej na ten temat – patrz str. 550). 

 
 

 

Gdy nie możesz “rozpuścić” krawędzi pomiędzy dwoma trójkątami (czasami tak się zdarza), zaznacz 

ich wszystkie cztery wierzchołki i wywołaj polecenie Face→Tris to Quads ( Alt - J ).  

 

3. Wybierz 
Edges 

2. Naciśnij 

X  

 

1. Zaznacz 
krawędzie  

 

Pozostawia jednak 
wszystkie wierzchołki 

Blender usuwa także ściany powią-
zane ze wskazanymi krawędziami 
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Dissolve 

Edges 
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X  

 

Znikają środkowe 
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12.25 Tworzenie nowej ściany 

Zaznacz wierzchołki (lub krawędzie), na których chcesz "rozpiąć" nową ścianę. Następnie naciśnij F  

(Vertex→New Edge/Face). Polecenie tworzy ścianę łączącą zaznaczone elementy (Rysunek 12.25.1): 

               

Rysunek 12.25.1 Dodanie trójkątnej ściany do siatki 

Ściany liczące więcej niż 4 boki są nazywane n-gonami. Wewnętrznie Blender dzieli je na tymczasowe trójkąty. 

N-gony mogą bardzo uprościć siatkę. Jeżeli jednak używasz modyfikatora Subdivision Surface, mogą powodo-

wać pewne problemy ze kształtem wynikowej powierzchni podziałowej. Na koniec modelowania zawsze staraj 

się zastąpić n-gony kombinacją czworoboków. Jeżeli czworoboczne ściany nie są możliwe, użyj trójkątów. 

Szczegóły takiego „czyszczenia” topologii siatki znajdziesz na str. 550. 

By stworzyć cały ciąg ścian pomiędzy dwoma zaznaczonymi rzędami wierzchołków, użyj polecenia 

Edge→Bridge Edge Loops (Rysunek 12.25.2): 

                    

Rysunek 12.25.2 Łączenie dwóch krawędzi poleceniem Bridge Edge Loops 

 

Liczba wierzchołków w zaznaczonych liniach musi być identyczna. Inaczej rezultat będzie zaburzony.  

 

W przypadku ścian tworzonych “ręcznie”, jak na ilustracji powyżej, można łatwo odwrócić ich orienta-

cję. To może spowodować problem w siatkach wygładzonych za pomocą modyfikatora Subdivision 

Surface lub podczas renderowania. Więcej informacji na ten temat – patrz str. 568.  

 
 

1. Zaznacz 
wierzchołki 2. Naciśnij F  Nowa ściana 

Ta siatka jest wygładzona 
modyfikatorem Subdivison  

1. Zaznacz 
dwie linie 
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2. Wywołaj to polecenie 

Nowy 
segment 

siatki 
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12.26 Tworzenie nowej krawędzi 

Aby stworzyć nową krawędź na pomiędzy wierzchołkami nie należącymi do tej samej ściany: zaznacz dwa 

wierzchołki, a następnie naciśnij F  (Vertex→New Edge/Face – Rysunek 12.26.1): 

                               

Rysunek 12.26.1 Dodanie do siatki nowej krawędzi (bez ściany) 

Aby stworzyć nową krawędź na pomiędzy wierzchołkami ścian: zaznacz dwa wierzchołki, a następnie naciśnij 

J  (Vertex→Connect Vertex Path – Rysunek 12.26.2): 

                                   

Rysunek 12.26.2 Dodanie do siatki nowej krawędzi poprzez podział istniejącej ściany 

To samo polecenie może być użyte do połączenia dwóch wierzchołków z różnych ścian (Rysunek 12.26.3): 

                                   

Rysunek 12.26.3 Dodanie do siatki nowej krawędzi łączącej dwa odległe wierzchołki 
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przeciętych przez utworzoną linię 

Nowa 
krawędź! 
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12.27 Wydzielenie fragmentu siatki w nowy obiekt (Separate) 

Zaznacz fragment siatki, który chcesz przekształcić w nowy obiekt. Następnie naciśnij P  (Mesh→Separate). Z 

menu opcji, które się pojawiło, wybierz Selection (Rysunek 12.27.1): 

                     

Rysunek 12.27.1 Wydzielenie zaznaczenia (lotki) w nową siatkę 

W rezultacie zaznaczone ściany znikają z oryginalnej siatki i stają się siatką nowego obiektu (Rysunek 12.27.2). 

Nie są usuwane jednak tak samo, jak gdybyśmy wybrali polecenie Delete (str. 543). W tym przypadku krawę-

dzie zaznaczonego obszaru pozostaną na swoim miejscu. 

 

Rysunek 12.27.2 Siatka po wydzieleniu lotki 

Nowy obiekt otrzymał taką samą nazwę jak ten, z którego powstał, zakończoną jednak dodatkową końcówką 

typu ".001". Na przykład lotka, wydzielona w ten sposób z płata B.100.Wing, otrzymuje początkową nazwę 

B.100.Wing.001. Oczywiście, zmień ją zaraz na prawidłową (str. 477). 

 

Operacją odwrotną do wydzielenia siatki jest scalenie siatek obiektów (Join Objects, str. 485).  

 
 

 

Aby skopiować fragment siatki w nowy obiekt bez usuwania, przed wywołaniem polecenia Separate 

skopiuj (Duplicate) zaznaczone ściany (por. str. 534). 

1. Zaznacz fragment 
siatki, który chcesz 
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3. Wybierz 
Selection 

2. Naciśnij P  

 

Nowy 

obiekt 
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12.28 Lustrzane odbicie siatki (Mirror) 

Obiekty symetryczne można tworzyć modelując tylko jedną z ich połówek. Drugą połowę można dynamicznie 

wygenerować za pomocą modyfikatora Mirror. 

Zaznacz modyfikowany obiekt. W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modi-

fier. Spośród dostępnych modyfikatorów siatki wybierz Mirror (Rysunek 12.28.1): 

   

Rysunek 12.28.1 Dodawanie modyfikatora Mirror do obiektu 

Ten modyfikator tworzy lustrzaną kopię siatki obiektu (Rysunek 12.28.2): 

 

Rysunek 12.28.2 Domyślny rezultat modyfikatora Mirror 

Domyślnie, Mirror wykorzystuje jako środek symetrii środek (origin) modyfikowanego obiektu, a osie symetrii są 

osiami jego lokalnego układ współrzędnych. Stąd sprawdź przed użyciem modyfikatora, czy ten środek jest we 

właściwym miejscu (por. str. 487). Odbicie lustrzane oznacza skopiowanie siatki połączone ze skalowaniem o 

współczynnik -1 wzdłuż lokalnych osi X, Y, Z obiektu. Możesz wybrać jedną lub więcej z tych osi wykorzystując 

przełączniki X, Y, Z (Rysunek 12.28.2). 

Możesz także użyć innego obiektu jako „dostawcy” środka i osi symetrii. Wskaż go w polu Mirror Object. Daje 

to możliwość tworzenia lustrzanych odbić względem dowolnego środka i osi. 

Gdy używasz razem modyfikatorów Mirror i Subdivision Surface, na liście modyfikatorów obiektu umieszczaj 

Mirror powyżej Subdivision (jeżeli to możliwe). W tym przypadku możesz także włączyć opcję Merge. Ta opcja 

powoduje scalanie oryginalnego wierzchołka i jego kopii, jeżeli są bliżej niż odległość graniczna w polu z prawej. 
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X  
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współrzędnych  
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Opcja Clipping (Rysunek 12.28.2) uniemożliwia podczas edycji siatki przekroczenie przez wierzchołki płasz-

czyzny symetrii. „Zamraża te wierzchołki na tej płaszczyźnie. Może się przydać podczas wprowadzania zmian w 

takiej siatce z lustrzanym odbiciem. 

Do odbicia lustrzanego można wybierać dowolna kombinację osi X, Y i Z. Poniżej pokazuję efekty jednocze-

snego zaznaczenia dwóch lub wszystkich trzech osi symetrii (Rysunek 12.28.3): 

                  

Rysunek 12.28.3 Generowanie symetrycznych kopii wzdłuż dwóch lub trzech osi 

Trzyosiowa symetria może być przydatna np. przy modelowaniu opon kół podwozia. 
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12.29 Weryfikacja topologii siatki 

Pierwszy test jest oczywisty: poszukaj oderwanych, zapomnianych wierzchołków lub krawędzi. Potem poszukaj 

nietypowych ścian. Podczas pracy można nawet przypadkiem stworzyć ściany o więcej niż 4 bokach. Określa 

się je jako n-gony (n-gons). Te n-gony przydają się w modelowaniu. Gdy jednak potem wygładzasz siatkę mody-

fikatorem Subdivision Surface, to ściany, które nie są czworokątami, mogą tworzyć „zmarszczki” na powierzchni 

wynikowej (por. str. 518). Dla takich „wygładzonych” obiektów, n-gony i trójkąty można pozostawiać tylko na 

płaskich obszarach. Dlatego także warto sprawdzić, czy nie wystąpiły w ukończonej siatce: 

1. Wyłącz wszelkie zaznaczenia siatki ( Alt - A ). Włącz statystykę sceny (por. str. 53). 

2. Wywołaj polecenie Select→Select All by Trait→Loose Geometry. Potem sprawdź w statystykach 

sceny, czy nadal jest zaznaczone 0 wierzchołków (Rysunek 12.29.1). Jeżeli tak – to w siatce nie ma 

żadnych zapomnianych elementów. Jeżeli nie – naciśnij X  (Remove), aby je usunąć. 

     

Rysunek 12.29.1 Znajdowanie „zapomnianych” wierzchołków i krawędzi 

3. Poszukaj w siatce ścian trójkątnych: przełącz się w tryb Face Select, włącz cieniowanie X-Ray, następ-

nie wywołaj Select→Select All by Trait→Faces by Sides. Zaraz po tym poleceniu naciśnij F9  i zmień 

jego parametry, ustalając Number of Vertices na 3 (Rysunek 12.29.2): 

 

Rysunek 12.29.2 Znajdowanie ścian trójkątnych 

Jeżeli wszystkie trójkąty są w „bezpiecznych” miejscach siatki – można je tam zostawić.  

W tej siatce nie ma “za-
gubionych” elementów 

Liczba zazna-
czonych 

wierzchołków 

1. Otwórz parametry 

polecenia ( F9 ) 

Liczba trójkątnych 
ścian w tej siatce 

2. Zaznacz 
wszystkie  ścia-
ny o 3 bokach 

Face Select X-Ray 
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4. Poszukaj w siatce n-gonów tym samym poleceniem Select→Select All by Trait→Faces by Sides. Po 

naciśnięciu F9 , ustaw Number of Vertices na 4 i przełącz Type na funkcję Greater Than (Rysunek 

12.29.3): 

 

Rysunek 12.29.3 Znajdowanie n-gonów 

W tej siatce skrzydła są cztery n-gony pomiędzy żebrami 000 i 122. Podobnie jak trójkąty, te ściany powstały, 

gdy tworzyliśmy dodatkową krawędź wzdłuż dźwigara #5 (por. str. 189). Jednak nie uświadomiłem sobie wów-

czas, że ich efektem będzie jeszcze jedna para n-gonów pomiędzy żebrami 122 i 197 (Rysunek 12.29.3). 

Tym niemniej, żaden z tych n-gonów nie tworzy widocznych „zmarszczek” na wynikowej powierzchni podziało-

wej, więc zdecydowałem się je pozostawić bez zmian. 

Gdybyś chciał podzielić je na czworokąty: połącz ( J ) dwa przeciwległe wierzchołki, na przykład te pokazywane 

przez Rysunek 12.29.4a) i b): 

 

           

Rysunek 12.29.4 Podział pięciokąta na czworokąt i trójkąt 

W rezultacie, podzieliłeś pięciokąt pokazany przez Rysunek 12.29.4a) na czworokąt i trójkąt (Rysunek 

12.29.4b). Ewentualne możesz jeszcze wykonać kolejny krok i połączyć dwa sąsiednie trójkąty (Rysunek 

12.29.4c) w czworokąt. Jednak w przypadku przedstawionym na tej ilustracji sugerowałbym pozostawić te dwa 

trójkąty bez zmian: w przeciwnym razie możesz zepsuć profilu kształt żebra 000. 

 

1. Otwórz parametry 

polecenia ( F9 ) 

Liczba n-gonów 
w tej siatce 

2. Zaznacz 
wszystkie ściany 

o więcej niż 4 
bokach 

Żebro 000 

Żebro 122 

Żebro 197 

Dodatkowe kra-
wędzie wzdłuż 

dźwigara #5 

1. Zaznacz 
przeciwległe 
wierzchołki 

2. Naciśnij J  

Usunąć (np. 
Dissolve) tę 
krawędź? 

Pięciokąt 
Czworokąt 

Ściana 
trójkątna 

a) b) c) 
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12.30 Operacje na bryłach (Boolean) 

W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modifier. Spośród dostępnych "modyfi-

katorów" siatki wybierz Boolean (Rysunek 12.30.1):  

   

Rysunek 12.30.1 Dodanie modyfikatora Boolean 

Blender dodaje ten modyfikator na końcu listy modyfikatorów aktywnego obiektu. Początkowo jest nieaktywny: 

musisz wskazać drugą bryłę, która ma być użyta w jednej z trzech możliwych operacji (Rysunek 12.30.2): 

 

Rysunek 12.30.2 Wybór drugiego obiektu 

W polu Object możesz wpisać nazwę drugiej bryły. Jednak sugeruję użyć umieszczonego z prawej przycisku z 

„pipetką”  (Rysunek 12.30.2) do wybrania drugiego obiektu bezpośrednio z okna 3D. 

Rysunek 12.30.3 pokazuje rezultat modyfikatora o ustawieniach pokazanych przez Rysunek 12.30.2:  

 

Rysunek 12.30.3 Rezultat modyfikatora Boolean (Difference) 

1. Otwórz zakładkę 
Modifiers 

2. Rozwiń tę listę 

3. Wybierz Boolean 

Wybierz 
operację 

Kliknij tutaj i wybierz 
drugi obiekt z okna 3D 

W zakładce Properties:Object 
tego obiektu opcję Viewport 
Display:Display As na Wire    

An opening in place 
of the second object 
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Zazwyczaj, „bryłami tnącymi” wybieranymi dla modyfikatorów Boolean są obiekty pomocnicze, stworzone wy-

łącznie do tego celu. Możesz je ukryć, gdy modyfikator zacznie działać. 

Gdy w panelu modyfikatora Boolean włączysz opcję Edit Mode, będziesz widział jego rezultat także podczas 

edycji siatki (Rysunek 12.30.3): 

 

Rysunek 12.30.4 Edycja siatki zmodyfikowanej modyfikatorem Boolean 

W odróżnieniu od efektu polecenia Boolean (Knife) (por. str. 527), rezultat modyfikatora Boolean jest dynamicz-

ny: nie zmienia siatki modyfikowanego obiektu. Możesz łatwo przywrócić modyfikowany obiekt do stanu począt-

kowego (jak pokazywany przez Rysunek 12.30.1) poprzez usunięcie modyfikatora z listy. Modyfikatory Boolean 

pozwalają na prostsze topologie siatek modelu.  

Poniżej kilka końcowych wskazówek, dotyczących tego modyfikatora: 

• Nadal możesz modyfikować kształty obydwu obiektów wykorzystywanych przez ten modyfikator, uzy-

skując szynko inne wycięcia. To jest duża pomoc w modelowaniu historycznych samolotów: możesz ła-

two zmienić kontur wycięcia na lotkę poprzez modyfikację kształtu obiektu tnącego. Robiąc to, będziesz 

widział (w czasie rzeczywistym!) jak się zmienia kształt wycięcia. 

• Modyfikator Boolean umieszczony po modyfikatorze Subdivision Surface przecina ściany gładkiej po-

wierzchni wynikowej. Dzięki temu, nie zmienia jej kształtu poza krawędzią przecięcia. 

• Gdy modyfikowany obiekt jest kształtem otwartym, przed zastosowaniem modyfikatora Boolean nadaj 

mu jakąś „grubość” modyfikatorem Solidify (por. str. 521). W przeciwnym razie możesz uzyskać zaska-

kujące wyniki, jak te opisane na str. 527. 

 

Włącz tę opcję Edit Mode 
aby widzieć rezultat modyfi-
katora podczas edycji siatki 
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12.31 Proste deformacje (Simple Deform) 

Zaznacz obiekt, który chcesz zdeformować. Warto także wyświetlić jego lokalne osie. Możesz to zrobić w za-

kładce Properties:Object, panelu Viewport Display (Rysunek 12.31.1). Potem przejdź do zakładki Modifiers i 

rozwiń tam listę Add Modifier. Spośród dostępnych modyfikatorów siatki wybierz Simple Deform: 

   

Rysunek 12.31.1 Dodawanie modyfikatora Simple Deform do obiektu 

W pierwszej chwili rezultat tego modyfikatora może wyglądać dziwnie. Nie przejmuj się tym, tylko wybierz w 

jego panelu zamierzoną deformację i jej oś (Rysunek 12.31.2): 

 

Rysunek 12.31.2 Skręcanie obiektu za pomocą modyfikatora Simple Deform 

W przypadku powyżej wybrałem deformację Twist. Polega ona na skręceniu obiektu wzdłuż wybranej (lokalnej!) 

osi Axis o podany kąt Angle. Domyślnie, środkiem tej transformacji jest środek deformowanego obiektu, ale 

możesz także wskazać środek innego obiektu (wybierając go do pola Origin). 

 

 

Więcej szczegółów o tym modyfikatorze i jego deformacjach znajdziesz w sekcji “Modeling: Modifiers: 

Simple Deform Modifier” podręcznika Blendera online.  

1. Otwórz zakładkę 
Modifiers 

2. Rozwiń tę listę 

3. Wybierz 
Simple Deform 

Tutaj włącz 
widoczność 

lokalnych osi 
obiektu 

1. Wybierz 
transformację 

2. Wybierz oś 
transformacji 

Kąt skręcenia 
obiektu 

https://docs.blender.org/manual/en/latest/modeling/modifiers/deform/simple_deform.html
https://docs.blender.org/manual/en/latest/modeling/modifiers/deform/simple_deform.html
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12.32 Wyginanie wzdłuż krzywej (Curve) 

Przygotuj krzywą (str. 490). Zaznacz modyfikowany obiekt. W oknie Properties przejdź do zakładki Modifiers i 

rozwiń tam listę Add Modifier. Spośród dostępnych modyfikatorów siatki wybierz Curve (Rysunek 12.32.1): 

   

Rysunek 12.32.1 Dodawanie modyfikatora Curve do obiektu 

Blender dodaje ten modyfikator na koniec listy modyfikatorów obiektu. Przesuń ją potem we właściwe miejsce. 

Początkowo modyfikator Curve jest nieaktywny: trzeba przypisać mu krzywą (Curve Object - Rysunek 12.32.2): 

 

Rysunek 12.32.2 Przypisanie Curve Object 

W polu Curve Object możesz wpisać nazwę obiektu krzywej. Sugeruję jednak kliknąć w umieszczoną z prawej 

„pipetę” (Rysunek 12.32.2) aby bezpośrednio wskazać ten obiekt w oknie 3D. Dla krzywych, sugeruję włączyć 

ich opcje Viewport Display:Show Axis (por. str. 564). Widząc te osie, można łatwo wybrać odpowiednią Deform 

Axis dla tego modyfikatora. Łatwiej także wskazać krzywą kliknięciem w jedną z jej osi. 

Rysunek 12.32.3 pokazuje wstępny rezultat i ustawienia modyfikatora Curve: 

 

Rysunek 12.32.3 Początkowy rezultat modyfikatora Curve 

Gdy porównasz Rysunek 12.32.3 i Rysunek 12.32.2, zauważysz, że ta krzywa nie tylko wygina, ale też skręca i 

obraca deformowany profil. To typowe kłopoty z tym modyfikatorem. Aby wyeliminować te niepożądane defor-

macje, musimy wprowadzić do tej krzywej dwie proste korekty. Pokazuję je na następnej stronie. 

Zaznacz krzywą i przełącz się w Edit Mode. Włącz opcję Viewport Overlays:Normals (znajdziesz ją u dołu tego 

panelu – por. Rysunek 12.32.4): 

Krzywa (obiekt) 

Modyfikowany 
obiekt 

1. Otwórz 
zakładkę 
Modifiers 

2. Rozwiń tę listę 

3. Wybierz Array 

Kliknij tutaj i wskaż 
obiekt krzywej w 
oknie 3D 

Upewnij się, że środki obydwu 
obiektów znajdują się w tym 
samym miejscu, a ich osie mają 
identyczną orientację 

X 

To jedna z 
osi krzywej! 

A 

Siatka została odwrócona. 
Jej sekcja A jest tutaj:  

A 

Siatka obiektu jest 
skręcona o 90º! 
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Rysunek 12.32.4 Wizualizacja kierunku i skręcenia krzywej 

„Normalne” krzywej są uproszczonymi strzałkami. Ich kierunek pokazuje kierunek krzywej. Teraz widać, że ta 

krzywa zaczyna się przy końcu niezdeformowanej części profilu (punkt A). Płaszczyzna tych strzałek pokazuje 

aktualne skręcenie. 

Odwróćmy kierunek tej krzywej: wywołaj polecenie Segments→Switch Direction (Rysunek 12.32.5): 

 

Rysunek 12.32.5 Odwrócenie kierunku krzywej 

W tle możesz zauważyć, że zdeformowana siatka nie jest już odwrócona. 

Kolejna modyfikacja: zaznacz wszystkie węzły ( A ) i w zakładce Item przybornika zmniejsz Mean Tilt o 90º: 

 

Rysunek 12.32.6 Zmiana kąta skręcenia węzłów krzywej 

Teraz przekroje wygiętej wzdłuż krzywej siatki wróciły na swoje właściwe miejsca. 

Gdy krzywa została poprawiona, wróćmy do deformowanej siatki. Włącz w tym obiekcie, w modyfikatorze 

Curve, opcję Edit Mode, by widzieć jego efekt także podczas edycji (Rysunek 12.32.7): 

Viewport Overlays 

Aby zobaczyć te “strzałki”, 
włącz opcję Normals  

A 

Siatka deformowanego 
profilu znów ma po-

prawną orientację 

Skręć tę 
krzywą o 

-90º 

Siatka profilu już 
nie jest skręcona 
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Rysunek 12.32.7 Ocena rezultatu działania modyfikatora (w Edit Mode) 

Zdeformowana siatka z rysunku powyżej wymaga jeszcze kilku poprawek: 

1. Przesuń sekcję A wzdłuż lokalnej osi Z, by wyeliminować odstęp pokazywany przez Rysunek 12.32.7. 

2. Wstaw (Loop Cut) 5 nowych linii krawędzi pomiędzy sekcjami A i B, by lepiej dopasować tę siatkę do 

gładkiego konturu krzywej (Rysunek 12.32.8): 

 

Rysunek 12.32.8 Poprawki, wprowadzane do deformowanej siatki 

Zwróć uwagę, że ten modyfikator także ma opcję On Cage (znaną nam z Subdivision Surface). Gdy ją włą-

czysz, zobaczysz wierzchołki siatki w wersji zdeformowanej (Rysunek 12.32.9): 

 

Rysunek 12.32.9 Deformowana siatka w Edit Mode (On Cage: wł.) 

Gdy jednak spróbujesz przesunąć te wierzchołki, przekonasz się, że pracujesz z ich niezdeformowanymi współ-

rzędnymi (tymi, pokazywanymi przez Rysunek 12.32.7 i  Rysunek 12.32.8). 

Włącz tę opcję, by widzieć tę 
deformację także w Edit Mode 

Niezdeformowana siatka 

Do domknięcia tej 
szczeliny potrze-

bujemy trochę 
dłuższej siatki 

A 

A’ 

Z (lokalna) 

B 

Przesunięta 
sekcja A 

A 

A’ 
Gęstsza siatka 

lepiej się układa 
wzdłuż krzywej  

Ta siatka jest wygładzona 
modyfikatorem Subdivision 

Surface, umieszczonym 
przed modyfikatorem Curve  

Włącz tę opcję, by widzieć 
zdeformowaną siatkę 
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12.33 Skręcanie wzdłuż krzywej (Curve) 

Modyfikator Curve pozwala nie tylko wykrzywiać, ale i skręcać siatkę. W porównaniu z modyfikatorem Simple 

Deform (Twist) zapewnia lepszą kontrolę nad rozkładem kątów skręcenia wzdłuż jej osi. Taka precyzja jest po-

trzebna na przykład podczas modelowania łopaty śmigła.  

Zamiast skręcenia „na stałe”, jakie zastosowaliśmy w sekcji 4.4, przypisz do „płaskiego” wariantu tej łopaty (re-

zultatu sekcji 4.3) modyfikator Curve, skojarzony z prostą krzywą (Rysunek 12.33.1): 

 

Rysunek 12.33.1 Płaska łopata śmigła, skojarzona z prostą krzywą 

Zrób to tak, jak podano w poprzedniej sekcji (str. 555). Użyj krzywej, która tworzy linię prostą i biegnie wzdłuż 

osi łopaty śmigła. Początkowo, taki nowy modyfikator nie zmienia dotychczasowej powierzchni wynikowej. 

Jednak, gdy zmienisz wartość Tilt na jednym z końców krzywej, spowoduje to skręcenie odpowiedniej części 

siatki (Rysunek 12.33.2):  

      

Rysunek 12.33.2 Skręcanie krzywej 

Zwróć uwagę, że rozłożenie tego skręcenia jest nieliniowe (w istocie, to krzywa B-sklejana – B-spline) 

Y 

X 

Nieskręcona łopata 
(obiekt: B.010.Blade) 

Krzywa (Path) 

wzdłuż osi łopaty  

Modyfikator Curve 
z B.010.Blade  

Skręć ten węzeł  

Rozkład efektywnych kątów skręce-
nia wzdłuż krzywej jest także krzywą 

60º 

0º 

0º 

0º 

0º 

Skręcona siatka   
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Teraz możesz skręcić dalsze punkty kontrolne tej krzywej (zmieniając ich wartość Tilt). Możesz je także przesu-

wać wzdłuż osi łopaty, dopóki nie znajdą się w optymalnym położeniu (Rysunek 12.33.3): 

 

Rysunek 12.33.3 Skręcona łopata śmigła 

 

Precyzyjne modelowanie skręconej na stałe siatki łopaty śmigła (na przykład: modyfikowanie konturów 

jego krawędzi natarcia lub spływu) może być bardzo trudne. O wiele łatwiej jest zachować tę siatkę w 

“płaskiej” postaci, a obiekt łopaty skręcić dynamicznie, za pomocą modyfikatora Curve.  

 
 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić plik Blendera ukoń-

czony w tej sekcji: model\p40\history\P40B-23.40.blend . 

36º 

0º 
Rozkład kata skręcenia 

wzdłuż łopaty śmigła 

Tam, gdzie to 
potrzebne, 

wstaw dodat-
kowe węzły 

Przesuń węzły tam, 
gdzie to potrzebne  

Y 

X 
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12.34 Fazowanie i zaokrąglanie krawędzi (Bevel) 

W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modifier. Spośród dostępnych modyfi-

katorów siatki wybierz Bevel (Rysunek 12.34.1): 

   

Rysunek 12.34.1 Dodawanie modyfikatora Bevel do obiektu 

Domyślnie, ten modyfikator fazuje wszystkie krawędzie, które łączą ściany pod kątem większym niż 30º. Szero-

kość fazowania (Amount) jest domyślnie niewielka i wynosi 0.1 (Rysunek 12.34.2): 

 

Rysunek 12.34.2 Początkowy efekt modyfikatora Bevel 

Oczywiście, możesz zmienić ten graniczny kąt (Angle) oraz szerokość fazki (Amount).  

Width Type to metoda „przyłożenia” wartości Amount. Rysunek 12.34.3 wyjaśnia dostępne opcje: 

 

 

    

 

 

 

Rysunek 12.34.3 Różne metody określania szerokości fazki 

Pierwsze trzy pozycje listy (Depth, Width, Offset) reprezentują alternatywne metody określania szerokości 

fazki „wyciętej” pod kątem 45º. Rysunek 12.34.3b) wyjaśnia ich znaczenie. W ostatniej metodzie – Percent – 

szerokość fazki zależy od rozmiarów przyległych ścian (Rysunek 12.34.3c). Dla metody Percent wpisuj w pole 

Amount wartości od 0 do 100 (%). Dla pozostałych metod Amount to długość, wyrażona w jedn. Blendera. 

1. Otwórz zakładkę 
Modifiers 2. Rozwiń tę listę 

3. Wybierz Bevel 

Szerokość fazowania 

Fazuje wszystkie krawę-
dzie łączące ściany pod 
kątem większym od 30º 

Tutaj Amount = 30 (%) 

a) c) 

Width 

Depth 

Offset 

Percent  

70% 

30
% 

30
% 

70% 

b) 

Absolute jest 
podobny do 

Offset 
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Czasami, gdy zwiększysz Amount nic się nie zmieni. Przyczyna jest opcja Clamp Overlap, ukryta na panelu 

tego modyfikatora w sekcji Geometry (Rysunek 12.34.4a): 

              

Rysunek 12.34.4 Clamp Overlap zapobiega nakładaniu się fazek 

Gdy Clamp Overlap jest włączone, Blender sprawdza, czy gdzieś w tej siatce fazy się nie nakładają. Gdy tylko 

wykryje taka kolizję – blokuje ich szerokość (por. Rysunek 12.34.4a). Oczywiście, możesz wyłączyć tę opcję, 

ale wówczas na modelu pojawią artefakty jak te, pokazywane przez  Rysunek 12.34.4b). 

 

Gdy widzisz, że Clamp Overlap zablokował zwiększanie szerokości fazy – sprawdź geometrię siatki! 

Musi się w niej znajdować jakaś zapomniana krawędź lub ściana, która to powoduje.  

 
 Gdy w modyfikatorze Bevel zwiększysz liczbę Segments, uzyskasz zamiast fazowania efekt zaokrąglania kra-

wędzi (Rysunek 12.34.5): 

       

Rysunek 12.34.5 Zaokrąglanie krawędzi  

Oczywiście, dobrym pomysłem jest przełączyć cieniowanie takiej siatki na Shading Smooth (str. 515). Domyślne 

opcje w sekcji profile (Superellipse: Shape = 0.5) tworzą regularne krawędzie o okrągłym przekroju. 

Gdy przełączysz Profile na Custom, możesz zdefiniować swój własny przekrój z krzywych Beziera. W praktyce 

nigdy nie używałem tej opcji. Przypuszczam, że może tworzyć interesujące rezultaty. 

 

Jak dotąd, zawsze używam domyślnego profilu zaokrągleń (takich, jakie pokazuje Rysunek 12.34.5).   
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Jednak nawet sam współczynnik Superellipse:Shape pozwala uzyskać różnie przekroje (Rysunek 12.34.6): 

                         

Rysunek 12.34.6 Sterowanie kształtem zaokrąglenia za pomocą współczynnika Shape 

Zamiast metod „automatycznych”, możesz ręcznie wskazać krawędzie siatki, które mają być fazowa-

ne/zaokrąglone. W tym celu ustaw Limit Mehod na Weight i zaznacz krawędzie, które chcesz zmodyfikować. 

Potem, w przyborniku, ustaw ich współczynnik Item:Bevel Weight na 1.0 (Rysunek 12.34.7): 

 

Rysunek 12.34.7 Ręczna selekcja krawędzi do zaokrąglenia (użycie współczynnika Bevel Weight) 

Bevel Weight może przyjmować wartości od 0 (bez fazy) do 1 (pełna szerokość fazy). Zwróć uwagę, że Blender 

podświetla krawędzie z niezerową wagą fazy na niebiesko. Intensywność tej barwy odpowiada wadze krawę-

dzie. Szerokość fazy / promień zaokrąglenia są proporcjonalne do wartości tych wag. 

Rysunek 12.34.8 pokazuje przypadek dwóch krawędzi zaokrąglonych przez pojedynczy modyfikator Bevel: 

 

Rysunek 12.34.8 Zaokrąglenia dla dwóch różnych Bevel Weight 

Waga fazowania dla dolnej krawędzi jest 1.0, więc promień jej zaokrąglenia to 2.0 (pełen Bevel:Amount). Dla 

wagi = 0.5, przypisanej górnej krawędzi, promień zaokrąglenia jest 1.0 (0.5 * Amount). 

 

Dla każdej krawędzi Blender przechowuje jedną wartość Bevel Weight. Stąd, o ile jednemu obiektowi 

możesz przypisać wielu modyfikatorów Bevel, to tylko jeden z nich może mieć Limit Method = Weight.   
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Zastosowanie modyfikatora Bevel pozwala także zachować prostą topologię siatki, co np. ułatwia późniejsze 

rozwinięcia UV (Rysunek 12.34.9): 

          

Rysunek 12.34.9 Wpływ modyfikatora Bevel na mapowanie UV 

Dotąd fazowaliśmy krawędzie, ale czasami przydatne jest także fazowanie pojedynczych narożników. W tym 

celu przełącz modyfikator Bevel w tryb Vertices. W praktyce, zawsze zaokrąglam tylko kilka narożników siatki, 

więc wybieram tu zawsze Limit Method: Weight (Rysunek 12.34.10): 

      

Rysunek 12.34.10 Zaokrąglanie pojedynczych narożników (tryb Vertices) 

Zwróć uwagę, że na ilustracji powyżej używam alternatywnych wag Bevel Weight wierzchołków, podczas gdy 

Rysunek 12.34.7 pokazywał modyfikację Bevel Weight krawędzi. To zupełnie dwie różne, niezależne wartości. 

Blender przechowuje pierwszą z nich w bloku danych wierzchołka, podczas gdy druga znajduje się w bloku 

danych krawędzi. 

 

 

Ten modyfikator ma jeszcze wiele innych opcji. Kompletny opis znajdziesz w podręczniku online Blen-

dera, rozdziale “Modeling: Modifiers: Bevel Modifier”.  
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12.35 Powielenie siatki (Array) 

Zaznacz modyfikowany obiekt. W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modi-

fier. Spośród dostępnych modyfikatorów siatki wybierz Array (Rysunek 12.35.1): 

   

Rysunek 12.35.1 Dodawanie modyfikatora Array do obiektu 

Blender dodaje ten modyfikator na koniec listy modyfikatorów obiektu. Początkowo, Array umieszcza 

wygenerowaną kopię siatki obiektu obok oryginału (Rysunek 12.35.2): 

 

Rysunek 12.35.2 Początkowe ustawienia modyfikatora Array (Relative Offset) 

Sugeruję korzystać z trybu Constant Offset, w którym można podać wymiary zamiast skali (Rysunek 12.35.3): 

 

Rysunek 12.35.3 Ustawienia w trybie Constant Offset 

Na przykład, jeżeli chcę powielić tę siatkę wzdłuż lokalnej osi Z, zachowując ściśle określony odstęp pomiędzy 

tymi kopiami, włączam tryb Contant Offset i ustawiam Distance:Z na [długość obiektu]+[szerokość odstępu]. 
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12.36 Rzutowanie na powierzchnię (Shrinkwrap) 

Modyfikator Shrinkwrap umieszcza wierzchołki siatki na powierzchni wskazanego obiektu  

Zaznacz modyfikowany obiekt. W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modi-

fier. Spośród dostępnych modyfikatorów siatki wybierz Shrinkwrap (Rysunek 12.35.1): 

   

Rysunek 12.36.1 Dodawanie modyfikatora Shrinkwrap do obiektu 

Początkowo ten modyfikator jest nieaktywny: musisz wskazać obiekt docelowy (Target) . W przypadku poniżej 

(Rysunek 12.36.2) jest to B.100.L.Wing. Wierzchołki modyfikowanej siatki są rzutowane na jego powierzchnię: 

 

Rysunek 12.36.2 Rezultat modyfikatora 

Jak pokazuje to Rysunek 12.36.2, pierścień opadł na skrzydło „jak naleśnik”. W tym przypadku Shrinkwrap 

kompletnie spłaszczył jego pionowy kołnierz (por. stan wyjściowy – Rysunek 12.35.1). 

Na ilustracji powyżej możesz także dostrzec linie pomocniczego cylindra. Używam go tutaj jako odniesienia. 

Przed deformacją (Rysunek 12.35.1) kołnierz pierścienia pasował do jego ścian bocznych. Po rzutowaniu na 

powierzchnię skrzydła pojawiły się odkształcenia, widoczne w rzucie z dołu (Rysunek 12.36.3a): 

             

Rysunek 12.36.3 Wyniki rzutowania na powierzchnię skrzydła metodą Nearest Surface Point 

Widać na nim różnicę pomiędzy cylindrem i tylną częścią zmodyfikowanego pierścienia. Jest to wynik domyślnej 

metody projekcji modyfikatora Shrinkwrap: Nearest Surface Point. To rzutowanie wzdłuż normlanych do po-

wierzchni docelowej (Rysunek 12.36.3b). Powierzchnia skrzydła jest wygięta w dół, więc oryginalny pierścień 

jest „ciągnięty do przodu”, szczególnie na obszarach o większym nachyleniu (bliżej krawędzi spływu).  
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Aby zachować oryginalny kształt pierścienia w widoku z dołu, użyj innej metody rzutowania: Project. Gdy wy-

bierzesz tę opcję, Blender wyświetli w panelu modyfikatora dodatkowe kontrolki (Rysunek 12.36.4). Przełącznik 

Axis określa kierunek rzutowania. 

W przypadku poniżej wybrałem lokalną oś Z. Zwróć uwagę, że zaznaczyłem także opcję Negative, która ozna-

cza, że wierzchołki będą rzutowane w lokalnym kierunku -Z: 

 

Rysunek 12.36.4 Użycie metody Project (wzdłuż lokalnej osi Z) 

Co z kołnierzem pierścienia? Aby „odzyskać” te pionowe ściany, zdefiniujmy w tej siatce dwie grupy wierzchoł-

ków (por. str. 458): Base i Flange, tak jak pokazuje to Rysunek 12.36.5: 

 

Rysunek 12.36.5 Grupy wierzchołków, których użyjemy w tym modyfikatorze 

Ogranicz efekt Shrinkwrap do grupy Base, wybierając tę nazwę w polu Vertex Group panelu tego modyfikatora 

(Rysunek 12.36.6): 

 

Rysunek 12.36.6 Ograniczanie zakresu modyfikacji do grupy wierzchołków 

Po tej zmianie, obydwie linie wierzchołków grupy Base leżą na powierzchni skrzydła, podczas gdy pozostałe 

wierzchołki pozostają w swoim oryginalnym położeniu. 
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Teraz wykonaj następujące kroki: 

1. Skopiuj modyfikator Shrinkwrap. Możesz to zrobić skrótem Shift - D  w panelu modyfikatora, lub wybiera-

jąc polecenie Duplicate z jego menu kontekstowego – por. str. 572). 

2. Przypisz do tego nowego modyfikatora Vertex Group Vertex Group: Flange. 

3. Ustaw jego Offset Vertex Group na -2 (Rysunek 12.36.7): 

 

Rysunek 12.36.7 Złożenie dwóch (ograniczonych) modyfikatorów Shrinkwrap 

Dla łatwiejszej identyfikacji, możesz zmienić nazwy tym dwóm modyfikatorom. 

 

Modyfikator Shrinkwrap rzutuje wierzchołki na wynikową powierzchnię (czyli powierzchnię uzyskaną w 

wyniku działania wszystkich ewentualnych modyfikatorów obiektu docelowego).  

 
 W powierzchni skrzydła pokazywanej przez Rysunek 12.36.5, Rysunek 12.36.6 i Rysunek 12.36.7 wyciąłem 

otwór w powierzchni docelowej. Użyłem do tego wzorcowego cylindra i modyfikatora Boolean. Przez ten otwór 

W lepiej widać deformowany pierścień i kołnierz. Jednak przed uruchomieniem operacji Boolean minimalnie 

zmniejszyłem promień tego „tnącego” cylindra. Gdybym tego nie zrobił, niektóre z wierzchołków rzutowanych 

przez modyfikator Shrinkwrap nie trafiłyby w powierzchnię docelową i „utonęły” w tej dziurze. W rezultacie, lo-

sowe fragmenty siatki pozostałyby na swoich oryginalnych miejscach, tworząc jakąś chaotyczny efekt.  
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12.37 Sterowanie zwrotem wektorów normalnych (Normal) 

W Blenderze każda ściana ma stronę „wewnętrzną” i „zewnętrzną”. Prostopadły do ściany „wektor normalny” 

wskazuje stronę zewnętrzną. 

Aby zobaczyć wektory normalne ścian siatki, włącz odpowiednią opcję w panelu rozwijalnym Viewport 

Overlays (Rysunek 12.37.1):  

 

Rysunek 12.37.1 Włączenie wyświetlania kierunków normalnych do ścian siatki 

W jego sekcji Normals włącz wizualizację normalnych ścian siatki, jak na ilustracji powyżej. Zazwyczaj bę-

dziesz musiał je nieco wydłużyć lub skrócić, korzystając z kontrolki Normals:Size. 

 

Ciągłość zwrotu normalnych jest bardzo ważna. Ewentualne zakłócenie (“odwrócona ściana”) tworzy 

ostrą krawędź na powierzchni wygładzonej modyfikatorem Subdivision Surface, lub dziwne, nienatural-

ne odblaski i cienie podczas renderowania. 

 
 Rysunek 12.37.2a) pokazuje problem geometryczny: ostrą krawędź na wygładzonej powierzchni. Powstała w 

wyniku odwrócenia kierunku normalnych ścian jednego z segmentów torusa: 

                       

 

Rysunek 12.37.2 Ujednolicanie wektorów normalnych 

Te odwrócone ściany są ciemniejsze (w cieniowaniu Solid:MatCap), a ich wektory normalne wyglądają jak nie-

bieskie kropki, gdyż są skierowane do środka torusa. Szybka korekta dla tego i podobnych problemów to: 

1. zaznacz wszystkie wierzchołki siatki ( A , Select→All) 

2. naciśnij Shift - N  (Mesh→Normals→Recalculate Outside) 

Rysunek 12.37.2b) pokazuje rezultat. 
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Polecenie Recalculate Outside może nie być skuteczne dla bardzo skomplikowanych siatek. W takich 

przypadkach zaznacz tylko odwrócone ściany i przestaw je poleceniem Normals→Flip. 
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12.38 Odsunięcie powierzchni (Surface Offset) 

W oknie Properties przejdź do zakładki Modifiers i rozwiń tam listę Add Modifier. Spośród dostępnych modyfi-

katorów siatki wybierz Geometry Nodes, a z listy w panelu modyfikatora – Surface Offset (Rysunek 12.38.1): 

   

 

 

 

 

Rysunek 12.38.1 Dodawanie do obiektu modyfikatora Surface Offset  

To odsuwa wierzchołki siatki wzdłuż ich normalnych na odległość wpisaną w Offset  (Rysunek 12.38.2): 

 

Rysunek 12.38.2 Zmodyfikowana powierzchnia obiektu 

Wartość Offset jest wyrażona w jednostkach Blendera. Może być ujemna lub dodatnia, powodując powiększenie 

lub pomniejszenie modyfikowanego obiektu. 
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Surface Offset jest prostym zestawem węzłów geometrii, który przesuwa wierzchołki siatki na podaną odległość 

wzdłuż ich wektorów normalnych. Stworzyłem go, ponieważ nie mogłem takiej funkcji znaleźć wśród standar-

dowych modyfikatorów Blendera. Dodałem ten zestaw węzłów do domyślnego pliku startup.blend, który towa-

rzyszy tej książce (por. str. 435), więc możesz wybrać go tak, jak pokazuje Rysunek 12.38.1. 

Ponieważ Surface Offset używa normalnych do wierzchołków, najlepiej działa na prostych, sześciennych „pu-

dełkach” lub gładkich, zakrzywionych powierzchniach. Rysunek 12.38.3 pokazuje dodatkową deformację, która 

pojawia się na ostrych krawędziach nieco bardziej skomplikowanych siatek: 

 

Rysunek 12.38.3 Zmodyfikowana powierzchnia obiektu 

Takie niezamierzone „wygładzenie” jest bardziej widoczne dla dużych (bezwzględnych) wartości Offset. Nie 

poprawiałem go dotąd, ponieważ w praktyce używam tego modyfikatora z relatywnie małymi wartościami odsu-

nięć, tylko dla siatek o kształcie „pudełek” lub o zaokrąglonych krawędziach. 

 

 

Za pomocą Geometry Nodes możesz w Blenderze tworzyć swoje własne modyfikatory. Nie będziemy 

jednak ich omawiać w tym poradniku (to zbyt rozległy temat). 
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12.39 Modyfikatory obiektu – zarządzanie 

Pewne operacje są takie same we wszystkich modyfikatorach. Opiszę je pokrótce w tej sekcji. Pominąłem tu 

tworzenie nowego modyfikatora, ponieważ opisałem ten krok wielokrotnie, w innych miejscach tego rozdziału. 

Jednak jest jeszcze druga metoda dodawania modyfikatorów: powielenie. Otwórz menu kontekstowe w panelu 

modyfikatora, który chcesz powielić i wybierz z niego polecenie Duplicate (Rysunek 12.39.1): 

                

Rysunek 12.39.1 Powielenie modyfikatora 

W odpowiedzi, Blender doda do listy modyfikatorów obiektu kopię wskazanego modyfikatora. Możesz zmienić 

jego nazwę (to zwiększy czytelność tej listy). Nazwy modyfikatorów muszą być unikalne w obiekcie, więc mogą 

się powtarzać w różnych obiektach. Użycie identycznych nazw modyfikatorów, które pełnią tą samą rolę w róż-

nych obiektach, poprawia „czytelność” struktury modelu. 

Inną typową operacją jest utrwalanie. Polega na przekształceniu dynamicznego rezultatu generowanego przez 

modyfikator w trwałą („statyczną”) deformację siatki. Rysunek 12.39.2a) przedstawia to na przykładzie modyfi-

katora Shrinkwrap. Można to zrobić tylko w Object Mode. Zaznacz obiekt, znajdź panel modyfikatora w zakład-

ce Modifiers i z jego menu kontekstowego wybierz polecenie Apply (Rysunek 12.39.2b). Rysunek 12.39.2c). 

pokazuje jego rezultaty (w Edit Mode): 

 

 

 

Rysunek 12.39.2 „Utrwalenie” efektu modyfikatora (trwałe przekształcenie siatki)  
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Zawsze utrwalaj pierwszy z listy modyfikatorów. W przeciwnym razie rezultat może być zaskoczeniem.  

 
 Możesz także kopiować modyfikatory pomiędzy obiektami. Ta funkcja jest szczególnie użyteczna, gdy chcesz 

dodać ten sam modyfikator do wielu obiektów. Jest dostępna tylko w Object Mode (Rysunek 12.39.3): 

1. Zaznacz obiekty, które otrzymają modyfikator. 

2. Zaznacz obiekt, który zawiera kopiowany modyfikator (ma się stać obiektem aktywnym). 

3. W oknie Properties obiektu aktywnego otwórz zakładkę Modifiers. Rozwiń menu kontekstowe kopiowa-

nego modyfikatora, i wybierz polecenie Copy to Selected: 

 

Rysunek 12.39.3 Kopiowanie modyfikatora z aktywnego obiektu do pozostałych zaznaczonych obiektów  

Rysunek 12.39.4 przedstawia rezultat tych skopiowanych modyfikatorów: 

 

Rysunek 12.39.4 Rezultat kopiowania modyfikatorów  

Skopiowane w ten sposób modyfikatory są zawsze dołączane na koniec listy modyfikatorów zaznaczonych 

obiektów. 

 

1. Zaznacz obiekty, 
którym chcesz dodać 
modyfikator 

2. Zaznacz obiekt 
zawierający ten 

modyfikator 

3. Z menu kontekstowego 
modyfikatora wywołaj pole-
cenie Copy to Selected  
 

Płaszczyzna 
symetrii 

Kopiowane modyfikatory są 
dodawane na koniec listy 

Lustrzane kopie, wygenerowane 
przez dodane modyfikatory 
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Rozdział 13. Blender – pozostałe 

Tu umieściłem wszystkie polecenia Blendera, które nie pasują do pozostałych rozdziałów.  
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13.1 Zdefiniowanie nowego materiału  

Pokażę tu tworzenie prostego materiału, który będziemy używać wyłącznie do wyróżniania obiektów podczas 

edycji w oknie 3D. Nazwiemy go Artificial.Red. 

Zaznacz obiekt, któremu chcesz przypisać nową barwę. W oknie Properties wybierz zakładkę Material i naciśnij 

przycisk New (Rysunek 13.1.1): 

 

Rysunek 13.1.1 Obiekt bez przypisanego materiału 

W rezultacie Blender stworzy nowy materiał (o domyślnej nazwie Material) i przypisze go do aktywnego obiek-

tu. W zakładce Material zaroiło się od paneli (Rysunek 13.1.2a): 

                            

Rysunek 13.1.2 Nowy materiał i jego podstawowe kontrolki 

Lista u góry tej zakładki wyświetla tzw. „sloty materiałów”, zdefiniowane dla tego obiektu. Obiekt może mieć 

wiele slotów, każdy z nich powiązany z innym materiałem1.  

Zwróć uwagę na typowy zestaw kontrolek bloku danych (por. str. 627) poniżej tej listy (Rysunek 13.1.2a). Wy-

świetla materiał z podświetlonego na liście slotu. Jeżeli odłączysz ten materiał – slot stanie się pusty. Możesz 

także użyć środkowego klawisza tej kontrolki do stworzenia kopii tego materiału (Rysunek 13.1.2b). Taka nowo 

utworzona kopia będzie początkowo przypisana („używana”) tylko przez ten obiekt. 

W tym najprostszym przypadku stworzyliśmy pierwszy slot i przypisaliśmy go do nowego materiału o nazwie 

Material. Najlepiej od razu zmieńmy mu nazwę – w tym przypadku na Artifical.Red (Rysunek 13.1.2b).  

Dla takiego pomocniczego materiału sugeruję włączyć opcję Fake user, pokazywaną przez Rysunek 13.1.2b). 

W ten sposób unikniesz przypadkowego usunięcia tej definicji z pliku, gdy nie będzie użyta w żadnym obiekcie. 

 
1 Do każdego z tych slotów możesz przypisać różne fragmenty siatki. Więcej na temat wykorzystania wielu materiałów w pojedynczym 

obiekcie znajdziesz w Tomie III.  

1. Zaznacz 
obiekt 

2. Zaznacz 
zakładkę 
Material 3. Kliknij ten 

przycisk 

a) 

Kliknij dwukrotnie (LPM ) by 

zmienić nazwę materiału  

Tworzy kopię 
obecnego 
materiału 

b) 

Materiał przypisany do 

podświetlonego slotu 

Lista “slotów” na materiały 
przypisane do obiektu 

Panele poniżej 
dotyczą tego 

materiału 

Usuwa (odłącza) 
materiał z pod-
świetlonego slotu  

Fake user 
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Tego „technicznego” materiału nie będziemy używać na finalnych renderach, więc pomińmy, póki co, jego naj-

ważniejszy panel Surface. Kolor obiektu w trybie cieniowania Solid jest ustawiony w panelu Viewport Display 

(Rysunek 13.1.3a). Kliknij w jego pole Color aby otworzyć panel wyboru barwy (Rysunek 13.1.3b): 

                                    

Rysunek 13.1.3 Zmiana barwy materiału 

Wybierz w niej kolor czerwony (Rysunek 13.1.4):  

 

Rysunek 13.1.4 Zmiana barwy materiału w oknie 3D 

Raz utworzony materiał można przypisać wielu obiektom/siatkom. Możesz także przypisać materiał wielu obiek-

tom naraz. 

Pojedynczy materiał jest zazwyczaj przypisany do wielu obiektów. Aby przypisać jeden z istniejących materiałów 

do obiektu: zaznacz ten obiekt, a potem wybierz ten materiał z listy rozwijalnej (Rysunek 13.1.5):  

           

Rysunek 13.1.5 Ustawianie koloru obiektu w oknie 3D 

 

Możesz poeksperymen-

tować z tymi ustawieniami 

Kliknij LPM  w to pole, by 

otworzyć panel wyboru barw 

 

Color for the 3d viewport, 
displayed in the Solid mode. 

Kliknij tutaj i wybierz 
jeden z istniejących 
materiałów 



Rozdział 13 Blender – pozostałe 577 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Dodatki 

Czytając wcześniejsze rozdziały, zapewne przekonałeś już się, że uwielbiam umieszczać u dołu strony przypisy 

z dodatkowymi informacjami. Ta część książki to właściwie wybór takich "uwag na marginesie", które w trakcie 

pisania urosły do rozmiaru całej sekcji     . 

 

Jak w każdym dodatku, są to informacje, z których nie musisz korzystać, aby stworzyć e-model samolotu. Cza-

sami jednak mogą się przydać, by coś wyjaśnić lub ułatwić. Mam nadzieję, że znajdziesz tu rozwinięcie wielu 

zagadnień, które świadomie skracałem w głównym tekście książki. 
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Rozdział 14. Wykorzystanie zdjęć jak obrazów wzorcowych 

Ten rozdział opisuje, jak można użyć zdjęcia o wysokiej rozdzielczości w charakterze dokładnych obrazów 

wzorcowych. Do tej metody potrzebujesz wstępnego modelu 3D swojego samolotu. Możesz go przygotować w 

oparciu o plany i wszystkie inne klasyczne techniki modelarskie. 

Twój model musi zawierać jakieś elementy o rozmiarach i proporcjach potwierdzonych przez wymiary z orygi-

nalnych rysunków producenta. Będziesz dopasowywać te „potwierdzone” kształty do ich odpowiedników na 

zdjęciu, znajdując w ten sposób projekcję jego kamery. Rozpiętość skrzydeł czy całkowita długość kadłuba nie 

są najlepszym wyborem do takich testów, szczególnie jeżeli te wymiary pochodzą z jakiejś wydrukowanej tabel-

ki a nie z oryginalnej dokumentacji. (Źródła drukowane mogą wprowadzić w błąd, bo często powtarza się w nich 

pomyłki z wcześniejszych publikacji). Lepiej jest użyć innych wymiarów: na przykład, odległości przegrody silni-

ka od osi steru, lub podobnych. Można je znaleźć np. na rysunkach ofertowych producenta. 

 

W tej książce, przeprowadzimy takie porównanie dla modelu P-40 ukończonego w sekcji 9.3. W tym przypadku 

możemy traktować jako „potwierdzone” kształty: stateczników (pionowego i poziomego), skrzydła, oraz ich od-

ległości od przegrody silnika. 

 

Do wykonania czynności opisanych w tym rozdziale, potrzebujesz: 

1. Wstępnej wersji swojego modelu, stworzonej np. w oparciu o plany modelarskie, i co najmniej 

kilku oryginalnych wymiarów (im więcej takich znanych wymiarów, tym lepiej). 

2. Zdjęć o wysokiej rozdzielczości całego modelowanego obiektu (samolotu). 
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14.1 Wykorzystanie współczesnych zdjęć wykonanych teleobiektywem 

Jak znaleźć dobre zdjęcie wzorcowe? Jeżeli masz szczęście i istnieją jakieś odrestaurowane samoloty typu, 

który modelujesz, możesz przejrzeć ich fotografie. Najlepsze będą szczegółowe obrazy o wysokiej rozdzielczo-

ści, wykonane za pomocą teleobiektywu (chodzi o projekcję z jak najdłuższą ogniskową). Zazwyczaj będą to 

zdjęcia samolotów w locie. Tzw. deformacja beczkowata takich fotografii jest minimalna. W pierwszej sekcji tego 

rozdziału użyjemy takiego zdjęcia z pokazów lotniczych z Duxford (Rysunek 14.1.1): 

 

Rysunek 14.1.1 Współczesne zdjęcie odrestaurowanego P-40C, wykonane kamerą z teleobiektywem 

Tu jest link do tej fotografii. Zacząłem od jej przycięcia, usuwając puste przestrzenie z niebem ponad i poniżej 

samolotu1. 

Szerokość tego obrazu to 3669px, a szczegóły są dobrze widoczne na powierzchni tego samolotu (Rysunek 

14.1.2a). W przypadku współczesnych zdjęć, długość ogniskowej można odczytać z własności pliku: 

                

Rysunek 14.1.2 Szczegóły obrazu 

Przyjrzyj się ostatniej wartości z sekcji Camera, opisanej jako 35mm focal length (Rysunek 14.1.2b). To zdjęcie 

wykonano teleobiektywem o standardowej ogniskowej 5252mm. Użyjemy tej wartości w następnym kroku. 

 
1 To samo zdjęcie użyliśmy już w pierwszej części tego poradnika – por. Tom I, sekcja 5.1, Rysunek 5.1.10. 

2 “Długość ogniskowej 35mm” to równoważna długość ogniskowej dla standardowego „sensora” o szerokości 35mm – czyli klatki klasycz-

nego aparatu, w którym każda klatka filmu miała rozmiar 35x24mm. Jeżeli w Twoim pliku ta wartość jest pusta, możesz użyć wartości Focal 

length, ale najpierw sprawdź rozmiar sensora w użytej kamerze (typ kamery znajdziesz w polu Camera model). Na przykład, w obrazie 

powyżej, można odczytać typ kamery: „NIKON D3200” i rzeczywistą długość ogniskowej (350mm). Potem poszukałem w Internecie hasła 

„NIKON D3200 sensor size” i zaraz otrzymałem wynik: 23.2x15.4mm. Korzystając z większego z tych dwóch wymiarów (23.2mm) mogłem 

obliczyć standardową długość ogniskowej 53mm/23.2mm*350mm = 528mm. Ten wynik różni się nieznacznie od 525mm deklarowanej 

przez NIKON. Przypuszczam, że przyczyną tej różnicy są inne proporcje tego sensora i standardowej klatki filmu.  

Źródło: wikimedia.org 

a) b) 

To rzeczywista 
długość ognisko-
wej tej kamery  

Zbliżenie usterzenia  

Ustandaryzowana 
długość ognisko-

wej kamery 

Okno właściwości 
pliku obrazu  

https://commons.wikimedia.org/wiki/File:Curtiss_P-40C_Warhawk_%27160_-_10AB%27_(G-CIIO)_(35522158964).jpg
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Zacznij od dodania do sceny Blendera nowej kamery poleceniem Add→Camera (por. str. 474). Nazwij ją DUX-1 

(to jest taka konwencja, którą sobie przyjąłem: od „Duxford”). Gdy ustalisz jej Lens:Focal Length na 525 i 

Camera:Size na 35 (Rysunek 14.1.3, por. także str. 475), jej kształt stanie się wydłużoną „piramidą”. Blender 

demonstruje w ten sposób aktualny kąt widzenia takiego „teleobiektywu”: 

 

Rysunek 14.1.3 Ustawienie nowej kamery 

Aby wygodnie sterować kierunkiem kamery, stwórz pomocniczy obiekt. Nazwij go DUX-1.Target. Mógłby być 

Empty, ale sugeruję użyć tu walca (Add→Mesh→Cylinder), jak pokazuje to Rysunek 14.1.4. Sądzę, że taka 

bryła będzie bardziej widoczna:  

 

Rysunek 14.1.4 Wstawienie pomocniczego obiektu – „celu” kamery 

Aby uczynić ją jeszcze bardziej widoczną, nadaj jej kolor czerwony (przypisując kontrastowy materiał 

Artificial.Red). Potem uczyń ten obiekt „celem” kamery DUX-1 za pomocą ograniczenia Track To (str. 488).  

 

Ustaw parametry ograniczenia Track To dokładnie tak, jak na ilustracji powyżej. W przeciwnym razie 

nie będziesz mógł dokończyć tego samouczka (ponieważ sterowanie kamerą będzie działać inaczej). 

Nowa kamera 
(DUX-1)  

Ustaw jej 
ogniskową 
na 525mm 

Zmień także te 
dwa parametry  

Kamera 
DUX-1 

DUX-1.Target  

Lokalna oś Z kamery jest skiero-
wana na przypisany obiekt Target 

Zawsze włączaj tę 
opcję w ogranicze-

niu Track To kamery 

Z 

Ograniczenie kamery, dodane poleceniem Object→Track→Track To 
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Uczyń DUX-1 kamerą aktywną (View→Cameras→Set Active Object as Camera). Gdy to zrobisz, przełącz 

jedno z okien 3D na widok z kamery (skrótem 0 , lub poleceniem View→Viewpoint→Camera). W rezultacie 

zobaczysz obrazek przypominający ten pokazywany przez Rysunek 14.1.5a): 

 

Rysunek 14.1.5 Początkowy widok z kamery DUX-1 

W środku ramki kamery widać jej obiekt-cel. Jednak, ta kamera ma wąskie pole widzenia i jest zbyt blisko sa-

molotu, więc widzisz w niej tylko fragment boku kadłuba. Aby zobaczyć więcej, odsuń ją wzdłuż lokalnej osi Z od 

tego modelu (Rysunek 14.1.5b). 

Gdy przesuwasz myszkę, kamera się odsuwa, a w jej ramce coraz więcej widać. Jednak w pewnym momencie 

model zacznie znikać za czymś, co wygląda jak niewidzialna ścian (Rysunek 14.1.6): 

 

Rysunek 14.1.6 Model „wycięty” przez ograniczoną głębokość pola widzenia kamery 

Aby skorygować ten efekt, zmień ustawienia Camera:Lens pokazane powyżej. Zwiększ parametr Clip End do 

większej wartości niż przewidywana odległość modelu od kamery. Aby być „po bezpiecznej stronie” sugeruję 

zwiększyć wartość Clip End do 10 000 jednostek. Jednocześnie, aby usunąć z tego widoku kilka małych „prze-

bić” wewnętrznych ścian modelu, zwiększ parametr Clip Start – na przykład do 500. 

 

a) b) 

Ramka kamery  

Widok z kamery 

Obiekt-cel kamery 

Z (lokalne) 

Odsuń kamerę 
wzdłuż lokalnej osi Z  

(skrót: G , Z , Z ) 

Zwiększ Clip End 
aby model nie był 
„obcinany” przez 

granice pola kamery 

Zwiększ Clip Start, 
aby zmniejszyć te 
drobne „przebicia” 

Object Data (kamery) 

Widok z kamery 
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Po tej poprawce możesz znów wywołać polecenie Move i kontynuować odsuwanie kamery wzdłuż jej lokalnej 

osi Z, dopóki nie zobaczysz w ramce całego modelu (Rysunek 14.1.7): 

 

Rysunek 14.1.7 Widok po odsunięciu kamery 

Aby wyśrodkować model w ramce, przesuń obiekt-cel kamery (Rysunek 14.1.8): 

 

Rysunek 14.1.8 Wyśrodkowanie modelu w „obiektywie” kamery 

Jeżeli chcesz obrócić model w ramce, obróć obiekt-cel w widoku z kamery (Rysunek 14.1.9): 

 

Rysunek 14.1.9 Obracanie modelu w ramce kamery 

Zwróć uwagę, że cel kamery w ramce wydaje się nieruchomy. To dlatego, że kamera podąża za jego obrotem 

(dzięki włączonej opcji Target Z w parametrach ograniczenia Track To – por. Rysunek 14.1.4). 

Widok z kamery Widok z góry 

Model  

Kamera 

~6 600 

Przesuń obiekt-cel 
kamery aby wyśrodko-

wać model w ramce 

Środek obrotu: 
Active Element 

Obróć obiekt-
cel kamery 

Widok z kamery 

Widok z kamery 
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W następnym kroku dopasuj proporcje kamery do obrazu. Odczytaj jego wysokość i szerokości z zakładki 

Details we właściwościach pliku (Rysunek 14.1.2b). Potem w oknie Properties Blendera, zakładce Output, pa-

nelu Format, wpisz te wartości w pola Resolution X i Y  (Rysunek 14.1.10): 

 

Rysunek 14.1.10 Dopasowanie proporcji kamery 

Zaznacz kamerę DUX-1, przypisz do niej ten obraz. Kliknij przycisk Add Image, potem kliknij przycisk Open. 

Wskaż plik z obrazem (Rysunek 14.1.11): 

                            

Rysunek 14.1.11 Przypisanie do kamery obrazu wzorcowego 

Gdy obraz się pojawi, ustaw jego Depth na Front i zmniejsz wartość Opacity, by widzieć za nim model: 

 

Rysunek 14.1.12 Poprawki w ustawieniach wyświetlania obrazu 

Widok z kamery 

Wpisz tu wymiary (w pikse-
lach) zdjęcia wzorcowego 

Skorygowane pro-
porcje kamery 

1.  Kliknij ten 
przycisk 

2.  Wybierz 
obraz 

Właściwości 
obrazu kamery 
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Do dalszego dopasowywania kamery, ustaw 3 okna 3D na ekranie Blendera tak, jak pokazuje Rysunek 14.1.13: 

 

Rysunek 14.1.13 Sugerowany układ ekranu 

Celem jest ustalenie projekcji, w której nasz model (lub, co najmniej, jego potwierdzone elementy) będzie pa-

sował do zdjęcia. W górnym oknie widzisz rezultaty przesunięć kamery i/lub jej celu. Poniżej masz dwa okna z 

widokami z góry i z boku, w których wykonujesz wszystkie te transformacje (Move, Rotate). Zazwyczaj będziesz 

przesuwał obiekt-cel, ale czasami trzeba włączyć do tych przekształceń także kamerę. 

Ustaw domyślna orientację transformacji na Local (por. przełącznik w nagłówku okna 3D –  Rysunek 14.1.13) 

Na początek musisz zbliżyć kamerę do celu, bo na razie model wydaje się mniejszy od zdjęcia. Zaznacz aktyw-

ną kamerę (DUX-1) klikając jej ramkę w oknie kamery. Przesuwaj ją wzdłuż lokalnej osi Z ( G , Z ), aż pozorny 

rozmiar modelu będzie pasował do sylwetki samolotu na zdjęciu (Rysunek 14.1.14): 

 

Rysunek 14.1.14 Dopasowanie względnego rozmiaru modelu do obrazu tła kamery 

Widok z kamery 

Widoki ortograficzne 

Cel 
kamery 

Domyślna orien-
tacja: Local 

 

Zbliż kamerę do modelu 
(wzdłuż lokalnej osi Z) 
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Jednak nadal trzeba przesunąć (por. Rysunek 14.1.8) i obrócić (por. Rysunek 14.1.9) ten model, dopasowując 

go do sylwetki na zdjęciu w kamerze. Po kilku „rundach” takich dopasowań (zmiana odległości kamery, przesu-

wanie i obracanie obiektu-celu w widoku z kamery), powinieneś osiągnąć rezultat przypominający ten pokazy-

wany przez Rysunek 14.1.15: 

 

Rysunek 14.1.15 Wstępne dopasowanie 

Teraz możesz ocenić różnice pomiędzy zdjęciem i orientacją modelu. Zrób to korzystając z potwierdzonych 

elementów modelu. W przypadku na ilustracji powyżej, różnica w położeniu końcówek skrzydła wskazuje, że 

powinniśmy obrócić kamerę wokół modelu. 

Mógłbyś to zrobić, przesuwając kamerę w górę i do tyłu. To zmieniłoby jednak położenie modelu w ramce obiek-

tywu. Bardziej efektywną metoda jest obrót kamery i jej celu wokół kursora 3D. Podczas takiej transformacji, 

punkt modelu, w którym umieścisz kursor, pozostanie w tym samym miejscu na mapowanym obrazie.  

Przełącz Transformation Pivot na 3D Cursor i umieść kursor 3D w miejscu, w którym zdjęcie i model są do sie-

bie dopasowane. W opisywanym przykładzie jest to podstawa kołpaka śmigła (Rysunek 14.1.16): 

 

Rysunek 14.1.16 Ustawianie obrotu wokół kursora 3D 

Potem zaznacz kamerę i jej cel, i obróć ( R ) w widoku z góry obydwa obiekty wokół kursora 3D. 

 

Aby osiągnąć większą dokładność, podczas transformacji trzymaj wciśnięty klawisz Shift , gdy przesu-

wasz myszkę. 

Różne położenie 
końcówek skrzydła 

Podstawy kołpaka są w 
tym samym miejscu  

1.  Przełącz środek trans-
formacji na 3D Cursor 

3.  Obróć 
kamerę i jej 
obiekt-cel 

2.  Umieść kursor 3D w miejscu, 
gdzie model pasuje do zdjęcia 
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Rysunek 14.1.17 pokazuje rezultat tego obrotu: 

 

Rysunek 14.1.17 Widok z kamery po tym obrocie 

Dopasowaliśmy krawędzie natarcia skrzydła, ale nowa różnica, która pojawiła się na ogonie, sygnalizuje, że 

musimy odsunąć kamerę. Moglibyśmy to zrobić w dwóch krokach, jak poprzednio (przesuwając kamerę, potem 

dopasowując pozycję celu). Jednak dla tak małej korekty, możesz to zrobić w jednej operacji: skalując kamerę i 

jej cel względem kursora 3D (Rysunek 14.1.18): 

 

Rysunek 14.1.18 Dopasowywanie projekcji modelu 

 
Teraz obróćmy kamerę i cel wokół globalnej osi Y ( R , Y : Rysunek 14.1.19): 

 

Rysunek 14.1.19 Korygowanie poziomu końcówki skrzydła 

 

Na czas tych transformacji, przełącz domyślną orientację z Local na Global (por. Rysunek 14.1.13). 

Podstawa koł-
paka jest nadal 
dopasowana  

Końcówki skrzydeł 
są już bliżej  

Musimy jeszcze 
trochę odsunąć 

kamerę od modelu 

Dopasuj do zdjęcia 
kontur statecznika 

Ster kierunku może 
być odchylony 

Skaluj kamerę i jej cel 
względem kursora 3D 

W miejscu kursora 3D model 
jest „przypięty” do zdjęcia    

Obróć kamerę i jej cel wokół 
kursora 3D (globalnej osi Y)  
 

Dopasuj do siebie 
końcówki skrzydła 
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Zazwyczaj potrzeba kilku „rund” podobnych przybliżeń, aby ostatecznie dopasować skrzydło i stateczniki do 

wzorcowego zdjęcia. Użyj zbliżeń do dokładnego dopasowywania szczegółów modelu (Rysunek 14.1.20): 

        

Rysunek 14.1.20 Dopasowanie krawędzi spływu końcówek skrzydła 

Gdy dopasujesz skrzydło i usterzenie, możesz odkryć, że czubek kołpaka śmigła nie pasuje idealnie do zdjęcia. 

Aby zmniejszyć wpływ dalszych transformacji na dopasowane wcześniej obszary, umieść kursor 3D na ogonie 

samolotu. Przeniosłem go na tylną krawędź statecznika/kadłuba (Rysunek 14.1.21). Potem obróciłem kamerę i 

jej cel wokół globalnej osi X: 

 

Rysunek 14.1.21 Dopasowywanie czubka kołpaka śmigła 

 
Dlatego w przypadku powyżej nie umieściłem kursora 3D na krawędzi spływu steru kierunku. 

Zwróć uwagę, że w wyniku tej poprawki musisz ponownie dopasować do zdjęcia końcówki skrzydeł (jak poka-

zywał to Rysunek 14.1.20). To normalne, jeżeli tylko takie kolejne transformacje są coraz mniejsze. Dopasowa-

nie projekcji do zdjęć wymaga wielu iteracji. 

 

Nie dopasowuj żadnej z powierzchni sterujących, bo na zdjęciach są zawsze choć trochę odchylone. 

Różnica na 
krawędziach 

spływu 

Dopasowane 
krawędzie 

spływu 

Umieść kursor 3D na 
tylnej krawędzi kadłu-
ba, w osi samolotu,   

Obróć kamerę 
i jej cel wokół 
globalnej osi 

X 

Dopasuj do siebie 
czubki kołpaków   

Teraz ta końcówka 
skrzydła wymaga 

drobnych poprawek 
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Samolot na zdjęciu jest w trakcie składania podwozia, więc nie dopasowuję do niego pokryw goleni. Po wielu 

próbach powinieneś uzyskać zadowalające dopasowanie całego modelu (Rysunek 14.1.22): 

 

Rysunek 14.1.22 Model dopasowany do zdjęcia  

Gdy wszystkie „potwierdzone” elementy są dopasowane do zdjęcia, możesz przyjrzeć się modelowi w oknie z 

projekcja z kamery, szukając ewentualnych odchyleń (Rysunek 14.1.23): 

        

Rysunek 14.1.23 Niektóre z różnic pomiędzy modelem i wzorcowym zdjęciem 

Rysunek 14.1.23a) pokazuje, że promień podstawy kołpaka w odrestaurowanym samolocie jest większy (o oko-

ło 0.5”) niż w naszym modelu. Znalazłem także pewne różnice w ramce oszklenia kabiny (Rysunek 14.1.23b). 

Dostrzegłem także kilka innych odchyłek (np. w położeniu osi klap z osłony silnika). 

Jednak zanim zaczniesz poprawiać swój model, zmapuj jeszcze kilka innych zdjęć tego samolotu i przeprowadź 

podobne porównania. Staraj się użyć zdjęć innego egzemplarza, bo niektóre części odrestaurowanych maszyn 

nie są oryginalne. Na przykład – podstawa kołpaka tego P-40C z Duxford (Rysunek 14.1.23a) wydaje się zbyt 

duża. Przypuszczam, że co najmniej jej tylna część była odtworzona w lokalnym warsztacie, z widocznym skut-

kiem. Porównując różne samoloty, łatwiej jest zauważyć takie szczegóły. 

Oczywiście, skany o wysokiej rozdzielczości archiwalnych zdjęć samolotu są najlepszym źródłem. Niestety, 

dopasowanie do nich projekcji wiąże się z dodatkową trudnością, którą opiszę w następnej sekcji. 

 

Nie byłem w stanie dopasować projekcji do niektórych współczesnych zdjęć, na przykład – do tego. W 

ich właściwościach brak jest informacji o kamerze. Mogę tylko podejrzewać, że są to obrazy w jakiś 

sposób zmodyfikowane, np. ktoś je wydłużył lub skrócił (mam na myśli skalowanie). 

Podwozie w trakcie chowania w skrzydło 

a) b) 

W samolocie na zdjęciu, 
promień kołpaka śmigła 
jest większy (o ~0.5”) 

Stacja #7 

Wyższa kra-
wędź (~0.5”) 

Przesunięta 
ramka (~0.7”) 
 

Krawędź ze-
wnętrzna (~0.2”) 

https://www.spokesman.com/stories/2016/dec/06/museum-puts-recollections-of-pearl-harbor-other-ba/
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W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić zdjęcia zmapowa-

ne w tej sekcji: model\p40\history\P40B-27.01.blend. 
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14.2 Wykorzystanie historycznych zdjęć  

W poprzedniej sekcji dopasowaliśmy projekcję modelu P-40B do współczesnego zdjęcia odrestaurowanego 

samolotu. Wykorzystaliśmy kamerę Blendera do „pozowania” modelu, tak aby w ramce kamery wyglądał tak, 

jak samolot na fotografii. Jedną z kluczowych informacji, z której korzystaliśmy, była długość ogniskowej obiek-

tywu, za pomocą którego wykonano to zdjęcie. Współczesne kamery zapisują tą informację, wraz z innymi pa-

rametrami, w pliku obrazu. Dzięki temu mogliśmy po prostu ustawić długość ogniskowej kamery Blendera na 

wartość odczytaną z właściwości zdjęcia (por. str. 579, 580). Potem, metodą prób i błędów, określiliśmy pozo-

stałe niewiadome: położenie kamery i jej kierunek (orientację). 

Jak jednak dopasować model do archiwalnego, „analogowego” zdjęcia? Na przykład, takiego jak przedstawione 

poniżej oryginalne zdjęcie Curtiss Tomahawka IIA, z listopada 1940r (Rysunek 14.2.1)? 

  

Rysunek 14.2.1 Archiwalne zdjęcie Tomahawka IIA (technicznie odpowiada P-40B) 

W takim zdjęciu długość ogniskowej jest nieznana. Musimy ją odkryć/przybliżyć taką samą metodą „prób i błę-

dów”, jak określaliśmy pozostałe współrzędne kamery. Gorzej, te stare obiektywy były bardziej podatne na róż-

ne optyczne deformacje, szczególnie zniekształcenie beczkowate (por. sekcja 16.3, str. 649). Dodatkowe de-

formacje mogły się także pojawić podczas procesu wywoływania zdjęcia i tworzenia odbitek. 

Czasami możesz wykryć zniekształcenie beczkowate wykorzystując widoczne na zdjęciu elementy otoczenia 

samolotu. Na przykład, kilka lat temu użyłem krawędzi betonowych płyt lotniska jako ekwiwalentu „długich, pro-

stych linii” pokazywanych przez Rysunek 16.3.3 (str. 650). Gdy znajdziesz na obrazie taki „indykator”, możesz 

spróbować skompensować jego deformację, np. za pomocą GIMP (por. str. 651-652)1. 

 
1 W GIMP robię to filtrem Lens Distortion. Oczywiście, podobne narzędzie istnieje w Photoshop, tyle, że nosi inną nazwę. 

Źródło: NSAM (z flicker.com) 

 

https://www.flickr.com/photos/publicresourceorg/494047597
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Podobne płyty betonowe widać na zdjęciu Curtiss pokazanej na poprzedniej stronie, więc załadowałem je do 

Inkscape i użyłem linii pomocniczych do sprawdzenia, czy ich krawędzie są wykrzywione (Rysunek 14.2.2): 

 

Rysunek 14.2.2 Podstawowa weryfikacja zdjęcia wzorcowego 

Jak widać na rysunku powyżej, krawędzie tych płyt układają się w linię prostą, więc prawdopodobnie zniekształ-

cenie beczkowate tego obrazu jest pomijalne. 

Dodatkowo, znalazłem przyciętą wersję tego zdjęcia w monografii „Curtiss Fighter Aircraft” Francisa Deana 

(opublikowanej w 2007r). Ilustracja w tej książce wydaje się mieć większa rozdzielczość od obrazu pokazywa-

nego przez Rysunek 14.2.1. Zdecydowałem się użyć jej do sprawdzenia proporcji tego zdjęcia1. Zeskanowałem 

tę ilustrację i umieściłem w Inkscape pod porównywanym zdjęciem. Potem szukałem jakiejś różnicy pomiędzy 

tymi dwoma obrazami. Na szczęście, nie znalazłem żadnej2. 

Dopasujmy projekcję naszego modelu 3D to tej fotografii. W tym celu użyjemy skanu obrazu zaznaczonego na 

ilustracji powyżej (Rysunek 14.2.2) linią kreskowaną, ze względu na jego wyższą rozdzielczość (4493x1744px). 

Tutaj jest link do pobrania tego pliku. 

 
1 Zawsze się obawiam, że podczas składu książki lub projektowania strony internetowej nieznaczenie zmieniono proporcje zdjęcia, by lepiej 

dopasować je do strony. Taka deformacja czyni je bezużytecznym do dopasowania projekcji modelu. 

2 Oczywiście, nadal istnieje wiele innych deformacji, które mogły się przytrafić temu analogowemu zdjęciu. Na przykład, mogło zostać znie-

kształcone podczas tworzenia odbitki z utrwalonego filmu. 

 

W tej sekcji kontynuujemy pracę nad plikiem Blendera stworzonym w sekcji poprzedniej (14.1): 

model\p40\history\P40B-27.01.blend. 

Użyłem innej reprodukcji tego samego zdjęcia (z innego 
źródła) do sprawdzenia, czy ich kontury pasują do siebie 

Krawędzie tych beto-
nowych płyt wydają 

się być proste 

http://wjaworski.pl/blog/p-40/104-TomahawkIA.jpg
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Musimy dodać do tej sceny kolejną kamerę i jej obiekt-cel. Moglibyśmy je stworzyć tak, jak to robiliśmy w po-

przedniej sekcji (por. Rysunek 14.1.3 - Rysunek 14.1.6). Jednak jest szybsza metoda: skopiuj (powiel) kamerę 

DUX-1 i obiekt DUX-1.Target, stworzone w tamtej sekcji: 

                      

Rysunek 14.2.3 Tworzenie nowej kamery i jej celu poprzez skopiowanie istniejących obiektów 

W oknie 3D zaznacz obiekty kamery i cel, i wywołaj polecenie Object→Duplicate Objects ( Shift - D ). To tworzy 

kopie obydwu obiektów, nazwanych tak, jak pokazuje to Rysunek 14.2.3. Teraz zmień nazwę nowej kamery na 

CTS-1 (lub inną, wg własnej konwencji) a jej celu na CTS-1.Target (Rysunek 14.2.4): 

                     

Rysunek 14.2.4 Dalsze zmiany w strukturze (logicznej) aktualnej sceny 

Aby nie pomylić obiektów-celów, stwórz nową, niewidoczną kolekcję o nazwie RC.Cameras i przesuń do niej 

kamerę DUX-1 i jej cel (Rysunek 14.2.4b). Potem zmień obraz tła w kamerze CTS-1 (Rysunek 14.2.5), usuwa-

jąc dotychczasową ścieżkę do pliku i wskazując w to miejsce nową: 

                     

Rysunek 14.2.5 Zmiana obrazu tła kamery 

a) b) 

Duplicate Objects 

a) b) 

Zmień nazwy tej nowej 
kamerze i jej „celowi” 

Nowa, niewidoczna 
kolekcja na kamery 
wzorcowe i ich cele   

Odłącz ten obraz … 

… a potem otwórz ten 
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Zmniejsz długość ogniskowej kamery CTS-1 do 80mm.(Wpisz tę wartość w Lens:Focal Length – por. Rysunek 

14.1.3.W tym przypadku nie znamy dokładnej ogniskowej, to tylko wstępne przybliżenie). Zmień rozmiary obra-

zu kamery na 4493x1744px. (Wpisz te nowe wymiary w panel Output:Dimensions – por. Rysunek 14.1.10). Na 

koniec ustaw CTS-1 jako aktywna kamerę (View→Camera→Set Active Object as Camera). Rysunek 14.2.6 

pokazuje, jak taka ramka i model wyglądają na początku: 

 

Rysunek 14.2.6 Początkowa ramka kamery CTS-1 

Model w tej ramce wygląda na bardzo mały z powodu zmniejszenia ogniskowej kamery z 525mm do 80mm. 

Teraz przesuń i obróć kamerę i jej cel (tak, jak to robiliśmy na str. 582-588), aby dopasować projekcję modelu 

do zdjęcia (Rysunek 14.2.7) 

 

Rysunek 14.2.7 Model i ramka kamery po wstępnych dopasowaniach 

Tak jak w poprzedniej sekcji, dopasuj „potwierdzoną” odległość od przegrody silnika do tylnej krawędzi kadłuba 

oraz kształt końcówki skrzydła. Zauważ, że kontur kadłuba nie pasuje idealnie do zdjęcia (Rysunek 14.2.8): 

 

Rysunek 14.2.8 Szczegóły dopasowania 

Odległy model 
jest tutaj 

Aby lepiej widzieć mo-
del, przełączyłem jego 

cieniowanie w oknie 3D 
z Material na Random 

Dopasowałem się 
do tego potwier-

dzonego wymiaru 

Różnice w konturze kadłuba  

Dopasowana 
końcówka 
skrzydła 
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Takie różnice wskazują, że powinieneś zmienić siódmą niewiadomą tego równania: długość ogniskowej. Gdy to 

jednak zrobisz, zmniejszając wartość Lens:Focal Length choćby o kilka procent (powiedzmy, z 80mm do 77mm) 

– model w ramce kamery zrobi się mniejszy (Rysunek 14.2.9): 

    

Rysunek 14.2.9 Typowy efekt zmniejszenia ogniskowej kamery 

Teraz powinieneś skompensować ten efekt zbliżając kamerę (wzdłuż jej lokalnej osi Z) do modelu. Konieczność 

ciągłego kompensowania czyni te zmiany ogniskowej bardzo uciążliwymi. 

Z myślą o tym problemie, stworzyłem specjalną wtyczkę Blendera. Działa na kamerach, które mają przypisany 

obraz tła i obiekt-cel (poprzez aktywne ograniczenie Track To) – czyli takich, jak nasza kamera. Gdy zmienisz jej 

ogniskową, wtyczka automatycznie kompensuje to zmianą odległości od celu kamery. Rysunek 14.2.10 przed-

stawia zasadę działania tego dodatku: 

 

Rysunek 14.2.10 Kompensowanie zmian ogniskowej przesunięciem kamery  

Odległość jest zmieniana proporcjonalnie do długości ogniskowej kamery (f), tak by pozorny rozmiar obiektu-

celu w obiektywie kamery pozostawał bez zmian. To oznacza, że w tej transformacji położenie w obiektywie 

kamery wszystkich punktów płaszczyzny neutralnej, prostopadłej do kamery i przechodzącej przez środek 

obiektu-celu, nie ulega zmianie. 

Oczywiście, pozorne rozmiary obiektów poza tą płaszczyzną będą się zmieniać. Jednak w ujęciach z boku, 

profil samolotu leży w płaszczyźnie symetrii, która jest niemal prostopadła do kamery. Stąd, jeżeli umieścisz 

obiekt-cel kamery w osi kadłuba, długość jego konturu w projekcji z boku nie będzie się zmieniać. 

 

Zmniejszenie ogniskowej kamery zmniejsza 
pozorny rozmiar modelu w jej obiektywie 

 

Obiekt

- cel 

Kamera 

Zachowany: 
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 Płaszczyzna 
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f=77mm 
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Przesuńmy cel kamery na płaszczyznę symetrii modelu. Aby nie zepsuć aktualnej projekcji, w widoku z kamery 

przełącz domyślną orientację transformacji na View (Rysunek 14.2.11). Następnie przesuń cel kamery wzdłuż 

osi Z okna ( G , Z ), obserwując w widoku z góry, kiedy jego środek znajdzie się ponad osią samolotu:  

 

Rysunek 14.2.11 Umieszczenie obiektu-celu w płaszczyźnie symetrii samolotu 

W tym przypadku obiekt-cel znalazł się w środku kokpitu. W takim położeniu trudno jest go zaznaczać kliknię-

ciem myszki w oknie 3D. Na szczęście i ten obiekt, i kamerę, można zaznaczać w oknie Outliner.  

Dodatek Reference Cameras znajduje się wśród skryptów towarzyszących tej książce. Jeżeli załadowałeś je 

wszystkie jak opisuje sekcja 10.6 (str. 436), to znajdziesz go wśród wtyczek User. W przeciwnym razie, zainsta-

luj plik source\Blender cfg\scripts\addons\object_reference_cameras.py tak, jak to opisuje sekcja 10.10. Po-

tem włącz tą wtyczkę w oknie Preferences (Rysunek 14.2.12a): 

                              

Rysunek 14.2.12 Włączenie dodatku Reference Cameras  

Wtyczka dodaje do przybornika nową zakładkę Cameras (Rysunek 14.2.12b). Umieściłem w tej zakładce panel 

Current, zawierającą ulepszoną kontrolkę zmiany ogniskowej. Znajduje się tutaj także panel Ref Cameras, którą 

omówimy na końcu tej sekcji. 

 

1.  Na chwilę 
włącz domyślną 
orientacjęView 

2.  Przesuwaj obiekt-cel 
wzdłuż osi Z widoku z kamery 

Obserwuj w widoku z góry, 
kiedy cel znajdzie się na 

płaszczyźnie symetrii modelu Widok z góry 

Widok z kamery 

Panel z przy-

bornika ( N ) 

Wtyczka dodaje 
zakładkę Cameras 

Tę panel omó-
wimy później  

a) b) 

Włącz tą wtyczkę  



596 Dodatki 

 

 
Wirtualne modelarstwo – Tom II: Modelowanie www.samoloty3d.pl 

W związku z dużo krótszą długością ogniskowej, możesz także zmniejszyć wartości Clip Start/End kamery 

CTS-1 do 50/5000 (por. str. 581, Rysunek 14.1.6). Teraz możesz zacząć eksperymentować ze zmianami ogni-

skowej, posługując się kontrolką Cameras:Lens (Rysunek 14.2.13): 

 

Rysunek 14.2.13 Eksperymentowanie z różnymi długościami ogniskowej 

Najlepiej zorientować się, jak długość ogniskowej zmienia widok z kamery, poprzez płynną zmianę jej wartości 

za pomocą myszki. Wystarczy ją przeciągnąć z wciśniętym LPM  ponad polem Current:Lens. (Możesz to także 

zrobić we właściwościach kamery, zmieniając pole Focal Length z panelu Lens). Gdy chcesz zwiększyć precy-

zję tych zmian – podczas przeciągania myszki trzymaj także wciśnięty klawisz Shift . 

Szybko odkryjesz, że zmniejszenie ogniskowej nie tylko powiększa bliższe elementy (jak końcówka skrzydła), 

ale także odrobinę obraca modelem. Dzieje się tak, gdy płaszczyzna kamery nie jest idealnie prostopadła do 

płaszczyzny symetrii modelu. Aby dostrzec różnicę, porównaj Rysunek 14.2.7 (f =80mm) i Rysunek 14.2.13 

(f=52mm). Aby skompensować ten efekt, musisz odrobinę obrócić wokół tego modelu kamerę oraz jej cel (por. 

str. 585, Rysunek 14.1.16). 

Dopasowując ogniskową, możesz sterować pozornymi proporcjami trapezu skrzydła. Jednak pomimo tego, 

bardzo trudno było się dokładnie dopasować do zdjęcia poniżej. Nie mogłem do niego jednocześnie dopasować 

skrzydła i statecznika pionowego. (Już nie wspominam wysokości konturu z boku: to kolejny nierozwiązany 

problem). Rysunek 14.2.14 pokazuje moje najlepsze przybliżenie, uzyskane dla ogniskowej f=68.6mm: 

 

Rysunek 14.2.14 Najlepsze dopasowanie, jakie znalazłem dla tego zdjęcia 

Przeciąganie myszki ponad 
ta kontrolką dynamicznie 

zmianie długość ogniskowej 

Możesz także uzgodnić położenie łopat 
śmigła ze zdjęciem (tylko obróć je tro-
chę, by ich pozycje pasowały do siebie) 

Zmiana ogniskowej nie-
znacznie “obraca” model 

Te obszary są wciąż 
niedopasowane 

Szczegóły panelu są lepiej widoczne, gdy włą-
czysz opcję Object:Viewport Display:Wireframe 

Dopasowałem kształt 
(„trapez”) skrzydła 
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Oczywiście, to może znaczyć, że nie jestem w stanie znaleźć prawidłowej projekcji tego zdjęcia. Jednak po kilku 

nieudanych próbach znalazłem jeszcze jedną wersję tej fotografii na portalu World War Photos. Gdy porówna-

łem ją z kopią z NASM (Rysunek 14.2.1, Rysunek 14.2.2), znalazłem różnice!  

 

Rysunek 14.2.15 Różnice pomiędzy dwoma kopiami tego samego (?) zdjęcia (porównanie wykonane w Inkscape) 

Rysunek 14.2.15 pokazuje dwa nałożone i dopasowane do siebie w Inkscape obrazy. Ich warstwy nakładają się 

w trybie Difference. W tym trybie jaśniejszy kolor oznacza różnicę pomiędzy odpowiednimi pikselami. Zwróć 

uwagę na białe linie, które pojawiają się w miejscach, których nie mogłem dopasować w Blenderze (porównaj 

obraz powyżej i Rysunek 14.2.14). 

Cóż, spróbujmy się teraz zmierzyć z tą kopią w WW Photos.  W tym celu, skopiowałem kamerę CTS-1 i jej cel 

(jak na str. 592) i nazwałem te nowe obiekty CTS-1a i CTS-1.Target. O dziwo, w tym przypadku udało mi się 

uzyskać niemal idealne dopasowanie (Rysunek 14.2.16): 

 

Rysunek 14.2.16 Dopasowanie modelu do kopii z World War Photos 

Tym razem nie widać żadnych różnic wzdłuż konturów kadłuba i usterzenia. Na powyższej ilustracji użyłem 

ogniskowej f=71.2mm. Kamera CTS-1a jest położona w (X:782.43, Y:-7.78, Z:-14.66). Obiekt-cel CTS-

1a.Target znajduje się w: (X:1.33, Y:-69.52, Z:15.67) a jego kąty obrotu to: (X:+14.255º, Y: -0.890º, Z:-0.293º). 

Te białe linie to 
niezgodności po-
między obrazami 

Obrazy nałożone w trybie Difference 

Zdjęcie z NASM jest 
lekko obrócone 

Aby “widzieć poprzez” górny 
obraz, zmniejszyłem jego 
nieprzejrzystość o 50% 

Projekcja modelu do-
pasowana do zdjęcia 

https://www.worldwarphotos.info/gallery/usa/aircrafts-2-3/p-40raf/tomahawk-mk-ia-ah973/
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Dlaczego te dwa zdjęcia tego samego samolotu (nr RAF: „AH 973”) są różne? Może to dwie kolejne klatki z 

tego samego filmu, lub nawet dwie odbitki z tego samego negatywu, wykonane w odrobinę inny sposób? 

(Zwróć uwagę, że kopia z World War Photos jest jaśniejsza, a kopia z NASM lekko obrócona). Myślę, że ten 

przypadek jest dobrą ilustracją przypadkowych deformacji, które mogą wystąpić na starych zdjęciach. 

Oczywiście, gdybym nie znalazł drugiej wersji tego obrazu, mógłbym „poprawić” kształt kadłuba w moim mode-

lu. Dlatego zawsze powinieneś dopasowywać projekcję do wielu zdjęć. Uśrednienie rezultatów tych porównań 

pozwala na osiągnięcie większej dokładności. Mam nadzieję, że większość tych fotografii nie jest zdeformowa-

na w tak dziwny sposób, jak ten AH 973 z NASM. Przymierzmy się więc do tego zdjęcia (Rysunek 14.2.17): 

 

Rysunek 14.2.17 Archiwalne zdjęcie P-40-cu  

Najpierw próbuj wykryć ewentualne zniekształcenie beczkowate. Użyłem do tego białych pasów, namalowanych 

na powierzchni widocznego na zdjęciu lotniska. Te pasy na zdjęciu są proste, więc jest szansa, że ten obraz to 

niemal czysta projekcja perspektywiczna. Oczywiście, może zawierać jeszcze inne zniekształcenia. Ich obec-

ność może się objawić w postaci problemów z dopasowaniem projekcji naszego modelu. 

Przypisz to zdjęcie do nowej kamery, o nazwie (powiedzmy) CTS-2. Po dopasowaniu projekcji naszego modelu, 

uzyskałem rezultaty pokazane przez Rysunek 14.2.18: 

 

Rysunek 14.2.18 Wynik dopasowania modelu 

Źródło: Wikimedia 

Wszystkie pasy na lotnisku wyda-
ją się proste – co oznacza brak 
zniekształcenia beczkowatego 

Ten ster jest 
obrócony o -9º 

Różnica w konturze uste-
rzenia pionowego (~0.2”) 

Nie byłem w stanie 

dopasować łopat śmigła 

Dopasowane: 
skrzydło i kadłub 

Dopasowany: 
statecznik 
poziomy 

https://commons.wikimedia.org/wiki/File:Curtiss_P-40_060913-F-1234P-001.jpg
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Starałem się jak mogłem, ale na tym zdjęciu nie byłem w stanie jednocześnie dopasować skrzydła, statecznika 

pionowego i kołpaka śmigła. Rysunek 14.2.18 pokazuje najlepszy „kompromis”. Kamera CTS-2 znajduje się w 

X:-598.95, Y: 12.36, Z:-6.05, a jej ogniskowa f=48.0mm. Cel CTS-2.Target znajduje się w: X:0.58, Y:65.29, 

Z:9.01, a jego obrót to: X:11.264º, Y: 0.304º, Z:-0.837º. W tej projekcji śmigło (wraz z kołpakiem) wydaje się 

przesunięte do przodu i ustawione pod kątem pasującym do ogniskowej f=51mm. Na nieszczęście, w takiej 

projekcji reszta modelu nie pasuje do zdjęcia. Niewielka różnice widać w konturach statecznika pionowego i 

steru kierunku. Ten ster jest na zdjęciu obrócony o 9º w prawo, co można łatwo odtworzyć w Blenderze. Rysu-

nek 14.2.18 pokazuje jednak, że jego wysokość nie odpowiada dokładnie wysokości w modelu. Przypuszczam, 

że to zdjęcie zawiera jakąś niezidentyfikowaną deformację.   

Spróbujmy kolejnego zdjęcia z World War Photos. Tym razem to ujęcie „z 3/4” (Rysunek 14.2.19): 

 

Rysunek 14.2.19 Dopasowanie do ujęcia 3/4 Tomahawka IIA (nazwa kamery: CTS-3)  

Jak widać, nie zdołałem na nim dopasować końcówek skrzydeł i łopat śmigła. Lepiej mi się udało dopasować 

ujęcie „3/4 z góry” ze zdjęcia pochodzącego z NASM (Rysunek 14.2.20): 

 

Rysunek 14.2.20 Kolejne zdjęcie świeżo wyprodukowanych P-40-cu (nazwa kamery: CTS-4) 

W tym przypadku wszystko pasuje do obrazu w tle, z wyjątkiem czubka kołpaka śmigła. 

Końcówka skrzydła nie 
pasuje do zdjęcia 

Końcówka łopaty śmigła 
nie pasuje do zdjęcia  

Ster na zdjęciu był 
obrócony o 7º 

Niedopasowany 
czubek kołpaka 

https://www.worldwarphotos.info/gallery/usa/aircrafts-2-3/p-40raf/tomahawk-mk-ia-ah860/
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Jednak kolejna fotografia z tej samej sesji zdjęciowej sprawiła mi więcej problemów (Rysunek 14.2.21): 

 

Rysunek 14.2.21 Inne ujęcie tego samego P-40-cu (nazwa kamery: CTS-5) 

W tym przypadku dopasowałem wszystko oprócz końcówki lewego skrzydła. Zastanawiam się, czy czegoś nie 

przeoczyłem. Czy mogę założyć, że ta różnica to wynik kolejnej „niezidentyfikowanej deformacji” zdjęcia? 

Dopasowywanie projekcji modelu do fotografii archiwalnych jest trudniejsze niż do współczesnych zdjęć. Choć 

moja wtyczka częściowo kompensuje zmiany ogniskowej kamery, ten dodatkowy nieznany parametr czyni 

znaczną różnicę. Co więcej, analogowe odbitki mogą zawierać więcej deformacji niż współczesne cyfrowe ob-

razy. Te zniekształcenia mogą być spowodowane optyką kamery, ale także różnymi przesunięciami i zawinię-

ciami, które mogły wystąpić podczas wywoływania odbitek. 

Zazwyczaj nie jesteś w stanie zidentyfikować tych deformacji. W praktyce oznacza to, że dopasowanie projekcji 

modelu do archiwalnego zdjęcia wymaga więcej iteracji niż w przypadku zdjęcia, dla którego znamy ogniskową. 

W praktyce, spędzam co najmniej kilka godzin nad jedną fotografią. Często nie można dopasować określonych 

obszarów: końcówek skrzydła, kołpaka śmigła czy konturu usterzenia. W takim przypadku, staraj się przynajm-

niej minimalizować te różnice. Zawsze traktuj wyjaśnienie o „ukrytych deformacjach obrazu” jako ostatnie1. 

 
1 Znana w filozofii i naukach ścisłych reguła „brzytwy Okhama” dotyczy także tego dopasowywania: sprawdź każdą możliwą kombinację 

parametrów projekcji zanim stwierdzisz, że nie możesz się dopasować do zdjęcia z powodu jego „ukrytych deformacji”. To czasami może 

być prawda, ale czasami może być spowodowane jakimś błędnym kształtem w Twoim modelu, który traktujesz jako „potwierdzony”. 

Na przykład: kilka lat temu dopasowywałem model SBD Dauntless do zdjęć. Robiąc to, miałem zawsze problem z dopasowaniem końcówek 

skrzydeł, nawet na współczesnych zdjęciach. Próbowałem różnych metod, ale te końcówki ciągle były za niskie i za długie (por. ten post z 

mojego bloga). Nie mogłem znaleźć żadnego geometrycznego rozwiązania, i myślałem, że te różnice są spowodowane dynamiczną defor-

macją skrzydła w locie. Pięć lat później zdobyłem oryginalną dokumentację tego samolotu. Zestawiłem jej wymiary w trójwymiarowy „szkie-

let”. Porównując uzyskaną geometrię, odkryłem, że w prawdziwym SBD rozpiętość skrzydeł była o 3” krótsza (41’ 3.2”) od wymiarów nanie-

sionych na rysunkach poglądowych Douglas i powtarzanych we wszystkich innych źródłach (41’ 7”). Jednocześnie, efektywny wznios 

skrzydła był większy niż podany na tych ogólnych opisach. Przyczyna była dziwna powierzchnia bazowa (odniesienia) użyta w dokumentacji 

skrzydła SBD (por. ten post). Za każdą różnicą, która powtarza się w mapowanych zdjęciach, może się kryć nowy (często zaskakujący) fakt 

o analizowanym samolocie! 

 

Aby efektywnie użyć zdjęć archiwalnych, dopasuj ich tyle, ile możesz (co najmniej dziesięć różnych 

fotografii). Ufaj tylko tym zidentyfikowanym różnicom, które występują na wszystkich fotografiach. 

Ta końcówka skrzydła nie 
pasuje do zdjęcia 

https://airplanes3d.wordpress.com/2015/12/05/matching-the-model-to-the-photos/
https://airplanes3d.wordpress.com/2020/05/16/original-sbd-dauntless-blueprints-wing-geometry/
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Do tej pory zdefiniowaliśmy sześć wzorcowych kamer, skojarzonych z różnymi zdjęciami. Chyba zauważyłeś, 

jak uciążliwe jest ręczne przełączanie się pomiędzy tymi projekcjami? Trzeba zaznaczyć obiekt kamery, wska-

zać go jako kamerę aktywną, dopasować proporcje obrazu wynikowego do obrazu przypisanego kamerze. Moż-

liwość szybkiego przełączania się pomiędzy tymi kamerami jest kluczowa dla efektywnego wykorzystania ich 

obrazów jako wzorców. Powinna być tak łatwa, jak przełączanie pomiędzy widokami ortogonalnymi. W istocie, 

początkowo wtyczka Reference Cameras miała dostarczać tylko takich „skrótów na jedno kliknięcie” w postaci 

przycisków przełączającej aktualny widok na zmapowane kamery.   

Na początku tej sekcji stworzyliśmy specjalna kolekcję dla kamer referencyjnych (por. Rysunek 14.2.4b). Jeżeli 

zmienisz jego nazwę na RC:Cameras, zobaczysz w panelu Cameras:Ref Cameras nowe przyciski. Każdy z 

nich włącza jedną z kamer z tej kolekcji (Rysunek 14.2.22): 

                                                

Rysunek 14.2.22 Aktywacja skrótów do kamer wzorcowych 

Ta wtyczka przegląda kolekcje sceny, szukając pierwszej, której nazwa ma końcówkę „RC:Cameras”. (Położe-

nie tej kolekcji w hierarchii sceny i przedrostek nazwy są nadal dowolne). Gdy wtyczka znajdzie taki zestaw, 

tworzy w panelu Ref Cameras przycisk dla każdej kamery referencyjnej z tej kolekcji (jak widać na ilustracji 

powyżej). Kliknięcie w taki przycisk przełącza projekcję okna 3D na wskazaną kamerę. 

Przesuń aktualną kamerę referencyjną (CTS-5) i obiekt CTS-5.Target do kolekcji z tymi kamerami. Ponieważ 

tak kolekcja jest ukryta (niewidoczna), zmapowany obraz wzorcowy zniknie ze wszystkich okien 3D tej sceny 

(Rysunek 14.2.23): 

 

Rysunek 14.2.23 Okno 3D z ukrytą aktywną kamerą 

 

Dowolny 

przedrostek 

Gdy zmienisz końcówkę nazwy 
kolekcji kamer wzorcowych na 
RC:Cameras, panel w przy-
borniku wyświetli skrót do 
każdej kamery z tego zestawu 

Kliknij ten przycisk 

Obraz tła z niewidocznej kame-
ry jest także niewidoczny    
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Zauważ, że panel Ref Cameras automatycznie odświeża swoją zawartość. Teraz możesz w niej widzieć przyci-

ski wszystkich kamer wzorcowych. Kliknij tylko w jeden z nich – powiedzmy w CTS-1a, aby zobaczyć model w 

tej projekcji (Rysunek 14.2.24): 

 

Rysunek 14.2.24 Rezultat kliknięcia w przycisk Ref Cameras:CTA-1a 

Teraz kliknij przycisk CTS-5, aby powrócić do projekcji poprzedniej (Rysunek 14.2.25). 

Aby ułatwić dalsze poprawki aktualnej projekcji, ta wtyczka tworzy specjalna kolekcję o nazwie RC:Temporary. 

Umieszcza w niej linki do aktywnej kamery i jej obiektu-celu (Rysunek 14.2.25):   

     

Rysunek 14.2.25 Specjalna kolekcja dla wybranej kamery wzorcowej (i jej obiektu-celu) 

 

 
Gdy już zostanie stworzona, możesz przesunąć kolekcję RC:Temporary w inne miejsce hierarchii sceny. Mo-

żesz także dodać do jej nazwy jakiś przedrostek. (Wtyczka znajduje ją po końcówce „RC:Temporary”). 

 

Każdy obiekt Blendera może należeć do wielu kolekcji. Ta wtyczka korzysta z tej funkcjonalności, pod-

łączając (linking) wybrane obiekty ze źródłowej kolekcji RC:Cameras. 

 

Kolekcja RC:Temporary powinna być widoczna w oknie 3D, ale ukryta do renderowania. (Gdy jest 

ukryta w oknach 3D, przyciski z panelu Ref Cameras nie działają). Wtyczka resetuje zawartość tej 

kolekcji za każdym razem, gdy klikniesz w jeden ze skrótów do kamery. 

Projekcja z kamery CTS-1a 

Dodatkowa kolekcja  

Zachowaj tę kolekcję widoczną w 
oknach 3D i ukrytą dla renderowania    

Te dwa obiekty 
należą także do 

kolekcji źródłowej   
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Pamiętaj, że wtyczka Reference Cameras wyświetla w panelu Ref Cameras przyciski dla każdego obiektu ka-

mery ze sceny, który: 

1. należy do kolekcji, której nazwa kończy się na „RC:Cameras”. 

2. ma przypisany Background Image; 

3. śledzi obiekt-cel za pomocą ograniczenia Track To. 

Te przyciski działają poprawnie wtedy, gdy jest włączona widoczność pomocniczej kolekcji RC:Temporary. 

Konkluzja 

• Możesz dopasować projekcję swojego modelu do archiwalnego zdjęcia, a potem używać go tak, jak pla-

nów. Jednak takie zdjęcia mogły ulec różnym zniekształceniom. Zazwyczaj nie będziesz w stanie zidentyfi-

kować nawet natury tych deformacji, nie wspominając już o ewentualnych korektach. Te zniekształcenia 

mogą uniemożliwić dopasowanie modelu do zdjęcia (por. Rysunek 14.2.18, Rysunek 14.2.19, Rysunek 

14.2.21). Wszystko, co możesz w takim przypadku zrobić, to dopasować model do innych zdjęć. Uzgod-

nienie z kilkunastoma fotografiami tworzy „reprezentatywną bazę” obrazów wzorcowych. Pamiętaj jednak o 

przybliżonej naturze tych dopasowań. Wprowadzaj do modelu tylko te różnice, które dostrzeżesz na 

wszystkich (lub niemal wszystkich) porównywanych fotografiach. 

• Dobrym pomysłem jest dodanie do zestawu obrazów wzorcowych kilku współczesnych zdjęć o wysokiej 

rozdzielczości odrestaurowanych samolotów (takich jak ten ze str. 588). W tym przypadku, staraj się ziden-

tyfikować w tych maszynach elementy odtworzone (niepochodzące z oryginału). Aby nie powtarzać błędów 

zespołów odbudowujących te samoloty, wyklucz te części z dalszych analiz. 

• Oceniam, że dla ogólnych wymiarów (jak długość czy rozpiętość) jednosilnikowego samolotu tolerancja tej 

metody jest bliska 1”. W przypadku oddzielnych zdjęć mniejszych elementów (osłona silnika, owiewka ka-

bin) ten zakres błędu może być niższy (rzędu ułamków cala). 

 

 

 

W danych, które towarzyszą tej książce (por. str. 19) możesz znaleźć i sprawdzić zdjęcia zmapowa-

ne w tej sekcji: model\p40\history\P40B-27.02.blend. 
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Rozdział 15. Wykorzystanie oryginalnej dokumentacji samolotu 

W zasadzie oryginalna dokumentacja techniczna powinna zapewnić komplet informacji niezbędnych do odtwo-

rzenia przedstawionego w niej obiektu. Istotnie, zawarte w niej dane są najbardziej wiarygodne. Jednak nie 

oczekuj, że w dokumentacji historycznego samolotu odnajdziesz wszystko, czego potrzeba do budowy modelu. 

Zazwyczaj takie zestawy rysunków są niekompletne i opisują inną wersję (lub wersje) samolotu niż ta, którą 

zamierzasz stworzyć. Dlatego, zanim użyjesz tych arkuszy, powinieneś zapoznać się z historią rozwoju tej ma-

szyny. Ta wiedza jest niezbędna dla poprawnej identyfikacji jej wariantu choćby w oparciu o kilka detali pokaza-

nych na jakimś rysunku. 

W tym rozdziale omówię źródła, z których można uzyskać oryginalne dokumentacje historycznych samolotów. 

Następnie pokażę praktyczny przykład użycia rysunków Curtiss do odtworzenia geometrii kadłuba P-40B (w 

szczególności – jego osłony silnika). 
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15.1 Szkielet referencyjny – tworzenie 

W wielu przypadkach nie możesz użyć skanów oryginalnej dokumentacji w ten sam sposób, jak obrazów pla-

nów modelarskich. Na przykład, jeżeli spróbujesz umieścić w przestrzeni modelu w odpowiednich stacjach ka-

dłuba półprzeźroczyste rysunki złożeniowe kolejnych wręg, ujrzysz w swojej scenie 3D nieczytelną, czarno-białą 

„mgławicę”. Lepszym pomysłem jest skopiować kontur każdej z tych wręg w wielobok, a potem użyć podczas 

formowania kadłuba takie pomocnicze obiekty jako wzorce. Te pomocnicze wieloboki są najlepszym rozwiąza-

niem w przypadku, gdy posługujesz się stabelaryzowanymi współrzędnymi (jak w przypadku geometrii osłony 

silnika, analizowanej w poprzedniej sekcji). 

W tej sekcji zademonstruję przygotowanie takiego „trójwymiarowego wzorca” z rysunków fabrycznych na przy-

kładzie kadłuba P-40B. Zgrupuję w nim w formie „wizualnej” wszystkie współrzędne i wymiary rozproszone w 

oryginalnej dokumentacji. Wynik będzie przypominał szkielet. Zamierzam użyć go do dopasowania finalnych 

powierzchni modelu. Przygotowując ten obiekt, napotkam (i rozwiąże) większość problemów z geometrią, któ-

rych nie widać na rysunkach 2D. Ten dodatkowy wysiłek ułatwi formowanie właściwego modelu samolotu. 

Zacząłem od pustego pliku Blendera. Dla ułatwienia, umieściłem w nim mój widok z boku (Tom I, sekcja 9.7). 

Ten wzorzec powinien być w takiej samej „skali” jak późniejszy model, więc tu także założyłem, że 1 jedn. Blen-

dera = 1 cal. Użyłem dwóch diagramów P-36 do odtworzenia tyłu kadłuba (część od przegrody silnika do steru 

kierunku). Pierwszy z nich (75-21-140) podaje szerokości i położenia podłużnic kadłuba na każdej wrędze. 

Sprawdziłem je także na jego zmodyfikowanej wersji (75-21-836) z XP-40: 

 

Rysunek 15.1.1 Geometria podłużnic kadłuba XP-40 (rys. 75-21-836) 

Stwierdziłem, że obydwa rysunki są identyczne. Maksymalną szerokość kadłuba mogłem odczytać z szerokości 

podłużnicy 8, która biegnie wzdłuż osi kadłuba. Dodatkowo, ten diagram podaje także wymiary kontury kadłuba 

w widoku z boku – są to podłużnice: 1 i 13. Przypuszczam, że czarne „maski” widoczne na rysunku XP-40 do-

powiadają chłodnicom Prestone i oleju. W pierwszym wariancie tego prototypu znajdowały się za krawędzią 

spływu skrzydła, w „pudełkowej” osłonie przypominającej tą z Hawker „Hurricane”. 

Skan diagramu XP-40, pokazywany przez Rysunek 15.1.1, ma grube, czarne linie i wymiary, podczas gdy część 

linii z diagramu P-36 jest tak cienka, że niknie w tle. Gdy napotkam na jednym z nich jakiś nieczytelny wymiar, 

sprawdzę go na drugim. 

Szerokości i wysokości podłuż-
nic w każdej ze stacji kadłuba 

Miejsce na 
chłodnice? 

https://app.aircorpslibrary.com/drawing/viewer/75-21-140/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-21-836/p-40
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Niestety, w przypadku współrzędnych kadłuba P-36 (75-21-020) nie mam takiego „dublera”. Skan tej klatki mi-

krofilmu jest częściowo nieczytelny: 

 

Rysunek 15.1.2 Współrzędne kadłuba P-36 (rys. 75-21-020) 

W szczególności, szkice w lewej dolnej części obrazu (Rysunek 15.1.2) znikają w tle, przez co nie mogłem 

określić znaczenia parametrów w poszczególnych kolumnach umieszczonych w nim tablic.   

Najpierw użyłem tych wymiarów i współrzędnych do uformowania płaszczyzny poziomej i pionowej. Każdy 

wierzchołek tych wieloboków odpowiada wymiarom z rysunków P-36 i P-40 (Rysunek 15.1.3): 

 

Rysunek 15.1.3 Pierwsze płaszczyzny wzorcowe 

Na razie nie chcę spekulować na temat konturów pomiędzy tymi punktami, więc połączyłem je prostymi krawę-

dziami. To trójwymiarowa reprezentacja współrzędnych z dokumentacji samolotu.    

Niektóre współrzędne 
są nieczytelne 

Zanikające kluczowe element 
szkiców z opisem współrzędnych 

Każdy wierzchołek to 
zwymiarowany punkt 

Proste odcinki 

https://app.aircorpslibrary.com/drawing/viewer/75-21-020/p-40
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Dla większej czytelności powierzchni wzorcowych, wstawiłem w ich istotnych miejscach kilka dodatkowych 

ścian (na przykład – za krawędzią spływu skrzydła). Uformowałem je zgodnie z rysunkiem fabrycznym, który 

mógł być nieco zdeformowany. Dlatego traktuję je jako „niepotwierdzone” żadnym wymiarem. Gdy podczas 

formowania finalnego modelu napotkam sprzeczność w szkielecie wzorcowym, te dodatkowe wierzchołki będą 

pierwszymi kandydatami do ewentualnych zmian. Dlatego oznaczyłem je innym kolorem (Rysunek 15.1.4): 

 

Rysunek 15.1.4 „Niepotwierdzone” obszary na płaszczyznach oznaczam kolorem zielonym 

Zdecydowałem się oznaczyć na niebiesko ściany łączące zwymiarowane punkty wieloboku, a na zielono –

ściany stworzone w oparciu o kontury z oryginalnych rysunków samolotu. 

Z drugiej strony, nie zapominajmy, że ta dokumentacja była przygotowana w „erze analogowej”. Oznacza to, że 

wszystkie wymiary podane w jej rysunkach i tabelach były wynikiem pomiarów jakiegoś „głównego wzorca” 

geometrii samolotu. Takie fizyczne pomiary zawsze zawierają drobne, losowe odchylenia. Można je zauważyć 

patrząc pod ostrym kontem na kontury naszych wieloboków, szczególnie na odcinki prostych (Rysunek 15.1.5): 

   

Rysunek 15.1.5 Odchylenia współrzędnych kadłuba 

W widoku z boku, dolny kontur ogona P-40 jest długą, prostą linią (Rysunek 15.1.5a). Jednak, gdy popatrzysz w 

dużym zbliżeniu wzdłuż tej krawędzi na uformowanym wieloboku, zauważysz odchylenia jego wierzchołków 

(Rysunek 15.1.5b). Chyba tolerancja ich pomiarów wynosiła +/- 0.02”. Myślę, że to jest całkiem możliwe, ponie-

Niebieskie ściany: 
łączą zwymiarowane 

punkty danych 

Zielone ściany: kontury skopiowane 
z rysunków (tzn. niezwymiarowane) 

Koncepcyjnie, to 
jest linia prosta 

Zbliżenie 

Typowe 
odchylenia: 
< 0.02” 

0.075” – czy to 
odchylenie? 

 

a) b) 
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waż typowa grubość blachy poszycia to 0.03”. Jednak wśród tych punktów danych można napotkać kilka odchy-

łek trzy-cztery razy większych. 

Na tym etapie budowania wzorca 3D trudno jest określić, czy taka „odstająca” współrzędna ujawnia jakiś praw-

dziwe, drobne ugięcie konturu samolotu, czy jest wynikiem błędu pomiaru. Stąd nie wykonałem żadnych popra-

wek, tylko zaznaczyłem („ku pamięci”) krawędzie wokół takich wątpliwych punktów jako „ostre” (Crease = 1).  

Czasami możesz oznaczyć taka współrzędną jako błędną, a potem znajdziesz kolejny rysunek, który poda w 

inny wymiar dla tego samego punktu. Gdy zidentyfikowałem, że dolna część tabel z częściowo nieczytelnego 

diagramu 75-21-020 (Rysunek 15.1.2) zawiera współrzędne punktów podłużnic, mogłem zacząć je w ten spo-

sób weryfikować. Okazało się to dużą pomocą. 

Stworzyłem wzorcowe wieloboki dla każdej z podłużnic kadłuba. Curtiss numerował je od 1 do 13, więc zacho-

wałem te cyfry w nazwach poszczególnych obiektów (Rysunek 15.1.6): 

 

Rysunek 15.1.6 Płaszczyzny podłużnic kadłuba 

Dodatkowo, znalazłem na diagramie 75-21-020 małą tabelę ze współrzędnymi górnej krawędzi teownika łączą-

cego kadłub ze skrzydłem. Stworzyłem z tych punktów kolejny obiekt wzorcowy. 

W trójwymiarowych siatkach opartych na tych współrzędnych można szybko znaleźć większość „odstających” 

wierzchołków, takich jak pokazane przez Rysunek 15.1.5. Wystarczy popatrzeć wzdłuż ich brzegów. Aby uświa-

domić Czytelnika, jak wiele błędów może zawierać taki oryginalny diagram, Rysunek 15.1.7 pokazuje górną 

część skanu 75-21-140, na której oznaczyłem te błędne wymiary na czerwono: 

 

Rysunek 15.1.7 Błędne wymiary na diagramie podłużnic P-36 (oznaczone na czerwono) 

1 

11 

12 

10 

2 
3 

4 

5 

6 

7 

8 

9 

Górna krawędź teownika mo-
cującego skrzydło do kadłuba 

13 
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Podczas tej weryfikacji przestudiowałem znów diagram 75-21-020 (Rysunek 15.1.2) i zidentyfikowałem, że jego 

górna tabela zawiera szerokości i wysokości wręg. Zwymiarowane punkty są rozmieszczone co 3” w pionie. 

Korzystając z czytelnych fragmentów tych tabel, odtworzyłem wręgi ogona: od #5 do #16 (Rysunek 15.1.8): 

 

Rysunek 15.1.8 Wręgi oparte o współrzędne z rys. 75-21-020 

Oczywiście, używałem także danych z innych źródeł, Na przykład – rysunki 99157 i 75-12-080 dostarczyły wy-

miary górnych części wręg #5, #6, #7, #8 i #9, a także oszklenia za fotelem pilota. 

Na nieszczęście, współrzędne wręg #1…#4 są nieczytelne. Współrzędne podłużnic dostarczają tylko wymiary 5 

punktów każdego z tych konturów. Musiałem szukać dodatkowych informacji na różnych rysunkach szczegóło-

wych. Ostatecznie, dodatkowe wymiary krawędzi kokpitu pozwoliły mi odtworzyć kształty wręg #2 i #3, oraz 

określić położenie i skręcenie dźwigara kadłuba (Rysunek 15.1.9): 

 

Rysunek 15.1.9 Wręgi #1…#4 

Nie znalazłem żadnych dodatkowych wymiarów przegrody silnika (#1), ale skopiowałem ten kontur z rysunku 

złożeniowego. Pasuje do końców podłużnic, ale oznaczyłem go na zielono, zgodnie z przyjętymi regułami. Wy-

miary wręg #2 i #3 ujawniły, że ich kontury pomiędzy podłużnicami 7 i 9 to łuki. Grzbiet #2A to dwa łuki i prosta. 

#5 

#16 

Promienie prze-
krojów oszklenia 
– wg rys.  99157 

#9 

#1 (przegroda 
silnika) 

#2 

#2A 

#3 

Krawędź kokpitu 

Dźwigar 

Kontur wręgi #4 powinien być 
“liniową interpolacją” pomię-
dzy wręgą #3 i wręgą #5 

#5 

https://app.aircorpslibrary.com/drawing/viewer/99157/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-21-080/p-40
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Wiedząc to, a także znając kształty podłużnic pomiędzy wręgami #3 i #5, założyłem, że kontur wręgi #4 był li-

niową interpolacją obrysów dwóch sąsiednich wręg. 

Wiatrochron może sprawić problemy, gdy jego krawędź przecięcia z kadłubem wygląda inaczej niż na zdję-

ciach. Aby uniknąć takich niespodzianek, sprawdziłem tę krawędź na naszym wzorcu (Rysunek 15.1.10): 

 

Rysunek 15.1.10 Krawędź przecięcia pomiędzy wiatrochronem i kadłubem 

Założyłem, że kształt wiatrochronu był identyczny w P-36 i w P-40, wiec wykorzystałem wymiary z rysunków 

osłony kabiny P-36 (75-26-001, -012, -011). Uformowałem górną część kadłuba w oparciu o wręgi #1, #2A oraz 

brzeg kokpitu. Potem porównałem uzyskaną krawędź przecięcia z archiwalnymi zdjęciami P-40. Odkryłem, że o 

ile w XP-40 kształt tej dolnej ramki wiatrochronu był tak „kanciasty” jak w P-36, to w P-40-cu jej tylne części 

stały się łagodniej wyprofilowane i cofnięte do tyłu o około 0.8”. To oznacza, że w seryjnych P-40 zmodyfikowa-

no kształt kadłuba pomiędzy stacjami #2A i #3A. 

W P-40B/C Curtiss wprowadził kolejną modyfikację ramki wiatrochronu, związaną z powiększeniem otworów 

inspekcyjnych do zamków kadłubowych karabinów maszynowych (Rysunek 15.1.11): 

    

Rysunek 15.1.11 Powiększony otwór inspekcyjny zamków nkm w P-40B/C 

“Kanciasty” kontur 
w P-36 i XP-40 

W P-40 te narożnik są 
zaokrąglone, i rozsta-
wione nieco szerzej  

Łagodniejsza 
krzywa w P-40-cu 

#1 #2A 

#3A (przypuszczalny) 

Wręga #3, zmo-
dyfikowana P-40  

Założyłem iden-
tyczną geometrię 
kabin P-36 i P-40 

W P-36 tutaj byłby 
ostry narożnik 

Mały otwór 
inspekcyjny 
w P-40-cu 

W P-40B/C duży 
otwór inspekcyjny 

“zachodzi” na 
wiatrochron 

https://app.aircorpslibrary.com/drawing/viewer/75-26-001/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-26-012/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-26-011/p-40
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W rezultacie, w P-40B/C ramka wiatrochronu uzyskała dość skomplikowany kształt. Jednak ta modyfikacja nie 

miała wpływu na przekroje poprzeczne kadłuba, więc zdecydowałem się ją pominąć w naszym wzorcu 3D. My-

ślę, że łatwiej będzie uformować tę ramkę wiatrochronu zaczynając od pierwszego, prostszego wariantu z 

P-40-cu, a potem ją zmodyfikować do stanu jak w P-40B/C. 

Studiując niewyraźny skan 75-21-020 nie byłem w stanie odczytać współrzędnych niektórych punktów z górnej i 

dolnej części konturu każdej z wręg (Rysunek 15.1.12): 

   

Rysunek 15.1.12 Tabele współrzędnych kadłuba (75-21-020) 

W efekcie powstały luki w budowanym szkielecie (Rysunek 15.1.13a). Na szczęście, na diagramie znalazłem 

współrzędne z dwóch płaszczyzn, umieszczonych +3” i +6” od płaszczyzny symetrii (Rysunek 15.1.13b). 

              

Rysunek 15.1.13 Dodatkowe płaszczyzny pionowe 

Teraz byłem w stanie interpolować te punkty krzywymi. Dlaczego starałem się umieścić w tym szkielecie 

wszystkie dostępne punkty? Ponieważ można je interpolować na różne sposoby. Na przykład,  

 

 

 

 

Rysunek 15.1.14 pokazuje dwie alternatywne krzywe interpolujące te same trzy punkty: 

 

 

 

 

Wysokości (+/-, co 3”) Szerokości (co 3”) 

S
ta

c
je

 

Nieczytelne sze-
rokości kadłuba 

Nieczytelne wyso-
kości kadłuba 

Wymiary w pionie (gór-
ne i dolne) na płasz-
czyznach +3” i +6” 

V+6 

V+3 

a) b) 

Brakujące 
fragment 
konturów 
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Rysunek 15.1.14 Różne krzywe, przechodzące przez te same trzy punkty 

Aby być „po bezpiecznej stronie”, do określenia ostatecznych kształtów krzywych interpolujących użyłem kontu-

rów z rysunków złożeniowych wręg (Rysunek 15.1.15): 

           

Rysunek 15.1.15 Dopasowywanie rysunku wręgi do współrzędnych z diagramu 

Dopasowanie tych rysunków do punktów z diagramu może ujawnić nowe „odstające” współrzędne, które nie 

zostały dotąd zauważone. Na ilustracji powyżej skorygowałem ogólną szerokość i wysokość obrazu wręgi, tak 

by pasowała do punktów leżących na osiach kadłuba (Rysunek 15.1.15a). Jednak kontur z rysunku nie pasuje 

do niektórych punktów położonych pomiędzy osiami (Rysunek 15.1.15b). Przypuszczam, że prawdziwa linia 

przechodziła przez punkt (3). Z kolei punkt (2) jest zbyt wysoko (o ok. 0.1”) ponad najbardziej prawdopodobnym 

konturem. W tym przypadku zdecydowałem, że (2) wygląda na błąd pomiaru. 

Formowanie konturu pojedynczej wręgi zgodnie z jej rysunkiem nie gwarantuje płynnej zmiany kształtów po-

między kolejnymi przekrojami kadłuba. Aby uniknąć takich błędów, tworzę ich interpolacje za pomocą pomocni-

czej powierzchni. Na kilku ilustracjach poniżej pokazuję jak przygotowuję wygładzone kontury dolnych części 

wręg kadłuba. Zacząłem od interpolacji pierwszej i ostatniej wręgi (Rysunek 15.1.16): 

The same 
datapoints 

Dopasowałem obraz 
do ogólnej szerokości 

i wysokości wręgi 

1 
Kontur z rysunku nie 
pasuje do niektórych 

współrzędnych 

2 

3 
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Rysunek 15.1.16 Interpolacja pierwszej i ostatniej wręgi 

Te wręgi formują zewnętrzne krawędzi „wycinka” powierzchni. To powierzchnia podziałowa. Wierzchołki jej siatki 

są jej punktami sterującymi – tak jak w powierzchniach NURBS używanych w systemach CAD. 

W kolejnym kroku, wstawiłem nową linię krawędzi, interpolującą środkową wręgę (Rysunek 15.1.17): 

 

Rysunek 15.1.17 Interpolacja wręgi środkowej 

Zwróć uwagę, że oznaczyłem tę nową krawędź jako „ostrą” (Crease = 1). W rezultacie, choć kontur wręgi jest 

gładką krzywą, to krawędzie prostopadłe do niego pozostają proste. W tej postaci łatwiej jest dopasować tę 

powierzchnię do prostych krawędzi wieloboków podłużnic, unikając ewentualnych problemów z krzywizną w 

kierunku prostopadłym (wzdłuż osi kadłuba). Robię tak, gdyż wyłącznym celem tej pomocniczej powierzchni jest 

stworzenie gładkich konturów wręg. Dwuwymiarową krzywizną kadłuba zajmę się podczas formowania modelu. 

W kolejnym kroku, wstawiłem pomiędzy istniejące kolejną linię krawędzi (kontur kolejnej wręgi): 

Gładka powierzch-
nia podziałowa 

Proste 
krawędzie 

Dopasowałem tę gładką krzywą do wierz-
chołków niebieskiego konturu wręgi 
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Rysunek 15.1.18 Interpolacja kolejnej wręgi 

Kontynuując takie podział każdego segmentu powierzchni, stworzyłem zestaw krzywych dla wszystkich wręg 

ogona samolotu (Rysunek 15.1.19): 

     

Rysunek 15.1.19 Gotowa powierzchnia pomocnicza 

Następnie w widoku z tyłu sprawdziłem, czy wierzchołki tej siatki (punkty sterujące powierzchni) są regularnie 

ułożone. Gdy siatka sterująca jest gładka, wynikowa powierzchnia podziałowa jest jeszcze gładsza. Ta regular-

ność zapewnia poprawne zmiany kształtu w konturach kolejnych wręg. 

Przygotowałem kilka takich pomocniczych „wycinków” dla różnych części konturów wręg (Rysunek 15.1.20): 

Zawsze wstawiaj nową linię kra-
wędzi tej wręgi, która jest najbliżej 
środka dzielonego segmentu 

W tym przypadku mo-
żesz wybierać pomiędzy 
tymi dwoma wręgami 

Gotowy zestaw 
interpolujący wręgi 

Sprawdź, czy wierzchołki tej siatki 
układają się w regularne, „gładkie” linie 

Widok z tyłu 
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Rysunek 15.1.20 Wycinki powierzchni interpolujące różne części konturów wręg 

Środkowy wycinek zaczyna się od regularnego łuku przy wrędze #5, który przekształca się w inny rodzaj krzy-

wej (stożkową?) przy wrędze #13. Zwróć uwagę, że ta siatka nakłada się na dolną powierzchnię. Usunę tę 

nadmiarowość później, podczas „sklejania” z krzywych wynikowych wręg. W rysunkach oszklenia (99157 i 75-

21-078) znalazłem promienie grzbietu kadłuba za kabiną (od wręgi #5 do #9). Okazało się, że te przekroje po-

przeczne są prostą kontynuacją kształtu odsuwanej owiewki kabiny: trapez zamknięty łukiem. Ich płaskie kontu-

ry boczne ulegają łagodnemu zakrzywieniu pomiędzy stacjami #9 i #13. Promień tego zakrzywienia jest tak 

duży, że zrezygnowałem z interpolacji tego fragmentu za pomocą pomocniczej powierzchni. W tym przypadku 

trzy oryginalne punkty współrzędnych i dwie podłużnice dostarczają wystarczającą ilość danych. 

W następnym kroku, wydzieliłem krawędzie wręg z pomocniczych siatek i połączyłem je w kompletne kontury 

(Rysunek 15.1.21): 

 

Rysunek 15.1.21 Gładka interpolacja konturów wręg 

Oczywiście, te interpolowane kształty są mniej pewne, ale bardziej użyteczne od pojedynczych zwymiarowa-

nych punktów. Dlatego zdecydowałem się oznaczyć je innym kolorem: czerwonym. Co więcej, zachowałem 

oryginalne niebieskie wieloboki. Gdyby to było potrzebne, pozwolą szybko sprawdzić czerwony kontur. 

Nie interpolowałem linii podłużnic, ponieważ ich promienie krzywizny są o wiele większe od promieni konturów 

wręg. Do odwzorowania takich kształtów wystarczają pojedyncze wierzchołki „niebieskich” wieloboków. 

Liczba obiektów w tej scenie się zwiększa, więc pogrupowałem je w cztery podstawowe kolekcje: 

• Blueprints – wszystkie obrazy wzorcowe. 

W tej część grzbietu kadłuba wręgi mają 
przekrój trapezu zakończonego łukiem   

Te dwa segmenty two-
rzą rodzaj „wybrzusze-
nia”, ukryty pod oprofi-
lowaniem skrzydła 

#5 

#13 

Na tym płaskim obszarze kadłuba 
oryginalny diagram dostarcza 
wystarczającej liczby punktów 

#9 

Regularny łuk 

Gładkie (interpolowane 
krzywymi) kontury wręg 

Wszystkie interpo-
lowane kontury są 
czerwone 

https://app.aircorpslibrary.com/drawing/viewer/99157/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-21-078/p-40
https://app.aircorpslibrary.com/drawing/viewer/75-21-078/p-40
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• Ordinates – wszystkie zwymiarowane (czyli niebieskie) obiekty. 

• Interpolation – wszystkie czerwone obiekty: gładkie kontury pomiędzy punktami z Ordinates. 

• Auxiliary – pomocnicze wycinki powierzchni i inne obiekty pomocnicze. 

Jak wspomniałem wcześniej (Tom I, sekcja 9.6) nie zachowały się współrzędne osłony silnika P-40-cu/B/C. Jej 

wzorzec 3D stworzyłem ze współrzędnych ostatniego wariantu XP-40 ze szkicu L-10202,  Rysunek 15.1.22): 

     

Rysunek 15.1.22 Współrzędne osłony silnika XP-40 

W poprzedniej sekcji doszedłem do wniosku, że osłona chłodnic XP-40 została w seryjnych P-40 obniżona o 

1.2” (Tom I, sekcja 9.7). Kształt ich bocznych i górnych paneli osłony silnika wygląda jak w ostatnim wariancie 

XP-40.   Dlatego najpierw interpolowałem powierzchnią oryginalny kształt z tego prototypu (Rysunek 15.1.23): 

 

Rysunek 15.1.23 Interpolacja osłony silnika XP-40 

W następnym kroku dopasowałem jej dolną część do mojego skompilowanego rzutu z boku (Rysunek 15.1.24): 

szkic L-10202 

Górna część powinna 
pasować do P-40-cu/B/C 

W seryjnych P-40 osłona 
chłodnicy była niższa o ~1”   

Tabela współrzędnych 

0 (przegroda 
silnika) 

-11 -22 -32 -44 -54 -64 -72 -74 -84 -90 3/4 

-92 5/16 

(podstawa 
kołpaka 
śmigła) 

https://app.aircorpslibrary.com/drawing/viewer/L-10202/p-40
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Rysunek 15.1.24 Interpolacja osłony silnika P-40-cu/B/C 

Jak widać, odtworzyłem także złożony kształt wlotu powietrza do chłodnic (na postawie szkicu L-10276). Po 

porównaniu z archiwalnymi zdjęciami, zdecydowałem, że w P-40-cu/B/C kształt tej części był taki sam. Co naj-

wyżej, w tych seryjnych maszynach wlot chłodnic został przesunięty do dołu o około 0.5”. 

Gdy pomocnicza powierzchnia była ukończona, skopiowałem jej krawędzie w nowe wręgi (Rysunek 15.1.25): 

 

Rysunek 15.1.25 Przekroje osłony silnika P-40-cu/B/C 

Zwróć uwagę, że oznaczyłem zmodyfikowaną część osłony chłodnic na żółto. Zdecydowałem się użyć tej barwy 

do oznaczenia elementów, których geometria jest oparta o zdjęcia (tzn. najmniej wiarygodna). 

Obniżona powierzchnia 

Wlot powietrza:  
odtworzony wg L-10276   

Żółte elementy: 
odtworzone w 

oparciu o zdjęcia 

https://app.aircorpslibrary.com/drawing/viewer/L-10276/p-40
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Choć jest oparty na współrzędnych z XP-40, ostateczny kształt osłony silnika P-40 wynika także z kilku 

założeń. Założyłem, że przekroje poprzeczne z XP-40 były zmodyfikowane tylko na obszarze osłon 

chłodnic cieczy, i zachowano ciągłość stycznych wzdłuż linii podziału paneli osłony. Założyłem także, 

że kształt wlotu powietrza w tym wczesnym P-40 był taki sam jak w ostatnim wariancie XP-40. Takie 

hipotezy czynią te przekroje „mniej pewnymi” od innych części tego trójwymiarowego wzorca.    

 
 W ostatecznym wariancie tego wzorca dodałem kilka szczegółów, na przykład –kontury wycięć za zagłówkiem 

pilota (Rysunek 15.1.26): 

 

Rysunek 15.1.26 Trójwymiarowy wzorzec kadłuba 

Wymiary wręg za zagłówkiem znalazłem na rysunku 75-21-078. Wykorzystując te dane i geometrię tylnych 

okien kadłuba (por. Rysunek 15.1.20), byłem w stanie określić dokładne przekroje poprzeczne tego wgłębienia. 

Skorzystałem z nich, bo na planach jego krawędź przecięcia z kadłubem była zasłonięta przez ramkę oszklenia. 

Dodałem do tego wzorca jeszcze kilka innych szczegółów, jak płaszczyzny podziału paneli osłony silnika, 

owiewki km, chwyt powietrza do gaźnika. Umieściłem je w kolekcji Auxiliary (Rysunek 15.1.26). Ich podstawo-

we kształty pochodzą ze szkiców SK-2603 i SK-2605. Dla uproszczenia, pominąłem zaokrąglenia ich krawędzi 

(odtworzę je w finalnym modelu). W widoku z przodu płaszczyzny podziału paneli silnika są liniami prostymi. 

Dwie dolne są potwierdzone przez rys. L-10202. Pozostałe dwie górne płaszczyzny są w kolorze żółtym, po-

nieważ odtworzyłem je korzystając ze zdjęć.  

Po kadłubie, w podobny sposób odtworzyłem skrzydła i usterzenie, przygotowując trójwymiarowy wzorzec całe-

go samolotu (Rysunek 15.1.27): 

Wycięcie za 
zagłówkiem 
fotela pilota 

Podział paneli   

Inne szczegóły z   
kolekcji Auxiliary 

 

https://app.aircorpslibrary.com/drawing/viewer/SK-2603/p-40
https://app.aircorpslibrary.com/drawing/viewer/SK-2605/p-40
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Rysunek 15.1.27 Kompletny trójwymiarowy wzorzec P-40(-cu) 

O dziwo, najtrudniejszą częścią tej pracy była osłona goleni podwozia. Rysunki P-40D/E podają tylko kilka z jej 

kluczowych wymiarów. Określają położenie zawiasów odchylanych pokryw, ich długości i szerokości. Znalazłem 

także kilka konturów z boku i rysunek wręgi. Dla P-36 mam nawet rysunek z teoretycznymi liniami osłony, ale w 

P-40 Curtiss uprościł te kształty. Rysunek 15.1.28 pokazuje wzorzec, który ostatecznie przygotowałem: 

    

Rysunek 15.1.28 Trójwymiarowy wzorzec osłony goleni koła głównego 

Używałem także archiwalnych zdjęć, które ujawniły, że niektóre szczegóły tych osłon we wczesnych wersjach 

P-40 były odziedziczone po P-36 (na przykład: kontur zewnętrznych brzegów osłony). W późniejszych („krótko-

nosych”) wariantach P-40 te podobieństwa znikły. Powinieneś być bardzo ostrożny w korzystaniu ze współcze-

snych zdjęć z „obchodów” muzealnych maszyn. W niektórych odrestaurowanych P-40B/C można napotkać 

osłony podwozia pochodzące z P-40E lub późniejszych wersji. 

W następnej sekcji piszę o tym, jak użyć taki plik w swoim projekcie Blendera. 

 

 

Plik *.blend zawierający ten trójwymiarowy wzorzec można znaleźć w materiałach towarzyszących 

(por. str. 19). Pełna ścieżka to: source/reference/3D_model/P-40_ref.blend. 

 
 

Zewnętrzne 
kontury osłony 
– jak w P-36 

Kontur boczny – 
skopiowany z 

rys. fabrycznego 
Zawias pokrywy bocznej 

Wręga  

Zawis 
pokrywy 
głównej 

Ten detal 
znikł w P-40D 

Przeciwległa krawędź pokrywy głównej    
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15.2 Szkielet referencyjny – użycie   

W poprzedniej sekcji opisałem przygotowanie trójwymiarowego wzorca P-40. Najprostszą metodą użycia takie-

go „wzorcowego szkieletu” do tworzenia modelu jest zaimportowanie go jako oddzielnej sceny. Gdy pisałem 

Rozdział 5, przygotowałem wzorzec skrzydła, w pliku source/reference/3D_model/wing_ref.blend (por. str. 19). 

Używając polecenia File→Append (str. 437) możesz „wejść do środka” tego pliku, i ze znajdującego się w nim 

folderu Scene importować jedyną umieszczoną w nim scenę, o nazwie Reference (Rysunek 15.2.1): 

     

Rysunek 15.2.1 Importowanie sceny wzorcowej 

Po zaimportowaniu, znajdziesz tę scenę na liście scen swojego pliku projektu (Rysunek 15.2.2): 

 

Rysunek 15.2.2 Importowany trójwymiarowy wzorzec skrzydła 

Gdy wybierzesz z tej listy scenę Reference, zobaczysz zaimportowany „szkielet wzorcowy”. 

1.  Otwórz zawartość tego pliku  

2.  Otwórz „folder” Scene  

3.  Importuj tą scenę 

Wzorcowy 
„szkielet” 
skrzydła 

Importowana scena 
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Teraz przełącz się do swojej sceny (tutaj nazwanej Model) i w zakładce Properties:Scene ustaw Reference 

jako Background Scene (Rysunek 15.2.3): 

 

Rysunek 15.2.3 Umieszczanie wzorca 3D jako Background Scene 

Gdy chcesz ukryć ten wzorzec – wystarczy wyczyścić pole Background Scene przyciskiem Clear ( ). 

 

Wielką zaletą umieszczenia wzorca w “scenie tła” jest brak możliwości zaznaczenia jego elementów. 

To bardzo upraszcza modelowanie. 

 
 Podczas modelowania, możesz łatwo dopasować wygładzoną powierzchnię siatki do tych wzorcowych żeber i 

dźwigarów. Widać je w oknie 3D jak każdy inny obiekt sceny (Rysunek 15.2.4): 

          

Rysunek 15.2.4 Używanie trójwymiarowego wzorca podczas modelowania  

Każdy wierzchołek niebieskich ścian tego wzorca odpowiada potwierdzonemu (przez wymiar lub współrzędne) 

punktowi powierzchni. Powierzchnia podziałowa dopasowywana do takich ścian powinna tylko „dotykać” tylko 

ich wierzchołki. Nie przejmuj się łączącymi je prostymi krawędziami: są tutaj tylko do „wypełnienia przestrzeni”. 

Zielone ściany są mniej pewne: skopiowałem ich kontury z oryginalnych rysunków Curtiss, ale ich kształt nie 

został (przynajmniej w pełni) zwymiarowany. Kontury na rysunkach mogły zostać z różnych przyczyn zdefor-

mowane i nie można na nich polegać tak, jak na geometrii potwierdzonej przez jawne wymiary. 

Czerwone elementy to interpolacje za pomocą powierzchni podziałowych obszarów pomiędzy niebieskimi (po-

twierdzonymi) punktami. Jak w każdej interpolacji, istnieje tu pewna swoboda kształtu między wierzchołkami. 

Wybierz tu scenę 
Reference 

Wzorcowy szkielet pojawi 
się w tej scenie (Model) 

Zakładka 
Scene 

Każdy wierzchołek błę-
kitnego obiektu to punkt 
oryginalnej powierzchni 

Końcówka skrzydła 

Żebro 000 

Zielone ściany: 
kontury z rysun-
ków fabrycznych 

Niebieskie ściany to orygi-
nalne dane geometryczne 

Ignoruj te 
proste 

krawędzie 
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Niektóre obiekty w scenie wzorcowej są z różnych powodów ukryte. Jednym z takich domyślnie niewidocznych 

zespołów są uproszczone bryły kluczowych elementów podwozia. Przesłaniają „czystą” geometrię skrzydła, 

którą Rozdział 5 omawia w swoich sekcjach początkowych. Aby ukryć/odkryć któryś z tych obiektów, zmieniaj 

widoczność ich kolekcji w scenie Reference (Rysunek 15.2.5): 

 

Rysunek 15.2.5 Kolekcje sceny wzorcowej  

Aby uniknąć konfliktów nazw z kolekcjami Twojego modelu, kolekcje wzorca mają przedrostki: R, S lub T. Jak 

widać powyżej, skrzydło używa przedrostka S. Kolekcja główna (S.Wing) dzieli się na cztery subkolekcje:  

• S.3--.Ordinates: wszystkie niebieskie i zielone elementy (czyli kształty potwierdzone na rysunkach). 

• S.4--.Interpolation: wszystkie czerwone elementy (gładkie interpolacje oryginalnych punktów). 

• S.5--.Auxiliary: wszystkie pozostałe obiekty. 

W każdych z tych kolekcji możesz znaleźć jakieś indywidualne obiekty (np. jak pomocnicza S.Wing Surface) 

oraz kolekcje grupujące podzespoły. Na przykład – kolekcje z żebrami skrzydła (Sections) są zarówno w kolek-

cji Ordinates jak i Interpolation. W tej drugiej znajdują się dwa interpolowane żebra skrzydła (czerwone wręgi, 

przy osi obrotu goleni podwozia). 

W kolekcji S.3--.Ordinates znajduje się kolekcja o nazwie S.3e-.Landing Gear. Gdy włączysz jej widoczność, 

zobaczysz uproszczoną goleń podwozia i koło (Rysunek 15.2.5). Choć te obiekty są dość „schematyczne”, ich 

osie i punkty obrotu znajdują się w dokładnym położeniu. Rozmiar głównego koła odpowiada jego konturom z 

oryginalnych rysunków Curtiss. 

Znajdują się tu także dwa obiekty Empty, których nazwy zaczynają się od słowa „Base”. Obiekt S.Base z kolek-

cji S.Wing (Rysunek 15.2.5) jest początkiem hierarchii („rodzicem wszystkich rodziców”) całego zespołu skrzy-

dła. Użyj go do przesunięcia wzorca skrzydła w docelowe miejsce w kadłubie i/lub obrotu o kąty zaklinowania i 

wzniosu. S.LG Base z kolekcji S.3e-.Landing Gear jest „rodzicem” zespołu podwozia (i „potomkiem” S.Base). 

Zaznaczyłem w ten sposób oś obrotu goleni podwozia.  

 

Dla większej „czytelności” tego szkieletu wzorcowego, w niektórych miejscach znajdują się w nim tylko 

czerwone interpolacje zamiast oryginalnych punktów danych. Tak jest np. na końcówce skrzydła. 

 
 

Przełącz się do sceny 
Reference by zoba-
czyć te kolekcje: 

Włącz widoczność tej 
sceny, by zobaczyć 

(uproszczone) podwozie 

Ten brzeg otworu koła używa mody-
fikatora Boolean, powiązanego z 
bryłą tnącą ukrytą w tej kolekcji   “Rodzic” hierarchii 

zespołu skrzydła 



Rozdział 15 Wykorzystanie oryginalnej dokumentacji samolotu 623 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Wzorzec skrzydła zawiera także szkielet osłon goleni podwozia. Jego elementy są rozproszone wśród kolekcji 

Ordinates, Interpolation i Auxiliary (Rysunek 15.2.6): 

 

Rysunek 15.2.6 Kolekcje sceny wzorcowej (c.d.) 

Znalazłem tylko kilka (w dodatku częściowych) rysunków tego podzespołu. Wydaje mi się, że na archiwalnych 

zdjęciach dostrzegłem także różnice tych osłon pomiędzy „krótkonosymi” (P-40D i dalsze) i „długonosymi” P-40 

(P-40C i wcześniejsze). W oparciu o zachowane rysunki oraz zdjęcia P-36 i P-40 starałem się odtworzyć wa-

riant z „długonosych” P-40. Jednak żółty kolor wszystkich wręg tej osłony sygnalizuje, że ich kształty są czę-

ściowo oparte na spekulacjach. Jest to najmniej „pewien” wzorzec. W przyszłości może się zdarzyć, że na pod-

stawie danych z jakiegoś nowego źródła będę musiał poprawić kształt tych wręg.    

Czasami wśród numerycznych współrzędnych z dokumentacji możesz napotkać na „odstający” punkt danych 

(tzn. nie pasujący do pozostałych). To wynik błędu pomiarów dokonywanych we wzorcowni zakładów Curtiss. 

Odchyłki w takich przypadkach mogą osiągać nawet 0.1”. Zachowałem te „wystające” punkty na niebieskich 

ścianach, ale wyrównałem je w odpowiadających im czerwonych interpolacjach.   

*   *   * 

Gdy skończysz już model, możesz usunąć scenę Reference z końcowego pliku *.blend. W zasadzie wystarczy 

tu jedno kliknięcie: użyj przycisku Clear po prawej stroni jego nazwy (por. str. 453), Jednak nie oczekuj, że roz-

miar tego pliku natychmiast zmniejszy się o dane tej sceny. W związku z używanym w Blenderze algorytmem 

„opóźnionego usuwania” (por. str. 628), może to zająć wiele cykli zapisywania i otwierania pliku. 

 

Umieszczenie obiektów wzorca w odrębnej scenie separuje ich hierarchię parent/child oraz hierarchię 

kolekcji od struktury Twojego modelu. 

 
 

 

Kolor obiektów sygnalizuje “poziom dokładności” danych prezentowanych w tym wzorcu. Najdokład-

niejsze są element niebieskie (tolerancja: +/-1/32”). Ewentualne odchylenia obiektów zielonych mogą 

być kilka razy większe. Czerwone “interpolacje” wypełniają przestrzeń pomiędzy niebieskimi punktami.    

 
 

 

Jeżeli chcesz przyśpieszyć ten proces, po usunięciu sceny Reference użyj przycisku Purge z nagłów-

ka trybu Orhpan Data okna Outliner (por. str. 630). 

 
 

Zawias 
pokrywy 

Zewnętrzna 
krawędź 

osłony goleni 

Włącz widoczność tych 
trzech kolekcji Nacelle 

Żółte obiekty to najmniej 
dokładny wzorzec 
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Dla dalszej pracy nad naszym modelem, przygotowałem wzorcowy szkielet całego samolotu. Możesz go zna-

leźć w pomocniczych materiałach towarzyszących tej książce (por. str. 19). Pełna ścieżka do tego pliku to: 

source/reference/3D_model/P-40_ref.blend. Gdy skończysz Rozdział 5, możesz usunąć scenę Reference ze 

skrzydłem. Potem wymuś przyciskiem Purge szybkie usunięcie jej całej zawartości i zaimportuj ten kompletny 

szkielet (Rysunek 15.2.7): 

 

Rysunek 15.2.7 Trójwymiarowy wzorzec kompletnego P-40 

Na ilustracji powyżej widać, że scena Reference zawiera trzy główne kolekcje: Fuselage, Wing i Empennage. 

Możesz szybko ukryć każdy z tych trzech zespołów wyłączając jego widoczność. Wewnętrzna struktura tych 

kolekcji przypomina zespół skrzydła, omówiony na poprzednich stronach. Wewnątrz odpowiednich kolekcji 

Ordinates, Interpolation i Auxiliary możesz znaleźć subkolekcje związane z różnymi podzespołami (Cockpit, 

Cowling, …). Pamiętaj, że taka pozycja może wystąpić we wszystkich trzech kolekcjach (Ordinates, 

Interpolation, Auxiliary), jak np. osłona pokazana przez Rysunek 15.2.6. Tak jak poprzednio, niektóre najmniej 

istotne elementy tej sceny są z różnych przyczyn ukryte. Na przykład, ukryłem niebieskie wzorce wręg kadłuba, 

ponieważ tylko zakrywają swoje gładkie interpolacje. 

Hierarchie stateczników (poziomego i pionowego) są przypisane do pojedynczych, pomocniczych „rodziców” 

(pustych obiektów bazowych), tak jak w przypadku skrzydła. Te obiekty bazowe pozwalają je łatwo ustawić pod 

odpowiednim kątem zaklinowania, tak jak skrzydło. Znajdziesz je u dołu kolekcji T.5--.Auxiliary. Możesz użyć 

tych baz do położenia stateczników „na płasko”. Takie ułożenie przydaje się podczas ich formowania w scenie 

Model. Zawiasy sterów kierunku i wysokości są podobnymi „ostatecznymi rodzicami” w hierarchii tych podze-

społów. Kadłub nie ma żadnego obiektu bazowego. 

Bazy usterzenia 
są w tej kolekcji 

Traktuj te szare 
obiekty jak czer-

wone interpolacje 

Nie ma kołpaka 
śmigła, ponieważ 

zaginęła jego 
dokumentacja 
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Rozdział 16. Dodatkowe wyjaśnienia 

W tym rozdziale umieściłem informacje "dla dociekliwych". Znajdują się tu szczegółowe wyjaśnienia wybranych 

zagadnień, nad którymi nie chciałem się rozwodzić w części głównej (aby nie zbaczać z tematu).  
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16.1 Struktura danych modelu i sceny w Blenderze 

Zapewne wiele razy, podczas pracy z Blenderem, mignęło Ci przed oczami tajemnicze słowo "datablock" ("blok 

danych"). Pojawia się w różnych miejscach i znaczeniach. Gdy zrozumiesz, czym w istocie jest dla Blendera 

"blok danych", zrozumiesz także zasady, rządzące elementami rysunku (pliku). Pozwoli Ci to poprawnie przewi-

dywać zachowanie programu i bardzo ułatwi pracę1.  

Każdy model w Blenderze złożony jest z obiektów (object) . Obiekt możesz traktować jak doskonale przejrzyste 

"pudełko": ma określony rozmiar, środek (punkt odniesienia), położenie, obrót, skalę. Obiekt "sam z siebie" nie 

ma żadnego kształtu. Kształt określa siatka (mesh). Siatka właśnie jest pewnym rodzajem "bloku danych" 

(datablock). Zawiera złożone informacje o wierzchołkach, krawędziach, ścianach powłoki, która ma być rysowa-

na na ekranie. Zazwyczaj każdy obiekt ma przypisaną "własną" siatkę (Rysunek 16.1.1):  

 

 

Rysunek 16.1.1 Obiekt i jego siatka 

Czasami ten sam blok danych – siatka – może być użyta przez kilka różnych obiektów. Przykładem takiej sytu-

acji jest śmigło modelu P-40 (Rysunek 16.1.2a): 

   

Rysunek 16.1.2 Łopaty śmigła – przykład jednej siatki współdzielonej przez trzy obiekty  

Te relacje obiekt:siatka można przedstawić na diagramie, takim jak ten pokazywany przez Rysunek 16.1.2b). 

 
1 "Datablock" to termin, któremu udało się wymknąć z żargonu programistów. W istocie każdy większy program posiada swoje własne 

słownictwo. Niektóre z tych słów to określenia żargonowe, których twórcy używali tak często, że bezwiednie zaczęli je umieszczać w komu-

nikatach i objaśnieniach. Ci ludzie żyją z tymi zwrotami na co dzień, i zupełnie nie zauważają, że "zwykli" użytkownicy mogą ich nie rozu-

mieć. Na przykład w AutoCAD-zie podobnym słowem było "entity", przeniesione żywcem z fachowej terminologii baz danych.      

Siatka, przypisana do obiek-
tu, określa jego kształt. 

Obiekt określa ogól-
ne właściwości: skalę, 
położenie, obrót... 

Przybornik ( N ) 

Obiekty Dane 
obiektów 

Kołpak  Siatka kołpaka 

Łopata A  

Łopata B 

Łopata C 

Siatka łopaty 

Łopata A 
(B.010.A) 

Łopata C 
(B.010.C) 

Łopata B 
(B.010.B) 

Kołpak (B.005) 
a) b) Diagram powiązań 

Siatki 

Obiekty 
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To śmigło składa się z trzech identycznych łopat. Rysunek 16.1.2a) pokazuje je w oknie Outliner. Można w nim 

wyróżnić trzy typy bloków danych, wyróżnionych ikonami: 

• : obiekt (obiekt to także „blok danych”); 

• : siatka; 

• : lista modyfikatorów obiektu. Każdy z tych modyfikatorów to oddzielny blok danych. 

Nie umieściłem tu ikony kolekcji, ale kolekcje są także odrębnym rodzajem bloków danych. 

 

Każdy element (oprócz list), który jest wyświetlany w oknie Outliner jest blokiem danych Blendera. 

 
 W szczególności, są nimi: 

• Siatki: nadają obiektom kształt. Zawierają dodatkowe dane, jak 

współrzędne mapowania tekstury (U, V), przechowywane przez 

każdą ścianę. 

• Kamery: określają projekcję używaną do renderowania sceny. 

• Światła: źródła oświetlenia dla renderowanej sceny. 

• Obiekty (już je znamy): uniwersalne „pudełka”, zawierające „w 

środku” (zakładka Object Data) jeden z bloków danych wymie-

nionych powyżej. 

• Materiały: określają barwę, przejrzystość, połyskliwość i wiele 

innych własności powierzchni. Można je przypisywać do siatek 

lub obiektów. 

• Obrazy (images): przypisane do materiałów jako tekstury, ale 

używane także jako rysunki referencyjne. Zazwyczaj zawierają 

tylko ścieżkę (link) do obrazu rastrowego na dysku. Jednak 

możesz także „zapakować” te obrazy do pliku projektu 

(*.blend). 

Aby przeglądać bloki danych w projekcie, w oknie Outliner wybierz tryb Blender File (Rysunek 16.1.3). Zoba-

czysz tam je wszystkie, pogrupowane według typu. Są to „podstawowe cegiełki”, które tworzysz i łączysz pod-

czas pracy nad modelem: siatki do obiektów, materiały do siatek (lub obiektów), obrazy do materiałów, itd. Nie-

które z bloków danych, jak modyfikatory, nie mają tu wydzielonej grupy. Są dołączone do swoich obiektów.  

Powiązane bloki danych są w Blenderze wszędzie. Większość z tych powiązań – do siatek, obrazów, świateł 

czy kamer – jest obsługiwana w ten sam sposób, przez wyspecjalizowaną kontrolkę. Pokażę ją na przykładzie 

łopaty śmigła. Gdy zaznaczysz ten obiekt i przejdziesz do okna Properties, zakładki Object Data, znajdziesz tę 

kontrolkę u góry tego okna (Rysunek 16.1.4) : 

 

 

 

 

Rysunek 16.1.4 Kontrolki, zarządzające przypisanym blokiem danych 

 

Rysunek 16.1.3 Kategorie bloków danych 

 

Tryb Blender 
File  

Lista rozwijalna z innymi 
blokami danych tego rodzaju 
(wszystkimi siatkami) 

Nazwa to unikalny identyfikator bloku 
danych. Tutaj możesz ją zmienić! 

Włącz ten przełącznik, by zachować ten 
blok przed automatycznym usuwaniem 

Licznik odniesień. 
Kliknij (LPM ) na tym polu by stworzyć 

kopię tego bloku danych związaną 
wyłącznie z aktualnym obiektem 
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Pole z nazwą bloku danych jest jego identyfikatorem w pliku projektu. Zmiana jego zawartości oznacza zmianę 

nazwy bloku1. Ten identyfikator musi być unikalny wśród bloków danych tego samego typu, więc możesz uży-

wać tę samą nazwę dla obiektu i jego siatki (por. B.005.Spinner pokazywana przez Rysunek 16.1.2a). Jeżeli 

chcesz wybrać inny, istniejący blok danych, użyj listy rozwijalnej po lewej stronie pola z nazwą. 

Po prawej stronie nazwy bloku danych umieszczony jest licznik "użycia" (referencji). Pojawia się dla bloków, 

które są powiązane z więcej niż jednym obiektem. Siatka B.010.Blade jest przypisana do trzech obiektów, stąd 

Rysunek 16.1.4 pokazuje przy niej liczbę 3. Kiedy klikniesz w ten przycisk – Blender utworzy duplikat aktualnej 

siatki. Duplikat nosi taką samą nazwę jak pierwowzór, z dodatkową końcówką numeryczną („.001”, „.002”, …). 

Oczywiście, możesz zaraz zmienić jego nazwę. Ta kopia zastępuje oryginalną siatkę przypisaną do obiektu.  

Licznik referencji bloku danych jest w Blenderze niezwykle ważny. Gdy siatka nie jest „użyta” przez żaden 

obiekt – jej licznik spada do zera. Wszelkie bloki danych o liczniku równym zero są pomijane przy zapisie pliku 

na dysk. Kołpak śmigła w naszym przykładzie – B.005.Spinner – miał własną siatkę, o identycznej nazwie: 

B.005.Spinner. Gdy usuniemy ten obiekt (Delete), siatka B.005.Spinner nadal będzie istnieć, ale jej licznik 

"użycia" spadnie do zera. Taki nieużywany blok danych Blender oznacza na liście cyfrą "0" (Rysunek 16.1.5): 

                       

Rysunek 16.1.5 Siatka usuniętego kołpaka śmigła 

 

Wszystkie bloki danych, które nie są wykorzystywane ("osierocone"), Blender pomija przy zapisie na 

dysk. Są w ten sposób, z opóźnieniem, usuwane z pliku. 

 
 Jeżeli tego chcesz, możesz uchronić siatkę B.005.Hub, przed "czystką" podczas zapisu. Trick polega na włą-

czeniu przełącznika z „tarczą” przed usunięciem obiektu, który zawiera ten blok danych (Rysunek 16.1.6):  

                

Rysunek 16.1.6 Zabezpieczenie bloku danych przed usunięciem  

Ten przełącznik sztucznie zwiększa licznik "użycia" bloku o 1, więc nigdy nie spadnie do 0. To tak zwany „fał-

szywy użytkownik” (F od fake user). Dzięki temu ten blok danych uniknie „czystki” (purge) podczas zapisu. 

 
1 Początkujący użytkownicy często próbują użyć tego pola jako „filtru” dla listy rozwijalnej (można napotkać taką funkcję w innych progra-

mach). Wpisują tam nazwę innej siatki, oczekując, że w ten sposób przypisują do obiektu inny blok danych. W rzeczywistości, zmieniają w 

ten sposób nazwę aktualnego bloku. Aby zachować jej unikalność, Blender dodaje do nazwy oryginalnego bloku przyrostek „.001”. Na 

przykład, jeżeli wpisałbym w pole z nazwą pokazywane przez Rysunek 16.1.4 „B.005.Spinner”, nadpisałoby to oryginalną nazwę 

„B.010.Blade” tego bloku. Jednocześnie, Blender zmieniłby nazwę oryginalnej siatki „B.005.Spinner” na „B.005.Spinner.001”. 

Kliknij tę “tarczę” przed 
usunięciem kołpaka śmigła  

Bloki danych z flagą F są 
zawsze zachowywane  

Usunięty obiekt koł-
paka (używał siatki 

B.005.Spinner) 

Nieużywana siatka B.005.Spinner 

(jej licznik referencji spadł do 0) 
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W oknie Outline można wybrać specjalny widok Orphan Data (Rysunek 16.1.7). W tym trybie wyświetlane są 

„osierocone” bloki danych, tzn. bloki bez powiązań z resztą projektu. Pokazywane są tu i elementy „chronione” 

(z licznikiem referencji = 1) i elementy gotowe do ”czystki” (z licznikiem referencji = 0): 

 

 

Rysunek 16.1.7 Widok „osieroconych” danych (tryb Orphan Data)  

 

Jeżeli zapomniałeś włączyć ochronę siatki przed usunięciem jej obiektu, wciąż możesz znaleźć ten 

blok danych w trybie Orphan Data okna Outliner. Możesz tu jeszcze włączyć tę ochronę (Rysunek 

16.1.7). Tylko zrób to przed zapisaniem i zamknięciem tego pliku Blendera!  

 
 W przypadku zagnieżdżonych referencji, domyślne „czyszczenie przy zapisie” wymaga więcej niż jednego cyklu 

do usunięcia wszystkich powiązanych bloków. Pokażę to na przykładzie materiału z teksturą (Rysunek 16.1.8): 

    

Rysunek 16.1.8 Przykład zagnieżdżonych referencji do bloków danych 

Materiał o nazwie Color Pattern jest przypisany do obiektu B.005.Spinner (Rysunek 16.1.8a). Łopaty śmigła 

używają innego materiału, więc licznik referencji Color Pattern = 1. Ten materiał używa jako tekstury obrazu 

Pattern. W diagramie tych relacji (Rysunek 16.1.8b) blok Pattern jest „połączony do połączonego bloku”, więc 

jego poziom zagnieżdżenia wynosi 2.  

Gdy wybierzesz inny materiał dla obiektu kołpaka (B.005.Spinner), licznik referencji Color Pattern spadnie do 

0. Ten materiał zniknie przy najbliższym zapisie. Rysunek 16.1.9a) pokazuje to w Outliner:Orphan Data: 

               

Rysunek 16.1.9 Usuwanie zagnieżdżonych referencji do nieużywanych bloków 

Gdy zapiszesz i otworzysz ponownie ten plik, wśród „osieroconych” danych znajdziesz obraz Pattern (Rysunek 

16.1.9b). Jego usunięcie wymaga kolejnego zapisania i otworzenia tego pliku (Rysunek 16.1.9c). 

Usunięty kołpak “osierocił” 

siatkę B.005.Spinner 

Tryb Orphan Data 

Licznik referencji 

Kliknij tutaj, aby włączyć 
“ochronę przed czystką” 

Wymuszenie “czystki”  

Tekstura związana 
z materiałem Color 
Pattern  

Poziom 
zagnieżdżenia 

B.005.Spinner 
obiekt 

a) b) Diagram powiązań 

Obiekt 
B.005.Spinner 

Color Pattern 
materiał 

Pattern    
obraz 

0 

1 

2 

Obraz Pattern jest 
wciąż powiązany z 
tym materiałem 

File→Save (1)  File→Save (2)  
Pattern stracił swo-
je powiązanie i stał 
się “osierocony”  

Wszystkie dane ma-
teriału Color Pattern 
zostały usunięte 

a) b) c) 
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Sekwencje zapisu/otwierania pliku, podobne do tej pokazywanej Rysunek 16.1.9, mogą być jeszcze dłuższe. 

(Na przykład: gdy materiał z teksturą byłby przypisany do siatki, a nie bezpośrednio do usuwanego obiektu). 

 

Automatyczne usuwanie przy zapisie pliku jest akceptowalne, ponieważ zazwyczaj nie zwracasz uwa-

gę na usuwane dane. Jeżeli jednak chciałbyś przyśpieszyć ten proces, użyj przycisku Purge z nagłów-

ka okna Outliner w trybie Orphan Data (por. Rysunek 16.1.10).   

 
 Czasami „odłączony” materiał lub obraz nie pojawia się wśród „osieroconych” danych. Przyczyna nie jest oczy-

wista, nawet dla średnio zaawansowanych użytkowników Blendera: są „używane” przez któreś z okien (edytor)! 

W przypadku materiałów, może to być Shader Editor, w przypadku obrazów – Image Editor lub UV Editor. Oka-

zuje się, że gdy otwierasz obraz w takim oknie, Blender zwiększa licznik referencji tego bloku danych. Nawet 

gdy w tym obszarze zmienisz edytor na inny – na przykład okno 3D – Blender przechowuje niewidoczny edytor 

obrazu „pod ekranem”, gotowy do powtórnego wyświetlenia. Ta instancja edytora zostanie usunięta tylko gdy 

scalisz ten obszar ekranu z innym obszarem. W praktyce, gdy chcesz usunąć jeden spośród wielu obrazów, 

możesz mieć problem ze znalezieniem takiego zapomnianego edytora, który wciąż „trzyma” ten blok danych. 

Może być ukryty w jakiejś dawno zapomnianej zakładce (workspace). 

Istnieje prostsza metoda na bezwzględne usunięcie bloku danych. Załaduj go do nowego edytora i kliknij w 

ikonę „odłącz” ( ) trzymając wciśnięty klawisz Shift . Rysunek 16.1.10 pokazuje to na przykładzie obrazu: 

             

Rysunek 16.1.10 Wymuszenie bezwzględnego usunięcia bloku danych 

Kiedy klikniesz ikonę „odłącz” tylko samym LPM  – Blender usuwa blok danych z edytora i zmniejsza jego licznik 

referencji o 1. Jednak kiedy użyjesz kombinacji Shift -LPM , program resetuje licznik referencji do 0. Powoduje to 

natychmiastowe umieszczenie takiego obrazu wśród „osieroconych” danych. 

 

Ikona “odłącz” nie jest dostępna w polach z zakładki Properties:Object Data (por. Rysunek 16.1.4).   

 
 

*     *     * 

Jak wspomniałem wcześniej, obiekty to także bloki danych. Są przypisywane do scen (Rysunek 16.1.11): 

                                                                          

Rysunek 16.1.11 Przykład dwóch scen 

Na ilustracji powyżej scena Model zawiera kompletne śmigło, a scena Spares zawiera sam kołpak śmigła. 

1. Załaduj blok da-
nych, który chcesz 
usunąć, do nowej 
instancji jego edytora 

3. Kliknij przycisk Purge 

2. Kliknij tu z 

Shift -LMB   

 
Ta kombinacja przestawia licznik 
referencji bloku danych na 0 (zrywa 
wszystkie istniejące powiązania) 

Image Editor Outliner 
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B.010.C.Blade  

M
o

d
e

l 

S
p

a
re

s
 

Diagram powiązań 



Rozdział 16 Dodatkowe wyjaśnienia 631 

 

 
 (CC) Witold Jaworski, 2009 – 2023 

Scena może zawierać wiele obiektów. Scena Model (Rysunek 16.1.11) jest sceną Scene z domyślnego sza-

blonu Blendera, której zmieniłem nazwę. Dodatkowo stworzyłem (por. str. 453) nową, pustą scenę o nazwie 

Spares. Umieściłem tam kołpak śmigła1. Na diagramie powiązań (Rysunek 16.1.11) widzisz, że ten obiekt 

B.005.Spinner otrzymał dodatkowe powiązanie. To zwiększyło jego licznik referencji. Od tej chwili, nawet jeżeli 

usunę ten obiekt ze sceny Model, to będzie nadal w Spares. Będę zawsze w stanie go stamtąd przywrócić. W 

ten sposób możesz używać tę drugą scenę jako pomocniczy „skład”. Może tu trzymać różne pomocnicze obiek-

ty, które chciałbyś zachować „na wszelki wypadek”, aby nie zagracać sceny głównej. 

 

Sceny Blendera zawierają tylko referencje (linki) do bloków danych obiektów. Dlatego w każdej z nich 

te obiekty mają takie same własności (położenie, obrót, skalę, materiały …).   

 
 Technicznie, gdy usunięcie obiektu oznacza jego „odpięcie” od bieżącej sceny. Rysunek 16.1.12 pokazuje struk-

turę pliku po usunięciu kołpaka śmigła (B.005.Spinner) ze sceny Model. To zmniejszyło licznik referencji 

B.005.Spinner o 1. Gdyby był użyty tylko w tej scenie – Blender wyeliminowałby go podczas najbliższego zapi-

sywania pliku. Lecz to nie nastąpiło, ponieważ B.005.Spinner jest wciąż obecny w drugiej scenie, więc jego 

licznik referencji jest wciąż większy od 0: 

                                                                          

Rysunek 16.1.12 Struktura pliku po usunięciu B.005.Spinner ze sceny Model 

Zwróć uwagę, że pomimo usunięcia ze sceny Model, to we właściwo-

ściach łopat śmigła B.005.Spinner nadal figuruje jako „rodzic” (obiekt 

nadrzędny). Blender nadal wyświetla jego nazwę w zakładce 

Properties:Object (Rysunek 16.1.13). Ta powiązanie nadal istnieje – 

obrót kołpaka w scenie Spares obraca jego łopaty w scenie Model. 

Wydaje się, że relacja parent/child nie zwiększa licznika referencji w 

żadnym bloku danych. 

Możesz także używać sceny do przechowywania różnych wersji mo-

delu samolotu (po jednej na każda scenę) w pojedynczym pliku pro-

jektu (*.blend). W takim scenariuszu, części wspólne dla wszystkich 

wariantów mogą być współdzielone pomiędzy tymi scenami. Obiekty 

specyficzne dla danej wersji znajdowałyby się tylko w jednej z tych 

scen. W praktyce taka organizacja wymaga nieco samodyscypliny w 

utrzymywaniu dopasowania wszystkich tych zależnych od wariantu 

detali do podzespołów współdzielonych pomiędzy scenami. 

 

 
1 Poleceniem Object→Link/Transfer Data→Link Objects to Scene 

 

Rysunek 16.1.13 „Rodzic” łopaty śmigła 

(scena Model) 
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16.2 Powierzchnie podziałowe (modyfikator Subdivision Surface) 

Powierzchnie podziałowe zostały wprowadzone do grafiki komputerowej pod koniec 20 wieku przez studio ani-

macji Pixar. Postacie w ich pierwszym filmie („Toy Story”, 1995) były zamodelowane za pomocą powierzchni 

NURBS. To był standardowy model matematyczny systemów CAD/CAM od lat 70. Przy okazji animacji kształ-

tów organicznych okazało się, że te powierzchnie „prują się wzdłuż szwów” elementarnych „płatków” NURBS. 

Jeden z twórców Pixar, Ed Catmull, zaproponował jako rozwiązanie powierzchnie dzielone wg schematu, który 

opracował z Jimem Clarkiem dwadzieścia lat wcześniej (w 1978r). Ich implementację opracował Tony DeRose. 

Zostały z sukcesem zastosowane w „Toy Story 2”. Powierzchnie Catmull-Clarka stały się standardem w pro-

gramach do animacji i wizualizacji. Powierzchnie NURBS potrafią „wygładzić” tylko czworokąty, podczas gdy 

powierzchnie podziałowe nie mają takich ograniczeń. Z drugiej strony, NURBS reprezentują analityczne wzory, 

podczas gdy powierzchnie podziałowe są zawsze tylko przybliżeniem. Do celów wizualizacji, powierzchnie 

Catmull-Clarka są „wygodniejsze” od NURBS, nawet w przypadku takich obiektów jak samoloty czy statki1.      

Nim opowiem o powierzchniach podziałowych, zacznijmy od przypadku prostszego – linii (krzywej) podziałowej. 

Linia taka powstaje w Blenderze wówczas, gdy zastosujesz modyfikator Subdivision Surface (określany także 

skrótem Subdivision) do siatki, składającej się tylko z jednego rzędu wierzchołków. Subdivision w pojedynczym 

kroku dzieli każdą krawędź oryginalnego wieloboku na dwie, tworząc nową, bardziej "gładką" linię.  

Rysunek 16.2.1 pokazuje przykład podwójnego podziału. Sześciokąt (Rysunek 16.2.1a) jest linią przed wygła-

dzeniem. Będę go określał dalej jako wielobok oryginalny. Każda zmiana położenia któregokolwiek z jego 

wierzchołków (A1..A6) zmieni kształt wyznaczanej linii podziałowej. Z tego powodu wielobok oryginalny jest tak-

że nazywany wielobokiem sterującym (ang. control polyygon). Punkty A1..A6 to punkty sterujące. 

 

                         

Rysunek 16.2.1 Linie podziałowe sześciokąta – wyjściowa i po kolejnych podziałach 

Każda kolejna linia podziałowa to wielobok, który ma dwa razy więcej wierzchołków niż ten, z którego powstał. 

Rysunek 16.2.1b) przedstawia rezultat pierwszego podziału sześciokąta. (W Blenderze, w ustawieniach modyfi-

katora Subdivison Surface, odpowiada to wartości Levels = 1). Jest to regularny wielobok, o dwunastu wierz-

chołkach. Rysunek 16.2.1c) przedstawia rezultat kolejnego podziału, tym razem dwunastoboku z rysunku b). (W 

ustawieniach modyfikatora Subdivision Surface, odpowiada to wartości Levels = 2). Jest to obrys o 24 wierz-

chołkach, bardzo zbliżony do okręgu! 

 

Krzywa, którą stałaby się linia podziałowa w wyniku nieskończonej liczby podziałów, nazwijmy krzywą 

ostateczną. Zazwyczaj już po dwóch – trzech podziałach oryginalnego wieloboku, linie podziałowe 

osiągają kształt niewiele różniący się od ostatecznego. Dzięki tej właściwości, w wyniku niewielkiej 

liczby obliczeń można uzyskać jego dobre przybliżenie. To duża zaleta tego modelu matematycznego. 

 
1 Programy wykorzystujące powierzchnie NURBS lepiej się nadają do modelowania złożonych części maszyn, jak np. odlew korpusu silnika. 

Są wyjątkowo dobre w odtwarzaniu przecinających się zaokrągleń krawędzi, jakich jest pełno w odlewach. Jednak „biegłość” w tym zakresie 

nie wynika wprost z modelu matematycznego. Ta logika była przez 40 lat „szlifowana” przez programistów systemów CAD. 

a) b) c) 

A1 

A2 

A3 

A4 

A5 

A6 

Oryginalna 
linia (6 boków) 

1 podział, 
→12 boków 

2 podziały, 
→24 boki 
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Rysunek 16.2.2 przedstawia reguły wyznaczania wierzchołków krzywych podziałowych. Przedstawiam je na 

przykładzie sześciokąta. 

Jednym z jego wierzchołków jest A (Rysunek 16.2.2a). Sąsiednie wierzchołki to E1 i E2. Te trzy wierzchołki two-

rzą podstawowy segment do podziału. Taki segment powtarzany dla każdego wierzchołka sześciokąta.  

Co drugi wierzchołek linii podziałowej leży w środku boku oryginalnego wieloboku. Rysunek 16.2.2b) pokazuje 

sześć wierzchołków takich wierzchołków.  Nazwijmy je krawędziowymi, bo leżą na krawędziach dzielonej linii. 

Wśród nich są punkty e1, e2, związane z wierzchołkiem A. 

 

           

Rysunek 16.2.2 Wyznaczenie wierzchołków e – "krawędziowych" punktów linii podziałowej 

Aby znaleźć pozostałe wierzchołki linii podziałowej, wyznacz najpierw pomocnicze punkty ok, leżące w połowie 

pomocniczego odcinka |ek i ek+1|. Rysunek 16.2.3a) pokazuje jeden oznaczony jako o, umieszczony w połowie 

odcinka |e1 e2|). Pozostałe sześć punktów linii podziałowej – a, nazywanych wierzchołkowymi – leży w połowie 

odpowiednich odcinków |A o| (Rysunek 16.2.3b). Łącząc wierzchołki a i e uzyskamy linię podziałową: 

   

           

Rysunek 16.2.3 Wyznaczenie wierzchołków a – "wierzchołkowych" punktów linii podziałowej 

Rysunek 16.2.3b pokazuje, że z wierzchołka A oryginalnej siatki powstały:  

• punkty krawędziowe e1 i e2 (współdzielone z rezultatami podziału sąsiednich wierzchołków); 

• punkt wierzchołkowy a, który reprezentuje „ślad” oryginalnego wierzchołka A na nowym wieloboku. 

Rezultat – linia 
podziałowa    

a) b) 

b) 

e2 

 e1 

 
 

 

 

o 

 

 

 

 

 

A 

 

 

 

 

a 

 

 

 

 

 

e2 

 e1 

 
 

 

 

o 

 

 

 

 

 

A 

 

 

 

 o – punkty 
pomocnicze 

a) 

E1 

A 

E2 

 

 

 

 

 e1 

e2 

 
 

E1 

A 

E2 

 

 

 

Punkty krawędziowe e – 
nieparzyste wierzchołki 

linii podziałowej 

E1 i E2 są sąsiednimi 
wierzchołkami A. 
 

Punkty wierzchoł-
kowe a – parzyste 

wierzchołki linii 
podziałowej 
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W każdym kolejnym podziale można wskazać taki punkt wierzchołkowy a, który jest bezpośrednim odwzorowa-

niem oryginalnego wierzchołka wieloboku sterującego A (Rysunek 16.2.4): 

 

             

Rysunek 16.2.4 Segmenty linii podziałowej dla różnych poziomów podziału 

Te bezpośrednie odwzorowania punktów A pozwalają wyróżnić na linii podziałowej tyle segmentów, ile bo-

ków ma wielobok sterujący (Rysunek 16.2.4).  

Rysunek 16.2.2 i Rysunek 16.2.3 podały "wykreślną" metodę wyznaczenia nowej linii podziałowej. Komputery 

nie jest jednak maszyną "geometryczną", tylko "algebraiczną". Jego procesor oblicza linie i powierzchnie po-

działowe w oparciu o współrzędne wierzchołków wieloboku sterującego. W porównaniu z innymi krzywymi sto-

sowanymi w grafice komputerowej (Beziera, B-sklejanymi), wzory te są bardzo proste. Sądzę, że pozwalają 

dostrzec zależności linii podziałowej od wieloboku sterującego, które nie są oczywiste w metodzie "wykreślnej": 

 

)(
2

1
11 AEe += ; )(

2

1
22 EAe +=   (por. Rysunek 16.2.2) 

Wyr.  16-1 Współrzędne punktów krawędziowych1 

21
8

1

8

6

8

1
EAEa ++=      (por. Rysunek 16.2.3) 

Wyr.  16-2 Współrzędne punktów wierzchołkowych 

Matematycy dowiedli, że krzywa ostateczna, do której zmierzają linie podziałowe opisane Wyr.  16-1 i Wyr.  

16-2, to tzw. jednorodna linia B-sklejana (uniform B-spline – UBS), trzeciego stopnia (cubic) . Oznacza to tyle, 

że linie podziałowe są dobrym przybliżeniem tej odmiany krzywych NURBS2 – modelu matematycznego stoso-

wanych od lat w systemach CAD/CAM oraz w projektowaniu przemysłowym.  

 
1 Wszystkie wyrażenia w tej sekcji tekstu operują na zapisie wektorowym. Symbole, które w nich występują, to w istocie wektory trzech 

współrzędnych: {x, y, z}. Stąd np. wzór na e1 z Wyr.  16-1 może być zapisany jako układ trzech niezależnych równań, dla każdej współ-

rzędnej oddzielnie:  

  xe = 1/2 (XE + XA);  ye = 1/2 (YE + YA); ze = 1/2 (ZE + ZA); 

gdzie e1 = { xe, ye, ze}, E1 = { XE, YE, ZE} , A = { XA,YA, ZA};      

2 Dokładniej: NURBS oznacza "Non-Uniform, Rational B-Spline" – "niejednorodna, ułamkowa krzywa B-sklejana". Jest to szeroka rodzina 

różnorodnych linii. Wśród nich są także "jednorodne krzywe B-sklejane" (oznaczane czasami jako UBS). W matematyce rzeczy „jednorod-

ne” są specjalnym przypadkiem rzeczy „niejednorodnych”. Tak więc ostatecznym kształtem, do jakiego dąży każda linia podziałowa, jest 

krzywa UBS, której punktami sterującymi są wierzchołki oryginalnego wieloboku linii podziałowej. 

a) b) 

Podziałów: 2 

a 

A 

Segment linii 
podziałowej 

Bezpośrednie 
odwzorowanie A 

Podziałów: 3 

A 

a 
Bezpośrednie 
odwzorowanie A 

Segment linii 
podziałowej 
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Linie podziałowe zachowują właściwości NURBS, m.in. : 

• ciągłość promienia krzywizny wzdłuż całej linii (dzięki temu krzywa wydaje się być bardziej "płynna" od 

np. połączenia kilku łuków); 

• sterowanie kształtem linii za pomocą wierzchołków oryginalnego wieloboku (punktów sterujących); 

• "lokalność" zmian: przesunięcie pojedynczego punktu sterującego wywołuje zmianę kształtu linii podzia-

łowej tylko w pobliżu tego punktu. 

Ta ostatnia z wyliczonych właściwości – ograniczony zasięg wpływu punktu sterującego na kształt krzywej – 

bardzo się przydaje w praktyce. Ale co to właściwie znaczy "w pobliżu punktu sterującego"? Otóż z Wyr.  16-1 i 

Wyr.  16-2 wynika, że położenie każdego wierzchołka linii podziałowej zależy od (co najwyżej) trzech sąsiednich 

punktów sterujących (E1, A, E2). Ta reguła dotyczy pojedynczego podziału. A gdzie się kończy wpływ punktu A 

na krzywą podziałową, która powstała w wyniku dwóch lub więcej podziałów? Rysunek 16.2.5a) pokazuje roz-

szerzanie się obszaru wpływu oryginalnego wierzchołka A na kolejne linie podziałowe. Wygląda na to, że wpływ 

ten nigdy nie osiągnie granicy drugiego segmentu linii: 

               

Rysunek 16.2.5 Granica wpływu punktu sterującego na kształt krzywej 

Rysunek 16.2.5b) pokazuje tę właściwość w praktyce. Przesunąłem wierzchołek A oryginalnego (regularnego) 

sześciokąta. W rezultacie krzywa podziałowa (2 podziały) zmieniła swój kształt z "prawie idealnego okręgu" 

(por. Rysunek 16.2.4b) na coś mniej regularnego. Przyjrzyj się temu kształtowi dokładnie. Punkt a jest bezpo-

średnim odwzorowaniem A na wynikowej krzywej. Zmianie uległ kształt tylko 4 segmentów najbliższych wierz-

chołkowi A (po dwa z każdej strony). Segmenty bardziej odległe (mierząc wzdłuż krzywej) są bez zmian!  

 

Wpływ każdego punktu sterującego na kształt linii podziałowej jest ograniczony tylko do czterech naj-

bliższych segmentów tej linii. W przypadku pokazanym przez Rysunek 16.2.5b) przesunięcie A prze-

sunęło bezpośrednie reprezentacje najbliższych wierzchołków: B and C. Pozostałe są bez zmian. 

 
  

*     *     * 

 

Podczas modelowania różnorodnych konstrukcji mechanicznych trzeba tworzyć różne okrągłe elementy lub 

otwory. Im mniej punktów ma ich wielobok sterujący, tym lepiej (szybszy rendering, mniej pracy z modelowa-

niem). Z drugiej strony rezultat podziału powinien być jak najbardziej zbliżony do okręgu. Warto więc sprawdzić, 

na ile dokładne "koło" można uzyskać z podziału jakiejś figury o niewielkiej liczbie boków, np. sześciokąta.  

 

a) b) 

A 

a 

Kształt 
bez zmian 

Zmienione 

segmenty 

1 podział 

2 podział 

3 podział 

A 

 

 

 

zakres wpływu punktu A 

Segment 1 Segment 2 
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C 

Oryginalny 

sześciokąt 
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Aby sprawdzić odchylenia od regularnego kształtu, porównamy kształt kilku linii podziałowych, wpisanych w 

okrąg o promieniu 1000 jednostek. Zmierzymy dwa rodzaje różnic: 

• max. odległość wierzchołka linii podziałowej do okręgu (idealnie – powinna być =0); 

• max. odległość pomiędzy środkiem boku linii podziałowej a konturem idealnego okręgu (zależy od licz-

by wierzchołków linii); 

Rysunek 16.2.6 i Rysunek 16.2.7 pokazują wartości odchyleń dla podziału sześciokąta: 

 

                                              

Rysunek 16.2.6 Odchylenie od okręgu dwukrotnego podziału sześciokąta 

                                              

Rysunek 16.2.7 Odchylenie od okręgu trzykrotnego podziału sześciokąta 

Linia podziałowa regularnego wielokąta jest nieco spłaszczona w środku każdego segmentu. Stąd w tym m iej-

scu występują największe odchylenia (p. Rysunek 16.2.6 i Rysunek 16.2.7). Należy zdawać sobie sprawę, że 

odsunięcie wierzchołka linii podziałowej od okręgu wynika wyłącznie z różnicy kształtu krzywej ostatecznej. 

Drugie odchylenie, które mierzyliśmy – odległość środka boku od okręgu – zależy także od liczby wierzchołków 

linii podziałowej. Będzie zawsze większe od odchylenia wierzchołka. (Im linia ma więcej wierzchołków, tym jest 

mniej "graniasta"). Błąd położenia wierzchołków przy zwiększeniu poziomu podziału sześciokąta z 2 (Rysunek 

16.2.6) do 3 (Rysunek 16.2.7) zmniejszył się tylko o kilkanaście procent (z 0.42% do 0.33%). W związku jednak 

z dwukrotnym wzrostem liczby boków, trzykrotny podział sześciokąta ma dwukrotnie mniejsze odchylenie ścia-

ny (1.2% dla podziału dwukrotnego, 0.5% dla trzykrotnego). 

Czy trzykrotny podział sześciokąta jest dobrym kandydatem na siatkę okręgu? Niestety nie: w praktyce naszego 

modelowania nie stosujemy trzykrotnych powierzchni podziałowych. Mają zbyt wiele ścian, a kształt, który uzy-

skamy, jest tylko o 30% bliższy do okręgu od podziału dwukrotnego. Podział dwukrotny sześciokąta, z pozio-

mem odchyleń w granicy 1.2%, jest dobry do modelowania małych elementów. Może to być wyposażenie kabi-

ny, drobne otwory, różnego rodzaju rury.  

2 podziały, 24 wierzchołki  

Max. odległość 
do krawędzi: 12.4 

Max. odległość do 
wierzchołka: 4.2  

Okrąg o średnicy 
1000 jednostek 

3 podziały, 48 wierzchołki 

Max. odległość 
do krawędzi: 3.3  

Max. odległość 
do krawędzi: 5.0  
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Aby dokładnie zamodelować większe okręgi – o średnicy 5-20” (12-50cm) – potrzebne jest max. odchylenie 

rzędu 0.6%. Powinna je posiadać jakaś dwukrotna linia podziałowa. Cóż, skoro sześciokąt nie spełnił naszych 

oczekiwać, sprawdźmy dwukrotny podział ośmiokąta (Rysunek 16.2.8): 

  

                                              

Rysunek 16.2.8 Odchylenie od okręgu dwukrotnego podziału ośmiokąta  

Wygląda na to, że dwukrotny podział ośmiokąta jest zadowalająco dobrym przybliżeniem okręgu. Odchylenia 

wierzchołków są na poziomie 0.13%, a odchylenie boku też leżą w zakresie tolerancji: 0.57%. 

 

Do zamodelowania mniejszych okręgów wystarczy użyć dwukrotnego podziału sześciokąta (max. od-

chylenie kształtu rzędu 1.2%). Do większych okręgów lepiej użyć dwukrotnego podziału ośmiokąta 

(max. odchylenie kształtu rzędu 0.57%). 

 
  

*     *     * 

 
Do tej pory zajmowaliśmy się wyłącznie krzywymi podziałowymi na bazie konturu zamkniętego. To dlatego, że 

większość linii podziałowych, które napotkasz w Blenderze, to krzywe zamknięte. (Linią podziałową jest kraniec 

każdej powierzchni podziałowej, a granica każdej powierzchni musi być obrysem zamkniętym).  

Rysunek 16.2.9 demonstruje zasady podziału na otwartych końcach oryginalnego wieloboku: 

 

              

Rysunek 16.2.9 Linia podziałowa dla obrysu otwartego – wyznaczanie punktów końcowych 

2 podziały, 32 wierzchołki 
 

Max. odchylenie  
wierzchołka: 1.3 
mm 

Max. odchylenie  
boku: 5.70 

a) 

A=a 

E2  

e2 

1/2 of |A E2|  

Pierwszy podział 

b) 

e  

1/4 of |A E2|  

Drugi podział 

A=a 

E2  
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Dla końca otwartego wieloboku sterującego A nie można wyznaczyć punktu wierzchołkowego a według Wyr.  

16-2 (str. 634) ponieważ z lewej brakuje punktu E1 (por. Rysunek 16.2.9a) i Rysunek 16.2.3). Dla takiego przy-

padku implementacja krzywych podziałowych w Blenderze zakłada, że: 

a = A 

Wyr.  16-3 Współrzędne końca linii podziałowej (ostatni punkt wierzchołkowy) 

Z każdym kolejnym podziałem koniec linii podziałowej będzie się „trzymał” końca oryginalnej linii. Ostatni seg-

ment linii podziałowej zawsze leży na ostatniej krawędzi oryginalnego wieloboku. Po każdym podziale staje się 

tylko coraz krótszy. Rysunek 16.2.9b) pokazuje, że po drugim podziale punkt krawędziowy e leży na 1/4 orygi-

nalnego boku |A E2|. 

Uwaga praktyczna: aby uzyskać w Blenderze takie same krzywe jak 

na ilustracjach, wyłącz opcję Use Limit Surface w sekcji Advanced 

ustawień modyfikatora Subdivision (Rysunek 16.2.10). W ten sposób 

uzyskasz „surowe” linie podziałowe wzdłuż brzegów powierzchni. 

Do obsługi powierzchni podziałowych Blenderze używa bibliotekę 

Open Subdiv ze studia Pixar. Jej formuły wykorzystują ulepszone 

wersje formuł podanych w tej sekcji. Przełącznik Use Limit Surface, 

domyślnie włączony, umieszcza wierzchołki rezultatu na ostatecznej 

powierzchni podziałowej. Dla pojedynczego wieloboku Blender zaw-

sze używa ostatecznej krzywej, bez względu na ten przełącznik. 

Oznacza to, że dla każdego poziomu podziału, punkty wierzchołkowe 

(por. Rysunek 16.2.6 - Rysunek 16.2.8) są zawsze w tym samym 

miejscu, najbliższym idealnego okręgu. (Odchylenie tych wierzchoł-

ków dla ośmiokąta to 0.11%). Nadal jednak zwiększenie liczby po-

działów zmniejsza odległości boków, jak na str. 636-637. 

*     *     * 

Powierzchnie podziałowe powstają w wyniku podziału oryginalnej powłoki (siatki połączonych ścian). Podczas 

podziału każda czworokątna ściana dzieli się na cztery nowe ściany, a trójkątna – na trzy. Rysunek 16.2.11 

przedstawia przykład dwóch kolejnych podziałów: 

 

                        

Rysunek 16.2.11 Podział 32-ściennego "globusa" 

Rysunek 16.2.11a) przedstawia oryginalną powłokę, złożoną z 32 ścian. Jej 26 wierzchołków (zbyt wiele, aby je 

na tej ilustracji zaznaczać) to punkty sterujące powierzchni podziałowej. Rysunek 16.2.11b) przedstawia rezultat 

pierwszego podziału tej siatki. Zwróć uwagę na kształt podziału ścian w okolicach "biegunów" oryginalnej po-

włoki. Rysunek 16.2.11c) to wynik dwukrotnego podziału. Kształt powłoki stał się już zbliżony do kształtu po-

wierzchni ostatecznej (powierzchni UBS trzeciego stopnia). W przypadku naszego "globusa" wcale nie jest to 

kula, tylko elipsoida. Przekrój w płaszczyźnie równoleżnika jest okręgiem, a w płaszczyźnie południka – elipsą. 

 

 

Rysunek 16.2.10 Ustawienia modyfikatora 

Subdivision Surface, które odpowiadają prezen-

towanym w tej sekcji formułom   

Powłoka 
oryginalna: 
32 ściany 

2 podziały, 
448 ścian 

a) b) c) 

1 podział, 
112 ścian 

Tu ustaw All 
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Aby przedstawić reguły schematu podziałowego Catmull-Clarka dla powierzchni, użyjemy przypadku przedsta-

wionego przez Rysunek 16.2.12:  

 

 

Rysunek 16.2.12 Punkt sterujący A i jego otoczenie 

Wierzchołek A łączy kilka krawędzi. Na ilustracji – Rysunek 16.2.12 – są to cztery krawędzie, na których leżą 

punkty E1, E2, E3, E4.  Otacza go także kilka innych punktów, z którymi nie jest bezpośrednio połączony. Są to 

pozostałe wierzchołki ścian, do których należy A. Na ilustracji oznaczyłem cztery takie punkty: F1, F2, F3, F4. 

Pierwszą grupa wierzchołków powierzchni podziałowej leży w pośrodku każdej ze ścian powłoki kontrolnej. 

Oznaczymy je jako punkty środkowe (Rysunek 16.2.13): 

 

 

Rysunek 16.2.13 Wyznaczanie wierzchołków f – środków ścian dzielonej powierzchni 

Punkty środkowe można wyznaczyć wg Wyr.  16-4: 

 

dla ściany czworokątnej: )(
4

1
1++++= kkkk EAEFf    

dla ściany trójkątnej:  )(
3

1
1+++= kkk EAEf   

gdzie1 k = 1,2, ..., n; a n – to liczba ścian wokół wierzchołka A. 

Wyr.  16-4 Współrzędne punktów środkowych ścian wokół wierzchołka A 

Oczywiście, środek fk można obliczyć dla ściany o dowolnej liczbie krawędzi.  

 

1 Wierzchołki wokół A ponumerowałem cykliczne – gdy k = n, to przyjmujemy, że k+1 = 1. Na przykład w Wyr.  16-4, przy obliczaniu f4, 

punkt Ek+1 powinien nosić oznaczenie E5, podstawiamy jednak na to miejsce E1. 

A 

E1 

E3 

E2 

E4 

F1 

F2 

F3 

F4 

A 

E1 

E2 

E4 F2 

f1 

f2 

f3 

f4 

E3 
F3 

Punkty środkowe f – 
środki każdej ze ścian 
otaczających A 

F1 

F4 
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Kolejne wierzchołki powierzchni podziałowej to punkty krawędziowe – ek. Każdy z nich leży w połowie odległo-

ści pomiędzy środkiem odcinka |AEk|, a środkiem odcinka |fk,fk+1| (Rysunek 16.2.14): 

 

 

Rysunek 16.2.14 Wyznaczanie wierzchołków e – punktów "krawędziowych" pow. podziałowej 

Każdy z punktów krawędziowych – e1, e2, e3, e4 – może być wyznaczony wg Wyr.  16-5: 

)(
4

1
1 AEffe kkkk +++= +

   

gdzie k = 1,2,..,n, a n – to liczba ścian wokół wierzchołka A. 

Wyr.  16-5 Współrzędne punktów krawędziowych wokół wierzchołka A 

Punkty środkowe fk i krawędziowe ek wyznaczają zewnętrzną krawędź nowych ścian, które powstają wokół 

wierzchołka A (Rysunek 16.2.15). (Ta krawędź jest "współdzielona" ze ścianami podziałowymi sąsiednich 

wierzchołków). Do zakończenia wyznaczenia czterech ścian brakuje już tylko ostatniego punktu – a. Punkty a, 

tak jak w przypadku krzywych, nazywamy punktami wierzchołkowymi:  

 

 

Rysunek 16.2.15 Punkt a – punkt "wierzchołkowy" pow. podziałowej 

Punkt wierzchołkowy a leży zawsze pomiędzy punktem A, końcami krawędzi oryginalnej powłoki Ek, oraz punk-

tami środkowymi fk. Dokładną zależność pomiędzy nimi opisuje Wyr.  16-6: 

)...(
1

)...(
1)2(

212212 nn fff
n

EEE
n

A
n

n
a ++++++++

−
=  

gdzie n – to liczba ścian wokół wierzchołka A  

Wyr.  16-6 Współrzędne punktu wierzchołkowego a – odwzorowania punktu sterującego A 

A 

E1 

E2 

E4 

f1 

f2 

f3 

f4 

E3 

Punkty krawędziowy e3 
e2 

e3 

e4 

e1 

Środek krawędzi |AE3| 

Połowa odległości po-
między punktami środ-
kowymi f3 i f4 

A 

E1 

E2 

E4 

f1 

f2 

f3 

f4 

E3 

e2 

e3 

e4 

e1 

a 

Punkt wierzchołkowy 
a 
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Powstanie powierzchni podziałowej pokazałem na przykładzie wierzchołka łączącego cztery czworokątne ścia-

ny. Dla tak zbudowanych powierzchni sterujących, powłoka ostateczna, do której zmierzają kolejne podziały 

Catmull-Clarka, jest jednorodną powierzchnią B-sklejaną, trzeciego stopnia („sześcienną”)1. 

W odróżnieniu od powierzchni NURBS, powierzchnie podziałowe potrafią utworzyć gładką powłokę z dowolnej 

kombinacji ścian, z których każda może mieć inną liczbę boków2. Przykładem takiej topologicznie różnorodnej 

siatki jest nasz „globus”. Oprócz ścian czworokątnych, wokół „biegunów” występują tam także trójkąty (Rysunek 

16.2.16). Wierzchołki „biegunów” łączą więcej niż cztery krawędzie. W okolicach takich punktów powierzchnia 

ostateczna nie jest powłoką B-sklejaną, i ciągłość promienia jej krzywizny może być zaburzona. Na pewno jed-

nak powierzchnie podziałowe pozostają "gładkie". Nawet wokół wierzchołków "specjalnych" zachowują przy-

najmniej ciągłość stycznych do powierzchni. 

 

 

Rysunek 16.2.16 Zwykłe i "specjalne" wierzchołki powłoki sterującej 

Wyrażenia opisujące powierzchnie podziałowe (Wyr.  16-4,Wyr.  16-5, Wyr.  16-6) są podane w sposób ogólny, 

dla dowolnej liczby ścian wokół wierzchołka oryginalnej powłoki. Używając ich, można także wyznaczyć wierz-

chołki siatki wokół takich "specjalnych" wierzchołków jak punkt B (Rysunek 16.2.16). 

 
Na każdej powłoce podziałowej Catmull-Clarka można wskazać krawędzie i segmenty, stanowiące bezpośred-

nie odwzorowanie ("ślad") krawędzi powłoki sterującej (Rysunek 16.2.17): 

 

 

Rysunek 16.2.17 Segment powierzchni podziałowej 

 

 

 

 

Rysunek 16.2.18 Przełączanie się w tryb bezpośredniego od-

wzorowania powierzchni podziałowej 

 
1 Jest to więc jeden z rodzajów powierzchni NURBS. 

2 Tego powierzchnie B-sklejane, nawet tak "elastyczne" jak NURBS, nie są w stanie obsłużyć. Powłoki NURBS są powłokami parametrycz-

nymi, przez co wymagają siatek punktów sterujących, w których wszystkie ściany mają taką samą liczbę boków. Skomplikowane, rzeczywi-

ste kształty są więc "szyte" z czworokątnych lub trójkątnych "płatków" powierzchni (patches). I właśnie te "szwy" były horrorem programi-

stów CAD/CAM w latach 80. i 90. XXw. W dodatku "pękały" podczas animacji. 

Zwykły punkt, łączący regularne, 
czworokątne ściany. (Tu powłoka 
ostateczna jest powierzchnią B-
sklejaną)  

Punkt specjalny – łączy 
sześć trójkątnych ścian. 
(Tu powłoka ostateczna 
nie jest powierzchnią B-

sklejaną) 

A 

B 

A

1 
A4 

A2 A

3 

a4 
a1 

a2 a3 

Kliknij przełącznik On Cage aby 
bezpośrednio zmieniać węzły na 
gładkiej powierzchni podziałowej, 
zamiast punktów sterujących 

(wierzchołków) siatki bazowej 

Panel modyfikatora Subdivision w Properties:Modifiers 
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Fragment powierzchni podziałowej ograniczony "śladami" krawędzi powłoki sterującej nazwiemy segmentem. 

Każda powłoka podziałowa ma tyle segmentów, ile ścian ma jej powierzchnia sterująca. (Jest to analogia do 

segmentów krzywych podziałowych – p. str. 634).  

 

W Blenderze, podczas edycji siatki, możesz się swobodnie przełączać pomiędzy ścianami powłoki 

sterującej i jej segmentami. Służy do tego niepozorny przełącznik On Cage w panelu modyfikatora 

Subdivision Surface (Rysunek 16.2.18). 

 
 Zakres wpływu pojedynczego punktu sterującego na kształt powierzchni podziałowej jest ograniczony. Zmiany 

nigdy nie przekroczą obszaru sąsiednich 4 x 4 segmentów. Oznacza to po dwa segmenty w każdą stronę, licząc 

od odwzorowania zmienionego wierzchołka (Rysunek 16.2.19):                

   

Rysunek 16.2.19 Granica wpływu punktu sterującego A na kształt powierzchni podziałowej 

Wspomniałem wcześniej, że siatki typu "globus", na których do tej pory eksperymentowaliśmy, pozwalają uzy-

skać elipsoidę, a nie kulę. Są dwie drogi, aby uzyskać za pomocą powierzchni podziałowych kształt kuli: 

• zastosować jako powłokę sterującą jakiś wielościan foremny (wszystkie jego ściany są jednakowe); 

• zwiększyć liczbę oraz zmienić położenie "równoleżników" na powłoce typu "globus", by nieco „spłasz-

czyć” uzyskiwaną z niego elipsoidę; 

Najprostszym przykładem pierwszej metody – użycia wielościanów foremnych – jest sześcian Rysunek 

16.2.20a). Innym, lepszym przybliżeniem jest powłoka o większej liczbie ścian (Rysunek 16.2.20b): 

                                     

Rysunek 16.2.20 Powłoki, pozwalające uzyskać powierzchnie podziałowe zbliżone do kuli 

Rysunek 16.2.20c) przedstawia przykład drugiego rozwiązania – modyfikację siatki typu "globus". Mimo, że 

okolice "biegunów" mają w takiej powłoce największe odchylenie od kształtu kuli, w praktyce często stosuję 

właśnie to rozwiązanie. Dlaczego? Zazwyczaj modelujemy nie pełną kulę, ale jej część (jakieś zaokrąglenie). 

Fragment siatki typu "globus" z punktem biegunowym łatwo jest wyprowadzić z fragmentów innych siatek.  

A 

A 

Obszar bez zmian 

A 
2 segm. 

2 segm. 2 segm. 

2 segm. 

Obszar 

zmieniony 

a) b) c) 
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A odchylenie w okolicy bieguna? Cóż, jest to pewien problem, ale zazwyczaj wystarcza dodać jeden - dwa do-

datkowe równoleżniki, i kształt staje się wystarczająco "kulisty". 

Do tej pory omawiałem powierzchnie zamknięte. Rysunek 16.2.21 pokazuje przykłady powierzchni otwartych: 

      

Rysunek 16.2.21 Powierzchnie podziałowe dla powłok otwartych 

Rysunek 16.2.21a) przedstawia efekt usunięcia połowy "globusa". Powstała powłoka sterująca w kształcie cza-

szy. Jej krawędź jest krzywą podziałową – taką jaką analizowaliśmy w pierwszej części tej sekcji. O kształcie tej 

linii decydują wyłącznie punkty krawędzi powłoki sterującej. (W tym przypadku jest okręgiem, powstałym w wy-

niku podziału ośmiobocznej krawędzi czaszy). Czasza z przypadku a) ma nieco większą średnicę niż elipsoida, 

z której powstała. Ten efekt widać dobitniej w drugim przykładzie.  

Rysunek 16.2.21b) przedstawia powierzchnię, która także powstała z siatki "globusa". Tym razem nie usunęli-

śmy żadnego wierzchołka. Usunięta została tylko pojedyncza ściana – i powstał w powłoce otwór. Jego krawędź 

zależy tylko od wierzchołków tej usuniętej ściany, więc leży w ich płaszczyźnie. W efekcie krawędź otworu zna-

lazła się powyżej oryginalnej powłoki i "pociągnęła" za sobą inne ściany z otoczenia. Wygląda to trochę jak 

brzeg formującego się wulkanu. Dla powłok o niewielkim zaokrągleniu ten efekt jest praktycznie niewidoczny. 

Może stanowić problem, gdy będziesz próbował wykonać większy otwór w bardziej zaokrąglonej powierzchni 

(por. Rysunek 16.2.29, str. 647). W przypadku otworów prostokątnych można tego uniknąć za pomocą płaskie-

go połączenia ścian (por. Rysunek 16.2.23, str. 644). 

Abyś nie odniósł wrażenia, że krawędź powierzchni podziałowej zawsze jest jakimś płaskim obrysem, przygo-

towałem trzeci przykład. Rysunek 16.2.21c) pokazuje nieregularną powierzchnię, w której jedne ściany są trój-

kątne, a inne – czworokątne. Krawędź takiej powłoki jest przestrzenną krzywą podziałową1.  

 

Krawędzią powierzchni podziałowej jest zawsze krzywa podziałowa. Wielobokiem sterującym tą krzy-

wą jest krawędź powłoki sterującej. 

 
 Do obliczania wierzchołków krawędzi otwartych powłok podziałowych musisz użyć innych wyrażeń niż dla po-

zostałych wierzchołków powierzchni. Ich punkty krawędziowe są wyznaczane według Wyr.  16-1 (str. 634) a nie 

Wyr.  16-5 (str. 640). Podobnie punkty wierzchołkowe – opisuje je Wyr.  16-2, a nie Wyr.  16-6. To programiści 

zakodowali ten dualizm w tej implementacji schematu Catmull-Clarka. Dodali także nową możliwość: użytkow-

nik może sam oznaczyć niektóre krawędzie oryginalnej powłoki jako "ostre" (creases) . Zostaną wówczas po-

traktowane, jak gdyby były krawędziami zewnętrznymi (mimo że leżą pośrodku powierzchni). Ich odwzorowa-

niem na powłoce podziałowej jest ostra krawędź, o kształcie krzywej podziałowej. 

 
1 Krzywej podziałowej jest "wszystko jedno", czy leży na jednej płaszczyźnie, czy nie. Jest zawsze krzywą przestrzenną – por. str. 1195. 

a) b) c) 
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Rysunek 16.2.22 przedstawia dwa przypadki ostrych krawędzi: 

 

Rysunek 16.2.22 Ostre krawędzie wewnątrz powierzchni podziałowych 

Rysunek 16.2.22 a) przedstawia sytuację wyjściową – zwykłą, gładką powłokę. Rysunek 16.2.22 b) pokazuje, 

jak zmieni się ten kształt, gdy "równik" powłoki sterującej został oznaczony jako "ostry" (crease). Odpowiadają-

ce jej krzywa powierzchni podziałowej została podniesiona, tworząc ostrą krawędź. Zauważ, że Blender tworzy 

narożnik w wierzchołku, w którym przecina się „ostra” krawędź z brzegiem powłoki. 

Rysunek 16.2.22c) demonstruje efekt przecięcia się dwóch „ostrych” krawędzi. Oprócz "równika", oznaczyłem 

jako "ostry" jeden z południków. Wierzchołek siatki łączący te dwie krawędzie stał się ostrym narożnikiem.  

 

Jeżeli z wierzchołka oryginalnej siatki wychodzą co najmniej trzy "ostre" krawędzie, to tworzy się w nim 

narożnik. Każda powierzchnia podziałowa (dowolnego poziomu) „dotyka” tego punktu. Zewnętrzne 

brzegi siatki także liczą się jako „ostre” krawędzie.  

 
 Wyjątkiem od reguły "punktu narożnego" jest narożnik prostokątnej ściany, leżący na krawędzi powłoki. Rysu-

nek 16.2.23 przedstawia narożny wierzchołek A. "Gładka" krawędź powłoki omija go szerokim łukiem. Gdy jed-

nak "wyostrzymy" jego obydwie krawędzie – stanie się narożnikiem: 

 

                  

Rysunek 16.2.23 Uzyskanie narożników na zewnętrznej krawędzi powłoki prostokątnej 

 

Istnieje także alternatywa: zamiast oznaczania krawędzi brzegu siatki jako “ostrych”, w ustawieniach 

modyfikatora Subdivision włącz opcję Boundary Smooth (w subpanelu Advanced – por. str. 638, Rysu-

nek 16.2.10). Ustaw je na Keep Corners. W tym trybie Blender tworzy ostry punkt w każdym narożniku 

ściany, tak jak pokazuje to Rysunek 16.2.23 (po prawej). 
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Wyostrzenie krawędzi umożliwia także uzyskanie prostokątnego otworu wewnątrz powłoki podziałowej. Gdy 

usuniesz ściany ze środka siatki, Blender tworzy otwór o zaokrąglonych krawędziach. Na powierzchniach wy-

pukłych (Rysunek 16.2.24a) te zaokrąglenia są wygięte na zewnątrz (efekt „krawędzi wulkanu”, por. Rysunek 

16.2.21b). Jeżeli "wyostrzysz" dwie krawędzie wychodzące z tego wierzchołka (Rysunek 16.2.24b), uzyskasz 

ostry narożnik. Co więcej: jeżeli trzy ściany oryginalnej siatki wokół tego narożnika (Rysunek 16.2.24c, ściany 1, 

2, i 3) leżą na tej samej płaszczyźnie, zachowasz „gładkość” (ciągłość stycznych) powierzchni podziałowej. (To 

eliminuje efekt „krawędzi wulkanu”):   

     

 

 

 

 

Rysunek 16.2.24 Uzyskanie narożników na krawędzi wewnętrznego, prostokątnego otworu 

Rysunek 16.2.25 ilustruje, jaką "barierą dla zmian" jest ostra krawędź. Przedstawiona powłoka zawiera dużą 

deformację, wywołaną przesunięciem punktu sterującego A. Przypadek a) to kształt gładkiej, zdeformowanej 

powierzchni. Przypadek b) – powierzchni, w której wpływ punktu A został ograniczony przez "ostrą" krawędź. 

 

 

                           

Rysunek 16.2.25 Ograniczenie wpływu punktu sterującego A przez "ostrą" krawędź 

 

 

Ostra (crease) krawędź siatki ogranicza wpływ punktów sterujących na kształt wygładzonej powierzch-

ni. Punkty sterujące z jednej strony ostrej krawędzi nie mają żadnego wpływu po stronie przeciwnej. 
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Krawędzie nie muszą być zawsze "całkiem ostre" lub "całkiem gładkie". Implementacja Pixara pozwala na płyn-

ną regulację "ostrości" (crease) w zakresie od 0 (zwykła, gładka krawędź) do 1 (krawędź ostra). Pokazuje to 

Rysunek 16.2.26: 

 

             

Rysunek 16.2.26 Stopniowa zmiana ostrości krawędzi       

Wierzchołek ag leży na zwykłej, gładkiej powierzchni, a ao – na zupełnie ostrej (Rysunek 16.2.26). Jak wyzna-

czane jest położenie wierzchołka a, który leży na "częściowo" ostrej krawędzi (crease = 0.5)? Jego współrzędne 

są "średnią ważoną" współrzędnych punktów ag i ao. "Wagą" w tym przypadku jest wartość "ostrości" – współ-

czynnik o zakresie od 0.0 do 1.0. Poniżej podaję wyrażenia wykorzystywane do obliczania punktów wierzchoł-

kowych i krawędziowych dla takiej krawędzi: 

 

go aaa )1(  −+=    

gdzie:  σ –    współczynnik "ostrości" (crease): od 0.0 (całkowicie gładkie) do 1.0 (całkowicie ostre); 

a0 –  punkt wierzchołkowy dla krawędzi całkowicie "ostrej", wg Wyr.  16-2;  

ag –  punkt wierzchołkowy dla krawędzi całkowicie "gładkiej" wg Wyr.  16-6;  

Wyr.  16-7 Współrzędne punktów wierzchołkowych a dla krawędzi "półostrych" 

go eee )1(  −+=   

gdzie:  σ –    współczynnik "ostrości" (crease): od 0.0 (całkowicie gładkie) do 1.0 (całkowicie ostre); 

e0 –  punkt krawędziowy dla krawędzi całkowicie "ostrej", wg Wyr.  16-1;  

eg –  punkt krawędziowy dla krawędzi całkowicie "gładkiej", wg Wyr.  16-5;  

Wyr.  16-8 Współrzędne punktów krawędziowych e dla krawędzi "półostrych" 

W Blenderze można zmieniać ostrość krawędzi poleceniem Edge→Edge Crease ( Shift - E , Rysunek 16.2.27a). 

Możesz także wpisać tę wartość w zakładce Item przybornika (w polu Mean Crease –  Rysunek 16.2.27b): 

         

Rysunek 16.2.27 Dwie metody sterowania współczynnikiem Crease w Blenderze       
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Pamiętasz, jak podkreślałem, że współrzędna X każdego punktu powłoki podziałowej zależy tylko od współ-

rzędnej X odpowiednich punktów sterujących (str. 634)? Podobnie współrzędna Y takiego wierzchołka zależy od 

Y, a Z od współrzędnej Z punktów sterujących. Prowadzi to do następującej reguły: 

 

Kształt rzutu powierzchni podziałowej na płaszczyznę zależy tylko od kształtu rzutu jej punktów steru-

jących na tej płaszczyźnie. 

 
 Ta reguła brzmi dość niejasno, ale jej znajomość bardzo ułatwia modelowanie. Postaram się ją pokazać na 

przykładzie. Rysunek 16.2.28 pokazuje lekko wygiętą powłokę, w której wykonałem otwór. Krawędź jej otworu w 

rzucie na płaszczyźnie XY jest okręgiem (Rysunek 16.2.28c): 

  

                             

                              

Rysunek 16.2.28 Okrągły otwór w lekko wygiętej powłoce 

Jak się zmieni kształt tej powierzchni na płaszczyźnie XY po wygięciu w płaszczyźnie ZX (Rysunek 16.2.29)? 

Zrobiłem to, przesuwając punkty sterujące wzdłuż osi Z w kierunku prostopadłym do pł. XY. Rysunek 16.2.29c) 

pokazuje, że jej rzut z góry nie uległ żadnej zmianie! (Porównaj Rysunek 16.2.29c i Rysunek 16.2.28c): 

                             

                             

Rysunek 16.2.29 Okrągły otwór w bardzo wygiętej powłoce 

Ta właściwość jest nieoceniona szczególnie w przypadku konieczności dokonania jakichś niewielkich poprawek 

kształtu. Możesz je zazwyczaj zaplanować jako przesunięcia wierzchołków wzdłuż pojedynczej osi. W ten spo-

sób masz gwarancję, że kształt obiektu w kierunku prostopadłym nie ulegnie żadnej zmianie. 
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Podsumowanie 

• Oryginalny obiekt geometryczny ulegający podziałowi jest nazywany wielobokiem sterującym (dla krzy-

wych) lub siatką sterującą (dla powierzchni). Jego wierzchołki to punkty sterujące (“punkty kontrolne”) 

wynikowej powierzchni podziałowej (str. 632, 638). 

• Na wynikowej krzywej/powierzchni zawsze można wskazać wierzchołek, który jest bezpośrednim 

odwzorowaniem odpowiedniego punktu kontrolnego (str. 634, 641).  

• Na krzywych podziałowych można wyróżnić segmenty. Każdy segment jest bezpośrednią reprezentacją 

pojedynczej krawędzi wieloboku sterującego (str. 634). Podobnie, każdy segment powierzchni podziałowej 

odpowiada pojedynczej ścianie siatki sterującej (str. 641). 

• Przesunięcie pojedynczego punktu sterującego n krzywej podziałowej wpływa na bezpośrednie odwzoro-

wanie dwóch najbliższych punktów sterujących: n-1, n+1 (str. 635). Podobnie, przesunięcie punktu sterują-

cego [u,v] siatki zmienia także położenie 4 najbliższych punktów sterujących: [u-1,v], [u+1,v], [u,v-1], [u, 

v+1] (str. 642). 

• Podwójny podział (level = 2) sześciokąta jest dobrym przybliżeniem małych okręgów (średnica poniżej 

10”).  Dla większych okręgów używaj ośmiokątów (str. 637). Dla okręgów większych niż 20” używaj dwuna-

stokątów foremnych. 

• Krawędzie brzegów otwartych powierzchni podziałowych są krzywymi podziałowymi (str. 643). 

• Możesz oznaczyć niektóre krawędzie siatki sterującej jako „ostre”. To wyostrza (creases) ich bezpośrednią 

reprezentację na powierzchni podziałowej (str. 644). Można także uzyskiwać częściowe wyostrzenie (str. 

646). 

• Ostra krawędź ogranicza wpływ punktów sterujących na powierzchnię wynikową (str. 645). 

• Rzut powierzchni podziałowej na płaszczyznę zależy tylko od rzutów jej punktów sterujących na tę płasz-

czyznę (str. 647). Dzięki tej własności, możesz łatwo uzyskiwać dokładne otwory o kształcie koła w po-

wierzchniach wynikowych. 
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16.3 Zniekształcenia obiektu na zdjęciach 

Najbardziej oczywiste zniekształcenie obiektu odwzorowanego na zdjęciu jest spowodowane przez projekcję 

perspektywiczną. Przedstawię ją na przykładzie prostego „domku” (złożony kształt samolotu utrudniłby dostrze-

żenie kluczowych zagadnień, które przedstawiam poniżej): 

 

Rysunek 16.3.1 Przykład zniekształcenia perspektywicznego 

Jednak płaszczyzny prostopadłe do kierunku kamery to specjalny przypadek (Rysunek 16.3.2):  

 

Rysunek 16.3.2 Własności płaszczyzn prostopadłych do kierunku kamery 

Projekcja perspektywiczna konturu, który leży na płaszczyźnie prostopadłej do kamery, zachowuje także jego 

kąty. Oznacza to, że ściany, które pokazuje Rysunek 16.3.2, zachowały swój oryginalny kształt (w szczególności 

– proste kąty narożników). Jednak zwróć uwagę na względne rozmiary tych ścian: zależą od odległości od ka-

Wszystkie linie proste 
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równoległe I prostopadłe  
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zależą od odległości od kamery  
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mery. W przestrzeni trójwymiarowej krawędzie A i B (Rysunek 16.3.2) mają identyczną długość, ale w tej pro-

jekcji A wydaje się być dłuższe od B, gdyż jest bliżej obserwatora (tj. kamery) .  

 

To oznacza, że sylwetka samolotu na zdjęciu z boku wykonanym prostopadle do płaszczyzny symetrii 

samolotu powinna odpowiadać jego konturowi z rzutu z boku (o ile zdjęcie nie jest zniekształcone). 

 
 Jednak w prawdziwych obiektywach na projekcję perspektywiczną nakłada się jeszcze inne zniekształcenie. 

Poniżej pokazuję przykład typowego zniekształcenia ujemnego („beczkowatego”)  (Rysunek 16.3.3): 

 

Rysunek 16.3.3 Przykład negatywnego zniekształcenia („beczkowatego”) w obiektywie kamery 

Gdybym usunął z powyższego obrazka pomocniczą siatkę i odciął zaokrąglone brzegi, trudno byłoby dostrzec 

to zniekształcenie. Możesz wykryć jego obecność sprawdzając długie linie, które w czystej projekcji perspekty-

wicznej powinny pozostać proste. Jeżeli są zakrzywione jak te na ilustracji powyżej, to obraz jest zdeformowa-

ny. Silne zniekształcenie beczkowate można łatwiej zauważyć dla bardzo krótkich ogniskowych kamery (gdy 

zaczyna przypominać obrazy z obiektywu typu „rybie oko”). 

Starsze teleobiektywy (o długich ogniskowych) mogą tworzyć zniekształcenia dodatnie („poduszkowe”):  

 

 Rysunek 16.3.4 Przykład dodatniego zniekształcenia („poduszkowego”)  

Tak jak w zniekształceniu beczkowatym, możesz wykryć tę deformację zdjęcia poprzez sprawdzenie wygięcia 

na obrazie długich, prostych linii (lub krawędzi). 

Bez tej pomocniczej siatki 
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Ostatnim przypadkiem jest złożenie zniekształceń negatywnych i pozytywnych  (Rysunek 16.3.5): 

 

Rysunek 16.3.5 Przykład deformacji złożonej („w wąsy”)  

Na ilustracji powyżej zniekształcenie ujemne („beczkowate”) dominuje w środku obrazu, podczas gdy znie-

kształcenie dodatnie („poduszkowate”) – w narożnikach. W tym przypadku ogólne zniekształcenie jest mniejsze, 

ponieważ te dwie deformacje się częściowo kompensują. Linie, które są proste w przestrzeni trójwymiarowej, tu 

są wygięte wzdłuż złożonych krzywych, których kształt przypomina spłaszczone wąsy. Stąd ten rodzaj deforma-

cji jest także określany jako zniekształcenie „w wąsy”. 

Czasami można wykryć zniekształcenie zdjęcia sprawdzając pewne elementy otoczenia samolotu. Rysunek 

16.3.6 pokazuje, jak wykorzystałem krawędzie betonowych płyt jako „długie, proste linie” : 

 

Rysunek 16.3.6 Identyfikacji zniekształcenia beczkowatego za pomocą linii krawędzi płyt lotniska (samolot: Douglas SBD-5)   

Obraz tych prostych linii jest wygięty wzdłuż 
złożonej krzywej o kształcie „wąsów” 

Ten obraz jest zniekształcony wzdłuż krzywych, 
których kształt przypomina (spłaszczone) wąsy 

Zdjęcie: Pacific Aviation Museum Pearl Harbor 

Prosta linia, styczna do 
linii podziału płyt po 
prawej stronie zdjęcia 

Linie podziału betonowych 
płyt, widoczne na zdjęciu 
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Gdy znajdziesz taki „wskaźnik”, możesz skompensować to zniekształcenie. Robi się to na przykład w GIMP, 

wykorzystując filtr Lens Distortion. Wywołaj okno Filters→Distorts→Lens Distortion (Rysunek 16.3.7): 

 

Rysunek 16.3.7 Kompensacja zniekształcenia beczkowatego (GIMP)  

W tym oknie wystarczy zmniejszać zniekształcenie Main, aż krawędzie płyt nie staną się proste. Powoduje to 

zmiany ich kątów pochylenia, przez co nie można tego sprawdzać za pomocą linii pomocniczych. Mówiąc 

szczerze, użyłem w tym celu fizycznej linijki, przyłożonej do ekranu (odkąd współczesne monitory LCD są zu-

pełnie płaskie, nie ma nic złego w takim niekonwencjonalnym narzędziu). Dla kompensacji zniekształcenia „z 

wąsami” używaj złożenia deformacji Main i Edge. Parametry Shift X i Shift Y to przesunięcie środka zniekształ-

cenia (od centrum obrazu). Parametr Zoom nie jest praktyczny (proporcjonalnie zmienia rozmiar obrazu).   

Te korekty pozwoliły mi poprawnie dopasować mój modelu 3D SBD-5 do zdjęć (Rysunek 16.3.8): 

 

Rysunek 16.3.8 Dopasowanie modelu 3D do zniekształconego („przed korektą”) i skorygowanego zdjęcia  

Zmieniaj zniekształcenie 
Main dopóki krawędzie 
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Do kompensacji deformacji “w wąsy” używaj 
złożenia zniekształceń Main i Edge. 
 

 

Zdjęcie: Pacific Aviation Museum Pearl Harbor 

Ta długa, prosta krawędź dachu była 
znakomitą linią do sprawdzania korekty 
 

 

Dopasowanie 
osłony silnika 
 

 

Przed korektą Przed korektą 

Dopasowanie statecznika 
i krawędzi kadłuba 
 

 

a) 

b) 

Po korekcie 

Za tym zdjęciem jest mój 
model. Można dostrzec czę-
ści jego siatki oraz elementy 
zabarwione na czerwono   

Zdjęcie: Pacific Aviation Museum Pearl Harbor 
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Rysunek 16.3.8a) i b) pokazuje problemy z dopasowaniem modelu do oryginalnego zdjęcia, które znikły po 

skorygowaniu zniekształcenia beczkowatego. Po takich korektach, te szczegółowe zdjęcia stały się dokładnymi 

obrazami wzorcowymi dla mojego modelu SBD-5. 

 

Dopasowanie modelu 3D do zdjęć samolotu opisuje Rozdział 14 (str. 578). 

 
 Jednak dla większości zdjęć nie będziesz w stanie ocenić, jak intensywne jest ich zniekształcenie. Dlatego do 

bezpośredniego sprawdzania rysunków referencyjnych (lub gotowego modelu 3D) sugeruję używać współcze-

snych zdjęć wykonanych teleobiektywem (np. w ten sposób fotografuje się samoloty w locie). Ich ewentualne 

zniekształcenia są minimalne. 

 

Środek obrazu jest zawsze najmniej zniekształcony. Największych deformacji możesz oczekiwać w 

pobliżu krawędzi. (Zakładając, że zdjęcie nie jest fragmentem wyciętym z większej całości). 

 
 Gdy używasz zeskanowanych zdjęć z książki lub magazynu, staraj się sprawdzić, czy wydawca zachował ich 

oryginalne proporcje. Podczas składu publikacji całkiem często zdarza się, że ilustracja nie pasująca do układu 

strony nie jest przycinana, a nieznacznie skalowana wzdłuż jednej z osi. Takie nieproporcjonalne skalowanie 

czyni ją bezużyteczną dla jakichkolwiek dokładnych porównań.  

 

W przypadku zdjęć z książek lub magazynów, zawsze staram się znaleźć tę samą ilustrację w innej 

publikacji i porównać ich proporcje. Jeżeli nie pasują do siebie idealnie – jedna z nich musiała zostać 

przeskalowana. 

 
 W większości takich przypadków nie jesteś w stanie określić, która ze fotografii została przeskalowana. W rezul-

tacie, obydwie są bezużyteczne. (Z drugiej strony – nie stracisz czasu na bezowocne próby dopasowania two-

jego modelu do takiego zdjęcia). 
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Słownik 

GPL, licencja – General Public Licence, udostępniająca produkt za darmo wszystkim odbiorcom. Licencja ta 

jest sformułowana w ten sposób, aby uniemożliwić komercyjne rozpowszechnianie produktu. 

 
materiał – to w Blenderze zestaw cech, używanych przy nanoszeniu obiektu na ostateczny obraz (renderowa-

niu). Cechy materiału to: barwa, połyskliwość, tekstura, i dziesiątki innych parametrów. Z materiałem może być 

związanych wiele tekstur (nierówności, barwy), zmieniających "ogólne" właściwości materiału dla pojedynczych 

pikseli renderowanego obrazu.  

 
NURBS (Non-Uniform Rational B-splines) – inny sposób wygładzania powłoki, złożonej z jednorodnych ścian. 

Powierzchnie NURBS stawiają wygładzanym powłokom wyższe wymagania. Muszą mieć jednorodne ściany 

(zazwyczaj czworokątne), a zespół ścian powinien także być regularnym czworokątem. NURBS jest starszym o 

ponad 30 lat modelem obliczeniowym od powierzchni podziałowych. Przez ten czas stał się standardem w sys-

temach CAD/CAM. Osobiście sądzę, że okres jego świetności ma się ku końcowi (choć wielu specjalistów może 

się ze mną nie zgodzić). 

 
rastrowy, obraz – popularna metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych lub 

czarno-białych punktów (pikseli). Tak jest np. wyświetlany obraz na ekran telewizyjnym, monitorze komputera. 

Wadą reprezentacji rastrowej jest pogorszenie jakości obrazu w dużych powiększeniach – gdy zaczynają być 

wyraźnie widoczne pojedyncze piksele. Zaletą jest stosunkowo prosty algorytm wyświetlania. Istnieje wiele róż-

norodnych sposobów zapisu (formatów) przechowywania obrazów rastrowych w plikach. Najpopularniejsze to 

*.jpg, *.png, *.bmp, *.tif. 

 
renderowanie (ang. rendering) – w tej książce oznacza tworzenie ostatecznego obrazu (lub sekwencji obrazów 

– animacji) przygotowanej wcześniej trójwymiarowej sceny. W pierwszych wersjach Autodesk 3D Studio (począ-

tek lat 90-tych XX wieku) było przetłumaczone na polski jako powlekanie, ale ta nazwa się nie przyjęła.  

 
shear (ang.) – przekoszenie (określane także jako "ścinanie"). Transformacja obrazu w GIMP. Przekształca 

kształt prostokąta w rąb (przeciwległe boki zachowują równoległość). 

 
subdivision surface (pol.: powierzchnia podziałowa) – sposób wygładzania kształtu oryginalnej powłoki, złożo-

nej z dowolnych ścian. W Blenderze występuje jako modyfikator siatki Subsurf (p. str. 511). Szczegółowy opis 

powierzchni (i linii) podziałowych znajdziesz na str. 632. 

 
tekstura – obraz (zazwyczaj rastrowy), nakładany na trójwymiarową powierzchnię. Stosowany w grafice kom-

puterowej do "urealniania" obiektów (nieregularności barw, napisy, itp.). Zastosowanie tekstur wykracza poza 

odwzorowanie barw – są stosowane także do zamodelowania drobnych nierówności powierzchni obiektów (tzw. 

bump maps). 

 
wektorowy, obraz – metoda reprezentacji, polegająca na zapisie obrazu jako zbioru kolorowych linii i obszarów. 

Każdy element obrazu ma określone współrzędne i kształt (prosta, łuk, koło, krzywa Beziera, ...). W ten sposób 

są zapisywane stworzone na komputerze rysunki techniczne. Zaletą reprezentacji wektorowej jest zachowanie 

dokładności przy dowolnym powiększeniu. Wadą jest złożony algorytm wyświetlania (dla ekranu lub drukarki 

wymaga przekształcenia na postać rastrową). Jednym ze sposobów zapisu danych wektorowych jest format 

*.svg, stosowany m.in. przez Inkscape. 

 
wireframe (pol.: siatka?) – oznacza sposób reprezentacji modelu w którym nie są rysowane żadne ściany, tylko 

krawędzie łączące poszczególne wierzchołki. Jest ich zazwyczaj dużo i są cienkimi liniami. Stąd obrazowo w 

literaturze anglojęzycznej taka reprezentacja jest nazywana "drucianą siatką" czyli "wireframe". 

 



Podziękowania 

Napisanie pierwszej edycji tej książki zajęło mi 6 lat (licząc od wprowadzenia, napisanego w listopadzie 2007, 

do tłumaczenia na angielski ostatniego tomu, zakończonego w listopadzie 2013). Potem była jeszcze edycja 

„uzupełniająca”, opublikowana w 2015, i ostatecznie – edycja obecna. Chciałbym podziękować mojej rodzinie 

za ten cały czas, w szczególności mojej najdroższej Żonie. 

Jestem wdzięczny Jackowi Jackiewiczowi, Mariuszowi Łukasikowi i Jumpei Temmie za plany, których używam 

w tej książce. Dziękuję także autorom zdjęć, które wykorzystuję. W szczególności dotyczy to zdjęć wysokiej 

rozdzielczości używanych jako tła, które pochodzą od: Tomo Yuna (yunphoto.net) i Chrisa Archera 

(archerbravo.com). Chciałbym także podziękować Hume Bates za komentarze i materiały dotyczące wczesnych 

P-40. 

 

Alex Stewart – recenzent wszystkich czterech tomów angielskiej edycji „Wirtualnego modelarstwa”. Zdjęcie przedstawia go pod-

czas pierwszego samodzielnego lotu na dwupłacie Tiger Moth. Alex interesuje się szczególnie samolotami z okresu I Wojny Świa-

towej. Życzę mu, aby kiedyś mógł się na którymś z nich przelecieć!  

Przemek Wysoczyński dokładnie przejrzał niniejsze wydanie w języku polskim, za co jestem Mu bardzo 

wdzięczny. Jego uwagi, w połączeniu z informacją zwrotną, którą dostarczali: Alex Stewart, David Payne, Rich 

Conclikn, Andrzej Borysewicz, Richard Deleu, Carlos Lopez i Daniel Wentzell, pomogły mi nadać „Wirtualnemu 

modelarstwu” ostateczny kształt i uczynić je jak najbardziej czytelnym. 
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Skorowidz 

 

Nazwy poleceń, skróty klawiatury, podane w skorowidzu, dotyczą Blendera, o ile w haśle nie jest za-

znaczone inaczej: „(GIMP)”, „(Inkscape)” 

 
  

. 

. (kropka):, Patrz Pivot 

= 

=, Patrz transformacja, wprowadzanie parametrów 

1 

1, Patrz Front 

3 

3, Patrz Left 

3D Cursor 

jako punkt odniesienia, 506, 510 

jako punkt wstawienia, 462 

panel z zakładki View przybornika, 86 

w oknie 3D, 67 

wybór z listy Pivot, 67 

3D Viewport 

okno, 27 

5 

5, Patrz Perspective/Orthographic 

7 

7, See Top 

A 

Active Camera 

polecenie z menu Cameras, 475 

Active Element 

jako punkt odniesienia, 506 

środek transformacji, 498 

Add Constraint (with Target) 

polecenie z menu Constraints, 488 

Add Modifier 

polecenie z zakładki Modifiers, 467, 514, 521, 548, 

552, 554, 555, 560, 564, 565, 570 

add-on 

Intersection, 482 

Add-ons 

sekcja okna Preferences, 443 

Adjust Last Operation 

panel okna 3D, 466 

aktywne 

okno, 28 

aktywny 

obiekt, Patrz obiekt, aktywny 

wierzchołek, 496, 498 

Align 

polecenie z menu Vetex (Vertex Tools), 524 

Allpolecenie z menu Select, 499 

Alt-D, Patrz Duplicate Linked 

Alt-H, Patrz Reveal Hidden 

Alt-P, Patrz Clear Parent 

angle constrain 

opcja polecenia Knife, 533 

Animation 

układ ekranu, 34 

Annotations 

panel z zakładki View (przybornika), 447 

Append 

polecenie z menu File, 437 

przycisk w oknie File View, 438 

Apply 

polecenie z menu kontekstowego modyfikatora, 572 

polecenie z menu kontekstowego modyfikatora, 515 

Array 

modyfikator, 564 

odległość odsunięcia kopii, 564 

współczynniki trybu Relative Offset, 564 

Arrows 

odmiana pustego obiektu (Empty), 472 

polecenie z submenu Empty, 472 

artefakty 

cieniowania, 516 

Artificial 

materiały pomocnicze, 186 

atrefakt 

w widoku perspektywicznym (okno 3D), 44, 475, 476 

Auto Save 

polecenie z submenu Recover, 439 

Auto Smooth 
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opcja z panelu Object Data 

Normals, 516, 541 

Axis 

kierunek projekcji siatki (modyfikator Shrinkwrap), 

566 

B 

B, Patrz Box Select, Patrz Box Select 

Back to Previous 

przycisk z nagłówka, 40 

Background 

polecenie z submenu Image, 461 

baza 

(obiekt) podzespołu steru kierunku, 264 

(obiekt) podzespołu steru wysokości, 244 

zespołu usterzenia, 236 

zespołu usterzenia pionowego, 260 

beczkowate 

zniekształcenie zdjęcia, 650, 651 

Bevel 

Clamp Overlap 

zapobieganie nakładaniu fazek, 561 

Depth 

opcja z listy Width Type, 560 

kąt graniczny, 560 

modyfikator, 560 

modyfikator a rozwinięcie siatki w UV, 563 

modyfikator, przykład użycia, 193 

modyfikator, użycie zmiennych wag, 378 

Offset 

opcja z listy Width Type, 560 

Percent 

opcja z listy Width Type, 560 

pole Amount, 560 

pole Limit Method, 560, 562 

Profile 

opcje Shape, 562 

Segments 

zaokrąglanie krawędzi, 561 

Weight 

różnicowanie promienia zaokrąglenia, 562 

Width 

opcja z listy Width Type, 560 

Width Type 

parametr polecenia, 560 

współczynnik Weight, 562 

biblioteki 

elementów — wykorzystanie innych plików Blendera, 

438 

Blender 

rozszerzenia funkcjonalności, 443 

wyjście z programu, 37 

blok danych, Patrz datablock 

Boolean 

’czyszczenie’ krawędzi, 529 

modyfikator, 552 

modyfikator, przykład użycia, 169, 171, 187 

operacje w trybie edycji, 527 

problemy z metodą Exact, 173, 174 

problemy z metodą Fast, 173, 174 

problemy z zależnością parent/child, 171 

różnica (Difference), 527, 552 

widoczność rezultatów w Edit Mode, 553 

wybieranie drugiego obiektu, 552 

Bottom 

polecenie z menu View, 43 

Boundary Smooth 

opcja modyfikatora Subdivision Surface, 638, 644 

Bounding Box Center 

jako punkt odniesienia, 506 

przykład użycia, 98 

wybór z listy Pivot, 68 

Box Select 

polecenie z menu Select, 58, 500 

Bridge Edge Loops 

polecenie z menu Edge, 545 

C 

C, Patrz Circle Select, Patrz Circle Select, Patrz Clamp, 

Slide Vertices 

Camera 

polecenie z menu Add, 474 

polecenie z submenu Viewpoint, 56 

utworzenie nowego obiektu, 474 

Cap Fill Type 

parametr polecenia Add Cylinder, 470 

Catmulla-Clarka 

powierzchne podziałowe, 467 

checkbox 

kontrolka panelu, 76 

cieniowanie 

unikanie artefaktów, 516 

w oknie 3D 

opcje, 50 

tryb Material Preview, 52 

tryb opcja X-Ray, 48, 49 

tryb Rendered, 52 

tryb Solid, 48, 50, 51, 119 
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tryb Wireframe, 49 

cięcie 

siatki, 144, 145 

Circle 

parametry polecenia, 466 

polecenie z menu Add, 466 

przykład użycia, 97 

Circle Select 

polecenie z menu Select, 59, 500 

Clamp 

tryb Slide Vertices, 538 

tryb Vertex Slide, 140 

Clear and Keep Transformation 

polecenie z menu Clear Parent, 480 

Clear Object Constraints 

polecenie z menu Constraints, 489 

Clear Parent 

menu, 480 

Clear Sharp 

polecenie z menu Edge, 541 

Clear Track 

usunięcie ograniczeń Track To, Locked Track, 489 

Clear Track and Keep Transform 

usunięcie ograniczeń Track To, Locked Track, 489 

Clip End 

pole panelu Lens z zakładki Object Data, 476 

Clip Start 

pole panelu Lens z zestawu Object Data, 475 

pole z zakładki przybornika 

View, 45 

Clipping 

parametr modyfikatora Mirror, 549 

Collection Instance 

polecenie z menu Add, 493 

Collections 

panel z zakładki Object, 451 

color button 

wybór barwy, 455 

Color Management 

opcja z panelu Render 

Shading, 457 

panel z zakładki Render, 456 

config 

folder konfiguracji Blendera, 435 

Connect Vertex Path 

polecenie z menu Vertex, 546 

Constant Offset 

odległości w modyfikatorze Array, 564 

constraint, Patrz ograniczenie  

Copy Settings 

opcja z menu New Scene, 453 

Copy to Selected 

polecenie z menu kontekstowego modyfikatora, 573 

Crease, Patrz ostra krawędź 

ostre krawędzie, przykład użycia, 164, 174, 175, 177 

ostrość krawędzi, 539 

w tworzeniu ostrych narożników, 645 

Ctrl, Patrz przesunięcie,skokowe 

Ctrl-1, Patrz Rear 

Ctrl-3, Patrz Right 

Ctrl-7, Patrz Bottom 

Ctrl-I, Patrz Invert 

Ctrl-J, Patrz Join 

Ctrl-P, Patrz Set Parent To 

Ctrl-R, Patrz Loop Cut and Slide 

Ctrl-S, Patrz Save 

Ctrl-Spacja, Patrz Maximize Area, Patrz Tile Area 

Cube 

polecenie z menu Add, 473 

CUDA 

włączanie w Blenderze, 434 

Cursor to Active 

polecenie z menu myszki Snap, 454 

Cursor To Active 

polecenie z menu myszki Snap, 507 

Cursor to Selected 

polecenie z menu myszki Snap, 454 

przykład użycia, 107 

Cursor to World Origin 

polecenie z menu myszki Snap, 454 

Curve 

modyfikator, 555, 558 

oś deformowana, 555 

skręcanie siatki za pomocą modyfikatora, 558 

typowe problemy, 555 

Curve Object 

parametr modyfikatora Curve, 555 

cut through 

opcja polecenia Knife, 533 

Cycles 

kluczowe paramery, 81 

liczba próbek, 82 

renderer, przykład, 81 

Cylinder 

polecenie z menu Add, 470 

D 

datablock 
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czyszczenie, 630 

licznik referencji (użycia), 628 

nie używane, 628 

usuwanie nieużywanych, 629 

w pliku Blendera, 626 

w wielu scenach, 631 

zabezpieczenie przed usunięciem, 628, 629 

zestaw kontrolek, 627, 630 

Deform Axis 

parametr modyfikatora Curve, 555 

deformacja 

wokół otworu w powierzchni podziałowej, 643 

Delete, Patrz Delete 

menu opcji usuwania, 542, 543, 544 

polecenie z menu kontekstowego kolekcji, 452 

polecenie z menu układu ekranu, 441 

Delete Hierarchy 

polecenie z menu kontekstowego kolekcji, 452 

Depth 

(Auto) przełącznik z sekcji Preferences 

Navigation, 430 

parametr polecenia Add Cylinder, 470 

pasek wyboru z panelu Object Data 

Empty, 463 

Display Device 

opcja z panelu Render 

Color Management, 456 

Dissolve Edges 

opcja z menu Delete, 544 

Dissolve Vertices 

opcja z menu Delete, 543 

przykład użycia, 142 

dodanie 

nowej kolekcji, 448 

dodatki (add-ons) 

instalacja, 436, 443 

usuwanie, 445 

dodawanie 

modyfikatora (siatki), 514, 521, 548, 552, 554, 555, 

560, 564, 565, 570 

nowego materiału, 575 

nowej sceny, 453 

nowych pozycji na liście, 458 

dokładność 

widoku z przodu, 160 

domyślne 

ustawienia modyfikatora Mirror, 548 

dopasowywanie 

modelu do konturu, 101 

dropdown 

kontrolka panelu, 76, 77 

Duplicate 

polecenie z menu kontekstowego modyfikatora, 572 

polecenie z menu Mesh, 534 

polecenie z menu układu ekranu, 441 

przykład użycia, 150 

Duplicate Area into New Window 

polecenie z submenu Area, 36 

Duplicate Linked 

polecenie z menu Object, 464 

przykład użycia, 123 

Duplicate Objects 

polecenie z menu Object, 464 

dwa monitory 

praca z, 36 

E 

E, Patrz Extrude Edges 

Edge Crease 

polecenie z menu Edges, 539 

edge loop 

linia wierzchołków, 511 

Edge Loops 

opcja z menu Delete, 542 

Edge select 

opcja w trybie edycji, 502, 536 

Edge Slide 

polecenie (z paska), 513 

polecenie z menu Edges, 513 

przykład użycia, 101 

edgeloop, Patrz linia,krawędzi 

linia wierzchołków, 513 

Edges 

opcja z menu Delete, 544 

Edit Mode 

dla krzywych, 490 

okna 3D, 497 

przełącznik modyfikatora Boolean, 553 

przełącznik modyfikatora Subdivision Surface, 142 

Editing 

sekcja okna Preferences, 429 

edycja 

tryb pracy, włączanie, 497 

edytor 

wybór typu, 31 

Eevee 

renderer, przykład, 81 

ekran 
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kopiowanie układu, 441 

układ okien, zarządzanie, 441 

usunięcie jednego z układów, 442 

zmiana nazwy układu (zakładki), 441 

ekran powitalny 

importowanie ustawień Blendera z poprzedniej wersji, 

23 

przy pierwszym uruchomieniu, 22 

wybór funkcji klawisza spacji, 22 

Empty 

jako pomocniczy obiekt nadrzędny, 171, 228 

obiekt (obraz referencyjny), 84 

obiekt Arrows representation type, 472 

obiekt, tworzenie, 472 

obiekty ‘puste’, 461 

obraz, przejrzystość, 85, 86 

panel z zakładki Properties 

Object Data, 463 

polecenie z menu Add, 472 

powiązanie z obrazem (referencyjnym), 85 

zamiana przypisanego obrazu, 91 

Emulate Numpad 

opcja z sekcji Input okna Preferences, 35 

przełącznik z sekcji Preferences 

Input, 430 

Esc, Patrz rezygnacja, z polecenia 

wyjście z trybu selekcji, 500 

Extrude 

narzędzie z przybornika, 504 

polecenie z menu Control Points, 490 

przykład użycia, 98 

Extrude Edges 

polecenie z submenu Extrude, 503 

Extrude Region 

polecenie z submenu Extrude, 503 

Extrude Vertices 

polecenie z submenu Extrude, 505 

F 

F, Patrz New Edge/Face from Vertices 

F12, Patrz Render Image 

Face select 

opcja w trybie edycji, 502 

Faces by Sides 

polecenie z menu Select All by Trait, 550, 551 

Fake user 

bloku danych, 628, 629 

fazowanie 

krawędzi, 560 

profil fazki, 562 

szerokość, 560 

szerokość fazki (problemy), 561 

ustalanie szerokości, 560 

zaznaczanie krawędzi do, 560 

File Paths 

sekcja okna Preferences, 440 

File View 

okno, 423, 439, 443 

pole tekstowe, 79 

Filter 

arkusz rozwijalny z nagłówka okna Outliner, 450 

filtr 

w sekcji Add-ons okna Preferences, 444 

Flip 

polecenie z submenu Normals, 569 

Flip to Bottom 

polecenie z menu Header, 32 

Flip to Top 

polecenie z menu Header, 32 

Focal Length 

pole panelu Lens z zakładki Object Data, 476 

pole z zakładki przybornika 

View, 45 

formo, 246 

formowanie 

dolnej powierzchni końcówki skrzydła, 151, 152 

kabina — oprofilowanie wiatrochronu, 356, 361 

kabina — osłona, 347, 366 

kabina — osłona rolek, 370 

kabina — otwór inspekcyjny przed wiatrochronem, 

361, 362, 363 

kabina — ramka wiatrochronu, 348, 349, 350, 351, 

353, 362, 363 

kabina — ramki osłony, 367, 368, 369 

kabina — szczyt wiatrochronu, 352 

kabina — szkło osłony, 369 

kabina — szprychy wiatrochronu, 353, 364 

kabina — szyna osłony, 370 

kabina — wiatrochron, 346, 347, 348, 360 

kabina — wyjście awaryjne, 371 

kadłub — bazy wymiarowe, 275, 287 

kadłub — burty (wzdłuż kokpitu), 279 

kadłub — chłodnice cieczy, 321 

kadłub — chwyt powietrza gaźnika, 296, 298, 299, 

300, 301, 302, 411 

kadłub — część środkowa, 360 

kadłub — grzbiet ogona, 279 

kadłub — kanał powietrza gaźnika, 297 
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kadłub — kanały do chłodnic, 321 

kadłub — kil, 323, 324, 331, 410 

kadłub — kil (segmenty), 325, 326, 327, 409, 410 

kadłub — kolekcje, 276 

kadłub — kontury chwytu powietrza, 297, 299 

kadłub — kontury wzorcowe, 276, 277, 278, 288, 289 

kadłub — krawędzie kokpitu, 280 

kadłub — mocowanie skrzydła, 282 

kadłub — ogon, 283, 284 

kadłub — osłona silnika, 287, 290, 291, 292 

kadłub — osłony luf km, 305, 307, 308 

kadłub — oszklenie za kabiną, 335, 336, 337, 338, 

339, 340, 341, 342, 343, 344, 402 

kadłub — otwór koła ogonowego, 285 

kadłub — panel wiatrochronu, 354, 355, 362 

kadłub — pokrywy koła ogonowego, 403, 404, 405, 

406, 407 

kadłub — ponad skrzydłem, 281 

kadłub — przycinanie chwytu powietrza, 301, 302 

kadłub — przycinanie powierzchni, 283, 285, 293, 294 

kadłub — sekcje dodatkowe, 282, 290 

kadłub — wlot chłodnic, 313, 314, 316, 317, 318, 319, 

320, 321 

kadłub — wylot chłodnic, 327, 329, 330, 332, 409, 

410 

kołpak śmigła, 97 

kontur końcówki skrzydła, 142, 143 

końcówki łopaty śmigła, 114, 115, 116 

linii prostej, 108 

lotka — hierarchia zespołu, 179 

lotka — krawędź natarcia, 174, 175, 176 

lotka — krawędź spływu, 177 

lotka — oś obrotu, 178 

łopaty śmigła, 106, 108, 109, 110, 112, 116, 117, 118, 

121 

oprofilowanie skrzydła — rysunki, 390, 391 

oprofilowanie usterzenia, 382, 383, 384, 385, 386, 

387, 407 

przekrój łopaty śmigła, 108 

skrzydła, 132 

skrzydło — dźwigar klapy, 213 

skrzydło — geometria otworu na koło, 221 

skrzydło — klapa, otwór na, 187 

skrzydło — klapa, rysunki referencyjne, 184, 203, 219 

skrzydło — klapa, zamykanie wycięcia na, 190 

skrzydło — kołnierz otworu na koło, 221, 222 

skrzydło — kontury oprofilowania, 391 

skrzydło — końcówka, 140, 156, 157, 159, 160, 161, 

163, 164, 165 

skrzydło — końcówka (koncepcja), 135 

skrzydło — krawędź natarcia, 134 

skrzydło — krawędź spływu, 133, 136 

skrzydło — kształt podstawowy, 136 

skrzydło — lotka, otwór dla, 169, 171 

skrzydło — lotka, rysunki referencyjne, 167, 168 

skrzydło — lotka, wydzielenie, 172 

skrzydło — oprofilowanie podstawy, 395, 396 

skrzydło — oprofilowanie podstawy (poprawki), 397 

skrzydło — osłona goleni podwozia, 374, 376, 377, 

378, 379, 405, 408 

skrzydło — otwór klapy, 208 

skrzydło — podłuznica klapy, 214 

skrzydło — podłużnice, 199 

skrzydło — podłużnice (w komorze podwozia), 225, 

226 

skrzydło — podłużnice, dopasowanie, 200 

skrzydło — powierzchnia klapy, 206, 207 

skrzydło — prawa strona, 230, 232 

skrzydło — profil końcówki, 137, 138 

skrzydło — profil podstawy, 132, 133, 134 

skrzydło — przekrój poprzeczny oprofilowania, 392 

skrzydło — przycięcie u podstawy, 229 

skrzydło — stożek oprofilowania, 392, 393, 394 

skrzydło — ściany komory podwozia, 223, 224 

skrzydło — tylna krawędź klapy, 209, 215, 216, 217 

skrzydło — wstawianie żeber, 141 

skrzydło — wycięcie na lotkę, 179, 180, 181 

skrzydło — zakończenie krawędzi spływu, 185, 186 

skrzydło — zawiasy klapy, 204, 205, 208 

skrzydło — żebra klapy, 210, 211, 212, 218 

skrzydło — żebra krawędzi spływu, 191, 193, 194, 

195, 196, 197, 198 

skrzydło — żebra krawędzi spływu, wymiary, 191 

staecznik poziomy, 235 

statecznik pionowy, 259 

statecznik pionowy — dźwigar, 260, 262 

statecznik pionowy — koncepcja topologii siatki, 260 

statecznik pionowy — kontur końcówki, 260 

statecznik pionowy — końcówka, 261 

statecznik pionowy — profil podstawy, 260 

statecznik pionowy — segment główny, 260 

statecznik pionowy — wycięcie, 261 

statecznik pionowy — żebra, 261 

statecznik poziomy — dźwigar, 241 

statecznik poziomy — koncepcja topologii siatki, 236 

statecznik poziomy — kontur końcówki, 236 

statecznik poziomy — końcówka, 237, 238 
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statecznik poziomy — odbicie lustrzane prawej strony, 

242 

statecznik poziomy — profil podstawy, 236 

statecznik poziomy — segment główny, 237 

statecznik poziomy — wycięcie, 239 

statecznik poziomy — żebra, 239, 240 

ster kierunku, 264 

ster kierunku — klapka trymera, 272 

ster kierunku — kontur dźwigara, 267 

ster kierunku — końcówka, 270 

ster kierunku — krawędź spływu, 268 

ster kierunku — krzywe konturów, 267 

ster kierunku — oprofilowanie, 268 

ster kierunku — profil bazowy, 267 

ster kierunku — przeciwwaga, 270 

ster kierunku — segment główny, 269 

ster kierunku — wycięcia, 271 

ster kierunku — żebra, 272 

ster wysokości, 243 

ster wysokości — klapka trymera, 255, 256 

ster wysokości — kontur dźwigara, 246 

ster wysokości — końcówka, 248, 249 

ster wysokości — krawędź natarcia, 252 

ster wysokości — krzywe konturów, 246 

ster wysokości — odbicie lustrzane prawej strony, 257 

ster wysokości — oprofilowanie, 249, 250, 252 

ster wysokości — przeciwwaga, 253, 254 

ster wysokości — segment główny, 247 

ster wysokości — topologia siatki (koncepcja), 246 

topologia końcówki skrzydła, 143 

wykorzystanie otworów tymczasowych, 149 

zamykanie otworów tymczasowych, 153, 154 

zaokrąglonych krawędzi końcówki skrzydła, 149, 150, 

151, 152, 153 

Front 

polecenie z menu View, 43 

Full Copy 

opcja z menu New Scene, 453 

G 

G, Patrz Grab/Move 

gamma 

korekcja wyświetlanych kolorów, 456 

geometria 

łopaty śmigła, 104, 105, 125, 126, 128 

trapezu skrzydła, 131 

Geometry Nodes 

modyfikatory, 570 

gizmo, Patrz ornamenty 

głębokość 

widoku, 45 

Grab/Move 

polecenie z submenu Transform, 62 

H 

H, Patrz Hide Selected 

odcień koloru, 455 

Header 

menu kontekstowe, 32, 33 

Hex 

tryb wyboru koloru, 456 

Hide Selected 

polecenie z submenu Show/Hide, 525 

hierarchia 

’parent/child’ a kolekcje, 481 

identyfikacja obiektu nadrzędnego, 480, 631 

obiektów modelu, 481 

sceny, tworzenie, 124 

ustalanie dla obiektów, 479 

wyłączanie obiektu z, 480 

Horizontal Split, Patrz nowe:okno (Blender) 

HSV 

tryb wyboru koloru, 455 

HTML notation 

heksadecymalna reprezentacja barwy, 456 

I 

ignore snap 

opcja polecenia Knife, 533 

Image 

panel z zakładki Properties 

Object Data, 462 

polecenie z submenu Empty, 462 

submenu z menu Add, 461 

import 

bilblioteki dynamicznych wzorców, 438 

tryb ‘referencji’ (Link), 438 

wybór elementów z pliku Blendera, 438 

z pliku Blendera, 437 

Individual Centers 

wybór z listy Pivot, 68 

Individual Origins 

tryb Transformation Pivot, 125 

Input 

sekcja okna Preferences, 430 

inspekcyjny otwór 

wiatrochronu, 361, 362 

instalacja 
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dodatków, 436, 443 

Install 

przycisk z sekcji Add-ons okna Preferences, 443 

Install Add-on 

przycisk okna File View, 443 

Instance Offset 

pola z panelu Collection 

Instancing, 493 

instancja 

tworzenie, 493 

Interface 

sekcja okna Preferences, 429 

Intersect 

Boolean 

parametry polecenia, 527 

polecenie z menu Face, 527 

przełączanie odciętych części, 527 

przykład użycia, 145 

Knife 

polecenie z menu Face, 528 

przykład użycia, 173 

Intersection, Patrz przecięcie, powłok 

add-on, 482 

add-on, włączanie, 482 

okno dialogowe, 483 

opcje, 531 

Use both meshes 

opcja polecenia, 483 

Use diagonals 

opcja polecenia, 484 

Use selected faces 

opcja polecenia, 483 

zasada działania, 484 

Invert 

polecenie z menu Select, 499 

J 

J, Patrz Connect Vertex Path 

Join 

polecenie z menu Object, 485 

Join Areas, Patrz scalanie:okna 

K 

kabina 

geometria, 346, 366, 399, 400, 401 

kolekcje, 357 

osłona, 347 

osłona rolek, 370 

osłona,różnice między P-36 i P-40, 366 

ramka wiatrochronu, 348, 349, 350, 351, 353, 362, 363 

ramki osłony, 367, 368, 369 

szczyt wiatrochronu, 352 

szkło osłony, 369 

szprychy wiatrochronu, 353, 364 

szyna osłony, 370 

wiatrochron, 347, 348, 360 

wiatrochron,różnice między P-36 i P-40, 359, 361 

wyjście awaryjne, 371 

kadłub 

bazy wymiarowe, 275, 287 

chłodnice cieczy, formowanie, 321 

chwyt powietrza gaźnika, 296, 298, 299, 300, 301, 

302, 411 

dodatkowe sekcje, 282, 290 

formowanie burt, 279 

formowanie części środkowej, 360 

formowanie konturów, 276, 277, 278, 288, 289 

formowanie oprofilowania skrzydła, 390 

formowanie osłon luf km, 305, 307, 308 

formowanie osłony silnika, 290, 291, 292 

kanał powietrza gaźnika, 297 

kanały chłodnic, formowanie, 321 

kil, geometria, 323, 324 

kil, segment 0, 325, 409, 410 

kil, segment 1, 325, 327, 410 

kil, segment 2, 326, 410 

kil, segment 3, 326, 410 

kil, wyrzutnik łusek, 331, 410 

kolekcje, 276 

kontury chwytu powietrza, 297, 299 

kontury wlotu chłodnic, 313, 314 

kontury wręg, 276, 360 

krawędzie (nowe, wstawianie), 284 

krawędzie kokpitu, 280 

mocowanie do skrzydła, 282 

oprofilowanie podstawy skrzydła, 391, 392, 393, 394, 

395, 396, 397 

otwór koła ogonowego, 285 

panel wiatrochronu, 354, 355, 362 

pokrywy koła ogonowego, 403, 404, 405, 406, 407 

ponad skrzydłem, 281 

przycinanie chwytu powietrza, 301, 302 

przycinanie powierzchni, 283, 285, 293, 294 

rysunki osłony silnika, 287 

sprawdzanie kształtu osłon luf km, 306 

stacje osłony silnika, 287 

stacje wręg, 275 

tworzenie powierzchni, 279 
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wlot chłodnicy, część przednia, 315, 316, 317 

wlot chłodnicy, krawędź natarcia, 318, 319, 320 

wlot chłodnicy, przycinanie, 321 

wyciąganie powierzchni, 283, 284 

wylot chłodnic, blister, 328, 329, 332, 409, 410 

wylot chłodnic, klapy, 329, 330, 409 

wylot chłodnic, wręga, 327 

kamera 

aktywna, 474 

ogniskowa, 476 

podgląd projekcji w oknie 3D, 475 

rozmiar obiektu, 476 

stworzenie nowej (obiektu), 474 

widok z, 56 

zasięg, 475, 476 

katalog 

z konfiguracją Blendera, 435 

kątomierz 

narzędzie pomiarowe, 446 

usuwanie ze sceny, 447 

Keep Corners 

opcja modyfikatora Subdivision Surface, 644 

Keymap 

definiowanie nowych skrótów, 431, 432 

znajdowanie skrótów, 431 

klawiatura 

kiedy stosować skróty, 33 

laptopa, 430 

numeryczna, 430 

klonowanie 

obiektu, 123, 464 

Knife 

opcja angle constrain, 533 

opcja cut through, 533 

opcja ignore snap, 533 

opcja midpoint snap, 533 

opcje działania, 533 

polecenie z paska narzędzi, 532 

tryb ‘cut through’, 533 

kolejność 

elementów listy, 459 

paneli, zmiana, 73 

kolekcja 

nazewnictwo, konwencje, 90 

środek, 493 

kolekcje 

a hierarchia ‘parent/child’ obiektów, 481 

identyfikacja powiązanych z obiektem, 451 

powiązane z obiektem, 451 

przenoszenie obiektów, 449 

przenoszenie powiązanych obiektów, 481 

ukrywanie zawartości w oknie 3D, 449 

usuwanie, 452 

wstawienie nowej, 448 

zarządzanie, 448 

zespołu kokpitu, 357 

zespołu skrzydła, 230, 231, 232 

zmiana nazw, 448 

zmiana położenia (w hierarchii), 449 

kolor 

heksadecymalne wartości R,G,B, 456 

inetnsywność (V), 455 

kontrolka w Blenderze, 455 

korekcja gamma, 456 

nasycenie (S), 455 

odcień (H), 455 

opcja Color Management, 457 

opcja sRGB, 456 

ustalanie wartości HSV, 455 

ustalanie wartości RGB, 455 

wybór ‘poprzez przykład’, 455 

kołpak śmigła 

formowanie, 97 

konfiguracja 

Blendera, 35 

kontrolka 

na nazwę obiektu, 552 

kontrolki 

lista, 76 

lista rozwijalna, 76, 77 

pasek wyboru, 76 

pole wyboru, 76 

końcówka 

skrzydła, formowanie, 140, 156, 157, 159, 160, 161, 

163, 164, 165 

kopie bezpieczeństwa 

interwał tworzenia, 440 

ustawienia, 440 

kopiowanie 

obiektów, 91 

obiektu, 464 

kółko ogonowe 

otwór dla, 285 

pokrywy, 403, 404, 405, 406, 407 

krawędziowe 

punkty, krzywych podziałowych, 633 

punkty, powierzchni podziałowych, 640 

krawędź 
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barwa zaznaczonej, 498 

cieniowanie dla ostrej, 541 

częściowo ostra, 646 

fazowanie, 560 

linia (wielu krawędzi na siatce), 496 

opcje cieniowania, 541 

ostra (powierzchni podziałowej), 164, 643, 644 

oznaczanie ostrych (Crease), 174, 175, 177 

podział, 535 

powierzchni podziałowych, 643 

profil zaokraglenia, 562 

przecięcia, 527, 531 

przecięcia dwóch siatek, 482, 484 

przerywanie w wierzchołku, 520 

regulacja ostrości, 539 

różnicowanie promieni zaokrągleń, 562 

siatki, wyjaśnienie pojęcia, 496 

spłaszczanie, 507 

sterowanie współczynnikiem Crease, 540 

stworzenie, 545, 546 

szerokość fazki, 560 

usuwanie, 544 

usuwanie linii wierzchołków, 542 

wyciąganie, 490, 503 

zaokraglanie, 561 

zaokrąglanie wybranych, 562 

zmienne wagi fazowania (Bevel Weight), 378 

krawędź natarcia 

formowanie, 134 

krawędź spływu 

formowanie, 133, 136 

końcówki skrzydła, 160, 162, 163, 165 

lotki, 176 

krzywa 

kierunek i skręcenie, 555, 558 

odwracanie kierunku, 556 

skręcenie węzłów, 555, 558 

tryb edycji, 490 

tworzenie, 490 

waga węzła, 491 

wielobok sterujący, 490 

współrzędne węzła, 491 

krzywa ostateczna 

linii podziałowej, 632, 638 

krzywe podziałowe 

a NURBS, 634 

formowanie linii prostej, 108 

krzywa ostateczna, 632 

krzywa otwarta, 638 

odwzorowanie okręgu, 636 

punkty krawędziowe, 633 

punkty sterujace, 632 

punkty wierzchołkowe, 633 

segmenty, 634, 635 

wielobok oryginalny, 632 

wielobok sterujacy, 632 

właściwości, 635 

wprowadzenie, 632 

wyrażenia algebraiczne, 634 

zakres wpływu punktu sterującego, 635 

kursor 

3D, 454 

kursor 3D 

jako środek obrotu, 67 

polecenia w menu myszki Snap, 67 

polecenia z menu Snap, 454 

położenie (ustalanie), 67 

ustalanie położenia, 454 

w oknie 3D, 454 

współrzędne, 454 

współrzędne (ustalanie), 68, 86 

wyjaśneinie pojęcia, 67 

kwadrat 

utworzenie, 469 

L 

laptop 

klawiatura, 430 

Lasso Select 

polecenie z menu Select, 59 

Layout 

układ ekranu, 34 

Left 

polecenie z menu View, 43 

Lens 

panel z kontekstu Object Data, 475 

Lens Distortion 

polcenie z menu Distorts (GIMP), 652 

Levels 

Render 

modifier parameter, 514 

parametr modyfikatora, 467 

Viewport 

modifier parameter, 514 

parametr modyfikatora, 467 

licznik referencji 

do bloku danych Blendera, 628 

linia 
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krawędzi, 496 

wierzchołków, 499 

linia wierzchołków 

prostowanie, 523 

linie podziałowe, Patrz krzywe podziałowe 

linijka 

narzędzie pomiarowe, 446 

usuwanie ze sceny, 447 

Link 

polecenie z menu File, 438 

Linked Copy 

opcja z menu New Scene, 453 

lista 

dodawanie nowych pozycji, 458 

kontrolka panelu, 76 

kontrolka w Blenderze, 458 

menu kontekstowe elementów, 459 

wyszukiwanie (filtr), 459 

z okna Properties 

dodawanie nowych pozycji, 458 

menu kontekstowe, 459 

szczegóły obsługi, 458 

wyszukiwanie (filtr), 459 

zmiana uporządkowania, 459 

zmiana uporządkowania elementu, 459 

Load factory Settings 

polecenie z submenu Defaults, 37 

Load Settings 

przycisk na ekranie powitalnym, 23 

Loop Cut 

narzędzie (z paska), 511, 512 

przykład użycia, 100 

Loop Cut and Slide 

polecenie z menu Edge, 511 

Loose Geometry 

polecenie z menu Select, 529 

polecenie z menu Select All by Trait, 550 

lotka 

hierarchia zespołu, 179 

krawędź natarcia, 174, 175, 176 

krawędź spływu, 160, 162, 163, 165, 177 

promień krawędzi spływu, 176 

wycinanie wręg, 173 

zawiasy (obiekt), 178 

lustrzane odbicie 

alternatywny środek i osie symetrii, 548 

osie symmetri, 548, 549 

scalanie bliskich wierzchołków, 548 

ustawienia domyślne, 548 

Ł 

Ła-5 

przykładowy model, 39 

łopata śmigła 

formowanie części środkowej, 112 

formowanie końcówki, 114, 115, 116 

formowanie krawędzi spływu, 108, 109, 110, 112 

geometria, 125, 126, 128 

ostatnie poprawki, 116, 117, 118 

pomocnicze rysunki, 104 

skok, 125, 126, 128 

skręcanie, 121, 122 

typowy przekrój, 108 

wytłaczanie podstawowego kształtu, 106, 107 

M 

M, Patrz Merge 

Make Edge/Face 

polecenie z menu Mesh, 546 

Make Track 

menu podręczne, 488 

Mark Sharp 

polecenie z menu Edge, 541 

MatCap 

opcja z arkusza Viewport Shading, 51, 119 

Material Preview 

tryb cieniowania w oknie 3D, 52 

materiał 

kolor w cieniowaniu Solid, 576 

przypisanie do obiektu, 429 

utworzenie nowego, 575 

uzycie w edycji siatki, 186 

wybór istniejącego, 576 

zmiana nazwy, 575 

Maximize Area 

polecenie z menu Header, 33, 40 

Mean Crease 

pole z sekcji Edges Data (przybornika), 540 

Mean Tilt 

pole z panelu Transform przybornika, 556 

Measure 

narzędzie z paska narzędzi, 88, 446, 447 

menu 

kontekstowe 

elementów listy, 459 

Merge 

At Center 

polecenie z submenu Merge, 518 

przykład użycia, 100 
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By Distance 

polecenie z submenu Merge, 519 

parametr modyfikatora Mirror, 548 

podręczne menu scalania wierzchołków siatki, 518 

Mesh 

w Blenderze, 626 

midpoint snap 

opcja polecenia Knife, 533 

mierzenie 

odległości w Blenderze, 86, 88 

Mirror 

modyfikator, 548 

Mirror Object 

parametr modyfikatora Mirror, 548 

model 

Ła-5 (przykład), 39 

Modifiers 

sekcja okna Properties, 514 

zakładka okna Properties, 467, 521, 548, 552, 554, 

555, 560, 564, 565, 570 

modyfikator 

Array, 564 

Bevel, 560 

Boolean, 552 

Curve, 555, 558 

dodadnie, 514, 521, 548, 552, 554, 555, 560, 564, 565, 

570 

Geometry Nodes, 570 

kopiowanie do innych obiektów, 573 

Mirror, 548 

powielenie na liście, 572 

Shrinkwrap, 565 

Simple Deform, 554 

Solidify, 521 

Subdivision Surface, 467, 514 

Surface Offset, 570 

tworzenie, 467, 514, 521, 548, 552, 554, 555, 560, 

564, 565, 570 

tworzenie własnych, 570 

usuwanie, 515 

utrwalenie, 572 

włączenie w Edit Mode, 101 

Move 

narzędzie z paska, 65 

polecenie z submenu Transform, 490, 508 

przykład użycia, 107 

Move to Collection 

polecenie z submenu Collection, 449 

N 

N, Patrz Sidebar 

NACA 

profile lotnicze, 131 

NACA-2209 

różnice współrzędnych wg Curtiss, 138 

NACA-2215 

różnice współrzędnych wg Curtiss, 138 

nacięcie 

nowej krawędzi siatki, 532 

nagłówek 

okna, 30, 54 

okna 3D,w trybie edycji siatki, 497 

okna, przełączanie, 32 

panelu, 72, 73 

przesuwanie w prawo i lewo, 54 

nakładki 

okna 3D, 53 

narożnik 

powierzchni podziałowej, 644 

narożniki 

okna, 29 

nazwa 

kolekcji, 90, 448 

obiektu, 90, 357 

obiektu, przykład nadania, 102, 103 

siatki, przykład nadania, 102, 103 

system określania, 477 

zmiana dla materiału, 575 

zmiana dla sceny, 453 

Nearest Surface Point 

metoda projekcji siatki (modyfikator Shrinkwrap), 565 

Negative 

opcja w panelu modyfikatora Shrinkwrap, 566 

New 

opcja z menu New Scene, 453 

polecenie z menu File, 428, 435 

przycisk z zakładki Material, 575 

New Edge/Face 

polecenie z menu Mesh, 545 

New Edge/Face from Vertices 

polecenie z menu Vertex, 545 

New Scene 

opcje tworzenia nowej sceny, 453 

n-gon 

ściany, znajdowanie w siatce, 551 

nie używane 

bloki danych, 628 

None 
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polecenie z menu Select, 499 

normalne 

do ściany siatki, 568 

odwracanie (zwrotu), 569 

rozmiar wyświetlanych, 568 

skopiowanych ścian, 150, 154 

ujednolicanie kierunku, 515 

wizualizacja kierunku, 568 

wpływ na cieniowanie siatki, 541 

wyświetlanie, 555 

Normals 

sekcja z panelu Viewport Overlays, 568 

Size 

kontrolka z panelu Viewport Overlays, 568 

nowe 

okno (Blender), 29 

numeric field 

pole numeryczne, 77, 78 

numeryczna 

klawiatura (emulacja), 430 

NURBS 

a krzywe podziałowe, 634 

a powierzchnie podziałowe, 641 

krzywa 

zakres wpływu węzła, 491 

O 

obiekt, Patrz Object 

aktywny, 57 

aktywny,współrzędne (ustalanie), 68 

Empty (Image), 84 

Empty, tworzenie, 461 

hierarchia, 124 

hierarchia ‘parent/child’ a kolekcje, 481 

hierarchia modelu, 481 

identyfikacja obiektu nadrzędnego, 480, 631 

identyfikacja powiązanych kolekcji, 451 

interaktywna zmiana parametrów, 466, 470 

klonowanie, 123, 464 

kolor w oknie 3D, 576 

kopiowanie, 91, 464 

kopiowanie modyfikatorów (pomiędzy obiektami), 

573 

nazewnictwo, 357 

nazewnictwo, konwencje, 90 

nie do zaznaczenia, 450 

obrót lokalnego układu współrzędnych, 173 

obrys w trybie cieniowania Solid, 181 

ograniczenia (constraints), 488 

połączony, 123 

powiązany, 464 

powielenie modyfikatora, 572 

przełączanie widoczności, 450 

przenoszenie pomiędzy kolekcjami, 481 

przypisanie (istniejącego) materiału, 576 

pusty (Empty), 472 

scalanie siatek, 485 

ukrywanie w oknie 3D, 450 

utrwalanie modyfikatorów, 572 

utworzenie (okręgu), 466 

utworzenie (przez podział), 547 

utworzenie (walca), 470 

utworzenie w aktualnym widoku, 429 

użycie materiałów, 186 

w wielu kolekcjach, 451 

włączenie w wiele scen, 631 

wskazywanie do pola GUI, 552 

wycinanie części, 552 

wykluczenie z renderowania, 450 

zmiana hierarchii, 479, 480 

zmiana kolekcji, 449 

zmiana położenia środka, 487 

obiekt, aktywny 

kąty obrotu, 68 

współczynniki skali, 68 

współrzędne położenia, 68 

Object 

(Link Materials To) opcja z sekcji Preferences 

Editing, 429 

pole modyfikatora Boolean, 552 

w Blenderze, 626 

Object (Keep Transform) 

polecenie z menu Set Parent To, 479 

Object Constraints 

zakładka z okna Properties, 488 

obracanie 

widoku w oknie 3D, 42 

obraz 

(rastrowy), wstawianie, 461 

położenie na scene, 85 

przejrzystość (w obiektach Empty), 85, 86 

referencyjny, kopiowanie, 91 

referencyjny, ustawianie w Blenderze, 84 

relatywna ścieżka do, 85 

tworzenie (jako obiekt Empty), 84 

zamiana w obiektach Empty, 91 

obrót 

obiektu, 66 
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opcje obserwatora w oknie 3D Viewport, 430 

środek, 67 

w trakcie polecenia Extrude, 510 

wierzchołków (siatki), 510 

wokół pojedynczej osi, 66 

wokół selekcji, 430 

wokół wybranej osi obiektu, 510 

z użyciem ornamentu, 66 

obrys 

obiektu w trybie cieniowania Solid, 181 

odcinanie 

części siatki (Boolean), 527 

odsłanianie 

ukrytych części siatki, 525 

odzyskanie 

danych (bo błędzie programu), 439 

pliku Blendera po awarii programu, 425 

Offset 

parametr modyfikatora Solidify, 521, 522 

parametr modyfikatora Surface Offset, 570 

pole w panelu modyfikatora Shrinkwrap, 567 

Offset X 

kontrolka z panelu Object Data 

Empty, 462 

Offset Y 

kontrolka z panelu Object Data 

Empty, 462 

ogniskowa 

kamery, 476 

widoku, 45 

ograniczenie 

(obiektu), właściwości, 488 

Track To, 488 

usunięcie, 489 

okno 

aktywne, 28 

nagłówek, 30, 54 

nagłówek, przełączanie, 32 

narożniki, 29 

nowe (Blender), 29 

osi czasu, 27 

otworzenie dodatkowego ekranu Blendera, 36 

pasek narzędzi, 30 

podstawowe elementy, 30 

powiększanie, 40 

praca z dwoma monitorami, 36 

przesuwanie granic, 27 

przybornik (sidebar), 30, 31 

scalanie, 28, 29 

struktury sceny, 27 

typ, 31 

ustawień Blendera, 428, 443 

widoku, 27 

właściwości, 27, 72 

zapisanie, 427 

zmniejszanie, 40 

Okno 3D 

cieniowanie jednym kolorem, 50 

cieniowanie Material Preview, 52 

cieniowanie Rendered, 52 

cieniowanie Solid, 48, 50, 51, 119 

cieniowanie testowym materiałem, 51, 119 

cieniowanie Wireframe, 49 

cieniowanie z opcją X-Ray, 48, 49 

Edit Mode, 497 

materiały MatCap, 51, 119 

nakładki, 53 

opcje cieniowania, 50, 181 

oramenty (kontrolki), 40, 53 

oświetlenia typu Studio, 50 

okrąg 

interaktywna zmiana parametrów, 466 

odwzorowanie w krzywych podziałowych, 636 

parametry domyślne, 466 

utworzenie, 466 

On Cage 

opcja modyfikatora, 101, 642 

Online Manual 

polecenie z menu kontekstowego formantu, 32 

Opacity 

kontrolka z panelu Object Data 

Empty, 462 

kontrolka z panelu ObjectData 

Empty, 85, 86 

Open 

polecenie z menu File, 423 

przycisk z okna File View, 424 

Open Recent 

polecenie z menu File, 425 

oprofilowanie 

podstawy skrzydła, 390 

wiatrochronu, 356, 361 

OptiX 

włączanie w Blenderze, 434 

Orbit Around Selection 

przełącznik z sekcji Preferences 

Navigation, 430 

orientacja 
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projekcji ortograficznej, 96 

origin 

punkt odniesienia (środek) obiektu, 67 

Origin to 3D Cursor 

polecenie z menu Object, 487 

ornament 

do wytłaczania, 504 

obrotu, 66 

okna 3D, 40, 53 

przesunięcia, 65 

skalowania, 70 

Orphan Data 

tryb wyświetlania zawartości okna Outliner, 630 

ortograficzna 

projekcja, orientacja, 96 

osi czasu 

okno, 27 

osie 

symetrii modyfikatora Mirror, 548, 549 

osłona 

kabiny, geometria, 366, 401 

kabiny, różnice między P-36 i P-40, 366 

ostateczna 

krzywa,linii podziałowych, 632 

powierzchnia,powłok podziałowych, 638 

ostra 

krawędź (powłoki podziałowej), 643, 644 

ostra krawędź 

częściowo gładka, 646 

wpływ na powierzchnię podziałową, 645 

ostre 

cieniowanie krawędzi, 541 

krawędzie powierzchni podziałowych, 539 

krawędzie w powierzchni podziałowej, 174, 175, 177 

krawędzie, sprawdzanie, 540 

ostrość 

krawędzi powierzchni podziałowej, 164 

oszklenie 

za kabiną, formowanie szyby, 339, 340 

za kabiną, geometria, 335, 399, 400, 401, 402 

za kabiną, ramka szyby, 340, 341, 342, 343, 344 

za kabiną, wgłębienie kadłuba, 336, 337, 338 

oś 

obrotu, 510 

obrót wokół wybranej, 510 

przesuwanie wzdłuż wybranej, 508 

skalowania, 506 

otwarcie 

pliku Blendera, 423, 425 

otwarta 

krzywa podziałowa, 638 

otwarte 

powierzchnie podziałowe, 643 

otwory 

tymczasowe, w edycji siatki, 149 

zamykanie w siatce, 153, 154 

otwór 

deformacje krawędzi powierzchni podziałowych, 643 

Outliner 

okno, 27 

użycie kolekcji, 231, 232 

overlays, Patrz nakładki (okna 3D) 

P 

P, Patrz Separate 

Pan, Patrz przesuwanie,widoku 

panel 

nagłówek, 72, 73 

przesuwanie, 73 

w oknie Properties, 72 

zakładki w oknie Properties, 74 

zawartość, 76 

Parent 

submenu z menu Object, 479 

pasek 

wyboru (kontrolka), 76 

pasek narzędzi 

okna, 30 

Path 

polecenie z submenu Curve, 490 

Perspective 

(Auto) przełącznik z sekcji Preferences 

Navigation, 430 

polecenie z menu View, 44 

perspektywiczna 

projekcja, właściwości, 649, 650 

perspektywiczny 

widok, 44 

Pivot 

lista w oknie 3D, 506, 510 

Plane 

polecenie z menu Add, 469 

plik 

Blendera, struktura, 437 

lista ostatnich, 425 

odzyskiwanie po awarii programu, 425 

taktyka zapisywania, 426 

plik Blendera 
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struktura, 627 

plik startowy 

Blendera, 428, 435 

plik ustawień 

Blendera, 36, 428, 435 

płaszczyzna 

przesuwanie po wybranej, 508 

podłużnice 

dopasowanie do poszycia, 200 

tworzenie, 199 

poduszkowe 

zniekształcenie zdjęcia, 650 

podwozie 

komora podwozia głównego, 221, 222, 223, 224, 225, 

226 

odchylane pokrywy goleni, 379, 405, 408 

osłona goleni, 374, 376, 377, 378 

rysunki osłony goleni, 375 

podziałowe 

krzywe, 632 

linie, Patrz krzywe podziałowe 

podziałowy 

schemat, implementacja w Blenderze, 638 

pola 

interfejs użytkownika, 76 

pole 

numeryczne, 77, 78 

tekstowe, 79 

ze ścieżką do pliku, 79 

polecenie 

obrót obiektu, 66 

przesunięcie obiektu, 62 

rezygnacja z, 62 

skalowanie obiektu, 70 

połączony 

obiekt, 123 

pomiar 

kątów, 446 

obiektów na scenie, 446 

odległości, 446 

użycie ‘kątomierza’, 446 

użycie ‘linijki’, 446 

widoczność, 447 

powiązanie 

obiektu z wieloma kolekcjami, 451 

powiązany 

obiekt, 464 

powierzchnia 

odcinanie, 527 

poziom podziału, 467, 514 

rzutowanie siatki na, 565 

wycięcia w, 552 

powierzchnia ostateczna 

powłok podziałowych, 638 

powierzchnie 

krawędź przecięcia — wyznaczanie, 482, 484 

powierzchnie podziałowe 

a NURBS, 641 

deformacja wokół otworu, 643 

edycja, 101 

krawędzie, 643 

krawędzie częściowo ostre, 646 

narożniki zewnętrzne, 644 

odwzorowanie sfery, 642 

ostre krawędzie, 643, 644 

otwarte, 643 

otwory prostokątne, 645 

powierzchnia ostateczna, 638 

projekcja na płaszczyznę, 158 

przybliżenie sfery, 642 

punkty krawędziowe, 640 

punkty sterujace, 638 

punkty środkowe, 639 

punkty wierzchołkowe, 640 

segmenty, 642 

stałość rzutu na płaszczyznę, 647 

ściany trójkatne, 518 

wpływ ostrej krawędzi, 645 

wprowadzenie, 638 

wyszukiwanie nieregularności, 162 

zakres wpływu, 642 

powiększanie 

okna, 33, 40 

w oknie 3D, 41, 45 

efekt ‘niewidzialnej ściany’, 45, 46 

widoku 

blokada w widoku perspektywicznym, 45, 46 

powiększenie 

zmiana w widoku perspektywicznym, 430 

poziom 

powierzchni podziałowej Catmull-Clarka, 467, 514 

Preferences 

okno, 35, 428, 443 

panel z sekcji Preferences 

Keymap, 431 

polecenie z menu Edit, 35 

sekcja Editing, 429 

sekcja File Paths, 440 
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sekcja Input, 35, 430 

sekcja Interface, 35, 36, 429 

sekcja Save & Load, 440 

sekcja System, 434 

profil 

modyfikacje współrzędnych, 138 

skrzydła, 131 

Project 

metoda projekcji siatki (modyfikator Shrinkwrap), 566 

projekcja 

atrefakty w perspektywie (okno 3D), 475, 476 

ortograficzna, 96 

perspektywiczna, 430, 649, 650 

powierzchni podziałowej na płaszczyznę, 158 

przełączenie na widok z kamery, 475 

Properties 

kontrolka listy, 458 

okno, 27, 72 

zakładki (grupy paneli), 74, 75 

prostowanie 

linii wierzchołków, 523, 524 

przecięcia 

krawędź, 527, 531 

krawędź, znajdowanie, 528 

przecięcie 

powłok 

podział ścian, 484 

wyznaczanie krawędzi, 482 

przecinanie 

siatki, 173 

ścian siatki (Boolean), 531 

znajdowanie krawędzi przecięcia, 173 

przełącznik 

Exclude from render, 450 

Hide, 450 

Selectable, 450 

przenoszenie 

kolekcji w hierarchii sceny, 449 

przerywanie 

krawędzi w wierzchołku, 520 

przesuniecie 

wzdłuż osi, 64 

przesunięcie 

dokładne, 65 

granic okien, 27 

kursora 3D, 67 

linii wierzchołków, 513 

na wskazanej płaszczyźnie, 508 

nagłówka okn, 54 

obiektu, 62 

po wybranej płaszczyźnie, 65 

skokowe, 64 

w oknie 3D, 41 

wierzchołka wzdłuż krawędzi, 537 

wierzchołków (siatki), 508 

wierzchołków wzdłuż indywidualnych krawwędzi, 

538 

wykluczanie pojedynczej osi, 65 

wzdłuż wybranej osi obiektu, 508 

z użyciem ornamentu, 65 

przybornik 

okna, 30 

wyciąganie (narzędzie), 504 

przycisk 

wyboru koloru, 455 

punkt sterujący 

krzywej podziałowej 

zakres wpływu, 635 

NURBS 

zakres wpływu, 491 

punkty kontrolne, Patrz punkty sterujące 

punkty krawędziowe 

krzywych podziałowych, 633 

powierzchni podziałowych, 640 

punkty sterujące 

krzywych podziałowych, 632 

powierzchni podziałowych, 638 

przesunięcie, 490 

skalowanie, 490 

wyciąganie (Extrude), 490 

zakres wpływu, 642 

punkty środkowe 

powierzchni podziałowych, 639 

punkty wierzchołkowe 

krzywych podziałowych, 633 

powierzchni podziałowych, 640 

purge 

usuwanie niepotrzebnych danych z pliku, 630 

Purge 

przycisk z okna Outliner, 630 

usuwanie niepotrzebnych danych z pliku, 628 

Python Tooltips 

opcja z sekcji Interface okna Preferences, 36 

Q 

Quit 

polecenie z menu File, 37 
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R 

R, Patrz Rotate 

radial buttons 

kontrolka panelu, 76 

Radius 

parametr polecenia Add Cylinder, 470 

parametr polecenia Add Empty, 472 

Rear 

polecenie z menu View, 43 

Recalulate Outside 

polecenie z menu Normals, 515 

Recover Auto Save 

polecenie z menu File, 425 

Reference 

polecenie z submenu Image, 461 

referencyjny 

obraz, położenie, 85 

obraz, przejrzystość, 85, 86 

obraz, skala, 86 

obraz, ustawianie w Blenderze, 84 

Relations 

panel z zakładki Properties 

Object, 480, 631 

Relative Offset 

współczynniki modyfikatora Array, 564 

Relative Paths, Patrz ścieżka, względna 

Remove 

przycisk z panelu dodatku (Add-on), 445 

render 

pasek postępu, 82 

przerywanie procesu, 82 

wybór renderera, 81 

zapisywanie rezultatu, 81 

Render Image 

polecenie menu Render, 80 

Rendered 

tryb cieniowania w oknie 3D, 52 

renderowanie 

modelu Ła-5, 80 

ostatecznego obrazu, 25 

wykluczanie obiektów i kolekcji, 450 

zapisanie rezultatu, 427 

Reset to Default Value 

polecenie z menu kontekstowego formantu, 32 

retopologia 

przykład, 145, 146, 147 

Reveal Hidden 

polecenie z submenu Show/Hide, 525 

rezygnacja 

z polecenia, 28, 62, 506, 508, 510 

RGB 

tryb wyboru koloru, 455 

Right 

polecenie z menu View, 43 

Rip Vertices 

polecenie z menu Vertex, 520 

Rotate 

narzędzie z paska, 66 

polecenie z submenu Transform, 66, 510 

rozmiar 

kamery (obiektu), 476 

rozszerzanie 

siatki, 140, 538 

rozwijalna 

lista, 76, 77 

rysunek 

oprofilowania skrzydła, 390, 391, 395 

oprofilowania steru kierunku, 267 

oprofilowania steru wysokości, 245 

osłona goleni podwozia, 375 

osłony silnika, 287 

profile statecznika pionowego, 259 

profile statecznika poziomego, 235 

referencyjny, ustawianie w Blenderze, 84 

ster kierunku (z boku), 264 

steru wysokości, 245 

rysunki referencyjne 

lotki, 167, 168 

łopaty śmigła, 104, 105 

rzut na płaszczyznę 

powierzchni podziałowej, 647 

S 

S, Patrz Scale 

nasycenie koloru, 455 

Save 

polecenie z menu File, 426 

Save & Load 

sekcja okna Preferences, 440 

Save As 

polecenie z menu File, 426 

polecenie z menu Image, 81 

Save As Image 

polecenie z menu Image, 427 

Save Screenshot 

zapisanie obrazu ekranu, 427 

Save Startup File 

polecenie z menu Defaults, 435 
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polecenie z menu File, 428 

polecenie z submenu Defaults, 37 

scalanie 

obiektów, 485 

okna, 28, 29 

Scale 

narzędzie z paska, 70 

polecenie z menu Mesh, 506 

polecenie z submenu Transform, 70, 490 

przykład użycia, 98 

scena 

opcje tworzenia, 453 

skala modelowanego obiektu, 86 

usuwanie, 453 

utworzenie nowej, 453 

użycie wielu scen, 631 

zarządzanie, 453 

zmiana nazwy, 453 

Scene, Patrz scena 

scripts 

folder konfiguracji Blendera, 435 

segmenty 

krzywych podziałowych, 634, 635 

powierzchni podziałowych, 642 

sekcja, Patrz także:zakładki, paneli 

Modifiers, 514, 521, 548, 552, 554, 555, 560, 564, 

565, 570 

Select Hierarchy 

polecenie z menu kontekstowego obiektu, 481 

selekcja, Patrz wybór 

Separate 

polecenie z menu Mesh, 547 

przykład użycia, 172 

Set Active Object as Camera 

polecenie z menu View, 474 

Set Parent To 

menu, 479 

przykład użycia, 124 

sfera 

odwzorowanie w powierzchni podziałowej, 642 

przybliżenie powierzchnią podziałową, 642 

Shade Auto Smooth 

polecenie z menu kontekstowego obiektu, 517 

Shade Flat 

polecenie z menu Face, 517 

polecenie z menu kontekstowego obiektu, 517 

Shade Smooth 

polecenie z menu Face, 515 

polecenie z menu kontekstowego obiektu, 517 

przykład użycia, 98 

tryb cieniowania siatki, 541 

Shift, Patrz transformacja, dokładna 

Shift-D, Patrz Duplicate 

Shift-E, Patrz Edge Crease 

Shift-K, Patrz Knife 

Shift-N, Patrz Recalculate Outside 

Shift-S, Patrz Snap, Patrz Snap, menu myszki 

Shift-V, Patrz Slide Vertices 

Show In 

opcje z panelu Object Data 

Empty, 463 

Shrinkwrap 

modyfikator, 565 

przykład użycia, 222 

siatka, Patrz Mesh 

’czyszczenie’ resultatu operacji Boole’a, 529 

cięcie (boolowskie), 144, 145 

dodadnie modyfikatora, 514, 521, 548, 552, 554, 555, 

560, 564, 565, 570 

fazowanie krawędzi, 560 

grupy wierzchołków, 458 

kopiowanie fragmentów, 520 

krawędź przecięcia, 531 

nacięcie nowej krawędzi, 532 

normalne, 150 

normalne (ścian), 154 

odcinanie (Boolean), 173 

odcinanie części, 527 

odsłanianie tymczasowo ukrytych fragmentów, 525 

odwracanie zwrotu normalnych, 569 

ostre krawędzie, 539, 540, 541 

podział krawędzi, 535, 536 

powielenie fragmentu, 534 

profil zaokrąglenia krawędzi, 562 

przecinanie nakładających się ścian (Knife), 533 

retopologia, 145, 146, 147 

rozszerzanie, 140, 538 

rzutowanie na inny obiekt, 565 

scalanie wierzchołków, 518 

skok do, 67 

spłaszczanie krawędzi, 507 

stworzenie krawędzi, 545, 546 

stworzenie ściany, 545 

topologia końcówki skrzydła, 143 

tymczasowe ukrywanie fragmentów, 525 

ustalanie szerokości fazki, 560 

usunięcie krawędzi, 544 

usunięcie wierzchołków, 543 
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utworzenie kwadratu, 469 

utworzenie okręgu, 466 

utworzenie sześcianu, 473 

utworzenie walca, 470 

używanie modyfikatorów w Edit Mode, 101 

wpływ normalnych ścian, 541 

wybór linii wierzchołków, 499 

wybór wierzchołka, 498 

wyciąganie (rozbudowa), 503 

wydzielenie fragmentu w nowy obiekt, 547 

wygładzanie za pomocą Slide Vertices, 153 

wyjaśnienie pojęcia, 496 

wyświetlenie normalnych, 568 

zaokrąglanie krawędzi, 561 

zaokrąglanie narożników (wierzchołków), 563 

zaokrąglanie wybranych krawędzi, 562 

siatki 

krawędź przecięcia, 482, 484 

Side 

pasek wyboru z panelu Object Data 

Empty, 463 

Sideabar 

przybornik (okna), 31 

Simple Deform 

modyfikator, 554 

modyfikator, przykład użycia, 186 

skręcanie obiektów, 554 

Single 

opcja z arkusza Viewport Shading, 50 

Size 

kontrolka z panelu Object Data 

Empty, 463 

parametr polecenia Add Cube, 473 

parametr polecenia Add Plane, 469 

pole panelu Viewport Display z zakładki Object Data, 

476 

skala 

modelu 3D, 86 

skalowanie 

na wybrana płaszczyznę, 507 

obiektu, 70 

wierzchołków (siatki), 506 

wzdłuż osi, 506 

z użyciem ornamentu, 70 

skok 

do najbliższego wierzchołka, 250 

do węzła siatki, 67 

łopaty śmigła, 125, 126, 128 

Vertex, przykład użycia, 250 

skręcanie 

obiektów modyfikatorem Curve, 558 

obiektów modyfikatorem Simple Deform, 554 

skróty 

definiowanie nowych skrótów klawiatury, 431, 432 

klawiatury, 431 

przypisanie polecenia do klawisza spacji, 431 

znajdowanie na liście, 431 

skróty klawiatury 

kiedy stosować?, 33 

skrypty 

Blendera, 443 

skrzydło 

formowanie, 132 

formowanie oprofilowania podstawy, 390 

geometria ukośnych krawędzi, 189 

kąt wzniosu, 229 

kąt zaklinowania, 229 

klapa, dźwigar, 213 

klapa, kontur, 208 

klapa, otwór na, 187 

klapa, podłużnica, 214 

klapa, poszycie, 206, 207 

klapa, rysunki referencyjne, 184, 203, 219 

klapa, tylna krawędź, 209, 215, 216, 217 

klapa, zamykanie wycięcia na, 190 

klapa, zawiasy, 204, 205, 208 

klapa, żebra, 210, 211, 212, 218 

kolekcje (w oknie Outliner), 230, 231, 232 

komora podwozia, 223, 224, 225, 226 

kontur końcówki (w rzucie z góry), 142, 143 

końcówka, 135 

dolna powierzchnia, 151, 152 

formowanie, 140 

otwory tymczasowe, 149, 153, 154 

pomocniczy kontur, 142, 143 

poprawianie kształtu, 156, 157, 159, 160, 161, 163, 

164, 165 

retopologia, 145, 146, 147 

topologia siatki, 143, 148 

wycinanie, 144, 145 

zaokrąglenie krawędzi, 149, 150, 151, 152, 153 

krawędź natarcia, 134 

krawędź spływu, 133, 136, 160, 162, 163, 165 

kształt podstawowy, 136 

lotka 

otwor dla, 169, 171 

rysunki referencyjne, 167 

typu Frise, 167 
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wydzielenie, 172 

modyfikacje profili, 138 

oprofilowanie podstawy 

formowanie stożka, 392, 393, 394 

kontury, 391 

krawędź natarcia, 396 

krawędź spływu, 395, 397 

rysunki, 390, 395 

osłona goleni podwozia, 374, 376, 377, 378, 379, 405, 

408 

otwór na koło, 221, 222 

podłużnice, 199 

podłużnice, dopasowanie, 200 

położenie, 229 

pomocnicze rysunki referencyjne, 131, 168, 172 

pomocniczy obiekt bazy, 228 

pomocniczy obiekt nadrzędny, 171 

profil (przekroju), 131 

profil końcówki, 137 

profil podstawy, 132, 133, 134 

przycinanie podstawy, 229 

punkt odniesienia, 228 

tworzenie prawej strony, 230, 232 

wycięcie na lotkę, 179, 180, 181 

wydłużanie, 140 

wyszukiwanie nieregularnych powierzchni, 162 

zakończenie krawędzi spływu, 185, 186 

żebra, 141 

żebra krawędzi spływu, formowanie, 194 

żebra krawędzi spływu, tworzenie, 191, 193, 195, 196, 

197, 198 

żebra krawędzi spływu, wymiary, 191 

Slide Vertices 

polecenie z menu Vertex, 537 

wygładzanie kształtu siatki, 153 

slider 

typ pola numerycznego, 77 

Snap 

menu myszki, 67, 454 

polecenie z menu Object, 67 

Vertex (tryb), 250 

Solid 

tryb cieniowania w oknie 3D, 48, 50, 51, 119 

Solidify 

grubość powierzchni, 521 

modyfikator, 521 

położenie względem powierzchni, 522 

przykład użycia, 102 

spacja 

przypisana funkcja, 22 

Specials 

podręczne menu edycji siatki, 535 

sRGB 

tryb konwersji barw, 456 

stacja 

wyjaśnienie pojęcia, 137 

startup.blend 

ustawienia Blendera, 428, 435 

statecznik pionowy 

formowanie konturu końcówki, 260 

formowanie końcówki, 261 

formowanie profilu podstawy, 260 

formowanie segmentu głównego, 260 

formowanie wycięcia, 261 

formowanie żeber, 261 

obiekt bazowy, 260 

odchylenie dźwigara, 262 

rysunki referencyjne, 259 

topologia siatki (szkic), 260 

współrzędne profili, 259 

statecznik poziomy 

formowanie dźwigara, 241 

formowanie konturu końcówki, 236 

formowanie końcówki, 237, 238 

formowanie profilu podstawy, 236 

formowanie segmentu głównego, 237 

formowanie wycięcia, 239 

formowanie żeber, 239, 240 

obiekt bazowy, 236 

rysunki referencyjne, 235 

topologia siatki (szkic), 236 

tworzenie prawej strony, 242 

współrzędne profili, 235 

ster kierunku 

baza (obiekt), 264 

klapka trymera, formowanie, 272 

kontur dźwigara, formowanie, 267 

kontury, 267 

końcówka, formowanie, 270 

krawędź spływu, formowanie, 268 

oprofilowanie (rysunki), 267 

oprofilowanie, formowanie, 268 

profil bazowy, formowanie, 267 

przeciwwaga, formowanie, 270 

rysunki referencyjne, 264 

rzut z boku, 264 

segment główny, formowanie, 269 

współrzędne profili, 265, 266 
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wycięcia, formowanie, 271 

żebra wzorcowe, 265, 266 

żebra, formowanie, 272 

ster wysokości 

baza (obiekt), 244 

klapka trymera, formowanie, 255, 256 

kontur dźwigara, formowanie, 246 

kontury, 246 

końcówka, formowanie, 248, 249 

krawędź natarcia, formowanie, 252 

oprofilowanie (rysunki), 245 

oprofilowanie, formowanie, 249, 250, 252 

plany, 245 

profil bazowy, formowanie, 246 

przeciwwaga, formowanie, 253, 254 

rysunki referencyjne, 243 

segment główny, formowanie, 247 

topologia siatki (szkic), 246 

tworzenie prawej strony, 257 

współrzędne profili, 243 

zdjęcia, 243 

żebra (wzorcowe), 243 

sterujące 

punkty, krzywych podziałowych, 632 

punkty, powierzchni podziałowych, 638 

sterujący 

wielobok,krzywych podziałowych, 632 

struktura 

pliku Blendera, 437, 627 

struktury 

okno, 27 

Studio 

lista oświetleń z arkusza Viewport Shading, 50 

stworzenie 

krawędzi, 545, 546 

ściany, 545 

Subdivide 

Number of Cuts 

parametr polecenia, 535 

polecenie z menu Edge, 535 

subdivision curves, Patrz krzywe podziałowe 

Subdivision Surface 

bezpośrednia modyfikacja, 101 

modyfikator, 467, 514 

przykład użycia, 97 

ukrywanie resultatów modyfikatora, 142 

usage example, 101 

Surface Offset 

modyfikator, 570 

parametr, 570 

suwak 

typ pola numerycznego, 77 

Swap 

przełącznik parametrów Intersect (Boolean), 527 

Switch Direction 

polecenie z menu Segment, 556 

system 

nazewnictwa, 477 

sześcian 

utworzenie, 473 

szkło 

materiał, 340 

Ś 

ściana 

kierunek normalny do, 568 

podział, 535, 536 

siatki, wyjaśnienie pojęcia, 496 

stworzenie, 545 

środek, 502 

trójkatna w powierzchni podziałowej, 518 

wyciąganie, 503 

zaznaczanie w trybie X-Ray, 502 

ścieżka 

edycja, 490 

tworzenie, 490 

waga węzła, 491 

wielobok sterującyh, 490 

współrzędne węzłów, 491 

względna (do plików), 79 

śmigło 

geometria łopaty, 104 

środek 

3D Cursor, 506, 510 

Active Element, 506 

Bounding Box Center, 506 

obiektu (kursor 3D), 67 

obiektu (origin), 67 

zmiana dla obiektu, 487 

środkowe 

punkty, powierzchni podziałowych, 639 

T 

T, Patrz Toolbar 

Tab, Patrz tryb edycji) 

Target 

obiekt docelowy modyfikatora Shrinkwrap, 565 

text field 
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pole tekstowe, 79 

Thickness 

parametr modyfikatora Solidify, 521 

Tile Area 

polecenie z menu Header, 33 

Timeline 

okno, 27 

Timer 

interwał tworzenia kopii bezpieczeństwa, 440 

To Scene 

polecenie z menu Object, 453 

Toolbar 

pasek narzędzi, 30 

Tools 

domyślna funkcja klawisza spacji, 22 

Tooltips 

opcja z sekcji Interface okna Preferences, 36 

Top 

polecenie z menu View, 43 

Track To 

opis ograniczenia, 488 

Target Z 

podążanie za orientacją ‘celu’, 488 

usunięcie ograniczenia, 489 

Track To Constraint 

utworzenie ograniczenia, 488 

Trackball 

opcja z sekcji Preferences 

Navigation, 430 

Transform 

panel (dla węzłów krzywej), 491 

W 

waga węzła (NURBS), 491 

transformacja 

dokładna, 65 

na wybranej płaszczyźnie, 65 

rezygnacja (z polecenia), 506, 508, 510 

środek (punkt odniesienia), 67 

wykluczanie pojedynczej osi, 65 

względem pojedynczej osi, 64, 66 

Transformation Pivot Point 

lista rozwijalna z menu okna 3D, 67 

trójkatne 

ściany, w powierzchni podziałowej, 518 

trójkąty 

ściany, znajdowanie w siatce, 550 

tryb 

edycja krzywej, włączanie, 490 

edycji, włączanie, 497 

U 

układ ekranu 

Animation, 34 

kopiowanie, 441 

Layout, 34 

predefiniowany, 34 

UV Editing, 34 

wybór, 34 

zmiana nazwy zakładki, 441 

ukrywanie 

części siatki (tymczasowe), 525 

pojedynczego obiektu, 450 

zawartości kolekcji w oknie 3D, 449 

umieszczanie 

kursora 3D, 454 

Undo 

limit (ustawianie), 434 

polecenie z menu Edit, 69 

ustawienia, 434 

upgrade 

importowanie ustawień z poprzedniej wersji, 23 

Use Limit Surface 

opcja modyfikatora Subdivision Surface, 638 

userpref.blend 

ustawienia Blendera, 36, 428, 435 

ustawienia 

Blendera dla tej książki, 436 

Editing, 429 

File Paths, 440 

folder config, 435 

folder scripts, 435 

funkcja spacji, 22 

import z poprzedniej wersji, 23 

Input, 430 

Interface, 429 

kopie bezpieczeństwa, 440 

nadpisanie istniejących, 436 

plik startowy, 428, 435 

plik startup.blend, 428, 435 

plik userpref.blend, 36, 428, 435 

plik z konfiguracją programu, 36, 428, 435 

położenie katalogu, 435 

Save & Load, 440 

System, 434 

Undo, 434 

użycia karty graficznej, 434 

zapisywanie, 435, 436 

usterzenie 

oprofilowanie, asymetria, 387 
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oprofilowanie, część główna, 383, 384 

oprofilowanie, część przednia, 384, 385, 386 

oprofilowanie, przycinanie krawędzi, 387 

oprofilowanie, rysunki, 382, 407 

oprofilowanie, zaokrąglenia, 384, 385, 386 

usuwanie 

aktualnej sceny, 453 

danych z pliku Blendera, 628 

dodatków, 445 

kolekcji, 452 

krawędzi, 544 

linii wierzchołków, 542 

menu Delete, 542, 543, 544 

modyfikatora, 515 

narzędzi pomiarowych, 447 

niepotrzebnych danych z pliku Blendera, 629, 630 

ograniczenia, 489 

okno opcji, 542, 543, 544 

układu ekranu, 442 

wierzchołków, 543 

utworzenie 

linii wierzchołków, 511 

nowego materiału, 575 

nowej sceny, 453 

UV Editing 

układ ekranu, 34 

V 

V, Patrz Rip Vertices 

intensywność koloru, 455 

Vertex Group 

pole w panelu modyfikatora, 566, 567 

Vertex select 

opcja w trybie edycji, 502 

Vertex Slide 

skrzydło — wstawianie żeber, 140 

Vertex Tools 

instalacja, 524 

włączanie, 524 

wtyczka, 524 

Vertical Split, Patrz nowe:okno (Blender) 

Vertices 

opcja z menu Delete, 543 

parametr polecenia Add Cylinder, 470 

View 

(Align To) opcja z sekcji Preferences 

Editing, 429 

panel z przybornika (View), 45 

Viewport Display 

panel z zakładki Material, 576 

Viewport Overlays 

panel rozwijalna (nagłówek okna 3D), 555 

panel rozwijalna okna 3D, 568 

W 

walec 

interaktywna zmiana parametrów, 470 

parametry domyślne, 470 

utworzenie, 470 

wąsy 

zniekształcenie zdjęcia, 651 

wiatrochron 

geometria, 346 

otwór inspekcyjny, 361, 362, 363 

różnice między P-36 i P-40, 359, 361 

widoczność 

narzędzi pomiarowych, 447 

widok 

atrefakty w perspektywie (okno 3D), 44 

efekt ‘niewidzialnej ściany’ (w oknie 3D), 45, 46 

obracanie (w oknie 3D), 42 

ogniskowa, 45 

okno, 27 

perspektywiczny, 44 

powiększanie (w oknie 3D), 41, 45, 46 

przesuwanie (w oknie 3D), 41 

wizualizacja normalnych, 568 

z boku, 43 

z dołu, 43 

z góry, 43 

z kamery, 56 

z prawej, 43 

z przodu, 43 

z tyłu, 43 

zakres głębokości, 45 

widok z przodu 

problemy z dokładnością, 160 

wielobok oryginalny, Patrz wielobok sterujący 

wielobok sterujący 

krzywą, 490 

krzywych podziałowych, 632 

wierzchołek 

aktywny, 496, 498 

dodanie przez podział krawędzi, 535, 536 

kopiowanie, 520 

linia (na siatce), 499 

obrót, 510 

powielenie na siatce, 534 
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przesunięcie, 508 

przesunięcie linii, 513 

przesunięcie wzdłuż wybranej krawędzi, 537, 538 

scalenie duplikatów, 518 

usuwanie, 543 

utworznie linii (wierzchołków), 511 

wybór, 498 

wybór linii (siatki), 499 

wybór obszarem prostokątnym, 500 

wybór okręgiem, 500 

wybór wielokrotny, 498 

wyciąganie, 505 

wyjaśnienie pojęcia, 496 

zaokraglanie (w narożniku), 563 

zmiana skali, 506 

wierzchołki 

grupy, 458 

wierzchołkowe 

punkty, krzywych podziałowych, 633 

punkty, powierzchni podziałowych, 640 

Wireframe 

tryb cieniowania w oknie 3D, 49 

właściwości 

krzywych podziałowych, 635 

ograniczenia (obiektu), 488 

okno, 27, 72 

workspace 

zarządzanie (układami ekranu), 441 

wprowadzanie 

dokładnych wartości parametrów tranformacji, 69 

wręgi 

kadłuba, 275 

osłony silnika, 287 

rysunki referencyjne, 276, 360 

wskazanie 

koloru na ekranie, 455 

współrzędne 

kursora 3D, 68, 86, 454 

obiektu aktywnego, 68 

transformacji 

wpisywanie dokładnych wartości, 69 

współrzędne lokalne 

transformacja układu, 173 

wtyczka 

Intersection, 531 

Vertex Tools, 524 

wybór 

grupy obiektów, 58, 59 

linii wierzchołków, 499 

obiektu, 56 

obszarem prostokątnym, 500 

okręgiem, 500 

typowe błędy, 501 

typu okna, 31 

wielu wierzchołków (siatki), 498 

wierzchołka (siatki), 498 

wskazówki, 501 

wykluczanie linii wierzchołków, 499 

wykluczenie grupy obiektów z, 58 

wyłączenie, 499 

zaznaczenie wszystkiego, 499 

wyciąganie 

krawędzi, 490, 503 

metoda rozbudowy siatki, 503 

narzędzie z przybornika, 504 

ścian, 503 

wierzchołków, 505 

wycinanie 

części powłoki (Boolean), 552 

wycofywanie 

ostatniej operacji, 69 

wydłużanie 

skrzydła, 140 

wydzielenie 

fragmentu siatki w nowy obiekt, 547 

wykluczenie 

obiektu z renderowania, 450 

wyłączenie 

obiektów z selekcji, 58 

wymiary 

bazy wymiarowe skrzydła, 228 

kąt zaklinowania skrzydła, 229 

położenia skrzydła, 229 

wznios skrzydła, 229 

wyszukiwanie 

elementów na liście, 459 

nieregularności na powierzchni podziałowej, 162 

wznios 

kąt, dla skrzydła, 229 

wzory 

algebraiczne,krzywych podziałowych, 634 

X 

X, Patrz transformacja względem osi, Patrz Delete 

X-Ray 

opcja cieniowania, 48, 49 

używanie w trybie edycji, 501 

w zaznaczaniu ścian, 502 
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Y 

Y, Patrz transformacja względem osi 

Z 

Z, Patrz transformacja względem osi 

zagubione 

wierzchołki i krawędzie siatki, 550 

zaklinowanie 

kąt, dla skrzydła, 229 

zakładka 

Modifiers, 467 

zakładki 

okna Properties, 74, 75 

paneli w oknie Properties, 74 

zakres 

wpływu węzła krzywej NURBS, 491 

zakres wpływu 

punktów sterujących, 642 

punktu sterującego w krzywych podziałowych, 635 

zamiana 

obrazów w obiektach Empty, 91 

zaokraglanie 

krawędzi, 561 

narożnika (wierzchołka), 563 

profil zaokraglenia, 562 

wybranych krawędzi, 562 

zaokrąglenie 

czubka, 98 

zapisanie 

okna Blendera, 427 

pliku Blendera, 426 

wyniku renderowania, 427 

zapisywanie 

konfiguracji, 435, 436 

resultatu renderowania, 81 

stanu pracy, 426 

zarządzanie 

kolekcjami (sceny), 448 

scenami, 453 

układem okien na ekranie, 441 

zasięg 

kamery, 475, 476 

zastąpienie 

konfiguracji Blendera, 436 

zaznaczanie, Patrz wybór 

n-gonów (ścian), 551 

ścian w trybie cienowania X-Ray, 502 

trójkątów, 550 

wskazywanie obiektu do kontrolki GUI, 552 

wyboru, 56 

wykluczenie obiektów i kolekcji, 450 

wykluczenie z, 450 

zaznaczenie 

zagubionych wierzchołków i krawędzi, 550 

zdjęcia 

korekta zniekształceń, 652 

projekcja perspektywiczna, 649 

wykrywanie zniekształceń, 651 

zniekształcenie ‘w wąsy’, 651 

zniekształcenie beczkowate, 650 

zniekształcenie poduszkowe, 650 

zmiana 

typu edytora, 31 

zmniejszenie okna, 40 

zniekształcenie 

korygowanie na zdjęciach, 652 

wykrywanie na zdjęciu, 651 

zdjęcia, 650, 651 

Zoom, Patrz powiększanie,widoku 

Zoom In 

polecenie z menu View, 41 

Zoom Out 

polecenie z menu View, 45 

Ż 

żebra 

krawędzi spływu, 191 

tworzenie, 191, 193, 194, 195, 196, 197, 198 

żebro 

skrzydła, 141 
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 (CC) Witold Jaworski, 2009 – 2023 

O autorze 

Nazywam się Witold Jaworski i odkąd skończyłem 10 lat jestem fa-

nem lotnictwa oraz modelarzem. Zaczynałem od plastikowych zesta-

wów do sklejania (1:72), potem wycinanek z „Małego Modelarza” 

(1:33), by skończyć na budowie modeli od podstaw (1:24). Te zainte-

resowania zaprowadziły mnie na Wydział Mechaniczny Energetyki i 

Lotnictwa Politechniki Warszawskiej, który ukończyłem w 1994 r. W 

1987 r. przerysowywałem w tuszu plany samolotów, m.in. do książki 

„Samoloty bombowe września” (te prace zlecał Andrzej Glass). Potem 

p. Andrzej zaproponował mi samodzielne opracowanie rysunku prze-

krojowego i kilku arkuszy planów do nowo powstającego magazynu. 

Mogłem wybrać dowolny samolot. W ten sposób powstały dokładne 

rysunki myśliwca F-4 Phantom II, opublikowane w 1990 r. w pierw-

szym numerze miesięcznika „Aero HOBBY”. Nadal można znaleźć ich 

kopie w Internecie, na różnych portalach z planami. Podczas studiów 

na MEiL zainteresowałem się także grafika komputerową i systemami 

CAD. W 1991 r. miałem okazję po raz pierwszy wykorzystać tę wie-

dzę, pomagając w budowie prototypu szybowca PW-5 (zwycięzcy 

konkursu na tzw. szybowiec światowy w 1992 r.). 

 
Obecnie pracuję jako specjalista IT. Mieszkam wraz z żoną i trójką dzieci w Poznaniu. Od czasu do czasu piszę 

artykuły dla czasopism lotniczych. W tej książce połączyłem swoje dwie pasje: grafikę komputerową i lotnictwo, 

w nowy rodzaj modelarstwa: budowę realistycznych, cyfrowych modeli historycznych samolotów. 

 

 

 



 

W XX wieku można było robić miniatury samolotów z 

kartonu lub z plastiku. Na początku wieku XXI przyszedł 

czas na jeszcze jedną odmianę tego hobby: modele 

komputerowe. Ta nowa gałąź modelarstwa redukcyjnego 

rodziła się „po cichutku”. Dwadzieścia lat temu mało kto 

mógł wydać (prywatnie!) parę tysięcy dolarów na 

odpowiedni program. A tymi „nieodpowiednimi” nie było 

się co chwalić… Nieliczni zapaleńcy siedzieli więc przy 

monitorach i tworzyli pierwsze modele, ucząc się na 

własnych błędach.  

 
Obecnie niezbędne oprogramowanie jest dostępne za 

darmo (na licencji Open Source). Jeżeli jeszcze Twój 

komputer ma mniej niż 6 lat, to masz już wszystko, czego 

potrzeba, by zacząć! Ta książka dostarcza niezbędnego 

know how. Pokazuje krok po kroku, jak zrobić takie 

modele, jak na ilustracjach obok. I, podobnie jak 

oprogramowanie które opisuje, także jest bezpłatna!  

 
„Wirtualne modelarstwo” jest kierowane nie tylko do 

modelarzy. Może zainteresować wszystkich tych, którzy 

chcą się poznać takie ogólnodostępne programy, jak 

Blender, GIMP, czy Inkscape.   

 

ISBN:  978-83-941952-5-0           Bezpłatna publikacja elektroniczna, udostępniana na licencji Creative Commons 

 

Samolot z 3-go dywizjonu AVG („Hell’s Angels”), Kunming 1942, wg opracowania Janusza Światłonia. (Tło: © Tomo Yun, www.yunphpto.net) 
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